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Main topics and tasks
▪ How to use this help  20
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How to use this help
Main elements

Tips for using the help

Table of Contents

▪ If you do not see the Table of Contents on the left, enlarge the Help window 
or zoom out the characters (Ctrl+mouse wheel).

▪ If you want to know the current topic’s position within the browse 
sequence, click the Table of Contents icon and locate the green indicator.
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Search

▪ To search for two or more adjacent words, use quotes. For example, “plus 
maze”.

▪ While you type, the Help gives you suggestions about recurring terms and 
sentences. Click one of them to refine your search.

▪ The search results are shown on the left side pane.
▪ To go back to the main page, click the EthoVision XT icon at the top-left 

corner of the screen.

Index

▪ To use the index, type a word in the Filter keyword field.
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▪ If an index term (or sub-term) occurs in different topics, these are listed 
under the term.

▪ To reset the index, delete the word you typed or click the X button and 
press Enter.

Notes
▪ The EthoVision XT Help is in responsive HTML5 format. Depending on the 

size and shape of the Help window, the buttons are automatically re-
arranged, for example in tablet mode.

See also

For more manuals, click the following link:

EthoVision XT 18 Other Documentation

Or from the Windows Start menu, choose All Apps > Noldus > EthoVision XT 18 
Other Documentation.
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Introduction to EthoVision XT
Learn about

▪ Video tracking with EthoVision XT
▪ Video in EthoVision XT
▪ Modules of EthoVision XT
▪ What’s new in EthoVision XT 18
▪ Restrictions in EthoVision XT
▪ For more information
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Video tracking with EthoVision XT
EthoVision XT is an automated video tracking and motion analysis system. Video 
tracking means that EthoVision XT detects and follows one or more animals, or 
objects, in a video image (live footage or pre-recorded video file), and tracks their 
location and movement.

EthoVision XT is a software platform. The Base version help you carry out tests like 
the Open field and the Morris water maze test. With its Add-on modules, it offers a 
wide range of video tracking options, and extensive analysis of locomotion and 
behavior. For more information, see Modules of EthoVision XT on page 31.

Overview
The entire process carried out by EthoVision may be summarized as follows: a video 
camera observes the movement of one or more subjects, and passes images of the 
subjects to your computer. There they are transformed into a digital signal and 
optionally encoded as a digital video file. From this digital signal or file, EthoVision 
first detects the subjects and then extracts the size of the subjects and position of 
one or more body points of the subjects in each image. That data is then 
transformed into a series of dependent variables quantifying the behavior of the 
subjects.

See also

▪ The EthoVision XT 18 - Quick Start Guide, which came with the software.
▪ The EthoVision XT Video Tutorial to learn how to set up an experiment in 

EthoVision XT. In EthoVision XT, choose Help > Video Tutorial. Note that 
the Video Tutorial contains audio.

Image sensing
The starting point of an imaging system is a video camera. A video camera 
transforms a scene (the area in front of the lens), into an image (a picture taken by 
the camera). If you have an analog camera the image must be converted into a 
digital image consisting of pixels. With USB, Gigabit Ethernet (GigE) and Internet 
Protocol (IP) cameras, digitization occurs within the camera. You can plug them 
directly into your computer. Instead of using live video from a camera, you can also 
make a digital video file and use that for tracking.

One video image from a camera or digital video file is called a frame. The frame is 
made by a point which scans the scene in a series of horizontal lines (called fields), 
starting at the top and working its way down to the bottom. The fields are 
interlaced, that is, the camera first scans the odd lines, then the even lines. As the 
24



scene is scanned, the brightness (or color) of the scene is transformed into an 
analog signal describing the intensity of the image at each point of the scan.

The number of frames scanned in each second is called the frame rate, and this 
determines the maximum possible sample rate for EthoVision. The frame rate 
differs between cameras. See Cameras supported by EthoVision XT

Subject detection
When EthoVision XT receives the video frame, it does not “see” a mouse in an open 
field (for instance), but a bitmap composed of pixels, each of which has a particular 
gray value. The first thing that EthoVision XT does is to distinguish between the 
subjects to be tracked, and the background. In order to establish which pixel is part 
of the animal and which pixel is part the background, EthoVision makes use of 
different detection methods. You can choose which detection method to use, but 
you can also let EthoVision XT select the best method for you. To do so, choose the 
Automated Setup of the Detection Settings.

Excluding noise
Whichever detection method you choose, it is possible that some pixels are 
identified as the subject, that are in fact just system noise or reflections. You can 
exclude these as follows:

▪ Before tracking:
In the Arena Settings, define an arena. This means that pixels outside the 
arena are ignored.

In the Detection Settings, make various settings to exclude noise.
25



▪ After tracking:
Smooth the track to filter out system noise, outliers and small movements.

Identifying multiple subjects
EthoVision XT can track more than one animal per arena. A few techniques are 
available, from the basic tracking of unmarked subjects to the state-or-the-art 
identification technique based on Deep learning (see below). To track multiple 
subjects, you need the Social interaction add-on module. Modules of EthoVision XT

Tracking of unmarked subjects

You can track multiple animals without using color markers. For instance, track a 
shoal of fish to measure the average between-individual distance. However, keep in 
mind that there may be subject identity swaps, that is, what is labeled subject 1 may 
be labeled subject 2 later in the track. Therefore individual identification is not 
guaranteed. The methods listed below keep track of the subjects’ identities.

Color-marker tracking

Here below, you see an example of color marker tracking. EthoVision XT follows the 
color spots on the back of the insects, ignoring the shape of the animals.

Marker-assisted identification

With Marker-assisted identification, EthoVision XT uses the colors to identify the 
subjects, but tracks their entire body. This method allows to collect detailed data in 
social interaction tests, particularly in rodents. Just like for the previous method, you 
need to tell EthoVision XT which colors to follow.
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Tracking based on Deep learning

If two subjects look different, or are marked in some way (also in grayscale video), 
EthoVision XT can discriminate between the two using its neural network. In most 
cased you need to mark one of the two subjects on its back or at the base of its tail.

Individual discrimination is accomplished after tracking, in a process named Data 
Preparation which involves a thorough review of the tracks and the corresponding 
video images. The neural network re-assigns the identity labels to the subjects 
based on their visual appearance. Note that to use Deep learning you need a 
compatible secondary graphics card (GPU). See Deep learning: Basics and Deep 
learning: Requirements

Video tracking and video recording
You can set EthoVision XT to track the subjects and, at the same time, save the 
video image to a digital video file. Alternatively, you can choose to save video first, 
and track the subjects later from that video. See Important things to know about 
data acquisition.
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Subject position, size and orientation
When EthoVision XT has identified a group of adjacent pixels as a subject, it extracts 
a few features (depending on which add-on you have):

▪ Subject position. This is the x,y coordinates of the body points being tracked: 
either the center-point only, that is the point mathematically in the center of 
the shape considered to be the subject, or the center-point, the nose-point 
and the tail-base point. See Overview of nose-tail base detection

▪ Subject area. This is the area of the surface in the video image (camera 
image or video file) which composes the detected subject. The area is 
expressed and exported as squared distance units.

▪ Subject area change. This is the proportion of the subject’s area that 
changes between frames. It is used to estimate the subject’s mobility. 

▪ Subject’s head orientation. When you track the subject’s nose point (only for 
contour-based methods), the software estimates the direction of the gaze. 
This is indicated with the blue line that originates from the nose point.

▪ Subject elongation. This quantifies how stretched the subject’s body is. 
For an overview of the output variables related to the subject’s body, see 
Dependent Variables in Detail > Body

Quantifying behavior
The output of video tracking is a series of numbers representing the x,y coordinates 
and size of the subject. From the raw data EthoVision XT calculates a number of 
Dependent variables describing the behavior of the subject. These include speed 
and distance moved but also complex variables such as the direction of movement 
relative to an object. 

Furthermore, with the Rat and Mouse Behavior Recognition modules, behaviors like 
grooming and rearing can be detected automatically.
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Data analysis and results export
For all the dependent variables, EthoVision XT can calculate a wealth of descriptive 
statistics (such as mean, standard deviation, etc.). These are shown for each trial, 
and for the groups of trials that you may want to define (for example, treated vs. 
vehicle subjects).

Results and raw data (x,y coordinates and per-sample values of dependent 
variables) can be exported to text and Excel format.

NOTE  With custom code written in JavaScript language within EthoVision XT, you 
can greatly expand analysis capabilities. See a few examples in the following topics:

▪ JavaScript continuous
▪ JavaScript event
▪ JavaScript state
29



Video in EthoVision XT
EthoVision XT can work with different types of cameras:

Analog cameras
To use analog CCD cameras, you need an encoder board, which converts the analog 
signal to digital. With this board you can also save the video image to a video file 
directly with EthoVision XT. See Install analog cameras

Digital cameras
You can plug a digital camera (GigE Vision or USB 3.0) directly into your computer. 

The video signal is used directly in EthoVision XT to track live and save video. 
However, for acquisition the quality of the input signal is crucial, therefore not all 
digital cameras can be used. See Cameras supported by EthoVision XT

Mixing camera images
You can feed multiple cameras to the EthoVision XT computer. EthoVision XT mixes 
the images of up to sixteen cameras. Video is saved with all camera images merged 
into one. For example, when you use two cameras, the resulting video file contains 
the two camera views next to each other.

For information on the supported cameras, frame rates, and resolutions, and the 
maximum number of cameras supported, see Camera Installation.

Recording video with MediaRecorder
With the Noldus MediaRecorder software you can record video to be used in 
EthoVision XT for offline tracking. An advantage of using MediaRecorder is that 
you can create separate, full resolution video files from multiple cameras. With 
EthoVision XT, the images from multiple cameras are merged in one video file.

See also

▪ Camera Installation
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Modules of EthoVision XT
To know which add-on module you have, choose Help > About EthoVision XT 
then click the License Info button. The modules enabled in your license are marked 
with a check symbol.

What module is enabled depends on the EthoVision XT license is currently active on 
that computer. You cannot select and deselect those modules from the software. 
See also Types of EthoVision XT license

Base module
The Base module of EthoVision XT allows tracking of the center-point, the nose-
point and tail-base point and other relevant features of one subject in one arena.

▪ Tracking the nose-point is, for instance, relevant in the Elevated plus maze 
test to determine the number of times the subject puts its head in one of 
the open arms of the maze without actually entering the arm. Tracking the 
center-point is then not so useful.

▪ You can also record your subjects’ behavior manually using the Manual 
Scoring function.

▪ You can also measure Body elongation on the basis of thresholds that you 
set yourself.

NOTE  The Multiple Body Points module is included in the Base module.

You can extend the base functionality with the add-on modules listed below.

Multiple Arenas module
Allows tracking in more than one arena at the same time. You can track one subject 
per arena.
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Rat Behavior Recognition module
With this module you can have EthoVision XT detect various behaviors 
automatically: drinking, eating, jumping, grooming, rearing (supported and 
unsupported), resting, sniffing, twitching and walking. 

Mouse Behavior Recognition module
With this module you can have EthoVision XT detect various behaviors of mice 
automatically: digging, drinking, eating, grooming, hopping, rearing (supported 
and unsupported), resting, sniffing and walking. 

IMPORTANT  The Mouse Behavior Recognition and the Rat Behavior Recognition 
modules are not interchangeable. For example, you cannot use the Mouse Behavior 
Recognition to detect digging in rats.

External Data module
With this module, you can import any external data in ASCII format. External data 
may include physiological data (e.g. EEG, blood pressure, heart rate, body 
temperature, etc.) or environmental data (e.g. room temperature, humidity, etc.).

You can synchronize track data and associated external data and subsequently 
visualize, select and export these data. See External Data

Quality Assurance module
This module supports you in making experiments which fulfill quality requirements. 
It helps you protect your data and creates log files so you can easily keep track of 
everything that happens during a project. See EthoVision XT and Quality Assurance

Social Interaction module
This module allows you to track more than one animal per arena and study social 
interactions. For the statistical analysis a number of variables are available like the 
distance between the animals, and the relative movement. See also Advanced 
detection settings for tracking color-marked subjects

Trial & Hardware Control module
With this module, you can make advanced rules to start and stop the trial. You can 
also control hardware, like, e.g., a pellet feeder and make settings in such a way that 
the pellet feeder drops a pellet when the animal is in the trigger zone for 30 
seconds. See Trial Control Settings in this Help and the EthoVision XT 18 - Trial and 
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Hardware Control - Reference Manual. To find this manual, in the Window Apps 
screen choose Noldus > EthoVision XT 18 Other Documentation. 

EthoVision XT 18 Other Documentation

Track3D module
Track3D is a solution for tracking animals in a 3D space. This add-on includes a 
MATLAB application that converts 2D tracks obtained from two cameras to a three-
dimensional track, and calculates a wealth of movement parameters in 3D.

Note that Track3D only works with one tracked individual at a time. For more 
information, contact Noldus.
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What’s new in EthoVision XT 18
In the spotlight

▪ Deep learning technique for two-subject tracking. EthoVision XT extends the 
use of neural network models to the case of social interaction test with two 
subjects. This method requires that the two subjects have some noticeable 
difference in the appearance. In most cases you need to mark one of the 
two animals, on the back (see the figure below, left) or on the base of the 
tail (right). 

For details see the following:

▪ Deep learning: Requirements
▪ More information on graphics cards (GPUs)

Apparatuses and video technology
▪ Full support for PhenoTyper 2. EthoVision XT can operate the top unit of 

PhenoTyper 2 recently released. For details, see the EthoVision XT - 
PhenoTyper - Reference Manual.

▪ Support for 16 digital cameras. You can record video from up to 16 Basler 
monochrome digital cameras. See 16-camera configuration

▪ Ugo Basile Fear Conditioning System. The devices of the Ugo Basile FC 
system are now fully controlled from the EthoVision XT Trial Control 
Settings. These include the infrared light necessary for tracking. You no 
longer need an external device to adjust the IR light intensity inside the 
cubicle.

Detection and data acquisition
▪ Use the first video frame to update the reference image. When you carry out 

a series of trials and use either Dynamic Subtraction or Differencing as the 
detection method, you want to update the reference image based on the 
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most recent lighting conditions and background. For this, you can let 
EthoVision XT take the first video frame of the trial and use it as a reference 
image. See The reference image 

▪ Manual Scoring. you can visualize the arenas and the zones while you 
observe and score behaviors manually. Click the Show/Hide button at the 
top-left corner of the Manual Scoring screen, and choose Arena features.

Data analysis
▪ New JavaScript analysis functions. JavaScript custom analysis variables rely 

on the tracking data. New functions make it easier to extract tracking data.
▪ The function IsSubject[bodypoint]InZone helps you check whether one 

of the subjects of a multi-subject experiment is in a specific zone. 
▪ The function IsPointInZone checks that a point (i.e., a body point or a 

point of interest) lies within a zone. It replaces the old variable IsInZone.
▪ The functions GetSubjectArea, GetSubjectChangedArea, 

GetSubjectElongation, GetSubjectViewDirection extract relevant 
information of subjects in a multi-subject experiment.

See the complete list in Commands and functions for JavaScript variables

▪ New JavaScript variables for analysis of social behaviour. New JavaScript 
code is available for analysis of social events: social contact, approaching, 
following and leaving. You can find the scripts on the EthoVision XT 
installation package under Drivers and tools\JavaScript custom variables, or 
on GitHub. See JavaScript custom variables

▪ New option for Relative movement. The social behavior variable Relative 
movement quantifies the tendency of one subject to move toward or away 
from another subject. You can now tell the software what movement is 
based on a minimum velocity. See Relative movement

▪ Data visualization of multi-day recordings. In the Integrated Visualization 
you can now plot data for up to seven days (previous limit was 24 hours).

Miscellaneous
▪ New experiment templates. Experiment templates are now available for the 

Ugo Basile Fear Conditioning System, the Ugo Basile Active Avoidance 
Shuttle Box and for PhenoTyper 2, the latter also in a 16-cage 
configuration. See Create an experiment from a predefined template

▪ Import profile for Doric data. A profile for importing external data from 
Doric fiber photometry/optogenetics systems has been added to the list of 
import profiles. See Doric
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▪ Video Tutorial. The EthoVision XT Video tutorial includes a section about 
two-subject tracking using Deep learning.

▪ Onboarding training. If you are new to EthoVision XT, click the link on the 
start screen under Learn more to access the Noldus Academy’s EthoVision 
XT onboarding training.

See also

EthoVision XT 18 Other Documentation
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Restrictions in EthoVision XT
In the following table you find a summary of the main restrictions in EthoVision XT.

General

Feature Maximum 
number

Notes

Subjects per arena 1 (Base module), 
up to 16 (Social 
Interaction 
module)

The limit of 16 subjects is set by the software. It 
may be difficult to discriminate between 16 
different color marks depending on the light 
conditions. See Color markers

We recommend to only use Tracking from video 
files when you track multiple subjects and 
multiple body points.

The technical limit of 16 subjects per arena can be 
overridden in the software; contact Noldus for 
the possible solutions. Contact the Noldus 
Support

Arenas 100 With the Multiple Arena Module; One arena with 
the Base Module.

Arenas must not overlap. The number of arenas 
does not depend on the number of cameras. You 
can have for example 96 wells in one camera 
image, or 16 arenas with 16 camera views (one 
arena per camera).

When you combine tracking of multiple subjects 
(with colors) and multiple arenas, performance 
may limit the total number of subjects followed 
simultaneously.

Trials 10000

Behavior types 
scored manually

256

Hardware 
commands and 
signals

1024 With the Trial and Hardware Control Module

Arena Settings 
cache

50 MB

Heatmap 
dimensions (pixels)

65536

Rows or columns in 
analysis results 
table

One million
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Computer

See also

▪ System requirements: Hardware
▪ Ordering a PC from another supplier
▪ More information on graphics cards (GPUs)

Free intervals 2000 See Free interval

Time bins No restriction If you create more than 1000 time bins, the group 
charts are not displayed.

Feature Limitations Notes
Computer type Workstation We recommend the use of Dell workstations 

especially when using multiple add-on modules 
(e.g. tracking nose-, center- and tail-base points 
in multiple subjects simultaneously)

When tracking for more than 24 hours, restart the 
PC before a new trial.

See Hardware

Video graphics 
card

NVIDIA, 4 GB or 
larger

If you opt to buy your own PC, it must have a 
stand-alone graphics card that supports Direct3D 
acceleration, We recommend NVIDIA video cards 
with a memory of 4 GB or larger. 

For tracking subjects with Deep learning, there 
are further restrictions. See Deep learning: 
Requirements

Processor and RAM 
memory

Intel We recommend an Intel processor; for desktops 
PCs a 32 GB RAM, and for laptops a 16 GB RAM.
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Video resolution, sample rate and trial duration

IMPORTANT  When tracking from video files at high resolution and/or frame rate, 
always select DDS in the Playback Control window. This way EthoVision XT adjust 
the analysis speed to the time needed to analyze each frame without skipping 
frames. See DDS (Detection determines speed)

IMPORTANT  When tracking for more than 24 hours, always reboot the PC after every 
trial to refresh the PC resources, the RAM specifically. Failure to do so could result in 
crashing, which can corrupt the experiment, or the recorded video. 

Feature Maximum Notes
Video resolution 
(camera image)

Depends on 
camera type

See Cameras supported by EthoVision XT

Video resolution 
(video file)

1900 x 1200 Higher resolutions, for example 4K video may 
work. Test a few sample videos and check for 
missing samples. Keep DDS selected in the 
Acquisition screen.

See DDS (Detection determines speed)

Sample rate (live 
tracking)

60 frames per 
second; it depends 
on the camera

See Cameras supported by EthoVision XT

Sample rate 
(tracking from 
video file)

Not specified EthoVision XT can handle short video files with a 
frame rate of 1000, but that also depends on the 
video format. Test a few sample videos and check 
for missing samples before running the 
experiment.

Trial duration 72 hours, but this 
depends on the 
tested setup

See Resolution, frame rate, and maximum trial 
duration
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Applications and add-ons

See also

▪ Choose your camera
▪ System requirements
▪ The test environment

Feature Maximum 
number

Notes

Multiple Body Point 
module (live 
tracking)

Four arenas per 
computer

In principle it is possible to track in more than 4 
arenas, but it depends on the apparent size of the 
subjects in the video image (in pixels).

Sample rate must be 25 samples/s or higher.

Multiple Arena 
module

100 arenas The number of arenas may be limited by other 
factors, for example the number of subjects in 
each arena and the tracking of multiple body 
points.

Contact Noldus if you wish to work with more 
than 100 arenas.

Social Interaction 
module

16 subjects per 
arena

If subject are unmarked, there may be subject 
identity swaps.

CognitionWall 
(Sylics)

Four arenas, only 
center-point 
tracking; up to 72 
h recording

In case of recordings > 24 h, we advise to restart 
the PC after each trial. A workstation is required.

Behavior 
Recognition

Subjects: one per 
arena

Arenas: one (live 
tracking), up to 
four (offline 
tracking) 

Requires the Multiple Body Point module. 
Camera must be overhead. Camera frame rate 
must be at least 25 fps with no missing frames. 
Cannot work together with Deep learning-based 
tracking. The PC must be a workstation.

See Behavior Recognition: Requirements

Deep learning for 
nose-tail base 
tracking

One or two 
subjects per arena 
(up to 4 arenas) 

See Deep learning: Requirements
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For more information
Manuals
For all the other manuals, click the following link:

EthoVision XT 18 Other Documentation

Or from the Windows Start menu, choose All Apps > Noldus > EthoVision XT 18 
Other Documentation.

For EthoVision XT:

▪ EthoVision XT 18 - Quick Start Guide.pdf
Recommended when you use EthoVision XT for the first time. It also comes 
with the software, printed on paper. The Quick Start Guide is also available 
in four languages: German, French, Italian, and Spanish.

▪ EthoVision XT 18- Application Manual.pdf
This manual shows you how to use EthoVision XT with standard tests like 
the Morris water maze test, the Novel Object test and the Sociability/Social 
novelty test, but also complex setups like Optogenetics and Calcium 
Imaging.

▪ EthoVision XT 18 - Trial and Hardware Control - Reference Manual.pdf
An extensive manual about controlling external devices and creating 
complex routines within EthoVision XT.

For PhenoTyper:

▪ PhenoTyper - EthoVision XT 18 - Reference Manual.pdf
▪ PhenoTyper - EthoVision XT 18 - Service Manual.pdf

For DanioVision:

▪ DanioVision DVOC-0041 - EthoVision XT 18 - Reference Manual.pdf
You can also find all manuals on the MyNoldus portal. 

my.noldus.com

Sample experiments
On the download page of EthoVision XT you can find all the documentation listed 
above and sample experiments. Open a sample experiment to see how a specific 
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test, for example the Morris water maze test, or the Novel Object Recognition test, 
is conducted in EthoVision XT.

Browse to

my.noldus.com

Click Downloads, then EthoVision XT and then Sample Experiments. Note that to 
access the MyNoldus pages you must register and log in.

Help menu

Choose Help > ...

▪ Help Topics. Opens this Help.
▪ Video Tutorial. The Video Tutorial explains how to set up an experiment in 

EthoVision XT and shows useful examples of how to adjust various settings.
▪ Noldus Online. If your computer is connected to the Internet, you can 

choose this option to go to the EthoVision XT home page, check for 
updates, contact Noldus Support or consult the EthoVision XT knowledge 
base. If you encounter a problem with EthoVision XT, choose Report an 
Issue. The EthoVision XT home page contains all kinds of information about 
the program as well as examples of how EthoVision XT is used.

▪ Upgrade. See Upgrade EthoVision XT.
▪ About EthoVision XT. Choose this option to see details of exactly which 

version of EthoVision you are using, the end-user license agreement and 
the copyright notices for third-party software.

Information messages
In some parts of the program you see an “i” icon next to specific features. Click the 
icon to know more about this feature.
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Noldus Support
If you have any problems, questions, remarks or comments, please let us know. You 
can contact us at our support page:

my.noldus.com

We offer 24 hour support in various time zones. 

Before you contact Technical Support, please have the following information 
available. To find this information, go to the Help menu and select About 
EthoVision XT:

▪ The version number of your copy of EthoVision XT.
▪ The name of the registered user of EthoVision XT (click License Info).
▪ The license number of your copy of EthoVision XT (click License Info).

Our Technical Support department may request a log file and/or a dump file when 
answering your support question. Please see File locations.

Other contact information
Browse to 

www.noldus.com/about-noldus/meet-noldus

Make a PC report for Support
This section is needed if Noldus Support has asked you to send a PC report for the 
EthoVision XT computer. 

1. Download the SIW utility as indicated by Noldus Support and save it to the 
EthoVision XT computer.

2. Double-click on the file called siw64.exe.
3. Choose File > Create Report File > HTML Report.
4. Save the HTML file to your Desktop.
5. Send the HTML file as an e-mail attachment to Noldus Support.
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Send video material to Noldus
In order to provide adequate support, it is possible that we request you to supply us 
with video recordings made by your organization. Since May 25th 2018 the new 
GDPR rules apply to all people in the EEA (EU + Norway, Iceland and Liechtenstein). 
For this reason we need your signed consent that you agree with the fact that you 
have given us permission to use these video recording(s). Please be aware that the 
person(s) who are recognizable in the video also has/have to give consent that the 
video is sent to Noldus Information Technology BV and our technology partners, 
and that it is your responsibility to arrange this consent. More information 
regarding our Privacy policy can be found at:

https://www.noldus.com/legal/privacy-policy.

NoldusCare
Your license of EthoVision XT comes with a standard service package of one year. 
This includes a one-year period of free technical support. With NoldusCare you 
make sure that you work with the latest version of your software, based on input 
from our worldwide customer base. Updates, upgrades and new releases are 
available for free. As well as update meetings, where you can discuss new features 
with a Noldus consultant. For more information, see our web page:

Browse to

my.noldus.com

and select NoldusCare.
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The EthoVision XT screen
Learn about

▪ Screen components

What do you want to do?
▪ Customize your EthoVision XT screen
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Screen components
The EthoVision XT interface is made of three main elements: the menu bar (A), the 
Experiment Explorer (B), and the Working area (C).

When you click an item in the Experiment Explorer, the Working area shows the 
elements related to that item. 

Use the Show/Hide button at the top-right corner to specify which windows and 
other elements in the Working area you want to show.
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Menu bar
Throughout this Help, instructions like “Choose File > Open...” refer to menu items. 
The three menus Setup, Acquisition and Analysis contain the same functions as 
the Experiment Explorer.

With the View menu you can show or hide the Standard toolbar, the Experiment 
Explorer and the Status bar.

The Experiment Explorer
The Experiment Explorer helps you keep an overview of your experiments, including 
your data and the settings used for tracking. It consists of three main items: Setup, 
Acquisition and Analysis.
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▪ Expand and collapse. Click an item to view its components.
▪ View or hide. By default, the Experiment Explorer is visible. To hide it, 

choose View and deselect Experiment Explorer.
▪ Auto hide. You can minimize the Experiment Explorer by clicking the Auto 

hide button in its upper-right corner.

To expand the Experiment Explorer s again, hover with your mouse over the 
minimized Experiment Explorer on the upper-left corner of your screen. To 
expand it permanently, click the Auto hide button once more. 

▪ Right-click menus. Most items in the Experiment Explorer have right-click 
menus to access key functionality. For example, to create a new settings 
profile.

Other tools
The Working area shows specific toolbars, which depend on the function that is 
currently open. For example, when you open the Arena Settings, this toolbar 
includes the tools for drawing arenas and zones.
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The Standard toolbar includes icons for basic functions like creating and opening 
experiments, saving and copying-pasting. To view the Standard toolbar, choose 
View > Standard Toolbar.

The Status bar is located at the bottom of the screen. It gives information about the 
status of some keyboard keys: Caps Lock, Num Lock and Scroll Lock. To view the 
Status bar, choose View > Status Bar.
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Customize your EthoVision XT screen
To show and hide windows and other elements
Click the Show/Hide button at the top-right corner of the screen. 

The menu options that appear are related to the current phase of the experiment. 
For example, during acquisition, choose Show/Hide > Detection Features and 
choose in which colors to show the subject being tracked.

To position and resize the windows
By default, all the windows on your screen are docked. You can change their 
position and resize them according to your needs.

To position a window

To re-position a window, click its title bar and drag it to the new position. To undock 
a window, click its title bar and drag it anywhere until you see its margins no longer 
constrained by other windows. Docking icons appear, to show you where you can 
position the undocked window.
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If you hover with your window over one of the docking icons, the new position of 
the window is shown in blue. 

If you release the window, the window is positioned at the chosen location. 

To resize a window

Hover the mouse on one of its margins until the cursor changes to this symbol:

Next, drag the margin to the desired position.
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Software Installation

Main topics and tasks
▪ System requirements  53
▪ Install EthoVision XT  66
▪ License activation  80
▪ Upgrade EthoVision XT  97
▪ Preferences  103

See also

▪ Camera Installation  1266
▪ End-user license agreement  113

NOTE  Complete your experiments and make a backup of all of them before 
installing the new version.
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System requirements
Before you install EthoVision XT
If you ordered a computer from Noldus Information Technology when you 
purchased EthoVision XT, the software and any internal hardware has already been 
installed and tested.

If you did not order a computer, you must install EthoVision XT from the MyNoldus 
portal. See the Welcome Letter for more information. 

Prior to installation, please check the packing list to make sure all the components 
are present. If any of the components listed is missing or damaged, please let us 
know.

The contents of your package differ for new and existing users:

▪ If you are a new EthoVision XT user, you received a printed Quick Start 
Guide and a Software Activation Key.

▪ If you are upgrading from older versions of EthoVision XT, you received a 
printed Quick Start Guide and an Software Upgrade Key to upgrade your 
current license. See Upgrade EthoVision XT

Learn about
▪ Operating system
▪ Hardware
▪ Network and user rights

See also

▪ Restrictions in EthoVision XT
▪ Camera Installation
▪ EthoVision XT and Quality Assurance
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Operating system
Windows version
EthoVision XT 18.0 supports Microsoft Windows 11 Pro and was tested with 
Windows 11 Pro, 64 bits, version 23H2.

NOTE  EthoVision XT 18 was also installed on Windows 10 Pro, version 22H2 and 
Windows 11 Pro, version 24H2 for short tests unrelated to the assessment of 
tracking performance with specific camera configurations. Although we did not 
report any significant issue, Noldus cannot guarantee that the same performance 
as on Windows 11 can be obtained on these versions when using a specific camera 
configuration. See Resolution, frame rate, and maximum trial duration

EthoVision XT is not designed for use with the Touch features of Windows.

User rights
To install EthoVision XT, you must have administrator rights. In other words: either 
you are the system administrator or you are a member of the Windows group 
Administrators and have been assigned administrator rights.

IMPORTANT  We recommend to turn off automatic updates for device drivers. See 
Turn off automatic updates for device drivers

IMPORTANT  We also recommend not to use a comma as decimal separator in the 
Windows regional settings. To check the regional settings, in Windows choose 
Apps > Windows System > Control Panel. Under Clock, Language and Region 
click Change date, time or number formats, then click Additional settings.

Language support
EthoVision XT has also been tested with Cyrillic, Japanese and Chinese language 
packs. 

Like any software package, it remains possible that minor differences in the 
operating systems of certain local language versions may affect how well the 
program runs. If you encounter a problem of this sort, please contact Noldus 
Technical Support.

Windows Update
There have been cases of EthoVision XT trials being interrupted by forced Windows 
Update. It is not straightforward to prevent unwanted updates during data 
acquisition, especially in Windows 11. If you plan to do long data acquisition 
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sessions (e.g. 24+ hours), an easy solution is to disconnect the EthoVision XT 
computer from the network and restart it before starting the new acquisition 
session.
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Hardware
Computer
EthoVision XT has been tested with the workstations listed below. If you order a 
complete solution from Noldus Information Technology, you will obtain one of 
these computers or its successor, with EthoVision XT installed and ready to use. See 
also Ordering a PC from another supplier

Dell Precision 3680 desktop

▪ Processor: Intel Core i7-14700, 20 CPU cores, 3.4 GHz.
▪ Internal memory: 32 GB DDR5.
▪ Hard disks: M.2 1TB PCIe NVMe SSD.
▪ Graphics card: NVIDIA T1000, 4 GB GDDR6.
▪ PCIe slots (full-height): 1x Gen5 PCIe x16, 1x Gen3 PCIe x4, 1x Gen4 PCIe x4 

(open-ended)   
▪ Operating system: Windows 11 Pro.

Dell Precision PCs are recommended when tracking subjects with the Deep learning 
method. See Deep learning: Requirements

Dell 3591 mobile

▪ Processor: Intel Core Ultra 7 155H vPro Essentials, 16 cores, up to 4.8 GHz
▪ Internal memory: 16 GB DDR5.
▪ Hard-disks: M.2 2280 1 TB PCIe NVMe SSD.
▪ Graphics card: NVIDIA RTX 1000, 6 GB GDDR6.
▪ Operating system: Windows 11 Pro.

Ordering a PC from another supplier
If you choose to order a PC from a supplier other than Noldus or its distributors, 
you can use the above specifications as a guideline. 

Use a professional workstation

We recommend that you use a professional workstation. It is possible to buy 
consumer-range computers with a high processor speed and plenty of memory, but 
in order to remain competitive regarding price, the manufacturers often economize 
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on the underlying system architecture. That means those computers are suitable for 
home use, but not for running professional scientific software. You should select a 
computer which is intended for professional use or labeled by the manufacturer as 
a workstation.

Desktop or laptop?

▪ If you plan to purchase a desktop computer, always choose a tower mid-size 
or full tower size. Do not use mini or small form factor desktops. When in 
doubt, ask your Noldus representative.

▪ If you plan to use a laptop or a desktop with an unpowered network 
interface board (also known as network interface card, NIC), you need a 
Power over Ethernet Injector to power a GigE camera. 

▪ If you plan to use analog cameras (e.g. for PhenoTyper 1), you need a 
desktop computer with at least one PCI slot.

▪ The Ethernet interface board should support data transfer of 1 Gb/s (one 
port).

▪ If you plan to use a laptop, please consider the following:
▪ Only one camera is supported. The laptop must have a Ethernet port; a 

USB-Ethernet adaptor won’t work.
▪ There may be restrictions in terms of maximum resolution and/or 

maximum recording time. Check carefully what has been tested. See 
Cameras supported by EthoVision XT

▪ Always acquire data with the laptop being plugged in. In Windows, 
click Settings, then type power. Click Power, sleep and battery 
settings. Next, click Screen and sleep. Next to When plugged in, put 
my device to sleep after select Never.

Intel processor (CPU)

We strongly recommend to use a computer with Intel x64-compatible processors, 
Intel Xeon or i7 CPU. In Intel processors the acceleration required by the IPP 
(Integrated Performance Primitives) software is guaranteed. That may not be the 
case for other manufacturers which offer high-quality and fast processors.

IPP is an extensive library of ready-to-use, domain-specific functions. It is used by 
EthoVision XT during image processing and data acquisition. IPP therefore affects 
performance of video-tracking. Processors from other manufacturers are 
compatible with EthoVision XT, but tracking could be significantly slower. Consider 
this when you plan to purchase a computer to acquire large amount of data from 
high-resolution video, or analyze video with Behavior Recognition or Deep learning.
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▪ Other processors such as AMD may well work with the IPP although Noldus 
does not support them. Always test your computer thoroughly before 
running the actual experiments.

▪ EthoVision XT won’t work on Qualcomm / ARM chips.

Important factors to keep in mind

▪ The more animals and arenas you track, the more processor load you 
require.

▪ Nose-tail tracking requires more processor load than tracking the center-
point only.

▪ The optimal sample rate depends on the species you track. Mice, e.g., 
require a higher sample rate than rats. See Sample rate for more 
information about the optimal sample rate.

▪ A larger image requires more computer resources for tracking, so a larger 
image does not necessarily lead to better tracking.

RAM Memory

▪ For desktop computers, we recommend a 32 GB RAM Memory.
▪ For laptops, a 16 GB RAM Memory should suffice.

USB 3.0 port

Current PCs have USB 3.x ports standard installed. USB ports are necessary if you 
use a USB 3.0 camera. See Install USB 3.0 cameras

If you use hardware like the USB-IO box, you need an additional USB port.

Power supply unit (PSU)

Powerful graphics cards need additional power. Ensure that the computer has a 
Power Supply Unit (PSU) that can provide enough power to the graphics card. Take 
note of the Suggested PSU of a specific card and make sure the PC can handle that. 
See also More information on graphics cards (GPUs) and Install a graphics card for 
Deep learning

Virtual machines

Virtualization allows you to run different operating systems on the same computer. 
However, EthoVision XT was not designed to work on a virtual machine, therefore 
its use on virtual machines is not supported.
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Ethernet interface board
In order to use high-quality GigE cameras, your computer must have a 1 Gb 
Ethernet Interface Adapter (board), also known as Network Interface Card 
(abbreviated NIC). Depending on the number of Ethernet ports you can connect 
one to four cameras per board. The following boards have been tested successfully:

▪ CT1000 Pro (1 camera)
▪ Adlink PCIe-GIE74 (1-4 cameras)
▪ Basler GigE Interface Card, 4 port PoE (1-4 cameras)
▪ FS X550AT2-2TP (1-16 cameras)

Make sure that the board has the necessary number of ports when you use multiple 
cameras. See Install an Ethernet board for GigE cameras and Using multiple GigE 
cameras

If you have a laptop, you can connect only one GigE camera. The Ethernet port of 
your laptop will be the dedicated camera port. If you want to connect the laptop to 
the internet, you need to use a Wi-Fi connection. Note that if your laptop has a USB 
port with a Ethernet-USB adapter, instead of an Ethernet port, that may not work 
with GigE cameras.

Power over Ethernet (PoE) injector
If you bought your GigE camera elsewhere and you are not using an Ethernet board 
powered from the PC, you need a Power over Ethernet (PoE) injector to power the 
camera. In all cases it must be a Gigabit PoE injector.

USB 3.0 interface boards
See Install the USB 3.0 interface board.

Graphics card for deep learning-based tracking
If you intend to use the Deep learning technique for nose- and tail-base detection, 
you need a powerful NVIDIA Graphics Processing Unit (GPU). GPUs other than 
NVIDIA would not work due to lack of compatibility with the NVIDIA TensorRT 
software component. For suggestions, see Deep learning: Requirements.
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IMPORTANT  Make sure to install latest driver for your graphics card.

Monitor
Your monitor should be set to at least 24 bit color depth. If you use a dual monitor 
set-up, both monitors should be at least 24 bit. To check the color depth, search for 
Display in Windows or open the graphics control panel of your display. 

Camera
For a list of the camera models currently supported, see Camera Installation.

If you would like to use another type of camera, please check with your nearest 
Noldus representative first.

IMPORTANT  For correct functioning of cameras, we recommend to turn off 
automatic updates for device drivers. See Turn off automatic updates for device 
drivers

Disk space to store video files
If you are tracking from video files, you need sufficient free disk space to store 
them. You need to be especially aware of the disk space when you let EthoVision XT 
save videos while you carry out batch acquisition and for long recordings. See 
Video file size

If your video files are on a DVD or network drive, first copy them to your hard disk 
drive before loading them in EthoVision XT.

External hard disk drives
▪ For tracking. We do not recommend that you do tracking from video files 

that are stored on an external hard disk. Always store the video files on the 
hard disk of the EthoVision XT computer.

▪ For video playback. Once you have done tracking, you can store the video 
files on an external hard disk. When you want to review the video in the 
Integrated Visualization (see Plot integrated data) EthoVision XT asks you 
to locate the video files if it does not find them in the default experiment 
location on the hard disk. Select the folder on the external hard disk where 
the video files are stored. You can also instruct EthoVision XT to look for 
video files in an alternate folder. See also Preferences for default folders 
NOTE  Video might sometimes not play smoothly depending on the size of 
the video file and the speed of data transfer from the external hard disk.
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See also

▪ System requirements
▪ Restrictions in EthoVision XT
▪ How to prevent Missed samples
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Network and user rights
Using EthoVision XT across a network
Please note that it is not possible to install EthoVision XT on one computer and 
access it from another across a local area network. The program must be installed 
on the computer where it will be used. However, you can work with EthoVision XT 
remotely using one of the remote control applications like TightVNC or 
TeamViewer. See Work with EthoVision XT remotely

You can track from video files stored at other computers in your network 
(depending on your network's bandwidth), although we recommend to copy the 
file to you hard disk before tracking. To let EthoVision XT know where to find the 
video files, choose File > Preferences and select the location on the network in the 
Alternative media location field.

Working with EthoVision XT as a restricted user
The user rights for folders and files are different for System administrators, Power 
users, and restricted (normal) users. Users who have Administrator rights and Power 
users have enough access rights to use EthoVision XT and its files without any 
limitations. 

For restricted users the following limitations apply:

▪ As a restricted user you can create new experiments and view, edit and 
delete your own experiments.

▪ If you want to make it possible for other users to edit or delete your 
experiments, your system administrator must change the Windows security 
rights for the folder that contains the experiments. By default this folder is 
C:\Users\Public\Public Documents\Noldus\EthoVision XT\Experiments. 
For instance, to set the Modify rights to Everyone: in the Windows Explorer, 
select the folder mentioned above, right-click it, select Properties and then 
the Security tab and set the rights.
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Work with EthoVision XT remotely
Aim
You can use utilities like TightVNC or TeamViewer to control EthoVision XT fully 
remotely. 

Prerequisites
▪ When using a hardware key, remember to leave the hardware key plugged 

in the EthoVision XT computer before you leave work if you need to acquire 
data (i.e., do tracking). However, if you only need to do post-acquisition 
data analysis and export, you do not need to leave the hardware key 
inserted. This may actually free up the hardware key to be inserted in 
another computer at work running EthoVision XT so another user can use it 
for data acquisition. See EthoVision XT in analysis mode

▪ When using a software license, make sure that the license on the EthoVision 
XT computer is active. See Activate your EthoVision XT license

Procedure
1. Leave the EthoVision XT computer running.
2. On the remote computer use a utility to access EthoVision XT on that PC.
3. Only one user can access a remote EthoVision XT computer at any one 

time. Of course you can install EthoVision XT on multiple PC so multiple 
users can work with EthoVision XT.

TightVNC
www.tightvnc.com/
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IMPORTANT  You must have a VPN connection to the network where the PC you are 
connecting to is located.

1. Download the installer of TightVNC for Windows from the TightVNC 
website and run it on the PC with EthoVision XT. Use the Full install to install 
both the Viewer and the Server. Use the default install, but set the 
passwords for security.

2. Restart the PC, and leave it running in order to be able to connect to it. 
3. Install the Viewer on the PC you want to work with. 
4. Make the connection to the Local Network where the remote computer is 

running.
5. Run the Viewer and type the name or the IP address of the PC you want to 

connect to.

6. Enter the password. You can view the desktop of the remote PC in a 
window.

TeamViewer
www.teamviewer.com

1. Download TeamViewer for Windows.
2. When installing TeamViewer on both the work PC and your remote PC, 

make sure to select Unattended Access.
3. Open TeamViewer on the workplace PC. On the General tab under 

Unattended Access, select Start TeamViewer.
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4. Write down the Partner ID (or Your ID) and Password (or take a photo of the 
screen).

5. Before leaving your work place, launch TeamViewer and leave it running.
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Install EthoVision XT
Please read this first

▪ Installing EthoVision XT 18 but does not replace previous versions, for 
example EthoVision XT 17. 

▪ You can keep working with both versions. However, if you have completed 
your experiments in the previous version, you can uninstall that previous 
version. 

▪ We recommend that you complete your experiments and make a backup of 
all of them before you open them in a new version of the software. See Back 
up an experiment

▪ Removing or installing EthoVision XT does not remove your experiments 
and data already stored on that computer.

What do you want to do?
▪ IMPORTANT  Turn off automatic updates for device drivers
▪ IMPORTANT  Disable fast startup
▪ IMPORTANT  Disable the Power save options
▪ Install EthoVision XT

See also

▪ Uninstall EthoVision XT
▪ Upgrade EthoVision XT
▪ Read the End-user license agreement
▪ Acknowledgments and copyright notices
▪ EthoVision XT trial version
▪ Uninstall EthoVision XT
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Turn off automatic updates for device 
drivers
Aim
To make sure EthoVision XT works with the drivers that were tested by Noldus.

Although the general recommendation from Microsoft to use automatic updates is 
good, especially for security updates, automatic updates of hardware device drives 
can sometimes give problems. Follow this procedure to specifically turn off the 
automatic updates only for device drivers.

Procedure
1. Click the Windows Start menu and type change device.
2. Click Change device installation settings in the search results under Best 

match.
3. In the Device installation settings window, select No (your device might 

not work as expected).
4. Click Save Changes.

Note
There have been cases of EthoVision XT trials being interrupted by forced Windows 
Update. It is not straightforward to prevent unwanted updates during data 
acquisition, especially in Windows 11. If you plan to do long data acquisition 
sessions (e.g. 24+ hours), an easy solution is to disconnect the EthoVision XT 
computer from the network and restart it before starting the new acquisition 
session. Do not forget to recover internet connection after you complete your trials.

See also

▪ Disable fast startup
▪ Disable the Power save options
▪ Install EthoVision XT
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Disable fast startup
Aim
To disable the Fast startup option in Windows 10/11, which can have adverse effect 
on EthoVision XT performance.

Procedure
1. Click the Windows Search icon on the taskbar and enter control panel. 
2. Click Control Panel, choose System and Security > Power options. 
3. Click Choose what the power buttons do in the upper left corner.
4. Click Change settings that are currently unavailable (this may require an 

administrator password).
5. De-select the options Turn on fast start-up, Sleep, and Hibernate.

See also

▪ Turn off automatic updates for device drivers
▪ Disable the Power save options
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▪ Install EthoVision XT
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Disable the Power save options
Aim
To prevent that the computer is put to sleep or the hard disk is turned off during 
tracking.

Procedure
1. Click the Windows Search icon on the taskbar and type edit power plan.
2. Click Edit power plan when it appears in from the search results.
3. Click Change advanced power settings.
4. Under Hard disk > Turn off hard disk after, select 0 (Never). For laptops, 

select Never for both On battery and Plugged in.
5. Click OK.

See also

▪ Turn off automatic updates for device drivers
▪ Install EthoVision XT
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Install EthoVision XT
Please read this first

▪ Installing EthoVision XT 18 but does not replace previous versions (that is, 
EthoVision XT 17 and earlier). If you want to remove previous versions, do 
so in the Windows Control Panel > Programs and Features.

▪ Close all other programs before installing EthoVision XT and turn off the 
screen saver and power save options. Check that programs do not run in 
the background (look in the system tray at the bottom right of your screen).
We recommend to follow these procedures: Disable the Power save 
options, Disable fast startup, Turn off automatic updates for device drivers 

▪ IMPORTANT  For users of Quality Assurance: If you have added EthoVision XT 
users in User Management and re-install the software, those users and their 
rights are deleted.

Procedure
1. Browse to the MyNoldus portal:

https://my.noldus.com/download/latest/ethovision-xt

Log in or register (if you are a new user you can use the registration code 
which you can find on the Welcome letter).

2. Click Versions and download the EthoVision XT - Installation Package 
[version number].zip. Save th zip file on your PC. 
NOTE  The Installation Package is a very large file; download may take some 
time.

If you store the zip file on a network drive, copy it to your PC before the 
next step.

3. Unzip and extract the files on your computer. 
The zip file contains six installation files: 

▪ EthoVision XT - Setup - [version number].exe
▪ EthoVision XT - Package - [version number].msi 
▪ Tracker Interface NN - x64 Package - [version number].msi
▪ Tracker Interface NN - x64 Cabinet - [version number]- 01.cab
▪ Tracker Interface MST - x64 Package - [version number].msi
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▪ Tracker Interface MST - x64 Cabinet - [version number]- 01.cab
4. Double-click EthoVision XT - Setup - [version number].exe.
5. Select the interface language. You have the choice between English 

(United States) and Chinese (Simplified).
6. Under Installation type, select Standard.Then click Next.

Select Custom if you want to specify the location for the program and the 
experiments other than those selected by default.

Application location: C:\Program Files\Noldus\EthoVision XT 18. 

Experiments location: C:\Users\Public\Public Documents\Noldus\ 
EthoVision XT\Experiments

IMPORTANT  Do not select a removable disc, like a USB memory drive, as the 
experiments location.

7. Under Drivers and Tools, select the drivers you want to install. 
If you have USB 3.0 cameras, choose Basler USB camera driver.

If you have GigE Vision cameras, choose Basler GigE camera driver.

If you have analog cameras, choose Euresys Multicam. This works with the 
Picolo Alert encoder board.

NOTE  If you need to re-install the drivers for your camera, you can find 
them on the MyNoldus support portal. See also Install the driver software 
for the digital cameras

8. Click Next. Read the end-user license agreement. Select I agree with the 
End-User License Agreement and click Install.

9. When the message Installation is complete! appears, click Close.

Notes
▪ To view the manuals other than the EthoVision XT Help, you need a PDF 

reader like Acrobat Reader or Foxit Reader.
▪ To uninstall EthoVision XT, do this from the Control Panel. See Uninstall 

EthoVision XT

See also

▪ Software components installed with EthoVision XT
▪ Camera Installation
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▪ End-user license agreement
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Software components installed with 
EthoVision XT
Components installed automatically
The following components are installed automatically when you install EthoVision 
XT:

Name EthoVision XT 18 EthoVision XT 17.5
Noldus - Basler Pylon Interface - x64 
Package - 1

1.1.12 1.1.10

Noldus - Chart Wrapper Control - x64 
Package - 3

3.0.6 3.0.4

Noldus - Data Storage Converter - x86 
Package - 1

1.0.10 1.0.8

Noldus - Frame Counter - x64 Package - 2 2.0.2 -

Noldus - HardwareInterface IoBox - x64 
Package - 5

5.1.16 5.1.10

Noldus - HardwareInterface UgoBasile - 
x64 Package -1

1.0.14 1.0.10

Noldus - ImporterInterface LMT - x64 
Package - 1

1.0.8 1.0.6

Noldus - IPP - x64 Package - 8 8.2.4. 8.2.2

Noldus - LeadTools - x64 Package - 21 21.0.14 21.0.8.0

Noldus - MBRM Interface - x64 Package - 2 2.0.6 1.3.2

Noldus - MediaLooks ScreenCapture - x64 
Package - 2

2.0.4 2.0.4

Noldus - ParameterInterface LMT - x64 
Package - 1

1.0.10 1.0.8

Noldus - RBRM Interface - x64 Package - 2 2.0.6 1.3.2

Noldus - Resizer Filter - x64 - Package - 13 13.1.10 13.1.6

Noldus - SampleGrabber - x64 Package - 
15

15.0.4 14.0.2

Noldus - Tracker Interface NN - x64 
Package - 2

3.0.8 2.0.10

Noldus - Tracker Interface MST - x64 
Package - 1

1.0.12 -
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To view the components currently installed on your computer, from the Windows 
Start menu choose Settings > Apps > Apps & features. Sort the list by install date 
and locate the items installed with EthoVision XT.

(*) Not installed if a newer version is already present on the PC.

Additional components
The list of components under Apps and features also includes camera drivers and 
drivers for the PCIe interface boards. These are usually installed when you install 
EthoVision XT. See also Cameras supported by EthoVision XT 

(*) You need this component to be able to control hardware devices through a serial 
(COM) port. You find this component on the EthoVision XT full installation disk, 
under Drivers and tools. For more information, see Set the port connections for 
COM ports in the EthoVision XT 18 - Trial and Hardware Control - Reference 
Manual.

Notes
▪ To view the components currently installed on your computer, from the 

Windows Start menu choose Settings > Apps > Apps & features. Sort the 
list by install date and locate the items installed with EthoVision XT.

▪ There may be components installed with previous EthoVision XT versions:
▪ Noldus MainConcept Encoder Package 7.7 (for recording video)
▪ Noldus MainConcept Codec Package 8.5.34 (for playback of video files)
▪ Noldus MediaLooks AV Filter 5.0.1.0.
▪ Components similar to those listed in the first table above, but with 

lower version number (e.g. Sample Grabber 13). 

Sentinel Runtime 8.11 8.11

Microsoft Visual C++ 2015-2019 
Redistributable (x64) / (x86)

14.29 (*) 14.29

Name Version number
pylon 7 Camera Software Suite 7.5.0.15658

Daheng Galaxy SDK 1.12.2102.9251

Euresys MultiCam 6.15.1.3573

Noldus - HardwareInterface SerialPort - x64 Package - 1 (*) 1.1.6
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Please keep them only if you still use previous versions of EthoVision XT. 
The MainConcept software has been replaced by the LeadTools software in 
EthoVision XT 16 and 17.

▪ To add a component, like a camera driver, or the video tutorial, that is not 
installed yet on your computer, double-click the file EthoVision XT - Setup 
- [version number].exe (see Install EthoVision XT) and select Custom, then 
Modify. Select the component you require and click Update.

▪ The Euresys Picolo U4/U8 H.264 encoder boards are no longer supported 
with EthoVision XT. Those boards do not work on 64-bit software.

See also

▪ Camera Installation
▪ End-user license agreement
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EthoVision XT trial version
Aim
To evaluate the full functionality of EthoVision XT for a limited period of time (14 
days).

Prerequisites
▪ You have received a Software Activation Key from your Noldus Sales 

Representative.
▪ You have downloaded and installed the EthoVision XT trial version. You can 

find the installation files on:
https://www.noldus.com/download/trial-download-ethovision-xt

▪ By downloading the trial version you agree:
▪ That you shall only use the trial version to review EthoVision XT.
▪ That you shall not acquire data that you use to produce scientific 

research and/or publication.
▪ That you shall not hand over or sell the trial version to a third party.

To start a trial version
1. Start EthoVision XT. A message appears that no valid license key is 

detected.
2. Click Activate software license key.
3. Choose whether to activate a Computer-locked license or a Floating license. 

See Types of EthoVision XT license
4. Activate Online is automatically selected as that is the only option 

available. Type in the Activation key that you received and click OK.

Notes
▪ The EthoVision XT trial version is fully functional and includes all add-on 

modules as the full license, like Multiple Arenas, Social Interaction and 
Behavior Recognition, except the Quality Assurance Module and Track3D. 
See Modules of EthoVision XT

▪ To check the number of days left for evaluation, choose Help > About 
EthoVision XT. When the trial period is over, a message is shown.
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▪ Experiments from the EthoVision XT trial version cannot be opened in 
previous versions of EthoVision XT.

See also

▪ Install EthoVision XT
▪ Activate your EthoVision XT license
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Uninstall EthoVision XT
Aim
To remove EthoVision XT, drivers and other components from the computer.

NOTE  If you have a computer-locked license or a floating license and want to use 
that license somewhere else, first deactivate the license, then uninstall EthoVision 
XT. Deactivate an EthoVision XT license

Procedure
1. In the Windows Search screen, search for programs, or apps and select 

Programs and Features or Apps and Features (depending on the 
Windows version). 

2. In the Programs/Apps and Features window, select EthoVision XT 18 and 
click Uninstall.

3. To make a complete uninstall, also select and uninstall each of the 
components installed with EthoVision XT. Sort the programs list by 
Installed On and look for the components installed on the same day as 
EthoVision XT. See Software components installed with EthoVision XT in the 
topic Install EthoVision XT.

Notes
▪ When you uninstall EthoVision XT, the your software license stays on that 

computer. So if you re-install the software on that computer you do not 
have to re-activate it.

See also

▪ Install EthoVision XT
▪ See the list of Software components installed with EthoVision XT
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License activation
What do you want to do?

▪ Activate your EthoVision XT license
▪ Deactivate an EthoVision XT license
▪ Software license - offline
▪ Turn a floating license to a computer-locked license
▪ Turn a computer-locked license to a floating license

Learn about
▪ Types of EthoVision XT license
▪ Duration of the EthoVision XT license
▪ EthoVision XT in analysis mode
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Activate your EthoVision XT license
Aim
To activate an EthoVision XT license after purchase. Note that you do not need to 
follow this procedure if your license is on a USB hardware key.

If you have already an EthoVision XT license and you purchased a new add-on 
module, see Add new modules to your license

Background information
When you start EthoVision XT, the software checks that your license is valid. The 
license may be stored in your hardware key (dongle), in your EthoVision XT 
computer (Computer-locked license) or in the Noldus server (Floating license). See 
Types of EthoVision XT license

If no valid license is found, you can activate your license by following the procedure 
below. 

Important terms

Activation key

An activation key is provided by Noldus to activate your license. You find an 
activation key on a letter or e-mail sent to you.

Computer key

A Computer key comes into play when you activate your license offline (see below), 
This is a key that identifies the computer that you are using during activation.

License key

A license key is the unique piece of information that you obtain after you activate 
the license. You can find this key in EthoVision XT, by choosing Help > About 
EthoVision XT > License Info. See Types of EthoVision XT license

Computer-locked license

This is a license that is bounded to a specific computer. It is a fixed-seat license 
intended to be used for long time in the same location. However, when necessary, 
you can easily transfer this license to another computer. See Types of EthoVision XT 
license
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Floating license

This is a license that is not associated with a specific computer. It is intended to be 
used in multiple computers, although not simultaneously, for example, in one PC at 
the lab and one or more PCs in the office. See Types of EthoVision XT license

Prerequisites
▪ You have installed EthoVision XT. See Install EthoVision XT
▪ You have received a license Activation Key from Noldus. Contact Noldus 

Support
▪ If your license is stored in a hardware key (dongle), you do not have to 

follow this procedure. Simply plug in the key in a USB port of your PC.

What do you want to do?
▪ Activate a floating license

Use a license on different computers at different times. However, if you 
have two or more floating licenses instead of one, you can use EthoVision 
XT on multiple computers simultaneously. For this type of license you need 
an internet connection.

▪ Activate a computer-locked license - online
Your license is coupled with a specific computer. Activate your license 
online. You need an internet connection during activation.

▪ Activate a computer-locked license - offline
Your license is coupled with a specific computer. The computer does not 
have to be connected to the internet, but you need a smartphone or tablet 
with an internet connection during activation.

NOTE  This option is not available if you have purchased a time-limited 
license or received a license for a free trial. See Duration of the EthoVision 
XT license

Activate a floating license
IMPORTANT  You can only activate and use a floating license when your EthoVision 
XT computers are connected to the internet. So make sure that your EthoVision XT 
computer in the lab is always connected.

Follow these steps for each computer.

1. Make sure that your EthoVision XT computer is connected to the internet.
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2. Start EthoVision XT.
3. In the window that appears, choose Use the software activation key and 

click Continue.
4. Choose Floating license - Online connection required and click 

Continue.
5. Enter or copy the activation key that you received from Noldus. 

6. Click Continue. 
7. When the license has been activated, a message appears.

Repeat the procedure on the other computers.

Activate a computer-locked license - online
1. Make sure that your EthoVision XT computer is connected to the internet.
2. Start EthoVision XT.
3. In the window that appears, choose Use the software activation key and 

click Continue.
4. Choose Computer-locked license - Online activation and click Continue.
5. Enter or copy the activation key that you received from Noldus. 
6. Click Continue.
7. When the license has been activated, a message appears.

Activate a computer-locked license - offline
1. Make sure that you have a smartphone connected to the internet that can 

scan a QR-code.
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2. Start EthoVision XT.
3. In the window that appears, choose Use the software activation key and 

click Continue.
4. Choose Computer-locked license - Offline activation and click Continue.
5. Enter or copy the activation key that you received from Noldus. 
6. A QR code appears on the window. Scan the QR code with your 

smartphone.
If the QR code is recognized, the Noldus License Manager web page opens 
on your smartphone, showing the required Computer Key.

7. Enter this key in the Enter computer key field in the Noldus License 
Activation window.
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8. Click Continue.
9. When the license has been activated, a message appears.

Notes
▪ You cannot activate a term license after the expiration date.
▪ If activation fails:

▪ Try once again and make sure that you enter the correct Activation/
Computer Key, including capital letters and dashes.

▪ Contact Noldus to obtain a valid Activation Key.
▪ If your license is not activated, you can still start EthoVision XT and work in 

Analysis mode. See EthoVision XT in analysis mode
▪ If the license activation window does not appear after starting EthoVision 

XT, it may be that the software is in Analysis mode. To activate/deactivate 
the license, first choose Help > Deactivate License. The window says 
Deactivate Analysis mode. Choose Continue, then restart EthoVision XT. 

▪ See also Upgrade EthoVision XT
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Deactivate an EthoVision XT license
Aim
To deactivate a license, either to end the license agreement or to transfer the license 
to another computer.

EXAMPLE  You have purchased a new computer and you would like to transfer your 
EthoVision XT license from the old to the new computer.

Prerequisites
▪ EthoVision XT is running, and no experiment is open.
▪ The EthoVision XT computer is connected to the internet, or you have a 

smartphone connected to the internet.

What do you want to do?
▪ Deactivate a computer-locked license
▪ Deactivate a floating license

See Types of EthoVision XT license

Deactivate a computer-locked license
1. If an experiment is open in EthoVision XT, close it (File > Close).
2. Choose Help > Deactivate License.
3. Choose Computer-locked and click Continue.
4. Select one of the options depending if your EthoVision XT computer is 

connected to the internet. 
▪ Deactivate online. Do this if your EthoVision XT computer is 

connected to the internet. Select this option and click OK.
▪ Deactivate offline. If your computer is not connected to the internet, 

you need a smartphone connected to the internet, which can scan a 
QR-code. (1) Select this option, and click OK. (2) A QR code appears on 
the screen. (3) Scan this code using a smartphone and follow the link 
within 24 hours. (4) Click Deactivate on the screen that appears in your 
browser.

5. EthoVision XT shows a message that the license has been deactivated and 
closes.
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Note:

▪ If your smartphone is not connected to the internet, leave the link open, go 
to a place where your smartphone is connected to the internet and open 
the linked page. 

▪ When you click Deactivate offline, your license is deactivated on your 
computer, but not yet on the Noldus Server. For this second step you must 
scan the QR code and follow the associated link and click Deactivate on a 
web browser of your smartphone. Do this within 24 hours.

Deactivate a floating license
Deactivate a floating license when you need to transfer that license to another 
computer. Note that, when you have floating licenses, in order to be able to work on 
one computer you just need to close EthoVision XT on the other computer(s). You 
do not need to deactivate the license on the other computer(s).

1. Make sure that the EthoVision XT computer is connected to the internet.
2. In EthoVision XT, choose Help > Deactivate License.
3. A message appears: The license was successfully deactivated.
4. Click Close. You can now activate that floating license on another computer. 

See Activate your EthoVision XT license

See also

▪ Activate your EthoVision XT license
▪ Types of EthoVision XT license
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Turn a floating license to a computer-
locked license
Aim
You may want to turn a floating license to a computer-locked (fixed-seat) license so 
you can use EthoVision XT on a computer without internet connection.

Prerequisites
▪ You have an Activation Key for your license.

Procedure
1. Open EthoVision XT and deactivate the floating license. Here you need an 

internet connection. See Deactivate a floating license
2. After deactivation of the license, EthoVision XT closes.
3. Start EthoVision XT on the computer where you want to have the license 

activated.
4. Choose Activate software license key, then Computer-locked. Follow the 

instructions in Activate a computer-locked license - online.

See also

▪ Types of EthoVision XT license
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Turn a computer-locked license to a 
floating license
Aim
You may want to turn a computer-locked (fixed-seat) license to a floating license 
because you want to use EthoVision XT on multiple computers (although not 
simultaneously).

Note that if you purchased multiple floating licenses, you can work on multiple 
computers simultaneously, because a license will be active in each computer.

Prerequisites
▪ You have the Activation Key for your license.

Procedure

1. Open EthoVision XT and deactivate the computer-locked license. See 
Deactivate a computer-locked license

2. After deactivation of the license, EthoVision XT closes.
3. Start EthoVision XT on the computer where you want to activate the 

floating license. Here you need an internet connection.
4. Choose Activate software license key, then Floating - On multiple 

computers. Follow the instructions in Activate a floating license.

Notes
▪ If you choose to deactivate offline, first click OK, then scan the QR code that 

appears. Follow the link and click/tap Deactivate. 

See also

▪ Types of EthoVision XT license
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Types of EthoVision XT license
There are two main types of EthoVision XT license: 

▪ License on a hardware key
▪ Software license key

In all cases, to know which modules your license has, choose Help > About 
EthoVision XT > License Info.

License on a hardware key
Your EthoVision XT license is stored on a USB key. A USB key looks similar to a USB 
Flash drive, but does not include any disk storage space.

IMPORTANT  Make sure that you do not lose the hardware key! You will need to pay 
for a new license if you do so. Please be careful with the hardware key. It is sensitive 
and can be easily damaged.

In order to use the full functionality of EthoVision XT on either one or the other 
computer, you must plug the hardware key in that computer. 
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Alternatively you can start EthoVision XT without a hardware key plugged in and 
work in analysis mode to analyze the trials already acquired but not acquire new 
trials. See EthoVision XT in analysis mode

Software license key
A software license key allows you to use EthoVision XT without a hardware key 
plugged in your computer.

IMPORTANT  Your software license key is coupled to the hardware of your computer; 
not to a specific user or user group name.

A software license can be of two types: Computer-locked and Floating.

Computer-locked license

This license is meant to be used on a specific computer for long time. It is a fixed-
seat license associated with that computer. This association is registered on the 
Noldus Server.

In order to use a computer-locked license on another computer, you must first 
deactivate that license on the computer where it is currently active. See Deactivate 
an EthoVision XT license
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Floating license

This license is handy when you want to use EthoVision XT to acquire data and video 
on two or more computers (though not simultaneously).

▪ EXAMPLE  Activate a floating license on two computers: one in the lab for 
recording video, and one in the office to acquire the tracks from the 
resulting video files.

▪ If you always record data/video on the same computer in the lab and 
analyze/visualize data on your laptop in the office, a floating license may 
not be needed. You can activate a computer-locked license on your lab’s 
computer to acquire data and video and install EthoVision XT and use it in 
Analysis mode in your office (see below). See EthoVision XT in analysis 
mode

▪ With a floating license you can work on one computer at a time. Make sure 
that EthoVision XT is closed on the computers other than the one you are 
using at that time.

▪ IMPORTANT  In order to work with a floating license, your EthoVision XT 
computer must be connected to the internet. When you close EthoVision 
XT on one computer with a floating license, the license is automatically 
deactivated, at the condition that the computer is connected to the Noldus 
Server. At that point you can start using EthoVision XT on another 
computer.
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▪ With a floating license you can work offline with EthoVision XT for a 
maximum of 90 days. After that, you must re-connect the EthoVision XT PC 
to the internet in order to continue to work with the software or to 
deactivate the license and make it possible to use the license on another 
PC.

Notes
▪ If the hardware key is not plugged in your PC or the software license is not 

activated, you can still start EthoVision XT and work in Analysis mode. This 
means that you can analyze and visualize previously-recorded data, but 
cannot acquire more data. See EthoVision XT in analysis mode

See also

▪ Activate your EthoVision XT license
▪ Modules of EthoVision XT
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Duration of the EthoVision XT license
An EthoVision XT license can be:

Perpetual license 
This is the most common license. You purchase a copy of EthoVision XT on a one-
time basis and can use the software forever.

Time-limited license
This license is generally valid for a period of six or twelve months.

▪ A time-limited license can only be activated online. See Activate your 
EthoVision XT license

Trial license
This is a temporary, free-of-charge license that you can use to evaluate the newest 
version of the software. See EthoVision XT trial version

▪ A trial license can only be activated online. See Activate your EthoVision XT 
license

See also

▪ Types of EthoVision XT license
▪ Activate your EthoVision XT license
▪ Upgrade EthoVision XT
▪ License agreement
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EthoVision XT in analysis mode
Aim
To carry out analysis and visualization of already-existing track data in EthoVision 
XT without a license.

Background information
An EthoVision XT license is needed whenever you acquire new data and record 
video. So it is important to activate a license on the computer that you use to collect 
data. However, you can also install EthoVision XT on other computers without a 
license. If an experiment already contains data, you can open it in EthoVision XT, 
filter data, calculate statistics and make charts and heatmaps.

EXAMPLE  Collect the data in your lab. Copy the experiment to your laptop where 
you have installed EthoVision XT without a license. There you can visualize and 
analyze your data.

Procedure
1. If you have not done so yet, install EthoVision XT on a computer.
2. Start EthoVision XT.
3. If EthoVision XT does not find a valid license, a window opens with the 

message Your license. 
4. Choose Start in analysis mode. 

What you can do in analysis mode
EthoVision XT in analysis mode offers all the functions necessary to refine analysis 
and produce results.

▪ Add new zones and modify existing zones in the Arena Settings.
▪ Edit tracks in the Track Editor screen. For example, remove outliers before 

running analysis.
▪ Create behavioral categories in the Manual Scoring Settings, and score 

those categories manually while reviewing existing video. 
▪ Adjust the Track Smoothing settings.
▪ Create new Data profiles and select data.
▪ Create new Analysis profiles and select dependent variables.
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▪ Use all the analysis functions under Analysis > Results.
▪ Export data and results.
▪ Make a backup of your experiment.

Furthermore you can create new Detection Settings profiles, create new Trial 
Control Settings profiles, and add trials and variables in the Trial List.

Notes
▪ To return to or start a full license, you must first deactivate the analysis 

mode. Close the experiment, then choose Help > Deactivate License, then 
click Continue. Next, restart EthoVision XT. See Activate your EthoVision XT 
license

See also

▪ License activation
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Upgrade EthoVision XT
What do you want to do?

▪ Upgrade EthoVision XT
▪ Add new modules to your license

Read about
▪ Types of EthoVision XT license
▪ Modules of EthoVision XT
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Upgrade EthoVision XT
Aim
To activate the license for a newer version of EthoVision XT.

If you purchased add-on module, see Add new modules to your license

Prerequisites
▪ You have an older version of EthoVision XT (17.5 or earlier) and you have 

just purchased a new EthoVision XT 18 license.
▪ You received a code (named Upgrade Key) from Noldus, either on the 

Welcome letter or by e-mail.
▪ If you have a USB hardware key, insert that in a USB port of your EthoVision 

XT computer.

Procedure
Choose the procedure that applies.

For a software-based license

1. Download and install EthoVision XT from
my.noldus.com.

NOTE  You do not need to uninstall previous EthoVision XT versions.

2. Start EthoVision XT.
3. Choose Activate software license key.
4. Choose whether to activate online or offline and follow the instructions on 

the screen. See also Activate your EthoVision XT license

For a license stored on the hardware key

1. Download and install EthoVision XT from
my.noldus.com.

NOTE  You do not need to uninstall previous EthoVision XT versions.

2. Start EthoVision XT.
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3. Enter the Upgrade Key that you received from Noldus and complete the 
upgrade procedure.

See also

▪ License on a hardware key
▪ Activate your EthoVision XT license
▪ Deactivate an EthoVision XT license
▪ Types of EthoVision XT license
▪ Modules of EthoVision XT
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Add new modules to your license
Aim
To make update your EthoVision XT license after you have purchased one or more 
add-on modules. For example:

▪ The Multiple Arena module.
▪ The Rat Behavior Recognition module.

See Modules of EthoVision XT

Prerequisite
▪ If you have a software license, the EthoVision XT computer must be 

connected to the internet, or you have a smartphone connected to the 
internet.

▪ If you have a license stored on a hardware key, insert the hardware key in a 
USB port of your EthoVision XT computer.

Procedure
Choose the procedure that applies to upgrade your license with new modules.

Software license - online

If your EthoVision XT computer is connected to the internet, the license is updated 
automatically the next time that you start the software. You do not have to take any 
further action.

Software license - offline

1. Start EthoVision XT.
2. Choose Help > Reactivate Offline.
3. In the window that appears, click the Deactivate button.
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4. A QR code appears on the right. Scan that QR code with your smartphone.
5. Tap the link that appears on the smartphone, then on the smartphone tap 

Deactivate.
NOTE  The web page that opens on the smartphone shows your current 
license key and a code that identifies your computer. 

You’ll notice nothing changes after you have clicked Deactivate on the 
smartphone screen. That’s ok.

6. On the computer screen, click Scanned.
7. A new QR code appears. Scan this code and tap the link that appears on the 

smartphone.

8. On the computer screen, next to Computer key, enter the code that 
appears on the smartphone.

9. A message informs you that the license has been activated, and the 
software closes. You can now start EthoVision XT and work as usual. 

License stored on a hardware key

1. Start EthoVision XT. Make sure that no experiment is open.
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2. Choose Help > Upgrade. 
3. Enter the Upgrade Key 1 and, if that apples, the Upgrade Key 2 that you 

received from Noldus. 

4. Click OK to complete the upgrade procedure.

Notes
▪ To know which modules are included in your current license, choose Help > 

About EthoVision XT > License Info. See also Modules of EthoVision XT

See also

▪ Activate your EthoVision XT license
▪ Types of EthoVision XT license
▪ Troubleshooting: Installation and license
102



Preferences
Aim
After installing EthoVision XT, it is a good idea to set general preferences. For 
example, where to store the experiments, the default measurement units, etc. 

The options under Preferences are at the application level. This means that they are 
applied to all new experiments. However, default units can also be changed per 
experiment.

Procedure
Choose File > Preferences.

▪ Preferences for default folders
▪ Preferences for warnings
▪ Preferences for auto save
▪ Preferences for default units
▪ Preferences for language
▪ Preferences for video settings

Notes
▪ To return to the default settings, click the Defaults button.

Returning to default means that: 

- The default experiment folder will be that specified during installation. 

- All the warnings are selected.

- Auto save is enabled, with auto save interval is reset to 5 min. 

▪ When you click the Defaults button with the Default Folders tab open, the 
preferences for warnings, auto save and default units are also reset (and 
vice versa).
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Preferences for default folders
Procedure
Choose File > Preferences > Default Folders tab. See the options below.

Default folder location
Click Browse to specify a default location for new experiments. The initially 
suggested location is the location specified during installation. 

See also File locations on page 1238

Alternative media location
When visualizing and animating tracks, EthoVision XT needs the corresponding 
video files. If EthoVision XT does not find the video files in the Media Files folder of 
the experiment, it looks in the folder specified under Alternative media location.

This can happen, for example, when you copy an experiment to another computer 
and the video files are not stored in the Media Files folder of the experiment, but on 
a different folder external to the experiment, or even a different drive. When you 
open the experiment on the second computer, EthoVision does not find the video 
files. 

To have EthoVision XT look for videos in an additional location, click Browse and 
select the correct location.

See also

▪ Preferences
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Preferences for warnings
Aim
To enable or disable a warning that appears after you perform a certain action.

To choose which warnings to view
Choose File > Preferences > Warnings.

See also

▪ Preferences
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Preferences for auto save
Aim
To enable or disable auto save of data and settings.

To enable auto save
Choose File > Preferences > Auto Save. Select Enable auto save. Enter the time 
interval at which you like to save your data.

Notes
▪ Auto save saves all the data (tracks, independent variables, detection 

settings, data and analysis profiles, etc.), just like when you save the 
experiment manually (choose File > Save Experiment or press Ctrl+S).

▪ Auto saves during acquisition are suspended to prevent auto save from 
interfering with data acquisition. 

See also

▪ Preferences
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Preferences for default units
Aim
To specify the default units for distance, time and rotation for future experiments. 

Procedure
Choose File > Preferences > Default Units.

▪ Unit of distance. Choose between mm (millimeters), cm (centimeters), m 
(meters) or inch (inches). 

▪ Unit of time. Choose between ms (milliseconds), s (seconds), min (minutes) 
or hr (hours).

▪ Unit of rotation. Choose between deg (degrees; ), rad (radians), grad 
(gradians; 1 grad = 9/10 or /200 rad) or rot (rotations).

Notes
▪ EthoVision XT measures the distance between two points in pixels. With the 

Calibration procedure in Arena Settings, these are converted to distance 
values. 

▪ Changing the default units in Preferences does not affect the experiment 
currently open. To change the units in your present experiment, do so in the 
Experiment Settings > Units.

▪ Changing the units does not affect the raw data, only their presentation.
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See also

▪ Preferences
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Preferences for language
Aim
To specify the language in EthoVision XT. You can choose between US English and 
Simplified Chinese.

Procedure
1. Choose File > Preferences > Language.
2. Select either English (US) or Chinese (Simplified). 
3. Click OK and restart EthoVision XT to apply the change. 

See also

▪ Language support
▪ Preferences
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Preferences for video settings
Aim
To specify how video is processed during tracking. These settings are applied to all 
new experiments.

Background information
In EthoVision XT 17.5 and later versions you can set playback of video to be done 
through the Graphics Processing Unit (GPU or dedicated graphics card) instead of 
the CPU. This allows greater performance, especially when tracking in demanding 
conditions like with Behavior Recognition. Up to EthoVision XT 17.0 it was only 
possible to playback video with the CPU.

Procedure
1. Choose File > Preferences > Video settings.
2. Next to Play back and record video with, Select either GPU (default) or 

CPU. 
▪ Choose GPU if you want to have the GPU to process video.
▪ Choose CPU if you want to have the CPU to process video. 

3. Click OK to apply the change. 

Notes
▪ If you are in a middle of an experiment started with EthoVision XT 17.0 or 

an earlier version and some tracks were acquired before upgrading to 
EthoVision XT 18, you have two options:
▪ Complete the experiment with the old playback method. Keep the 

option CPU selected (recommended). The reason is that if you choose 
GPU a video file could look slightly brighter than it would do if you 
chose CPU. In that case you would need to make new detection 
settings for the next trials. To keep consistent detection settings across 
trials, choose CPU.

▪ Acquire all trials with the new playback method. Clear the existing trials 
(i.e., delete the tracks without removing the videos), and re-acquire all 
trials, with the option set to GPU for consistency. See Redo a trial

▪ For all your new experiments, we recommend to keep the option GPU 
selected.
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▪ What option you choose next to Play back and record video with does 
not affect tracking based on Deep Learning, even though this relies on the 
GPU. So whatever option you choose, you can use the Deep Learning body-
point detection technique, provided that your PC meets specific 
requirements. See Deep learning: Requirements

See also

▪ Preferences
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License agreement
Topics and tasks

▪ End-user license agreement
▪ Acknowledgments and copyright notices
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End-user license agreement
Procedure
To open a PDF copy of the End-User License Agreement, do one of the following:

▪ Browse to the following file:
C:\Program Files\Noldus\EthoVision XT 18\Documentation\Legal\End-User 
License Agreement.pdf

▪ In EthoVision XT, choose Help > About EthoVision XT > License Info > 
End-User License Agreement.

Notes
▪ If you installed EthoVision XT on a folder other than the default one, then 

browse to that folder, and open 
...\EthoVision XT 18\Documentation\Legal.

See also

▪ File locations
▪ Acknowledgments and copyright notices
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Acknowledgments and copyright notices
EthoVision® is a registered trademark of Noldus Information Technology bv. 
EthoVision XT would not be what it is without the use of third-party software. This 
page lists all software libraries and other software products used in EthoVision XT 
and where you can find license and compliance information and/or 
acknowledgments for that product.

For the complete terms and conditions in PDF format, click the link below:

Acknowledgments

This folder is located, by default, on C:\Program Files\Noldus\EthoVision XT 
18\Documentation\Legal\Acknowledgments.

If you installed EthoVision XT on another location, refer to that location.

Name Description Link/ License

Boost Open source (Boost 
community) software library, 
C++ templates

Boost software license

http://www.boost.org/users/
license.html

Euresys 
Multicam

Driver to address Picolo boards Euresys 

http://www.euresys.com/

Terms & conditions

http://www.euresys.com/terms-
conditions/

FFmpeg Cross-platform solution to 
record, convert and stream 
audio and video

FFmpeg

https://ffmpeg.org

GNU Lesser General Public License

https://ffmpeg.org/legal.html
114

file://C:/Program Files/Noldus/EthoVision XT 18/Documentation/Legal/Acknowledgments
http://www.boost.org/users/license.html
http://www.euresys.com/
http://www.euresys.com/terms-conditions/
https://ffmpeg.org
https://ffmpeg.org/legal.html


HASP Library for software protection EULA

https://
supportportal.gemalto.com/
csm?id=kb_article_view&sys_kb_i
d=f8ad2d43db19ff04d298728dae
96195d&sysparm_article=KB0018
933

Thales Group

https://cpl.thalesgroup.com/

IPP, MKL, TBB Software library for signal, 
image, speech and audio 
processing (Intel Corporation)

Intel Composer XE

https://software.intel.com/en-us/
license/intel-simplified-software-
license

LeadTools Video encoder and decoder 
software

LeadTools license agreement

Portions of EthoVision XT were 
created using LEADTOOLS 
©1991-2021, LEAD Technologies, 
Inc. ALL RIGHTS RESERVED. 
Portions of this product are 
licensed under US patents 
9,552,527, 10,318,563 and 
10,576,653 and foreign 
counterparts.

https://www.leadtools.com/help/
sdk/v21/licensing/leadtools-
software-license-agreement.html

LibTorch C++ frontend for PyTorch 
machine learning framework

Pytorch

https://pytorch.org/

3-clause BSD License

https://github.com/pytorch/
pytorch/blob/main/LICENSE

NVIDIA 
CUDA®

Parallel computing platform for 
general computing on GPUs

NVIDIA CUDA Toolkit

https://docs.nvidia.com/cuda/
eula/index.html
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NVIDIA 
cuDNN

Library of primitives for deep 
neural networks

NVIDIA

https://docs.nvidia.com/
deeplearning/cudnn/reference/
eula.html

NVIDIA 
TensorRT

SDK for deep-learning 
inference

NVIDIA

https://developer.nvidia.com/
tensorrt

Apache License 2.0

https://github.com/NVIDIA/
TensorRT/blob/master/LICENSE

OpenCV Software library for various 
computer vision problems

OpenCV

http://www.intel.com/content/
www/us/en/research/intel-
research.html

Apache License 2.0

https://github.com/opencv/
opencv/blob/master/LICENSE

Pylon Camera 
Software Suite

Driver for Basler cameras Baslerweb

https://www.baslerweb.com

Pylon End-User License 
Agreement

https://www.baslerweb.com/en/
service/pylon-eula/

QR Code 
generator 
library

Library for generating QR 
codes

MIT License

https://github.com/nayuki/QR-
Code-generator

Project Nayuki

https://www.nayuki.io/page/qr-
code-generator-library
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Wix Toolset Tools to author software 
installers

Wix Toolset

http://wixtoolset.org/

.NET Foundation

https://dotnetfoundation.org/

Microsoft Reciprocal License (MS-
RL)

All copyright, patent, trademark 
attribution notices that are 
present in the installation 
software are retained by Microsoft

https://wixtoolset.org/docs/
about/#license
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Set Up an Experiment

Main topics and tasks
▪ Your first EthoVision XT experiment  119
▪ Experiment settings  127
▪ More about Experiment Settings  164
▪ Manual scoring settings  202
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Your first EthoVision XT experiment
Learn about

▪ Important terms
▪ Protocols on the web featuring EthoVision XT

What do you want to do?
▪ Create an experiment from a predefined template
▪ Procedure

Notes
▪ You can also Create a new experiment based on an existing experiment. To 

do so, open the existing experiment and choose File > Save as. In the new 
experiment, delete the existing trials and settings if needed.

▪ IMPORTANT  When you create experiments, do not move, rename or delete 
experiment files and folders with Windows Explorer. Instead, always 
manage your experiments from within EthoVision XT. See File Management

▪ To create an experiment for Live Mouse Tracker, choose File > New and 
select the option Live Mouse Tracker experiment. For details, see Live 
Mouse Tracker: Create an experiment and Live Mouse Tracker: Workflow 

▪ For information on how to conduct EthoVision XT experiments with specific 
apparatuses, like the Open Field, the Morris Water Maze, the Novel Object 
Recognition and others, see the EthoVision XT 18 - Application Manual in 
this folder:
Other Documentation
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Important terms
Experiment
In EthoVision XT, the experiment is the container of all information related to an 
experimental setup. For example, you can create an experiment to collect data of a 
Morris water maze test, and another experiment for a Porsolt forced swim test. 

Create an experiment from a template (recommended)

You can create an experiment with already predefined settings, for example a 
circular arena for a Morris water maze. You can create a template experiment in two 
ways: a) from one of the predefined templates or b) from one of your preexisting 
experiments.

▪ Create an experiment from a predefined template
▪ Create a new experiment based on an existing experiment

If none of the predefined templates applies to your experiment, create a experiment 
from scratch (see below).

Create an experiment from scratch

You can create a new experiment with no predefined settings. To do so, choose File 
> New. See Create a new experiment from scratch

DanioVision experiment
A special version of an experiment for tracking zebrafish larvae with DanioVision. 
For the procedure, see the DanioVision DVOC-0041 - Reference Manual. See 
Manuals

GLP experiment
This is a special version of an EthoVision XT experiment made for Quality Assurance. 
First, certain actions such as editing or deleting data can only be done by specific 
users. EthoVision XT logs all user actions which can result in changes to the 
acquired data, for instance altering settings. It is also possible to leave a comment 
in the log when a user leaves a part of the program. 

▪ EthoVision XT and Quality Assurance
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Live Mouse Tracker experiment
This is a special version of an EthoVision XT experiment made for importing data 
from Live Mouse Tracker systems. In a Live Mouse Tracker experiment, some 
elements are not available, like the Track Editor and the Acquisition module. You 
cannot acquire data directly. Instead, import the Live Mouse Tracker databases into 
EthoVision XT. You do not need to draw the arena since that is already defined in 
the Live Mouse Tracker database. You analyze Live Mouse Tracker data just like any 
other EthoVision XT experiment. Note: EthoVision XT is based on Live Mouse 
Tracker version 1.0.3.

Trial
A trial is a single, uninterrupted data acquisition session. The trial starts when you 
either click the Start Trial button or press Ctrl+F5.

Track
A track is the actual data collected by EthoVision XT - a succession of 2D positions 
of each subject. At track include additional information such as the subject’s 
apparent size in pixels, and other information. The start of a track may or may not 
coincide with the start of the trial. This depends on your Trial Control Settings. In 
most cases, with the default Trial Control Settings, EthoVision XT waits one second 
after the subject has been detected in the arena. Therefore, depending on when the 
subjects is in view, the track begins some time after the moment that you click the 
Start trial button.

If you have multiple subjects or multiple arenas in the same video image, each 
subject produces one track within the trial.
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Create an experiment from a predefined 
template
Aim
To create a new experiment based on standard experimental setups like Morris 
water maze, Elevated plus maze, DanioVision, PhenoTyper, etc.

Procedure
1. Choose File > New From Template (Ctrl+T), or in the EthoVision XT 

Startup window, under New experiment, click New from template.
2. In the Select a template option window, select Apply a predefined 

template and, next, follow the instructions in the guided setup.
3. Step 1- Which video source will you use?

From video file. If you select this option, you can click Browse to select the 
video file. Optionally, you can also open the video file later.

Live tracking (and saving video files). Select this option and click Sources. 
In the window that opens, select the video sources for tracking. You can 
also set up your video source here. If you plan to co-acquire physiological 
data, select DAQ Co-acquisition.

You can only select Live tracking if EthoVision XT detects an encoder board 
for analog cameras or a digital camera. See Cameras supported by 
EthoVision XT

4. Step 2 - Which subjects will you track?
If you select the option Rodents, Fish or Arthropods, select a species from 
the list. If your species is not in one of these lists, select Other.

Based on the subject you select, different arena configurations are available 
in the next step of the guided setup, a suitable sample rate is selected and 
the nose-tail detection is made available.

5. Step 3 - How is the arena configured?
Arena template. Select a type of arena from the list (a picture is shown 
upon selection).

Zone template. Here you have the choice to select predefined zones for 
the type of arena you select in the Arena template list.

Number of Arenas. Select the number of arenas in the list. 
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You can only select multiple arenas, if you have the Multiple Arenas module.

Rows and columns. If you have multiple arenas, select the layout of the 
arenas.

6. Step 4 - How many subjects per arena will you track?
You can only select multiple animals if you have the Social Interaction 
module.

This step is skipped for some single-subject configurations like the Morris 
water maze.

7. Step 5 - Which features will you track? 
Select the tracked features. Also select whether the animal is Darker, 
Brighter or Brighter and darker than the background. The features option is 
skipped for configurations like the Novel object test, where tracking the 
nose-point is mandatory, or DanioVision where only the center point is 
tracked.

You can change your selection later in the Experiment Settings. See Tracked 
features

8. Step 6 - Initialize template experiment. 
This window gives an overview of the selected settings. Click Previous if 
you want to change settings, otherwise click Finish.

9. In the New Experiment window, in the Name field, enter a name for your 
experiment.
Select GLP Experiment if you want EthoVision to help you making a 
Quality Assurance-compliant experiment.

10. Click Browse and select the location in which you want to store your 
experiment. Do not select a removable disc, like a USB memory drive.

11. Click OK. The EthoVision XT Overview window appears.
12. Next: check the Experiment settings.

Notes
▪ Each experiment is stored in a folder with the same name as the 

experiment. 
▪ The default experiment location is the location specified during installation. 

See File locations
▪ The pre-defined templates (*.tpl) are stored in 

C:\ProgramData\Noldus\EthoVision\XT 18\Templates. 
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Do not move or delete those files!

▪ For experiments with one or two subjects per arena, you can select to use 
Deep learning to detect the nose and tail base of your subjects. Note that 
Deep learning works if a recent graphics card (GPU) is installed on your PC 
and its driver is up-to-date. See Deep learning: Requirements and More 
information on graphics cards (GPUs)

▪ If you select DanioVision as arena template, the EthoVision XT interface is 
adjusted for DanioVision. Unnecessary functions like the Manual Scoring 
Settings are not available. Detection settings are optimized for detection of 
zebrafish larvae and the arenas are detected automatically. For more 
information, see the DanioVision DVOC-0041 - Reference Manual. See 
Manuals
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Create a new experiment based on an 
existing experiment
Aim
To create a new experiment with settings (arena shape, detection settings etc.) 
imported from an existing experiment. Note that the new experiment will not 
contain data from the existing experiment.

Procedure
1. Do one of the following:

Choose File > New From Template (Ctrl+T), or in the EthoVision Startup 
window, under New experiment, click New from template.

2. In the Select a template option window, click Use a custom template.
3. Browse to the experiment folder of the existing experiment, click the 

experiment file (*.evxt) and click Open.
4. In the Name field, enter a name for your experiment.

Select GLP Experiment if you want EthoVision to help you making a 
Quality Assurance-compliant experiment. See EthoVision XT and Quality 
Assurance

5. Browse to the location in which you want to store your experiment. Then 
click OK. The default location is the location that you specified during 
installation.

6. The EthoVision XT Overview window appears. Click the buttons to check 
and adjust settings if necessary.

Notes
▪ When you create an experiment based on an existing experiment set to Live 

tracking, the new experiment imports the camera settings from that 
existing experiment. Check that the camera settings, for example the frame 
rate and the exposure time, still apply to the new situation. See Adjust 
camera settings in EthoVision XT 

▪ If you create an experiment based on an existing experiment, which used 
Live tracking and was created on a different computer, you must remake the 
Video source settings for the new experiment.
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Protocols on the web featuring 
EthoVision XT
Researchers are encouraged to publish test protocols on the internet to improve 
reproducibility of animal experiments.

Browse to 

https://www.bio-protocol.org/en/searchlist?content=ethovision

There you find protocols created with or mentioning EthoVision XT. 

See also

▪ Your first EthoVision XT experiment
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Experiment settings
To access the Experiment Settings, in the EthoVision XT Overview window, click 
Experiment Settings, or choose Setup > Experiment Settings.

In the Experiment Settings specify those aspects of your experiment that remain 
constant during the entire course of the experiment.

▪ Experiment information
▪ Video source
▪ Enable DAQ co-acquisition of external data
▪ Number of arenas
▪ Subjects per arena
▪ Tracked features
▪ Body point detection technique
▪ Analysis options: Activity analysis and Behavior Recognition
▪ Trial control hardware
▪ Units

See also

▪ Select multiple cameras
▪ Adjust camera settings in EthoVision XT
▪ More about Experiment Settings
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Experiment information
Experiment mode
The mode depends on your EthoVision XT license and the options you choose while 
creating a new experiment. The mode can be:

▪ Standard if you created an experiment, without selecting the DanioVision 
experiment, or GLP experiment option.

▪ DanioVision if you selected DanioVision experiment while you created a 
new experiment, or created an experiment using a DanioVision template. 
Manual Scoring Settings are not available and the Arena Settings and 
Detection Settings are optimized for zebrafish larvae in well plates.

▪ Standard GLP if you selected GLP experiment while you created a new 
experiment. This option is only available if you have the Quality Assurance 
Module. See EthoVision XT and Quality Assurance

▪ DanioVision GLP if you create a new experiment and select both options 
DanioVision experiment and GLP experiment. The experiment is set up 
for Quality Assurance and optimized for DanioVision.

IMPORTANT Once you created an experiment, the mode cannot be changed. Create 
a new default experiment if you want to change the mode. 

For details about setting up a DanioVision experiment, see the DanioVision DVOC-
0041 - Reference Manual. See Manuals

Location
The location where your experiment is stored on your computer. The default 
location is (unless it changed during installation or in the Preferences): 

C:\Users\Public\Public Documents\Noldus\EthoVision XT\Experiments.

To change the default location for experiments, choose File > Preferences.

Description 
Enter information about your experiment such as the kind of test that you perform, 
the scientific research question that you aim to answer with this study, etc. To edit 
the description, use Unicode characters in the Basic Multilingual Plane range. You 
can enter up to 255 characters.

See http://en.wikipedia.org/wiki/Plane_(Unicode) #Basic_Multilingual_ Plane.
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Video source
From video file
Select this option if you track from video files acquired with software other than 
EthoVision XT, for example MediaRecorder. For the list of compatible video formats, 
see Video file formats.

Live tracking
Select this option to acquire data live from the camera image.

IMPORTANT  If you work with Basler digital cameras, close the camera software Pylon 
Viewer before operating the camera in EthoVision XT.

One digital camera

Connect the camera to the Ethernet port of the PC. Click the Refresh button. Select 
1 from the list next to Number of sources and select the camera from the list under 
Source. 

TIP  For how to install and connect digital GigE Vision cameras, watch the video 
tutorial Set Up the Cameras. To open the tutorial, choose Help > Video Tutorial.
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Multiple digital cameras

▪ See Select multiple cameras

One analog camera

Connect your camera to the encoder board. Select 1 from the list next to Number 
of sources and select the correct input from the list under Source.

Multiple analog cameras 

▪ See Select multiple cameras

Notes
▪ IMPORTANT You cannot use a combination of analog and digital cameras. 

Always use the same type of camera in one experiment.
▪ You can use 1, 2, 3, 4, 8, 12 or 16 cameras simultaneously. Using for example 

5 cameras is not supported.
▪ When you use analog cameras, you need an encoder board. See Install 

analog cameras and Connect analog cameras to the computer
▪ If you mix the image from multiple cameras with a hardware video mixer, 

follow the procedure for one analog camera.
▪ The quality of the camera image can only be adjusted prior to acquisition. 

For details, see Adjust camera settings in EthoVision XT.

See also

▪ Cameras supported by EthoVision XT
▪ Check that the camera is set up properly
▪ Install GigE cameras and Install USB 3.0 cameras
▪ Install analog cameras
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Enable DAQ co-acquisition
Aim
To co-acquire external data with a separate Data AcQuisition (DAQ) system. You can 
co-acquire, for example, physiological data while you track the subjects.

Prerequisites
▪ Under Video Source in the Experiment Settings, you have selected Live 

tracking.
▪ You have the External Data module.

Procedure
1. Choose Setup > Experiment Settings.
2. Under Video Source select Live tracking.
3. Select Enable DAQ co-acquisition.
4. For the complete procedure, see Enable DAQ co-acquisition in EthoVision 

XT.

See also

▪ External Data
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Select multiple cameras
Aim
To mix the live view of multiple camera in a picture-by-picture fashion.

IMPORTANT  When you mix video images of many cameras, the resulting resolution 
per camera image is reduced. Make sure that this resolution is high enough for 
proper detection and tracking.

Prerequisites
▪ For GigE cameras (including PhenoTyper 2), see Using multiple GigE 

cameras, Connect the GigE camera to the PC and Assign IP addresses
▪ For analog cameras (PhenoTyper 1): see Connect analog cameras to the 

computer

Multiple digital cameras
EthoVision XT mixes the camera images in a picture-by-picture fashion. 

1. Connect your cameras.
Plug each camera to the port of its Ethernet board. Each camera has its 
unique link with one of the ports of the Ethernet interface board. If you 
swap cameras, EthoVision XT won’t get the camera image. See Using 
multiple GigE cameras and Assign IP addresses

2. In the Experiment Settings, select the number of cameras from the list next 
to Number of sources.

3. Select the cameras under Source. The camera names will show a number in 
brackets at the end, which makes it possible to distinguish between the 
cameras.

4. Select the Resolution, the Frame rate and the Color space for the first 
camera. The settings are then applied automatically to the other cameras. 
See Adjust camera settings in EthoVision XT

5. Next to Merged camera view, select the resolution of the merged camera 
view. This is also the resolution of the video file that EthoVision XT creates if 
you opt for video recording.

6. Click the preview icon to get a preview of the merged camera images. 

EXAMPLE  Selecting four GigE cameras: note the different IP addresses.
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NOTES

▪ For how to install and connect digital GigE cameras, watch the video tutorial 
Set Up the Cameras. To open the tutorial, choose Help > Video Tutorial.

▪ The video resolution and frame rate that you set in one experiment is 
selected automatically in your next experiment. When you create a new 
experiment, always check that the camera settings are those required for 
that experiment. See also Configure the digital camera

See also

▪ Connect the GigE camera to the PC
▪ Using multiple GigE cameras
▪ Tested configurations with GigE cameras
▪ Check that the camera is set up properly

Multiple analog cameras
NOTE  Mixing images from analog cameras using encoder boards other than the 
Picolo Alert is not supported.

Two or four analog cameras

1.  Connect your cameras to the inputs of your encoder board. See Connect 
analog cameras to the computer

2. Next to Number of sources, select the correct number of cameras from the 
list and select the inputs from the list under Source. The resolution and 
frame rate are selected automatically, dependent on whether you have 
NTSC or a PAL cameras.

3. Next to Merged camera view, select the resolution of the mixed image. 
This is also the resolution of the video file that EthoVision XT creates if you 
opt for video recording. See Acquire one trial
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4. Click the preview icon to get a preview of the merged image. 
EXAMPLE  Selecting four analog cameras:

More than four analog cameras

When using more than four analog cameras, we recommend to use a hardware 
video mixer also known as Quad Processing Unit. See Connect analog cameras to 
the computer. If you use PhenoTyper 1, see also the PhenoTyper - EthoVision XT - 
Reference Manual. See Manuals

See also

▪ Tested configurations with Analog cameras
▪ Install analog cameras
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Adjust camera settings in EthoVision XT
Aim
To adjust the settings of your camera within EthoVision XT. For example, the video 
resolution, the frame rate, or the exposure. 

IMPORTANT  To improve the quality of the image, always try adjusting the lighting 
and camera aperture before changing the settings in EthoVision XT.

Prerequisites
▪ If you work with Basler digital cameras, before using the camera in 

EthoVision XT close the camera software Pylon Viewer.

To access the camera options
1. Choose Setup > Experiment Settings, and click the camera button for the 

camera you require.

2. Click one of the tabs and adjust the settings (see below).
▪ Format tab
▪ Image tab
▪ Camera/General tab
▪ Color tab
▪ Address tab
▪ More settings

Format tab
The Format tab is only available for the first camera. The settings you specify here 
are also applied to the other cameras.
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IMPORTANT  If you change the resolution within an experiment, open the Arena 
Settings profile and Grab the background image. This will update the background 
image with the new resolution. If the Arena Settings profile is locked, right-click it 
and select Duplicate. In the new profile you can now grab the background image. 
Next, use that Arena Settings profile to acquire new trials.

Resolution

For single arenas and subjects more than a couple of centimeters long, a resolution 
of 384x288 (analog cameras, PAL) or 320x240 (analog cameras, NTSC) or 640 x 480 
(GigE cameras) is sufficient. 

For digital cameras: When you reduce the resolution, the field of view also changes. 
In the following example, reducing the resolution from 800 x 600 to 640 x 480 
results in a cropped image. 

You can compensate for this if your camera is provided with a zoom lens. Another 
option is to leave the resolution unchanged and use the Binning function which 
reduces the size of the image in pixels but does not affect the field of view.

If you opt for a higher resolution in GigE cameras, for example 1280 x 1024, always 
check that it does not conflict with the frame rate (see below).

▪ The higher the video resolution, the more accurate your tracking. 
▪ The higher the video resolution, the larger the resulting video files. If disk 

space is limiting, use the above-mentioned resolution.
▪ Use a high resolution especially:
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▪ When you track the three body points in general.
▪ You work with Behavior Recognition. See Behavior Recognition: 

Requirements
▪ You track the subjects with the Deep learning technique. See Deep 

learning: Requirements

Frame rate

This is the number of video images per second that are generated by the camera. 
Note that the frame rate is not the same as the Sample rate, which is the number of 
images the EthoVision XT analyzes per second. 

▪ For digital cameras, the frame rate can vary. Common values are 25 and 30. 
A frame rate higher than 30 is recommended when working with fast-
moving animals, or when you want to detect movements like startle 
responses in fish or rapid turns in flying insects. High frame rates require 
more processing power. If you select a high frame rate, in some cases you 
need to lower the video resolution. This window shows a message when 
that is the case. See the tested configurations in GigE cameras

▪ For analog cameras, the frame rate is determined by the TV standard of 
your camera.

Color space

This option is available for digital cameras only.

Color space determines how the information about brightness and color is encoded 
in the video frames that are sent to EthoVision XT. Note that this may impact the 
maximal frame rate. The optimal color space differs between cameras. See also Pixel 
format and color space

▪ For monochrome cameras: Choose Y800. Check the preview image to 
assess whether the image quality is good.

▪ For color cameras: If the image is black-and-white instead of color and a 
Moire pattern appears in the image, try selecting another color space. 
Normally, the default color space gives a good image quality. If you use a 
high frame rate or resolution, this reduces the number of animals you can 
track simultaneously. This also depends on how fast your computer is.
TIP  In the Detection Settings, in the Detection Performance pane check the 
value under Missed samples to get an indication of the quality of tracking.

See also Settings for the color camera and Pixel format and color space 
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Standard

This is only available for analog cameras. Select the TV standard of your camera. You 
can find this in the specifications section of your equipment's manual. It will 
probably be the standard used in your country.

▪ PAL. In Western Europe, China, Indonesia and Australia.
▪ NTSC. In United States, Canada and Japan.

Image tab
Brightness, Contrast and Saturation are only available for analog cameras. Move the 
slider, click the arrows or change the number in one of the fields to adjust the 
settings and check the resulting image.

Click the Default button to revert the Image settings to default. The settings on the 
other tabs will not change. Click the More Settings button to open a window with 
additional settings.

Brightness

Be aware that a too dark/too bright image may reduce the quality of video tracking. 
Brightness is not the same as Exposure; the latter is the period of time when the 
camera sensor is exposed to light.

Contrast

This is the difference in brightness or color that makes objects in an image 
distinguishable. Use this slider to enhance or reduce the contrast in the image.

Saturation

This is the strength or purity of the color and represents the amount of gray in 
proportion to the hue. A saturated color is pure, while an unsaturated color has a 
large percentage of gray.
138



Camera/General tab
Some options are only available for Basler cameras.
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Center Image

When selected, Center Image ensures that the resulting camera image is centered 
over the sensor when not capturing the largest possible image. We recommend to 
keep this option selected. See also Center the camera view

Binning

Use Binning when you want to reduce the video size, increase brightness without 
cropping the video image. When selected, sensor pixels are grouped together to 
make one image pixel. For example, selecting 2 means that two horizontal and two 
vertical pixels, thus 4 sensor pixels, make up one image pixel. This increases the 
sensitivity of the camera but reduces the size of the video image. 

In the following figure, setting binning to 2 reduces the video size from 800 x 600 to 
644 x 513. Note that the image is just smaller, not cropped.

Note:
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▪ Binning results in a brighter image. Check that detection is still optimal. To 
reduce brightness, close the aperture ring of the camera lens, or reduce the 
Exposure time or the Gain.

▪ When you select or deselect Binning, do that for all the cameras in your 
experiment. Binning should be the same across the cameras.

▪ If you want to reduce the video size and crop the video image, clear the 
Binning option, keep Center Image selected and reduce the resolution. 

▪ You can also crop the video image when your camera lens is multi-focal 
(that is, the lens has a zoom ring).

Exposure time

Exposure determines the time when the sensor is exposed to light. The higher the 
value, the brighter the image. Note that, if Exposure is too high, the camera may not 
be able to send the images at the supposed frame rate. In that case, the window 
shows that the frame rate is too low. Reduce the Exposure, or reduce the frame rate 
to have longer time intervals between subsequent video frames. 

▪ For Zebrafish larvae, enter 4000 or 2000, depending on the video 
resolution chosen; the smaller the resolution, the shorter the exposure time 
needed. 

▪ For rodents in an open field, a value between 5000 and 20000 is fine.
▪ For a mosquito filmed under infrared, a value around 10000 is fine.
▪ All else being equal, faster animals require shorter exposure times.

TIP  If the image becomes too dark due to the short exposure time, increase the 
Gain (see below).

Gain

Adjust the Gain to change the amplification level of the signal coming from the 
camera sensor. A higher value means more sensitivity. Increase the gain to make the 
picture brighter, for example in dark environments. Be aware that higher Gain may 
increase noise in the image.

Default/More

▪ Click the Default button to change the camera settings back to default. The 
settings on the other tabs will not change. 

▪ Click the More button to open the camera software with additional 
settings. To operate this software, click first the Cancel button in the 
EthoVision XT Video Settings window.
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Color tab

Gamma

Human visual perception is typically non-linear. Adding 1 to a dark or bright color 
would not result in the same increase in the perceived brightness. Gamma adjusts 
the brightness of pixel values to account for this non-linearity. Choose sRGB to take 
a colors as is. Choose user to fine-tune the color representation and get a color 
perception that is optimal for you. 

When the gamma correction value is set to 1, the output pixel brightness is not 
corrected. A value between 0 and 1 results in increased overall brightness; a value 
greater than 1 results in decreased overall brightness.

Color adjustment

With Color adjustment you can fine tune the color perception by adjusting the 
settings of colors separately. Select Enable, then choose a color from the list and 
adjust the saturation Value. Check the result in the image preview.

Address tab
This contains the settings for IP cameras. 
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IP Address

Enter the IP address of the IP camera. For details about how to define a IP address 
for the camera, see the Help of EthoVision XT 17 or earlier, which you can download 
from my.noldus.com.

Port

Enter the port number specified for the IP camera (default for Noldus cameras: 
554).

User name

Enter the user name specified for the IP camera. For details on how to define a user, 
see the Help of EthoVision XT 17 or earlier, or consult the camera’s manual.

Password

Enter the password specified for the IP camera. For details on how to set a 
password, see the camera’s manual.

More settings
For some types of cameras the More button takes you to additional settings. For 
example, for GigE cameras:
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These settings corresponds to those you can access with the camera software (see 
Configure the digital camera). The main settings are:

▪ Analog Controls > Gain. Increase the value of Gain Raw to increase light 
intensity. Note that this also increases background noise.

▪ AOI Controls > Resolution. See Format tab above for this setting.
▪ Acquisition Controls > 

▪ Exposure time. Increase the value of Exposure time to have a brighter 
image. However, a long Exposure time may conflict with other settings, 
in particular frame rate. See Configure the digital camera

▪ Acquisition frame rate. See Format tab above for this setting.

Notes
▪ For digital GigE or USB 3.0 cameras, all settings are available in the camera 

software. See Configure the digital camera
▪ When you adjust the camera settings in EthoVision XT, the settings are sent 

back to the camera once you re-open the experiment.
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▪ The camera settings are saved at the experiment level. So you can create 
two EthoVision XT experiments with different camera frame rates, exposure 
levels, etc.

See also

▪ Configure the digital camera
▪ Check that the camera is set up properly
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Check that the camera is set up properly
Aim
If a digital camera is not setup properly, you will get dropped video frames which 
results in either Missed samples or Interpolated samples in EthoVision XT.

Prerequisites
▪ You have followed the steps in Camera Installation to connect and 

configure the camera
▪ You have created an experiment in EthoVision XT
▪ You have made the Arena Settings. This step is necessary to open the 

Detection Settings.

Procedure
1. In the EthoVision XT experiment, select Setup > Detection Settings > 

New.
2. Make sure that the video window shows the live camera image.
3. In the Detection Settings pane, under Smoothing, set Dropped frame 

correction to Off.
4. Locate the Detection Performance pane. 
5. Check the value of Missed samples. If the percentage of missed samples is 

low, say less than 1%, then the camera is set up properly.
If the percentages is higher, there may be an issue with the camera.

6. You have a few options:
▪ For GigE cameras: check that the exposure time is not too high for the 

set frame rate. See Adjust the camera exposure time
▪ Reduce the video resolution, the frame, or both.
▪ The Ethernet board may not be set up properly. See Settings of the 

Ethernet board
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▪ See the Troubleshooting: Camera

Notes
▪ The value of Subject not found is not related to the camera setup. It shows 

how often the software is not able to find a subject in the arena. If the arena 
is empty, the value grows to 100%.

▪ The Dropped frame correction set to Off enables you to see if EthoVision 
XT can cope with the actual camera frame rate without missing samples.

▪ If the camera is set up properly and still the number of Missed samples is 
high (e.g. > 5%), you can set Dropped frame correction to On. However, 
the software interpolates samples to compensate for the missing video 
frames. See Dropped frames correction
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Number of arenas
Aim
To specify the number of enclosures (arenas) that you use during a trial.

Prerequisites
▪ Your EthoVision XT license includes the Multiple Arenas Module. See 

Upgrade EthoVision XT
▪ You want to track animals in two or more arenas simultaneously.

Procedure
1. Choose Setup > Experiment Settings.
2. Specify the Number of Arenas in the video image.

Notes
▪ Examples of multiple arenas: a well plate with 96 wells; two apparatuses for 

a novel object recognition test placed one next to the other; four open 
fields; 4 or 16 PhenoTypers.

▪ It does not matter how many cameras you use. If you use for example four 
cameras, each pointing to an open field, select 4 as the number of arenas.

▪ With the Base version of EthoVision XT you can track one subject in one 
arena. With the Multiple Arenas Module you can track in up to 100 arenas 
simultaneously.

▪ IMPORTANT  If you want to use more than one arena, first check that no 
samples are missed during acquisition before deciding to work with live 
tracking. You can display statistics on missing samples during acquisition, in 
the Analysis Results and Scoring pane, in the Trial Status tab.
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Subjects per arena
Aim
To specify the number of subjects that are present in each arena during a trial. This 
setting is valid throughout the experiment, and cannot be changed after you have 
acquired the first trial.

Procedure
1. Choose Setup > Experiment Settings.
2. Next to Number of Subjects per Arena, select the number of subjects that 

are present in each arena simultaneously.
If you intend to use the Deep learning technique for body point detection, 
you can apply it to one or two subjects per arena. See Body point detection 
technique

3. Under Subject roles, enter the role of the subjects or accept the default 
ones (Subject 1, Subject 2, etc.).

Subject roles
To modify the Subject's role name, right-click a name, select Rename and type in 
the new name. Enter generic role names, for instance in a Resident-intruder test 
with two animals, enter Resident and Intruder, or Mutant and Wild type.

Do not enter the ID of the subjects you are going to test. You can specify the ID of 
your subjects as an independent variable. See Define an independent variable

If you use the Deep learning technique to track two subjects in an arena, the 
software does not know which role belongs to a specific individual. So it may 
happen that the resident subject is labeled Resident in one trial, and Intruder in 
another trial. To correct this, open the Track Editor and swap the subjects in the trial 
where the resident subject is labeled as Intruder. See Swap subjects
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Notes
▪ With the Base version of EthoVision XT you can track one subject per arena.
▪ With the Social Interaction Module, you can track up to 16 subjects per 

arena. Mind that this is a technical limit; the actual number of subjects that 
you can track depends on other factors. When using color markers to 
discriminate between individuals, it may be difficult to discriminate 
between 16 different color marks depending on the light conditions.

▪ To change the number of subjects per arena after acquisition, either delete 
the trials or make a copy of the experiment with a different name (File > 
Save As) and delete all trials.

▪ Contact Noldus if you need to track more than 16 subjects per arena.
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Tracked features
Aim
To specify which feature of the subject body is tracked. This choice affects the X,Y 
coordinates resulting in a Track.

Procedure
1. Choose Setup > Experiment Settings. 
2. Under Tracked Features choose the option that applies to your 

experiment.

Center-point detection
To track only the geometric center of the subject detected (or the part of its body 
being detected). For example, in an open field or Morris water maze test.

Center-point, nose-point and tail-base detection
Tracking the nose-point is essential in, for example, a Novel Object Recognition test 
or in a Social interaction test to determine how often and how long your subject 
touches the object of interest or follows and interacts with the other subject.

Also select this option

▪ When you track two or more rodents per arena, marked with colors.
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▪ When you want to use the Behavior Recognition function.

Color marker tracking (treat marker as center point)
If you choose this option, EthoVision XT will only detect the color marker, and track 
its geometric center. EthoVision XT won’t extract the position of body points and 
any information about the subject’s body posture. 

Choose this option for social interaction tests where you do not need to track nose 
and tail base (e.g. color-marked insects or fish).
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Body point detection technique
Aim
To choose which technique EthoVision XT uses to detect the nose-point and the 
tail-base points of your subjects.

Prerequisites
▪ In the Experiment Settings, under Tracked Features, you selected Center-

point, nose-point and tail-base detection.
▪ The camera must be placed overhead.

Procedure
1. Choose Setup > Experiment Settings. 
2. Under Body Point Detection Technique, choose the option that applies to 

your experiment.

Contour-based
This technique uses foreground/background segmentation based on conventional 
image processing. The center-point, the nose-point and the tail-base point are 
derived from the detected body contour. This technique is suitable for any animal 
with an elongated body and pointed snout, for example rodents, fish, and certain 
insects.

NOTE  Contour-based is used by default in older EthoVision XT versions.

Deep learning
If you choose this option, the nose-point and the tail-base point are detected using 
a trained neural network. The center-point is detected based on the contour of the 
detected subject, as described above (except for when there are two subjects in the 
arena; in that case the center point is also found using the neural network).

IMPORTANT  Deep learning is currently limited to rodents, and for up to two subjects. 
If you want to use the Deep learning technique, consider that there are specific 
restrictions and hardware requirements. See also:

▪ Deep learning: Basics
▪ Deep learning: Requirements
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Notes
▪ If you chose Center-point as the tracking feature, the center-point is always 

detected with the Contour-based technique.
▪ You cannot use the Deep learning technique combined with Behavior 

Recognition.
▪ When you select Deep learning, you may see this message: The graphics 

card driver is outdated or not installed or the graphics card does not support 
CUDA. It is possible that the graphics card is too old, or the graphics card 
driver is not up-to-date. See Deep learning: Requirements
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Activity analysis
Aim
Activity measures temporal changes in the video image that may have biological 
meaning. For example, a sudden drop in the levels of Activity in an open field may 
indicate freezing in a fear conditioning experiment. This can be detected 
automatically by EthoVision XT, based on the amount of temporal change in the 
gray scale value of each pixel in the arena.

EXAMPLE  In the example below: pixels marked in purple indicate temporal change in 
their gray scale value. Left: No pixel change around the mouse, which is completely 
immobile. Right: Pixel change when the mouse is active.

Additional examples:

▪ Detect immobility in a Porsolt swim test. When the subject stays still in the 
cylinder, Activity is reduced to a minimal level.

▪ Detect activity of insects flying around a target object. The more insects are 
flying around the target, the higher the level of Activity.

To use Activity Analysis
1. Choose Setup > Experiment Settings, and under Analysis options select 

Activity analysis.
2. In the Arena Settings, define the arena.
3. In the Detection Settings, define the level of significant activity. See Activity 

settings
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4. Run your trials. During acquisition, you can monitor the level of activity and, 
if necessary, use this information to adjust the activity settings to better 
detect the behavior you are interested in.
See an example in Fear conditioning: view Activity state

5. To analyze activity, in the Analysis profile choose the variables Activity and 
Activity state.

Notes
▪ Activity analysis is only available when in the Experiment Settings, under 

Subjects, you select 1 Subject per arena.

See also

▪ For how Activity is calculated, see Activity and Activity state as Dependent 
variables

▪ Fear conditioning: view Activity state
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Behavior Recognition
Aim
To active the functions Rat Behavior Recognition and Mouse Behavior Recognition.

For the list of behaviors recognized with these functions, see Behavior Recognition: 
Data, performance and accuracy

Prerequisites
▪ You have the Rat/Mouse Behavior Recognition module.

Procedure
1. Choose Setup > Experiment Settings.
2. Under Subjects, choose 1. 
3. Under Tracked Features, select Center-point, nose-point and tail-base 

detection.
4. Under Body Point Detection Technique, select Contour-based.
5. Under Analysis options, select Behavior recognition and choose the 

function Rat Behavior Recognition or Mouse Behavior Recognition.
6. Select the options that apply (see below).

Options
▪ Feeder. Select this if you want to analyze eating behavior at the feeder. In 

the Arena Settings, you must draw a zone over the feeder. 
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▪ Drinking bottle. Select this if you want to detect drinking. In the Arena 
Settings, you must draw a point over the tip of each drinking bottle spout. 

▪ Arena walls. To have EthoVision XT discriminate between rearing to the 
walls and rearing unsupported. In the Arena Settings, you must draw a zone 
over the walls.
See Zones and points for Behavior recognition

▪ Settings (for Mouse Behavior Recognition). When you select Mouse 
Behavior Recognition, click the Settings button and select the options 
that apply to your setup:
▪ Select Bedding present if the cage includes bedding material ad you 

want to detect digging behavior.
▪ Select Food available if there is food for the mice and you want to 

detect eating behavior.

Next steps
1. in the Arena Settings, draw the zones important for behavior recognition. 

See Zones and points for Behavior recognition
2. In the Detection Settings, set a sample rate between 25 and 31 samples per 

second, and specify the Detection settings for Behavior recognition.
3. Run your trials.

See also

▪ Behavior Recognition: Requirements
▪ Choose Help > Video Tutorial and watch the tutorial about Behavior 

Recognition.
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Trial control hardware
Aim
To set the EthoVision XT experiment to control hardware devices.

EXAMPLE  Enable control of two Pellet dispensers.

Prerequisites
You must have one of the following interface devices:

▪ The USB-IO box.
▪ The Mini USB-IO box.
▪ The DanioVision DVOC-00xx observation chamber.

To enable trial control hardware
1. Connect the interface device (Noldus USB-IO box, Noldus Mini USB-IO box 

or DanioVision Observation Chamber) to the EthoVision XT computer. 
For details and connection schemes, see the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual. See Manuals

2. Select Trial Control Hardware and click Settings.
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3. Depending on which device is connected to the EthoVision XT computer, 
select either Noldus USB-IO box or Noldus Mini USB-IO box, or the 
DanioVision version you have. Next, click OK.

4. If you have connected multiple USB-IO boxes, in the window that appears, 
select the interface device from the IO interface list. Otherwise, skip this 
step.

5. For each device connected, under Device Type select the port that device 
is connected to, and under Device ID specify the device name or accept the 
default name. See some examples below.

6. If you use multiple USB-IO boxes, repeat steps 4-5 for each USB-IO box. 
Specify the hardware connected to that box.

Examples

One Pellet dispenser

Locate the TTL port connected to the Pellet dispenser, and in that row under Device 
type select Pellet Dispenser.

One Pellet dispenser and one Lickometer

Under Device type, select Pellet Dispenser next to the TTL port connected to the 
Pellet dispenser. For Lickometer, select Lickometer next to the SDI port that is 
connected to the Lickometer.
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PhenoTyper

The connections depend on whether you use PhenoTyper 1 or PhenoTyper 2. For 
information, see the PhenoTyper 2 - EthoVision XT 18 - Reference Manual. See 
Manuals

DanioVision

The White Light stimulus and the Tapping stimulus (when present) are already 
assigned. For the Temperature Control Unit, or custom hardware, under Device 
type select the device next to the TTL port you use.

Notes
▪ IMPORTANT If you use multiple Noldus USB-IO boxes, their identity number 

must be different. You can set this number using the jumpers inside the 
USB-IO box. For details, see the EthoVision XT 18 - Trial and Hardware 
Control - Reference Manual. We recommend to test your own configuration 
of USB-IO boxes and devices before carrying out the actual trials.

▪ You cannot combine the regular Noldus USB-IO Box with the Noldus Mini 
USB-IO Box.
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▪ To see what type of USB-IO box you have, check the label at the bottom 
side of the box: PTIO-002x for the Noldus USB-IO Box or PTIO-003x for 
the Noldus Mini USB-IO Box. 

See also

▪ For details on how to connect hardware devices, see the EthoVision XT 18 - 
Trial and Hardware Control - Reference Manual.

▪ For DanioVision, the DanioVision DVOC-0041 - EthoVision XT 18 -
Reference Manual.

▪ For PhenoTyper, the PhenoTyper - Reference Manual for general 
information, and the PhenoTyper - EthoVision XT 18 - Service Manual for 
details about the Noldus devices that work with PhenoTyper.

▪ See Manuals
You can also find the manuals on the Noldus website.

my.noldus.com

Choose Downloads, then EthoVision XT and Documentation.
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Units
Specify the units for distance, time and rotation:. Changing the units does not affect 
the raw data, only their presentation. You can change the displayed units at any 
time.

Unit of distance
EthoVision measures the distance between two points in pixels. To convert these to 
real values you must calibrate your arena. Here, you can choose what unit of 
distance you prefer: millimeters (mm), centimeters (cm), meters (m) or inches (inch).

Unit of time: 
Milliseconds (ms), seconds (s), minutes (min) or hours (hr).

Unit of rotation: 
Degrees (), radians (rad), gradians (grad) or rotations (rot).

Notes
▪ You can change the units after you have acquired tracks. This only affects 

the presentation; the data are always correct.
▪ Changing the units only affects the present experiment. To change the 

default units for future experiments, choose File > Preferences. Click 
Default units and select the units you want.

▪ Settings of units are saved on your computer. If you open another 
EthoVision XT experiment from a colleague, numbers will be displayed 
according to your settings, regardless of the settings your colleague used. 
For example, your colleague tracked an animal moving one inch; on your 
computer it is shown as 2.54 cm.
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More about Experiment Settings
Deep-learning for body point detection

▪ Deep learning: Basics
▪ Deep learning: Requirements
▪ More information on graphics cards (GPUs)
▪ Install a graphics card for Deep learning

Behavior Recognition
▪ Behavior Recognition: Requirements
▪ Behavior Recognition: Data, performance and accuracy

Live Mouse Tracker
▪ Live Mouse Tracker: Workflow
▪ Live Mouse Tracker: Create an experiment
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Deep learning: Basics
Background information
NOTE  The following information only applies to tracking of rodents when using the 
Deep learning function. See also Adjust the settings for nose-tail base detection 
(Deep learning)

Deep learning is a type of machine learning. While machine learning is a general 
category that encompasses all sorts of mathematical tools that help a computer 
learn by experience, Deep learning refers to the use of deep neural networks, where 
“deep” indicates that the networks are made of multiple, hidden layers of neurons or 
decision nodes. 

In a deep neural network, intermediate layers are placed between the input layer, 
which receives the data, for example the RGB values of the pixels that make up a 
bitmap picture, and the output layer, which represents the categories of 
classification; for example, when classifying a picture, “the picture is of a cat” or “the 
picture is not of a cat”.

Deep learning in EthoVision XT
A deep neural network can find structures in unstructured data, like for example 
pictures and video images. They can recognize recurring patterns, such as the eyes 
of humans in a number of portraits, and relationships between those patterns. 
Because of the layered structure of decision nodes, deep neural networks can learn 
to represent data at various levels, from low levels such as edges, colors, curves, etc. 
to higher levels such as semicircles (a combination of a curve and a straight edge), 
squares (a combination of straight edges), up to even higher, more abstract levels 
(concepts), such as “handwriting”, “dark object”, “a tail” etc. 

EthoVision XT uses a trained network, that is, the network has learned to extract 
features from a number of video images of rodents of various colors and in various 
backgrounds, where the nose and the tail-base were previously annotated. During 
tracking, the network analyzes a portion of the image that includes the detected 
subject. It creates a map of probability of occurrence for both the nose- and the tail-
base points, and finally makes an estimate of the position of the nose point and the 
tail-base point, based on the highest probability.

With deep learning, the detection of the body points is less dependent on the 
detected contour of the subject. You can see this effect in cases with low contrast 
between the subject and the background, like in the following picture. Here, a dark 
mouse is only partly detected when it rears with the forepaws placed on the cage 
wall. However, the neural network can find the nose point.
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Convolutional networks
EthoVision XT uses a deep Convolutional Neural Network (CNN) to find the nose- 
and the tail-base points in each sampled video image. CNNs are particularly 
suitable to classify images based on spatial relationships. CNNs resemble the 
structures of the cells in the visual cortex of our brain. The visual cortex has small 
regions of cells that are sensitive to specific regions of the visual field. Hubel and 
Wiesel (Journal of Physiology 165: 559-568,1963) showed that some neurons fired 
only in the presence of edges of a certain orientation. Some neurons fired when 
exposed to vertical edges and some when shown horizontal or diagonal edges. The 
basis of convolutional networks is the idea that specialized components in the 
network have specific tasks, that is, to look for specific characteristics in the image.

Features detected with Deep learning
When you track the subjects with Deep learning, the main features of the subjects, 
for example the body center point, are calculated in different ways, either predicted 
by the neural network or the calculated based on the contour of the detected 
subject. When tracking multiple subjects with Deep learning, some of those features 
are not calculated at all. See the tables below for reference.

One subject per arena

Where:

Feature calculated Technique and other features used
Center-point Contour

Nose-point Deep learning

Tail-base point Deep learning

Body elongation Contour

Body area Contour

Body changed area Contour

Head direction line Contour, nose-point
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▪ Body elongation is used to calculate the dependent variable Body 
elongation and Body elongation state.

▪ Body area and Body changed area are used to calculate Mobility and 
Mobility state.

▪ The Head direction line is used to calculate Head direction and Head 
directed to zone.

Two subjects per arena

See also

▪ Deep learning: Requirements

Feature calculated Technique and other features used
Center-point Deep learning

Nose-point Deep learning

Tail-base point Deep learning

Body elongation Not calculated

Body area Not calculated

Body changed area Not calculated

Head direction line Not calculated
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Deep learning: Requirements
Main topics

▪ Graphics card (GPU)
▪ Video source
▪ Sample rate
▪ Subject species, color and size
▪ Number of subjects and arenas
▪ Video image
▪ Video length
▪ Individual marking (for two-subject tracking)
▪ Test apparatus and background
▪ Recording protocol
▪ Behavior Recognition
▪ Test results

Graphics card (GPU)
Neural networks make calculations over huge data matrices, and therefore require 
substantial computation power. In order for the Deep learning tracking technique to 
work in EthoVision XT, you need a Graphics Processing Unit (GPU, or graphics card) 
that is able to sustain those computations.

Furthermore, Deep learning makes use of TensorRT software development kit 
(version 8.6.1.6) which is built on the cuDNN deep neural network library, which in 
its turn relies on the CUDA computing platform. For this reason, the GPU driver 
must support CUDA runtime version 12.2.

If you intend to purchase a GPU for Deep learning, click here below for more 
information. 

▪ More information on graphics cards (GPUs)
▪ Install a graphics card for Deep learning

Video source
Choose:
168



▪ When tracking one subject per arena: Live tracking limited to up to four 
arenas, or From video file.

▪ When tracking two subjects per arena: From video file.
Tracking two subjects live using Deep learning may lead to a high number 
of missing samples, depending on the power of GPU. Always test your 
setup first. If you note a significant number of missing samples (e.g. > 5%), 
do not track live. Instead, record video first, then acquire the trial later using 
Deep learning.

See the recommendations in Resolution, frame rate, and maximum trial duration

Sample rate
Accuracy of individual discrimination may go down when reducing the sample rate, 
for example from 25 to 12.5 samples/s. We strongly recommend that you track at 
the maximum sample rate available, that is, the frame rate of your camera. Choose 
the sample rate in the Detection Settings. See Sample rate

Subject species, color and size
▪ The neural network has been trained with images of rats and mice of 

uniform color.
▪ For hooded rats, like Lister and Long-Evans rats:

▪ When tracking one subject per arena: Select Hooded rats in the 
Detection settings. This loads a neural network model specific for those 
animals. 

▪ When tracking two subjects per arena: the neural network for two 
interacting subjects has not been trained for the fur patterns of hooded 
rats. If you want to use hooded rats, test pairs of animals before the 
actual experiments, to check that the software produces acceptable 
results.

▪ The apparent length of the subjects should be at least 10% of the size of 
arena. We recommend that the apparent length of the subject’s body is at 
least 120 pixels for rats and 50 pixels for mice (nose to tail-base).

See also Adjust the settings for nose-tail base detection (Deep learning)

Number of subjects and arenas
You can select Deep learning as body point detection technique in experiments 
with:

▪ One subject per arena, in a maximum of four arenas.
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▪ Two subjects per arena, in a maximum of four arenas.
IMPORTANT  Always draw an arena in the Arena Settings for optimal results.

Video image
▪ When working with one arena at a time, choose a resolution of 640 x 480 or 

higher. 
▪ When working with two to four arenas, choose a resolution of 1280x960 or 

1280x1024, or similar. 
▪ In any case, use video of resolution equal to or higher than PAL/NTSC (PAL: 

704 x 576; NTSC/EIA: 640 x 480). A higher resolution is not necessarily 
better, also considering that it makes tracking slower when tracking offline, 
or can cause missing samples when tracking live. First try a low resolution, 
and switch to a higher resolution if the results are not good. See also 
subject size below.

▪ For live tracking, not all video resolutions and frame rates are compatible 
with Deep learning. See Test results and then click on the camera type for 
configurations tested with Live tracking combined with Deep learning: GigE 
cameras, USB 3.0 cameras, and Analog cameras.

▪ EthoVision XT converts video to grayscale before feeding it to the neural 
network. Therefore, both monochrome and color video work fine.

Video length
▪ One subject per arena: no restrictions. Maximal trial duration tested 72 

hours. See Resolution, frame rate, and maximum trial duration 
▪ Two subjects per arena: we recommend to perform trials of at least five 

minutes. Maximal trial duration tested 1 hour.
During the trials, the two subjects should be separated for at least three 
minutes. If the subjects are in contact for most of the trial duration, 
individual recognition may fail. Also consider that, with two-subject 
tracking:

▪ EthoVision XT saves additional files during acquisition, which increase 
the storage space needed on your PC. A 1-hour video produces 10 MB 
of additional files.

▪ With long trials, the marker could change or droppings would likely 
cumulate in the arena. Both factors could potentially interfere with 
marker recognition.
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Individual marking (for two-subject tracking)
This section refers to tracking two subjects per arena with Deep learning (up to four 
arenas). If you track one subject per arena, you do not need to mark the animals. 
For successful application of Deep learning-based discrimination between two 
individuals, the interacting animals must look different, or be marked.

IMPORTANT  EthoVision XT does not detect differences in the subject’s body size. 
Also, toe clipping, ear punching or tagging won’t work. Differences in fur color and 
markings (also on the tail base) are essential for successful individual discrimination 
with EthoVision XT.

For information about non-invasive marking techniques, see Klabukov et al. 2023. 
Animals 13(22): 3452. https://www.ncbi.nlm.nih.gov/pmc/articles/PMC10668729/

Different fur color

If the two subjects are of different fur color, for example one white and the other 
brown/black, you do not have to mark them.

Tail marks

Tail marks only work if they are close enough to the abdomen of the subject. Only 
mark one subject, not the other. Make one ring leaving some space between that 
and the abdomen:
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In the following figure the tail mark is too far from the abdomen. Individual 
discrimination won’t work.

▪ Advantages: The procedure is painless and easy.
▪ Disadvantages: It may require weekly marking, which could cause stress. 

Furthermore, droppings left in the arena could be detected as tail marks 
and affect individual discrimination. This could especially occur in long 
trials.

Shaving marks

You can use a hair trimmer to shave a patch of fur of one of the subjects. The patch 
must be located along the spine of the subject. If you decide to shave both subjects, 
they must exhibit different patterns. Such marks generally last 1-4 weeks, 
depending on the stage of the hair cycle.
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▪ Advantages: The procedure is painless; grooming and manipulation do not 
remove shaving marks; it may be performed on rodents of all colors.

▪ Disadvantages: The marking is temporary due to hair regrowth; you need to 
monitor the animals regularly to assess the condition of the mark. In long-
term experiments, you need to renew the mark as hair regrows. Also the 
marking may look too irregular, reducing identification rate.

Fur staining

White rodents can be marked with non-toxic dye or felt tip pens. When using 
infrared illumination, make sure that the marks are visible under infrared light. Mark 
only one of the subjects.

 

▪ Advantages: The procedure is easy and painless, and may be used with 
rodents of all ages.

▪ Disadvantages: Dyes may fade over time or due to grooming; daily 
monitoring is needed to assess the condition of the mark; it may be used 
predominantly on white-furred animals; there is potential adverse response 
to solvents and odor. 
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Do not make V-shape markings or separate markings that converge on the 
back of the subjects, since they could interfere with the detection of the 
nose point, like in the following example:

Bleaching

Here the same remarks for shavings apply.

▪ Advantages: The procedure is painless and bleach marks are not removed 
during grooming.

▪ Disadvantages: It may be used on dark-furred rodents only. Furthermore, 
the software won’t work optimally if the part bleached is irregular and so 
large that it breaks the subject’s contour, like in the following example:

IMPORTANT  Remove bleach solutions to avoid skin damage.

Color marking

Color marks could only work when they exhibit different light intensity in grayscale. 
For example, light pink and blue. In the example below, different colors may look 
too similar in grayscale. 
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A safer option is to mark one subject, not the other (see above). For more details 
about color marking, see Tips for color tracking.

Marker location

Make sure that the marks are visible in most cases, also when the animal is sitting 
curled up. In the example below (right), the mark is not visible.

In the following example, the two marks on the rat’s shoulders are just too small 
(left). Combined with the effect of direct lighting (to be avoided in all cases), the 
marks disappear a few frames later (right). Individual recognition won’t work here.
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Size of marks

The mark must be at least 4 x 4 pixels, after the arena has been rescaled to 256 x 
256. This applies to tail marks and marks on the back of the animal.

If in doubt, do the following:

1. Open the video file at zoom level 1:1 (Original size).
2. Make a screenshot of the video window.
3. In a paint program, cut the image to include approximately only the arena.
4. Rescale the arena to 256 x 256 pixels. For rectangular arenas, rescale in such 

a way that the longest side is 256 pixels. Maintain the original aspect ratio.
5. After rescaling, the marker should be at least 4 x 4 pixels, as shown in the 

following image.

Hooded rats

The neural network for two-subject tracking and identification has not been trained 
with the color patterns of hooded rats, so we cannot guarantee that it works when 
tracking two hooded rats. Do some tests before the actual experiments, to verify 
that it provides acceptable results.

Test apparatus and background

Test apparatus

EthoVision XT’s neural networks have been trained with videos of:

▪ One subject per arena, subjects of uniform color: Open field (regular or with 
round objects in it), PhenoTyper (with or without bedding material), 
Elevated plus maze, Three-chamber social approach cage, Barnes maze, 
Fear conditioning cage with floor grid, Y-maze (with no objects), and a 
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maze with multiple chambers and openings. See below the note about 
objects.

▪ One subject per arena, hooded rats: Open field (regular or with round, 
rectangular or triangular objects in it), PhenoTyper (with or without bedding 
material), and Elevated plus maze. 

▪ Two subjects per arena: Open field (with no objects), PhenoTyper (with or 
without bedding material), and home cage.

Size of the arena

▪ One subject per arena: No particular requirements, but see Video image 
above.

▪ Two subjects per arena: Small containers reduce the probability that the two 
animals are separated for sufficient time. This condition is necessary for 
success with Deep learning-based individual recognition.

Background

The figure below shows an example of a good background where the rat’s apparent 
size is about 150 pixels.

 

▪ If the animal is small relative to the arena, and there is no way to zoom in 
the camera image, try to improve the contrast with the background, for 
example by providing more infrared light, in order to compensate for the 
lower level of spatial detail.

▪ Low contrast. In the following example, the mouse is large enough (about 
80 pixels; see above) but the contrast with the background is too low. To 
solve this, increase lighting, or open up the lens’ aperture, or increase the 
camera gain. See Adjust camera settings in EthoVision XT
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▪ Floor grids are compatible with the Deep learning detection technique. If 
necessary, reduce the amount of light to minimize the reflections and 
shadows caused by the metal bars.

▪ Bedding material can also be used with Deep learning-based tracking. 
However, there should be enough contrast with the animals. In this example 
with two mice in a PhenoTyper, the dark individual often went undetected. 

Try increase lighting or, if possible, switch to another type of bedding.
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Too much bedding/nest material can cause occlusions when the animal 
digs in it. In that case the subject detection and discrimination may not 
work properly. 

Here below are examples of setups that worked.

 

▪ Objects. For one-subject tracking, the apparatus can contain objects, like in 
the Novel Object Recognition test, or in the Sociability test. Whenever 
possible, use objects of color different from the subject’s color.

▪ Blind corners. When working with multiple arenas simultaneously, check 
that there are no blind corners, which may reduce detection rate. 
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▪ Corridors and walls. For elevated plus mazes, radial mazes and other 
apparatuses with corridors, make sure that the walls are not of the same 
color as the subject.
In the following example, an excess of light from one side of the test room 
makes the top of the walls of this plus maze look white. A white mouse is 
still detected but when it touches the walls the nose-point and/or the tail-
base point are no longer detected. Dim the lights and adjust their 
orientation to reduce the reflections. 

When you define the Cutout size in the Detection Settings, try not to 
include walls and objects in the cutout box, especially if those objects are 
the same color as the animal. See Adjust the settings for nose-tail base 
detection (Deep learning)

▪ Hole boards. Deep learning-based tracking also performs well in situations 
of low contrast between the subject and the holes, like in the following 
example.
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TIP  Define the target hole as a hidden zone. See Shelters and other hidden 
zones

▪ Apparatuses with backlight
▪ One subject per arena: backlight is compatible but may not be ideal. In 

the following example, the mouse explores a plus maze with an 
infrared-lit background (left). When the mouse dips the head below the 
level of the open arms (right), the nose is not found. To solve this, place 
dim lights on the floor.

▪ Two subjects per arena: backlight is not compatible.
▪ Tethered animals

▪ One subject per arena: When running experiments with tethered 
animals, the contour of the subjects seen by EthoVision XT is often 
disrupted by the fiber. The Deep learning technique may not be able to 
resolve the position of the nose. We did not test Deep learning with 
tethered animals. Therefore, run a few tests with sample videos to make 
sure that detection of the nose point is accurate enough. To improve 
detection of tethered subjects, use the Dilation and Erosion filter 
options. See an example in Advanced detection settings: Subject 
contour
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▪ Two subjects per arena: this setup has not been tested thoroughly, 
therefore applying Deep learning is not recommended.

Recording protocol
▪ One subject per arena: No particular limitations.
▪ Two subjects per arena: preferably, tracking should start when both animals 

are in the arena. The software also works when you release one animal first, 
then the other. However, for best results, ensure that the second animal is 
released within up to 30 seconds after the first.

▪ With the Trial Control Settings, you can ensure that the data acquisition 
starts when both subjects are in the arena. See Start the trial in the Social 
interaction test

Behavior Recognition
Unfortunately, it is not yet possible to combine Deep learning for body point 
detection and Behavior Recognition for behavior classification in the same 
experiment. When you select Deep learning under Body Point Detection 
Technique in the Experiment Settings, the Behavior Recognition option is grayed 
out.

Test results
We tested Deep learning with various combinations of PCs, graphics cards and 
cameras. We recommend to use a high-end workstation when working with Deep 
learning - based tracking. Click the link that applies based on which camera type 
you have:

▪ GigE cameras
▪ USB 3.0 cameras
▪ Analog cameras

In all the tests we used live tracking + save video, with one arena per camera. All 
tests were based on an open-field experiment with a black mouse and a clearly 
contrasting gray background.

See also

▪ Cameras supported by EthoVision XT
▪ System requirements > Hardware
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More information on graphics cards 
(GPUs)
Aim

▪ To provide you with information about graphics cards and their software 
that is needed to perform video tracking with the Deep learning technique.

▪ This topic does not apply if you track your subject with Contour-based 
method.

NOTE  Technically, the GPU indicates the main processor in the graphics card. The 
graphics card includes other components such as the video memory (VRAM), the 
printed circuit board (PCB), a power management unit, the PCIe connectors, the 
display connectors etc. In this topic we assume that GPU coincides with the physical 
board that you install on your PC.

GPU microarchitecture
Graphics cards are categorized based on their microarchitecture. Such categories 
are also known as generations.

To know which microarchitecture category your GPU belongs to, browse to

https://en.wikipedia.org/wiki/CUDA

▪ Under the table Compute Capability, GPU semiconductors and Nvidia 
GPU board products locate the name of the GPU in the column GeForce. 
The name under Micro-architecture tells which generation the GPU 
belongs to.

▪ In the table Compute Capability (CUDA SDK support vs. 
Microarchitecture) you can see whether that GPU generation works with 
the CUDA SDK version used with EthoVision XT - currently 12.2.

GPU speed
When comparing two GPUs for deep learning applications, one of the best 
indicators is the memory bandwidth, rather than single properties like the GPU 
memory speed. A GPU's memory bandwidth determines how fast it can move data 
from/to the memory (VRAM) to the computation cores. 

Theoretically, the memory bandwidth depends on:

▪ The memory clock speed (in Hz). 
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▪ The width of the data bus between the card memory and the graphics 
processor, in bits (also known as memory interface). This is the physical 
count of bits that may fit along the bus every clock cycle.

▪ The memory type (the so-called memory clock type multiplier).
Memory bandwidth is measured in GB/s. For example, a graphics card with 
bandwidth 1000 GB/s is expected to perform two times faster than one with 500 
memory bandwidth. Again, this is just a rough indication of the difference in 
performance, as the real performance may depend on several other factors, 
including the neural network architecture. If there is no reading from memory at 
any particular clock cycle, that cycle's worth of bandwidth goes unused and cannot 
be stored and used later when there's more memory pressure. Because GPS tend to 
acquire data in spurts, the usable bandwidth is generally lower than the numerically 
available bandwidth.

Another useful measure is the number of Floating Point Operations per Second 
(FLOPS). For example:

▪ For the NVIDIA Quadro P2200: 3.8 TFLOPS (teraFLOPS equal to 1012 FLOPS).
▪ For the NVIDIA T1000: 2.5 TFLOPS
▪ For the NVIDIA GeForce RTX 4060: 15.1 TFLOPS.

For the specifications of graphics cards, see the following web site:

https://www.techpowerup.com/gpu-specs/

GPUs tested and supported
The following NVIDIA graphics cards have been successfully tested with Deep 
learning-based tracking.

TIP  Install the most recent driver version that is available on the NVIDIA web site for 
that GPU.

Desktop

NOTE  The GeForce RTX 4060 is a dual-slot GPU, that is, it occupies two PCIe slots. 
Moreover, there are several versions of this board, with two or three fans. Make sure 
it can fit in your PC. Both the T1000 and the MSI GeForce 4060 Ventus 2X (dual fan) 
fit in the Dell Precision 3680 desktop computer.

GPU Architecture Memory Bandwidth Driver v.
T1000 Turing 4 GB GDDR6 160 GB/s 553.09

GeForce RTX 
4060

Lovelace 8 GB GDDR6 272 GB/s 552.22
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Laptop

NOTE  If you install new GPU on a computer that you have used for some time to 
acquire the data with Deep learning, you must update the neural network model 
that is stored on your computer. See Update the neural network model after 
installing a new GPU

Performance
A few NVIDIA GPUs were tested in an EthoVision XT experiment with four arenas, 
one subject per arena, Deep learning as a body point detection technique. A 5-
minute video of resolution 1280 x 1024 and frame rate 30 fps was used. The average 
time taken to acquire one trial was as follows:

▪ Quadro P2200: 4 min 29 s.
▪ T1000: 4 min 24 s.
▪ GeForce RTX 4060 Ventus 2X: 1 min 58 s.

Importance of CUDA
The driver of the graphics card must support the CUDA component. CUDA is a 
parallel computing platform and programming model created by manufacturer 
NVIDIA that helps speed up applications by using the power of graphics cards.

However, each graphics card seems to have its own latest driver version in Windows 
Update. For the cards specified above, Windows Update installs the needed 
minimal version. However, other cards may need more recent versions than that 
available with Windows Update. When a driver version is not sufficient for 
supporting CUDA, EthoVision XT gives the message in the Experiment Settings: 

The graphics card driver is outdated or not installed, or the graphics card does not 
support CUDA. 

We recommend to download and install the latest driver from the card’s 
manufacturer. This should make the card work properly with CUDA, provided that 
the hardware supports that version. 

To know whether your NVIDIA graphics card is CUDA-enabled, refer to this web 
page:

https://developer.nvidia.com/cuda-gpus

GPU Architecture Memory Bandwidth Driver v.
RTX 1000 Mobile Lovelace 6GB GDDR6 192 GB/s 553.09
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CUDA version
If your GPU is already installed on the PC, follow these steps to know which version 
of CUDA is installed.

1. In Windows Explorer, locate the folder 
C:\ProgramData\Noldus\Components\Ethovision\TrackerInterfaceNN\[versi
on number]

2. In that folder you find a file named CudaReport.txt. 
3. Open this file. The runtime version should give an indication of the version 

of CUDA currently present on your PC.
If you do not see the folder specified above, create an experiment and in the 
Experiment Settings under Body Point Detection Technique select Deep 
Learning. Next, check again the folder in step 1.

NOTE  The version of CUDA is not the same thing as the version of the driver of the 
GPU!

Which GPU should I choose?
▪ Choose in any case a recent NVIDIA GPU of the series 1000, 2000, 3000 or 

4000. However, a very recent GPU or one of a new generation may not be 
compatible. Contact Noldus if in doubt.

▪ In principle, a graphics card of the Pascal microarchitecture category, with 4 
GB memory, 1024 CUDA cores and memory bandwidth up to 140 GB/s 
represents the minimum specifications. Click one of the links below 
depending on the camera you use. In the table that appears, locate the row 
with a specific graphics card and DL (Deep learning) specified in the 
rightmost column:
▪ GigE cameras
▪ USB 3.0 cameras
▪ Analog cameras

▪ The number of CUDA cores could be a good indicator of performance if 
you compare GPUs within the same microarchitecture (generation). 
However, when you compare cards between generations (e.g. Pascal vs. 
Turing) then the difference in the number of CUDA cores does not predict 
the actual difference in performance. An older card with more CUDA cores 
may not perform as good as a more recent card with fewer CUDA cores.

▪ Overall, newer generations perform better; for example, an Ampere GPU 
should perform better than a Turing GPU.
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▪ GPUs of the Maxwell generation / 900 series are not supported with 
EthoVision XT 18.

▪ Note that a more powerful GPU requires more power from the PC. Make 
sure that your PC has enough power to feed the GPU. See the prerequisites 
in Install a graphics card for Deep learning.

▪ Performance of a graphics card not only depends on its own characteristics; 
it also depends heavily on the sample rate and the resolution chosen in 
EthoVision XT. See Video source 

See also

▪ Install a graphics card for Deep learning
▪ Deep learning: Requirements
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Install a graphics card for Deep learning
Aim
To give general information about the installation of an advanced graphics card 
(Graphics Processing Unit, or GPU).

NOTE  This topic is not exhaustive and is not focused on a particular graphics card. If 
you need more details, see the documentation provided by the card’s manufacturer.

Prerequisites
▪ Space requirements. Ensure that there is enough space around the card in its 

final position. Other cards could reduce ventilation and cause overheating. 
If necessary, remove those cards and place them on another slot. Plan 
additional space for the cables.
▪ The NVIDIA T1000 needs 15.5 cm x 6.9 cm (6.1” x 2.7”). This card 

occupies one PCIe slot.
▪ The NVIDIA RTX 4060 dual fan needs 24.7 cm x 13 cm x 4.1 cm (9.8” x 

5.1” x 1.6”). This card occupies two PCIe slots.
▪ Power requirements. Ensure that the computer has a Power Supply Unit 

(PSU) that can provide enough power to the graphics card. Some graphics 
cards need additional power. For example:
▪ The NVIDIA T1000 has a maximum power consumption of 50 W and a 

suggested PSU of 250 W.
▪ The NVIDIA RTX 4060 dual fan has a maximum power consumption of 

115 W and a suggested PSU of 300 W.
▪ Power cables. Make sure your Power Supply Unit has the correct connectors 

to support the graphics card. Cheap PSUs may offer fewer options and 
shorter lengths. Check with your motherboard and graphics card 
documentation to determine which connector types are needed.
▪ The NVIDIA T1000 does not need an additional power supply.
▪ The NVIDIA RTX 4060 needs a power cable with a PCIe 8-pin connector.

▪ A graphics card must support the CUDA software. Check on this web page 
if you have a NVIDIA graphics card:
https://developer.nvidia.com/cuda-gpus
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Procedure
IMPORTANT  Before installation, disconnect the AC main source and place the 
computer on a stable surface. Discharge your body’s static electricity by touching a 
grounded surface, for example, the computer chassis. Do not install near water or 
when your hands or body are wet.

1. Remove the cover/side panel of the computer. 
2. Remove any existing graphics card (if there is one). 
3. Remove one or two adjacent slot brackets. Some graphics cards are double-

wide and require removing two slot brackets.
4. Plug the graphics card into the Primary PCI Express (PCIe) x16 slot on your 

motherboard. This is often the slot closest to the CPU. Sometimes this slot 
has a color different from the others (for example, blue instead of black), or 
has a retention lever on one end.

5. Most graphics cards need additional power. For this reason they have their 
own power connector. Connect the 6-pin (or 6+2 pin, or 8 pin) power 
connector from the PC’s power supply to the power connector on the card.
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NOTE  The connector and socket on the graphics card have a unique shape 
and connect one way only.

6. Put the cover back on your computer and reconnect any cables that you 
removed earlier.

7. Install the drivers that come with the card. When possible, choose to 
activate the automatic update of the drivers.

8. Restart the computer.

Update the neural network model after installing a new GPU
Follow the procedure below if you installed a new GPU and you have used the deep 
learning-based tracking technique on that computer.

Background information: The deep learning trackers use a built and serialized 
model specific for the GPU. This needs to be rebuilt when a different GPU is used. 
Do one or both of the two depending on what applies to your situation:

▪ When tracking one 1 subject per arena: Open the folder 
C:\ProgramData\Noldus\Components\Ethovision\TrackerInterfaceNN\3 (or 
latest version number).
Remove the file modelnn.trt and model_hoodednn.trt

If that does not solve the issue, in the Control panel > Programs and 
Features remove the component Noldus – Tracker Interface NN – x64 
Package – 3. Next, repair EthoVision XT from the installation package 
(choose Repair in the start screen).

▪ When tracking two subjects per arena: Open the folder 
C:\ProgramData\Noldus\Components\Ethovision\TrackerInterfaceMST\1. 
Remove the file model_mstnn.trt.
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If that does not solve the issue, in the Control panel > Programs and 
Features remove the component Noldus – Tracker Interface MST – x64 
Package – 1. Next, repair EthoVision XT from the installation package 
(choose Repair in the start screen).

Notes
▪ Install the graphics card into the primary PCI Express x16 slot. If you install 

the graphics card into the secondary slot, your system may not recognize 
the graphics card and there will be nothing displayed on the monitor. When 
your PC has more than one PCI Express x16 slots, you can configure the 
physical location of the primary slot in the motherboard’s BIOS.
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Behavior Recognition: Requirements
Species

▪ The Behavior Recognition function has been developed and tested for 
tracking rats and mice, not other animal species.

Number of arenas
▪ When tracking live: one arena.
▪ When tracking from pre-recorded video files: one to four arenas.

Subjects
▪ If you use multiple arenas, the subjects must have similar size. The apparent 

size of the subjects is specified in the Detection Settings. That size is used 
for all arenas.

▪ The subject’s length (nose to tail base) in the video image must be at least 
60 pixels for rats, and 55 pixels for mice. In all cases its length must not 
exceed half the arena size.

▪ The subject’s fur must be of uniform color. Hooded animals like Lister and 
Long-Evans rats have not been tested with Behavior Recognition.

▪ For rats: the subject must be older than approximately three weeks. In all 
cases the subject must be able to walk.

▪ In the Detection Settings, make sure that the subject’s tail is not detected. 
To do so, use the erosion filter. See Advanced detection settings: Subject 
contour

▪ Behavior detection is much depending on the subject age and size. For 
Wistar rats of age 3-5 weeks, the behavior size setting can be used about 
one week; from age 5 weeks on, it may be used two weeks. We advise to 
create separate Detection Settings for different age classes.

Camera and video
▪ The camera is placed above the subject, and provides a top view of the test 

setup.
▪ Because video compression introduces artifacts, live video is preferred over 

pre-recorded video.
▪ Video frame size (video resolution) must be greater than 352 x 288 per 

arena.
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▪ The frame rate of the recorded videos can only be a multiple of the sample 
rate that you intend to use. For example, for a sample rate of 25 samples 
per second, the camera/video file frame rate should be 25 or 50 etc. For a 
sample rate of 30, set the frame rate to 30 or 60.

▪ The video image must not be overexposed. Details of the subject’s fur must 
be visible.

▪ If you use pre-recorded video, compression should be as lossless as 
possible. Reducing compression by decreasing the GOP size (that is, the 
number of video frames between two full frames) produces better results 
than increasing video resolution. Values of GOP size of 10-15 worked well, 
however the lower the better. Reducing GOP size, however, increases file 
size.

▪ To check that your video file has artifacts, create a separate experiment with 
Activity analysis enabled. Set the Activity threshold to a minimum. See 
Activity settings. If video contains artifacts, you should see purple pixels 
appearing with a regular rhythm. See also Troubleshooting: Behavior 
recognition

▪ Try to avoid evident fish eye-effect (barrel distortion) in the video image, 
which hampers behavior recognition. If necessary, use a lens with lower 
distortion.

Test environment
▪ The test setup must be simple, for example a home cage (without bars) or 

an open field with no objects around.
▪ The animal should not climb on top of objects like a shelter. When the 

animal climbs on top of an object, it gets closer to the camera, and its 
apparent size changes significantly. This may bias results. See also Behavior 
Recognition: Data, performance and accuracy

▪ Lighting must be from the top, not backlighting. Slow changes in lighting in 
the course of the test are not a problem, but moving spotlights reduce 
reliability of detection.

▪ Avoid reflections on the walls.

Tracking settings
▪ In the Experiment Settings, you must select Contour-based as Body Point 

Detection Technique.
▪ In the Detection Settings, the sample rate must be set between 25 and 31 

samples per second.
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Further recommendations
▪ During acquisition, keep DDS (Detection Determines Speed) selected.
▪ After acquiring data, visualize the detected behaviors in the Integrated 

Visualization and check whether no gaps between scored behaviors occur. 
If gaps occur, which are not due to the fact that the subject is not found, 
they could be the result of video frames not being analyzed due to high 
processor load. To decrease processor load, lower the video resolution. 
Also, try not to use Differencing as detection method, and any of the 
methods named For occlusions as the tracking method. See Advanced 
detection settings: Method
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Behavior Recognition: Data, performance 
and accuracy
Data 
With the Rat/Mouse Behavior Recognition functions, the following behaviors can 
be automatically detected: digging (only for mice), drinking, eating, grooming, 
hopping (for mice), jumping (for rats), rearing (unsupported and supported), 
resting, sniffing, twitching (for rats), and walking. For the definition of those 
behaviors, see Behavior Recognition.

For each video frame, behavior is detected analyzing a number of frames before 
and after the current one.

▪ Behavior data are available from the start of the track, to about 13 s before 
the end of the track when using a default Trial Control Settings, which has 
an additional condition for starting the track (see the figure below).

▪ When the Trial Control Settings does not have the special condition 
mentioned above, behavior is not scored in the first 3 seconds of the track 
(see (*) in the figure below).

▪ When samples are missed or the subject is not found for a maximum of 0.4 
seconds, the subject’s position and size is interpolated using the adjacent 
frames.

▪ When samples are missed or the subject is not found in for more than 0.4 
seconds, or when the subject enters a hidden zone, the behavior detector is 
reset. This means that behavior is not scored some time before the first 
missing sample (or before entering the hidden zone) and after last missing 
sample (or after exiting the hidden zone). The behavior is set to Unknown 
(see the figure below for the exact times).
We advise you to adjust the duration of the trial in the Trial Control Settings. 
For example, set 6 minutes of track duration to get at least 5 minutes of 
automatically-detected behaviors. 

Below: Schematic representation of which portions of the track do not result in 
detection of behavior with the Behavior Recognition function. Times next to 
Unknown are shown for Mouse Behavior Recognition (in bold) and Rat Behavior 
Recognition.

*) The first part of the track is scored as Unknown only if you start tracking as soon 
as the animal is detected in the arena. If your Trial Control rule includes a condition 
that waits 3 seconds after the animal is detected, then you make sure that behavior 
is scored from the start of the track. We recommend to use the default Trial Control 
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Settings for experiments set to Rat or Mouse Behavior Recognition, which include 
this additional condition.

NOTE  To visualize or analyze the portions of the tracks scored as Unknown, select 
Unknown in the behavior property window in the Analysis profile.

Performance
When Behavior recognition is selected, and you track live, use maximally one arena. 
To improve performance, and avoid samples being discarded because of the use of 
too much processor capacity, follow these rules:

▪ As a detection method, use one of the Subtraction methods, not 
Differencing.

▪ For the nose-tail tracking, try first Rodents / Default, not Rodents / For 
occlusions. Use the latter only if the first does not give good results.

Accuracy 
▪ Rat Behavior Recognition was trained on Sprague Dawley rats and tested 

on various strains by DeltaPhenomics and Radboud University Nijmegen, 
The Netherlands. The details of this validation are in the publication listed 
below.

▪ Mouse Behavior Recognition was trained on C57Bl6 mice, and tested on 
various models and strains including BalbC, CD1 (white), and TgAD models. 
The module has been beta tested by four experienced animal behavior 
specialists at different labs (two in USA, two in Europe).

The average recall rate, that is, the fraction of ground truth manually scored 
behaviors that EthoVision XT recognizes correctly, is 0.70.

See the following paper:
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van Dam, E., J.E. van der Harst, C.J.F. ter Braak, R.A.J. Tegelenbosch, B.M. Spruijt, 
L.P.J.J. Noldus (2013). An automated system for the recognition of various specific 
rat behaviours. Journal of Neuroscience Methods 218 (2), 214–224.

http://dx.doi.org/10.1016/j.jneumeth.2013.05.012

See also

▪ Trial control With Behavior recognition
▪ Behavior Recognition in the Analysis profile
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Live Mouse Tracker: Workflow
Background information

▪ Live Mouse Tracker (https://livemousetracker.org) is a system for prolonged 
monitoring of mice housed in small groups and in enriched environment.

▪ Tracking and individual recognition is based on a Kinect depth camera and 
RFID antennas and readers.

▪ You can track up to four subjects (tested).
▪ For the assembling instructions: see https://livemousetracker.org.
▪ EthoVision XT supports data of Live Mouse Tracker version 1.0.3 (October 4, 

2022).

Prerequisites
▪ You must have the Social Interaction add-on module in your EthoVision XT 

license. See Upgrade EthoVision XT

Procedure
1. Assemble the Live Mouse Tracker setup.
2. Connect all the hardware to the PC.
3. Collect the data with Live Mouse Tracker.
4. In EthoVision XT, create an experiment in Live Mouse Tracker mode.

Choose File > New Experiment. Select the check box Live Mouse Tracker 
experiment.

5. Import Live Mouse Tracker data. For this you need the Live Mouse Tracker 
databases and the video files (optional).

6. In the Analysis profile, choose the dependent variables. See Live Mouse 
Tracker

7. Visualize and analyze the data.

Notes
▪ Live Mouse Tracker works with 3D coordinates (x, y, z). While analysis is 

mostly based on 2D (x,y) coordinates, some dependent variables are also 
based on the z-coordinates, for example Rear. See Dependent variables for 
Live Mouse Tracker
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▪ In the Live Mouse Tracker database, the x and y coordinates are in pixels, 
while z is in mm. However, EthoVision XT converts pixel coordinates to 
distance Units specified in the Experiment Settings.

▪ In Live Mouse Tracker experiments you can also analyze data using the well-
known analysis variables like Velocity and In zone. However, the following 
variables won’t be available in your Analysis profile, because they cannot be 
calculated with Live Mouse Tracker data:
▪ Head direction and Head directed to zone.
▪ Turn angle when it is based on head direction.
▪ Activity and Activity state.
▪ Body elongation and Body elongation state.
▪ Mobility and Mobility state.
▪ Body contact.
▪ Behavior Recognition (all behaviors).
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Live Mouse Tracker: Create an experiment
Aim
To create an EthoVision XT experiment that is compatible with the Live Mouse 
Tracker behavioral data acquisition system.

Background information
An EthoVision XT experiment set to Live Mouse Tracker is a modified version of a 
standard, multi-subject, multi-body point experiment, with predefined, permanent 
settings. The main characteristics are:

▪ In the Experiment Settings, the Video Source is Video file, the Number of 
Arenas is 1, the Number of Subjects is 4 and under Tracked Features the 
option Tracker add-in is selected. We recommend not to change those 
settings. You can, however, change the settings under Units.

▪ In the Arena Settings, the arena is already calibrated using the scaling factor 
of Live Mouse Tracker. If you like, you can add zones for analysis beyond the 
standard readouts of Live Mouse Tracker.

▪ Trial Control Settings, Detection Settings, Acquisition, and Track Editor have 
been removed because they are not relevant in Live Mouse Tracker.

▪ All analysis functionalities of EthoVision XT are kept. So you can, for 
example, analyze the tracks obtained with Live Mouse Tracker combined 
with zones using a Data profile, or combine Live Mouse Tracker readouts 
with the EthoVision XT analysis variables.

For more information about the Live Mouse Tracker acquisition system, see the 
following link:

https://livemousetracker.org

Prerequisites
▪ You have collected data using the Live Mouse Tracker acquisition system.
▪ You must have the Social Interaction add-on module in your EthoVision XT 

license. See Upgrade EthoVision XT

Procedure
1. Choose File > New.
2. Enter a name for the experiment.
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3. Select the Live Mouse Tracker experiment. 
4. Click OK.

5. Next: Import Live Mouse Tracker data.

Notes
▪ You may notice that in all Live Mouse Tracker experiments, when opening 

the Experiment Settings, under Tracked Features, the option Tracker add-
in is selected. This is the correct selection in the experiments made for Live 
Mouse Tracker. Please leave it as it is.

See also

▪ Live Mouse Tracker: Workflow
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Manual scoring settings
Learn about

▪ Scoring behaviors manually

What do you want to do?
▪ Define the behaviors that you want to record manually
▪ Edit the manual scoring settings
▪ Validate the manual scoring settings
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Scoring behaviors manually
Aim

▪ To record rodent behaviors that cannot be detected automatically with the 
Rat and Mouse Behavior Recognition; for example, pouncing or fighting. 

▪ To record behaviors in animals other than rodents; for example, thrashing in 
fish.

NOTE  You can also score behaviors after acquisition, for example to correct scoring 
errors and add data. See Score behaviors manually after acquisition

Procedure
1. Define the behaviors that you want to record manually.
2. OPTIONAL  Score behaviors manually during acquisition.

You score behaviors and events by pressing a predefined key or clicking an 
appropriate button on the screen as soon as the behavior or event occurs. 
Score behaviors manually after acquisition.

NOTE  This is only possible when you have tracked from a video file, or you 
tracked live and saved video.

Notes
▪ Manual scoring settings are not available in a DanioVision experiment.
▪ Manually-scored behaviors are stored in a special Manual scoring log 

associated with the track data.
▪ If you record video and track later, you can only record events when you do 

tracking, not during video recording.
▪ If you are familiar with The Observer XT software, the manual scoring 

settings in EthoVision XT is a simplified The Observer XT coding scheme. 
You can export the scored behaviors to The Observer XT for further 
analysis. See Export manually-scored behaviors

▪ With the Rat (or Mouse) Behavior Recognition module, EthoVision XT can 
detect a set of rodent behaviors automatically. See More about Experiment 
Settings
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Define the behaviors that you want to 
record manually
Prerequisite
Think in advance how the different categories of behavior relate to each other. You 
may for example want to score different types of grooming (Unilateral stroke, 
Bilateral stroke etc.). Each type will be a behavior, however these are best organized 
in a group. If you plan to score behaviors that do not relate to each other (for 
example Rearing and Drinking), they do not need to be defined in a group.

Procedure
1. Choose Setup > Manual Scoring Settings, or in the Experiment Explorer, 

click Manual Scoring Settings.

2. Click the Add Behavior button or press Ctrl+B. The Add Behavior window 
appears.
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3. Next to Behavior name, enter the name to the behavioral category you 
want to score. For example, Follow, or Bite.

4. Next to Behavior type, choose the type of behavior. This choice affects how 
you score the behavior relative to others. See Behavior types

5. If in the previous step you have chosen Mutually-exclusive, then the 
Behavior group list becomes available. Type in the name of the group the 
behavior belongs to, or, if you have already defined it, select it from the list.
If you have chosen Start-Stop or Point event, the behavior cannot be part 
of any group, and therefore the Behavior group list is not available. Go to 
the next step.

6. Enter a Description (optional) for the behavior. 
7. If you think that the behavior is active at the start of the trial, select the 

Initially active option.
8. Click OK. The behavior is listed in the table, under the group it belongs to.
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9. In the cell under Keys, select the keyboard key that you want to use for 
scoring that behavior. See Choose the keys for coding

Behavior types

Mutually exclusive 

The behavior will be part of a group, where one item, when scored, automatically 
switches off the item currently active. For example, you define a group of two 
behaviors, Rearing and No Rearing. When the subject shows rearing, score this 
behavior. Rearing is now active. As the subject stops rearing, score No rearing. This 
state is now active, while Rearing is stopped automatically.

Within a mutually-exclusive group, only one behavior can be defined as initially 
active. If one of the behaviors of a Mutually-exclusive group is already selected as 
Initially active and you check the same option in the Add Behavior window for a 
second behavior, the program asks you whether you want to remove that option for 
the first behavior. Click Yes to do so. If you click No, you return to the dialog, so you 
can clear the Initially active option.

In the Dependent variable plots, a mutually-exclusive group of behaviors would 
look like this:

Start-Stop

Scoring that behavior is fully independent of other behaviors. To stop that behavior 
you must press the Stop key.

In the Dependent variable plots, a Start-stop behavior would look like this:
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Point event

With this option you only score a point of time when the behavior occurs. Choose 
this option when you only want to measure the frequency, not the duration of the 
behavior. Typical examples of such behaviors are biting and twitching.

In the Dependent variable plots, a Point event would look like this:

Choose the keys for coding
▪ It is not required to use key codes. You can also score events using the 

mouse.
▪ Choose keys that you can press without taking your eyes off the keyboard 

(for example A, S, D) rather than keys which are easy to remember. If your 
scoring settings contain so many behaviors that you cannot remember the 
keys, it is probably too complex.

▪ For each cell you can enter one key, among those available a...z, and 0...9. 
▪ If your setup includes multiple subjects and arenas, choose a key for each 

arena-subject-behavior combination.
▪ For Start-Stop behaviors, choose a key to Start the behavior and a key to 

stop it. You can also define the same key for starting and stopping it.
▪ Only the keys available are listed, not those already in use. For Start-Stop 

behaviors, you can select the same key for both starting and stopping a 
behavior.

Notes
▪ For mutually-exclusive behaviors, It is always a good idea to define a 

default behavior that can be scored when the subject does not show any 
significant behaviors. Choose this behavior as Initially active.

▪ Names of groups and start-stop behaviors are displayed in a gray row. 
Names of mutually-exclusive behaviors are displayed in a white row under 
the corresponding group name.
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▪ Behavior names and group names must be no more than 64 characters 
long. The characters you use, must be Unicode characters in the Basic 
Multilingual Plane range. See the following web page:
http://en.wikipedia.org/wiki/Plane_(Unicode)#Basic_Multilingual_Plane

▪ How many behaviors? You can define as many behaviors as you need. 
However, since the number of available keys is 36, we advise you to limit the 
number of arena-subject-behavior combinations to 36, so you can assign a 
keyboard key to a behavior of a specific subject in a specific arena. If you 
need to define more combinations, do so without assigning a key code. You 
can score those behaviors by clicking the corresponding button on the 
acquisition screen. 
When you need to score behaviors live, keep the scoring settings as simple 
as possible, with few behaviors. If you try to score many complex behaviors 
at once then you may make mistakes.

See also

▪ Score behaviors manually
▪ Analyze a Manually scored behavior
▪ Export manually-scored behaviors to The Observer XT
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Edit the manual scoring settings
Rename a behavior or behavior group
Click the name of the behavior or behavior group, make the necessary changes and 
press Enter.

Modify the key code
Click the cell under Keys for a behavior, and type in the new key code, or select 
another key. If the new key you want to use is assigned to another behavior, it is not 
available in the Keys list. Pressing that key on your keyboard makes no change in 
the selected cell.

To delete a key code, click the corresponding cell and press Backspace.

Edit the behavior properties
Double-click the behavior row or right-click and select Edit Behavior. 

Create a new behavior group
Create first a behavior that belongs to that group, then from the Behavior type list 
select Mutually-exclusive, and in the Behavior group list enter the name of the 
new group.

Add a behavior to a specific group
Right-click the behavior group row and select Add Behavior. Type in a new name.

Delete behaviors and behavior groups
You can delete a behavior or behavior group only after you have deleted all your 
trials. Right-click anywhere on the behavior (or behavior group) row, and select 
Delete Behavior (or Delete Behavior Group).

IMPORTANT If you delete a behavior group, all behaviors of that group are deleted!

Move a behavior from one group to another
Double-click a behavior to edit it. In the Edit Behavior window, select the Behavior 
group you want to move the behavior to.
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Edit manual scoring settings after acquiring data
Choose Setup > Manual Scoring Settings.

You can:

▪ Add a new behavior.
▪ Rename an existing behavior or behavior group.
▪ Edit the behavior’s description.
▪ Set a behavior as Initially active. This won’t modify your existing data, it will 

only set that behavior as initially active for the next trial. 
You cannot:

▪ Delete behaviors, unless they have been added after data acquisition. If you 
acquire more trials, those new behaviors cannot be deleted.

▪ Rename or change the properties of behaviors in a Quality Assurance 
experiment.
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Validate the manual scoring settings
Aim
To have EthoVision XT check that the coding scheme is consistent.

Procedure
In the Manual Scoring Settings screen, click the Validate button or press Ctrl+V.

The program checks that the manual scoring settings are valid every time you leave 
the Manual Scoring Setting screen.

Notes
Manual scoring settings are valid if:

▪ For Start-Stop behaviors: A key has been selected for both start and stop, or 
for neither of the two. If you define a start key but not a stop key or vice 
versa, when leaving the manual scoring settings an error message is 
displayed.

▪ For Mutually-exclusive behaviors: All behavior groups contain at least two 
behaviors, and one is selected as Initially active.

▪ All behaviors and behavior groups have unique names.
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Arena Settings

Main topics and tasks
▪ Introduction to Arena Settings  213
▪ Make the arena  219
▪ More about zones  236
▪ Work with shapes  257
▪ Work with multiple arenas  264
▪ Further information on Arena Settings  273
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Introduction to Arena Settings
Learn about

▪ Important terms in Arena Settings
▪ Useful things to know about Arena settings
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Important terms in Arena Settings
Arena
An arena is the region in the video image on the screen in which a moving Subject 
is tracked by EthoVision XT. You can have one or more (up to 100) separate arenas 
in one screen. If you have multiple arenas, they must not overlap.

See also

▪ Physical setup of an arena

Zone
A zone is a specific area of interest within an arena. For example, in a Morris water 
maze, define the hidden platform as a zone named Platform.

You can use a zone to calculate, for example, the time the animal spent in that zone, 
or the number of zone visits; you can also use a zone for starting and stopping data 
acquisition.

Point
A point is a dimensionless object that you can use as a reference. For example, an 
odor source that is the target of an insect. You can define the source as a point, to 
determine whether the animal is heading towards that spot. 
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Cumulative zone
A zone that combines two or more existing zones, so you analyze them as one. For 
example, the two open arms “Open arm 1” and “Open arm 2” of an Elevated plus 
maze can be analyzed as a Cumulative zone “Open arms”.

Hidden zone
A zone that you can use to calculate the time that the subject stays out of view, for 
example in a shelter.

Zone group
You can organize zones in zone groups. Within one zone group, zones must be 
non-overlapping. 

See also

▪ Organize the zones in your arena
▪ Cumulative zones
▪ Shelters and other hidden zones
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Useful things to know about Arena 
settings
Define different Arena Settings in the same experiment
Arena Settings define the configuration of arenas and zones in an experiment. You 
can create as many Arena Settings as you want. This can be useful if your trials are 
carried out with different zones configuration. For example, when the position of 
the hidden platform changes in different trials in a Morris water maze experiment.

Arena Settings in the Experiment Explorer
All Arena Settings you create are listed under Arena Settings in the Experiment 
Explorer.

To open Arena Settings, choose Setup > Arena Settings > Open, or in the 
Experiment Explorer, under Arena Settings, click one of the Arena Settings. 

The Arena Settings currently active are shown in blue. Acquisition is done using 
those settings, unless you specify otherwise in the Trial list or in the Acquisition 
Settings window.
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Read-only Arena Settings
Arena Settings that have been used in acquisition are 'read-only' and can not be 
renamed or deleted. Read-only Arena Settings are indicated by a small lock symbol 
in the Arena Settings icon.

You can make an editable duplicate of read-only Arena Settings, edit it and use the 
new settings for acquisition. Alternatively you can delete all trials, which unlocks the 
read-only arena settings. In addition:

▪ Zones that are used in Trial Control cannot be deleted or edited.
▪ You can add new zones to read-only arena settings.

See also

▪ Settings and profiles

Working with layers
The elements of the Arena Settings are organized in layers. 

▪ To display arenas, zones, calibrations and background image on your 
screen, select an arena, zone group, zone, calibration or background image 
by clicking its row in the Arenas and Zones section. This way you can 
highlight the correct layer.

▪ To hide a layer, deselect the corresponding check box in the View column.
▪ To view more than one layer at the same time in the video image, select the 

appropriate check boxes in the View column. In the figure below, Arena 1 
and Background are selected in the View column and therefore visible.
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See also

▪ Organize the zones in your arena
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Make the arena
What do you want to do?

1. Grab the background image
2. Calibrate the arena
3. Draw the arena
4. Define zones (optional)

Organize the zones in your arena

5. Validate the Arena Settings

See also

▪ Draw a point
▪ More about zones
▪ Work with multiple arenas
▪ Make a subdivided arena
▪ Draw a point
▪ Validate the Arena Settings
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Grab the background image
Aim
To create a background that you can use to draw arenas and zones.

Procedure
1. Choose Setup > Arena Settings > New or right-click Arena Settings in 

the Experiment Explorer and select New.
Result: The Grab Background Image window opens.

2. If you track from video, click Browse and open a video file. In the Video 
window, if possible, browse to a video frame without animals. Then click 
Grab.
If you track live, if possible, remove the animal from the arena and click 
Grab. 

3. Check that the aspect ratio of the background image is correct, and if 
necessary, adjust it (see Check the video aspect ratio).

Notes
▪ If the Grab Background Image window shows a white background, that may 

be due to the graphics card settings. See Troubleshooting > The camera 
image is not shown in the Arena Settings or Integrated Visualization

▪ You can define and update a background of existing Arena Settings at any 
time, as long as they are not read-only. To do so, click the Grab 
Background Image button in the lower part of the Arena Settings window. 

▪ For all experiments from video: The default video file shown in the Video 
window is the last video used to grab a background image.

▪ For DanioVision experiments: After grabbing the background image, 
EthoVision XT attempts to detect the well plates and draw the arenas 
automatically. Check that the outline of the arenas overlap with the well 
borders. If they do, click Yes in the window that appears. For more 
information, see the DanioVision DVOC-0041 - Reference Manual, which 
you can open from the Apps screen under Noldus > EthoVision XT 18 
Other Documentation.
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▪ When presence of the animal makes it difficult to draw the arena, and it is 
not possible to grab a background image without the animal, do the 
following:
Open the Detection Settings. When the animal moves around in the arena, 
under Method click Background and use the Learn function. This saves a 
bitmap of the empty arena. 

Next, In the Arena Settings, click the Grab Background Image button, then 
Browse and open the Bitmap Files folder within your experiment folder. 
From the file type list, select All files (*.*) to also view image files.

Choose the bitmap image just saved - its name starts with DetProf_. 
Next, click Grab.
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Calibrate the arena
Aim
To convert the subject’s coordinates expressed in pixels to real-world coordinates. 

IMPORTANT Avoid barrel and spherical distortion by using correct lenses. Place the 
camera above the middle of the arena, and perpendicular to the arena surface.

IMPORTANT  If you use Track3D, do not do calibration within EthoVision XT. Instead, 
make sure that you set Pixel calibration to ON. For more information, see the 
Track3D Reference Manual.

Prerequisites
▪ You grabbed a background image. 
▪ You know the real-world size of the arena. Measure this distance at the 

height of the animal, not, for example, at the top of the arena.

Procedure
1. In the Arenas and Zones section, click 1. Draw Scale to Calibrate.
2. Click the mouse button on the first a point in the video image, hold the 

button down, and drag to the second point in the image. Next, release the 
mouse button.

3. In the Calibration Distance window, type in the real-world distance between 
the two points. 
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Notes
▪ Repeat the steps above for all calibration lines. EthoVision XT uses the 

average of the scale factors obtained from each calibration line. This factor 
is used for analyze movement of the subject in all directions. Draw 
calibration lines on both directions, horizontal and vertical.

▪ See also Modify the coordinate system of the arena.
▪ For each calibration line, EthoVision XT calculates a scale factor (real world 

distance entered divided by the length of the line in pixels). If this factor 
differs by more than 20% from the average of the other lines, a message is 
shown: “Calibration scale substantially larger or smaller then other existing 
calibration scales”.
Click No to edit the real world distance. Or click No and then Cancel to re-
draw the last calibration line.

Click Yes to accept the value. Beware that very different scale factors may 
produce false results.

▪ If you enter a real world distance smaller than 10 mm (0.39 in) or greater 
than 10 m (32 ft 9 45/64 in), a message is shown. Click Yes to confirm the 
value or No to edit it.

▪ If you have clicked Cancel and you want to repeat the calibration 
procedure, click again 1. Draw Scale to Calibrate.
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Draw the arena
Aim
To define an area of interest so that EthoVision XT ignores all activity outside this 
area, so only movement inside the arena is tracked.

With multiple arenas within one video image, you can track more animals 
simultaneously and separately. Each arena is an independent replicate.

Prerequisites
▪ You have calibrated the video image. 

Procedure
1. Click 2. Select Shape and Draw Arena in the Arenas and Zones section.

When working with multiple arenas, click the layer for the arena you want 
to draw. 

2. Select a shape on the Arena Settings toolbar at the top of the window by 
clicking it or by pressing the corresponding shortcut key. 
To split an arena in quadrants automatically (for example, in a Morris water 
maze, or an open field), choose Create subdivided 3-point circle  or 
Create subdivided rectangle . See Draw subdivided shapes

3. Create a shape that covers the region on the screen in which you want 
EthoVision XT to track the subject. Make sure the arrow point of the arena 
label is inside the shape you just created.
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4. If you have chosen one of the subdivided options, the Add Subdivided 
Circle (or Rectangle) window appears.
For circular arenas, enter the number of sectors (for example, 4 for 
quadrants in a Morris water maze). Default =2, maximum = 50.

For rectangular arenas, enter the number of rows and columns. A total of 
rows x columns equal zones will be defined.

Result: In the Arenas and Zones section, a new zone group named 
Subdivision Zones is added, listing the new zones. See The Subdivision 
Zones group

Notes
▪ If you do not draw an outline, the whole background image is considered as 

the arena.
▪ If you have multiple arenas with the same size and shape, you do not have 

to draw each arena separately. You just draw one arena and duplicate this 
one. See Duplicate an arena on page 266.

▪ The shape is filled with the color visible next to the arena name in the 
Arenas and Zones section. To change this color, click the color next to the 
name.

▪ To create a circle or a square, select the Ellipse or Rectangle tool, 
respectively, and hold Shift down while you draw the shape.
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▪ To export the image of the arena, click the camera button on the 
toolbar. Give the export file a name and select a picture format (*.png, *.jpg, 
*.bmp, *.gif).
The image contains all layers that are currently visible. See Working with 
layers for how to display layers.

▪ For an experiment in DanioVision mode, EthoVision XT can detect the 
arenas automatically. See the DanioVision DVOC-0041 - Reference Manual.

▪ You cannot delete an arena that has been used for acquisition; it has 
become ‘read-only’. To edit it for future tracks, duplicate the arena, edit the 
copy and use these settings for acquisition.
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Make a subdivided arena
When you draw an arena using the subdivided tools, note the following:

If the Auto-Label Zone is active, all sectors are automatically defined as zones, and 
labeled with S1, S2, etc. A layer named Subdivision is added in the Arenas and 
Zones section together with its zones.

TIP  When the Auto Label Zone is active, the Auto-Label Zone button is highlighted 
in orange.

If the Auto-Label Zone button is not highlighted, the arena is still divided in sectors, 
but the resulting zones are not labeled. Click the Add Zone Label button to label 
the zones.
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TIP  To activate/deactivate Auto-Label Zone, click 3. Select Shape and draw Zones 
(Optional) in the Arenas and Zones section and click the Auto-Label Zone button.

See also

▪ Draw subdivided shapes
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Define zones
Aim
To define specific regions of the arena to be used in analysis or to start and stop 
tracking.

NOTE  Any area falling outside the arena is not considered as a zone.

Prerequisite
▪ You have defined the arena.

Procedure for one zone
1. Click 3. Select Shape and draw Zones (Optional) in the Arenas and Zones 

section.
If multiple zone groups are defined, in the Arenas and Zones section, click 
the zone group where you want to insert the zone. This group is 
highlighted in the background image.

2. Select a shape from the toolbar. See also Draw simple shapes
3. Create a shape that covers the area of interest within the arena. Do so at the 

height of the animal, not, for example, at the top of the cage. 
If you choose one of the subdivided options, select the number of sectors 
or rows x columns and click OK. See also Draw subdivided shapes

4. In the Add Zone Label window that appears, enter the name of the zone or 
accept the suggested name, then click OK.
TIP  When you have multiple arenas and want to give the same name to a 
zone defined in each arena (for example, the Feeder in multiple 
PhenoTypers), select Use existing zone and choose the zone name.
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Notes

▪ The zone shape is filled with the color visible next to the zone name in the 
Arenas and Zones section. Click the color next to the name to change it. 

▪ To create quadrants in an existing arena, draw two perpendicular lines over 
the arena. Click the Add zone Label button and drag the label to one 
quadrant. Repeat this step for each quadrant.

Auto-label zone
By default the option Auto-label zones is turned on (the Auto-Label Zone button 
on the toolbar is highlighted in orange). This means that every time you draw a 
closed shape, the zone label is added automatically.

To switch the auto-label option off, click the Auto-Label Zone button on the 
toolbar or press A.

If the auto-label option is off (the button is not highlighted in orange) and the zone 
has no name, click the Add Zone Label button on the toolbar, drag the label to the 
zone, then click the mouse button. Name the zone and click OK.
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To edit the zone
You can resize and re-shape the zone. See Work with shapes on page 257.
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Organize the zones in your arena
Zone groups
Zones are organized in zone groups. You can add an unlimited number of zone 
groups to each arena. Within one zone group, zones must be non-overlapping. 

IMPORTANT If zones within a zone group are overlapping, the overlapping area is 
excluded from both zones. 

Zones that do not overlap
If two or more zones do not overlap, like the quadrants of a Morris water maze, 
then define them in the same zone group.

To create a new zone group, select the arena and then click the Add Zone Group 
button in the lower part of the Arena Settings window.

You cannot edit zone groups that contain zones that have been used in Trial Control 
(for example, to start tracking when the animal is detected in that zone) or have 
been used as hidden or entry zone. However, you can add new zone groups and 
there add zones. These zones then can be used, for example, for analysis.

To analyze zones in the same group as one, see Cumulative zones on page 239.

Zones that do overlap
If you want to define zones that overlap, define them in separate zone groups or 
use cumulative zones.

EXAMPLE  In a circular open-field, you want two circular zones (Center and Border) 
and four quadrant zones (NW, NE, SW, SE). Create two zone groups: one with the 
two circular zones, and one with the four quadrant zones (see below).
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Draw a point
Aim
Define a reference point, for example to calculate the average distance of the 
subject to the point, or the heading angle.

Procedure
1. In the Arenas and Zones section, select the zone group in which you want 

to add one or more Points.
2. Click the Add point button on the toolbar.

3. Click the background image to position the point. Note that you can also 
position a point outside the arena.

4. In the Add Point window, enter the point name and click OK.
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Validate the Arena Settings
Aim
To check that the Arena Settings are consistent, after defining all arenas and zones. 
For example, that the arena is calibrated, that multiple arenas do not overlap, and 
that all zones are inside the arena. 

Procedure
Click the 4. Validate Arena Setup button in the Arenas and Zones section.

If arenas and zones are created correctly, a message will be shown that Arena 
Settings are valid. If not, an error message appears.
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More about zones
What do you want to do?

▪ Copy a zone
▪ Move an entire arena with its zones
▪ Define Cumulative zones
▪ Define Shelters and other hidden zones
▪ Define an entry zone
▪ Change the hidden zone subject coordinates
▪ Zones and points for Behavior recognition
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Copy a zone
To copy a zone within the same arena

1. Right-click the shape and select Duplicate.
2. In the Duplicate window, enter an Enlargement factor and click OK. 

To copy a zone to another arena
1. In the Arenas and Zones section, select the zone group into which you want 

to add a zone.
2. Make a zone that covers the area of interest within the arena.
3. Click the Label Zone button on the toolbar and click in the shape you have 

just created.
4. In the Add Zone window, select Use existing zone and select one of the 

zones from the list.
5. Click OK.

Notes
▪ You cannot copy individual zones from one arena to another. You can 

redraw the zone in the destination arena and use a label with the same 
zone name.

▪ TIP  If you have multiple arenas with the same size and shape you can 
duplicate a complete arena including all zones. Then arrange the arenas, 
using the Multiple Arena Setup.

See also

▪ Duplicate an arena
▪ The Multiple Arena Setup
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Move an entire arena with its zones
1. In the Arenas and Zones section, click the Arena row to display the corre-

sponding arena in the video image. 

2. Drag the mouse cursor over the entire arena in the window on the left, to 
select all components. Then move the entire selection.

See also

▪ Move, rotate and resize a shape
238



Cumulative zones
Aim
To analyze two or more zones, as one. With the procedure below you create a 
cumulative zone, using two or more existing zones.

NOTE  The original zones are not deleted. The Cumulative zone is added as a new 
zone, outside the original zone group.

EXAMPLE  In an Elevated plus maze test, you defined two open arms and two closed 
arms. To analyze the total time spent in either arm type, define the two open arms 
as cumulative zone Open arms, and the two closed arms as cumulative zone Closed 
arms.

You can add zones from different zone groups to a cumulative zone.
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Procedure
1. In the Arenas and Zones section, click a zone group in which you want to 

create a cumulative zone.
2. Click the Add Cumulative Zone button at the bottom of the Arenas and 

Zones section.

3. In the Add Cumulative Zone window you have two options:
Create new cumulative zone. Type in the name of the new cumulative 
zone, click OK and select the zones in the window that appears.

Use existing cumulative zone. From the drop-down list, choose the name 
of an existing cumulative zone in another Arena Settings.

Duplicate a cumulative zone
Use the option Use existing cumulative zone to replicate a cumulative zone that 
was defined in another Arena Settings profile, and you want to include it in a new 
Arena Settings.

Make sure that, when you do this, all the zones that make up the existing 
cumulative zone are also defined in the new Arena Settings.

EXAMPLE  In a radial-arm maze test, four zones can be either baited or not baited. In 
some trials zone 1 and 3 are baited, in some other trials zones 2 and 4 are baited.

1. In Arena Settings 1, define all zones. Next, define a cumulative zone Baited 
with zones 1 and 3. 
TIP  you can double-click the label Cumulative zone 1 and rename it to 
Baited.
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2. Create a new Arena Settings (or duplicate Arena Settings 2). Make sure the 
all relevant zones are defined.

3. Swap the labels for the zones.

4. If you created Arena Settings 2 anew, create a cumulative zone and choose 
Use existing cumulative zone. Choose the existing cumulative zone from 
Arena Settings 1.
If you have duplicated Arena Settings 1 to obtain Arena Settings 2, the 
cumulative zone is already pointing to the correct zones after you swap the 
labels.
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Note that the same physical zone is labeled with different names in the two Arena 
Settings profiles; take this into account when you analyze single zones.

IMPORTANT  We advise you not to rename the cumulative zone in Arena Settings 2 
when pointing to physical zones other than those in Arena Settings1. If you do so 
the name also changes in Arena Settings 1, and that would create confusion.

Notes
▪ A cumulative zone is not the same as a zone group. 

A zone group is one of the layers in the Arena Settings, where zones are 
always analyzed separately. 

A cumulative zone is just an extra zone, outside the zone group it origins 
from. For example, zones S2 and S3 form Cumulative zone 1.
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Shelters and other hidden zones
Hidden zones and Entry zones
You can define a shelter or any zone where the animal is out of view as a Hidden 
zone. After you have defined a hidden zone, you must define at least one Entry 
zone for that hidden zone. The entry zone is used to determine whether the animal 
has entered or left the hidden zone.

Entering a hidden zone
Suppose you have a square shelter defined as hidden zone and an entry zone on 
the side of the shelter where the animal can enter it (see the figure below, left). 
When the animal enters the entry zone, one or more body points are tracked in that 
zone (1). As soon as a body point is not detected anymore (2), that body point is 
assumed to have entered the hidden zone and this body point is positioned in the 
center of the hidden zone during the time the animal is inside the shelter.

Leaving a hidden zone
By default, the animal is considered to have left the shelter when it is next detected, 
that is, when its body points are “not missing”. However, every time an animal pokes 
its nose out, this may be recorded as an exit (middle, 2). Subsequently, retracting 
back into the shelter - without ever really leaving the shelter - would count as 
entering again. This results in an overestimation of how often the animal enters/
exits the hidden zone. Therefore, EthoVision XT versions 5.1 and up have the 
possibility to also use the entry zone as leaving zone. The animal is then considered 
to have left the hidden zone when it was first considered to be in a hidden zone, 
and subsequently detected outside of the entry zone (see Right, 2). 

In other words: the exit is counted only when the body point crosses the border 
between the entry zone and the rest of the arena. We recommend you use this 
function if you want to prevent an overestimation of entrances into, and exits from 
the hidden zone.
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Left: If the animal's center point is first detected in the entry zone, and then 
disappears (because the apparent size of the animal becomes smaller than the 
minimum size set in Detection Settings, then the animal is considered to be in the 
shelter. 

Right: The detection for exiting the hidden zone differs for not using or using the 
entry zone as a leaving zone also, respectively. (A) The subject is detected as having 
left the hidden zone as soon as the minimum subject size is detected anywhere 
within the arena. Depending on the minimum size set, only poking out the nose 
could count as "exiting". (B) The subject is detected outside the hidden zone, but 
will only be recognized as "out of the hidden zone" as soon as it crosses the border 
of the entry zone into the rest of the arena.

Define a hidden zone
1. At the bottom of the Arenas and Zones section, click the Add Hidden Zone 

Group button.
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2. Create a zone covering the area you want to define as a hidden zone. 
If the Auto-label zones option is switched on, the zone is automatically 
named Hidden Zone 1. Right-click the name to rename it. If the auto-label 
option is switched off, click the Add Zone Label button on the toolbar, click 
the zone and rename the zone.

Note
▪ If a hidden zone is included in a larger, overlapping zone, the time spent in 

the hidden zone is not included in the results for the larger zone. See a note 
under the topic In zone.

See also

▪ Define an entry zone
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Define an entry zone
Aim
To define a region of the arena where the subject must be immediately before 
moving into the hidden zone and disappearing from view.

It is important that at least one sampled location of the subjects’ body point (in the 
example below, the center point) is found in the entry zone, for the subject to be 
considered in the hidden zone. Otherwise, the subject is considered missing. So, 
make the entry zone large enough!

See also the Troubleshooting topic:

The animal is in the hidden zone but the data show “missing sample”

Prerequisites
You have defined a Hidden zone. See Shelters and other hidden zones.

To define an entry zone
1. In the Arenas and Zones section, select the Entry Zone Group row.
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2. Draw a zone that covers the area, overlapping the hidden zone, to define as 
an entry zone.

The size of the entry zone is critical, it must be wide enough, but not too 
wide so that: 

When entering. The subject never goes straight away from the area outside 
the entry zone to the hidden zone; There should be at least one instance of 
the subject's body point within the entry zone, before disappearing from 
view. If necessary, increase your sample rate to make sure that this happens.

When exiting. The subject's body point is far, but not too far from the 
hidden zone when it crosses the entry zone border to the rest of the arena; 
just enough for it to be considered as having left the hidden zone. This only 
applies if you select Use this entry zone also as leaving zone (see step 7).

You can use the Integrated Visualization to help you set the right size.

3. If the Auto-label zone is activated, The Add Entry Zone window opens. If 
the auto-label option is switched off, click the Add Zone Label button on 
the toolbar and click the zone to open the Add Entry Zone window.
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4. In the Add Entry Zone window, link this entry zone to the appropriate 
hidden zone by selecting the Link box under Linked hidden zone. You can 
link more than one entry zone to a hidden zone, but you cannot link more 
than one hidden zone to an entry zone.

5. If you want to define the entry zone also as a leaving zone, select the check 
box for Use this entry zone also as leaving zone. This will be applied on 
all hidden zones in your Arena Settings. Each entry zone will be also used as 
leaving zone for the hidden zone associated to it. 

6. Click OK to assign the label to the entry zone.

Notes
▪ To display the hidden zone while drawing the entry zone, in the Arenas and 

Zones section, select the check box in the View column of the Hidden Zone 
Group row, next to the Color column.

▪ If you have multiple arenas, create first hidden zones and entry zones in the 
first arena, then duplicate that arena and its contents. See Duplicate an 
arena.
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To link a hidden zone to an entry zone
If you did not link an entry zone to its hidden zone when you defined the hidden 
zone (see above), you can do one the following:

▪ In the video image, right-click the hidden zone label or right-click the 
hidden zone row in the Arena Settings window. Select Link Entry Zones 
and select the Link check box of the appropriate entry zone in the Links to 
Entry Zones window.

▪ In the video image, right-click the entry zone label, or right-click the entry 
zone row in the Arena Settings window. Select Link Hidden Zones and 
select the Link check box of the appropriate hidden zone in the Link to 
Hidden Zone window.
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Change the hidden zone subject 
coordinates
Aim
To specify the coordinates of the subject when it is in the hidden zone.

When a subject enters a hidden zone, its body points are assumed to be in the 
center of the hidden zone. However, if you have a very large hidden zone, the 
distance the subject moves from the entry zone to the center of the hidden zone 
every time it enters the hidden zone, contributes rather significantly to Distance 
moved. In these cases, you can “move” the coordinates of the subject near the entry 
zone.

Prerequisites
You have defined a hidden zone. See Shelters and other hidden zones.

To set the hidden zone subject coordinates
1. Right-click the hidden zone label and select Hidden Subject Coordinates.
2. Now, select one of two options to set the hidden subject coordinates:

Center of the zone, unless the center is outside the zone (then it is the 
arrow tip location). Select this option when you have a small hidden zone 
(for an example, see A).

Arrow tip location. Select this option when you have a large hidden zone 
(for an example, see B).
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A. Default situation; the hidden subject coordinates are at the center of the hidden 
zone, thereby making a large contribution to the Distance moved.

B. The hidden subject coordinates are set to the arrow tip location, thereby 
minimizing the contribution to the Distance moved.
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Zones and points for Behavior 
recognition
Aim
When you use the Rat/Mouse Behavior Recognition function, defining a few special 
zones and points significantly increases behavior recognition accuracy. 

▪ Drinking spout points to detect drinking. See To define the drinking spout 
points

▪ Feeder zones to detect eating behavior at the feeder. See To define the 
feeder zones

▪ Wall zones to detect rearing to wall. See To define the wall zones

Prerequisites
▪ You need the Rat or Mouse Behavior Recognition Module of EthoVision XT.
▪ You have read important notes about behavior recognition. See Behavior 

Recognition: Requirements
▪ In the Experiment Settings under Tracked features you selected Center-

point, nose-point, and tail-base detection. Under Behavior Recognition, you 
selected one or more of the options Feeder, Drinking bottle, Arena walls. 
If one of the options is not selected, the corresponding layer is not added in 
the Arena Settings.

▪ Make sure that the outline of the arena covers all possible regions where all 
detected body points of the animal can be, including when rearing. See 
Draw the arena on page 224 for the procedure. Make sure that the aspect 
ratio of the video image is correct.

To define the drinking spout points
1. In the Arenas and Zones section, click 3. Select Shape and draw Zones 

(Optional).

2. Click the Drinking Spout Points zone group.
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3. Click the Add Point button on the toolbar. The mouse pointer changes to a 
cross.

4. Click the background image to position the point.
5. In the Add Point window, accept the default name (Spout 1 for the first 

point), or enter another name. Then click OK.

Repeat the steps above to define more points.

TIP  To have a better view of the background image and locate the tip of the 
drinking spout more easily, in the Arenas and Zones section deselect the View 
option for the Arena and other zone groups.
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To define the feeder zones
1. In the Arenas and Zones section, click 3. Select Shape and draw Zones 

(Optional).

2. Click the Feeder Zones zone group.

3. Using one or more drawing tools available on the toolbar, draw the outline 
of the feeder. 

4. If the Auto-label zone option is activated, the zone is automatically named 
Feeder Zone 1. Right-click the label to rename it. 

Repeat the steps 3-4 above to define more feeder zones.

To define the wall zones
All the high objects that the rat can use for supported rearing should be defined as 
wall zones.

1. In the Arenas and Zones section, click 3. Select Shape and draw Zones 
(Optional).
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2. Click the Wall Zones zone group.

3. Using the polygon drawing tool, draw the outline of the floor of the arena.
It is important that all sides of the arena are included in the wall zone, also 
when the side walls are barely visible.

4. If the Auto-label zone option is activated, the zone is automatically named 
Wall Zone 1. Right-click the label to rename it.

5. Make sure that the zone label points to the arena walls in the video image. 
If it points to the inside of the arena, move the label.

When the camera is not centered on the arena, like in a multiple arena setup, side 
walls may be partly or totally hidden. Draw the polygon in such a way that the wall 
zone also covers those regions.
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Notes
▪ In the Drinking Spout Points group, you can only define points, not zones.
▪ You cannot delete one of the zone groups Drinking Spout Points, Feeder 

Zones and Wall Zones. You can delete the zone/point label, but the zone 
group itself remains. To delete a group, deselect the corresponding option 
under Behavior Recognition in the Experiment Settings.
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Work with shapes
What do you want to do?

▪ Draw simple shapes
▪ Draw subdivided shapes
▪ Move, rotate and resize a shape
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Draw simple shapes
Line, rectangle, ellipse

1. Click the appropriate shape button on the toolbar  or press L for 
a line, S for a rectangle, and E for an Ellipse.

2. Click the background image to define the first point of the shape, keep the 
mouse button pressed, and drag to the end point. When ready, release the 
mouse button. 

To create a circle with the Ellipse tool, hold Shift down.

Polyline

1. Click the appropriate shape on the toolbar  or press O for an Open 
Polyline and Y for a Closed Polyline.

2. Click in the background image to position the first point, move the mouse 
pointer to the position of the second point and click in the background 
image. Next, move the mouse pointer to a new position for the third point, 
etc.

3. When ready, double-click.

3-point circle

1. Click the 3-point circle button on the toolbar or press T.

2. Click in the background image to position the first point, move the mouse 
and click to position the second point.

3. Move the mouse to position the 3-Point Circle and click to finish.
When you resize a 3-point circle, it becomes an ellipse. If you don’t want that, press 
Shift while you resize the circle. 

To show or hide the center of the bounding rectangle of a shape, right-click it and 
select Show/Hide center.

To copy and enlarge a shape
1. Right-click the shape and select Duplicate.
2. In the Duplicate window, enter an Enlargement factor and click OK. 
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Draw subdivided shapes
Aim
To automatically divide a circle and a rectangular shape into a number of zones. This 
applies when:

▪ You draw an arena and you want to split it in equal zones like the four 
quadrants in a Morris water maze.

▪ Within an existing arena, draw a shape and divide it in a number of zones.
Result: Zones are automatically defined with labels S1, S2, etc. provided that the 
Auto-Label Zone option is active.

To subdivide an arena in zones
This applies when you still have to draw the outline of the arena. See Make a 
subdivided arena.

To divide a shape within an existing arena
1. In the Arenas and Zones section, click 2. Select Shape and Draw Zones 

(Optional).

2. In the Arenas and Zones section, click the zone group where you want to 
insert the zones that result from the subdivision.
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3. Click one of the buttons on the toolbar:

For circular shapes, subdivided 3-point circle  or press I.

For rectangular shapes, subdivided rectangle  or press U.

4. Draw the shape.
5. In the Add Subdivided [Circle/Rectangle] window:

For circular shapes, enter the number of sectors (for example, 4 for 
quadrants in a Morris water maze).

For rectangular arenas, enter the number of rows and columns. A total of 
rows x columns equal zones will be defined.

Result: in the Arenas and Zones section, the zones are defined in the zone group 
that you clicked in step 2.

The Subdivision Zones group
Subdivision Zones is a zone group that includes the zones created in a subdivided 
arena.

NOTE  The Subdivision Zones zone group is not created when you subdivide a shape 
within an existing arena.

Subdivision segments
A subdivided shape is defined by a number of segments. Move and resize a 
segment just like with other shapes.
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Move, rotate and resize a shape
IMPORTANT  Whenever you edit an arena or zone, make sure the arrow point of the 
corresponding label stays within the shape.

To move a shape
1. On the Arena Settings toolbar, click the Normal mode button or press V.

2. Move the mouse pointer over the shape, so the pointer becomes a move 
pointer. Then click the object and move it.

To rotate a shape
1. Click the Rotation mode button on the Arena Settings toolbar or press R.
2. Move the mouse pointer over the shape, so the pointer becomes a rotation 

pointer. 
3. Click the object with the left mouse button, keep the mouse button pressed 

and move the pointer to rotate the shape.
4. Click Normal mode again when you are done rotating.

To resize a shape (or multiple shapes)
1. Click the Normal mode button on the toolbar (or press V), and select the 

shape. For multiple shapes, drag the mouse around all shapes.
2. Use the handles to resize the shape.

To resize a rectangle also at the opposite side, press Ctrl and move the 
resize handle.

To rescale a shape
If you rescale an shape, the size changes but the aspect ratio is maintained. 
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1. Click the Normal mode button on the toolbar (or press V), then select the 
shape. For multiple shapes, drag the mouse around all shapes.

2. Use the resize handles at the corners of the shape.
To rescale the shape with the center point of the shape as the reference 
point, press Ctrl and move the resize handle.

To rescale the shape with the opposite corner handle as the reference point, 
press Shift and move the resize handle.

To reshape a shape
1. Click the Point Edit mode button on the toolbar (or press P).

2. Click and drag the handles at the corners to a new position.

3. Select Normal mode when you are done reshaping.

To add or remove corners in a shape
1. Click the Point Edit mode button on the toolbar (or press P).

2. To add a corner, click on the contour of the shape. To remove a corner, 
right-click the corner and select Remove Point.
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Work with multiple arenas
What do you want to do?

▪ Calibrate multiple arenas
▪ Duplicate an arena
▪ Add and delete an arena
▪ Arrange arenas with the The Multiple Arena Setup
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Calibrate multiple arenas
When the video image includes two or more arenas, by default the calibration is 
shared. This means that the calibration is used for all arenas.

When you need more accurate calibration, for example when the distance between 
individual arenas and the camera varies, you can calibrate each arena individually.

To make calibration unshared
To make the default shared calibration unshared and calibrate individual arenas, in 
the Arenas and Zones section, right-click Calibration and select Unshare This 
Calibration.

Next, calibrate each arena. See Calibrate the arena.

To make calibration shared
In the Arenas and Zones section, right-click the calibration you want to share and 
select Share This Calibration.
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Duplicate an arena
Aim
To make copies of an existing arena in the same video image. For example, in an 
experiment with four PhenoTypers, draw an arena for cage 1, and then copy that 
arena for the other three cages.

IMPORTANT  Before duplicating an arena, make sure you have created all the zones 
for that arena.

To define arenas in DanioVision experiments, see the DanioVision DVOC-0041 - 
Reference Manual, which you can open from the Apps screen under Noldus > 
EthoVision XT 18 Other Documentation.

Procedure
1. In the Arena Settings window, click the row for the arena you want to dupli-

cate.

2. Click the Copy Arena button, or right-click the row and select Duplicate 
Complete Arena.

3. In the Duplicate Arena window, select an option from the drop-down list. If 
you select the option All other arenas, also select how the arenas are 
arranged in rows and columns. The multiple arena setup now opens.

4. Select Duplicate content to existing arenas if you want to duplicate zones 
and points to the other arenas.

5. Move the duplicated arena to the appropriate location.
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6. Repeat steps above for all consecutive arenas.
7. Adjust the position, shape and size of individual arenas. See Move, rotate 

and resize a shape.
8. If the arenas are evenly distributed in the video image, use the The Multiple 

Arena Setup to move, scale, rotate and space all arenas.

Notes
▪ To duplicate an arena, you can also right-click the outline of the arena and 

select Duplicate.
▪ When you copy an arena, calibration is also duplicated if it is unshared. See 

Calibrate multiple arenas.
▪ An arena to which another arena is duplicated, loses its previous definitions 

and contents.
▪ If you select the option Duplicate content to existing arenas, the position 

of existing arenas is maintained. If you do not select this option, the 
position of each arena is adjusted based on the number of arenas and their 
layout. See The Multiple Arena Setup.

See also

▪  The Multiple Arena Setup to adjust all arenas simultaneously.
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Add and delete an arena
You cannot add or delete an arena in the Arena Settings. You can only delete the 
shape that defines the contour of the arena.

To add or delete an arena
In the Experiment Settings, increase or reduce the number of arenas in the drop-
down list next to Number of Arenas.

Note
You cannot add/delete an arena in the Experiment Settings once you have carried 
out Acquisition in the Experiment.
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The Multiple Arena Setup
Use the Multiple Arena Setup to configure multiple arenas which are regularly 
distributed (for example, four open fields placed on a 2x2 grid). Taking into account 
the number of arenas and their layout (that is, the number of arenas on rows and on 
columns), EthoVision XT creates a virtual grid in which the arenas are initially evenly 
distributed. You can then configure the multiple arenas with the Multiple Arena 
Setup.

There are two ways to open the Multiple Arena Setup:

▪ The Multiple Arena Setup window opens automatically, when you copy an 
arena to all other arenas.

▪ In the Arenas and Zones section, click the Arrange Arenas button.

Arranging arenas
The following options are available in the Arrange Arenas window:

1. Move Grid. You can move all shapes (including zone shapes) both horizon-
tally and vertically, by using the slider, by pressing the up/down arrows of 
the corresponding box or by entering a number in a box.

2. Scale Arenas. To resize all shapes by using the sliders, by pressing the up/
down arrows of the corresponding box or by entering a number in a box.

By default the option Keep proportions is not selected. If you select this 
option, both the height and width of all shapes are changed while the 
original shape and position is kept. If you do not select the option Keep 
proportions, you can resize the height and width of all shapes separately.
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3. Rotate Grid. To rotate all shapes. The shapes rotate around the geometric 
center of Arena 1.

4. Arena Spacing. To change the space between the shapes.

BY default, the option Keep proportions is not selected. If you select this 
option, spacing is done both in horizontal and vertical direction relative to 
Arena 1. If you do not select Keep proportions, you can change the space 
between the shapes separately in the vertical and horizontal direction 
(relative to the first row and first column, respectively).

To reset the Multiple Arena Setup
Set the values back to zero. Make sure to deselect the option Keep proportions. 
Alternatively, press the Cancel button; this resets all configurations.

To view details in multiple arenas
If you have multiple arenas, you can view or hide layers and labels of all arenas for 
better viewing. In the Arenas and Zones section, right-click an arena and select one 
of the options:

▪ To show/hide the border of all arenas, select Show All Arenas or Hide All 
Arenas, respectively.

▪ To show/hide the fill color and the label of all arenas, select Show All Fills 
and Labels or Hide All Fills and Labels, respectively. 

▪ To show/hide a zone group or a zone, in all arenas, right-click that group or 
zone and select Show in All Arenas or Hide in All Arenas, respectively.
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To apply a color to all arenas
1. Change the color of one arena.
2. In the Arena Settings window, right-click the row of that arena and choose 

Apply Color to all arenas, or right-click the color field and select Apply to 
All Arenas.

To apply the color of a zone in all arenas
This changes the fill color for a zone in all arenas where a zone is defined with the 
same name.

1. Make sure the zone is present in all Arenas, and has the same name for all 
of them.

2. In the Arena Settings window, change the fill color of the zone in one of the 
arenas.

3. Right-click the row of that zone and choose Apply Color to all arenas, or 
right-click the color field and select Apply to All Arenas.

To change the contour color of a zone in all arenas
NOTE  The color of the contour of a zone depends on the color selected for the zone 
group (layer). By changing the contour color of a zone, you also change the contour 
color of all zones in that group.
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1. In the Arena Settings window, change the color for the zone group the zone 
belongs to. To do so, click the color cell for the row with the zone group 
name.

2. Right-click the row of that zone group and choose Apply Color to all 
arenas, or right-click the color field and select Apply to All Arenas.
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Further information on Arena Settings
Learn about

▪ The x-y coordinate system in the arena

What do you want to do?
▪ Modify the coordinate system of the arena
▪ Check the video aspect ratio
▪ Adjust the video aspect ratio
▪ Use the Arena - Hardware mapping
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The x-y coordinate system in the arena
The default coordinate system
By default, the x-and y- coordinates of your track are expressed relative to the 
center point of the background image. The positive x-axis points to the right, and 
the positive y-axis points upward.

Position of shapes in the coordinate system
After calibrating the arena, the Shape size and Position section at the bottom of 
the Arena Settings pane shows the real-world coordinates X and Y of the object 
currently selected.

If the arena is not calibrated yet, the coordinates X and Y are given in pixels.

Note:

▪ If you click the calibration arrow line, the X and Y values are the coordinates 
of the center of the arrow.

▪ If you click an object like a zone, X and Y are the coordinates of the 
geometric center of the object. Width and Height are the width and height 
of the rectangle around the object, respectively.
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▪ Remember that the value of X and Y depend on where the origin (0,0) is 
placed. In the default coordinates system, a negative value means that the 
center of the object is to the left (for X) or below (for Y) the center of the 
background image. See Modify the coordinate system of the arena

World point / Pixel point
In the Status bar, World point and the Pixel point indicate the current position of 
the mouse pointer. You can use this function to know the exact position of an 
object.

TIP  If you do not see the Status bar, choose View > Status bar.

▪ World point gives you the coordinates of a point based on the calibration 
scale and origin, and the distance unit chosen in the Experiment Settings 
(see Units). The World coordinates can be positive or negative depending 
on where your axis origin is.

▪ Pixel point gives you the coordinates of a point in pixels. The 0, 0 
coordinates correspond to the top-left corner of the video image. The Pixel 
coordinates are always positive.
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Modify the coordinate system of the 
arena
Aim
To have the coordinates system different from the default one. For example:

▪ You want to export the real-world coordinates and you want these 
coordinates expressed relative to a point of reference in the real world that 
is not in the middle of your image.

▪ You want the dependent variables that use angle (that is, Head direction, 
heading, Meander, Turn angle), to be expressed relative to a reference line 
that is different from the default one (horizontal and pointing to the right). 
For example, you have an external cue to the north-east of your arena and 
you want to express the animal's orientation relative to this cue. In this case, 
you rotate the Calibration Axes so the x-axis points towards the cue.

Use the Calibration Axes object to specify the orientation of the real-world 
coordinate system and to specify the real-world coordinates for one pixel point.

To modify the coordinates system
1. Click the Create Calibration Axes button at the bottom of the Arenas and 

Zones section.

2. OPTIONAL  In the Calibration Coordinate System window, type in the real-
world origin of the x-axis Origin X and of the y-axis Origin Y relative to the 
current position of the origin on your screen. Do this if you know the origin 
of the coordinate system is outside the background image. Alternatively, 
skip this step and go to the next.
EXAMPLE  If you type 10 (cm) for Origin X, it means the origin [0,0] of your 
calibration system is shifted 10 cm to the left relative to the center of the 
video image.

3. Click and drag the Calibration Axes object to re-position the axes origin. 
To flip the y-axis of the Calibration Axes object, double-click the Calibration 
Axes object and select Flipped Y-axis. Move the Rotation mode arrow to 
rotate the calibration axes.
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To return to the default coordinates system
Select the Calibration Axes object and press Delete.
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Check the video aspect ratio
The video aspect ratio
The video aspect ratio is the relation of the horizontal to vertical size of a video 
image. When you pre-record video from analog cameras, the aspect ratio of the 
resulting video files is not the same as that of the source camera. This results in a 
distorted background image. In such cases, a perfectly circular Morris water maze 
may look ellipse-like in EthoVision XT after you grabbed a background image from 
the video file.

When is the video aspect ratio not correct?
The problem of the aspect ratio does occur:

▪ When you record video with a program other than EthoVision XT, like 
MediaRecorder, and from analog cameras.

▪ When you recorded video with EthoVision XT and you use that video in a 
new experiment.

If you record video and do tracking within the same experiment, the video aspect 
ratio is always correct.

How do I know that the video aspect ratio is distorted?
▪ If the shape of the test enclosure as displayed in the background deviates 

from the shape that you expect. For example, a circular water maze looks 
like an ellipse, or a square open field looks like a rectangle. 

▪ Place a sheet with a circle under the camera and grab this image as 
background image. In the Arena Settings, draw a three point circle. If the 
aspect ratio of the image is correct, this three point circle fits over the circle 
from the camera image.

See Adjust the video aspect ratio

Calculate the correct aspect ratio in a video image
1. After grabbing the background image, locate the bitmap file of your back-

ground Image in the folder Bitmap Files of your experiment folder:
C:\Users\Public\Public Documents\Noldus\EthoVision 
XT\Experiments\[experiment name].

2. Open the file in an image editing program (such as Paint.NET). 
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3. Draw a shape exactly around the arena. Note the dimensions of the shape 
you have just drawn.

If the ratio (for instance, width/height) of the dimensions of the drawn shape 
deviates from the ratio of the real-world dimensions of the arena, this means that 
the image is distorted.

EXAMPLE 1  You have a perfectly circular water maze with a diameter of 100 cm. 
When you open the Background Image of this water maze in an image editing 
program and draw an ellipse around the maze, the ratio of width/height is not 
exactly 1 but is 1.019. This means that you need to adjust the aspect ratio of the 
Background Image using this ratio: in the Adjust Aspect Ratio window, in the 
Custom field, divide the width (box on the left) of the image by 1.019. Do not 
change the height.

EXAMPLE 2  You have a square open field measuring 40 x 40 cm. When you open the 
Background Image of the open field in an image editing program and draw a 
rectangle around the open field, the ratio of width/height is not exactly 1, but is 0.8. 
This means that you need to adjust the aspect ratio of the Background Image using 
this ratio. In the Adjust Aspect Ratio window, in the Custom field, divide the width 
of the image (box on the right) by 0.8. Do not change the height.

See also

▪ Adjust the video aspect ratio
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Adjust the video aspect ratio
Aim
To correct for image distortion that sometimes occurs when recording video from 
analog cameras. 

Prerequisites
▪ You track from pre-recorded video files.
▪ You know that the aspect ratio in the video file differs from that of the 

original camera image.See Check the video aspect ratio

Procedure
1. Open the Area Settings.
2. Click the Adjust Aspect Ratio button.

3. Choose the option based on the software and hardware you used (see 
below), then click OK.
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Options

If you used Noldus MPEG Recorder 1.1/2.0, or MediaRecorder, and analog 
cameras

▪ When you used MediaRecorder with a Picolo H.264 encoder board, choose 
Noldus Recorder and select Euresys PICOLO U4 H.264. Make sure you 
select the TV standard of the camera (NTSC or PAL).

▪ When you used an older encoder board (Picolo Diligent or IVC-4300), 
choose Noldus Recorder and select one of the other options.

If you used MediaRecorder, and digital cameras

▪ In most cases you do not need to correct the aspect ratio. However, if you 
are sure the video image is distorted, select Custom and enter the correct 
aspect ratio.

If you used video files recorded with EthoVision XT, but in a different 
experiment

▪ Select Noldus Recorder and select Euresys Picolo U4 H.264.

If you used video files recorded with programs other than MediaRecorder: 

▪ Select Custom and enter the adjusted aspect ratio. See Calculate the 
correct aspect ratio in a video image
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Arena - Hardware mapping
If your experiment is set to use of Trial control hardware, the Hardware mapping 
section at the bottom of the Arena Settings pane is available. Click the Arena-
hardware mapping button to assign hardware devices to each of your arenas.

If your experiment consists of only one arena, the hardware is automatically 
assigned to this arena, so you do not have to take further actions.

If you have more than one arena, assign the hardware to the arenas manually.

See also

▪ The section Assign devices to arenas in the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual. To open this manual, on the Apps 
screen choose Noldus > EthoVision XT 18 Other Documentation.
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Trial Control Settings

Main topics and tasks
▪ Introduction to Trial Control  284
▪ The Start-Stop trial rule  287
▪ Examples of Start-Stop trial rules  300
▪ Programming Trial Control  309
▪ Further information on Trial Control  342

IMPORTANT This chapter describes the Trial Control functions of the EthoVision XT 
Base version only. For a detailed overview of conditions, creating sub-rules and 
controlling hardware devices via the USB-IO box, see the EthoVision XT 18 - Trial 
and Hardware Control - Reference Manual. To access this manual, on the Apps 
screen choose Noldus > EthoVision XT 18 Other Documentation.
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Introduction to Trial Control
Learn about

▪ Why use trial control?
▪ Important terms in Trial Control
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Why use trial control?
Start and stop data acquisition
Trial Control allows you to automate your experiment. Let EthoVision XT control the 
start and stop of data acquisition (tracking) depending on time, the behavior of the 
subjects and other conditions. For example:

▪ Start tracking when the subject is released and detected in the open field.
▪ Start tracking at exactly 12:30:00, and stop tracking after one hour.
▪ Stop tracking when the rat has reached the platform in the Morris water 

maze, or one minute after the start in any case.
▪ Stop tracking after the animal has been in the closed arms of the Elevated 

plus maze for five minutes.
▪ Stop tracking when the subject has explored an object for five minutes.

See also

▪ The Start-Stop trial rule

Advanced Trial Control
With the EthoVision XT Trial and Hardware Control Module, you can also:

▪ Define conditioning routines for the subject, based on sequences of 
conditions and actions that are repeated a number of times (sub-rules). 

▪ Control hardware devices, like a pellet feeder, or the arms of a radial maze. 
Your EthoVision XT license must include the Trial and Hardware Control module.

For more information about advanced trial control options, see the EthoVision XT 
18 - Trial and Hardware Control - Reference Manual.
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Important terms in Trial Control
Trial vs. track
A Trial is a single, uninterrupted acquisition session. The trial can be viewed as a 
container for the data collected in one recording session. It starts when you give the 
Start command in acquisition and stops when the tracks for all arenas and subjects 
have stopped.

A Track is the actual recording of a subject's position and behavior. The start of a 
track may or may not coincide with the start of the trial. This depends on your Trial 
Control Settings. If you use the default Trial Control Settings, the track starts 1 
second after the animal has been detected in the arena and stops when you stop 
the trial.

Conditions and actions
A Condition is a statement that EthoVision evaluates. A condition can be based on 
time, presence of the subject in a zone, any variable that quantifies behavior, or the 
state of a device connected to EthoVision XT.

An Action is a command executed on a variable or a hardware device. You can 
therefore control your experiment by linking conditions with actions.

EXAMPLE  In a Morris water maze test, stop tracking when the rat is detected on the 
platform (provided that the platform has been defined as a zone). The action is Stop 
tracking and the condition is Rat detected on the platform. This is represented by 
the following:

A condition is followed by an action. The condition checks that the animal is in the 
zone named “Platform”. The action “Stop track” is taken when the condition is met.
286



The Start-Stop trial rule
Learn about

▪ The default Start-Stop Trial rule

What do you want to do?
▪ Control the start of tracking
▪ Control the end of tracking
▪ Split a multi-day test in multiple trials
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The default Start-Stop Trial rule
How to access the Start-Stop Trial rule

▪ Choose Setup > Trial Control Settings > Open and select an existing Trial 
Control Settings.

▪ In the Experiment Explorer, click one of the Trial Control Settings.

With this rule, you control the start and stop of data acquisition (tracking).

What the Start-Stop Trial rule means
The sequence of boxes A to F can be read as follows:

1. When you start the trial, for example by clicking the Start Trial button, the 
box A (Rule Begin - Start-stop trial) is activated. Control passes immedi-
ately to the box B.

2. EthoVision XT checks that the condition in the box B (Condition - In Zone) 
is true. The condition states that the center point of the subject (or of any 
subject in the same arena) must be detected in the arena for an 
uninterrupted period of one second. 
When you start the trial and the subject is not yet in the arena, the 
condition is false. EthoVision XT waits until the subject has been detected 
for one second. At that time, the condition becomes true. Control passes 
immediately to the box C.

NOTE  In special cases this box is absent or has different settings. See The 
start-stop trial rule in special cases

3. When the condition B becomes true, the box C (Action - Start track) is 
activated, and tracking starts.

4. Control passes to the box D (Condition - Time). EthoVision XT checks that 
the condition is met. This condition is set to wait indefinitely, so that 
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tracking stops when you give the stop command, or when the end of the 
video file has been reached, or when the maximum trial duration has been 
reached. See Control the end of tracking

5. When one of the events specified above occurs, the box E Action - Stop 
track marks the end of the tracks in the arena.

6. The box F Rule End - Start-stop trial marks the stop of the trial; it does not 
take any action.

Notes
▪ If the condition in box B is not met immediately, the time that tracking 

starts (C) is different that the time that the trial starts. 
▪ The Start-Stop trial rule only works when you acquire data (live or offline). If 

you only record video, the Start-Stop trial rule is inactive. You must start and 
stop video recording manually.

See also

▪ Trial vs. track
▪ How the trial control instructions are executed
▪ The start-stop trial rule in special cases
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The start-stop trial rule in special cases
Multiple arenas
When multiple enclosures are defined as separate arenas, the default Start-Stop trial 
rule is applied for each arena separately. This means that condition in box B is 
applied separately for each arena. As soon as an the subject is detected in an arena, 
tracking starts for that arena, not the others. As a result:

▪ This way you do not have to release all the animals at the same time.
▪ Tracking may start at different times in different arenas in the same trial, 

depending on when a subject is released in its arena.

See also

▪ Trial control in multiple arenas

Multiple subjects in the same arena
When multiple subjects are present in the arena, tracking starts when the first 
subject is found. Therefore, tracking starts for all subjects at the same time, even if 
the others are not yet in the arena. For those subjects, the track starts with a 
number of missing samples, until the subject is found.

To start tracking only when all subjects are found in the arena, and thereby avoid 
missing samples at the beginning of the track, see Start the trial in the Social 
interaction test.

With DanioVision
If you create a DanioVision experiment, the Condition - In zone box is not present. 
Tracking starts as soon as you start the trial.

With Activity analysis
If you select Activity analysis under Analysis Options in the Experiment Settings, 
the Condition - In zone box is removed from the default Start-Stop rule. To carry out 
tracking and activity analysis simultaneously, and start tracking when your subject is 
detected in the arena for a specific time, insert a new In Zone condition box in the 
Start-Stop rule.
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NOTE  If you also select Behavior recognition in the Experiment Settings, the Start-
Stop rule is as described below.

With Behavior recognition
If you select Behavior recognition under Analysis Options in the Experiment 
Settings, a Time condition is added between the Condition - In zone box and the 
Action Start Track box. This means that EthoVision XT waits 3 seconds after 
detecting the animal for the first time, before starting actual tracking. This is done 
because the behavior recognition algorithms need a number of video frames 
equivalent to about three seconds before the current frame in order to recognize 
behavior.

Part of the Start-Stop trial rule of the Trial Control Settings when selecting Behavior 
recognition in the Experiment Settings. 

The time condition “After a time of 3.0 s” is removed automatically from a Trial 
Control rule if you deselect Behavior recognition in the Experiment Settings.
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Control the start of tracking
To modify the Start track condition
The default Start track condition is a condition based on the variable In zone. The 
condition becomes true when the subject is detected in the arena for one second.

1. Click the Settings button. 
2. In the window that appears, specify in which zone the subject should be to 

start tracking. Click Settings and choose the zone. See details about the 
variable In zone

3. Specify the criterion (time, frequency in the zone etc.). From the Statistic 
list, choose one of the statistics. See the details below.

Statistics available 

▪ Current Duration or Cumulative Duration to start tracking when the 
animal has been detected for some time in the zone. Current Duration is an 
uninterrupted period of time (for instance, the animal must be detected for 
1 s without interruption). Cumulative Duration sums up all periods when 
the animal is in the zone since the start of the trial.

▪ Current to start tracking as soon as the animal is detected (one sample is 
sufficient). Note that this condition may become true also when noise is 
occasionally detected as subject for a very short time, before the animal is 
released in the arena. Make sure that this does not happen.
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▪ Frequency to start tracking when the animal has visited the zone a number 
of times.

▪ Latency to First to start tracking when the latency to its first visit to the 
zone is less or greater than a specific time.

To use a different Start track condition
Click the Condition - In zone box and press Delete, then choose another condition 
(see the examples below).

EXAMPLE 1  Start tracking exactly 1 minute after clicking the Start Trial button.

1. Click the Condition - In zone box and press Delete. 
2. Under Conditions, click the button next to the variable you want to use 

(Time in this example), and select the options you require.
3. Insert the new box in the sequence and re-connect the boxes. See Connect 

two boxes.
EXAMPLE 2  Start tracking at a time you are not in the lab, for example at 23:00 h.

1. In step 2 above, click the button next to Time, choose After clock time and 
enter 23:00:00.

2. Before leaving the lab, choose Acquisition > Open Acquisition and click 
the Start trial button. The program waits till 23:00 to start tracking.

See also Conditions on page 314.

Examples
EXAMPLE 1  Start tracking immediately when you start the trial

1. Click the condition box and press Delete.
2. Reconnect the first box with the second one. See Connect two boxes

EXAMPLE 2  Start tracking when both (all) subjects are in the arena

1. Here we assume that the experiment is set to multi-subject tracking.
2. Click the Settings button in the condition box.
3. In the window that appears, click the Actors tab and select the subjects that 

should be in the arena at the start of tracking. 
4. Select All selected subjects. 
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See also

▪ Details about the variable In zone
▪ Control the end of tracking
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Control the end of tracking
What do you want to do?

▪ Stop tracking after some time
▪ Stop tracking based on the behavior of the subject
▪ To set a maximum duration for your trials
▪ Stop video recording after some time

Stop tracking after some time
This option allows you to create tracks of fixed length. 

The default Stop track condition is a Time condition.

 

Click the Settings button, and choose the option you require.

▪ To stop tracking after some time, choose After a time of and set the time. 
For example, set 5 min if you want to track subjects for five minutes.

▪ To stop tracking at a specific clock time of the same day, choose After 
clock time and set the time required. To stop tracking after the current day, 
you must have the Trial and Hardware Control module.

Stop tracking based on the behavior of the subject
1. Click the Time condition box and press Delete.
2. Under Conditions, choose the variable that describes the behavior and 

click the corresponding button.
EXAMPLE  To stop tracking when the subject is in a zone, click In zone.

3. Configure the variable and insert the new box in the Start-Stop trial rule. 
See Insert a box in a Trial Control sequence
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To set a maximum duration for your trials
If the conditions to stop the trial are never met, EthoVision XT waits indefinitely and 
the trial never ends. To prevent this from happening, define a maximum trial 
duration.

EXAMPLE  In a Novel object test, if the Stop track box is preceded by a condition 
“when the subject enters the zone with the familiar object”, it may happen that the 
subject completely ignores the familiar object and only pays attention to the novel 
object. In that case the condition to stop tracking is never met.

In the Maximum Trial Duration pane, select Use a maximum trial duration and 
enter the maximum duration of the trial (in hours, minutes or seconds).

For information about the duration of trials tested with specific cameras and 
computers, see Resolution, frame rate, and maximum trial duration

Longer trials and videos are possible in principle but they have not been thoroughly 
tested.

Stop video recording after some time
All the options above refer to stopping the trial when you do tracking. If you record 
video and then acquire the tracks (see Record video, then acquire a trial), the 
Maximum Trial Duration option won’t work. This is because the Trial Control 
Settings, including the Maximum Trial Duration option, are not active when 
EthoVision XT just records video without acquiring data. You must stop video 
recording manually.

An alternative strategy is the following:

1. Set the Maximum trial duration (see above).
2. Acquire a trial live + save video.
3. The saved video has a fixed length. Now you can use that video to re-do 

tracking in the same experiment, or use that video in another experiment 
(set to offline tracking).
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Notes
▪ Keep at least one condition between Start track and Stop track. If you do 

not do this, tracking stops immediately after tracking starts, resulting in no 
data.

▪ If you do not see the Maximum Trial Duration pane, click the Show/Hide 
button on the toolbar and select Maximum Trial Duration. If the text in 
this pane is grayed out, it means that Trial Control Settings are read-only. 
Open another Trial Control Settings profile or create a new one.

▪ Instead of using a maximum trial duration, you can also define a condition 
based on time and place it immediately before the Stop track box. This way 
you set the exact duration of the tracks. See Stop tracking after some time

▪ For more information on conditions, see Overview of conditions in the 
EthoVision XT 18 - Trial and Hardware Control - Reference Manual.
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Split a multi-day test in multiple trials
Aim
To acquire trials longer than the maximum duration that is tested at Noldus. See 
Cameras supported by EthoVision XT > Resolution, frame rate, and maximum trial 
duration.

Procedure
1. In the Trial Control Settings, remove the condition immediately before the 

Start track action box.

2. In the Trial Control Settings, set the maximum trial duration. For example 24 
hours. See Control the end of tracking
TIP  Set this time to a little less than 24 hours, for example 1439 min (= 24 h 
minus 1 min). The remaining minute is used as inter-trial interval (see 
below). You can also choose a shorter inter-trial interval if you like.
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3. Choose Setup > Trial List. Add a number of trials that cover the total 
duration of the test for the subject.
▪ EXAMPLE 1  One arena. Each subject is tested over five days. Therefore, 

add five trials for that subject. 
▪ EXAMPLE 2  Subjects in four PhenoTypers (arenas) are tested over five 

days. Add five trials. Each trial contains data of one day and the four 
arenas.

TIP  Only add the trials for the current subject(s), not for the subjects that 
come next in the protocol. Because you will use the series of trials (see 
below), in most cases with a short inter-trial interval you won’t have time to 
clean the cages and release the next subject.

TIP  Add a variable “Subject ID” to the Trial List, and enter the ID of the 
subjects to be tested. So you know which trials refer to which subject.

4. Choose Acquisition > Open Acquisition. Under Method, select Track all 
planned trials with an Inter-trial interval of 1 minute. This is done to make 
sure that EthoVision XT has the time to save the data. If you want to use a 
shorter time, test it beforehand.

5. Acquire the data.
6. In step 3, add the trials for the next subject(s), and repeat the procedure.
7. In the Data profile, group the trials based on the subject ID. This way you 

can analyze a multi-trial test as one trial. See Define groups of tracks
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Examples of Start-Stop trial rules
What do you want to do?

▪ Start/stop the trial in the Morris water maze test
▪ Start the trial in the Social interaction test
▪ Stop the trial in the Eight-arm radial maze test
▪ Start and stop the trial at specific clock times
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Start/stop the trial in the Morris water 
maze test
Aim 1
To stop tracking when the animal has found the platform.

Procedure
1. In the Arena Settings, make sure that the platform has been defined as 

zone. 
2. In the Trial Control Settings, delete the Time condition before the Stop track 

box.
3. Define an In Zone condition. See also Stop tracking based on the behavior 

of the subject
If you want the program to stop recording as soon as the animal is over the 
platform, select Frequency as Statistic and choose >= 1. Click Settings and 
select the platform zone. See details about the variable In zone

Sometimes the animal swims over the platform, but it does not stop there. 
In such cases the program would stop recording while the animal has not 
‘found’ the platform. Instead of selecting Frequency, choose Current 
Duration and the minimum time the animal must stay on the platform (for 
example, 3 s) without interruption. Click Settings and select the platform 
zone.

Aim 2
To stop tracking either when the rat has found the platform, or when it has been 
swimming in the water maze for 60 seconds. 
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Procedure
The Arena Settings and the condition “the rat has found the platform” are similar to 
those in the example above. The condition “rat swimming for 60 s” can be 
translated to “time from start tracking >= 60 s”.

The track stops when either condition is met. The two conditions are combined with 
OR logic. See also Operators.

This solution results in tracks of different duration: less than 60 s for the animals 
that found the platform, and 60 s for the others. 

With the Start-Stop trial rule shown below, the trial stops when the subject has been 
in the platform zone for at least 3 s without break, or the time since the start of 
tracking is 60 s. 

A. In zone condition that specifies that the subject must be for at least 3 seconds 
over the Platform zone. Select Current duration >= 3s. 

B. Time condition that specifies a time of 60 s since the track started. 

C. ‘Any’ operator box.
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Start the trial in the Social interaction test
Aim
To start tracking when all the subjects have been released in the arena

Procedure
1. Click the Settings button in the second box (Condition - In zone).
2. Click Settings and then the Actors tab.
3. Select all the subjects that need to be in the arena at the time of start.
4. Choose All selected subjects below the subject list.
303



Stop the trial in the Eight-arm radial maze 
test
Aim
To stop tracking when the subject has been in four arms within 10 minutes

Procedure
This can be done by combining eight conditions, that is, that the animal must be in 
the arm specifying that at least four must be met, no matter which arm the animal 
visits. 

1. Create an In zone condition and specify that the Frequency for Arm 1 must 
be >=1. That is, the animal must have visited Arm 1 at least once. Do the 
same for each of the other arms.

2. Connect the resulting eight condition boxes in parallel using the N of All 
operator. See Operators

3. Set the maximum trial duration to 10 minutes to stop tracking in the case 
the animal fails to visit four arms in the meantime. See To set a maximum 
duration for your trials

Below: Trial Control sequence for an eight-arm radial maze. The trial must stop 
when the animal has visited four of the arms at least once. 1, 2,... 8: In zone 
condition boxes for Arm 1,2,... 8 respectively. A condition is met when the 
Frequency of In zone for that arm is greater than or equal to 1. A: Operator that 
checks that at least four of the eight conditions are met. B: Stop track box. When 
four conditions are met, the trial is stopped.
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See also

▪ Operators on page 332.
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Start and stop the trial at specific clock 
times
Aim
To control the start and stop of the trials, without the need for the researchers/
technicians to be in the stable to control EthoVision XT.

Procedure 1 - One trial
EXAMPLE  You want to start tracking at 9 AM (9:00) and stop at 7 PM (19:00). You are 
in the lab the day before.

1. Open the Trial Control Settings and create time conditions as in the figure 
below. 

2. Before leaving the lab, in the Acquisition screen click Start Trial. The 
screens says Checking start condition.

3. The software waits until 9 AM on the following day and then starts tracking.
4. Tracking stops on 19:00 (7 PM).

NOTE  If you click Start trial before 9:00, it will start tracking on the same 
day!

Procedure 2 - Repeated trials using a Series of trials
EXAMPLE  You plan to record your subjects for 20 days. Each trial should be carried 
out during the day, from 8 AM (8:00) to 7 PM (19:00). 

1. Create a Trial List with the number of planned trials. See Plan your trials
2. In the Trial Control Settings, create a Start-Stop rule similar to the one 

above, to start tracking from 8 AM to 7 PM. 
3. In the Acquisition screen, select Track all planned trials. In the Inter-trial 

interval field, enter the time that covers the interval from the end of one 
trial to some time before the beginning of the next. In this case the inter-
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trial interval runs from 7 PM to 7: 59 AM = 12 h 59 min. Leave some time 
between the end of the inter-trial interval (7:59 AM) and the Time condition 
of the rule (8 AM). This way the two instructions will not interfere with each 
other. At 7:59 AM of the next day, the trial starts but the software waits till 
8:00 AM to start tracking. 

4. To start the first trial in the series, make sure to click the Start Trial button 
before the time specified in the Time Condition box placed at the left of the 
Start track box (in this case 8 AM).

5.  In the remaining days you do not have to be in the lab at that time because 
the series of trials will do the work for you.
See also Acquire a series of trials (Batch acquisition)

Procedure 3 - Repeated trials using Task Scheduler
EXAMPLE  You plan to record your subjects for 20 days. Each trial should be carried 
out during the day, from 8 AM (8:00) to 7 PM (19:00).

This is an alternative method that makes use of the Windows Task Scheduler.

▪ Create batch files to trigger the start of the trials (this replaces the clicking 
of the Start Trial buttons in the procedures above).

▪ Use the Windows Task Scheduler to trigger the batch files at a specific time.
▪ Do not forget to add the planned trials in the Trial List; in this example, 20 

trials.
Do the following:

1. Using the Windows Notepad, create a file with extension VBS that performs 
a key press Ctrl+F5. This triggers the start of the trial. Enter the following 
code:
Set WshShell = WScript.CreateObject("WScript.Shell")

WshShell.AppActivate "EthoVision"

WScript.Sleep 1000

WshShell.SendKeys "^{F5}"

for (i = 0; i < g_aSubjects.length; ++i)

And name this file vbsprogram.vbs.

NOTE  The WScript.Sleep 1000 (1 s delay) ensures that the key press is given 
when EthoVision XT is in focus.

2. Using the Windows Notepad, create a second file, this time with extension 
BAT, which triggers the vbs script. Enter the following code:
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wscript "C:\vbsprogram.vbs"

And name this file start_vbsprogram.bat.

3. Save both files on C:\.
4. Start the Windows Scheduler and define a new basic task, which runs daily. 

Under Action, select Start a program and select the batch file 
C:\start_vbsprogram.bat.
Make sure that the task is repeated daily at the required time:

5. To program the end of the trial, do this in the Trial Control Settings. See 
Control the end of tracking

6. Leave EthoVision XT open on your screen and close all other unnecessary 
windows. When Windows runs the task at 8 AM, the trial starts 
automatically.

Notes
▪ If you select the option Save video in the Acquisition screen, video 

recording starts the moment that you click Start Trial. Depending on the 
condition placed immediately before the Start Track box, video recording 
starts some time before the actual start of tracking. In the case of Procedure 
1, several hours earlier. This means that you record many hours of video 
when tracking is not yet active.
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Programming Trial Control
Follow this section if you need more information on how to define conditions and 
actions in the Start-Stop trial rule. 

TIP  Before defining Trial Control in EthoVision XT, draw your experimental 
procedure as a flowchart, where each block represents either an action or a 
condition which, when met, triggers other actions or conditions.

Learn about
▪ Conditions
▪ Actions
▪ External commands
▪ Operators

See also

▪ Useful things to know
▪ Re-use trial control elements
▪ Working with trial control boxes

Other manuals

For further information, including information on controlling hardware devices such 
as the PhenoTyper Top Unit, the Pellet dispenser, PhenoWheel and the Lickometer, 
see the EthoVision XT 18 - Trial and Hardware Control - Reference Manual. To open 
this manual, choose Apps > Noldus > EthoVision XT 18 Other Documentation.
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Useful things to know
Components pane
Use the Components pane to choose conditions, actions and other elements for 
your Start-Stop trial rule.

If you do not see the Components pane, click the Show/Hide button on the toolbar 
and select Components.

To display the complete list of options, click the buttons next to More.

What you see in the Components pane depends on what EthoVision XT license you 
have on your computer. 

Trial Control boxes
A Trial Control box has the following information:
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▪ A. Type of control (Rule Begin/End, Action, Condition, Operator, Reference). 
You cannot change this text.

▪ B. Text describing the control. To change this text, click the Settings button 
and enter the text under Name, for example Drop one food item. You can 
also add a longer description under Comment (this is not shown). 
Names of Trial Control boxes must be unique, unless you make a copy of an 
existing box. See Re-use trial control elements

▪ C. Depending on the type of control, this text shows the option chosen, for 
example the command to be given, or the sub-rule that the box refers to.

Trial control boxes have different colors: 

▪ Light blue for the Start-Stop Trial rule, sub-rules and sub-rule References. 
▪ Olive green for conditions.
▪ Light green for actions.
▪ Grey for operators. 

To zoom the Trial Control rule in and out
▪ To enlarge the size of all trial control boxes up to their original size, click the 

Zoom in button (Ctrl+.).

▪ To reduce the size of all trial control boxes, click the Zoom out button 
(Ctrl+,).

▪ To make all trial control boxes visible on your screen, click the Fit all button 
(Ctrl+/).
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TIP  Navigate ‘from left to right’ in the Trial Control window by using the scrollbar at 
the bottom. Use the Fit all button to make all trial control boxes visible.

To keep Trial Control boxes aligned
The Trial Control boxes automatically snap to a grid. This helps you keep the boxed 
aligned.

To show the grid, click the Show/Hide button on the toolbar and select Show Grid.

To disable the grid alignment, click the Show/Hide button on the toolbar and 
deselect Snap to Grid.

Trial Control Settings become locked after acquisition
After you have acquired at least one trials, the Trial Control Settings used for that 
become locked. In the Experiment Explorer, locked settings are indicated by a lock 
symbol, and cannot be edited. To edit a locked Trial Control Settings profile, 
duplicate it and edit this copy. See Re-use trial control elements

To export a picture of the Trial Control Settings
1. Click the Export image button  on the toolbar.
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2. Select a location to save the image to, type in the File name or accept the 
default one and select an image type from the Save as type list, then click 
Save.

The complete Trial Control window is exported, irrespective of the zoom factor.
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Conditions
Aim
A Condition is a statement that EthoVision checks during the trial. When the 
Condition is met (True), the program evaluates the next element in the Trial Control 
sequence. 

EXAMPLES (Conditions are highlighted in italics)

▪ When the rat reaches the platform, stop tracking. 
▪ When the mouse is detected in the open field, start tracking. 
▪ When the animal has visited zone A ten times, stop tracking.

To define a condition
1. Open or create new Trial Control Settings.
2. In the Components pane under Conditions, locate the type of condition 

you want to define. and click the button next to it.

TIP  Combine two or more conditions using the Multi condition. For details, 
see the EthoVision XT 18 - Trial and Hardware Control - Reference Manual.

3. Next to Condition name, type in the name you want to give to the 
condition, or accept the default name. 

4. Specify the condition properties. See Types of condition
5. Enter a Comment (optional), then click OK. 
6. Insert the condition box in the Trial Control rule.
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Types of condition

Time

It defines a time interval that must elapse before an action be taken. 

EXAMPLE  Start tracking two seconds after clicking the Start trial button, or start 
tracking at 12 PM.

Time interval

This condition makes sense when it is combined with another condition. 

EXAMPLE  Stop tracking when the animal is found in Zone A (In zone condition) 
between 5 and 10 minutes (Time interval condition). 

Trial Control variable

To create a condition that is met when a Trial Control variable has a certain value, or 
a value within a range, or equal to another variable at the time the condition 
becomes active. See also To define a Trial Control variable

For the meaning of becomes active, see How the trial control instructions are 
executed on page 343. 

EXAMPLE  Stop tracking when the variable Counter is greater than or equal to 10.

Dependent variables

To define a condition based on the behavior of the subject. This also includes 
behaviors scored manually. Choose one of the dependent variables to create the 
condition. 

EXAMPLE 1  In zone condition. Stop tracking when the subject visits the target zone 
10 times.

EXAMPLE 2  Movement condition. Stop tracking when the subject has been in the 
Not moving state for more than five minutes.

EXAMPLE 3  Multi condition. Stop tracking when the subject has explored an object 
for more than 5 minutes. Here, “explored” is defined with a Multi condition: (a) the 
subject’s nose point is the object zone AND (b) its head is directed to the object. 
When the two conditions are met simultaneously for a total of 5 minutes, the trial 
stops.
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Hardware

To define a condition based on the signal given by a hardware device. To use 
hardware-based conditions, you must have the Trial and Hardware Control Module. 
See the EthoVision XT 18 - Trial and Hardware Control - Reference Manual.

Notes
▪ If the Add a condition window appears, it means that there is at least one 

condition with the same name in your experiment. Create a new condition, 
or re-use the existing condition. See Re-use trial control elements.

▪ For a complex condition like “stop the trial when the rat reaches the 
platform or it has been swimming for 60 seconds”, see an example for the 
Start/stop the trial in the Morris water maze test.

▪ Trial Control conditions cannot be defined based on behaviors scored 
automatically with Rat or Mouse Behavior Recognition. This because the 
detection of behavior also depends on video frames that come after the 
time that the condition is evaluated.

▪ If you insert a Condition box based on Activity, and then deselect Activity 
analysis in the Experiment settings, your rule becomes invalid. The 
Condition boxes based on Activity are removed from your sequence and 
the connecting arrows are removed. Re-connect the boxes.

▪ See also Overview of conditions in the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.
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Actions
Aim
An Action is a command that EthoVision XT carries out during acquisition.

EXAMPLES (Actions are highlighted in italics)

▪ Start tracking and Stop tracking (see The Start-Stop trial rule).
▪ Do C= C+1. This is an example of an action on a Trial Control variable. See 

Using Trial Control variables.
▪ Start video recording with MediaRecorder. This is an example of External 

Command. See External commands
▪ Open the door of LeftArm or Drop a pellet. These are actions on hardware 

devices (only with the Trial and Hardware Control Module).

Procedure
1. Open or create new Trial Control Settings.
2. In the Components pane under Actions, locate the type of action you want 

to define. and click the button next to it.
3. Next to Action name, type in the name you want to give to the action, or 

accept the default name. 
4. Specify the action.
5. Enter a Comment (optional), then click OK. 
6. Insert the action box in the Trial Control rule.
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Using Trial Control variables
Aim
Trial Control variables help you keeping track of events that occur during the trial. 
An example of a Trial Control variable is a counter.

To define a Trial Control variable
1. Open or create new Trial Control Settings.
2. In the Components pane, under Conditions or Actions click the button 

next to Trial Control variable. 

3. Next, click the Variables button. The Trial Control Variables window lists the 
variables currently in the experiment (also those defined in other Trial 
Control Settings). To add a new variable, click Add variable.

4. A new row is appended to the table. Under Name, type in the name you 
want to give to the variable. Under Initial Value, enter the value of this 
variable at the start of the trial (default: 0). 

5. Click OK. In the TC-variable action/condition window, define the action or 
condition you require. Click Cancel if you do not want to create a condition 
or action based on that variable at that point.

Notes
▪ To delete a variable, click the variable name in the Trial Control Variables 

window and click the Delete variable button. 
▪ To rename a variable, click the variable name in the Trial Control Variables 

window and edit this name. 
▪ The default name of a new trial control variable is VarN, where N is a 

progressive number.
▪ The variable name cannot contain blank spaces.
318



To define an Action on a Trial Control variable
1. In the Components pane, under Actions click the button next to Trial Con-

trol variable. If you do not see this action, under Actions click the More 
button.

2. If the Add an action window appears, it means that there is at least one 
action of the same type in your experiment. You are asked to choose 
between creating a new action, or re-use an existing one. See Re-use trial 
control elements on page 335. 

3. In the TC-Variable Action window, next to Action Name, enter the name of 
the action (for example, Increment Counter) or accept the default name.

4. Under Action to perform, select the variable from the list. You can also 
create the variable by clicking Variables if you have not yet done so. 

5. Next to the = symbol, do one of the following:
▪ To assign the same value of another variable (for example A = B), select 

the other variable (B) from the second list. 
▪ To enter a formula, click the double-arrow button. 

Select the operator from the list and specify the formula in the 
second and third lists. For example, A= A + 1.

▪ To assign a random value, select Random from the second list, and 
select the Minimum and Maximum limits (only integer values, 0 up to 
999) for the random value.
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For the Permutation option, see below.

6. Click OK. Insert the resulting Action box in the Trial Control rule. 

Notes
▪ If your setup includes multiple arenas, each arena receives an instance of 

the variable. Thus, a variable can have different values in different arenas.
▪ You cannot combine Random with a formula (for example, to compute A= 

Random+1). The equivalent solution is the following: define first an action 
B= Random, and then one more action A= B+1. Place the two resulting 
Action boxes in sequence. 

▪ For a random variable, select the Permutation option to generate a 
random value that is unique in the sequence of all values in the specified 
range. For example, if the Minimum is 1 and the Maximum is 5, any value 
will be generated only after all the other possible values have been 
generated in previous repeats of the action. That is, a new value 1 can only 
occur after that all the other possible numbers are generated during 
previous repeats of the action: 3, 2, 4, 1, 5, 1. Use the Permutation option to 
create sequences of unique numbers, for example to activate routines in a 
“pseudo-random” order but without the repetitions that would occur if you 
generate fully random numbers (e.g. 2, 4, 1, 1, 5). 

See also

▪ The EthoVision XT - Trial and Hardware Control - Reference Manual. See 
Manuals
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External commands
Aim
To trigger external software with EthoVision XT.

Prerequisites
▪ You need at least the Base version of EthoVision XT.

Procedure
1. Open or create new Trial Control Settings.
2. In the Components pane, under Actions click the button next to External 

command.

3. Next to Action Name, enter the name of the action (for example, start 
recording) or accept the default name.

4. Under Actions to perform, select which file you want to run by clicking the 
ellipsis button.

5. Select one of the file types from the list: Executables (*.exe), or Batch Files 
(*.bat, *.cmd). 

6. Browse to the file and click Open.
7. Optionally, enter a Command line option. Click the Information button to 

get additional information about defining an External command.

For more details, see the EthoVision XT 18 - Trial and Hardware Control - 
Reference Manual.

8. To test the command, click the Test button.
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Note
If you work with two or more arenas, be aware that an external command is sent out 
for each arena. For example, the command to play a sound is repeated 96 times for 
a 96-well plate DanioVision experiment. To prevent this from happening, put a 
condition before the External command box, which will only become true for one of 
the arenas, for example Arena 1. In the Arena Settings, create a zone in Arena 1 and 
call it “Zone 1A”. Make the zone as large as the arena. In the Trial Control Settings, 
make a condition like “Is subject in Zone A?”, followed by the external command. 
Make sure that the sequence does not interfere with the rest of the Trial Control 
rule, like in this example.

Application examples
▪ Play a sound
▪ Trigger video recording with MediaRecorder
▪ Trigger sound recording with UltraVox XT
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Play a sound
Aim
To play a sound file while carrying out a trial.

Procedure
1. Open the Windows Notepad and enter the following text:

@echo off

set soundFile="D:\Sound Files\Stimulus1.wav"

start "" "C:\Program Files\Windows Media Player\wmplayer.exe" 
%soundFile%

Replace the text within quotes with the actual path to your sound file.

2. Save the file with the *.bat extension. 
3. Follow the procedure in External commands to create an External 

Command action that selects the batch file. 

4. Place the External command box in the Trial Control rule.
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Notes
▪ Create one batch file for each sound file you want to play during the trial. 

Create multiple External command actions, one for each batch file, and 
place them in the Trial Control rule.

▪ wmplayer represents Windows Media Player. You can also use other 
software to play video, for example VLC. 
@echo off

set soundFile="D:\Sound files\Stimulus1.wav"

start "" "C:\Program Files\VideoLAN\VLC\vlc.exe" --play-and-exit 
%soundFile%

▪ For examples of the Command line options, see External Commands in 
the EthoVision XT 18 - Trial and Hardware Control - Reference Manual.

See also

▪ External commands
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Trigger video recording with 
MediaRecorder
Aim
To record high resolution video with MediaRecorder while tracking the subjects with 
EthoVision XT.

Prerequisites
▪ You work with analog video cameras. If you work with digital cameras, 

EthoVision XT and MediaRecorder cannot access the signal from a digital 
camera simultaneously.

Procedure
1. In the Trial Control Settings, create a condition that must be true in order to 

trigger video recording.
2. Follow the procedure in External commands to create an External 

Command action that starts video recording in MediaRecorder. 
TIP  To visualize batch (*.bat) files, choose Batch files (*.bat; *.cmd) next to 
File name.

3. Place the second box after the first in the Trial Control rule. See below for 
examples.
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Example 1
In this example, the trial starts in the early afternoon but the researcher wants to 
start video recording only after 6 PM (18:00) and end it after 12 hours. The box 
sequence is as follows (the rest of the Trial Control rule is not shown):

1. Start tracking. 
2. Open Media Recorder. Add the Command line option /E.
3. Wait until 18:00.
4. Start video recording. Add the Command line option /R.
5. Wait 12 more hours.
6. Stop video recording. Add the Command line option /S.

Example 2
In this example, the researcher carries out live tracking during a 24-hour period. The 
trial starts during the light cycle when the animal is inside the shelter but the 
researcher wants to start recording video only when the animal leaves the shelter. 
This saves significant disk space as the resulting video will be shorter.

1. Create an External Command action to open MediaRecorder. 
Select MRCmd.exe as the program to run and enter /E as a Command line 
option (see the figure below, box at the right). 

2. Create an In Zone condition “Out of shelter”.
3. Create a Time condition to make sure that video recording starts when 

MediaRecorder is already open on the screen. Combine the two condition 
boxes with an operator of type All inputs true (see below for an example).

4. Create an External command similar to the first one, this time with /R as a 
Command line option to start recording.
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5. You can have EthoVision stop video recording (Command line option: /S) 
after a specific time elapsed after the start.

In the example below, the first action box (left) starts up MediaRecorder. The action 
box on the right starts video recording when both conditions Out of Shelter and 
Time 5 sec become true, that is, the center-point of the animal has left the shelter 
at least 5 seconds after MediaRecorder was started.

Notes
▪ To record video in MediaRecorder and carry out data acquisition in 

EthoVision XT simultaneously, you need to feed the video signal to two 
separate channels. Split the video cable that comes from the camera in two, 
and connect each end to a separate video input of the encoder board. 
Select one input per program, for example video input 1 for EthoVision XT 
and 3 for MediaRecorder.
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▪ There may be a delay between the command Start Recording and the 
moment MediaRecorder actually starts recording. Run a test recording to 
test how long this delay is.

See also

▪ External commands
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Trigger sound recording with UltraVox XT
Aim
To record ultrasonic vocalizations with UltraVox XT 3 while tracking the subjects with 
EthoVision XT. UltraVox XT is triggered by an EthoVision XT’s external command.

Prerequisites
▪ We recommend to run UltraVox XT and EthoVision XT on separate 

computers, preferably connected through a network switch. Alternatively, 
you can use a local network but that could add delays in communication 
between the two computers. On both computers, disable the firewall.

▪ Set the IP addresses of the Ethernet ports on both PCs that match the IP 
address of the network switch. Here you find an example of IP addresses 
that were tested:
▪ Network switch (Netgear GS310TP): 192.168.0.239.
▪ EthoVision XT 18 PC: 192.168.0.201.
▪ UltraVox XT 3 PC: 192.168.0.202.

▪ IMPORTANT  If you decide to run EthoVision XT and UltraVox XT on the same 
machine, make sure that you start EthoVision XT and open the experiment 
before starting UltraVox XT. Also check that the PC can handle the 
recording of video, data and sound simultaneously. Check that there are 
few or no missing samples in your data before carrying out the actual 
experiment. For more information, see the UltraVox XT Help.
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Procedure
1. When working with two computer, make the folder C:\ProgramData\Nol-

dus\UltraVox\XT 3\Synch shared, so it can be accessed by the SUV batch 
file.

2. In the EthoVision XT Trial Control Settings, define an external command 
that runs one of the batch files SUV.bat stored on the EthoVision XT 
computer.
You can find the SUV batch files on the EthoVision XT full installation 
package, under Drivers and tools > Utilities > UltraVox XT 3 Control. For 
more information on this file, see the UltraVox XT Help. 

If you work with two PC and multiple arenas, use the batch file SUV - 2PC 
multiple arenas.bat (see below). We recommend not to run EthoVision XT 
and UltraVox XT on the same PC when you work with multiple arenas.

3. Place the external command immediately after the Start track box (see the 
figure below).

4. Define a second instance of the external command and place it 
immediately before the Stop track box (see the figure below).

5. Open your experiment in UltraVox XT and in the Trial Control Settings under 
Start acquisition select External program trigger.

6. Start acquisition by starting the trial in EthoVision XT.
7. After acquisition, import the UltraVox XT data in EthoVision XT using the 

import profile for UltraVox XT 3. See also Import a complete external data 
file at once 
NOTE  For this step you need the External Data add-on module. See 
Modules of EthoVision XT

Triggering UltraVox XT with two or more arenas
If you work with multiple arenas, we advise to use the batch file SUV - 2 PCs 
multiple arenas.bat, in such a way that the start command is given only once, for 
the first arena.
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This is the content of the batch file SUV - 2 PCs.bat for working with one arena:

@if exist "\\IP address\Synch\start.txt" del "\\IP address\Synch\start.txt"

@copy "C:\ProgramData\Noldus\Common\Tools\UltraVox XT 3 
Control\start.txt" "\\IP address\Synch" > nul

This is the content of the batch file SUV - 2 PCs multiple arenas.bat for when 
working with two or more arenas:

@if exist "\\IP address\Synch\start.txt" del "\\IP address\Synch\start.txt"

@echo off

echo %1

IF %1=="Arena 1" (

@copy "C:\ProgramData\Noldus\Common\Tools\UltraVox XT 3 
Control\start.txt" "\\IP address\Synch" > nul

)

Note: 

▪ In the Trial Control Settings, and for both Action boxes, add a command line 
option: “%an%” (including quotes).

▪ In the batch files, replace IP address with the IP address of the UltraVox XT 
computer (suggested: 192.168.0.202, or 10.0.0.9 as suggested in the 
UltraVox XT 3 Help). You can also use the name of the computer instead, 
e.g. DESKTOP-ABC123.

▪ If the arena has a name different from Arena 1, replace Arena 1 with that 
name in the batch file.

See also

▪ Import profile for UltraVox XT 3
▪ Import a complete external data file at once
▪ External commands
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Operators
Aim
To combine actions, conditions and sub-rules in various ways. 

EXAMPLES (Operators are highlighted in italics)

▪ When at least one of the two conditions A and B is met, then do … 
This is an example of conditions combined by an operator of the “Any” type 
(OR logic). 

▪ When two conditions are met at the same time, then do … 
This is an example of conditions combined by an operator of the “All” type 
(AND logic). 

▪ When at least/at most/exactly 4 of 8 conditions are met, then do …
This is an example of conditions combined by an operator of the “N of All” 
type.

To combine conditions/actions/rules:
1. Define the conditions/actions/rules that you want to combine. Place them 

in your Trial Control sequence as parallel branches. The connecting arrows 
must originate from the condition/action that precedes the combination of 
elements you want to define.
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2. In the Components pane under Structures, double-click Operator or click 
the button next to it.

3. Under Name, enter the Operator name or accept the default name 
Operator (n), where n is a progressive number. 

4. Under Operator triggers when, select the option that applies: 
▪ Any (at least one) of the inputs is 'true'.
▪ All inputs are simultaneously 'true'.
▪ N of All inputs are simultaneously 'true'. Specify how many inputs N 

must be 'true': = (exactly equal to), ≠ (not equal to), >= (at least), <= (a 
maximum of), etc. 

Where an input being 'true' means a condition being met, an action carried 
out, or a sub-rule finished.

5. Enter a Comment (optional) to describe this operator, and click OK. 
6. A new Operator box appears in the Trial Control. Place the box right of the 

elements defined in step 1, and connect each element (or ending element, 
in the case of a sequence) to the operator.

7. Connect the operator to the next element that should be activated. 
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Notes
▪ Instead of using multiple condition boxes, you can also combine conditions 

with Multi condition. For details, see the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.

▪ If the Add an operator window appears, it means that there is at least one 
operator of the same type in your experiment. For more information, see 
Re-use trial control elements. 

▪ Names of operators must be unique in your experiment. You cannot define 
two operators with the same Operator name.

▪ An Operator can also have just one input box. In that case the operator is of 
no use, because control passes immediately to the next box as soon as the 
input condition becomes true or the input action is carried out. EthoVision 
informs you about this. 
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Re-use trial control elements
Aim
To create a Trial Control element without starting from scratch.

All elements of Trial Control (conditions, actions, operators, sub-rules and sub-rule 
references) defined in other Trial Control Settings can be duplicated and re-used in 
your current Trial Control Settings.

Procedures

Re-use a Trial Control element (general)

Use this procedure to create a Trial Control element from an existing one, even 
when this is stored in another Trial Control Settings profile.

1. Click the button next to the element you want to create.

2. The Add window appears. Select Reuse an existing condition/ action. and 
select the name of the existing element from the list next to the option. 
From the second list, choose the Trial Control Settings profile that contains 
the element you want to re-use.

3. Click OK. 
4. A window appears for the type of element chosen. The Name and settings 

specified here are the same as in the element chosen in step 2. 
▪ To create an identical copy of the element, click OK and go to step 5.
▪ In all other cases, edit the settings and click OK, and go to the next 

step. 
5. Insert the resulting box in the Trial Control sequence.

Copy and paste a Trial Control element

Use this procedure to quickly copy one or more Trial Control elements that you see 
on the screen. This applies to actions, conditions, operators and references to sub-
rules. See Copy and paste a box
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Notes
▪ To duplicate an entire Trial Control procedure, In the Experiment Explorer, 

under Trial Control Settings, right-click the profile and select Duplicate.
▪ When you duplicate a Trial Control element, and change any settings of the 

new element, including name and comment, a window appears showing 
two options:
Apply the new settings only in the current trial control profile. Choose 
this option to apply the settings only to the new copy, 

Apply the new settings in all writable Trial Control profiles. Choose this 
option to extend those changes to the original elements in all Trial Control 
Settings that are writable, that means, not locked after acquisition.
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Working with trial control boxes
Create a new box
Click the button that applies in the Components pane.

Copy and paste a box
You can create duplicates of one or more Trial Control boxes. This makes it easier to 
create procedures with similar actions and conditions.

1. Click the box you want to copy. To select multiple boxes, click and drag the 
mouse around them.

2. Choose Edit > Copy, or right-click anywhere and choose Copy or press 
Ctrl+C.

3. When necessary, open the Trial Control Settings where you want to insert 
the new boxes.

4. Choose Edit > Paste, or right-click anywhere and select Paste, or press 
Ctrl+V.

NOTES

▪ The name of the new Trial Control box is the same as that of the original 
one, followed by (2), (3), etc.
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▪ You cannot copy and paste a sub-rule, only the actions and conditions 
within it.

Move a box
1. Hover the mouse on the margin or the colored area of the box. The mouse 

cursor changes to a four-headed arrow.

2. Drag the box to the position you require.
To move a group of boxes:

1. Draw a rectangle around the boxes you want to move or click on the boxes 
you want to select while holding the Ctrl key.

As a result, the selected boxes get a gray, dark border.

2. Hover the mouse on the margin or the colored area of one of the selected 
boxes. The mouse cursor changes to a four-headed arrow.

3. Drag the group of boxes to the position you require.

Insert a box in a Trial Control sequence
1. Drag the Trial Control box between two boxes until the connecting arrow 

turns white.
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2. Release the mouse button. The new box is inserted.

Connect two boxes
1. Point the mouse to the center of the first box, press and hold the left mouse 

button and drag toward the center of the other box.
2. Release the mouse button when the pointer has reached the center of the 

other box. The two boxes are connected.
Operator boxes can have one, two or more input arrows; all other boxes have no 
more than one input arrow.

All boxes can have 1 or more output arrows, pointing to different boxes. 

Modify the settings in a box
Click the Settings button in the lower part of the box. Make the appropriate 
changes in the window that appears.

Delete a box
1. Click the title of the box. The box border is highlighted.
2. Press Delete.

Delete a group of boxes
1. Draw a box around the boxes you want to delete or click on the boxes you 

want to select while holding the Ctrl key.
2. Press Delete.

You cannot delete the Rule Begin, the Rule End box, the Start track box and the Stop 
track box.
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Delete a connecting arrow
1. Click the arrow you want to delete. The arrow turns bold to show it is 

selected.
2. Press Delete.

You cannot delete the arrow connecting the Stop track box and the Rule End box. 
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Apply trial control to your trials
Apply Trial Control Settings to a single trial
Before starting the trial, do one of the following:

▪ In the Experiment Explorer, make sure that the Trial Control Settings profile 
you require is highlighted in blue.

▪ In the Acquisition screen, under Settings, select the Trial Control Settings 
you require.

Test your setup thoroughly before carrying out the actual trials (see above).

Apply Trial Control Settings to multiple planned trials
Choose Setup > Trial List. For each trial planned in the list, select the Trial Control 
Settings you require in the Trial Control Settings column. 

For more information, see Prepare the trial list for batch acquisition.
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Further information on Trial Control
Learn about

▪ How the trial control instructions are executed
▪ Trial control when tracking from video files
▪ Trial control in multiple arenas

What do you want to do?
▪ View trial control instructions during acquisition
▪ Analyze trial control data
342



How the trial control instructions are 
executed
When EthoVision XT evaluates conditions and actions
During a Trial, EthoVision XT evaluates the Trial Control Settings selected for that 
trial, and checks the state of conditions and actions at each sample time. Note that 
the sample time depends on the chosen sample rate, not on the video frame rate.

How EthoVision XT evaluates conditions and actions
The program remembers which Trial Control box was evaluated (active) in the 
previous sample. Depending on the type of this box:

▪ For a Condition box. EthoVision XT checks whether the condition at the 
current sample time is met. If it is not, the condition becomes false. The 
program waits until the condition is met. When this happens (condition 
becomes true; see 3 in the figure below), the program passes control to the 
next box in the sequence. The condition becomes then inactive (see 4).

▪ For an Action box. EthoVision XT carries out the action, and passes control 
to the next box, which becomes active. Then, the Action box becomes 
inactive (see 4-5). 

▪ For sub-rules and sub-rule references, see the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.

When a box becomes active, the previous becomes inactive.

Notes
▪ Boxes combined in parallel using operators are evaluated at the same 

sample time, in unspecified order. This means that one cannot establish 
which condition is evaluated/which action is taken first. 

▪ Actions on Trial Control variables are executed immediately. Actions on 
hardware devices are executed when all boxes that must be evaluated at 
that sample time have been evaluated.

▪ If a box being evaluated contains a condition that is immediately true, the 
program passes control to the next box. Therefore, within one sample time 
the program can pass control to two or more boxes to the right.

▪ When you stop the trial or the Maximum trial duration has been reached, all 
Trial Control boxes are deactivated and hardware devices are reset. See 
Control the end of tracking
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▪ When the Rule End box of the Start/Stop trial rule is evaluated, data 
recording stops. From that moment, Trial Control is deactivated, even in 
those sub-rules that were ongoing in the meantime. 

Schematic representation of how Trail Control Instructions are executed. The 
scheme shows an example of a Start-Stop trial rule.

1. Tracking starts, either manually or because a previous condition has been 
met. 

2. Control passes to a Condition box (for example, “Is mouse on top of 
Shelter?” which becomes active (hatched outline). The condition is 
evaluated. Since the condition is not met immediately, it becomes false.

3. The Condition becomes true (solid outline).
4. Control passes to the next box. In this case, it is an Action. Actions are taken 

immediately. 
5. The Action box becomes inactive (light outline). The next box becomes 

active.
For clarity, step 3 and 4 have been placed separately. In reality, when a condition is 
met it becomes inactive at the same time, and control passes to the next box. 
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Trial control when tracking from video 
files
When tracking from pre-recorded video files
EthoVision XT checks conditions using the time in the video file, instead of the real 
time.

▪ For conditions based on time. If you select the DDS option, Trial Control is 
carried out at the speed set by EthoVision in order not to skip video images. 
This results in the video playing faster or slower than normal (1x), 
depending on the processor load necessary to detect subjects. For example, 
if detection requires little processor work, the program tracks the subject 
faster than normal. A Time condition (for example, Time 60 s) is therefore 
met earlier than at real time.

▪ For conditions that use clock time. If you define a condition based on clock 
time, or schedule a sub-rule with clock time, this is translated into the video 
start time, that is, the date and time the video file used for tracking was 
created.
EXAMPLE 1  You set a Time condition to start tracking After clock time 11:30. 
The video file was created on March 6, 2008 at 11:00. once you start the 
trial, the condition is met half an hour later in the video.  
If you had set to start tracking After clock time 10:30, tracking would start 
immediately after starting the trial. 

EXAMPLE 2  You set a sub-rule to start at 10:00 (1st day). The video file was 
created on March 6, 2008 at 11:00. Once you start the trial, the sub-rule 
never starts, because the planned start occurs before the initial time of the 
video. To make a sub-rule start when tracking from that video, set the start 
time between 11:00 and the video end time. 

When recording video, then tracking
You can choose to record video first with EthoVision XT and then acquire the tracks 
from the resulting video file. In that case:

▪ When recording video, Trial Control is turned off.
▪ When you track from that video, Trial Control is activated, but you cannot 

control hardware devices. 
See Record video, then acquire a trial 
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When re-doing a trial
For video files recorded with EthoVision XT, you can re-do the corresponding trial 
(see Redo a trial). Note that the Trial Control log files recorded with the previous 
instance of the trial are deleted.
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Trial control in multiple arenas
Each arena gets its copy of Trial Control Settings
If your experimental setup includes two or more arenas, Trial Control is applied to 
each arena separately. This means that, if a condition is met in one arena, 
EthoVision XT takes the corresponding action in that arena, not the others.

EthoVision XT evaluates the instructions for each arena within the same sample 
time. The order in which arenas are evaluated is not stored in your data.

See also an example

▪ Working with trial control in multiple arenas.

Using zones in multiple arenas
A condition or action is not specific to one arena. If the condition is based on a 
zone, that zone must be present in all arenas, and have the same name.

If the zone is not present in an arena, Trial Control cannot progress for that arena. 
Therefore, tracking does not stop unless you set a maximum trial duration or 
tracking reaches the end of the video. See Control the end of tracking

Maximum trial duration with multiple arenas
Note the difference:

▪ If the Trial Control Settings include a maximum trial duration, tracking stops 
in all the arenas simultaneously.

▪ If the Trial Control Settings does not have a maximum trial duration, and a 
condition is set before the Stop track box, tracking does not necessarily 
stop in all the arenas simultaneously. Consider the following example: 
Start tracking is set when the subject is found for the first time, just like in 
the default Start-Stop trial rule. A Time condition of 5 minutes is placed 
before the Stop track box. If the subjects in two arenas are found for the 
first time at different times, tracking starts at different times in the two 
arenas. Tracking also stops at different times, after the five minutes applied 
to each subject independently.
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View trial control instructions during 
acquisition
Aim
During acquisition you can view the status of the trial control instructions. This way 
you can check that the Trial Control Rule works as expected. For example, check 
that an action is taken when the subject enters a zone. You can also view Trial 
Control States, which are time intervals defined by two Trial Control Events.

To view trial control states or events during acquisition
In the Acquisition screen, click Show/Hide and select Show Dependent variables. 
Select Trial Control Event, or Trial Control State.

See also

▪ An example in Conditioning test: view a Trial Control State variable
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Analyze trial control data
Aim
To analyze the events of the Trial Control rule which occurred during a trial. For 
example, visualize when a condition became true, or when EthoVision sent a 
command to an external device. You may want to do this for two reasons:

▪ To test if the Trial Control rule works as expected.
▪ To analyze the subject's response to presentation of stimuli in conditioning 

tests.

To visualize or calculate statistics of Trial Control data
1. Choose Analysis > Analysis Profile > New. In the Components pane, 

under Trial Control, click the button next to 
Trial Control event for example, to visualize when exactly a condition 
become true.

Trial Control state for example, to visualize the time from the moment a 
condition became active to when the condition became true.

2. Calculate statistics or visualize the data (choose Analyze > Results > ...).
For details, see Trial Control in the Analysis profile (page 1116), and Analysis of 
Trial Control data in the EthoVision XT 18 - Trial and Hardware Control - Reference 
Manual.

To analyze intervals based on Trial Control data
If you want to calculate statistics and visualize data of dependent variables like 
velocity in portions of a track based on Trial Control data, do the following:

1. In the Data profile, define an interval based on Trial Control data. You can 
use:
Nesting over a Trial Control state or

Nesting over a Free interval based on Trial Control events.

2. Specify the dependent variables in the Analysis profile.
3. Calculate statistics or visualize the data (choose Analyze > Results > ...).
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To export Trial Control data
See Export Trial Control data.
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Configure Detection 
Settings

Main topics and tasks
▪ Introduction to Detection Settings  352
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▪ Advanced detection settings for tracking color-marked subjects  406
▪ Detect the nose and the tail base  423
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Introduction to Detection Settings
Learn about

▪ Useful things to know about Detection Settings
▪ Adjust detection settings - General procedure
▪ Detection settings: Automated setup
▪ Detection settings: Advanced setup
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Useful things to know about Detection 
Settings
Detection Settings are a set of criteria to track moving subjects. Detection Settings 
specify, for example, how different the subject is from the background in terms of 
gray scale or color values, and how many images per second will be analyzed 
among those available.

You can create multiple Detection settings in the same experiment. For example, 
you can have one set for detecting white animals, and another to detect dark ones.

TIP  For a DanioVision experiment, see the DanioVision DVOC-0041 - Reference 
Manual. To open this manual, on the Apps screen choose Noldus > EthoVision XT 
18 Other Documentation.

To open the Detection Settings
Choose Setup > Detection Settings > choose one of the options. 

By default, the following windows are displayed:

▪ A. Detection Settings
▪ B. Video, showing the current camera image or video file.
▪ C. Playback Control
▪ D. Detection Performance.

Click the Show/Hide button on the toolbar to view/hide windows, or change 
features shown, like the yellow blob representing the subject being detected.
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Automated Setup
EthoVision XT has an Automated Setup function to apply the detection settings that 
work well in the most common scenarios. In most cases you will obtain good 
detection using the Automated Setup. In difficult situations, for example if video 
quality is bad, or if you have multiple animals with color markers that are not 
distinct enough, the Automated Setup may not give good enough detection. If this 
is the case, use the advanced settings to create the detection settings manually. 

Detection Settings available in your EthoVision XT license
Which settings are available depends on your EthoVision XT license:

▪ EthoVision XT Base version: In this version, you can track the center-point, 
the nose-point and the tail-base point of a single animal. 
The base version also allows tracking of a color marker on a single animal; 
in this case the color marker is treated as the center-point of the animal.
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▪ Social Interaction Module: This add-on allows you to track two or more 
animals in one arena, either color-marked or unmarked. Use this module in 
combination to study social interactions in detail.
We recommend to only use Tracking from video files if you track the three 
body points in combination with the Social Interaction module.

▪ Behavior Recognition Module: For detecting a number of behaviors 
automatically, including rearing, grooming and sniffing. In the Detection 
Settings, the Behavior Settings are enabled.
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Adjust detection settings - General 
procedure
 Subject detection works well if there is good contrast between the subject and the 
background in the video image, and for the whole duration of the trials. Increasing 
the contrast (for example, by changing the background so it differs as much as 
possible in color from the subject) is far more effective than any detection setting.

To adjust the detection settings
1. Select the sample rate and video file. See Video file, image quality and 

sample rate on page 357.
2. Use the Automated Setup functionality to detect the subject. See Detection 

settings: Automated setup on page 366.
3. Optionally use advanced detection settings if Automated Setup does not 

give satisfying detection. See Detection settings: Advanced setup on 
page 370.

Notes
▪ IMPORTANT Make sure you carefully follow the order of steps as described in 

the next topics. If a particular step does not apply to your setup, proceed to 
the next step.

▪ Every time you apply changes in the Detection Settings window, you can 
see the consequences in the Video window. 

▪ To save the detection settings, click the Save Changes button at the 
bottom of the pane. If you have made more changes and you want to 
return to the last saved settings, click the Undo Changes button. 

▪ EthoVision XT offers a number real-time statistics on the quality of 
detection that you can check while you adjust detection settings.
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Video file, image quality and sample 
rate
Learn about

▪ Video file and image quality
▪ Sample rate
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Video file and image quality
What you see under Video depends on whether you track from video files, or live.

Select Video
Available when tracking from video files. By default, the Detection Settings shows 
the same video file used in the Arena Settings, to obtain a background image.

To use another video file, click Select Video.

Image quality
Available when tracking live, and for some cameras, not others. To adjust, for 
example, the image contrast or brightness, click the Image Quality button under 
Video. 

IMPORTANT Always try adjusting the lighting and camera aperture settings before 
changing the Image Quality Settings.

In the window that appears, adjust the properties you require.
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▪ Contrast enhances the lighter and darker parts of the image.
▪ Brightness makes the image lighter
▪ Saturation increases the color intensity. 

Dependent on the camera, some settings may be grayed out. 

Notes
▪ For some cameras, the Image Settings are not available. In the Experiment 

Settings, click the camera button and click the Image tab. See Video source
▪ The Image Quality Settings also affect the image that is saved to a video 

file.
▪ To return to the defaults of the camera driver, click the Default button.
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Sample rate
The sample rate is the number of images EthoVision XT analyzes per second. 
Selecting a certain sample rate does not mean that the program can always analyze 
data at that rate. If the computer processor load is too high, EthoVision XT may skip 
a sample and analyze the next one. Skipped samples result in missed samples (see 
below). 

The maximum sample rate is the camera frame rate. The sample rate you set in 
EthoVision XT can only be the frame rate divided by an integer. For example, for PAL 
video it is 25, 12.5, 8.33, etc.

IMPORTANT Some digital cameras support very high frame rates. However, subject 
detection at such rates requires a lot of processor capacity. To prevent that 
EthoVision XT discards samples while tracking live, do not set the frame rate and 
sample rate too high. Check the percentage of missed samples (see View the 
detection statistics) to make sure the EthoVision XT can handle the selected frame 
rate.

What is the optimal sample rate?
Setting the correct sample rate is very important. If the rate is too high, the noise 
caused by small movements of your animal will be picked up and give an 
overestimate of dependent variables such as the distance moved. If the sample rate 
is too low, you will loose data and get an underestimate of the distance moved. See 
also the picture below. 
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General guidelines for the sample rate
We strongly recommend that you determine the optimum sample rate for your 
specific setup and animals (see To determine the optimal sample rate). If, for 
instance, your treatment causes hyperactivity, you will need a higher sample rate for 
hyperactive animals than somnolent animals.

NOTE  In the list below, the sample rate for NTSC video (29.97/s) is approximated to 
30/s.

Rodents

▪ Rat, single subject, center-point only: 5/s
▪ Mouse, single subject, center-point only: 12/s
▪ Rat/Mouse Behavior recognition: 25-31/s (depending on TV standard)
▪ Rat/Mouse, three body points: 25/s (PAL) to 30/s (NTSC or digital camera)
▪ Rat/Mouse, three body points combined with marker-assisted 

identification: 12.5/s (PAL) to 15/s (NTSC or digital camera)
▪ Rat/Mouse, three body points combined with Deep learning-based 

identification: 25/s or higher. See Deep learning: Requirements
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Other mammals

▪ Tree shrew (Tupaia): 6-12/s

Fish

▪ Zebrafish, adult: 5-6/s
▪ Zebrafish larva: For analog camera: 25/s (PAL) or 30/s (NTSC). For digital 

camera: 30/s or 60/s*
(*) For rapid movements you may want to track with a higher sample rate. It 
depends on the number of tracked subjects, the video resolution, the 
camera settings and the processor speed of your computer whether that is 
possible.

▪ Damselfish: 5/s
▪ Goldfish: 0.5/s

Arthropods

▪ Mite: 1/s
▪ Parasitic wasp: 2/s
▪ Tick: 3/s

To determine the optimal sample rate
The optimal sample rate is the minimum sample rate that provides an accurate 
estimation of the dependent variables (distance, velocity, etc.) without including the 
redundant information due to phenomena other than the 'real' locomotion. For 
example, for an animal walking in a straight line the data points will never be in a 
straight line because the center-point of the subject shifts laterally with each step. In 
order to distinguish between 'real' movement and effects like the one described 
above, you can calculate dependent variables like distance moved using the 
maximum or a lower sample rate.

1. Create new Detection Settings and specify the maximum sample rate. Be 
aware that the maximum sample rate also depends on the performance of 
your computer, the number of animals you track, and the video resolution.

2. Acquire data with those Detection Settings.
3. Calculate the dependent variable you are interested in.
4. Export the data to Excel and plot the dependent variable values against the 

sample rate. In the example below, distance moved is used.
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5. Repeat the steps above by selecting smaller sample rates. 
Once the data are plotted as in the figure below, there should be a range of sample 
rates for which the dependent variable value does not change much (plateau). This 
means that slight changes in the sample rate do no result in loss of information, or 
addition of redundant information (noise and movements like body wobble).

Low sample rates result in loss of useful information, because the sinuosity of the 
original path is removed. Therefore, the total distance moved is usually decreased.

High sample rates result in acquisition of redundant information. In the case of 
body wobbling, and assuming that the animal is moving along a straight line, the 
lateral shift of the body center causes the total distance moved to be longer than 
the 'real' one. With Track smoothing you can filter out 'noise' as a result of body 
wobble. See Smooth the Tracks

Missed samples
The actual sample rate may be lower than the maximum you set, because an image 
cannot be captured until the previous one is processed. If the sample rate you 
define is too high, EthoVision will miss samples (up to 1% is acceptable) and the 
processor load will be high. The percentage of missed samples is shown in the 
Detection performance pane and in the Trial List as a System Variable. You can 
calculate the number of missed samples in acquired tracks with the Number 
statistic of continuous variables (e.g., velocity). If your processor load is larger than 
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100, and there are large amounts of missed values, you will have to lower the 
sample rate.

TIP  After acquisition you can see the proportion of missed samples in the Trial list 
as one of the System Variables. 

TIP  When acquiring from video files, in the Playback Control window select the 
option DDS (Detection Determines Speed). This way, no samples will be missed. 
See DDS (Detection determines speed)

Factors affecting the occurrence of missing samples
The following factors may cause the processor load to be too high:

▪ Computer memory, processor speed and video graphics card capacity: See 
the system requirements. In general, using a computer with a dual-core 
CPU helps you to work with higher sample rates than normal computers do.

▪ Other programs installed: Do not install other video software (for example, 
video editing programs, DVD burning software), because this can interfere 
with EthoVision XT's video processing and cause a reduction in 
performance.

▪ Other programs are running: Make sure you shut down all other programs, 
including those running in the background such as e-mail programs and 
virus scanners. These are usually shown in the System Tray in the bottom-
right corner of your screen.

▪ Image resolution: For live video tracking, In the Experiment Settings you 
can choose the resolution for your video image.

▪ Size of arenas: Make arenas as small as possible (but including the entire 
area the animal can be in).

▪ Number of arenas: If you track live and use more than four arenas in a trial, 
check first that no samples are missed. If the number of missed samples is 
too high, first make a video file, then track from that. More generally, if you 
track from video files the number of arenas is never a problem as long as 
you select DDS (Detection determines speed).
When making detection settings, you could start with making an arena 
definition with only one area which speeds up the detection process. After 
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you have finished configuring detection settings for one arena, you can add 
the others to the arena definition.

▪ Display options: You can decrease processor load by minimizing the 
number of Track Features to be displayed (see View the detection features 
on the video window).

▪ Detection method: If possible, use the Gray scaling method which requires 
less processor load than Static subtraction. Static subtraction requires less 
processor load than Dynamic subtraction and Differencing. See Advanced 
detection settings: Method
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Detection settings: Automated setup
Aim
To quickly instruct EthoVision XT how to recognize the subject that moves in the 
arena. 

TIP  For common tests like the Open field and the Morris water maze, choose 
Automated Setup. If Automated Setup does not work well enough, see Detection 
settings: Advanced setup.

Prerequisites
▪ The subject must be released in the arena. If you work with pre-recorded 

video, play the video to a point when the subject is well visible.
▪ The contrast of the subject with the background is crucial for success with 

video tracking software. Choose Help > Video Tutorial and watch the 
video chapter Set up your Test Environment for tips on how to improve 
the contrast between the subject and the background. 

Procedure
1. In the Detection Settings pane, click the Automated Setup button.

2. Choose the type of animal you work with, then click Next.

3. Drag the mouse to draw a rectangle around the subject.
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▪ If you have multiple subjects, draw a rectangle around each of them. 
Make sure that the subjects are not in contact with one another.

▪ If you have multiple arenas, draw a rectangle around each subject in 
every arena.

▪ For rodents, draw the rectangle around the animal’s body. Try to leave 
the tail out of the rectangle. 

▪ For fish, always include the caudal fin in the rectangle.
4. Move the Finetune slider until detection quality is satisfactory. 

Moving the slider to the left detects more from the subject, for example it 
results in including the legs and tail of a rodent, but also more noise. 
Moving the slider to the right results in detecting less noise, but also less of 
the subject.

Below you see a detailed image of the same rat as in the picture above, 
when detected correctly (the red dot marks the detected center point).
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5. Check in the Detection Performance pane under Subject not found if 
detection is good. As a guideline, the percentage Subject not found should 
be lower than 10% if the animal is visible at all times. Realize that the initial 
frames in which the subject was not detected yet is included in this 
percentage. If the number of samples (in brackets) under Subject not 
found does not increase or hardly increases anymore, and the percentage 
Subject not found decreases, detection is good. After acquisition, in the 
Trial list click the Show/Hide button and select Variables. Select Subject 
not found and check the percentage in the Subject not found column.

6. If detection quality is satisfactory, click Yes. If not, click No and continue 
with the Detection settings: Advanced setup.

Notes
▪ If you work with the Deep learning detection technique, the Automated 

Setup (above) also includes the automatic adjustment of the Cutout 
window. This makes it less likely that you need to adjust this setting once 
again. See Adjust the settings for nose-tail base detection (Deep learning)

The next step
What you do next depends on how many subjects and what EthoVision XT 
functions you want to use.

▪ One subject per arena; Center-point detection
At this point you do not need to do anything anymore. If detection is not 
good enough, see Detection settings: Advanced setup

▪ One subject per arena; Nose-tail detection
See Detect the nose and the tail base. In the picture below you see an 
example of a mouse with its three body points detected correctly.
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▪ Social interaction (marker-assisted identification)
See Advanced detection settings: Marker-assisted identification, step 4.

If not all subjects are detected well after the Automated Setup, click No. 
Click Automated Setup again, and repeat the procedure when the subjects 
are in other locations. If this does not help, see Advanced detection settings 
for tracking color-marked subjects.

▪ Social interaction (unmarked subjects)
See Advanced detection settings for tracking multiple unmarked subjects

▪ Rat or Mouse behavior recognition
See Detection settings for Behavior recognition.

If detection is not satisfactory after the Automated Setup, continue with 
Detect the nose and the tail base. Then proceed with Detection settings for 
Behavior recognition.
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Detection settings: Advanced setup
If you do not get satisfactory detection with the Automated Setup, in the Detection 
Settings pane click Advanced. 

To track one animal per arena, center-point only
Follow the procedures in this order:

1. Advanced detection settings: Method
2. Advanced detection settings: Smoothing
3. Advanced detection settings: Subject contour
4. Advanced detection settings: Subject size (one subject per arena)

Other cases
▪ For tracking multiple animals per arena, color-marked

See Advanced detection settings for tracking color-marked subjects

▪ For tracking multiple animals per arena, unmarked
See Advanced detection settings for tracking multiple unmarked subjects

▪ For tracking center-point, nose-point and tail-base
See Detect the nose and the tail base

▪ For Behavior Recognition
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See Detection settings for Behavior recognition

▪ For tracking larvae in DanioVision
See the DanioVision DVOC-0041 - Reference Manual. To open this manual, 
on the Apps screen, choose Noldus > EthoVision XT 18 Other 
Documentation.
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Advanced detection settings: Method
Aim
To choose:

▪ The detection method, that is, how EthoVision XT finds the subject over the 
background. Once you have selected the method, specify the background 
image (for the detection methods Static Subtraction, Dynamic Subtraction 
and Differencing only) and the level of contrast between subject and 
background. See below.

▪ The method for estimating the body points. See Methods for estimating the 
body points

Gray Scaling
Choose Gray scaling when:

▪ The animal's grayness differs from the background in all parts of the arena.
▪ The background does not change during a trial.
▪ Lighting is even (minimal shadows and reflections) during the trial. 
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EXAMPLE  Tracking a white rat in a uniform black open field with no bright objects. 

Static Subtraction
Choose Static Subtraction when:

▪ The Gray scaling method does not work, for example because other objects 
in the arena have a similar color as the animal.

▪ The background does not change in time.
▪ The light is constant during the trial.

EXAMPLE  Tracking a white rat in an open field with unavoidable reflections or bright 
objects.

Dynamic subtraction
Choose this method when during trials light conditions gradually change or the 
background changes, for example because bedding material is kicked around, food 
pellets are dropped, droppings appear etc.

EXAMPLE  Tracking a mouse in a home cage provided with bedding material. The 
activity of the mouse causes the bedding to change appearance in the video image. 

Differencing
Choose this method when there is a lot of variation in contrast between a subject 
and the background within an arena.

EXAMPLE  There is a gradient in light intensity over the apparatus that cannot be 
removed, or a strong difference in the color of the fur of the animal, like in hooded 
rats.
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Gray Scaling
Aim
To detect the subject, under the assumption that its color is always different from 
that of the background (no shadows, gradients etc.).

How Gray scaling works
The video image is converted to monochrome. Each pixel in the image has a gray 
scale value, ranging from 0 (black) to 255 (white). With Gray scaling, you define 
which range of gray scale values should be considered as the subject. The 
remaining gray scale values are considered as background. The Gray scaling 
method does not make use of a background image, the subject is determined by its 
gray scale values only.

Procedure
1. In the Detection Settings pane, click Advanced, then Method. Select Gray 

scaling.
2. Release the subject in the arena, or position the media file at a point where 

the subject is moving.
3. Move the two sliders next to Range or type the values in the corresponding 

fields to define the lower and higher limits of gray scale values for the 
subject. Make sure there are no areas in the background with gray scale 
values that fall in this range, otherwise they will be detected as the subject. 

4. In the Video window, check the quality of detection. 
If the detected area (by default, in yellow) is too large, or other objects are 
detected as the subject, reduce the range in either direction (brighter or 
darker).
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If the detected area is too small relative to the real subject, increase the 
range at least in one direction (brighter or darker).

Areas marked as noise (by default, in orange), indicate that the gray scale 
range is too wide: you need to narrow it in at least one direction.

5. Move the sliders until the subject (or the part which is of interest) is 
detected fully, and the noise is minimized. Check that the subject is properly 
detected in all parts of the arena by moving the video slider, or by waiting 
for the live animal to move. 

IMPORTANT The whole animal's body must be detected for optimal tracking. 
Proceed with the Contour adjustments to optimize body detection.
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Static Subtraction
Aim
To detect the subject, assuming that the background does not change over time. 

How Static Subtraction works
The video image is converted to monochrome. Each pixel in the image has a gray 
scale value, ranging from 0 (black) to 255 (white). With the Static subtraction 
method, you choose an image of the arena without the subject, named Reference 
Image. When analyzing the images, EthoVision XT subtracts the gray scale value of 
each pixel in the reference image from the gray scale value of the corresponding 
pixel in the current image (live or from video files). The pixels with non-zero 
difference are considered the subject. 

You can remove small non-zero differences by defining the contrast between 
current image and background that must be considered as the subject (see the 
procedure below). The remaining pixels are considered as the background. 

Below: An example of how the Static subtraction detection method works. The gray 
scale value of each pixel of the reference image is subtracted from the gray scale 
value of each pixel of the live image. The result is ‘0’ for every pixel; if the difference 
> ‘0’ and within the gray scale range you have set, these pixels are considered to be 
the subject. So, with this method your task is to specify the contrast that optimizes 
the detection of the subject.

Procedure
1. In the Detection Settings pane, click Advanced, then Method. Select Static 

subtraction. 
2. Click the Background button. The Reference Image window opens with 

the image that is currently used as background. The aim is to obtain a 
reference image that does not contain images of the animals you want to 
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track. To do so, follow the instructions on the screen in consecutive order. If 
A fails, move on to B, if that fails move on to C. See also Optimize the 
reference image.

3. From the Subject color … list, select one of the following, depending on 
the color of the subject you want to track:
Brighter: For example, to track a Wistar rat in a black open field. 

Darker: For example, to track a C57BL6 mouse in an open field with white 
bedding.

Brighter and darker: For example, to track a DBA2 mouse in a home cage 
with white background and a black shelter, or a hooded (black and white) 
rat in a uniform gray open field.

Depending on the selection above, different contrast sliders become 
available. For each slider, the contrast varies from 0 (no contrast) to 255 (full 
contrast). Unlike with Gray scaling, the values selected with the sliders 
represent the difference between the current and the reference image, not 
absolute gray scale values.

4. Release the subject in the arena, or position the media file at a point where 
the subject is moving.

5. Move the appropriate slider or type the values in the corresponding fields 
to define the lower and higher limits of the contrast that corresponds to the 
subject. In the Video window, check the quality of detection.
EXAMPLE 1  The subject is brighter than the background. Only the whiter 
area of the subject is detected.

Move the Bright slider to the left to increase the range towards values of 
lower contrast between subject and background. 

EXAMPLE 2  The subject is darker than the background. Its body is detected 
only partially in the area of lower contrast.
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Move the Dark slider to the left to increase the range towards lower values 
of contrast between subject and background.

EXAMPLE 3  The subject is brighter and darker than the background. Only 
the darker areas of the black fur are detected.

Move the Bright slider to the left to increase the range towards less 
contrast between the subject's white areas and the gray background. Then, 
move the Dark slider to the left to increase the range towards less contrast 
between the subject's black areas and the background.

6. Move the sliders until the subject (or the part which is of interest) is 
detected fully, and the noise is minimized. Check that the subject is properly 
detected in all parts of the arena by playing back different parts of the video 
file, or by waiting for the live animal to move.
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Notes
When the subject is brighter and darker than the background, detection only works 
well when there is enough contrast between the areas of different brightness and 
the background. For example, tracking a hooded rat works well when the 
background is intermediate between black and white. Rather, use Differencing.
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Dynamic subtraction
Aim
To detect the subject, while compensating for temporal changes in the background. 

EXAMPLES

▪ Detect a rat in a water maze, where other detection methods do not work, 
usually because of the effect of waves in the pool.

▪ Detect a mouse in a PhenoTyper or home cage with bedding material, 
where the animal’s activity (e.g. digging) changes the appearance of the 
background.

▪ All cases where lighting changes slowly.

How Dynamic Subtraction works
Like with Static subtraction, EthoVision XT compares each sampled image with a 
reference image, with the important difference that the reference image is updated 
regularly. This compensates for temporal changes in the background. See How the 
reference image is updated in Dynamic subtraction.

Procedure
1. In Detection Settings pane, click Advanced, then Method. Select Dynamic 

subtraction.
2. Click the Background button. The Reference Image window opens with the 

image that is currently used as background. The aim is to obtain a reference 
image that does not contain images of the animals you want to track. To do 
so, follow the instructions on the screen in consecutive order. If A fails, 
move on to B, if that fails move on to C. See Optimize the reference image.

3. From the Subject color … list, select one of the options from the list, 
depending on the color of the subject you want to track.

4. Move the slider next to Bright/Dark to select the range of the contrast 
between subject and background.
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5. Move the slider next to Frame weight or enter the value in the appropriate 
field to specify how the reference image is updated (range 0-100%):

In typical situations, a value between 1-5 gives a good result.

IMPORTANT As much of the animal's body must be detected for good tracking. See 
Advanced detection settings: Subject contour to optimize body detection.

Frame weight
▪ Select a low value if you want to have a large number of past images to 

contribute to each reference image. As a result, changes in the background 
are diluted over many images. Choose a low value when the background 
changes slowly.

▪ Select a high value if you want to have a small number of past images to 
contribute to each reference image. As a result, changes in the background 
are captured over short time. Choose a high value when the background 
changes rapidly, for example, when the subject is very active and moves the 
bedding material around.

▪ If you select 0 as Frame weight, the reference image is not updated. This is 
the same as using Static Subtraction. 

▪ If you select 100, each sample gets its own reference image with no 
contribution by the past images. In most cases a Frame weight of 100 does 
not give good detection, because the subject itself is often removed from 
the detected image when it moves slowly or sits still.
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TIP To find the optimal Frame weight, set a value and carry out one or more trials. 
Evaluate if the tracking was satisfactory. If not, increase or decrease the setting by 
20% and try again.
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Differencing
Aim
To detect the subject, while compensating for spatial and temporal changes in the 
background. 

How Differencing works
Like with Dynamic subtraction, the Differencing method updates the reference 
image over time. Differencing makes a statistical (probabilistic) comparison 
between each pixel in the reference image and the pixels of the current image. The 
statistical comparison uses the variance in the contrast between the current and 
reference image to calculate the probability that each pixel is the subject.

The Differencing method takes more processor load than the subtraction methods. 
Therefore, when using Differencing, make sure you computer meets the system 
requirements. 

Procedure
1. In the Method section of the Detection Settings window, select Differenc-

ing.
2. Click the Background button. The Reference Image window opens with the 

image that is currently used as background. The aim is to obtain a reference 
image that does not contain images of the animals you want to track. To do 
so, follow the instructions on the screen in consecutive order. If A fails, 
move on to B, if that fails move on to C. See Optimize the reference image.

3. From the Subject color … list, select one of the options from the list, 
depending on the color of the subject you want to track.

4. Next, if necessary, adjust the position of the Sensitivity slider and change 
the option selected in the Background Changes list.

The Sensitivity slider determines what difference in contrast from the 
background is seen as the animal. For an image with good contrast, there is 
no need to change the slider. For images with less contrast, adjust the 
position of the slider to the right or the left until the subject is properly 
detected.

In the Background Changes list you can select options that reflect how fast 
the background changes. For example, a cage with bedding might change a 
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lot because of animals kicking around the bedding material. If this case, to 
prevent changes in the background to interfere with detection, select 
'Medium fast' or faster. Usually, 'Medium slow' works just fine.

IMPORTANT As much as possible of the animal's body must be detected for good 
tracking. 
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Methods for estimating the body points
Depending on the experiment mode (standard vs. DanioVision) and how many 
subjects and body points you specify in the Experiment Settings, the Method 
section of the Advanced Detection Settings window lists one or more options.

NOTE  In some cases, like when tracking the center point of one subject, this group 
of options is not available, because EthoVision XT applies the only method possible 
for that experiment.

Any Species / Default 

▪ This was called Shape-based / Any in EthoVision XT 14 and earlier.
▪ This method analyzes the contour of the blob detected as subject at each 

sample to assign the nose-point and the tail-base. If you track rodents, 
make sure that the tail is fully detected.

▪ The subject’s center-point is calculated as the geometric center of the area 
detected as subject. See Calculation of the center-point below for details.

▪ This method is automatically activated when you track the center-point in 
one animal per arena, and you specified Other species in the Automated 
setup.

▪ If your experiment is from an older EthoVision XT version, you have 
additional options available. Here you can choose to use the last 
improvements or keep the settings as they were in the older experiments.
▪ Choose Priority on tail base position whenever the tail is apparent in 

the video and well detected. This method finds the tail base and then 
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assigns the nose-point to the opposite point in the subject contour. If 
the tail base is not found, then other rules based on the contour are 
used to find the nose-point. Choose Balanced (XT 14 and earlier) if 
you want to use the same method as in previous EthoVision XT 
versions, or if for any reason the first option does not give good results.

Rodents / Default

▪ This was called Simple Model / Rodents in EthoVision XT 14 and earlier.
▪ This method analyzes the shape of the blob detected as subject and builds 

up a “rodent model”. It is more robust than the Any species / Default 
method because it does not require the nose and tail to be visible: it can 
'predict' the position of the nose and the tail based on previous samples.

▪ The subject’s center-point is calculated as the geometric center of the area 
detected as subject. See Calculation of the center-point below.

▪ Choose this method when you want to track a single rodent without 
occlusions or without difficult tracking conditions, like in an open field or a 
novel object recognition test. For optimal results, make sure in the 
detection settings that the tail is removed from the body contour, using 
Erosion and then Dilation. See Advanced detection settings: Subject 
contour

▪ If you upgrade your experiment from an older version of EthoVision XT, 
select Extra correction of nose-tail swaps to use the latest algorithm that 
aims at correcting nose-tail swaps during tracking. Compared to previous 
versions, this algorithm corrects swaps faster, reducing the total number of 
samples with swaps (if they occur). Choose EthoVision XT 15 and earlier if 
you want to keep using the old algorithm.

The extra correction is based on the detection of false backward 
movements, that is, when the animal looks like it is moving backward when 
the nose and the tail-base points are swapped.

Rodents / For occlusions

▪ This was called Advanced Model / Rodents in EthoVision XT 14 and earlier.
▪ This method learns the animal shape and how it moves in the first 15 

frames and continually updates its statistics. Therefore, it can handle severe 
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shape distortions, such as, for example, when the subject’s body is occluded 
or when two subjects come into contact. However, it requires a lot of 
computer performance.

▪ The subject’s center-point is calculated as the geometric center of the area 
detected as subject. For experiments created with previous EthoVision XT 
versions, choose how EthoVision XT should find the center point. See 
Calculation of the center-point below for details.

▪ Choose this method for rodents in a social interaction context, or when you 
track rodents that can be occluded, for example, by bars or other objects in 
the cage. For optimal results, make sure in the detection settings that the 
tail is removed from the body contour, using Erosion and then Dilation. See 
Advanced detection settings: Subject contour and Subject contour for 
nose-tail base detection

Adult Fish / For occlusions

▪ This was called Advanced Model / Adult Fish in EthoVision XT 14 and earlier.
▪ Choose this method to track adult zebrafish and other fish of similar shape, 

when viewed from above. Make sure that the whole body of the fish is 
detected, including the tail. This method is recommended no matter how 
many fish you track in the same tank.

▪ The subject’s center-point is calculated as the geometric center of the area 
detected as subject. For experiments created with previous EthoVision XT 
versions, choose how EthoVision XT should find the center point. See 
Calculation of the center-point below for details.

Other species / For occlusions

▪ This was called Advanced Model / Other in EthoVision XT 14 and earlier.
▪ This method does not make any assumption about the shape of the 

subject. Note: with this method you only track the center point.
▪ The subject’s center-point is calculated as the geometric center of the area 

detected as subject. For experiments created with previous EthoVision XT 
versions, choose how EthoVision XT should find the center point. See 
Calculation of the center-point below for details.

▪ Choose this method to track for example insects, crustaceans or large 
animals, and when multiple subjects move in the same arena, or when 
occlusions make detection difficult.

▪ Also choose use this method to track fish from the front view of the water 
tank, and the Adult Fish method does not give good results.
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DanioVision

▪ This method is optimized to track zebrafish larvae on a white background. 
It is only available in DanioVision experiments.

▪ Moving the Sensitivity slider to the left results in detecting more of the 
body of the larvae, but also more noise. Moving the slider to the right 
results in detecting less noise, but also gives less good detection of the 
larvae.

▪ For more information, see the DanioVision DVOC-0041 - Reference Manual.

Method names
Please note that the names of the methods above differ from those in EthoVision 
XT 14 and earlier versions:

Calculation of the center-point

For new experiments

In all new experiments, the subject’s center-point is determined using the area of 
the blob (in yellow, per default) that indicates detected subject. The x, y coordinates 
of the center-point are the average of the x, y coordinates of each pixel in the blob. 
For example: 

If the tail is detected, that contributes to the position of the center-point.

EthoVision XT 15-17 EthoVision XT 12-14 EthoVision XT 11 and earlier

Any species / Default Shape-based / Any Shape-based (XT 4)

Rodents / Default Simple Model / Rodents Model-based (XT 5)

Rodents / For occlusions Advanced Model / Rodents Advanced Model-based (XT 6

Adult Fish / For occlusions Advanced Model / Adult Fish -

Other species / For occlusions Advanced Model / Other -
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Experiments created in EthoVision XT 14 and earlier

If your experiment was created in a previous EthoVision XT version, and you use 
one of the For occlusions methods, you can choose whether to use the detected 
area (as described above) or the shape model. Choose Use center of model (XT14 
and earlier).

The x, y coordinates of the center-point is the average of the pixels coordinates of 
the model fit over the detected subject. In many situations the model has a more 
regular shape than the detected area. For example:

Choose this option Use center of model (XT14 and earlier) to keep compatibility 
with older experiments. Consider that, if detection or the model parameters are not 
optimal, the model may differ greatly from the subject’s image. In this case the 
center point may shift compared to the expected position (see B vs. C in the next 
picture). This may add up distance moved on the long run.

Below: A. Subject not detected. B. Center point determined as the model’s center. C. 
Center point determined as the center of the detected area.

If that happens often, choose Use center of detected area. Or, for multi-subject 
tracking, adjust the modeled subject size. See Advanced detection settings: Subject 
size (multiple animals per arena)

See also

▪ Adjust the settings for nose-tail base detection (Contour-based)
▪ Subject contour for nose-tail base detection
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Advanced detection settings: Smoothing
Aim
To make tracking less depending on noise.

▪ Use Video pixel smoothing to remove fine-grained noise in the video 
image.

▪ Use Dropped frames correction to compensate for irregular frame rate in 
low-end cameras.

▪ Use Track noise reduction to reduce jitter of the body points and smooth 
out the track during acquisition.

How to access these options
In the Detection Settings window, under Advanced, click Smoothing.

Procedure
▪ Video pixel smoothing
▪ Dropped frames correction
▪ Track noise reduction

See also

▪ Smooth the Tracks after acquisition
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Video pixel smoothing
Aim
The Video pixel smoothing option reduces the difference between adjacent pixels 
prior to detection, by smudging the image, that is, replacing the gray scale value of 
each pixel with the median of the surrounding pixels.

Background information
How does video pixel smoothing work? In the following example, a bright pixel with 
gray value 240 is surrounded by darker pixels:

▪ If you select Video pixel smoothing= Low, that pixel gets the median value 
calculated among the 8 nearest pixels plus that pixel itself. In that case the 
median is 150, so that pixel will look darker.

▪ If you specify Video pixel smoothing= Medium, the median is calculated 
over the 24 nearest pixels plus the pixel itself. 

▪ If you specify Video pixel smoothing= High, an even bigger group of 
surrounding pixels is considered.

Procedure
1. In the Detection Settings, under Advanced, open Smoothing.
2. Next to Video pixel smoothing, choose one of the values:

▪ None (default): No pixel smoothing. The video image is analyzed for 
subject detection as it is.

▪ Low: Each pixel is blended with the 8 nearest pixels (pixel distance =1). 
▪ Medium: Each pixel is blended with the 24 nearest pixels (pixel 

distance 1 or 2). 
▪ High: Each pixel is blended with the 48 nearest pixels (pixel distance 1, 

2 or 3).
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Notes
▪ Select a moderate Video pixel smoothing value or leave None selected If 

adjacent pixels in the background are relatively constant. Using more 
surrounding pixels for the smoothing effect does not bring up better 
results.

▪ Select a high Video pixel smoothing value if adjacent pixels in the 
background are on average very different. For example, when the cage's 
bedding material looks grainy. In such cases you need to smooth each pixel 
using more surrounding pixels to compensate for this variation.

▪ A high Video pixel smoothing level requires a significant amount of 
processor capacity.

▪ Using Video pixel smoothing may result in losing information in the video 
image important for detection. For example, sharp borders of subjects, etc.

▪ Pixel smoothing does not affect Color marker tracking. It does affect 
detecting the body contour in Marker assisted tracking.

See also

▪ Advanced detection settings: Smoothing
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Dropped frames correction
Aim
To interpolate data points when a video frame is not available at the required 
sample time.

NOTE  This information does not apply if you use analog cameras, GigE cameras and 
USB cameras supported with EthoVision XT. Normally those cameras do not skip a 
significant number of video frames, provided that you set the camera properly, 
especially the resolution, the frame rate and the exposure time. For digital cameras, 
see Configure the digital camera

IMPORTANT  This correction only deals with missing video frames, not when 
EthoVision XT does not detect the subject in a valid video frame, for example 
because of wrong detection settings. If you want to interpolate the points when the 
subject was not found, do this in the Track Editor. See Interpolate points

Background information
Some low-end cameras like webcams and IP cameras are not capable of achieving a 
fixed video frame rate. With those cameras, the time between two consecutive 
video frames is not constant enough, so that EthoVision XT cannot assign a video 
frame to a specific sampled time. 

EthoVision XT accepts video frames originated from a camera or a frame grabber, 
and assigns them to the expected sample time t, t+1, t+2, etc. according to the 
specified sample rate.

In the figure below, frames 1 and 3 arrive at the expected times. Frame 2 arrives a 
bit late but it is assigned anyway to its expected time. In all those cases EthoVision 
XT produces a valid sample.

However, if video frames do not arrive for significant time, no frame is assigned for 
one or more sample times. The result is a missing sample at time 3. Note that, 
because a frame was missing, frame 3 is assigned to time 4.
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Whenever missing samples occur, EthoVision XT can fill the gaps with interpolation, 
using the adjacent valid samples.

Procedure
1. In the Detection Settings, under Advanced, open Smoothing.
2. Next to Dropped frames correction, do one of the following:

▪ Select On if you want to apply the dropped frames correction. The 
missing samples will be replaced with valid samples obtained with 
linear interpolation. 

▪ Select Off (default) to leave the missing samples. If you select Off, you 
can always interpolate the missing samples after acquisition, in the 
Track Editor. See Interpolate points

Notes
▪ Dropped frames correction occurs during tracking. Interpolation is 

performed only for missing samples due to dropped frames. EthoVision XT 
interpolates between the last valid sample before a missing sample and the 
first valid sample after the last missing sample, for a maximum of 10 
consecutive dropped frames. If more than 10 dropped frames are found, 
correction is not done, and the subject remains missing for those samples.

▪ Dropped frames correction does not change the video time of the valid 
video frames. For example if the frame rate is not exactly 30 fps, the time 
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between subsequent frames will not be exactly 1/30 s = 0.03333 s. Small 
differences in the time between subsequent frames remain.

▪ Interpolation is only applied to the body points, and to the subject area. 
The center point is interpolated linearly using the center points in the 
adjacent samples. The nose- and tail-base point are obtained by doing 
interpolation on the angles formed by the segment joining the nose-point, 
the center point and the tail-base point. See How the nose-point and tail-
base point are interpolated

▪ Interpolation is not applied to: body elongation, head direction, area 
change from the previous sample (used to calculate mobility), and activity. 
Those values remain missing for the interpolated sample.

▪ To know the percentage of video frames actually corrected, see View the 
detection statistics.

See also

▪ Advanced detection settings: Smoothing
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Track noise reduction
Aim
To reduce the effect of noise in the data during tracking.

EXAMPLE  When the center point of an animal is detected in a zone, you want the 
pellet dispenser to drop a pellet. If the detected center point is moving rapidly 
because of noise, this may result in a number of consecutive pellets to be dropped, 
every time the center point crosses the border of the zone. Track noise reduction 
may solve this problem. 

IMPORTANT  Do not use Track noise reduction if you are particularly interested in 
rapid movements of the subject, for example, if you study the startle response of 
zebrafish larvae.

Background information
If the detected center point of the subject is continuously moving, while in fact the 
subject is sitting still, the total distance moved will be overestimated. You can use 
track smoothing to correct for this after you have acquired your data (see Smooth 
the Tracks), however in some cases you may want to smooth the track during 
acquisition. This may especially be the case if you use Trial and Hardware Control.

The example below shows the effect of track noise reduction (TNR) on the x 
coordinates of the tracked subject. The chart plots the x coordinate against time. 
With TNR on, the path is smoothed out.
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Procedure
1. In the Detection Settings, under Advanced, open Smoothing.
2. Next to Track noise reduction, do one of the following:

▪ Select Off (default) if you do not want to apply track noise reduction.
▪ Select On if you want to apply track noise reduction.

Notes
▪ Track noise reduction makes use of the Gaussian Process Regression 

method. Track noise reduction is applied during acquisition. Hence, it alters 
the acquired tracks, which cannot be undone afterwards. 
With Gaussian Process Regression, the sample points are smoothed, using 
the x,y coordinates of the previous 12 sample points. This differs from the 
Lowess post-acquisition smoothing method that uses samples before and 
after the sample point to be smoothed. This is not possible during 
acquisition, because the x,y coordinates of future samples are not yet 
known.

▪ Using Track noise reduction in the Detection Settings influences the 
acquired track, and therefore it is not possible to change it back after 
acquisition. This is in contrast to post-acquisition smoothing (see Smooth 
the Tracks) where you can use profiles to calculate analysis results with and 
without those filters applied.

▪ If you use noise-tail tracking, the paths of the nose point and tail base are 
smoothed independent of the path of the center point. 

▪ If you use Track noise reduction, the sample points may lag behind when 
compared with the video images, especially when the subject moves fast. 
This is because the sample position is smoothed using point locations 
acquired in the previous samples. 

▪ When you use Track nise reduction in combination with hidden zones, the 
subject may go missing when it is in fact in a hidden zone. This occurs when 
the last (smoothed) position of the subject before it disappears from view is 
outside the entry zone. See the Troubleshooting topic: The animal is in the 
hidden zone but the data show “missing sample”. 

See also

▪ Advanced detection settings: Smoothing
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Advanced detection settings: Subject 
contour
Aim

▪ To eliminate the detection of thin objects such as the rodent's tail.
▪ To remove the effect of fibers and other thin objects of similar color as the 

subject, for example in optogenetic stimulation systems.
▪ To remove the effect of cage bars.
▪ To 'join up' the parts of the body, when they are detected separately. For 

example a zebrafish when swimming over a dark object.

How to access this option
In the Detection Settings window, locate Subject Contour.

Procedures

To remove the rodent’s tail, or thin objects

1. Select Erosion >0, Dilation >0. In most cases the second Erosion filter is 
not necessary. 

2. Increase the values Erosion and Dilation until the rodent’s tail or the 
interfering objects are no longer detected.
TIP  Try with equal values for Erosion and Dilation; alternatively, Erosion 
slightly higher than Dilation. For example, 3, 2, 0. 
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For tethered animals, increase Erosion until only the subject is detected:

To remove the effect of cage bars

▪ If the cage bars are the same color as the subject, first erode, then dilate. In 
the example below, Erosion 1, Dilate 3, Erosion 0.

▪ If the cage bars are darker (or lighter) than the subject, then first dilate, then 
erode. In the example below, Erosion 0, Dilation 4, Erosion 1. 

To 'join up' parts of animals like fish and insects

1. Select Erosion 0, Dilate > 0, Erosion > 0.
2. Increase Dilation until the subject’s body is fully detected. Then increase 

Erosion to return to the normal subject size. For example Erosion 0, 
Dilation 4, Erosion 2.
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How Erosion and Dilation work

Contour erosion

Erosion removes an external layer of pixels from the subject’s contour. The detected 
subject appears smaller. 1 means that a layer of 1 pixel is removed. Range: 1 to 10.

Contour dilation

Dilation adds a layer of pixels around the subject’s contour. The detected subject 
appears larger. 1 means that a layer of one pixel is added. Range: 1 to 20.

Combine erosion and dilation
Select Erosion and Dilation when you want to keep the apparent size of the subject 
as the original. 

When you select at least two filters, erosion and dilation are applied based on the 
sequence that results from which filters you choose. 

▪ Erosion > 0, Dilation > 0, Erosion =0. A layer of pixels is removed, then 
another layer is added to the contour. This is the same as Erode first, then 
dilate in EthoVision XT 15 and earlier. 

▪ Erosion = 0, Dilation > 0, Erosion > 0. A layer of pixels is added, then 
another layer is removed from the contour. This is the same as Dilate first, 
then erode in EthoVision XT 15 and earlier.

▪ Erosion > 0, Dilation > 0, Erosion > 0. A layer of pixels is removed, then 
another layer is added, and finally a third layer is removed. 
TIP  Use this combination to improve nose-tail detection in some difficult 
situations, for example when the subject enters a darker area. Adding the 
second Erosion filter may help.
400



Note
▪ It is important that the complete body of the animal is detected. If even 

after setting the Contour adjustments you do not achieve this, go back to 
the appropriate Detection method and adjust the contrast to improve body 
detection.

▪ A reason for why you may want to eliminate the animal's tail is that when 
the animal sits still and its tail moves, it adds to distance moved. 
Furthermore, when the tail is not part of the detected blob, the center point 
is better estimated.

▪ If you apply Erosion 2, Dilation 0, Erosion 2, the effect is like that of Erosion 
4, Dilation 0, Erosion 0.

See also

▪ The video tutorial Contour Settings.
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Advanced detection settings: Subject size 
(one subject per arena)
Aim
To set a minimum and a maximum apparent size of the subject to prevent objects 
like droppings or large reflections from being detected during tracking.

This topic applies to
All experiments set to:

▪ Number of Subjects per Arena: 1
▪ Body point detection technique: Contour-based

Procedure
1. In the Detection Settings window, locate the Subject Size.

2. When EthoVision XT finds the subject, check the value under Current. The 
Current value gives an idea of the detected body size in pixels.

3. Click the Edit button and set the Minimum and Maximum subject sizes. 
Objects that have the same color as the animal, but are smaller than the 
Minimum or larger than Maximum size, are not tracked.

You are now ready to acquire data.

Notes
▪ The term size here means surface area in video pixels, not length or screen 

pixels. Enlarging the Video window does not change the subject's size in 
video pixels. 

▪ Objects whose size is outside the size range, are shown in the color under 
Noise (default: orange; see View the detection features on the video 
window).

▪ Click the video icon next to Subject Size and watch the video tutorial.
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Advanced detection settings for 
tracking multiple unmarked subjects
Aim
To set EthoVision to track multiple subjects per arena, when the subjects are not 
color-marked. 

▪ To minimize subject identity swaps, make sure that the subjects are well 
detected in the whole arena. Make lighting as uniform as possible, and use 
indirect light, to minimize shadows.

▪ When subjects crowd closely together EthoVision may temporarily assign 
the same position to those subjects, or lose track of one of them. This can 
be minimized or totally eliminated by setting good detection settings. 
Make sure that the body of the subjects is fully detected, and that the 
reference image does not contain the image of the subjects.

This topic applies to:
Experiments set to:

▪ Number of Subjects per Arena: 2 or more.
▪ Tracked Features: Center-point, nose-point and tail-base detection.
▪ Body point detection technique: Contour-based

If you use Deep learning to track two subjects, you do not need to adjust 
detection settings. Simply choose the sample rate (step 1 below) and skip 
the remaining steps. See Deep learning: Requirements

Procedure
1. In the Detection Settings window, under Video, select the image source 

and sample rate. See Video file, image quality and sample rate. 

2. Use the Automated Setup. When the Automated Setup gives good 
detection, proceed with the next step. If not, create advanced detection 
settings, follow the procedure in Advanced detection settings: Method.
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3. In the Detection Settings pane, under Subject Identification, select 
Unmarked subjects.

4. OPTIONAL  Click a cell under Body fill and specify the color for a subject. 
This helps checking identity swaps during tracking.

5. Adjust Advanced detection settings: Smoothing settings.

6. When tracking the three body points: adjust Subject contour for nose-tail 
base detection. In all other cases see Advanced detection settings: Subject 
contour.

7. Adjust Advanced detection settings: Subject size (multiple animals per 
arena).
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Notes
▪ When tracking unmarked animals, it is not possible to specify which animal 

is labeled “Subject 1”, which “Subject 2” and so on. EthoVision XT chooses 
which individual is assigned a label. This also means that the same animal in 
video 1 is not necessarily labeled with the same name in video 2. To link the 
identity (or role) of Subject 1, Subject 2, etc. enter that information as an 
independent variable in the Trial List. See Define an independent variable

▪ When tracking unmarked subjects, identity swaps may occur, that is, what is 
labeled Subject 1 may at some point in the track be labeled as Subject 2, 
and what was Subject 2 is now Subject 1. Always check carefully the tracks, 
and, if necessary, correct the identity swaps. See Swap subjects
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Advanced detection settings for 
tracking color-marked subjects
Aim
Use color marks in one of the following cases:

▪ When detection of the subject is difficult, for example because its color is 
similar to that of the arena.

▪ When you want to track multiple animals per arena, and you want to keep 
the correct identity of each individual.

Background information
There are two ways of tracking subjects that are color-marked: Marker-assisted 
identification and Color marker tracking. The difference between the two is as 
follows:

▪ Marker assisted identification. EthoVision XT tracks the animal's body but 
uses the marker to determine the animal's identity. In the Detection settings 
pane, under Subject Identification, select Marker-assisted identification. 
See the procedure in Advanced detection settings: Marker-assisted 
identification on page 408.

▪ Color marker tracking. EthoVision XT only tracks the marker’s geometric 
center, and ignores the subject’s body. The actual shape and size of the 
animal is ignored. To apply this method, in the Experiment settings under 
Tracked Features select Color marker tracking (treat marker as center-
point). 
Next, see the procedure Advanced detection settings for color marker 
tracking on page 421.

In all cases, you can track up to 16 animals simultaneously in the same arena. This is 
a technical limit; in practice, it may be difficult to discriminate between 16 different 
color marks depending on the light conditions.

Procedure
1. Advanced detection settings: Marker-assisted identification
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2. Advanced detection settings: Smoothing
3. Advanced detection settings: Subject contour
4. Advanced detection settings: Subject size (multiple animals per arena)

See also

▪ Advanced detection settings for tracking multiple unmarked subjects
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Advanced detection settings: Marker-
assisted identification
Prerequisites

▪ You have marked the animals with colors.
▪ You have optimized lighting as suggested in Tips for color tracking.

To adjust detection settings for marker-assisted identification
1. Put the marked animals in the arena or play the video.
2. In the Detection Settings window, under Video, select the image source 

and sample rate. See Video file, image quality and sample rate. 

3. Use the Automated Setup. 

At this stage EthoVision XT detects the subjects, but does not distinguish 
between the animals yet. When the Automated Setup gives good detection, 
proceed with the next step. If not, create advanced detection settings, 
follow the procedure in Advanced detection settings: Method.

When done with the Automated Setup, make sure Marker-assisted 
identification is selected in the Subject Identification section in the 
Detection Settings pane. Note:

▪ IMPORTANT Make sure you select a point in the video where the animals 
do not touch!

▪ If you use three-body point detection, it is normal that the nose is not 
correctly identified at this point.
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▪ If detection is processor intensive and you track from video, the video 
slows down, so all frames can be analyzed to enable creating good 
detection settings. 

4. In the Subject Identification section, click the name of one of the subjects 
and click the Identification button.

Result: The Identification [Subject name] window opens. Optionally enlarge 
the Video window by dragging its bottom-right corner.

5. Move the mouse pointer to the Video window so the pointer becomes an 
eyedropper.

6. Move the eyedropper on top of the color marker of the subject you want to 
identify (see the figure below) and click the left mouse button.

The Identification [Subject name] window now displays the color you just 
picked and the pixels with the initial color are highlighted in the Video 
window. In the Identification [Subject name] window, you can change the 
following (see also the figure below):

Hue: Hue is the predominant wavelength of the marker color and 
represents what is usually referred to as color in everyday life (red, green, 
blue, etc.). The range of values for Hue of the picked color are shown and 
this range is represented by the box on the vertical color bar on the right.
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Saturation: Saturation represents the purity of a color. Saturation decreases 
when a pure color is mixed with white; “red” is saturated, “pink” is less 
saturated. The range of values for Saturation are shown and this range is 
represented by the width of the box on the Color map.

Brightness: Brightness (or Intensity) represents the amount of light 
reflected by the colored surface. The range of values for Brightness are 
shown and this range is represented by the height of the box on the Color 
map. If you set this range too broad, you will not be able to separate the 
colors well.

Below: A: Color bar. The box represents Hue which corresponds to an angle 
on the circle in the HSI color model (for example, 0 degrees means red, 240 
degrees means blue). B: Color map. The height of the box represents the 
Brightness (or Intensity) range which corresponds to the vertical position of 
the color circle. The width of the box represents the Saturation range which 
corresponds to the horizontal position on the circle between the center and 
the edge.
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If the marker is not detected completely or not detected in all areas of the 
arena, expand the range of Hue, Saturation and Brightness slightly.
411



Change the color range by changing the numbers or by resizing the Hue 
box on the vertical color bar, or resizing/moving the box in the color map 
(horizontally to adjust Saturation, vertically to adjust Brightness). As a result, 
the outline covers (almost) the complete marker.

Below: The color of the marker after fine-tuning the color settings. Most of 
the marker is now selected as indicated by the white outline.

7. Next, play the video to see in the Video window whether the marker is 
detected correctly in different parts of the arena. 
If the marker 'dances' then your color settings are too sensitive. Go back to 
step 5 and make the box larger.
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8. Continue with setting the following:
▪ Marker erosion: Set the number of pixels to erode. By selecting Erode 

first, then dilate, you can make the marker more round to prevent the 
center-point of the marker to start jittering.

▪ Marker dilation: Set the number of pixels to dilate. By selecting Dilate 
first, then erode, you can prevent the marker from being masked or 
divided in two separate markers by, for instance, a grid on top of the 
arena.

▪ Minimal marker size: Set the Minimal marker size to prevent noise to 
be detected as the marker. First, increase the Minimal marker size until 
noise is not detected anymore. Next, enter a value for the Minimal 
marker size that is somewhere in between this lower threshold and the 
value of the Current marker size.

Marker pointer: Select a Marker pointer from the list. With relatively small 
markers it is useful to select Cross lines.

9. Click OK when you are done.
Click another subject under Subject Identification, and repeat steps 2-8 for all 
subjects you want to identify. If you used the Automated Setup, estimates for the 
settings below have been created. Optionally fine-tune these settings if detection 
of all subjects does not go well in the entire track. 

What next?

Follow the procedure in this order:

1. Advanced detection settings: Smoothing
2. Advanced detection settings: Subject contour
3. Advanced detection settings: Subject size (multiple animals per arena)
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Advanced detection settings: Subject size 
(multiple animals per arena)
Aim
To specify the average (and variation) of size of subjects, when tracking multiple 
subjects per arena.

IMPORTANT When setting the Subject size, make sure the animals do not touch each 
other.

To set subject size
1. In the Subject size section, click the Advanced button.

In the Size window, in the figure at the top, the thin red contour represents 
the current size of what EthoVision XT assumes is the animal shape.

▪ To set the Detected subject size, proceed with step 2. Set the Detected 
subject size to ensure that small or very large objects are not detected 
as a subject.

▪ To set the Modeled subject size, proceed with step 3. Set the Modeled 
subject size to obtain an estimate of the subject’s body size, and body 
position of the different subjects when they overlap or touch. 

2. Set the Minimum and Maximum subject size (represented by a green 
contour):
▪ Maximum subject size: The largest surface area (in pixels) that is 

detected as the subject. Objects bigger than the Maximum subject size, 
for example, the experimenter's arm, are detected as noise and not 
tracked. Decrease the Maximum subject size until its thick green 
contour surrounds the thin red contour by a fair margin.

▪ Minimum subject size: The smallest surface area (in pixels) that is 
detected as the subject. Objects smaller than the Minimum subject size, 
such as droppings or disturbed sawdust, are detected as noise and not 
tracked. Increase the Minimum subject size until its thick green contour 
is smaller than the thin red contour by a fair margin.

The two sliders are interdependent. So, after you have set the Minimum 
subject size, when you next change the Maximum subject size, the slider for 
the Minimum subject size also moves (although the size in pixels stays the 
same).
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3. In the Modeled subject size group, select Apply settings to all subjects if 
your multiple animals have similar sizes.

4. Select one of the subjects to model the subject size for, by clicking the 
name of the subject.

5. Next, adjust the modeled subject size (under Average - pixels) to the 
detected subject size (under Current - pixels):
You do this by clicking the Grab button. Keep clicking the Grab button until 
the modeled (Average) subject size equals the detected (Current) subject 
size.

Below: Part of the Modeled subject size group in the Size window (left) 
and the Video window. In the table, Current shows the current detected 
subject size in pixels, Average shows the modeled subject size in pixels. The 
arrows point to the visual feedback you get about the current and average 
subject size in the Video window.
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When the modeled (Average) subject size equals the detected (Current) 
subject size, the following becomes visible:

▪ In the Modeled subject size group: the Average subject size now 
equals or is larger than the Current subject size (see the table in the 
figure below).

▪ In the Video window: the modeled subject size now completely 
overlaps with the current subject size (see the figure below).

▪ In the Size window, the bold yellow contour represents the modeled 
subject size. This now coincides with the detected subject size indicated 
by the thin red contour.

Below: Part of the Modeled subject size group in the Size window (left) 
and the Video window. The modeled (Average) subject size is now adjusted 
to the detected (Current) subject size. Compare the table and video window 
in this figure with those in the figure above.
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6. You can now set the Tolerance. Click the corresponding cell and enter a 
value.
The Tolerance determines the deviation of the average subject size. When 
the Current detected size deviates more from the Average subject size than 
the Tolerance, then the object is not considered to be the subject anymore 
and EthoVision starts making an educated statistical guess about the body 
contour of the animal.

This is visible in the Video window by a wobbling marker-color area. When 
this happens when animals do not touch, you should increase the 
Tolerance.

7. Select the Fix check box for each subject.
8. Optionally click Advanced Modeled Parameters and change the settings 

for the Maximum noise size, Shape stability, and Modelling effort (see 
below).

Subject size when tracking multiple fish
Click Grab until the body fill color covers the whole body. Or, enter the body size 
under Average and select Fix. Keep Tolerance high (70-100%).
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Make sure that in the Subject size window, the red contour oscillates within the 
limits of the Average subject size (bold yellow contour). 

If that is not the case, click Grab when you see in the Video window that the 
subjects are detected correctly, or enter the appropriate value of size in the Average 
cell, then select Fix.
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Advanced Modeled Parameters

Maximum noise size

Set the Maximum noise size. The value should be lower than the minimum subject 
size and but high enough to make sure that small objects with the same contrast as 
the subject are not detected.

Shape stability

The Shape stability setting is used when you track animals whose body can be 
occluded by, for example, cage bars or part of the body of another animal. When 
this happens, the animal's body consists of two separate objects that are close 
together.

The Shape stability optimized for slider has two extreme settings:

▪ Occlusions: When you set the slider close to Occlusions, EthoVision 
considers separate objects that are close together part of one animal.

▪ Noise: When you set the slider close to Noise, EthoVision considers 
separate smaller parts not part of the animal.

The figure below shows the animal model as a result of applying the two extreme 
Shape stability settings. 'Noise' shows that the front of the animal, on the other side 
of the bar, is not considered to be part of the animal. 'Occlusion' displays the animal 
body as a whole.

If you are not sure which setting to select, leave Shape stability at the default value 
of 620.
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Modeling effort

The Modeling effort setting is used when two animals touch and EthoVision loses 
the separate shapes. At this point, EthoVision tries to determine which part of the 
big 'merged' body fill belongs to either animal. This costs a lot of processing load.

The Modeling effort optimized for slider has two extreme settings:

▪ Performance: When you set the slider close to Performance, EthoVision is 
only allowed a short time to determine which part of the 'merged' body fill 
belongs to which animal. Therefore, Modeling quality is low.

▪ Modelling: When you set the slider to Modelling, EthoVision XT is allowed 
a longer time per frame to determine which part of the 'merged' body fill 
belongs to which animal. Therefore, Modelling quality is good, but this 
costs a lot of processor load.
We recommend to select Modelling only when you have a computer that 
exceeds the minimum system requirements.

When you are not sure which setting to select, leave Modeling effort at the default 
value of 500.

Tips for setting the Subject Size
▪ Make sure you do not set the Tolerance too small; it is better get a wrong 

body size/shape than a wrong location of the animal.
▪ It is better to set the Average subject size slightly bigger than the actual 

subject size, especially when you carry out nose-tail tracking.
▪ If you want to carry out live tracking with multiple similarly-sized animals, it 

is recommended to first introduce one animal into the arena and make the 
Subject Size settings for this animal.

▪ If the subject size changes a lot between trials, it is recommended to create 
new Detection Settings for this new size.
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Advanced detection settings for color 
marker tracking
Aim
To specify which colors EthoVision XT should follow when tracking color markers.

Prerequisites
▪ You have marked the animals.
▪ In the Experiment Settings under Tracked Features you selected Color 

marker tracking (treat marker as center-point).

Note that with this option you track only the marker, while the animal’s shape is 
ignored.
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Procedure
1. Put the marked animals in the arena or play the video. Optimize the camera 

setup, lighting conditions and marker characteristics. See Tips for color 
tracking

2. In the Detection Settings window, under Video, select the image source 
and sample rate. See Video file, image quality and sample rate.

3. In the Detection Settings window, click Subject Identification.

4. Carry out steps 4 to 9 in Advanced detection settings: Marker-assisted 
identification for all subjects. 

No additional settings are necessary, EthoVision XT tracks the markers and makes 
no estimate of the body contours.
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Detect the nose and the tail base
Learn about

▪ Overview of nose-tail base detection
▪ Optimize nose-tail base detection

When do I need this information?
In the Experiment Settings, under Tracked features, you chose Center-point, 
nose-point and tail-base detection. Choose the procedure based on what you 
selected under Body point detection technique. See Body point detection 
technique

Contour-based technique

Follow the procedure in this order:

1. Adjust the settings for nose-tail base detection (Contour-based)
2. Adjust Advanced detection settings: Smoothing
3. Adjust Subject contour for nose-tail base detection
4. Adjust Subject size for nose-tail base detection

Deep learning

Follow the procedure: Adjust the settings for nose-tail base detection (Deep 
learning)

NOTE  Subject size and contour do not affect the performance of the Deep learning 
algorithm. Therefore, EthoVision XT should be able to find the nose and tail base 
points also when the detection of the subject’s body is not optimal. However, we 
advise you to adjust the settings for size and contour, especially if you want to 
analyze the body’s mobility.
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Overview of nose-tail base detection
When you set an experiment for Nose-tail base detection, EthoVision XT analyzes 
the contour of the area detected as subject at each sample, and assigns Nose-point 
and Tail-base to two specific pixels of the contour. Furthermore, it determines the 
direction the animal is supposed to point to (Head direction). 

Nose-tail base detection is optimized for rodents and for adult fish, depending on 
the method used.

Nose- and tail-base points
The two points are detected independently through one of two complex 
algorithms. The nose-point is found in all cases, except when the center-point is not 
found either. The tail-base may not be found in a few cases if detection is good.

Reliable tracking of nose and tail-base is limited by the size of the video image. You 
can mix four camera images like in the case of a group of PhenoTypers, with good 
results. Mixing 16 camera images makes the subjects too small for reliable nose and 
tail-base tracking.

Head direction
Once the nose-point has been found, two points are determined along the contour 
lying at a specific distance from the nose-point. The Head direction is the line 
dividing equally the angle formed by the center and those additional points.

IMPORTANT If you use Nose-tail tracking with two or more subjects per Arena, track 
from video file instead of live.
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Adjust the settings for nose-tail base 
detection (Contour-based)
Aim
To achieve detection of the nose- and tail-base points of your subjects with high 
accuracy.

Prerequisites
▪ In the Experiment Settings, under Tracked Features, you chose Center-

point, nose-point and tail-base detection.
▪ You have optimized the lighting and the background. See Optimize nose-

tail base detection

Procedure
1. Select the image source and sample rate. See Video file, image quality and 

sample rate.
2. Use the Automated Setup. When the Automated Setup gives good 

detection, proceed with acquisition. If not, follow the steps below. See 
Detection settings: Automated setup

3. Under Video, choose the sample rate. 
Use a sample rate as high as possible. However, for nose-tail tracking in 
combination with marker-assisted tracking, use a sample rate of 12.5, 15 or 
14.98 samples/s depending on the camera.

4. Open the Advanced detection settings: Method. Choose the detection 
method and the method for estimating the body points. See Methods for 
estimating the body points
If you followed the Automated Setup, a Default method is selected 
automatically for one-subject tracking, and For occlusions for multiple-
subject tracking. See Methods for estimating the body points

In the picture below: Left, a sub-optimal result of body detection (part of the right 
side of the body is not detected). Right, the result when the contrast settings are 
optimized; now the complete body is detected. The color of the body contour at 
this stage is orange (=noise) because the model parameters have not been 
configured yet.
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Notes
▪ The maximum sample rate depends on the camera.
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Subject contour for nose-tail base 
detection
Aim
To optimize the shape of the detected subject, so that the body points are correctly 
found.

Procedure
▪ When you use one of the following methods for detecting the body points, 

Any species / Default, or Adult Fish / For occlusions, make sure the tail is 
fully detected as part of the subject.

▪ When you use a Rodents method (Default or For occlusions), it is best to 
remove detection of the rodent’s tail. See Advanced detection settings: 
Subject contour

Notes
▪ When you track fish from above, the tail-base point is not positioned on the 

tail fin, rather more towards the mid-point. That is normal and is not a sign 
of bad detection.

See also

▪ Advanced detection settings: Subject contour
▪ Subject size for nose-tail base detection
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Subject size for nose-tail base detection
Aim
To optimize the size of the detected subject, so that the body points are correctly 
found.

Procedure
Choose the option depending on which method for estimating the body points you 
are using.

▪ For Any species / Default or Rodents / Default:
See Advanced detection settings: Subject size (one subject per arena).

▪ For Rodents / For occlusions and Other species / For occlusions:
See Advanced detection settings: Subject size (multiple animals per arena).
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Optimize nose-tail base detection
Because of the way the nose- and tail base points are found, nose-tail base 
detection is much depending on the quality of the video image and the 
experimental setup. Before using this feature, please check the following guidelines:

Conditions related to the Arenas
▪ Light: Light conditions must be equal across the arena. Try to remove 

shades, light spots and reflections. For proper detection, the subject's body 
contour must be kept as constant as possible across the whole arena. 

▪ Subject/background contrast: The color of the subject and of the 
background must be contrasting enough to get a full and clear body 
contour.

▪ Video quality: Noise and interference reduce the proportion of samples 
which are correctly detected.

▪ Noise reduction: The Video Pixel Advanced detection settings: Smoothing 
function can sometimes help getting a more appropriate body contour. 
However this is of little use if the video has too much noise or too little 
contrast. 

▪ Areas hidden to the camera view: When the animal enters or exits areas 
hidden to the camera (for instance, a shelter), nose-point and tail-base are 
wrongly assigned. 

▪ Number of arenas: Reliable tracking of nose and tail-base is limited by the 
size of the video image. You can mix maximally four camera images like in 
the case of a group of PhenoTypers, with good results.

Conditions related to the Subjects
▪ Subject's apparent size: The subject must be large enough to get a constant 

body contour. Small animals and large arenas pose detection problems with 
nose- and tail-base points. When you mix the image of multiple cameras 
with a quad unit, like in the case of a group of PhenoTypers, a group of 4 
cameras gives good results. When mixing 16 PhenoTypers, the apparent 
size of the subject is generally too small.

▪ Subject's color variation: For hooded rats, both the flanks (white) and the 
head (dark) must contrast with the background, otherwise detection of 
body contour is sub-optimal. In the Detection Settings, next to Subject 
color compared to background select Brighter and darker than 
background. You can also try the Differencing detection method instead of 
the Subtraction methods.
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▪ Subjects in a water maze: Tracking nose- and tail-base points in a water 
maze is impossible because the tail-base is under the water, and it is not 
possible to obtain a proper body contour.

▪ Subject's behavior: Immobile animals are hard to track because their body 
contour differs from that of a mobile animal. Nose-points are therefore 
hard to detect.

Important choices
▪ Tracking live vs. from video files. We recommend to track from video files if 

you use one of the methods named For occlusions. Tracking live requires 
high processor load, which may result in many missing points, especially 
when you use multi-subject tracking and multiple arenas simultaneously.

▪ When tracking from video files. Keep the DDS (Detection determines speed) 
option selected, unless you score behaviors manually.

▪ Missing tail-base points: The high percentage of missing tail-base points is 
an indication of poor detection. The higher this percentage, the greater the 
probability that the nose-point is not placed in the correct location. To 
estimate the proportion of missing tail-base points, run some test trials and 
visualize the Sample list in the Track Editor screen. You can also calculate 
the Number of samples as a statistic for a dependent variable such as 
Velocity for the nose point.

In practice…
The contour of the blob detected as subject is crucial for proper detection of nose- 
and tail-base points. If only part of the subject is detected, EthoVision XT may swap 
the pixels assigned as nose-point and tail-base.

Or the nose-point is not placed on the subject's nose tip (for clarity, the nose point 
is shown together with the Head direction): 
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If you use a Subtraction method, select a wider range of gray scale values or, for 
Differencing, adjust the sensitivity to increase the number of pixels detected as 
subject.

Detection of the tail depends on which method you use for detecting the body 
points. See Methods for estimating the body points

▪ When you use the Any species / Default method for estimating the body 
points, make sure that the tail is fully detected.

▪ When you use one of the Rodents method, remove the tail from the 
detected subject using the Erosion then the Dilation filter. See Subject 
contour for nose-tail base detection
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Adjust the settings for nose-tail base 
detection (Deep learning)
Aim
To achieve detection of the nose- and tail-base points of your subjects using the 
Deep learning method.

This topic applies to tracking of one subject per arena. If you track two or more 
subjects per arena with Deep learning, you do need to adjust settings besides the 
sample rate. 

Prerequisites
▪ In the Experiment Settings:

▪ Under Subjects, 1 is selected.
▪ Under Tracked Features, Center-point, nose-point and tail-base 

detection is selected. 
▪ Under Body point detection technique, Deep learning is selected.

▪ You optimized the lighting and the background based on Deep learning: 
Requirements.

Procedure
1. Open the Detection Settings. 
2. In the Video section (top-right), select the video file (if you track offline) 

and choose the sample rate. See Video file, image quality and sample rate
3. Under Advanced > Method, choose the detection method and the 

contrast range. See Advanced detection settings: Method
4. In the Detection Settings window, under Detection, click the Automated 

Setup button and follow the instructions. When the Automated Setup gives 
good detection, proceed with the next step. See Detection settings: 
Automated setup

5. Play the video or wait until the subject in the live image is located (a) far 
from walls and other objects (especially when the walls and objects provide 
little or no contrast with the subject), (b) its body is not curled or 
contracted, and (c) its nose is visible.
TIP  For best results, position the video on a frame where the animal is 
slightly stretched.
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6. If you work with hooded animals, like the Lister rats, or the Long-Evans rats, 
under Method, next to Deep learning settings, select Hooded rats.

7. Under Method, next to Deep learning settings, click the Define button. 
The Cutout window opens. EthoVision XT shows a square box around the 
subject.

The size of this box should already be optimized based on the detected 
subject. The Cutout box should include the whole subject’s body leaving 
some space around it.

8. If that is not the case, click Automated.

9. Click OK.
10. The Video window now shows the subjects with its nose and tail-base 

highlighted (nose = light blue). 
11. If the nose and tail base are not detected sufficiently well, click Define 

again and move the slider until the box includes the entire body of the 
subject. See the suggestions below.
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▪ The tail of the rodent does not have to be included.
▪ IMPORTANT  Keep some space between the subject and the outline of 

the Cutout box.

Notes
▪ To improve detection, see also Deep learning: Requirements
▪ The Cutout box size is saved in the Detection Settings. The next time you 

click Define, the Cutout dialog shows last saved value.
▪ Which value for the Cutout box size? The Cutout value is shown for 

reference. Do not focus on a specific value, because other, similar values 
may work fine (for example, 135 and 137). However, take note of that value 
if you know that it works, so you can use it in the next experiment assuming 
that you use the same camera distance, arena size, etc. 

As a rule of thumb, the Cutout box should include the animal also when it is 
stretched. Make sure that the box includes some space around the animal, 
at least half the body length. 
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▪ Small animals. With small animals, the Cutout box can quickly become too 
small or too big. Adjust the Cutout value by small steps, until the nose and 
tail-base points are detected correctly.

▪ Occlusions. When the subject image is obstructed by e.g. a door, increase 
the Cutout box size, so that the nose or tail can be found on the other side 
of the obstruction. This usually improves the detection.

▪ Reflections. If there are reflections at the wall of the apparatus, and these 
give problems with detection of the nose point try to reduce the size of the 
Cutout box. See an example in Troubleshooting: The detected nose point is 
far from the animal’s contour

▪ Multiple arenas. When you work with two or more arenas, the Cutout box is 
displayed only in the last arena. Adjust its size as described above.

Examples of a good Cutout box size
▪ Subject in an open field

In the first picture below, detection won’t work because the rat’s nose is 
outside the box. In the second picture, detection may work but a large 
Cutout size increases the risk that other objects are included that are of 
similar color as the rat.
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NOTE  In this example, the subject is near the wall of the open field. 
Although that should be avoided, in this case there are no reflections and 
the walls are as dark as the floor; therefore, the contrast is good. This makes 
it possible to use an image when the subject is near the walls.

▪ Subject in a corridor or a T- / Y-maze

See also

▪ Deep learning: Requirements
▪ The chapter Methods Settings in the EthoVision XT Video Tutorial
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Detection settings for Behavior 
recognition
Prerequisites

▪ You have the Rat/Mouse Behavior Recognition Module.
▪ In the Experiment Settings, under Tracked Features, you have selected 

Center-point, Nose-point and tail-base tracking. Under Analysis Options, 
you have selected Behavior recognition.

▪ See also Behavior Recognition: Requirements

Procedure
1. Put the animal in the arena or play the video. Optimize the camera setup, 

and lighting conditions. Try to reduce reflections on the walls of the arena 
as much as possible.

2. Select the image source and sample rate. In the Detection Settings pane, 
under Video, select a value of sample rate between 25 and 30 samples/
second.
See Video file, image quality and sample rate

3. Use the Automated Setup as described in Detection settings: Automated 
setup. 

4. When detection is good, open the Behavior Recognition section in the 
Detection Settings pane and follow Advanced detection settings: Behavior 
recognition.

Notes
▪ If detection with the Automated Setup is not good, in the Detection 

Settings pane, click Detection and then Advanced. Under Method, select 
one of the following:
▪ Rodents / Default. This is selected automatically when you use 

Behavior recognition, and should work in most cases.
▪ Rodents / For occlusions. Choose this method only when Default 

does not give good results. This option is optimal when there are 
objects in the arena (for example a novel object) which create 
occlusions and make detection of the whole subject’s body difficult.
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▪ The quality and amount of light is very important when using Behavior 
recognition. See Subject exposure
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Advanced detection settings: Behavior 
recognition
To adjust Behavior recognition settings

1. In the Detection Settings pane, click Behavior Recognition.
2. If you work with video, play the video up to a frame where the subject is 

walking normally, and its hind limbs can be partially seen; see the figure 
below. It is important that the animal’s body is not contracted or stretched. 
Also, nose- and tail-base points are correctly detected.

If you track live, wait until the animal shows a posture like in the figure 
above.

3. In the Behavior Recognition Settings window, click the Grab button. 
4. A still image appears showing the detected subject’s contour and the 

detected body points.
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You can update the grabbed image at any time: 

▪ If you track from video files, position the video to another frame, and 
click Grab. 

▪ If you track live, wait that the posture of the animal is like that 
described above, and click Grab.

EthoVision XT only stores the image grabbed last.

5. In the Behavior Recognition Settings window, make sure that the calculated 
Subject length is greater than 60 pixels (55 for mice), and that the Posture 
index is between 70 and 90.

If the Subject length is smaller than 60 pixels (55 for mice), move the 
camera closer to the animal, or use a higher video resolution. The subject 
length must not exceed half the arena size.

6. Click OK to close the Behavior Recognition Settings window.

To enter specific size values (optional)
If you know specific size values (for example, from a previous experiment using the 
same animal size, camera, lighting, camera-arena distance and the same 
calibration), click Manual in the Behavior Recognition Settings window and in the 
Manual Settings window enter the following values (see the picture below for 
explanation):

▪ Subject area (in distance unit square)
▪ Center-nose length (in distance unit)
▪ Center-tail length (in distance unit)
▪ Posture (between 70-90).
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Then click OK. The Behavior Recognition Settings window says No image saved: Size 
settings were manually set.

▪ Subject size is expressed in the unit selected in the Experiment Settings.
▪ The value of Subject length in the Behavior Recognition Settings window is 

the sum of Center-nose length and Center-tail length, expressed in pixels. If 
this value is lower than 60 (55 for mice), when opening the Acquisition 
screen an error message appears. To increase subject length, move the 
camera closer to the animal, or use a higher video resolution.

Making size-dependent detection settings
Accurate recognition of behavior is based on subject size settings. Since apparent 
size increases with the subject age, all being equal, we advise you to create 
detection settings specific for a certain age class. Each Detection Settings profile 
can only be used for a limited time. For example, for Wistar rats, a Detection 
Settings profile for rats that are 3-5 weeks old, which can be used about one week, 
and a Detection Settings profile for rats older than 5 weeks, which can be used for 
two weeks.

Subjects should not vary in size for more than 10%. If that happens, create more 
Detection Settings (for example, one for smaller animals and one for larger 
animals).

IMPORTANT EthoVision XT shows a warning message in the following cases:

▪ When the sample rate set is lower then 25 or higher than 31 samples/s.
▪ When the Subject length is smaller than 60 pixels for rats, or 55 pixels for 

mice.
▪ When the animal is larger than the arena.
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Other settings for behavior recognition

Smoothing

See Advanced detection settings: Smoothing.

Subject contour

For optimal results, we recommend to select Erosion and then Dilation to remove 
the tail from the detected body. See Advanced detection settings: Subject contour 

Subject size

Choose the option depending on the method for estimating the body points.

▪ If you select Rodents / Default:
See Advanced detection settings: Subject size (one subject per arena).

▪ If you select Rodents / For occlusions:
See Advanced detection settings: Subject size (multiple animals per arena).

Subject exposure

When using Behavior recognition, the amount of light that the camera receives 
from the subject is even more important than usual. See Subject exposure
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Subject exposure
Aim
To obtain a balanced image of the subject. This is of critical importance when using 
Behavior recognition.

Prerequisites
▪ Your experiment is set for Behavior recognition. 
▪ You open the Detection Settings.

Procedure
1. Play the video or let the subject walk in the arena.
2. In the Detection Performance window, locate the Subject Exposure 

indicator. 

3. Make sure that the Exposure is Good when the subjects has been in all parts 
of the arena.

4. When the image is overexposed or underexposed, the subject looks too 
bright or too dark, respectively. The details of the fur are hardly visible. Try 
the following:
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To reduce the subject’s exposure, close the aperture of the camera lens. 
Alternatively, for GigE and USB cameras, reduce the Exposure time.

To increase the subject’s exposure, open the aperture of the camera lens or 
increase the Exposure time. If that is not possible, increase the Gain.

For how to adjust the exposure and gain, see Adjust camera settings in 
EthoVision XT.

Notes
Check the exposure level when the subject is walking, or sitting still. The subject’s 
tail should not touch the sides of its body. It that occurs, the estimate of subject 
exposure may not be reliable. 

In the following example, the image of the rat is clearly overexposed (left). However 
when the tip of the rat’s tail touches its body (right), the Subject Exposure level may 
give the impression that exposure is good.
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Wait that the subject’s tail does not touch its body, and check the Exposure Level for 
a more reliable indication.
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Activity settings
If you selected Activity analysis in the Experiment Settings, you must create settings 
for this analysis.

To make it easier to judge whether the settings are correct, make sure the detected 
Body fill of your subject is not shown in the Video window. Click the Show/Hide 
button in the top-right corner of your window, select Detection Features and 
deselect Body fill and Noise. Then select Activity. Close the Detection Features 
window and play the video. The detected pixel change between samples is shown in 
purple.

Open the Activity section in the Detection Settings pane. 

Activity threshold
This value gives the threshold for the difference in gray scale values, between a 
sample and the previous sample. 

Background noise filter
Use this filter to remove noise in the video, or camera image. With the background 
noise filter, a pixel change is only counted as a change, if the surrounding pixels also 
have changed. The pixels that are not fully surrounded with changed pixels are 
removed and around the remaining pixels a layer of changed pixels is added. The 
higher the setting for the background noise filter, the more surrounding pixels are 
used. 

Below: Activity is based on the change in the pixels’ gray scale value with time. Left: 
The black squares represent pixels that have changed between two consecutive 
samples. First, all pixels that are not completely surrounded by one layer of changed 
pixels are removed (gray squares). Then, one layer of changed pixels is added 
around the remaining pixels. The resulting blob of changed pixels looks smoothed 
(right).
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Compression artifacts filter
Use the compression artifacts filter to compensate for video artifacts that are 
regularly recurring. With the compression artifacts filter, only the changes that are 
occurring in a number of consecutive frames are taken into account. 

▪ If you track live, we recommend to leave this setting on the default value 
Off.

▪ If you track from video, or if you select Redo tracking from an existing video 
file, select On. 

▪ However, if you are interested in very brief or fast occurring changes, leave 
the setting for the Compression artifacts filter on Off. 

Create settings in such a way that all activity of your animal is detected and some 
noise is left. Also try whether lowering the sample rate and using Video Pixel 
Smoothing improves Activity detection. Then, click the Show/Hide button once 
more and select Detection Features. De-select Activity and select Body fill. Then 
create detection settings for your subject. Or, if you need different sample rates for 
activity analysis and tracking, create separate detection settings for tracking. 

It is also possibly to only carry out activity analysis and not create detection settings 
for tracking. However, if you do so, it may happen that EthoVision XT has so much 
difficulties to detect the animal, that this decreases the performance of acquisition. 
This may result in many missed samples. Therefore, while creating activity settings, 
check that the proportion missed samples does not become too high. See Missed 
samples on page 363
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Optimize the reference image
Learn about

▪ The reference image
▪ How the reference image is updated in Dynamic subtraction
▪ How the reference image is updated in Differencing
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The reference image
Aim
To provide EthoVision XT an image of the background (that is, the arena without the 
subject) in such a way it can discriminate between the subject to track and 
everything else.

Background information
A reference image should not contain the image of the subject. The options below 
help you create a reference image even when it is not possible to have the subject 
removed from the video image.

A reference image is used in detection methods Static Subtraction, Dynamic 
subtraction and Differencing.

Grabbing a reference image is optional. However, if you do not do so, EthoVision XT 
takes the first video frame available from the camera or video file and considers 
that as the reference image.

Procedure
1. Click Background in the Method section.

2. In the Reference image window, choose Grab Current (A). Scroll through 
the video until you find an image without animals. If you track live, make 
sure that there are no animals in the arena, then click Grab Current (A). 
This image will be the initial reference image. Skip B and C and click Close. 
If your video does not contain images without animals, continue with 
option B. Also continue with option B if you track live and you cannot start 
with an empty arena. 
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3. Grab from other (B). You may have a video with an identical background 
as the one you use for tracking, but without animals. Or you may have an 
image of a background without animals. If this is the case, click Grab from 
Other and select this video file or image file. If you select a video file, the 
first frame of this file will be used as an initial reference image. If you select 
an image file, this has to have the same resolution as the video file you use 
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for tracking. Browse to this file and click Open. Skip option C and click 
Close. If you do not have such video or image, proceed with option C.

4. Start learning (C). With this option EthoVision XT makes an average image 
of the entire video. If the animals are moving, this process will average out 
the pixels of the animals, resulting in a reference image without animals.
In the figure below you see an effect of using this option. In A, the rat is in 
the view at all times. In B, after applying Start learning, the animal is 
removed from the background.

If you track live, you have to click Start Learning, and subsequently click 
Stop Learning as soon as you have obtained an initial reference image 
without animals. Click Close if you have a good reference image without 
animals. If you use Dynamic subtraction or Differencing and the reference 
image is still not good, continue with step 5.

5. Acquisition settings: If you run a number of consecutive trials, you may 
want to choose which image to use as initial reference image. Pay particular 
attention here, since the video image may not be exactly the same between 
the end of a trial and the start of the next one.
▪ Use saved reference image. Choose this option if the background 

remains constant between the different trials. For example, when there 
are no moving objects, bedding material, shadows etc.

▪ Use dynamic reference image. Choose this option if the background 
changes between the different trials, and you assume that the video 
image at the end of a trial is the same as that of the start of the next 
trial. For example, when a trial starts a few seconds or minutes after the 
end of the previous trial.

▪ Use first frame of each trial. Choose this option whenever the video 
image at the end of a trial is likely to differ from that at the start of the 
next trial. This may be the case for example when you do batch 
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acquisition from a number of video files, where shadows or reflections 
appear in the arena in the new video. EthoVision XT takes the first 
video frame available from the camera (or video file) and considers it as 
the background. Note that if you choose this option and the subject is 
already in the arena the moment that you start a new trial, EthoVision 
XT misses the subject in the first frames and finds it only when it moves 
away from the starting location. To avoid this, release the subject after 
you have started the trial.

6. Click Close. 

Notes
▪ By default, the reference images are stored in the folder Bitmap Files of 

your experiment. If the background has not changed, you can use these 
images as reference images in other experiments.

▪ If you are tracking from video files, you must play the video forward whilst 
making dynamic subtraction settings. This is because the program needs to 
update the reference image. Do not skip through the file, since the 
reference image will then not be correctly made. 

▪ The option Acquisition settings is available only in Dynamic subtraction 
and Differencing, since in these methods the background is continually 
updated during the trial.

See also

▪ How the reference image is updated in Dynamic subtraction
▪ How the reference image is updated in Differencing
452



How the reference image is updated in 
Dynamic subtraction
A video stream is composed of a number of video images (frames). During data 
acquisition, EthoVision XT analyzes one every x images according to the sample 
rate specified (see Video file and image quality). When analyzing the sample 
(image) n, the reference image is obtained by summing up the gray scale values of 
each pixel from two images:

▪ The reference image made of pixels which have an average value of 
previous images.

▪ The current image, where a square area around the subject detected in the 
previous sample has been removed. This provides a rough estimate of the 
current background.

The gray scale values are summed up according to the formula:

Referencei,n = (1-) * Referencei,n-1 +  * Currenti,n 

for each pixel I, where:

▪ Referencei,n = Gray scale value of pixel I in the reference image of sample n. 

▪ Referencei,n-1 = Gray scale value of pixel I in the reference image of sample 
n–1. 

▪ Currenti,n = Gray scale value of pixel I in sample n where a square area 
around the subject previously detected has been removed.

▪  = Current Frame weight.
The Current Frame weight determines the relative weight of the two components of 
the new reference image.

Because the above formula is recursive, that is, each value of Referencei,n is also a 
function of the previous sample, the value of  determines the number of past 
images that contribute to the reference image for the sample n. The lower , the 
more past images contribute at least partially to the current reference image.

The extent to which each past image contributes to the current reference image is a 
power function of 1-. The older an image relative to the current one, the smaller its 
contribution to the reference image.

EXAMPLE   If α=20%, then 1-α =80%. The first video image contributes by 80% to 
the second sample, by 80%2 =64% to the third sample, then by 80%3 =51% to the 
fourth sample, etc. At the 21th sample, the contribution by the first image gets 
below 1%.
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Below: In the Dynamic subtraction detection method, the reference image is 
updated at each sample. The starting reference image is the one you specify by 
clicking one of the buttons in the Reference Image window, otherwise it is the first 
frame analyzed (not shown in the picture). For the general sample n, the reference 
image is obtained by summing the reference image of the previous sample n–1 and 
the current image n where the area around the subject estimated from the previous 
sample has been removed. The current image with subject removed is given the 
weight  that you specify (see the procedure), while the previous reference image is 
given the weight (1-). Because of the way it is determined, each reference contains 
information on a number of past images, depending on the value of .
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How the reference image is updated in 
Differencing
The Differencing method uses a Gaussian distribution of all pixels in a frame. 
EthoVision XT keeps a running average of the mean  and the variance 2 of the 
gray value of each pixel to detect unlikely pixels. These pixels are considered to be 
the subject.

The mean of the gray values is summed up according to the same formula as for 
Dynamic subtraction. 

The variance of the gray values is summed up according to the following formula:

Variancei,n = (1-) * Variancei,n-1 +  * (Currenti,n. Referencei,n)2

for each pixel i, where:

▪ Variancei,n = Variance of gray scale value of pixel i in the reference image of 
sample n.

▪ Currenti,n = Mean gray scale value of pixel i in sample n where a square area 
around the subject previously detected has been removed.

▪ Referencei,n-1 = Mean gray scale value of pixel i in the reference image of 
sample n–1. 

▪  = Frame weight, which depends on the Background changes option. 
The higher the value set (from Very slow to Very fast), the higher .

The Frame weight determines the relative weight of the two components of the new 
reference image (see the example in How the reference image is updated in 
Dynamic subtraction).
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Customize the Detection Settings 
screen
To achieve optimal subject detection, you need proper feedback about the effect of 
your settings on the quality of detection. EthoVision offers you a number of 
statistics for this purpose.

What do you want to do?
▪ View the detection features on the video window
▪ View the detection statistics
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View the detection features on the video 
window
IMPORTANT Displaying detection features can use a lot of processor power and 
reduce the maximum possible sample rate if you are tracking live.

Procedure
1. In the Detection Settings screen, click the Show/Hide button on the tool-

bar and select Track Features.
2. Select View for the feature you want to view. Choose the color and, for the 

body points, whether to show the trails.

3. If you have selected to view the body points' trail, choose the number of 
Samples you want to be shown at a time.

4. Adjust the Line thickness and the Dot size.
5. Click Close and check the result in the Video window.

Detection features

Nose-point

To check that the nose tip is detected correctly.
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Center-point

To check that the center-point of the subject is detected correctly. 

The center-point is the point whose X,Y coordinates are the arithmetic 
mean of the X,Y coordinates of all pixels detected as subject. For more 
information on how the nose- and tail-base points are calculated, see 
Overview of nose-tail base detection. 

Tail-base

To check that the base of the tail is detected correctly.

Head direction

To estimate at what the subject is sniffing. Select this option especially with 
Novel object and orientation tests.

Body contour

To check that the subject's contour (or the part which should be found) is 
detected.

Body fill

To check that the subject's body (or part of it) is detected. For example, in a 
test where it is important to measure the change in the animal's shape to 
estimate its mobility. 

If you do not select a color for Body fill, the body contour will be shown as 
noise. 

Noise

To view the pixels that match the criteria for subject detection (depending 
on the detection method), but other than those detected as subject.

We recommend to keep Noise selected. This way you can see which parts of 
the video image have gray scale values similar to those of the subject(s) to 
be detected. 

Activity

To view the pixels that match the criteria for activity detection (see Activity 
settings). This setting is only available if you selected Activity analysis in 
the Experiment Settings.
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Some of the options above are not available if your experiment is set to 
Only center-point detection in the Experiment Settings.

Line thickness

This refers to the thickness of the trails, the body contour and the head direction 
line.

Dot size

This refers to the size of the body points visualized.
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View the detection statistics
The detection statistics are displayed in the Detection performance pane, which is, 
by default, displayed at the bottom of the screen.

If the Detection Performance pane is not displayed, click the Show/Hide button on 
the toolbar and select Detection Performance.

The Detection Performance pane shows immediate feedback when you change 
detection settings.

Missed samples
The percentage and number of samples that were skipped due to lack of processor 
time. This value tells you whether your PC can handle the sample rate specified (see 
Sample rate). See also Missed samples for tips on how to increase the maximum 
sample rate handled by the PC.

The value is reset to zero when you load another video file or click Save changes in 
the Detection Settings pane.

Interpolated samples
The percentage and number of missing samples due to missing video frames that 
were interpolated. This statistic is only available when in the Detection Settings 
under Smoothing the option Dropped frames correction is On. See Dropped 
frames correction

▪ What is the maximum acceptable percentage of interpolated samples? Only 
accept a high value of interpolated samples when you are sure that the 
tracks represent the movement of the subject reliably. If the percentage is 
as high as 30% and the subject moves fast or makes sharp turns, the 
resulting track includes lots of artifacts and the statistics are unreliable. In 
Integrated Visualization check whether the tracks with high percentages of 
interpolated samples match the actual movement of the subject.

▪ The value is reset to zero when you load another video file or click Save 
changes in the Detection Settings pane.
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NOTE  This correction is not applied when the subject is not found for other reasons 
other than the dropped frames, for example when the subject is out of view.

Subject not found
The percentage and number of samples in which the subject was not found. This 
information is useful to check the quality of detection in general. When a subject is 
not found, it means that EthoVision XT processed the image, but did not find 
anything matching the current Detection Settings. Use Subject not found to assess 
the quality of tracking.

When you select another video file, or click Save changes, the value for Subject 
not found is reset to zero.

Warning colors thresholds
The percentages of missed samples, interpolated samples and samples where the 
subject is not found are usually displayed in green for each arena and subject. 
When the values are above the set threshold, they are highlighted in red. This helps 
you monitoring the quality of tracking, and spotting detection issues.

Click the button under Missed samples, Interpolated samples or Subject not 
found to change the thresholds.
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See also

▪ Detection statistics after acquiring data
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Trial List

Main topics and tasks
▪ Introduction to the Trial List  464
▪ Independent variables  469
▪ Prepare the list of trials  482
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Introduction to the Trial List
Learn about

▪ Important terms in the Trial List
▪ Useful things to know about the Trial List
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Important terms in the Trial List
Independent variable
An independent variable is a variable that you define to record specific experiment 
conditions, the identity of your subjects, or the amount of drug injected.

An independent variable potentially determines the value of a dependent variable, 
such as speed of movement or distance moved. EthoVision XT assumes that the 
value of the variable stays constant throughout a trial.

Independent variables are especially useful to create analysis groups.

EXAMPLE  The independent variable Treatment with possible values Control, Sham, 
and Treated. Each subject is assigned one of the values. In the Data profile you can 
group tracks based on the value of Treatment.

System variable
A system variables is a variable that EthoVision records during acquisition. For 
example, the duration of a trial, or the name of the video file used in that trial.

Trial
A trial is a single data acquisition session, no matter how many subjects are tracked 
simultaneously. For each trial, you can enter the value of independent variables.

In the Trial List you can plan your trials. You can add and delete planned trials. You 
can also delete acquired trials.

See also 

▪ Analyze groups of tracks
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Useful things to know about the Trial List
To open the Trial List
Choose Setup > Trial List, or in the Experiment Explorer click Trial List.

To show and hide variables in the Trial List
1. Do one of the following:

Click the Show/Hide button on the toolbar and select Variables.

Right-click a column header and choose Show Variable.

2. In the Show Variables window, select the variables of your choice and click 
Apply. 

TIP  Under System, also choose Subject not found and Missed samples. The two 
variables give useful information about the reliability of your data. 
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The statistics are shown in two columns:

See also

▪ System variables
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To sort columns in the Trial List
You can change the order of the columns. Click the column header to select the 
column of your choice and then drag it to the new position. While you drag it, a red 
line shows the insertion point of the column.

To show and hide row headers in the Trial List
Do one of the following:

▪ Click the Show/Hide button on the toolbar.

Select Row Headers and then the headers you want to display.

▪ Right-click on any of the headers (Trial, Arena, Subject, No.) and select 
which headers you want to display.

Import External Data button
If you have the External Data Module, the Import External Data button is available 
on the toolbar of the Trial List. 

Click this button to import external data like EEG, or Heart Rate into EthoVision XT 
and synchronize it with the tracks. 
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Independent variables
What do you want to do?

▪ Define an independent variable
▪ Delete an independent variable
▪ Specify Variable values, formats and other properties
▪ Select System variables
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Define an independent variable
Aim
To label trials, arenas and subjects using an independent variable, for example the 
level of the treatment, the ID of the subjects and the day of testing.

Procedure
1. Open the Trial List.
2. Click the Add Variable button.

A new column with label User-defined is inserted at the end of the table.

3. Specify the label (name), description, type, format, predefined values and 
scope of the variable. See below an example of a Trial List with two 
independent variables, Rat ID and Treatment.
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Delete an independent variable
Aim
To remove an independent variable that you no longer need in your experiment. 

This action removes the column from the Trial List and also removes the values of 
the variable assigned to each trial, arena and subject.

Procedure
Right-click the column header and choose Delete Variable.

Notes
▪ You can only delete variables that you defined yourself. 
▪ To hide system variables, see System variables.
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Variable values, formats and other 
properties
Variable label
In the Label field enter the name of the variable. The name must be unique.

Names cannot be longer than 64 characters. The characters you use, must be 
Unicode characters in the Basic Multilingual Plane range. Please see http://
en.wikipedia.org/wiki/Plane_(Unicode)#Basic_Multilingual_Plane.

Variable description
In the Description field you can enter a short text or any other background 
information about the variable.

The description is limited to 255 characters. The characters you use, must be 
Unicode characters in the Basic Multilingual Plane range. Variable type

Click the Type field and from the drop-down list choose one of the following 
options:

▪ Text. A text variable is denoted by alphanumeric characters, composed of 
letters, numbers or both. For example, the name of the treatment.

▪ Numerical. A variable represented by numbers only, for example, the dose 
of the drug that you apply.

▪ Time stamp. A variable represented by a time stamp, for example, the start 
date and time of the trial.

▪ Duration. A variable represented by a duration, for example the duration of 
the treatment.

▪ Boolean. A variable that is either 'False' or 'True'. For example, the presence 
of a novel object in the arena.

Variable format
▪ For Text variables you do not need to specify a format.
▪ For Numerical variables, double-click in the Format field. In the Format 

window:
Select No. of decimals and enter the number of decimals (1 to 9). If you 
work with integer values, leave the check box unselected.
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Select Scientific notation if you want to write, for example, 1485 as 
1.485e+0.03

In the Unit field, enter the unit of your variable, for instance, μg/g for the 
dose of the drug. Then click OK. Tip: To enter Greek symbols, use the 
Windows Characters map. 

▪ For Time stamp variables, click in the Format field. In the Format string 
window, and enter your preferred format in the field at the top.

▪ For Duration variables, click in the Format field. In the Format string 
window, enter your preferred format in the field at the top.
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▪ For Boolean variables you do not need to specify a format.

Predefined Values
▪ For Text variables, double-click in the Predefined Values field. In the 

Predefined Values window:
Under Predefined Value enter one of the possible values of the 
independent variable, then click Add. Repeat this step for all values.

EXAMPLE  Your independent variable is the treatment you apply, with 
possible values drug and saline, enter drug, then click Add. Repeat this step 
for saline.

Keep the Allow other values check box selected if you are not sure 
whether the values that you defined are exhaustive. This allows you to add 
new values if needed. Clear this option if the values under Predefined 
values are exhaustive.

The characters you use, must be Unicode characters in the Basic 
Multilingual Plane range.
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To delete a predefined value, select it in the Predefined Values field and 
click Remove.

See also:

http://en.wikipedia.org/wiki/Plane_(Unicode)#Basic_Multilingual_Plane.

▪ For Numerical variables, double-click in the Predefined Values field. In the 
Predefine Numerical Values window, select one of the following options:
▪ Allow any value. Select this option if you do not want to predefine a 

range of values or individual values.
▪ Define a range. Define a minimum and maximum value. For instance, 

when the age of the rats in your experiment ranges from 6-18 months, 
enter '6' as the minimum value and '18' as the maximum.

▪ Define individual values. Select this option when you are, for instance, 
testing a drug in three dosages: 0.05; 0.1 and 0.5 mg/g. Enter '0.05' in 
the Predefined Value field and click Add. The value moves to the 
Predefined Values field. Repeat this procedure for the other two values. 
Keep the Allow other values check box selected if you are not sure 
whether the values that you defined are exhaustive. This allows you to 
add new values if needed. Clear the check box if you are sure that you 
do not want to add new independent variable values. To delete a 
predefined value, select it in the Predefined Values field and click 
Remove.
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▪ For Time stamp and Duration variables you cannot specify any predefined 
values.

▪ For Boolean variables, double-click in the Predefined Values field. In the 
Predefine Boolean window, enter values for True and False. For instance, if 
your independent variable is Presence of novel object, define the values Yes 
(True) and No (False).

Variable scope
For the scope of an independent variable you can choose between the following 
three options: Trial, Arena and Subject.

EXAMPLE  The scope of the variable Bedding type is Trial if all the arenas in a trial 
have the same kind of bedding material. Select Arena if the bedding material differs 
for different arenas during the same trial. 

For variables whose values may differ between subjects in the same arena and trial, 
select Subject. For instance, in two-subject interaction tests, the variable sex (with 
subject 1 being male, and subject 2 female) or Status (subject 1 being resident, and 
subject 2 intruder).
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System variables
To view/hide a system variable

1. From the Show/Hide menu on the toolbar, choose Variables. 

2. Select the variables you want to view. 
To hide a system variable, clear its check box. 

System variables

Acquisition status

The current status per arena:

▪ Planned. When a trial is added to the Trial List, all the arenas within the trial 
get the status Planned.

▪ To Skip. You can give an arena the status To skip when for any reason you 
do not want or cannot track a subject in that arena. For example, when the 
subject that was planned in that arena is no longer available.

▪ Skipped. The status Skipped is given to an arena that was previously set to 
To skip. The status Skipped is therefore a label given after the trial has 
been acquired (or at least video was recorded for that trial). See also Skip 
arenas within a trial.

▪ Postponed. This label appears when you choose to record video and track 
later (see Record video, then acquire a trial). After recording video, the 
arenas within a trial get the status Postponed. After you do tracking from 
that video, the status changes to Acquired.

▪ Postponed To Skip. If you have recorded video without tracking the status 
of the trials/arenas in the Trial List is Postponed (see above). Now you can 
choose to skip one of the trials/arenas by selecting Postponed to Skip. Do 
this for example if one of the arenas in the video is empty.
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▪ Waiting. An arena gets the status Waiting when you have started the trial 
but acquisition did not yet start because you defined a Trial Control profile 
with a Start recording rule and the starting condition is not yet met.

▪ Acquiring. An arena gets the status Acquiring when acquisition is 
ongoing. 

▪ Acquired. An arena gets the status Acquired when data has been acquired 
for that arena.

Arena name

The name of the Arena in which the animal was tracked.

Arena Settings

The name of the Arena Settings used to acquire your tracks.

Detection settings

The name of the Detection Settings used to acquire your tracks.

Interpolated samples

The proportion of samples that were interpolated during the trial, expressed in 
percentage. Interpolation occurs when the camera fails to send the video frames at 
the expected time. For details, see in Detection settings: Advanced setup > 
Dropped frames correction.
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Missed Samples

The proportion of missed samples, expressed in percentage. EthoVision misses 
samples if the processor load is too high or the camera delivers fewer video frames 
than expected. See also Missed samples

Recording after

The length of the interval between the start of the trial and the start of acquisition. 
This variable has the value 0 unless you defined a condition between the Start trial 
box and the Start track box in the Start-stop trial rule in the Trial Control settings.

Recording duration

The length of the interval from start of acquisition till stop of acquisition. Recording 
duration is equal to Trial duration unless you defined a condition between the Start 
trial box and the Start track box in the Start-stop trial rule in the Trial Control 
settings.

Start time

The date/time of the start of the trial.

Subject name

The name of the subject that track refers to. Subject names are specified in the 
Experiment Settings.

Subject not found

Proportion of time the subject was not found. If the subject is not found, it means 
EthoVision processed the sample but did not find anything matching the current 
Detection Settings. Therefore, this system variable is a measure of the quality of 
detection.
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Sync status

The status of the sync-out file. When no external data co-acquisition has been 
carried out for a specific trial, the status is Planned. As soon as co-acquisition is 
started on the DAQ system, the status becomes Acquired.

Track

The name of the track file.

Tracking source

The video input on the encoder board connected to the camera. If you use a digital 
camera, this is the name of the camera. The cell is empty when you track from a 
video file.

Trial Control settings

The name of the Trial Control profile used during tracking.

Trial Duration

The length of the interval from start of the trial until the stop of the trial.

Trial name

By default, Trial 1, Trial 2, etc. To change a trial name, double-click it and enter a new 
name.

Video file

The name and location of the video file that was used or will be used for acquisition. 
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Video start time

The date and time the video file that you used for tracking, was created.

System variable format
For the Time stamp variables (Start time and Video start time) and Duration 
variables (Recording after, Recording duration and Trial Duration) you can specify 
the format. 

Double-click in the Format field. In the Format string window, enter your preferred 
format in the field at the top and click OK.

For the other system variables Label, Description, Type, Predefined Values and 
Scope you cannot change their format.

See also

▪ The default Start-Stop Trial rule
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Prepare the list of trials
What do you want to do?

▪ Plan your trials
▪ Edit the Trial List
▪ Skip trials
▪ Clear trials in the Trial List
▪ Prepare the trial list for batch acquisition
▪ Import data from other experiments

NOTE  This option is for when you want to merge data from multiple 
identical experiments.
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Plan your trials
Aim

▪ To prepare the list of experimental trials in detail and in advance, so that 
fewer actions have to be taken during their execution. 

▪ Planning trials in the Trial List also allows you to run a batch acquisition. 
Select video files for all the trials in your trial list. For each trial you can 
optionally select separate Arena Settings, Trial Control Settings, and 
Detection settings. Then you can automatically acquire all trials. 

NOTE  If you do not predefine a trial list, it is built up automatically as you acquire 
new trials.

EXAMPLE  Define the independent variables ID and Dose and fill in the list of trials 
with the ID of the subjects to be tested, and the drug amount planned for each trial. 
When you start data acquisition, EthoVision XT informs you that for Trial 1 you need 
to prepare subject A21034 which has to be injected with 1.0 mg/kg apomorphine.

To define the list of trials
1. Choose Setup > Trial List, or in the Experiment Explorer click Trial List.
2. To add trials, do one of the following:

If you track live or from videos, click the Add Trials button on the toolbar, 
then enter the number of new trials you want to add.

If you track from videos, you can add trials automatically based on the video 
files you select. Each video will be associated with one trial. Click the Add 
Videos button on the toolbar, and select your videos. See also 
Automatically add video files to the Trial List.

3. A number of rows appear in the lower half of the Trial List. Each row 
represents a trial, that is, an acquisition session to be carried out in one or 
more arenas. If your setup is made of multiple arenas, each trial is divided in 
multiple rows, each one representing a track, that is, data of one individual 
subject tracked in a single trial.

4. For each trial, enter the value of the independent variables in the 
corresponding cells, when required.
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5. For each trial, select the Arena Settings, the Trial Control Settings and the 
Detection Settings you want to use.

Notes
▪ TIP  If you do not see the columns Arena Settings, Trial Control Settings and 

Detection Settings, click the Show/Hide button on the toolbar, select 
Variables and under System select the items you want to view. 

▪ You can also edit the Trial List before, during or after acquisition. See Edit 
the Trial List

▪ If trials are already present in the table, the trials you add are appended.
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Edit the Trial List
Enter values in the Trial List
Click a cell in the Trial List and enter the value you require, or select it from the list of 
values available.

Filling the Trial List table is not mandatory. You can also enter those values in the 
data acquisition screen.

Delete values from the trial list
Select the appropriate cell and click Delete. Or, right-click the appropriate cell and 
select Delete.

To delete trials, see Delete trials or Clear trials in the Trial List

Copy and paste values
You can copy and paste (part of) the Trial List:

▪ To/from Excel. You can copy a list of trials from Excel, for example, when you 
have made your list of independent variables and its values. You can copy/
paste multiple columns but make sure the columns are in the exact same 
order as in the Trial List.

▪ Within the same Trial list. You can copy and paste part of Trial List to newly 
added cells, for example, when you have added new trials.

Do the following:

1. Select one or more cells in the Trial List or in the Excel worksheet.
2. Right-click one of the selected cells and select Copy or press Ctrl+C.
3. Click a cell in the Trial List or in the Excel worksheet and either right-click 

and select Paste or press Ctrl+V. 
You can also select multiple adjacent cells to copy to. Click the first cell of the range, 
hold down Shift and click the last cell, then paste. 

You can also select nonadjacent cells using the Shift and Ctrl key. It is only possible 
to paste in such a selection if there is just a single value on the clipboard.
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Drag and drop cell values from Excel
You can also drag and drop cells from an Excel worksheet. Drag the cells to the first 
cell in the Trial List where you want the values to be copied, then release the mouse 
button.

Notes
▪ A value can only be pasted if the format of the value corresponds to the 

format required by the cell. For instance, it is not possible to paste a cell 
with a non-numerical independent variable to a cell with a numerical 
variable. If you do that, you will get a warning. The existing cell value 
remains unchanged.

▪ Check that the copied values of numerical independent variables are either 
within the predefined range or correspond to individual predefined values 
of numerical independent variables in the Trial list.

▪ You can change the order of variables by selecting a column and dragging 
it to the new position. 
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Skip trials
Aim
To skip one or more of the planned trials because of unforeseen circumstances. For 
instance, when a subject is no longer available.

You can skip:

▪ An entire trial. See the procedure below.
EXAMPLE  You track mice in an open field. For trial 5, the subject is no longer 
available. That means that after acquiring trial 4 you want to proceed with 
trial 6.

▪ One or more arenas within a trial. See Skip arenas within a trial

Procedure
1. Open the Trial List, and click Show/Hide > Variable > select Acquisition 

status.
2. In the Acquisition status column select To Skip for the corresponding trial.

3. Proceed with acquiring your trials. If for any reason you want to acquire the 
trial set to To Skip, set it back to Planned in the Trial List and open the 
Acquisition screen.

Notes
▪ You can also skip a trial in the Acquisition screen. When the text on the 

video window shows the name of the trial that you want to skip, click the 
Skip trial button. EthoVision is ready to acquire the next planned trial.
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▪ If your trials include multiple arenas, and you want to skip an entire trial, 
select To Skip for all the arenas in that trial. Otherwise you can skip specific 
arenas within a trial. See Skip arenas within a trial

▪ If you have recorded video and you want to skip trials/arenas before 
acquiring data, in the Trial List change the status from Postponed to 
Postponed To Skip.
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Skip arenas within a trial
Aim
To skip one or more of the arenas within a trial because those arenas are empty or 
the subjects there should not be tracked.

EXAMPLE  You track fish larvae in a well plate with 24 wells. Therefore, each trial 
contains 24 arenas. When some wells are empty, it does not make sense to do 
tracking in empty arenas. Therefore, skip those arenas before acquiring the trial.

Background information
▪ Before you acquire a trial which includes two or more arenas, all arenas are 

set to Planned. After acquiring the trial, they are all set to Acquired.

▪ The To Skip option in the Trial List allows you to skip some arenas in a 
specific trial, so you can proceed with tracking in the remaining arenas. For 
example, in Trial 2, Arena 2 is empty, so you want to skip Arena 2. After you 
acquire Trial 2, Arena 1 is set to Acquired and Arena 2 is set automatically 
to Skipped.
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Procedure
1. Open the Trial List, and click Show/Hide > Variable > select Acquisition 

status.
2. In the Acquisition status column select To Skip for the corresponding 

arena.
3. Proceed with acquiring your trials.

Notes
▪ When you skip arenas within a trial, only the subjects in the non-skipped 

arenas are tracked.
▪ You can clear a trial with one or more skipped arenas. After clearing a trial, 

all arenas are set to Planned (or Postponed if you chose to record video 
and track later). 
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Delete trials
Aim
To remove the trial from the Trial List and the experiment. This includes:

▪ The track data
▪ The manually-scored data
▪ The Trial Control events
▪ The Hardware log
▪ The video file (when requested)

Delete Trials also removes the corresponding row from the trial list.

Procedure
1. Do one of the following:

▪ Click the trial name in the list, press Delete.
▪ Right-click the trial name in the list, select Delete Trials.

2. If the trial is associated to a video file recorded with EthoVision XT, you are 
asked whether you want to rename it for backup purposes, or delete it. 
Choose the option that applies and click Yes.

Notes
▪ A video file is renamed with a number 0001 appended to its original name. 

The renamed video file is kept in the Media Files folder of the experiment.
▪ With Clear Trials you can remove the tracks, keep the row empty and when 

necessary acquire that trial again. See Clear trials in the Trial List and Redo a 
trial

See also

▪ Clear trials in the Trial List
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Clear trials in the Trial List
Aim
To delete the tracks, the associated data and the recorded videos of one or more 
trials, but leave those trials as empty rows in the Trial List, so you can redo those 
trials at later time.

IMPORTANT  When you clear a trial, the data scored manually (Manual Scoring log), 
the events of Trial Control and the hardware events associated with the trial are 
deleted.

NOTE  Clear Trials is not the same as Delete trials. When you delete a trial, the tracks 
are deleted and the corresponding row is removed from the Trial List.

Procedure
1. Right-click the name of the trial that you want to clear and select Clear 

Trials. 

2. Choose one of the options that appear. These depend on whether you 
tracked from external video files or live (+save video).
When tracking from external video files:

▪ Clear tracks. The tracks are deleted. In the Trial list, the link to the video 
file used for tracking located in the System - Video file column is 
removed. Choose this option if you want to re-do the trial using a video 
file different from the current one.
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▪ Clear tracks but re-use the video reference. As above, however the 
link to the video file is retained. You can open Acquisition to track from 
that video file.

When tracking live (and optionally saving video):

▪ Clear tracks. The tracks are deleted. This option is available if you 
acquired tracks without saving video.

▪ Clear tracks but re-use the video. To delete the tracks, not the video 
file used to acquire those tracks. You can then track again from the 
video file.

▪ Clear tracks and video. To delete the tracks and the associated video 
and redo the trial anew.

▪ Clear video. To clear a trial that has video only (its current status is 
Postponed). You can then record a new video and acquire tracks.

Notes
▪ When you clear a trial, the Arena Settings, Trial Control Settings and 

Detection Settings that were selected in the Trial List are retained.

See also

▪ Redo a trial
▪ Skip trials
▪ Skip arenas within a trial
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Prepare the trial list for batch acquisition
Aim
To make a list of the trials to be acquired in batch, either live or from video files.

Prerequisites
▪ Click the Show/Hide button on the toolbar and select Variables. When you 

track from pre-recorded video files, make sure that Video file is selected. 
▪ Optionally select to display Arena settings, Trial Control settings and 

Detection settings.

Prepare the Trial List for batch acquisition
1. Add the trials you need.

2. OPTIONAL  If you defined multiple Arena Settings, Trial Control settings or 
Detection settings: for each trial select which settings you want to use. 
Either select settings for all the trials or for none at all.
TIP  If you want to use the same Arena Settings, Trial Control settings or 
Detection Settings for all the trials, select them in the Acquisition Settings 
window.

3. Add video files to the planned trials, either automatically or manually. See 
the options below.
You can either select different video files for different trials or the same 
video for multiple trials. Choose the latter way of working if you made a 
long video with multiple trial recordings. If you choose the same video, 
EthoVision will start tracking at that point in the video where the previous 
trial stopped. To make sure that tracking starts and stops at the correct time 
point, you must define appropriate Trial Control settings.

Automatically add video files to the Trial List
1. Click the Add Videos button on the toolbar. 
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2. In the Add Videos window, select the video files you want to use and click 
Open.

3. Select one of the options under Sort order and click OK:
Date-time order. Selecting this option links the video file with the earliest 
date/timestamp to Trial 1, the next video file to Trial 2, etc.

Alphabetical order. Selecting this option links the video files to the trials in 
alphabetical order. 

Manually add video files to the trial list
Click one of the cells in the Video file column. In the Select Video window, select 
the video file and click Open. Do this for the other planned trials.

Notes
▪ If you select more video files than the number of planned trials in the Trial 

List, EthoVision will add additional trials to the Trial List.
▪ If you manually linked videos to some of the planned trials, and for the 

remaining trials you use the automatic option, EthoVision only fills the 
gaps, that is, it adds videos to those trials which do not have video 
references yet.

To carry out batch acquisition
Choose Acquisition > Open Acquisition. In the Acquisition Settings window, select 
Track all planned trials. 

See also

▪ Acquire a series of trials (Batch acquisition)
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Acquire Data

Main topics and tasks
▪ Introduction to Data Acquisition  497
▪ Acquire one trial  502
▪ Acquire a series of trials (Batch acquisition)  513
▪ Additional information on data acquisition  524
▪ Score behaviors manually  542
▪ Import data from other experiments  566
▪ Import Live Mouse Tracker data  570
▪ View real-time information  573
▪ The data acquisition screen  581

NOTE  If you plan to use hardware devices like a pellet dispenser or the PhenoTyper, 
see also the EthoVision XT 18 - Trial and Hardware Control - Reference Manual, 
which you can find on the Apps screen, under Noldus > EthoVision XT 18 Other 
Documentation.
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Introduction to Data Acquisition
Learn about

▪ Important terms in acquisition
▪ Important things to know about data acquisition
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Important terms in acquisition
Trial vs. track
A trial is a single acquisition session. A track is the data collected during a trial. A 
trial can contain one or more tracks. See Trial vs. track on page 286.

Batch acquisition
Acquisition of a series of trials, either live, or from pre-recorded video files. 

Inter-trial interval
When you choose a live series of trials, an inter-trial interval between two 
consecutive trials allows you to take the subject from the maze or cage, clean the 
maze/cage and release the next subject before the next trial starts automatically.

Planned trial
When you add trials in your Trial List, their default acquisition status is Planned. 
EthoVision XT acquires the planned trials in the order specified in the Trial List: Trial 
1, Trial 2, etc. 

You can skip a planned trial whenever you cannot acquire data, for example when 
the subject assigned to that trial is no longer available (see below).

Skipping a trial
It may happen that a trial planned in the Trial List cannot be acquired, for example 
when the animal to be tested is not available. You can skip one or more trials and 
acquire a trial further down in the Trial List. 

See Skip trials

When you skip a trial (and all arenas within it), you can always set it back to Planned 
to acquire data at a later time. See Carry out trials in an order different from that 
specified in the trial list. Furthermore, you can also skip single arenas within a trial, 
for example not to acquire data in empty wells in a well plate. See Skip arenas within 
a trial
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Start-Stop Trial rule
This is the rule in the Trial Control Settings that determines when actual tracking 
(data acquisition) starts and stops. For example, start tracking when the animal is 
detected in the arena. See The default Start-Stop Trial rule. 
499



Important things to know about data 
acquisition
Four methods to acquire data
Choose the method that best suits your setup and experimental protocol: 

▪ Acquire data live. The animals are tracked as they move in your 
experimental setup.
The disadvantage of this method is that you do not have a video backup, so 
if you need to repeat data acquisition you have to repeat the test itself.

See Acquire a trial live or Acquire a series of trials - live.

▪ Acquire data live and save video simultaneously. Like above, in addition 
EthoVision XT records video to a digital video file. You can use the video to 
re-do tracking if needed.
See Acquire a trial live + save video or Acquire a series of trials live + save 
video

▪ Record video with EthoVision XT, then acquire data. This is a two-steps 
method. First, record video to a digital video file as the animals move in 
your experimental setup. Afterwards, open the video file and acquire the 
data. This way you are free to track data later. See also Advantages of using 
video files below.
See Record video, then acquire a trial, or Record a series of videos, then 
acquire a series of trials.

▪ Acquire data from video files recorded with other programs. Use an external 
program, like MediaRecorder, to record video to a file while the animals 
move in the experimental setup. Later on, open the video file and acquire 
the data.
See Acquire a trial from a video file recorded with other programs, or 
Acquire a series of trials from video recorded with other programs.

See also Video file formats. 

Advantages of using video files
▪ You have a video backup. A video file is very handy since it allows you to 

acquire data for a trial once again, if needed. For example, if you realize that 
the detection settings were not optimal when you acquired the data. See 
Redo a trial on page 530.
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▪ You make sure that tracking is reliable. When you track from a video file, let 
EthoVision XT take as much time as it needs to analyze each sample, 
independent of the actual frame rate. For example, if the detection method 
used requires a lot of time per sample, acquisition may be slower than real 
time, but you ensure that no sample is missed. See DDS (Detection 
determines speed) on page 586.

Settings used for data acquisition
You can view which settings were used for a particular trial. 

In the Experiment Explorer, click Trial List. Click the Show/Hide button on the 
toolbar and in the Show Variables window, select Arena Settings, Detection 
Settings and Trial Control Settings.

In the Experiment Explorer, settings profiles are marked with a lock icon, meaning 
that they cannot be edited. To edit a settings profile, make a copy.

To view your trials
Choose Setup > Trial List. Click the Show/Hide button on the toolbar. In the Show 
Variables window, select Acquisition status. For an explanation of Acquisition 
status, see System variables on page 477.

Correct tracking errors
Good detection settings do not generally result in tracking errors. Before editing 
tracks, make sure that the lighting conditions and the detection settings are 
optimized.

See Edit the Tracks
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Acquire one trial
Learn about

▪ Before you start acquisition

What do you want to do?
▪ Acquire a trial live
▪ Acquire a trial live + save video
▪ Record video, then acquire a trial
▪ Acquire a trial from a video file recorded with other programs

See also

▪ Acquire a series of trials (Batch acquisition)
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Before you start acquisition
Screen saver and power options
Turn off the screen saver and make sure that the power save options of your 
computer are turned off.

Video cameras and video files
Make sure that the video cameras are connected to your PC's encoder board (for 
analog cameras) or USB/Ethernet ports (for digital cameras). See Camera 
Installation

Use the correct settings
Make sure that the Arena Settings, Trial Control Settings and Detection Settings you 
want to apply are selected in the Acquisition Settings window.

Enter the independent variables for the next trial
In the Analysis Results and Scoring pane, click the Independent Variables tab and 
enter or select the values of the independent variables in the row highlighted in 
green. You can enter independent variables values at any time in the Trial List. See 
Independent Variables tab

When co-acquiring external (physiological) data
If you want to acquire external data during the trial (only live, not from video files), 
make sure that the external data recording device is switched on and connected to 
the EthoVision XT computer. In EthoVision XT, in the Experiment Settings under 
Video Source select Enable DAQ co-acquisition. See also External Data. 

NOTE  You must have the External Data Module in order to use this functionality.

Auto-start data analysis
 If you want to start analysis immediately after finishing the trial (or series of trials, 
in the Acquisition Settings window select Auto-start data analysis.

To speed up analysis
▪ Hide the Analysis Results and Scoring pane. To do this, click the Show/Hide 

button and then deselect Analysis Results and Scoring.
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▪ For tracking offline: Select DDS in the Playback Control window. This way 
EthoVision XT plays the video faster than 1x if subject detection requires 
little processor time.
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Acquire a trial live
Aim
To carry out video tracking in a live situation. Video is not recorded.

Prerequisites
1. in the Experiment Settings, under Video Source select Live tracking.
2. Choose Acquisition > Open Acquisition. In the Acquisition Settings 

window, select Track next planned trial; do not select Save video.
3. Make sure at least one trial is planned. To add a new trial, in the Playback 

control window click the New trial button or press Ctrl+F3.

4. IMPORTANT  Make sure that video resolution, frame rate and duration do 
not exceeds the values reported in Resolution, frame rate, and maximum 
trial duration.

Procedure
1. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start trial 

button in the Playback control window.

2. Release the animal in the arena. As soon as data recording starts, the Video 
window says Acquiring.

3. The trial stops when the condition before the Stop track box is met, or when 
you choose Acquisition > Stop Trial, or press Ctrl+F6, or click the Stop 
trial button.

What next?
▪ If you need to enter values of independent variables, click the Independent 

Variables tab in the Analysis Results and Scoring pane. Edit the values where 
needed.
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▪ Remove the animal from the arena and repeat the procedure with the next 
trial.
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Acquire a trial live + save video
Aim
To carry out video tracking in a live situation. Video is recorded for backup 
purposes. This is also useful when one needs to re-do tracking.

Prerequisites
1. in the Experiment Settings, under Video source select Live tracking. 

Choose Acquisition > Open Acquisition. In the Acquisition Settings 
window, select both Track next planned trial and Save video.

2. Make sure at least one trial is planned. To add a new trial, in the Playback 
control window click the New trial button or press Ctrl+F3.

3. IMPORTANT  Make sure that video resolution, frame rate and duration do 
not exceeds the values reported in Resolution, frame rate, and maximum 
trial duration.

Procedure
1. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start trial 

button in the Playback control window.

EthoVision XT starts recording video, and waits that the condition to start 
tracking is met.

2. Release the animal in the arena.
3. The trial stops when the condition before the Stop track box is met, or when 

you choose Acquisition > Stop Trial, or press Ctrl+F6, or click the Stop 
trial button.

Video recording stops at the same time. 
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What next?
▪ If you need to enter values of independent variables, click the Independent 

Variables tab in the Analysis Results and Scoring pane. Edit the values 
where needed.

▪ Remove the animal from the arena and proceed with the next trial.
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Record video, then acquire a trial
Aim
To record video while the test is carried out. Video tracking is done at a later stage.

IMPORTANT With this method, the Trial Control rule is applied in the second stage 
(acquire trial), not during the first stage (save video). To stop video recording, after a 
fixed time, do so manually (see below) or see the suggestions in Stop video 
recording after some time.

Prerequisites
1. in the Experiment Settings, under Video source select Live tracking.
2. Choose Acquisition > Open Acquisition. In the Acquisition Settings 

window, select Save video only, track later.
3. Make sure at least one trial is planned. To add a new trial, in the Playback 

control window click the New trial button or press Ctrl+F3.

4. IMPORTANT  Make sure that video resolution, frame rate and duration do 
not exceeds the values reported in Resolution, frame rate, and maximum 
trial duration.

Procedure

Record video

1. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start trial 
button in the Playback Control window.

The Video window shows a message Recording video.

2. To stop video recording, choose Acquisition > Stop Trial, or press Ctrl+F6, 
or click the Stop trial button in the Playback Control window.
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Remove the animal from the arena. You can now proceed with the next 
subject or track the data from the video just saved (see below).

Acquire the trial from the recorded video

1. In the Acquisition Settings window, select Track next saved video file. The 
trial name shown next to Trial refers to the first saved video in your Trial List 
that you still have to track from.

2. Position the video at the point you require.

3. Select DDS in the Playback Control window to make sure that samples are 
not missed. See DDS (Detection determines speed) on page 586

4. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start trial 
button in the Playback Control window.

The video is played forward and tracking takes place.

5. Acquisition stops automatically based on the Trial Control Settings, or 
when the video file has reached the end, or when you choose Acquisition 
> Stop Trial, or press Ctrl+F6, or click the Stop trial button.

What next?
▪ If you need to enter values of independent variables, click the Independent 

Variables tab in the Analysis Results and Scoring pane. Edit the values 
where needed.

▪ If you wish to discard the track and re-do tracking from that video, see 
Redo a trial on page 530.
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Acquire a trial from a video file recorded 
with other programs
Aim
To carry out video tracking from a video file recorded with a program other than 
EthoVision XT.

Prerequisites
1. The video file is compatible with EthoVision XT. See Video file formats.
2. In the Experiment Settings, under Video Source, select From video file.
3. In the Arena Settings, Check the video aspect ratio.
4. OPTIONAL  Make a Trial List and add a video to each trial.
5. Choose Acquisition > Open Acquisition. If no trial is planned, to add a 

new trial, in the Playback control window click the New trial button or press 
Ctrl+F3.

To acquire a trial from a video file
1. In the Acquisition Settings window select Track next planned trial.
2. in the Acquisition Settings window, under Settings click the Video button.

Select the video file you require. To have files of all formats listed, select All 
files from the Files of type list.

3. Position the video at the point you require.

4. Select DDS in the Playback Control window to make sure that samples are 
not missed. See DDS (Detection determines speed) for more information.

5. To start the trial, choose Acquisition > Start Trial, or press Ctrl+F5, or click 
the Start trial button in the Playback Control window.
511



The video is played forward and tracking takes place.

6. Acquisition stops automatically when the video file has reached the end, 
or when the condition before the Start track box in the Trial Control rule is 
met, or when you choose Acquisition > Stop Trial, or press Ctrl+F6, or 
click the Stop trial button.

What next?
▪ If you need to enter values of independent variables, click the Independent 

Variables tab in the Analysis Results and Scoring pane. Edit the values where 
needed.

▪ You cannot Redo a trial obtained with this acquisition method.
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Acquire a series of trials (Batch 
acquisition)
What do you want to do?

▪ Acquire a series of trials - live
▪ Acquire a series of trials live + save video
▪ Record a series of videos, then acquire a series of trials
▪ Acquire a series of trials from video recorded with other programs

Learn about
▪ Choosing the optimal reference image in a series of trials

See also

▪ Acquire one trial
▪ Split a multi-day test in multiple trials
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Acquire a series of trials - live
Aim
To carry out video tracking in a live situation, for a number of times (trials), in a 
predefined list. Video is not recorded.

Trials and inter-trial intervals
In the following example, the duration of the trials is assumed to be constant (for 
example, 5-minutes trials in an open field). Click the Start series button to start 
acquisition. The inter-trial interval is not applied before the start of the first trial. You 
specify the inter-trial interval in the Acquisition Settings window. 

If you want to start the next trial before that end of the inter-trial interval, click the 
Skip countdown button.

IMPORTANT The serial acquisition is interrupted automatically when the available 
disk space gets lower than 100 MB. EthoVision XT checks the available disk space 
before starting a new trial. Close the experiment, clean up some disk space, and 
then resume acquisition.

Prerequisites
1. See also Before you start acquisition.
2. In the Experiment Settings, under Video Source select Live tracking.
3. Make sure that the Trial list includes all trials that you plan to acquire. If 

necessary, open the Trial List and add trials. Select a combination of Arena 
Settings, Trial Control Settings and Detection Settings for each planned 
trial.
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4. Choose Acquisition > Open Acquisition. In the Acquisition Settings 
window, select Track all planned trials and specify the Inter-trial interval 
(H:mm:ss).

The name of the first planned trial in the Trial List appears in the field next 
to Trial.

Procedure
1. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start series 

button in the Playback Control window.

2. Release the animal for the first trial in the arena.
3. The trial is stopped automatically according to the rules set in the Trial 

Control Settings. Remove the animal from the arena, clean the experiment 
setup and prepare the next animal.
The video window shows the countdown (inter-trial interval).

4. At the end of the countdown, the next trial starts. Release the animal in the 
arena.

5. To stop the series of trials:
The series stops automatically when the last planned trial has been tracked.
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You can stop the series manually at any time. Choose Acquisition > Stop 
Trial, or press Ctrl+F6, or click the Stop series button in the Playback 
Control window.

If you stop batch acquisition manually, all trials acquired up to that time are saved, 
including the current one that was interrupted. Click the Start series button again 
to complete the series. If necessary, redo the trial that was interrupted. See Redo a 
trial.

Notes
▪ If cleaning the experiment setup takes less time than the Inter-trial interval, 

and you do not want to wait until the end of the countdown, skip the 
remaining time and start the next trial. Click the Skip interval and Start 
trial button (or press Ctrl+F5).

▪ During the inter-trial interval, you can view information on when the next 
trial starts. In the Acquisition Settings window, next to Track all planned 
trials you see [name of next trial] starts in [H:mm:ss]. 
In the Video window you see [name of next trial] (Number of trials 
remaining) Starts in [H:mm:ss] (the last, in red). This text is always shown, 
even when you specify to hide the overlay text.

▪ Automatic analysis does not start if you stop the series manually.
▪ If you save video while tracking, saving the video at the end of each trial 

takes time. The Inter-trial interval countdown only starts after the video has 
been saved. For this reason, the total time between the end of the i-th trial 
and the start of the i+1-th trial may be longer than the inter-trial interval.
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Acquire a series of trials live + save video
Aim
To carry out video tracking in a live situation, for a number of times (trials), in a 
predefined list. Video is recorded.

Prerequisites
1. For general recommendations, see Acquire a series of trials - live.
2. In the Acquisition Settings window, select both Track all planned trials and 

Save video.

To acquire a series of trials live + video
See the procedure Acquire a series of trials - live on page 514.

The difference is that:

▪ Video for the current trial is being recorded to a file on the hard disk. Video 
recording starts at the start of the trial, not at the start of tracking. 

▪ For each trial, video recording is stopped before the start of the inter-trial 
interval. 

▪ Saving the video at the end of each trial takes time. The Inter-trial interval 
countdown only starts after the video has been saved. For this reason, the 
total time between the end of the i-th trial and the start of the i+1-th trial 
may be longer than the inter-trial interval.
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Record a series of videos, then acquire a 
series of trials
Aim
To record a number of video files while the tests are carried out. Video tracking is 
done in a later phase.

IMPORTANT With this method, Trial Control is not applied during video recording. 
This means that for example you cannot stop video recording automatically after 10 
minutes. To stop video recording, do so manually (see below). Trial Control is 
applied in the second phase (acquire trial).

Prerequisites
1. For general recommendations, see Acquire a series of trials - live.
2. Choose Acquisition > Open Acquisition. In the Acquisition Settings 

window, select Save video only, track later.
3. If no trials are planned, click the New trial button in the Playback Control 

window.

Procedure

Record a series of video files

1. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start trial 
button in the Playback Control window.

The Video window says Recording video. 

2. Release the animal in the arena. 
3. To stop video recording, choose Acquisition > Stop Trial, or press 

Ctrl+F6, or click the Stop trial button in the Playback Control window.
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Repeat the procedure for more video files.

Acquire a series of trials from the video files

1. In the Acquisition Settings window, select Track all saved video files.
2. Make sure that the video file is positioned at its beginning or, in any case, at 

the point where you want to start data acquisition.
OPTIONAL  Select Detection determines speed in the Playback Control 
window to make sure that samples are not missed. See DDS (Detection 
determines speed) for the advantages of applying this option. 

3. Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start trial 
button in the Playback Control window.

The video is played forward and tracking takes place. 

4. Acquisition stops automatically when the video file has reached the end 
and EthoVision XT automatically proceeds with the next saved video in 
your Trial List.

5. When all the videos have been analyzed, a message informs you that 
acquisition is done. 

Notes
▪ If you wish to discard the tracks and re-do tracking from that video, see 

Redo a trial.
▪ To make sure that tracking starts and stops at the correct moment in the 

video, you must define appropriate Trial Control settings.
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Acquire a series of trials from video 
recorded with other programs
Aim
To carry out video tracking from a number of video files, recorded with a program 
other than EthoVision XT.

Prerequisites
For general recommendations, see Acquire a trial from a video file recorded with 
other programs.

Procedure
1. Release the animals in the arena and record video to a digital media file 

using the appropriate hardware and software. We recommend using 
MediaRecorder.
At the end of this step you should have a number of video files.

2. Make a Trial List for batch acquisition and add one video for each trial in the 
list. See Prepare the trial list for batch acquisition.

3. Acquire a series of trials from the video files.
(a) Choose Acquisition > Open Acquisition. In the Acquisition Settings 
window select Track all planned trials. The name of the first planned trial 
in the Trial List appears in the field next to Trial and the associated video file 
opens in the Video window.

(b) Make sure that the video file is positioned at its beginning or, in any 
case, at the point where you want to start data acquisition. Select DDS in 
the Playback Control window to make sure that samples are not missed.

(c) Choose Acquisition > Start Trial, or press Ctrl+F5, or click the Start 
series button in the Playback Control window.

Notes
▪ To make sure that tracking starts and stops at the correct time point, you 

must define appropriate Trial Control settings.
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▪ If you stop batch acquisition manually, all trials acquired up to that time are 
saved, including the current one that was interrupted. Click the Start series 
button again to complete the series. If necessary, redo the trial that was 
interrupted. Redo a trial

▪ If you wish to track data once again from that video, add a trial and follow 
the procedure for single trial acquisition See Acquire one trial.

▪ The lighting conditions could be different between the start of subsequent 
trials. When using subtraction of differencing for subject detection, you can 
update the reference image based on the first video frame. So you keep the 
reference image matched with the current conditions. See Use first frame 
of each trial in Optimize the reference image > The reference image 
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Choosing the optimal reference image in 
a series of trials
Background information
The background image is the image that the software compares with the incoming 
images from a camera (or video file) in order to find the subject. A good 
background image is critical for obtaining high quality tracking data. See The 
reference image

When you acquire multiple trials in a series, a reference image is used at the start of 
each new trial. Choosing the reference image is important especially when there is a 
long temporal gap between the end of one trial and the start of the next one. 
Follow the guidelines below.

This topic applies when: 

▪ You use one of the detection methods Dynamic subtraction, Differencing, 
or DanioVision.

▪ You Acquire a series of trials (Batch acquisition), or carry out trials manually 
one after the other. 

Procedure
1. Create your series of trials in the Trial List. See Prepare the list of trials
2. In the Detection Settings, choose Automated Setup or choose the 

detection method. 
3. Under Method, click the Background button. Obtain the reference image 

for the current video (or live image). See The reference image
4. In the Background Image window, under Acquisition Settings, choose one 

of the following:
▪ Use saved reference image. The saved reference image is the image 

that you obtained in the previous step. The software will use this image 
at the start of each trial. Choose this option if you are 100% sure that 
the background does not change with time (or between video files). 
For example, when there is no bedding material, the background is lit 
uniformly, and the camera is always exactly in the same position 
relative to the arena.

▪ Use dynamic reference image. As explained in How the reference 
image is updated in Dynamic subtraction, a dynamic reference image 
keeps changing during a trial. With this option, for each new trial, the 
software will use the most recent dynamic reference image available, 
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that is, the one that was created at the end of the previous trial. Choose 
this option if the live (or video file) image at the end of a trial is 
comparable to that at the start of the next trial. For example, when a 
trial starts a few seconds/minutes after the end of the previous trial.

▪ Use first frame of each trial. With this option, the software takes the 
first video frame available from the camera (or video file) and uses it as 
the reference image. Choose this option whenever you suspect that the 
video image at the end of a trial is likely to differ from that at the start 
of the next trial. For example when lighting conditions change, or the 
bedding material looks different between two trials. When you specify 
long inter-trial intervals, that is often the best option. See Trials and 
inter-trial intervals

Notes
▪ Consider that the video image could also change between trials if the 

camera moves slightly relative to the camera. For example if you place a 
Petri dish under the camera not exactly on the same spot each time. This 
effect is more important when you track small animals. Any shift in the 
reference image, even a few pixels large, could affect detection in the next 
trial. 

▪ You should not use the option Use first frame of each trial when the 
subject is already in the arena at the start of each trial. If you do so, 
EthoVision XT misses the subject in the first frames and finds it only when it 
moves away from the starting point.
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Additional information on data 
acquisition
Learn about

▪ Working with trial control

What do you want to do?
▪ Carry out trials in an order different from that specified in the trial list
▪ Acquire data for some arenas, not others
▪ Redo a trial
▪ Rename or delete a trial
▪ Rename or delete a generated video file
▪ Score behaviors manually during acquisition
▪ Use a remote control to start and stop acquisition
▪ Export track data live
▪ Auto-start data analysis
▪ Search the Troubleshooting: Data acquisition
524



Working with trial control
Starting data acquisition

▪ Data acquisition starts depending on when the condition in the Action box 
Start track is met. In a default DanioVision experiment, this condition is not 
present, so tracking starts as soon as you start the trial. 

▪ If conditions to start data acquisition are never met within an arena, data 
are not recorded for that arena. A track file is created, but contains no track 
data.

▪ See The Start-Stop trial rule

Stopping data acquisition
▪ If you use the default Trial Control profile, data acquisition stops when you 

give the Stop command (by clicking the Stop button or pressing Ctrl+F6).
▪ If conditions to stop data acquisition are never met within an arena, data 

are recorded until the video ends or (in the case of live tracking) indefinitely 
unless you have specified a maximum trial duration in the Trial Control.

▪ See The Start-Stop trial rule

Starting and stopping data acquisition with multiple arenas
When your trial includes multiple arenas, a copy of the Trial Control rule is applied 
to each arena separately. This means that actual data acquisition may start and stop 
at different times in different arenas, depending on when the start/stop conditions 
are met in those arenas. See Trial control in multiple arenas

▪ When starting the trial , actual data acquisition starts independently for 
each arena depending on when the animal is detected.
EXAMPLE  The time indicated in each arena is the time since the start of the 
actual acquisition in the arena. Acquisition started first in Arena 1, 3 and 4 
because the animals were already in those arenas when the trial started. In 
Arena 2 acquisition has not started yet, because the animal was not yet 
released in the cage.
525



▪ Data acquisition stops independently for each arena unless you stop 
acquisition manually . 

EXAMPLE  A condition has been defined so that data recording stop when 
the animal is detected in its arena for 10 cumulative minutes (Cumulative 
duration). Data recording may stop at different elapsed times in different 
arena, if for example the animals have been released in the arenas at 
different times, and therefore the 10-minute threshold is reached at 
different times in the four arenas.
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Carry out trials in an order different from 
that specified in the trial list
Example
Carry out Trial 5 before Trial 4.

1. Skip Trial 4 and let EthoVision XT acquire data for Trial 5. 
2. If you want to carry out Trial 4 at a later time, in the Trial List set this trial 

back to Planned.
NOTE  This procedure also applies when you track subjects in multiple arenas 
simultaneously. Set all arenas to To Skip.

Procedure
To skip the current trial:

1. Make sure that the Acquisition Settings window shows the name of the trial 
you want to skip.

2. Click the Skip Trial button in the Playback Control window.

Result: The Acquisition Settings window shows the next trial number. 

3. Carry out the trials as usual.
To carry out the skipped trial

1. In the Experiment Explorer, click Trial List. Click the Show/Hide button on 
the toolbar, select Variables and make sure Acquisition status is selected 
in the Show Variables window.
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2. Locate the trial and change its Acquisition status from To Skip to Planned. 
Make sure that you do this for all the arenas you want to use in that trial.

3. Go to the Acquisition module and carry out the trials as usual. After that, its 
Acquisition status changes from Planned to Acquired.

Notes
▪ To skip a trial other than the current one in the Acquisition screen, open the 

Trial List. Click the Show/Hide button on the toolbar, select Variables and 
make sure Acquisition status is selected in the Show Variables window. 
Locate the trial you want to skip, and change the Acquisition status for that 
trial from Planned to To skip. See Skip trials

▪ You can also Skip arenas within a trial.

See also

▪ Acquire data for some arenas, not others
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Acquire data for some arenas, not others
Aim
To acquire data only it the arenas that contain subjects.

EXAMPLE  For Trial 32, a few arenas in a well plate are empty. Nevertheless, you want 
to track the subjects in the remaining arenas.

Procedure
1. In the Experiment Explorer, click Trial List. 
2. Locate the Acquisition status column. If it is not present, click the Show/

Hide button on the toolbar, select Variables and select Acquisition status.
3. Locate the trial for which you want to skip arenas, and change the 

Acquisition status for those arenas from Planned to To Skip.
4. Carry out the trials as usual. 

Notes
▪ After acquisition, the Acquisition status of the skipped arenas changes from 

To Skip to Skipped. See Skip arenas within a trial
▪ You can no longer acquire data for the Skipped arenas because the trial 

itself has been acquired. To acquire data for those arenas, add a new trial 
and acquire data anew. 

See also

▪ Skip arenas within a trial
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Redo a trial
Aim
To record video or track data once again for a trial previously acquired.

IMPORTANT When you redo a trial, you remove the tracks, the events scored 
manually and the trial control event data (including hardware device data) recorded 
during that trial.

EXAMPLE 1  You have acquired a trial and realize that you have acquired the data 
with the wrong detection settings, or the tracks obtained from that trial contain too 
many missing samples.

EXAMPLE 2  You have acquired video using EthoVision for Trial 12 and realize that 
something went wrong during the test. You want to record new video and assign it 
to Trial 12.

Procedure
We assume at this point that you have carried out a trial and a video file 
corresponding to that trial has been saved. 

1. In the Acquisition Settings window, under Options next to Clear and redo 
a trial, click the Select button.

2. In the Redo Trial window, select the trial that you want to redo.
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3. Select one of the options, then click OK. 
When tracking from video files: 

▪ Clear tracks. The tracks are deleted. Choose this option if you want to 
re-do the trial using a video file different from the current one.

▪ Clear tracks but re-use the video reference. As above, however the 
link to the video file is retained. You can open Acquisition to track from 
that video file.

When tracking live:

▪ Clear tracks. The tracks are deleted. This option is available if you 
acquired tracks without saving video.

▪ Clear tracks but re-use the video. To delete the tracks, not the video 
file used to acquire those tracks. You can then track again from the 
video file.

▪ Clear tracks and video. To delete the tracks and the associated video 
and redo the trial anew.

▪ Clear video. To clear a trial that has video only. You can then record a 
new video and acquire tracks. This is the only option available if you 
acquire data by saving the video first.

See also Clear trials in the Trial List

4. In the Acquisition Settings pane, under Method, 
▪ If you cleared a trial that used a video file not made with Ethovision XT, 

choose Track next planned trial. This is the option for redoing the trial 
from that existing video file.
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▪ If you cleared a trial with a video file made with EthoVision XT, and 
deleted that video file, choose Track next planned trial. Alternatively, 
choose Save video only, track later to record a new video file for that 
trial without tracking.

▪ If you cleared a trial with a video file made with EthoVision XT, but kept 
the video file, choose Track next saved video file. With this option 
you re-do the trial for that video file.

▪ Choose Track all planned trials if you have a list of planned trials and 
you want to acquire data for all of them in one go.

5. Under Settings, next to Trial, you see the number of the trial that you are 
about to acquire.
The Video box shows either Live video or the video file you will track from, 
depending on the options chosen above.

6. If necessary, click the button next to Video and select the video file to track 
from.

7. You can now start the trial. Click the Start trial button in the Playback 
Control window.

Notes
▪ The options available next to Select action vary depending on how you 

acquire the trials. For example, if you track from pre-recorded video files, 
then only the first two options Clear tracks and Clear tracks but re-use 
the video reference are available. 

▪ Before re-doing a trial, always check in the Acquisition Settings pane under 
Method which option is selected, and under Settings the video file you are 
going to acquire the trial from.

▪ If you track from video recorded with programs other than EthoVision XT, 
and you want to delete the video file corresponding to the trial you want to 
redo, you must delete the video manually.
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See also

▪ Plan your trials
▪ Skip trials
▪ Clear trials in the Trial List
▪ Acquire one trial
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Rename or delete a trial
To rename a trial
Trials are given default names depending on the order they are added in your Trial 
List: Trial 1, Trial 2, etc. (first column of the Trial List).

To rename your trials, edit the Trial name variable in the Trial List.

1. Choose Setup > Trial List.
2. Click the Show/Hide button on the toolbar and select Variables. In the 

Show Variables window, select Trial name.
3. In the Trial name column, double-click the cell corresponding to the trial 

you want to rename. Next, enter the new name. 
4. The name under Trial is changed automatically, matching what is entered 

under Trial name.
EXAMPLE  You want to rename Trial 5 to Probe Trial.

To delete a trial
Deleting a trial means that all the tracks and external data files (if these have been 
imported in EthoVision XT) are removed from your PC. To delete a trial, in the Trial 
List, click a trial and press Delete, or right-click a trial and select Delete Trials.
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Note

▪ If you have tracked from video files generated with EthoVision XT, you are 
asked whether you want to keep the video file associated with the trial or 
delete this file too. See Rename or delete a generated video file.

▪ If you have tracked from video files generated with programs other than 
EthoVision, the video file associated with the trial is kept on your PC. 

▪ To delete multiple trials, select the trials in the first column of the Trial List, 
then press Delete or right-click and select Delete Trials.

▪ In a multiple-arena experiment, you cannot delete tracks acquired in some 
arenas within a trial. You can only delete all tracks, that is, the entire trial.

▪ If you delete a trial and then add a new one, this is not given the name of 
the deleted trial. For example, if you have 10 trials in your Trial List and you 
delete Trial 4, when adding a new trial this is named Trial 11. To avoid this, 
do not delete the trial but clear it: right-click the trial in the Trial List and 
select Clear Trials. 

See also

▪ Clear trials in the Trial List
▪ Redo a trial
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Rename or delete a generated video file
Video files recorded within EthoVision XT are given the same name as the 
corresponding trial: Trial 1.mpg, Trial 2.mpg, etc. If you want to rename or delete a 
video file, you must first delete the corresponding trial.

If you want to rename a video file without deleting its trial, make a copy of the 
video file with the File Explorer and give this copy the new name.

1. Choose Setup >Trial List.
2. In the Trial List, right-click the row corresponding to the video you want to 

delete and select Delete. 
3. In the window that appears:

▪ Choose Rename generated video files for backup if you want to 
rename the file and delete the trial.

▪ Choose Delete generated video files if you want to delete the video 
file and the trial. 

IMPORTANT In either case the tracks and the external data files associated 
with that trial will be deleted!

4. Click Yes to confirm.
536



Use a remote control to start and stop 
acquisition
Aim
To start and stop data acquisition when standing far from the EthoVision XT 
computer.

Prerequisites
▪ You need a remote control with Page-up (<) and Page-down (>) buttons, 

such as those typically used for PowerPoint presentations.

Procedure
1. Close EthoVision XT.
2. Browse to my.noldus.com, log in or register. Click Downloads, then 

EthoVision XT, then Drivers and Tools, and download the file for remote 
control. Save remote_control.zip somewhere to your EthoVision XT 
computer.

3. Extract and double-click remote_control.reg file and when a message 
appears click Yes. You can now use the remote control.

4. Switch on and connect the remote control. This is usually done by plugging 
a USB receiver into the EthoVision XT computer.

5. Start EthoVision XT and choose Acquisition > Open Acquisition.
6. To start a trial, press Page-up (<) on the remote control.
7. To stop a trail, press Page-down (>) on the remote control.

Notes
▪ Signals from the remote control will only be recognized:

▪ While acquiring data, and if the trial is not finished yet.
▪ When you are not entering independent values.
▪ When you are not browsing through the video.

▪ For earlier versions, download the full installation package and look for the 
Remote Control folder under Utilities.
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▪ If your PC is connected to a network through Wi-Fi, you could control 
EthoVision XT from a smartphone using one of the apps available, provided 
that the network’s security settings allow communication.

▪ See also How do I start data acquisition on multiple PCs simultaneously?
▪ If you have the USB-IO box and the TTL Port Tester PTTB-001x, you could 

have EthoVision XT start tracking when you press the button on the TTL 
Port Tester. To do so, connect the TTL Port Tester to a TTL port of the USB-
IO box. In the Trial Control Settings, create a condition based on the TTL 
Port Tester that becomes true when the button 1 is pressed. Place the 
condition box between the Start Trial box and the Start track box. You use 
the TTL port tester as a remote control. Note that with this solution you 
must click the Start trial button in EthoVision XT, which then waits for the 
button press.
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Export track data live
Aim
To crease a sample interface that exports the track samples real-time, that is, during 
data acquisition.

Procedure
To enable external data export, you can write a DLL (COM DLL, also known as COM 
component) in C++. The DLL should implement the sample interface as follows:

Furthermore the DLL should include the instructions for processing the samples, for 
example:

▪ Write the sample data to a local file;
▪ Send the sample data over the network to an external application

If you need help with writing the code for your DLL, please contact Noldus. 

Notes
▪ The sample interface is specific to the EthoVision XT version you are using.
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Auto-start data analysis
The Auto-start data analysis option in the Acquisition Settings window allows you 
to automatically start batch calculations immediately after data acquisition has 
ended, without the need to give any additional command.

EXAMPLE  You have a large set of video files, and you plan to start the batch data 
acquisition before leaving the lab in the evening. By selecting Auto-start data 
analysis, you make sure that analysis starts immediately after the end of the last 
trial, so that the results are ready the next morning.

To enable auto-start data analysis
1. Define your series of trials in the Trial List.
2. In the Acquisition module, before starting acquisition, in the Acquisition 

Settings window, under Options, select Auto-start data analysis.

3. Select one of the two options:
▪ Active profiles only. To calculate the statistics using only the 

combination of the Track smoothing profile, Data profile and Analysis 
profile currently active (highlighted in blue in the Experiment Explorer).

▪ All profile combinations. To calculate the statistics using all 
combinations of the Track smoothing profiles, Data profiles and 
Analysis profiles in your experiment.

4. Carry out data acquisition as usual.

Notes
▪ If you choose the second option, to minimize processing time and disk 

space occupied by results, make sure that the Track smoothing, Data and 
Analysis profiles in your experiment are those you want to use for analysis. 
Remove any duplicate or non-interesting profiles.

▪ If you want to analyze data using certain profile combinations, not others, 
do not select Auto-start data analysis. Instead, do batch analysis after 
acquisition; there you can choose those profiles combinations.
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▪ The analysis does not start automatically when you stop tracking manually.
▪ If you move to another window and then return to the Data acquisition 

screen, you have to set the Auto-start data analysis option again.
▪ The Auto-start data analysis option is not available when you select Save 

video only, track later as acquisition method.
▪ Once analysis is started, a window with a progress bar opens. You can see 

that there are a few stages:
▪ Step 1 - Data Preparation (for when tracking two subjects with Deep 

learning). For details see Prepare the data in multi-subject trials
▪ Step 2 - Track Smoothing, for adjusting the tracks based on a Track 

smoothing profile.
▪ Step 3 - Data Selection, for choosing tracks, and track segments based 

on a Data profile.
▪ Step 4 - Analysis, for calculating the values of the dependent variables 

specified in an Analysis profile.
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Score behaviors manually
What do you want to do?

▪ Score behaviors manually during acquisition
▪ Score behaviors manually after acquisition
▪ Edit the duration of manually-scored behaviors
▪ Replace a behavior with another one
▪ Score behaviors in different arenas
▪ Score behaviors of two or more subjects
▪ Delete a manually-scored behavior
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Score behaviors manually during 
acquisition
Aim
To record behaviors manually, while EthoVision XT tracks the subjects.

NOTE  You can also Score behaviors manually after acquisition.

Prerequisites
▪ You have defined behaviors in the Manual Scoring Settings.
▪ In the Acquisition screen locate the Analysis Results and Scoring pane, and 

click the Manual scoring tab. If you do not see the Analysis Results and 
Scoring pane, click the Show/Hide button and select Analysis Results and 
Scoring.

▪ If you track from video files, in the Playback Control window, deselect DDS. 
So you make sure that the video file is played at the normal speed.

Behavior buttons and key codes
Each behavior has its corresponding buttons (with key code, if defined) for each 
arena and subject. Mutually-exclusive behaviors are shown under their group name.

For multiple animals per arena, you can use the fill color as a reference to identify 
animals.

If at least one trial is set to Planned in your Trial List, the buttons for behaviors 
defined as Initially active in the Manual Scoring Settings are highlighted in green 
(see No grooming in the picture below), indicating that when you start the trial this 
is recorded automatically as initial behavior.
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Procedure
1. Start the trial.

2. To score a behavior for a specific subject, arena and behavior, press the key 
for that combination, or click the button for that combination.

Result: The button of the scored behavior is highlighted in green. The 
behavior’s start has been scored.

For mutually-exclusive behaviors, the button of the previous behavior is 
reset.

3. When the subject no longer shows that behavior, do the following:
▪ For Mutually-exclusive states, score the behavior that is active next.
▪ For Start-Stop states, press the stop key or click the button for that 

behavior.
Result: The button of the behavior is reset. For mutually-exclusive 
behaviors, the button of the new behavior is highlighted in green.

Notes
▪ Data can only be recorded after tracking has started. If you start the trial 

and tracking starts some time later as a result of Trial control conditions 
setting some delay, any scoring action between the start of the trial and the 
tracking is not recorded.
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▪ You cannot pause recording behaviors even when you track from a video 
file. However, after acquisition you can Score behaviors manually after 
acquisition.

▪ If you want to change the initial state of a subject for the next trials, do so in 
the Manual Scoring Settings. Initial behavior for trials already acquired 
remains as it is.

▪ To modify the coding scheme, stop the trial and click Manual Scoring 
Settings in the Experiment Explorer. 

▪ For more efficient data scoring you can use the X-keys programmable 
keyboards. You can for example press and hold a key as long as the 
behavior lasts. Contact Noldus Information Technology for more 
information.

▪ To improve clarity in the video image during the observation, choose which 
body points to show, and adjust their size. See The video window > Show/
hide body points and other track features

▪ If you want to show the arena and zones during the scoring sessions, click 
the Show/Hide button at the top-left corner, and choose Arena features.
545



Score behaviors manually after 
acquisition
Aim
To add new or edit existing behavior scores in your trials.

Prerequisites
▪ You have defined behaviors in the Manual Scoring Settings.
▪ You have acquired one trial and its corresponding video.

Procedure
1. Choose Acquisition > Manual Scoring.
2. Choose the trial, and when it applies, the arena in which you want to score 

behaviors.

3. To enable the scoring mode, click the Start scoring mode button.

4. Follow one or more of the procedures below. 
TIP  Before editing existing data, click the Save button on the toolbar. This 
will save a copy of the current behavior scores. In the case you make 
mistakes when editing, you can always revert to that copy by clicking Undo. 
For more information, see Saving the track edits.

5. When finished, click the Stop scoring mode button.

To score a behavior with a duration
This applies to behaviors defined as Mutually exclusive and Start-stop. See Define 
the behaviors that you want to record manually
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1. Play the video to the point where the behavior starts.

2. To score the behavior at that point in the video, click the color button with 
the behavior name at the left side of the plot.

Result: The button is highlighted in red.

3. Play the video forward. As you play the video, a colored bar appears at the 
left of the hairline.
NOTE  If you play the video backward, the color bar is reduced in length.

4. Pause the video where the behavior stops. To score the end of the behavior, 
click again the button at the left, so it is not highlighted anymore.
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5. Repeat steps 1-4 to add more instances of the behavior.

To score a point event
Point events are events with no duration. See Define the behaviors that you want to 
record manually

1. Play the video to when the behavior occurs.
2. To score the behavior at that point in the video, click the color button with 

the behavior name at the left side of the plot.

3. Play the video further. The point event is displayed as a vertical segment.
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Notes
▪ After clicking Start scoring mode button, the video image shows [On] and 

message next to the button changes to Scoring on.

When you play the video, behavior scores do not change until you click the 
corresponding button at the left side of the plot.

▪ If you want to hide the center point to make the subject more visible, 
choose Track Visualization or Integrated Visualization or Track Editor, 
and de-select the body points on the right-hand pane. Next, close and re-
open the experiment. 

▪ When you click the button for a behavior, the name of the behavior is 
displayed on the video image.
To show/hide and customize this text, choose Show/Hide > Text Features.

▪ When you score the start of a behavior (either Mutually exclusive or Start-
Stop) and then you reach the end of the trial without scoring the end of the 
same behavior, that behavior is considered to last until the last sample.
If the behavior is defined as Start-stop, a complementary behavior (“not-
behavior”) is added at the end of the behavior you scored. You can see this 
in the Integrated visualization. The example below shows Grooming and the 
complementary Not grooming. The plot of distance has been added to 
visualize the last sample of the track.
549



This means that the statistics of Not grooming is increased by 1.

▪ Behaviors that are defined as Initially Active in the Manual Scoring 
Settings, are shown as active throughout the trial, if you do not edit them.
For example, No grooming was defined as Initially Active and no behaviors 
were scored during acquisition. When opening the Manual Scoring screen, 
the data look like this:

 

▪ If you want to show the arena and zones during the scoring sessions, click 
the Show/Hide button at the top-left corner, and choose Arena features.

See also

▪ Edit the duration of manually-scored behaviors
▪ Replace a behavior with another one
▪ Delete a manually-scored behavior
▪ Score behaviors in different arenas
▪ Score behaviors of two or more subjects
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Edit the duration of manually-scored 
behaviors
Aim
To increase or reduce the duration of instances of behaviors already scored in your 
trial. This way you can improve the match between what you see in the video and 
the behavior scores.

NOTE  This applies to all behavior types but Point events.

Prerequisites
▪ You have scored behaviors manually. See Score behaviors manually

Procedure
1. Open the Manual Scoring screen (Acquisition > Manual Scoring).
2. Choose the trial, and when it applies, the arena in which you want to score 

the behaviors.

3. Follow one or more of the procedures below.
TIP  Before editing existing data, click the Save button on the toolbar. This will save 
a copy of the current behavior scores. In the case you make mistakes when editing, 
you can always revert to that copy by clicking Undo. For more information, see 
Saving the track edits.

To extend the duration to a specific time point
1. Play the video up to when the behavior ends (here indicated with the 

arrow). 
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2. Hover with mouse over the existing color bar, right-click and choose Extend 
to current, or double-click the existing score.

3. Result: The color bar now ends at the specified time.

To fill the gap between two behavior scores
Follow this procedure if you scored two instances of the same behavior, and you 
want to fill the gap between the two instances since they actually refer to one bout 
of behavior. The frequency of the behavior will be reduced by 1.

1. Position the video at the start of the second color bar. 
2. Point to the first color bar, and double-click or right-click and select Extend 

to current.

To create a gap between two behavior scores
This applies to Start-stop behaviors only.

Follow this procedure if you scored an instance of a Start-stop behavior, and you 
want to insert a gap between the original start and end points. The frequency of the 
focal behavior will increase by 1. The gap will appear as Not [behavior name] in the 
analysis.

1. Click the Start scoring mode button.
552



2. Position the video to where you want the end of the gap (= the second start 
point of the behavior).

3. Click the button for the behavior.

4. Play the video backward. TIP Use the frame-by-frame controls for accurate 
scoring. Pause the video at the start of the gap (= the first end point of the 
behavior).

5. When finished, click the Stop scoring mode button.

To reduce the duration to a specific time point
Follow this procedure if the behavior score is too long relative to what shown in the 
video.

Do one or both the following, depending on whether the color bar occurs before (a) 
or after (b) the actual behavior in the video, or both (a) and (b).
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(a)

1. Position the video where the behavior starts. 
2. Point to the color bar at the left of the hairline. The mouse pointer turns to 

a delete symbol on the left side.

3. Right-click and choose Crop to current, or double-click the color bar.
4. Result: The color bar is shortened.

(b)

1. Position the video where the behavior ends. 
2. Point to the color bar at the right of the hairline. The mouse pointer turns to 

a delete symbol on the right side.
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3. Right-click and choose Crop to current, or double-click the color bar.
4. Result: The color bar is shortened.

NOTE  Which side of the color bar is deleted by Crop to current depends on where 
the mouse pointer is located relative to the hairline.
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Replace a behavior with another one
Aim 
To replace the score of a behavior with that of another behavior from the same 
Mutually-exclusive group.

Prerequisites
▪ You scored behaviors of a group defined as Mutually-exclusive. See Define 

the behaviors that you want to record manually
▪ You have opened the Manual Scoring Screen (Acquisition > Manual 

Scoring).

Procedure
1. Choose the trial, and when it applies, the arena in which you want to score 

behaviors.

2. To enable the scoring mode, click the Start scoring mode button.

TIP  Before editing existing data, click the Save button on the toolbar. This 
will save a copy of the current behavior scores. In the case you make 
mistakes when editing, you can always revert to that copy by clicking Undo. 
For more information, see Saving the track edits.

3. Position the video to the point where the new behavior starts.

4. Click the button for the new behavior.
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5. Play the video forward. TIP  Use the frame-by-frame controls for accurate 
scoring.

6. Pause the video when the behavior ends.

7. To confirm, click the behavior button again. To quit editing, click the Stop 
scoring mode button.

See also

▪ Delete a manually-scored behavior
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Delete a manually-scored behavior
Aim
To remove an instance of behavior scored manually.

Prerequisites
▪ You have opened the Manual Scoring screen (Acquisition > Manual 

Scoring).

Procedure
1. Choose the trial, and when it applies, the arena in which you want to score 

behaviors.

2. Hover with the mouse on the color bar (or vertical segment) which 
represents the instance you want to delete. The cursor changes to a symbol 
depending on where this instance is relative to the hairline.

TIP  If you are not sure of the results of editing, click first the Save button on 
the toolbar. You can always return to the last saved data by clicking Undo. 
See Saving the track edits

3. Right-click and choose Delete event.
4. The same is valid for point events:

TIP  When deleting point events, make sure that the hand cursor is slightly 
at the right of the event you want to delete.
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Notes
▪ If you delete a behavior from a mutually-exclusive group, the previous 

behavior is extended up to the end of the color bar that you delete.
EXAMPLE

Result:
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▪ You can only delete a behavioral category defined in the Manual Scoring 
Settings, but only after deleting all the trials. Note that if you remove all 
trials, you remove all your data! See Edit the manual scoring settings
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Score behaviors in different arenas
Aim
To edit behaviors manually for subjects that were tracked in different arenas.

Prerequisites
▪ You have defined two or more arenas in the Arena Settings. 
▪ You have defined behaviors in the Manual Scoring Settings.
▪ You have acquired one trial and its corresponding video.
▪ You have opened the Manual Scoring screen (Acquisition > Manual 

Scoring).

Procedure
1. In the Manual Scoring screen, select the arena in which you see the subject 

you want to score behaviors for. 

Result: The body points of the subjects in the selected arena are displayed.

2. To enable the scoring mode, click the Start scoring mode button.

3. Score/edit the behavior for the subjects in that arena. See Score behaviors 
manually after acquisition.
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4. Repeat the procedure for the remaining arenas.
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Score behaviors of two or more subjects
Aim
To edit behaviors manually in a social interaction context.

IMPORTANT  If you tracked unmarked subjects, always check that there is no subject 
swap in your tracks. If that is the case, correct the swaps in the Track Editor screen. 
Otherwise you take the risk to score a behavior for the wrong subject. See Swap 
subjects

Prerequisites
▪ You have defined behaviors in the Manual Scoring Settings.
▪ You have acquired one trial and its corresponding video.
▪ You have opened the Manual Scoring screen (Acquisition > Manual 

Scoring).

Procedure
1. In the Manual Scoring screen, subjects are indicated with different colors.

2. To score the behaviors of a subject, locate the plot marked with the same 
color.

3. Score the behavior as described in Score behaviors manually after 
acquisition.

4. When you score a behavior with duration, the subject name is also 
indicated on the video image. 
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Simultaneous scoring of behavior
Behaviors are always associated with a subject. If you want to score a behavior valid 
for all subjects simultaneously, score the same behavior for each subject. To do so, 

1. Position the video at the start of the behavior.
2. Click the button for each subject involved.

3. Next, play the video until the end of the behavior.
4. Finally, click the button for that behavior again, and for each subject.
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Notes
▪ TIP  Behaviors like proximity can be automatically measured. See Social 

dependent variables
▪ TIP  Before editing existing data, click the Save button on the toolbar. This 

saves a copy of the current behavior scores. In the case you make mistakes 
when editing, you can always revert to that copy by clicking Undo. For 
more information, see Saving the track edits.

▪ To show/hide and customize the overlay text, choose Show/Hide > Text 
Features.
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Import data from other experiments
Aim
To analyze data collected in two or more (identical) experiments.

EXAMPLE  You run experiments with a number of PhenoTyper cages. Each group of 
four PhenoTypers is controlled by a computer with EthoVision XT. Therefore, you 
have as many experiments as computers. You would like to analyze all the data from 
the original (source) experiments in one master experiment.

Prerequisites
▪ You have two or more EthoVision XT experiments containing data.
▪ The setup must be identical between the original experiments. Import of 

different experiments (e.g. am open field and a PhenoTyper) won’t work.
▪ The original experiments and the master experiment must have identical 

settings. For example:
▪ The same detected features (e.g. center point);
▪ The same number of arenas and the same number of subjects per 

arena;
▪ The same Arena Settings, with for example the same zone names, 

Detection Settings and Trial Control Settings.
▪ The same Behavior Recognition settings.
▪ The same behavioral events defined in the Manual Scoring Settings.
▪ The same hardware device names, mapped on the same arenas. For 

example, Lickometer 1 must be mapped on Arena 1 in all experiments. 
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TIP  When you create the first of the original experiments, adjust the 
settings and then, before acquiring the first trial, save it with a different 
name to create an identical copy (File > Save As). This is going to be your 
second original experiment.

Step 1 - Create the empty master experiment
1. Start EthoVision XT on the PC that contains one of the original experiments.
2. Choose File > New from Template. Choose Use a custom template and 

select one of the original experiments. Select the file with the name of that 
experiment and the extension evxt.

3. Complete the procedure, and give the new experiment a name, for example 
Master experiment.

4. If you intend to work with the master experiment on a different PC, copy 
the original experiments and the master experiment to another PC.

Step 2 - Import the trials into the master experiment
1. If needed, copy the original experiments to the PC where the master 

experiment is stored.
2. Open the master experiment (see above).
3. Choose Setup > Trial List.
4. Delete the empty trials in the master experiments. These rows were 

generated and left empty when you created the experiment from the 
custom template. You do not need them, so select all rows, right-click and 
choose Delete Trials. See Delete trials

5. Click the Import Trials button.

6. In the window that opens, select EthoVision XT data (trials) and click OK. 
7. Locate the experiment that you want to import. Select the file with the 

extension evxt and click Open. To locate this file, open the folder that has 
the same name as the experiment.

8. Select which trials you want to import. If you want to copy the video files 
into the master experiment, select Also import the associated video files.
567



NOTE  This option only applies when the video files were generated by 
EthoVision XT in experiments set to Live tracking. If your original 
experiments are set to Offline tracking, the video files that were used to do 
tracking are not copied; however, the master experiment preserves the link 
to those video files.

9. After import, which may take some time depending on the number and 
length of the tracks, the imported trials are shown in the trial list.

Result of the trial import
What is imported in the master experiment:

▪ The trials (track data, independent variables, manually-scored events, 
hardware events)

▪ The settings associated with the trials (Arena Settings, Trial Control Settings, 
Detection Settings, Manual Scoring Settings).

▪ The physiological data associated with the trials.

Notes
▪ If two settings profiles have the same name but slightly differ, for example 

one detection settings profile Detection Settings 1 in the first experiment 
set to Gray Scaling 40 to 255 while the Detection Settings 1 in the second 
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experiment is set to Gray Scaling 45 to 255, the second imported 
experiment is renamed; in this example Detection Settings 1 (1).

▪ If two settings profiles are exactly the same in the original experiments, 
they are imported with the same name.

▪ There may be subtle differences between the master experiment and one of 
the original experiments which cause import to fail. For example, in the 
master experiment a Trial Control Settings profile contains a condition 
named Time (1), while the same settings profile in experiment 1 or 2 
contains the same condition named Time (2). Although the settings 
profiles have the same name, EthoVision XT detects that their content is 
different. Please follow the procedures above to make sure that the master 
experiment is an exact copy of the original experiments.

▪ When you select the option Also include the associated video files and 
only for video files recorded with EthoVision XT, those video files are 
copied to the Media Files folder of the master experiment. If you do not 
select that option, you can still view the videos in the master experiment, 
provided that they are still stored in the original experiment.

▪ If you record video with MediaRecorder or software other than EthoVision 
XT, the video files are not copied to the master experiment anyway, also 
when they are stored in the Media Files folder of the original experiments. 
However, the Trial List shows the link to the original video files.
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Import Live Mouse Tracker data
Aim
To import Live Mouse Tracker (LMT) data into an EthoVision XT experiment.

Background information
You are going to import the information contained in the LMT database. The LMT 
database consists of a number of tables, each containing specific data, for example 
the subjects, the coordinates of the detected subjects, the list of events like Stop or 
Contact, the configurations the output variables, etc. 

A Live Mouse Tracker database does not contain video. To import video into 
EthoVision XT, the original video files must be stored in the folder where the LMT 
database is stored.

Prerequisites
▪ You use EthoVision XT 17.5 or a later version.
▪ Your EthoVision XT license includes the Social Interaction add-on module. 

See Upgrade EthoVision XT
▪ You have created an EthoVision XT experiment of type Live Mouse Tracker. 

See Live Mouse Tracker: Create an experiment
▪ You have one or more Live Mouse Tracker database files (*.sqlite). 

EthoVision XT supports import of data of LMT version 1.0.3.
▪ IMPORTANT  We strongly recommend that you keep databases and video of 

different Live Mouse Tracker recordings in different folders. This to prevent 
that EthoVision XT merges video of different experiments in one. when 
importing the databases. 

Procedure
1. Open the Live Mouse Tracker experiment in EthoVision XT. 
2. Choose Setup > Trial List. 
3. Click the Import Trials button on the toolbar.
4. in the window that opens, select Live Mouse Tracker data (databases) and 

click OK.
5. The Select files window opens. To add a database, click the Add button, 

select the database you want to import and click Open.
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▪ Repeat this step to select a new database. You can only select one 
database file at a time. 

▪ To remove one file from the list of added files, select that file and click 
Delete.

▪ You cannot add a database twice in the same experiment.
6. Once you have completed the list of the databases to be imported, click the 

Import button.

NOTE  Import of long recordings may take several minutes. 

7. Each database is imported as a new trial.

8. You are ready to analyze the data. Open an Analysis profile and add the Live 
Mouse Tracker variables. See Dependent Variables in Detail > Live Mouse 
Tracker

Notes
▪ Each Live Mouse Tracker database results in one trial when imported into 

EthoVision XT. Check that in the Trial List.
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▪ Live Mouse Tracker makes 10-minute video fragments. At import, 
EthoVision XT merges those fragments in one video file, which is imported 
and linked to the trial. 

▪ During the transition from one video fragment to the next one, Live Mouse 
Tracker does not record video frames. This means that there is a gap 
between adjacent video fragments. An offset between video and data may 
occur when visualizing the trial. EthoVision XT cannot compensate for this, 
however it places the next 10-minute fragment at the correct time point 
and restores synchronicity between video and data. 

▪ Calculation of some behaviors is based on fixed thresholds that were used 
during data acquisition. For example the speed thresholds that are used to 
define the behavior category Move. You cannot change those thresholds 
cannot be modified in EthoVision XT. 

▪ When you import Live Mouse Tracker data, the Trial List contains two 
additional independent variables: 
▪ RFID. This shows the RFID code of each subject. 
▪ Original dataset. This shows the location and the name of the original 

database file that was imported (*.sqlite).

See also

▪ Live Mouse Tracker: Workflow
▪ Live Mouse Tracker: Create an experiment
▪ Dependent Variables in Detail > Live Mouse Tracker
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View real-time information
What do you want to do?

▪ Choose a variable to view real-time

Application examples
▪ Open field: view the Movement variable
▪ Porsolt swim test: view the Mobility state variable
▪ Fear conditioning: view Activity state
▪ Conditioning test: view a Trial Control State variable
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Choose a variable to view real-time
By default, the dependent variables Velocity (with the statistic Mean) and Movement 
(with the statistic Cumulative duration, and only for the Moving state) are already 
displayed. You can specify any dependent variable, except behaviors recognized 
automatically.

To choose a variable
1. In the Analysis Results and Scoring pane, click the Dependent Variables 

tab.

2. Click the Show/Hide button on the toolbar, and select Show Dependent 
Variable.

3. Select the variable you want to monitor during the trial. Make sure that you 
specify the correct body point and statistic.
NOTE  You cannot select a Free interval variable to view during acquisition.

Below you find four examples.

To remove a variable
On the Dependent Variables tab of the Analysis Results and Scoring pane, right-
click anywhere in the variable column and select Delete.

Open field: view the Movement variable
In this example, the aim is to calibrate the Movement variable in order to detect 
bouts of locomotor activity. Movement is based on the subject’s speed.

1. Follow the procedure above to choose Movement. Click its properties 
button. On the Trial Statistics tab, choose Current.
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2. During the trial, watch the subject and monitor the current value of 
Movement in the Dependent Variables tab. Note when the behavior of the 
subject and Movement do not match.
▪ If the subject is walking and the cell under Moving-Current says false, 

you must reduce the Start velocity and Stop velocity thresholds. 

▪ Conversely, if the subject is still and the cell Moving-Current says true, 
you must increase those thresholds. Note that only displacement in 
space of the animal should be scored as Moving, not other movements 
like grooming or body axis curling. 

▪ If there are many rapid transitions false-true-false but the animal seems 
not to change its behavior, then you can increase the difference 
between Start velocity and Stop velocity, or increase the Averaging 
interval, for example from 1 to 3.

3. Click the properties button for Movement and adjust the settings 
accordingly.

4. Check again the match between behavior and the values in the Movement 
cell. If necessary repeat steps 3-4 until you have a good agreement 
between the two.

See also Movement in the Analysis profile.
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Porsolt swim test: view the Mobility state variable
In this example, the aim is to calibrate the Mobility state variable in order to quantify 
swimming behavior. Mobility state has three possible states and is based on the 
temporal change in the subject’s detected area.

1. Add Mobility and Mobility state. For both variables select Current as a Trial 
Statistic, and leave the other settings as they are.

2. During the trial, watch the subject and monitor the current values of 
Mobility and Mobility state in the Dependent Variables tab. Note when the 
behavior of the subject and Mobility state do not match. 
First, focus on the mobility thresholds, then on the averaging interval.

For example, to calibrate the Immobile state, watch the subject and check 
the value of Immobile-Current. If the subject swims (or struggles) and 
Immobile-Current is true, take note of the running values of Mobility. This 
tells you how much the animal’s area changes with time. You must set the 
Immobile below threshold smaller than those values.

The Immobile-Current value is true (second column), and the rat in the 
video is swimming. Mobility (first column) shows that the change in the 
area is around 5%. For correct scoring of the Immobile state, the Immobile 
below threshold of Mobility state should be set below 5%. 

3. Click the properties button for Mobility state and change the threshold 
accordingly.

4. Watch the subject again and monitor the value of Immobile-Current. If the 
subjects moves and Immobile-Current says true, the threshold must be 
lowered further.
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▪ At some point the animal still floats, something you would like to score 
as Immobile. Check that Immobile-Current is true. If not, the 
corresponding threshold must be increased slightly.

▪ If there are rapid transitions between Immobile, Mobile, Strongly 
Mobile, that cannot be accounted for in the video, you can increase the 
difference between the two thresholds, and/or increase the Averaging 
interval. 

5. Repeat the steps above to adjust the Highly mobile above threshold. The 
aim is to obtain Highly mobile-Current equal to true only when the animal 
struggles.

6. Visualize the trial (Plot Integrated Data) to view the events of Mobility state 
together with the video. You can always refine your thresholds in the 
Analysis profile to re-calculate the three states.

See also Mobility state in the Analysis profile.

Fear conditioning: view Activity state
In this example, the aim is to calibrate the Activity state variable in order to quantify 
activity levels and freezing. Activity state has four possible states and is based on the 
change in the pixels in the whole arena.

1. Select Activity analysis in the Experiment Settings and define the Activity 
settings in the Detection Settings.

2. Add Activity and Activity state to the Dependent Variables tab of the 
Analysis Results and Scoring pane. 

3. Choose the number of states (minimum two and maximum four). 
4. Leave the threshold values as they are, and set the minimum duration of a 

state. For example, if you think that inactivity should last at least 0.2 s, then 
enter 0.2.
Select Current as a Trial Statistic for both variables.

5. During the trial, watch the subject and monitor the current values of Activity 
state in the Dependent Variables tab. Note when the behavior of the subject 
and Activity state do not match. 
When the animal shows the behavior that should be scored as Inactive, 
monitor the running values of Activity. This tells you how much the video 
image area changes with time. If the value of Inactive-Current is false, you 
must reduce the Inactive below threshold smaller than those values.
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In the example above, the mouse in the video is still, but the Inactive-
Current value is false (second column). Activity (first column) shows that the 
change in the pixels is around 0.5%. For correct scoring of the Inactive state, 
the Inactive below threshold should be set below 0.5%

6. Click the properties button for Activity state and change the threshold 
accordingly.

With the new threshold, if episodes of inactivity are not detected, then 
adjust the threshold in the other direction.

7. If you have more than two states, repeat the steps above to adjust the other 
thresholds. The aim is, for example, to obtain the value of Highly mobile-
Current equal to true only when the animal struggles. 

See also Activity state in the Analysis profile.

Conditioning test: view a Trial Control State variable
In this example the aim is to test whether a pellet is dropped when the animal 
enters the trigger zone. This is also useful to check that the zone is defined 
correctly.

1. Define the Trial Control rule with a Zone transition Condition to define the 
transition to the trigger zone and an Action to let the pellet dispenser drop 
a pellet. See the figure below for an example.
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2. Open the Acquisition screen.
3. Choose Show/Hide > Show Dependent Variable > Trial Control State.
4. Define the Trial Control State as shown in the figure below. Select 

Frequency in the Trial Statistics tab. 

5. Start the trial and open the Dependent variables tab of the Analysis Results 
and Scoring pane to view the Trial Control State. If the animal moves to the 
trigger zone and a pellet is dropped the Frequency increases with 1.
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For simple Trial Control events, like the animal entering a zone, define a Trial Control 
Event instead of a Trial Control State. 
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The data acquisition screen
Learn about

▪ The video window
▪ The Playback Control window
▪ Analysis results and scoring pane
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The video window
Show and hide the Video Source
Click the Show/Hide button on the toolbar and select Video Source.

If you choose not to display the video source, you can still display the center-point 
and other features of the subject to monitor the tracking.

Displaying the video footage requires significant processor power. If viewing the 
video footage during acquisition is not necessary in your experiment, deselect 
Video Source to reduce processor load and consequently increase your maximum 
attainable sample rate.

Show/hide the overlay text
1. Click the Show/Hide button on the toolbar and select Text Features.
2. Select Hide Information or Show Information.
3. If you select Show information, choose one of the following:

Per Arena or Per Trial.

4. Select whether to show the trial name, acquisition status and/or acquisition 
elapsed time. Furthermore you can select the text color and opacity. 

If no trial has been planned, the Video window shows No Trial Planned.

Show/hide body points and other track features
1. Click the Show/Hide button on the toolbar and select Detection Features.
2. Select the features you want to display and their colors and opacity.
3. Adjust the Line thickness and the Dot size. Check the result in the video 

window, then click Close.
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When you are in the Manual Scoring screen, you can only choose which 
body point to show and adjust the dot size.

Show/hide arenas and zones
1. Click the Show/Hide button on the toolbar and select Arena Features.
2. In the Arena Features window, select the Arena Features you want to 

display.
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In this example, the four quadrants of an open field have been selected for display.

The arenas and zones are highlighted in the colors selected in the currently active 
Arena Settings. If you want to change the color of a zone or arena, open those 
Arena Settings, and change the fill color.

Acquisition status
You can check the status of acquisition in the Video window: 
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▪ Trial number. Displayed as long as the recording starts. If you carry out 
batch acquisition, the remaining number of trials is shown in brackets. 

▪ Ready for start. Displayed until data recording starts.
▪ In progress. Displayed as long as recording lasts. This text is displayed if 

you selected to show the text features Per trial.
▪ Acquiring. Displayed as long as recording lasts. This text is displayed if you 

selected to show the text features Per arena.
▪ Timer. Displayed as long as recording lasts.
▪ No Trial Planned. Displayed when no trial is planned to the trial list. To 

acquire data, add a trial, or in the Trial List change the trial status.
▪ Starts in. Displayed only when you track live in a series of trials. It shows the 

time until acquisition of the next trial starts. 
▪ Recording video. Displayed when you record video with the option Save 

video only, track later selected.
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The Playback Control window
Show/hide the Playback Control window
Click the Show/Hide button on the toolbar and select Playback Control to show/
hide the Playback Control window.

Use the Playback Control to:

▪ Start and stop trials, and add/skip trials in your list. 
▪ Position video files on the frame you require (when you track from video 

files).

Playback functions
For the description of the playback control buttons, see Playback Control, 
Acquisition and Visualization.

NOTE  Clicking the playback control buttons does not result in acquiring data!

DDS (Detection determines speed)
Detection determines speed is only available if you track from video. When you 
select this option, during acquisition images from the video file are analyzed at the 
maximum speed that the processor can handle. EthoVision varies the speed 
depending on how much data it has to process at each frame.

We recommend to keep this option selected, so that video frames are not missed 
with high processor load.

IMPORTANT Do not select DDS when you score behaviors manually or determine 
thresholds.

Why use Detection determines speed?
▪ To track faster when EthoVision XT can process images at a speed higher 

than the regular playback speed.
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If you select this option, the program tracks at a speed higher than normal 
(1x). For example, when you use a fast detection method such as Gray 
scaling.

▪ To ensure that no sample is missed when tracking is very demanding.
If you select this option, when EthoVision cannot keep up with the regular 
playback speed it tracks at a speed lower than normal (1x) in order not to 
miss any sample. For example, when you track from high resolution video, 
in many arenas and with a high sample rate combined with a detection 
method that requires significant processor time.
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Analysis results and scoring pane

Show/hide the Analysis Results and Scoring pane
Click the Show/Hide button on the toolbar and select Analysis Results and 
Scoring.

IMPORTANT  You can reduce processor load, for example when tracking from many 
arenas, by closing the Analysis Results and Scoring pane. To do so, from the Show/
Hide menu deselect Analysis Results and Scoring.

Trial Status tab
Shows information about the current Trial (to be acquired or being acquired). If no 
trials are planned, the Trial column says No Trial planned.

▪ Fill color (only visible when tracking multiple subjects per arena). Shows 
the color associated with each subject. You can assign a new color in the 
Subject identification settings.

▪ Trial start. Shows the time the current trial has started. If the current trial 
has not started yet, Trial start shows '00:00:00'. 

▪ Acquisition start. Shows the time that tracking has started. If the current 
trial has not started yet, Acquisition start shows '00:00:00'.
If you track from video files, Trial start is the time that the video was 
recorded. Acquisition start is the Trial Start + the video time elapsed at the 
start of data recording. 

▪ Time acquiring. The time elapsed since the start of data recording for a 
subject in a specific arena. Time acquiring can differ per arena because Trial 
Control is applied in each arena independently.
The real time information is only available after you start the trial and until 
you stop it.

▪ Missed samples. The percentage and the number (in parentheses) of 
samples missed up to the current sample.
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▪ Interpolated samples. The percentage and number (in parentheses) of 
missing samples that were interpolated. 
This statistic is only available when in the Detection Settings under 
Smoothing the option Missing sample interpolation is On. See Dropped 
frames correction in Advanced detection settings: Smoothing

▪ Subject not found. The percentage and the number (in parentheses) of 
samples in which the subject was not found up to the current sample.

To adjust the warning color thresholds

When the values under Missed samples, Interpolated samples and Subject not 
found exceed a specific threshold, they are shown in red. This helps you monitoring 
the quality of tracking during acquisition.

To change a threshold, click the button under one of the headers.

Detection statistics after acquiring data

After acquisition you can view the proportion of missed samples and samples in 
which the subject was not found in different parts of the software.

▪ In the Trial list, click Show/Hide on the toolbar and select Variables and 
select Missed samples and/or Subject not found.

▪ In the Statistics and Charts screen, click Show/Hide on the toolbar and 
select Independent Variables and select Missed samples and/or Subject 
not found.

▪ In the Track Visualization or in the Heatmaps screen, click Show/Hide on 
the toolbar and select Layout. Under Available, drag Missed samples and/
or Subject not found to the On Columns or On Rows box.
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Independent Variables tab

The Independent Variables tab is a simplified version of the Trial List. It shows the 
user-defined independent variables and the Acquisition status for the acquired 
trials and the planned trials.

Row colors

▪ Before acquisition, the current trial (about to be acquired) is highlighted in 
green. Acquisition status says Ready to start.

▪ During acquisition, the current trial is highlighted in red. Acquisition status 
says Acquiring.

Dependent Variables tab

In the Dependent Variables tab you can view any dependent variable in real time 
during acquisition, for each subject and arena. By default, it shows the following 
variables: Velocity and Movement. 

To view more variables during a trial, see Choose a variable to view real-time.

IMPORTANT  Adding variables may reduce performance and increase missing 
samples. Select only the variables and its properties you are interested in. For 
example, if you are interested in monitoring the Immobile state during a Porsolt 
swim test, add the Mobility state variable, then select Immobile and deselect the 
other two states under Calculate for state in the Mobility State properties window.
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Manual Scoring tab

See Score behaviors manually during acquisition
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External Data

Main topics and tasks
▪ Introduction to External data  593
▪ Import external data in EthoVision XT  602
▪ Examples of import profiles  621
▪ Synchronization of tracking data and external data  635
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Introduction to External data
Learn about

▪ Work with external data
▪ Enable DAQ co-acquisition in EthoVision XT
▪ On-Off vs. Time Code (TCAP) synchronization signal
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Work with external data
External data types
You can import external data, like for example heart rate, EEG, GSR or accelerometer 
data into EthoVision XT and synchronize these data with the tracks. EthoVision XT 
can import data in ASCII format with a constant sample rate or a time stamp 
column in the file. 

NOTE  It is also possible to import European Data Format (EDF) Files, or BioSemi 
Data Format (BDF) files, which is the 24 bit version of EDF, into EthoVision XT. 
Import of EDF+ or BDF+ files, which may contain annotations, is not supported. 

Procedure
Working with external data in EthoVision XT involves some basic steps:

1. When possible, connect the EthoVision XT computer to one of the input 
channels of the external DAQ system. This allows you to synchronize 
EthoVision XT and the external data automatically. Contact Noldus for a 
cable that serves this function. See Connect EthoVision XT to the DAQ 
system

2. Enable DAQ co-acquisition in EthoVision XT. 
3. Acquire the trials, while the DAQ system acquires its own data. 

See Acquire a trial live for the general procedure.

4. After data acquisition, import the external data file(s) and assign them to a 
Trial, Arena, or Subject. 
See Import a complete external data file at once

Tracking data and external data are automatically synchronized in case you 
used DAQ co-acquisition. If not, you can use manual synchronization.

5. Visualize external data together with video and acquired tracks.

Notes
▪ The external data are saved on the computer dedicated to the DAQ device, 

not on the EthoVision XT computer.
▪ If you want to visualize tracks according to the values of a dependent 

variable, make sure that you specify that dependent variable in the active 
Analysis profile. To edit a profile, click it in the Experiment Explorer and 
make the necessary changes. 
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Connect EthoVision XT to the DAQ 
system
Aim
To ensure that EthoVision XT sends a synchronization signal to the DAQ system 
during data acquisition.

Prerequisites
You must have:

▪ A free USB port on your EthoVision XT computer.
▪ A USB-to-Serial (COM) converter.

▪ A sync cable from Noldus. This cable has connectors that depend on the 
DAQ system you have. Contact Noldus to purchase one.

OPTIONAL  Connect the two computers through a local network for easy data 
transfer from the DAQ system to the EthoVision XT computer. See Import external 
data: General information
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Connection scheme

Notes
▪ It is also possible to ensure synchronicity between EthoVision XT and the 

DSI Ponemah system without a sync signal. See Sync the computer clocks 
for EthoVision XT and DSI Ponemah

See also

▪ Enable DAQ co-acquisition in EthoVision XT
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Enable DAQ co-acquisition in EthoVision 
XT
Aim
To program EthoVision XT to send a synchronization signal to the external DAQ 
system.

Procedure
1. In EthoVision XT, open your experiment.
2. Choose Setup > Experiment Settings.
3. Under Video Source, choose Live tracking and select the Enable DAQ co-

acquisition box. Click the Edit button.
4. Under Predefined Settings, select the item corresponding to your DAQ 

system, or create a new one (see below).

Notes
▪ When you have acquired data, the Experiment Settings are read-only 

(settings are grayed out).
▪ You can only co-acquire external data when you carry out Live Tracking.

To create a new DAQ Hardware Settings profile
1. In the DAQ Hardware Settings window, click the New button.

2. A new field appears at the bottom of the list of predefined profiles. Type a 
name for the new profile.
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3. Under Output device, select one of the COM ports from the list. This COM 
port is used to connect the EthoVision XT computer to the DAQ system.
Click the Check Status button to check the availability of the port. 

It may be that either all COM ports on your PC are occupied, or your PC 
does not have a COM port. In those cases, contact Noldus for a USB-to-
COM converter.

4. Under Signal Type, select:
▪ On-Off if the external signals are sampled at low rate (less than 10 Hz) 

and without interruption (thus no scheduled sampling).
▪ Time Code (TCAP) in all other cases. Enter the Sample rate (in Hz) with 

which you sample data on your DAQ system. 
If you want to sample data at a rate higher than 2 KHz, set 2000 Hz. 

Depending on the Sample rate, the Minimal sampling time changes; this 
indicates the minimum time the data should be acquired on the DAQ 
system for synchronization to work properly.

5. Click OK.

To delete a DAQ Hardware Settings Profile
In the DAQ Hardware Settings window, select a Profile and click Delete or press 
Delete.
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To change the order of DAQ Hardware Settings Profiles
In the DAQ Hardware Settings window, select a Profile and click the Move Up / 
Move Down button or press ALT-arrow down / ALT-arrow up on your keyboard.

To add a description to a DAQ Hardware Settings Profile
In the DAQ Hardware Settings window, select a Profile, click in the Description box 
and type in text. Click on another Profile and click Yes to save the Description.

See also

▪ On-Off vs. Time Code (TCAP) synchronization signal
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On-Off vs. Time Code (TCAP) 
synchronization signal
In order to synchronize external data and EthoVision XT tracking data, you can send 
out a synchronization signal with time information (SyncOut) from the EthoVision 
XT computer to the DAQ device. This signal is sampled by the DAQ computer and 
after acquisition imported into the EthoVision computer as a home coming signal 
where it is compared with the original synchronization signal. 

On-Off and Time Code (TCAP: Time Code Auxiliary Parity) are two types of signals 
that reflect two ways of synchronizing external data (for example, heart rate) with 
tracking data.

On-Off
This signal is sent from EthoVision XT to the DAQ device shortly after a trial is 
started and stopped. Note that the On and Off signal are not sent at the exact 
moments of trial start and stop. The difference in offset between the 
synchronization signal and reference signal is calculated at the start and at the end 
of the recording. In order for synchronization to be successful, the DAQ recording 
must start before starting acquisition in EthoVision XT, and end after stopping 
acquisition in EthoVision XT.

A dialog in EthoVision XT informs you to start and stop data acquisition on your 
DAQ device. Furthermore, the DAQ recording should not be stopped during 
acquisition in EthoVision XT, which means that you cannot use the On-Off signal 
when performing scheduled sampling (that is, starting and stopping DAQ 
acquisition at regular intervals).
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The relationship between Trial acquisition, the On-Off synchronization signal from 
EthoVision XT and acquisition on the external DAQ system.

Time Code
A series of bits called a frame is sent from the EthoVision XT computer to the 
external DAQ device. Each frame contains the current date and time and additional 
information. The difference in offset between the synchronization signal and the 
reference copy is calculated for several time points during acquisition (by default, 
for 10 time points), while the gain is calculated through regression analysis of offset 
values obtained at different points in time (that is, different frames). Therefore, 
synchronization of tracking and external data is more accurate using the Time Code 
signal because it is done for more than two offset points and not just at the start 
and stop of acquisition as with the On-Off signal.

The relationship between Trial acquisition, the Time Code synchronization signal 
from EthoVision XT and acquisition on the external DAQ system.
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Import external data in EthoVision XT
Learn about

▪ Import external data: General information

What do you want to do?
▪ Import a complete external data file at once
▪ Import one or more specific data sets
▪ Create a new custom import profile
▪ Edit a custom import profile

See also

▪ Examples of import profiles
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Import external data: General information
External data files
To import external data you need to link it to an acquired Trial, an Arena or a 
Subject. 

You can import external data with the following characteristics:

▪ It is stored in ASCII format.
▪ The sample rate is constant, or when it is not constant, the data file contains 

time stamps.
▪ The file contains at least 15 data lines. It preferably contains a header with 

information describing the data sets. This information about the data set, 
such as data set name, date and time information, sample rate, is typically 
stored in the header section of a DAQ export file

▪ You can import European Data Format (EDF) or BioSemi Data Format (BDF) 
data files. Import of EDF+ or BDF+ files is not supported.

Notes

▪ It is not necessary that external data are recorded when you do the 
tracking; for example, when you track from video files. However, you must 
ensure synchronization between the external data and the video file.

▪ You can only import external data into an acquired Trial. This is indicated in 
the Trial List by ‘Acquired’ in the System Variable Status column.

Data sets within a file
An external data file can contain one or more data sets. For example, you test three 
rats, each in its own arena, and for each rat you have acquired ECG data. The 
resulting external data file contains three ECG data sets. In EthoVision XT you now 
have the option:

▪ to link the complete external data file (i.e. all three data sets at once) to a 
Trial, Arena, or Subject.

▪ to link one or more data sets from an external data file to a Trial, Arena, or 
Subject.
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Import a complete external data file at 
once
To import an external data file

1. Choose Setup > Trial List.
2. Click the row for the trial you want to import the data to.
3. Do one of the following:

To import data to a specific arena or subject within that trial, right-click that 
arena or subject and select Import External Data.

4. Next, you can either:
▪ Select a predefined Import Profile. Select a predefined Import Profile 

from the list under Files of type. Next, locate the external data file, 
select the filename and click Open. 

▪ Create a new custom import profile.

Notes
▪ To import specific data sets in an external data file in the Trial List click the 

Import External Data button. See Import one or more specific data sets

See also

▪ Create a new custom import profile
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Import one or more specific data sets
1. Choose Setup > Import External Data, or in the Trial List, click the Import 

External Data button.

2. Select a predefined Import profile from the drop-down list under Files of 
type. Next, locate the external data file, select the filename and click Open. 
A second Import External Data window shows one or more Data Set Names. 
The Trial list also appears.

3. To add external data to a Trial, select on or more Data Set rows and drag-
and-drop it to the Trial list; you can choose to drag-and-drop external data 
to a Trial, Arena or a Subject (see the figure below).
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4. Click the Import button in the Import External Data window to finish 
import.

EthoVision XT offers predefined Import profiles for a number of export formats 
from DAQ systems. If your file type is not in the list, create a Custom Import Profile.
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Create a new custom import profile
Aim
To import external data as ASCII files when EthoVision XT does not have a 
predefined import profile (see step 4 in Import a complete external data file at 
once). With an import profile you create a template based on the structure of the 
external data file.

Prerequisites
▪ Your license for EthoVision XT includes the External Data Module
▪ You exported your external data as ASCII files.

Procedure
1. Choose Setup > Import External Data.
2. Click the Custom Import Profiles button and then the New button.
3. Browse to the external data file.
4. Build the import profile by specifying the structure of the data file. This is 

done by dragging and dropping cells. To make a selection undone, select 
the cell to which content was dropped and press Delete. 
Follow the procedure in these sections:

1 - Header

2 - Delimiters

3 - Time information

4 - Data

5. Import a text file with the new import profile
The numbers in this figure correspond with the numbers of the headers in the text 
below. 
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1 - Header
EthoVision XT usually automatically detects header and data information in the file. 
If not, specify which part of the data file contains the header. Choose an option 
from the Header detection list:

▪ Automatic (default). EthoVision XT is set to automatically detect the 
header and data sections in the data file. Choose one of the other options if 
automatic header detection does not work. 
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▪ Specify tag. Select this option if the data file has a variable number of 
header lines and the header always ends with the same word. Specify the 
phrase (with either nominal or numerical information) that indicates the 
end of the header part of the file. If necessary, also specify the number of 
rows between the header line that contains this phrase and the data.
EXAMPLE  The header always ends with a line containing the text [Data]. 
After the line with this text there is always an empty line before the data 
starts. Enter [Data] in the End tag field and 1 in the Extra rows field.

▪ Specify row number. If the data file always has the same number of rows 
in the header, select this option and specify the number of header rows.

2 - Delimiters
EthoVision XT uses the comma as the default delimiter to separate text in the 
header and data sets. However, the data file may have other delimiters. If this is the 
case, select the correct ones from the Select header delimiters and Select data 
delimiters lists. You can also select multiple delimiters. 

Some DAQ software enables you to select the type of delimiter when saving the 
DAQ data to an ASCII export-file. In that case you select the same delimiter in the 
File content section of the Profile Definition window. A comma or semicolon are 
advised as delimiters.

3 - Time information
Specify which cell or column contains the time information. This can be a column 
with time stamps, a cell with the sample rate, or a cell with the sample interval, 
which is the time between samples. Drag and drop the cell or column with time 
information to the appropriate field in the Profile definition section. 

1. Sample rate. If the header contains a cell with the sample rate, select the 
Sample rate button under Timing based on in the Profile definition 
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section. Drag the cell with the sample rate to the Sample rate box and 
select the appropriate unit (Hz or kHz) from the list.

2. Sample interval. If the header contains a cell with the sample interval, 
select the Sample interval button in the Profile definition section. Drag 
the cell with the sample interval to the Sample interval box. Select the unit 
of time from the list.
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3. Time series. If the header does not contain information on sample rate, 
select the Time series button under Timing based on. Under Data sets in 
the File content section, select the column with time stamps and drag this 
to the Time series box. The column with time stamps now appears grayed. 
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The Select Time Format window opens. If the time matches one of the 
predefined formats, EthoVision XT automatically selects one. Converted 
time shows the conversion of the text to time and Conversion is OK. 

You can also define your own format by typing an H for each number 
representing 'hour', an m for 'minute', an s for second and a f for each 
decimal of a second (see the next picture). 
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Under Import Time, select one of the options. 

▪ Relative to time zero. Suppose the first row in the imported external 
data set has time 00:00:05. When the option Relative to time zero is 
selected, the time stamp of the first row of the imported data set will 
remain 00:00:05.

▪ Relative to the time of the first data line. Suppose the data set you 
want to import starts at 14:28:00 and has samples every 5 seconds. 
With the option Relative to the time of the first data line, the first row 
of the imported data will get the time stamp 00:00:00. The second row 
will have time stamp 00:00:05. The options under Import Time are 
grayed out when your time stamps contain the date the file was 
created. In this case the option Relative to time zero is used.

▪ Select the option Allow timestamps to be non equidistant when the 
time stamps do not represent regular intervals. For example, 0, 490, 
572, etc...

4 - Data
Under Data definition in the Profile definition section there are two parts. The lilac 
part is labeled Header Data where you drag cells to from the lilac Header section. 
The green part is labeled Raw data where you drag Data sets to from the green 
cells in the Data sets section.
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1. Drag the first column under Data Sets to the first empty cell in the Raw 
data - Data Set column. As a result, the letter of the original column 
appears in the cell and the column in the Data Sets section is grayed.

2. Now locate the data set name, the unit and, optionally, other information in 
the header and drag those cells to the Header data cells in the same row.
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If you drag and drop the Start Date and/or Start Time a window opens in 
which you can define the format. Accept the default format, or see step 3 of 
3 - Time information for the procedure to change it. 

Multiple data sets

1. Follow the procedure above to define the next dataset. Once two datasets 
are defined, the Validity Check button becomes active. 

2. Click this button. EthoVision XT now automatically fills the other rows in the 
Data definition field.
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3. Check that the correct columns are selected.

How the Validity check is applied

EthoVision XT assumes that your header and data set info are ordered in a regular 
way in your external data file (e.g., left-right, with/without empty cells in between).

EXAMPLE  Your external data file contains four Data Sets in columns A, C, E and G. 
Columns B, D, F are empty. When you drag columns A and C to the first two rows in 
the Raw Data column and next click the Validity Check button, EthoVision XT 
automatically assigns columns E and G to rows 3 and 4, thereby taking into account 
the empty columns between Data Sets. 

The distance between the columns should be the same. For example, dropping 
columns A and C and clicking Validity Check works. The columns E, G, I, K etc are 
automatically added to the other rows. Dropping columns A and B, and clicking 
Validity Check also works. All other columns are then automatically added to the 
other rows. However, dropping A, B, and D and clicking Validity Check does not 
work, because there is an empty column between B en D, but not between A and B.   
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Data sets with missing samples

If your data set contains missing samples indicated by non-numeric symbols, 
specify this symbol and select the Treat as number checkbox.

Alternatively, click the button next to the Treat at number field to select one or 
more predefined symbols. To select a specific text, click <User Defined>, click OK 
and enter this text after a comma (,). 

If text is identified by a character, select this from the Text qualifier list.

Save the import profile
When all the information is in the Import Profile Definition sheet, click the Save 
As button and give the profile a name.

Import a text file with the new import profile
The newly created import profiles is now in the Files of Type list.
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1. Locate the external data file and select the filename. 
2. Click Open. 

Notes
▪ A missing sample is converted to a ‘zero’. As a result, it is plotted as a ‘zero’ 

in the Visualization.
▪ The import profile is stored with the extension *.eip.
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Edit a custom import profile
If you want to import an external data file that is very similar to, but not exactly the 
same as, another data file for which you already have an Import profile, you can edit 
the existing Import profile.

1. In the Import External Data window, click Custom Import Profiles.
2. Select the Import Profile from the list in the Import Profiles window and 

click Edit.

In the Select Sample File group you see the original sample file behind 
Profile based on.

3. Click Browse in the Select Sample File group to select the new external 
data file and click Open.

4. Follow the instructions 4-8 under Create a new custom import profile.
5. Click Save Profile As when you are finished filling in the Data definition 

sheet.
6. Type in the name for the Import Profile and click OK. Close the Profile 

Definition window.
7. Close the Import Profiles window. Make sure you select the right Import 

Profile.
8. Select the external data file and click Open to finish import.
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Note
▪ You cannot edit the import profile for European Data Format files. 
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Examples of import profiles
DAQ systems/software

▪ DSI Ponemah 6.40 and DSI DataQuest A.R.T. 4.3
▪ BIOPAC AcqKnowledge 4.4
▪ Doric
▪ Polar Precision Performance 4.0
▪ European Data Format files
▪ Noldus UltraVox XT 3
621



DSI
DSI Ponemah 6.40
The following picture shows the import profile for Ponemah 6.40. With this profile 
you can import one of more data columns.

▪ Note that the second column of the data file (B) contain time stamps and 
must be dragged to the Time series field.

▪ IMPORTANT  Import of data from Ponemah 6.40 to EthoVision XT works 
when the time format in Windows is set without AM/PM. When exported, 
the time should be in a format like 10:57:55.000.

▪ To export the data in Ponemah, choose Action > Start Review. Select all 
signals you wan to export, and the time range. In the graph window, choose 
File > ASCII Output. Select the channels and the data range. Select the 
622



option to Include Time in Output. Next, click Convert to ASCII. The file is 
ready for import into EthoVision XT.

DSI DataQuest A.R.T. 4.3
For DataQuest, the profile specifies that the first column of the data file (A in Data 
Sets) contains the time stamps. Column B contains the sync data, and the remaining 
columns C-G contain activity and physiological data.
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BIOPAC
For the BIOPAC system, AcqKnowledge is the software used to record, analyze 
and export the data. This is an example of an export file of AcqKnowledge 5. The 
file contains information about the sample interval. In this case the sample interval 
is 2 ms.

The following picture shows the Import Profile Definition window in EthoVision XT 
for a BIOPAC AcqKnowledge 5 file.
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The header contains information about the sample interval (milliseconds), and 
information about the channels. In this example, the ECG, heart rate, the R-R 
interval and R-peak height were measured.

The sample rate is calculated based on the sample interval. In this case the samples 
are taken at an interval of 2 milliseconds. This corresponds to a sample rate of 500 
Hz.
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Doric
Doric (*.doric) data files can be exported as CSV files to EthoVision XT.

The following figure shows an import profile for CSV files with multiple channels. 
The first column of the CSV includes the time stamps. The other columns contain 
data of the channels recorded. The arrows indicate where you need to drag the cell 
contents in the Header section and in the Data sets section in order to create a 
similar import profile.

See also

For more information, see https://neuro.doriclenses.com/
626

https://neuro.doriclenses.com/


Polar
The Polar system is used for monitoring heart rate. After data acquisition the data 
can be transferred to a computer (not available with all Polar systems). The data is 
stored in a HRM file. These HRM files can be directly imported into EthoVision XT. 

EthoVision XT cannot be connected to the Polar system. Therefore, Polar heart rate 
data and EthoVision tracking data always need to be synchronized manually.

To facilitate manual synchronization of Polar heart rate data and tracking data you 
can do the following:

▪ If the Polar software is running on the EthoVision XT computer: Synchronize 
the Polar watch with the clock of the EthoVision XT computer.
Please see the Polar Precision Performance software Reference Manual for a 
description of how to do this. Please note that this is not possible for all 
Polar systems.

▪ If the Polar software is not running on the EthoVision XT computer: 
Synchronize the EthoVision XT computer and the Polar computer. 
Synchronize the Polar watch with the clock of the Polar computer.

The settings on the Polar receiver determine what header information is written to 
the HRM file. Please refer to you Polar manual for a detailed description of the 
settings.

Below: An example of part of a Polar HRM file.
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The file header contains information about date and time, the length of the 
recording period (00:12:54:08) and the sample interval (5 sec). It also contains 
information about settings of the upper and lower limit of the heart rate.

Depending on the settings of the receiver, the HRM file can contain additional 
information. This does affect subsequent import of HRM files acquired with 
different type of receivers.

The HRData column show the mean heart rate (in beats per minute) over a 5-s 
period.

Polar Precision Performance 4.01 (no date - time)
This is an example of the Import Profile Definition window in EthoVision XT for the 
profile Polar Precision Performance 4.01 (no date - time) obtained with the Polar file 
described above.

Note that in the Data definition section the cells under Start Date and Start Time are 
empty, meaning that the import profile does not read date and time information in 
the Polar file.
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Polar Precision Performance 4.01
This is an example of the Import Profile Definition window in EthoVision XT for the 
profile Polar Precision Performance 4.01 obtained with the Polar file described 
above. This profile reads the date and time information contained in the export file 
header.

Note that in the Data definition section the cells under Start Date and Start Time 
contain the information read from the Header section (the corresponding cells in 
the Header section are grayed out). 
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Interbeat interval data
Interbeat interval data obtained with a Polar system have the same format as HRM 
data. However, the file does not contain the time stamps that EthoVision XT needs 
for time information. 
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UltraVox XT 3
Background information
Ultravox XT is software for analysis of ultrasound emitted by rodents and other 
animals. EthoVision XT can import Ultravox XT files (ETX) using a specific import 
profile.

The following picture shows an example of an ETX file for EthoVision XT 11 and 
later. The first column contains the time stamps in milliseconds. The other columns 
show 0 (not a call start) or 1 (call start time). The 0 in the row following a 1 marks 
the end of that call. Each column represents a call category (call name, or call 
name*pattern label). Note that the time stamps are not equidistant.

The UltraVox XT 3 import profile
The following figure shows an example of the Import Profile Definition window in 
EthoVision XT for the import profile of Ultravox XT 3.

In the Data definition section, the cells under Data Set Name contain the 
information read from the Header section (the corresponding cells in the Header 
section are grayed out). The cells in the Type column contain the call types and the 
green cells in the Data Set section contain the data sets.
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Install the UltraVox XT 3 import profile
If you do not see UltraVox XT 3 in the list of import profiles when you attempt to 
import the call data (that is, during Import a complete external data file at once), it 
may not be installed.

Install the import profile from the UltraVox XT installation USB Flash drive. 

1. Close EthoVision XT.
2. On the UltraVox XT 3 installation USB Flash drive, open the folder 

Extras\Import Profiles.
3. Double-click the file EthoVision XT 11 and Newer.bat. 
4. You should now see the UltraVox XT 3 import profile in the list. 
632



Notes
▪ The UltraVox XT 3 import profile is installed in the following folder:

C:\ProgramData\Noldus\Common\Profiles. 

It includes the folder UltraVox XT 3 and a file, UltraVox XT 3.eip.

▪ You can find the UltraVox XT installation files on my.noldus.com. Log in, and 
locate Downloads > UltraVox XT > Current Version.
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European Data Format files
European Data Format (EDF) files and BioSemi Data Format (BDF) files are binary 
files. EDF files are 16 bit and BDF files are 24 bit. The import profile for EDF and BDF 
files cannot be edited, as for BIOPAC and other import profiles.

Simply import the files by selecting the European Data Format in the import 
window.

Notes
▪ Import of EDF+ and BDF+ files, which may contain annotations, is not 

supported.
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Synchronization of tracking data and 
external data
What do you want to do?

▪ Synchronize data automatically
▪ Synchronize data manually at import
▪ Synchronize data manually after import

Learn about
▪ Other ways to ensure synchronicity between video and data streams
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Synchronize data automatically
Aim
To synchronize EthoVision XT data and external data using the synchronization 
signal sent to the external DAQ system during live tracking.

Procedure
1. Import the external data that was simultaneously acquired during live 

tracking into EthoVision XT.
2. In the Import External Data window, you see:

one or more 'Normal Data Sets' (indicated by a diagram icon).

one or more 'Sync Data Sets' (indicated by a clock icon).

The Link Variable cell for a Sync Data Set shows which Trial was acquired 
simultaneously with the external data.

A Sync Data Set is automatically detected when you use the Time Code 
(TCAP) synchronization signal. When you use the On-Off signal, it may be 
necessary to select Sync Data Set from the context menu to tell EthoVision 
XT that the data set contains the synchronization signal:

In the Import External Data window, right-click the Data Set that you want 
to change to Sync Data Set and select Sync Data Set.

3. If necessary, adjust the Synchronization Settings (this step) or proceed to 
step 4.
Click the Synchronization Settings button to open the Synchronization 
Settings window. Here you can set values for the following parameters that 
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determine how the information from the synchronization signal is extracted 
from the imported external data file (default values in brackets):

▪ Number of offset values (10) is the number time points in the 
synchronization signal used to calculate offset points. This only applies 
to the Time Code signal. The offset values are used for the calculation 
of average offset and gain. A higher value increases the accuracy of 
synchronization, but also increases calculation time.

▪ Smoothing factor (1) is the number of sample points over which an 
average signal level is calculated. A higher value reduces spikes on the 
signal, but also reduces the time accuracy of the synchronization. The 
Smoothing Factor is used for both On-Off and Time Code signal.

▪ Signal-to-noise-ratio (50) determines the tolerance for detecting 
high-low signal transitions. A higher value increases this tolerance, but 
also increases the chance of detecting false transitions.

▪ Number of samples prescan TCAP (180000) is the maximum number 
of sample points used for auto-detection of a Time Code signal in the 
DAQ samples. For example, 180 seconds at 1 kHz or 30 minutes at 100 
Hz. This setting only applies when you started your DAQ system before 
you started tracking in EthoVision XT.

Click in the boxes to set a value for each of the parameters. Click Defaults if 
you want to return to the default values or click OK to finish.

4. In the Import External Data window, select one or more Data Sets you want 
to link, click on one of the Data Sets with the left mouse-button, keep the 
left mouse-button pressed and link the Data Sets with a drag-and-drop 
action to the corresponding Trial, Arena or Subject.

5. Click Import to finish linking the Data Sets.

Notes
▪ The Synchronization Settings button in the Import External Data window 

is only available if Enable DAQ co-acquisition is selected in the Experiment 
Settings. 
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▪ The information in the synchronization signal is sampled by the DAQ 
system. During import into EthoVision XT some digital signal processing 
takes place to deal with noise, signal distortion, spikes etc. This processing 
is determined by the Synchronization Settings above.

See also

▪ Enable DAQ co-acquisition in EthoVision XT
▪ Connect EthoVision XT to the DAQ system
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Synchronize data manually at import
Aim
To synchronize the tracking data and the external data if it was not possible to 
connect the EthoVision XT computer and the external DAQ system.

You can manually synchronize external and tracking data during import of external 
data into EthoVision XT:

▪ Shift the offset. This means that the complete external Data Set is shifted in 
time. The duration of the external Data Set remains unchanged. Shifting is 
done by changing the Start Date/Time of a Data Set.

▪ Stretch or shrink the external data set. This means that the duration of the 
external data set is changed to match the duration of an acquired Trial. 
Stretching the external data set is done by changing the Start Date/Time 
and/or the Stop Date/Time. This way you can either stretch or shrink the 
duration of the data set.

Manual synchronization of external data and tracking data is accurate to within one 
millisecond. However, note that the sample rate of EthoVision XT, and therefore the 
resolution of the derived data, can never be higher than the video frame rate. 

When do I need to Shift the offset?
For example, you started acquisition on your DAQ system 10 seconds after you 
started acquisition in EthoVision XT. During import, shift your external data set 10 
seconds to match the offset of the Trial.

When do I need to Stretch/Shrink?
You need stretching/shrinking in the scenario that you carry out acquisition during 
a prolonged period of time during which the clocks of the EthoVision XT computer 
and the DAQ computer start running 'out of sync' (you started with synchronized 
clocks (see below how to synchronize computer clocks).

EXAMPLE  You carry out tracking for 24 hours and after this period you notice that 
the DAQ computer is 10 seconds ahead of the EthoVision XT computer. This means 
you need to shrink the external data set by changing the Stop Time of the data set 
to 10 seconds earlier.
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To facilitate manual synchronization
You can facilitate manual synchronization by synchronizing the clock of the 
EthoVision computer and the computer on which the external DAQ system is 
running, before acquisition. You can use one of the following methods:

▪ If the computers are situated next to each other, double-click the clock in 
the taskbar at the bottom of the screen on both computers. In the Date & 
Time tab, set both clocks to the same time.

▪ In all cases: use an online clock, when connected to the Internet, to set both 
clocks to the same time (see description above); or use NetTime, a simple 
Network Time Protocol (SNTP).

If, for some reason, it is not possible to synchronize the computer clocks there is a 
more advanced method to facilitate manual synchronization. This method only 
works when the external data file contains information about date and time of 
acquisition.

1. Acquire tracking data in EthoVision XT and external data on the DAQ 
system and make sure on both systems a synchronization event is recorded.
For example, you can use a relay to create a peak on your DAQ system and 
simultaneously switch on a light which is visible in the video.

2. Import the external data into EthoVision XT.
3. Visualize the data by choosing Analysis > Results > Plot Integrated Data. 

Go to the position in the video where the swiping action occurs. Note down 
the time stamp.

4. In the external data window, move the hairline to the position where the 
peak, caused by the swiping action, occurs. Note down the corresponding 
time.

EXAMPLE  The swiping action in the video occurred at 1.01. The 
corresponding peak in the external data occurred at 0.85 in the external 
data plot, so 16 seconds earlier.

5. In the Trial list, remove the external data. To do so, select the columns that 
contain the external data sets, right-click and select Delete Variable.
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6. Change the start time of the external data file by doing one of the 
following: 
▪ Open the external data file (for example, with Notepad) and change the 

start time.
▪ Import the external data file. In the Import External Data window, you 

can change the start time of the external data set (see below).
EXAMPLE  The difference in offset was 16 seconds (with the external data 
starting earlier than the tracking data). This means that the start time of the 
external data set should be set to 16 seconds later.

7. If you have edited the external data file, re-import it into EthoVision XT.
Manual synchronization of tracking data and external data is accurate to within one 
millisecond.

To shift an external data set
1. Import the external data that was simultaneously acquired during live 

tracking into EthoVision XT.
2. In the Import External Data window, double-click the Start Date/Time cell of 

the external data set you want to shift.
3. In this cell, click the year, month, day, hours, minutes, seconds or 

milliseconds and change them by using the arrow-up/arrow-down on your 
keyboard, the up/down arrow at the right side of the cell or just type in the 
desired value.
When you change the Start Date/Time of a Data Set, the Stop Date/Time 
also changes. As a result the duration remains the same.

4. Finish import.

To stretch/shrink an external data set
Stretching or shrinking can be used in the unlikely case that during acquisition the 
clock of the external DAQ system starts running out of sync with the clock of the 
EthoVision computer. This probably only occurs when live tracking is performed for 
a prolonged period of time. For example, in EthoVision XT, the clock time is 
determined by the camera frame rate. If the camera frame rate is not accurate, for 
example when a low-end consumer model is used, the time stamps in EthoVision 
gradually become out of sync with the DAQ computer clock. Then you need to 
manually increase or decrease the duration of the external data set.
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1. Import the external data that was simultaneously acquired during live 
tracking into EthoVision XT.
Shift the external data set if necessary (see above).

2. To stretch the Import External Data window, double-click the Stop Date/
Time cell of the external data set you want to stretch.

3. In this cell, click the year, month, day, hours, minutes, seconds or 
milliseconds and change them by using the arrow-up on your keyboard or 
the up-arrow at the right of the cell.
You can shorten the external data set, by changing the Stop Date/Time to 
earlier.

4. Finish import.
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Synchronize data manually after import
Aim
To adjust the offset between external data and video/track data.

NOTE  You change the offset of the original signal. The offset is automatically 
applied to all the EthoVision XT variables derived from that signal. Choose Analysis 
> Results > Integrated Visualization.

Procedure
1. From the lists available on the toolbar, choose the Track smoothing profile, 

the Data profile, the Analysis profile and the trial to visualize.
▪ Make sure that the signals are well visible; zoom in/out if necessary.
▪ If you want to re-synchronize using an event visible in a specific video 

frame, position the video to that frame.
2. Click the External data synchronization button on the toolbar, or choose 

Show/Hide > External data synchronization.

If no original signal is displayed in a chart, EthoVision asks you to select the 
original signal for synchronization.

Take note of the original start and top time in the Synchronize external data 
window. If you change the offset (next step) and click OK, the start/stop 
times are overwritten and cannot be recovered.
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3. You can synchronize data in two ways:
▪ In the Synchronize external data window, enter the new Start date and 

time and the Stop date and time for the chosen signal.

▪ In the plot area, hover the mouse over the original signal and drag to 
the position you require.

While you drag the mouse, the time plot of the original signal is shifted 
to the left or to the right. The Synchronize external data window shows 
the new Start and Stop time of the original signal. Release the mouse 
button when ready.
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4. Select the option Apply synchronization to all signals originating from 
the same data file if you also want to apply that offset to the EthoVision 
XT variables derived from the other signals imported from the same data 
file.
Make sure to keep this option selected when you import data sets from the 
same data file (for example, call data imported from UltraVox XT 3), and you 
want to maintain the original offset for all those data sets.

5. When ready, click OK.

Notes
▪ The shift in the offset is also applied to signals derived from the original 

signal, which are not currently visualized.
▪ After clicking OK, the shift in offset cannot be undone! To restore the 

original offset you must know the original Start and top time and enter 
them in the Synchronize external data window.

▪ To stretch the data in time, enter new values for Start and Stop time in such 
a way that the duration of the data set is longer than the original. First enter 
Start time, then Stop time.

▪ To shrink the data in time, enter new values for Start and Stop time in such a 
way that the duration of the data set is shorter than the original. First enter 
Start time, then Stop time.

▪ If your data plots include EthoVision XT variables derived from signals other 
than the one you synchronize, these are not synchronized automatically, 
unless the original signals come from the same file and you select Apply 
synchronization to all signals originating from the same data file. 
In all other cases, to synchronize those variables, open the signal they are 
derived from, and repeat the procedure above for that signal.

▪ Re-synchronization may affect your data selection when this contains 
Nesting functions based on those external data. For example, your Data 
profile contains a Nesting function based on Temperature state, which 
selects the intervals when Temperature > 30 ºC. If you re-synchronize 
Temperature and Temperature state, then also the intervals based on 
Temperature state will shift accordingly. Plot the data to check the changes.

▪ To undo the changes and return to the current offset between data sets, 
click Reset in the Synchronize external data window.
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If you synchronize external data at least once, re-opening the Synchronize 
external data window and clicking Reset does not restore the offset when 
you imported the data. It simply restores the last saved offset.
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Other ways to ensure synchronicity 
between video and data streams
Aim
Whenever you want to ensure high synchronicity between your video and the 
external data streams, for example EMG, this topic describes the possible solutions. 

This topic applies to Basler digital cameras.

Method 1 - Send a signal at every video frame
Many Basler digital cameras including the acA1300-60gm GigE camera have a 6-pin 
I/O connector on the back.

The pin number 2 is for input (named Line1 in Pylon Viewer), while pin number 4 is 
for output (Out1 in Pylon Viewer). You can connect pin 4 to a channel of the DAQ 
system that reads the time that the video frame is sent out.

NOTE  Which pin number serves a specific function may vary depending on the 
camera model. Please refer to the camera documentation.

1. Set the camera for example to free-running at 60 fps and get an electrical 
signal on the camera output Out1 pin when the camera makes a new 
frame. Settings can be made using the Pylon Viewer application. For details, 
see the Pylon Viewer manual and the camera manual.

2. Connect the camera output to the data recording channel. This way you 
know down to microseconds accuracy when the camera creates a video 
frame.
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Method 2 - Send a TTL pulse to the DAQ system
For this you need a USB-IO box and the Trial and Hardware Control add-on module.

1. Connect a TTL port of the USB/IO box to one of the channels of the DAQ 
system. For this you need a cable with a RJ45 connector at the end of the 
USB-IO box and a connector at the other end that matches the DAQ 
system.

2. In the Trial Control Settings of EthoVision XT, make a sub-rule with an 
action on the chosen TTL port that sends a pulse of 1 second at regular 
intervals, for example every 5 seconds.

3. During the trial, the pulses are recorded by the DAQ systems.
For more information:

▪ The chapter Experiments with Calcium Imaging in the EthoVision XT 18 - 
Application Manual, which includes an example with the Inscopix nVoke 
system.

▪ The EthoVision XT 18 - Trial and Hardware Control - Reference Manual.
See Manuals

Note
▪ To connect the camera to a DAQ system, you can use the standard cable 

available from Basler, or make your own using a Hirose connector HR10-7P-
6S(73).
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Sync the computer clocks for EthoVision 
XT and DSI Ponemah
Aim
To ensure high synchronicity between EthoVision XT data and physiological data 
collected with DSI Ponemah.

Background information
Synchronization between the EthoVision XT system and the DSI Ponemah system is 
based on a Network Time Protocol (NTP), a networking protocol for computer clock 
synchronization.

https://en.wikipedia.org/wiki/Network_Time_Protocol

The NTP Time Server runs on the DSI Ponemah computer and acts as time 
reference. The NTP Client runs on the EthoVision XT and adjusts that PC’s clock time 
based on the NTP Time Server.

Prerequisites
▪ The NTP Server is already installed on the DSI Ponemah computer.
▪ You need two installation files: 

▪ ntp-time-server-monitor-104.exe (NTP Server Monitor) 
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▪ ntp-4.2.8p15-v2-win32-setup.exe (NTP Client).
Download the Time Server Monitor software from

https://www.meinbergglobal.com/english/sw/ntp-server-monitor.htm

Download the NTP Client for Windows from 

https://www.meinbergglobal.com/english/sw/ntp.htm#ntp_stable

Procedure 1 - DSI Ponemah
1. On the DSI computer, create the following folder structure:

C:

C:\NTP\

C:\NTP\ETC\

C:\NTP\Installation\

2. Copy the file ntp-time-server-monitor-104.exe to C:\NTP\Installation.
3. Double-click the file and follow the instructions.

As the Destination Folder, choose C:\NTP.

As the Select Program Manager Group, keep Meinberg selected.

Click Next> and continue installation.

4. When installation is done, a new icon NTP Time Server Monitor appears 
on the desktop.

5. Right-click on the icon and choose Run as administrator.
6. In the NTP Time Server Monitor window, click the NTP Status tab. You 

should see that a line highlighted in green. That indicates that the service is 
running correctly.

In the next steps you take note of the IP address of the DSI computer. Note 
that the DSI computer has two network cards; one is connected to the 
matrix (2.0) and the other one should be connected to the network which 
connects that computer to the EthoVision XT computer.

7. On the DSI computer, open the Network Connections.
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8. Locate the item that corresponds to the network port to be connected to 
the EthoVision XT computer. 
TIP  To find the correct port, temporarily disconnect the network cable from 
one of the network ports and check which item shows the message 
Network cable unplugged.

That helps you find which item corresponds to which network port.

9. Right-click the network adapter item and choose Status, then click Details.
10. Take note of the IP address next to IPv4 Address.

Procedure 2 - EthoVision XT
This procedure is meant to install the NTP Client on the computer which runs 
EthoVision XT. The NTP client adjusts the computer clock in such a way that it will 
be in sync with the clock of the NTP Server. This ensures that the system time of the 
EthoVision XT computer is in sync with the system time of the DSI computer.

1. On the EthoVision XT computer, create the following folder structure:
C:\NTP

C:\NTP\ETC

C:\NTP\ETC\ntp.conf

C:\NTP\Installation

C:\NTP\Installation\ntp-4.2.8p15-v2-win32-setup.exe
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C:\NTP\Installation\ntp-time-server-monitor-104.exe

2. Double-click ntp-4.2.8p15-v2-win32-setup.exe.
3. Choose C:\NTP as the installation folder. Click Next and under Choose 

Components keep the default settings.
4. Under Files have been installed, keep C:\NTP\etc\ntp.conf selected file. 

This is the file that you copied in the first step, and contains all the 
necessary settings, except for the IP address of the DSI computer. 
De-select Create an initial configuration file with the following 
settings.

5. Click Next and under Setting Up NTP Service, select Create and use a 
special NTP account (recommended). Leave all selections as they are.

6. Click Next and enter a name and password. Next, complete installation.
After this, the Service is installed and started automatically. If the service 
does not start after the installation, because you used an existing network 
account, do the following: (1) Start Services in Windows (see 
Administrative Tools in the Windows Control Panel). (2) Select the Network 
Time Protocol Daemon service. (3) Change the Logon properties to the 
desired account (when you do that, the account will be given services 
rights). (4) Start the Service.

7. On the EthoVision XT computer, double-click the file ntp-time-server-
monitor-104.exe (for details see in Procedure 1 above).

8. When installation is done, run the NTP Time Server Monitor ad 
administrator and click the NTP Configuration file tab. There change the 
IP address by entering the one you found at the end of Procedure 1 (see 
also below).

Once ready, click the Save configuration button. At this point you will be 
asked to restart the service. TIP  You can always restart the service in the 
Windows Services.
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9. Click the NTP Status tab you should see the green line indicating that the 
service is running correctly.

10. Click the Statistic tab in the NTP Time Server Monitor window. A few 
minutes later you can view the statistics of the NTP synchronization.

11. To monitor the offset between the server and the client, under Available 
Logfiles click the browse button and in the folder C:\NTP\ETC\ select the 
loop statistics file. Typically, one file is generated per day. Click that file in 
the list to view the time-offset plot (in red). In most cases the offset, that is 
the difference in the clock time between the computers, is within one 
millisecond.

The NTP.CONF file
The ntp.conf file is a text file which contains the lines as shown below. You can open 
the file with the Windows Notepad.

Make sure that the IP address shown in bold is the IP address of the NTP Time 
Server, that is, your DSI-computer.

# NTP Network Time Protocol 
#IMPORTANT: WITH W7 MAKE SURE THE MONITOR RUNS AS ADMIN
# SET THIS IN THE PROPERTIES OF THE SHORTCUT
ignore_bigtimestep yes
# Use drift file 
driftfile "C:\NTP\etc\ntp.drift"
# your local system clock, could be used as a backup
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server 123.456.78.901 minpoll 4 maxpoll 4 burst iburst
# generate statistics
enable stats
statsdir "c:\NTP\etc"
statistics loopstats
# End of generated ntp.conf --- Please edit this to suite your needs

Notes
▪ When the two computers are in the same network domain, the domain 

administrator can use his/her existing account. However it is always 
possible to create a separate account as described above. The account must 
have the rights to start the NTP Service.

See also

▪ Import profiles for DSI physiological data
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Edit the Tracks

Main topics and tasks
▪ Introduction to editing tracks  656
▪ Customize your screen before editing  661
▪ Select the samples to edit  670
▪ Swap subjects and body points  680
▪ Delete, move and interpolate points  698
▪ Synchronize video and tracks  708
▪ Manage your edits  709
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Introduction to editing tracks
Learn about

▪ Why edit data?
▪ Important definitions in Track editing
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Why edit data?
Correcting tracking errors
Sometimes EthoVision XT tracks a reflection instead of the subject, or confuses the 
nose-point and tail-base. If that occurs, you can correct such errors in the Track 
Editor screen.

Examples
▪ Reflections in a water maze. EthoVision XT tracks accidentally a reflection 

next to the maze's border. There are “spikes” in the resulting track.

TIP  Make sure that light is not directed to the water surface. Watch the 
video tutorial Set up your test environment (Help > Video Tutorial).

▪ Nose-tail base swaps. In experiments set to nose-tail base tracking, the 
nose-point could be detected as the tail-base, and vice versa. In the last 
sample of the following track, the two body points are inverted. The Track 
Editor offers some ways to correct such swaps.

TIP  Try out the Deep learning tracking technique, which is superior at 
finding the subject’s nose-point.

Notes
▪ IMPORTANT  The Edit Tracks function in EthoVision XT is only intended for 

minor changes of a few points. If you have many errors, there is a problem 
with your experimental set-up, trial control or detection settings, and you 
should correct those problems rather than try to manipulate the raw data. 
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For example, if EthoVision XT tracks the arm of the operator who released 
the animal in the water maze, do one or both the following:
▪ In the Trial Control Settings, select to start tracking a few seconds after 

the subject is detected in the arena.
▪ In the Detection Settings, set a maximum subject size.
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Important definitions in Track editing
Sample vs. body point
A sample is the set of coordinates found at any sampling time. This means that:

▪ If your experiment is set to Only center-point detection, a sample is the 
subject's center point (one pair of X, Y coordinates).

▪ If your experiment is set to Center-point, nose-point and tail-base 
detection, a sample includes the center-point, nose-point and tail-base 
point (three pairs of X,Y coordinates). 

Within a sample, one or more points can be missing. Missing points are shown in a 
different color. 

See also

▪ Customize the missing sample points

Sample List
The Sample List is the list of coordinates of the subject’s body points and surface 
area, for each sample time. It is the actual raw data used in all the subsequent 
analysis functions (from Track Smoothing to Results).

To access the Sample List window, choose Acquisition > Edit Tracks. If the Sample 
List is not shown, choose Show/Hide > Sample List.

IMPORTANT  When you select samples in the Sample List, selected samples are 
highlighted in green, while the sample time that corresponds to the current video 
image is the one shown in blue in the Time column. These two selections are 
independent of each other, meaning that the video image may show a sample time 
that is not within the range selected. For example: 
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Save edits

You can save a copy of the track that includes the last edits. If you make changes 
after clicking Save, you can always go back to that copy if you are not satisfied with 
those changes.

See also

▪ Saving the track edits on page 710.
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Customize your screen before editing
What do you want to do?

▪ Visualize the tracks in the Track Editor screen
▪ Improve the readability of the tracks before editing
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Visualize the tracks in the Track Editor 
screen
To access the Track Editor screen, choose Acquisition > Edit Tracks, or in the 
Experiment Explorer, under Acquisition click Track Editor. 

In the track editing screen you can view the following objects.

▪ A. The track area, where you can view:
▪ The background. This can be of uniform color, the captured image of 

the arenas from the Arena Settings, or the content of the video file.
▪ Arenas and zones as overlay objects.
▪ Tracks (samples and paths).

▪ B. The toolbar, which contains tools for:
▪ selecting the trials to be edited.
▪ managing track edits and reverting to the original data if needed.
▪ selecting and editing data points.
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The toolbar also contains:

▪ The Show/Hide button for choosing the elements to display.
▪ C. The Playback Control window. 
▪ D. The Samples List window, listing the coordinates of the data points and 

the surface area of the subjects tracked.
▪ The Time column shows the time elapsed since the start of the trial. If 

data recording started after the start of the trial or ended before the 
end of the trial, the Samples List shows asterisks (*) for the samples not 
collected before the start and after the end of data recording. 

▪ The current time (also shown in the Playback Control window) is 
marked in blue.

▪ Missing points are listed with coordinates and surface area '-'. 
▪ E. The Track Plot Settings pane, for customizing the tracks and body points.

To display the Playback Control window, the Samples List and the Track Plot 
Settings pane, click the Show/Hide button on the toolbar and make sure they are 
selected.

To visualize the track you want to edit
Select the trial name from the list on the toolbar.

You can visualize one trial at a time. To switch from one trial to the previous or next, 
click the Previous Trial button or the Next Trial button on the toolbar, respectively.
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To play back tracks, use the buttons in the Playback Control window. Set the play 
back speed you require.

To visualize the whole tracks, clear the options under Filter in the Track Plot Settings 
pane and click the Jump to end button in the Playback Control window.

Colors
In the Colors tab of the Track Plot Settings pane, by default, Subject is selected 
under Level, that is, the track color does not change between tracks of the same 
subject. If you select Track, the color of tracks can change between tracks, according 
to the value of the variable selected under Variable for those tracks. 

See also

▪ Improve the readability of the tracks before editing
▪ Customize the track colors
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Improve the readability of the tracks 
before editing
Aim
To locate and edit the tracks more easily.

What do you want to do?
▪ Zoom in and out the track plots
▪ Visualize part of the track
▪ Visualize one sample every n-th
▪ Hide the tracks you do not need
▪ Hide unnecessary track features
▪ Adjust the line thickness and dot size
▪ Customize the missing sample points
▪ Customize the background

Zoom in and out the track plots

Click the Zoom in button  (Ctrl+.) or the Zoom out button  (Ctrl+.) on the 
toolbar, respectively.

If the data points are out of view after zooming in, use the scrollbars to find them.

Visualize part of the track
In the Track Plot Settings pane, click the Show/Hide tab, and under Filter select 
Last and enter the time interval. This way, only the last few seconds are visualized 
before the current sample.
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The current sample is highlighted in blue in the Samples List. 

Visualize one sample every n-th
This option is handy when you edit tracks with high sample rates or of slow-moving 
animals.

To show one sample every n-th, click the Show/Hide tab, and under Filter select 
Every and enter n in the corresponding field.

▪ If you select 0, only the current sample point is shown. 
▪ If you select 1, this is the same as not selecting the Last option (all samples 

are displayed).
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Hide the tracks you do not need
When two or more subjects move in the same arena, the tracks become a dense 
population of points. If you edit the track of subject A, you can hide the tracks of the 
other subject B which you do not edit at that time.

To hide tracks of subjects, in the Track Plot Settings pane click the Show/Hide tab. 
Under Subjects, clear the box corresponding to those subjects.

Hide unnecessary track features 
To hide unnecessary features like body points and connectors, in the Track Plot 
Settings pane click the Show/Hide tab. Under Features, clear the corresponding 
box for Sample or Trail.

Notes

▪ The nose-point and the tail-base point are not selected by default.
▪ What you choose under Features also determines which body points are 

shown in the Sample List. For example:
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Adjust the line thickness and dot size
Sometimes dots are too small and therefore scarcely visible, or too large make the 
tracks difficult to edit. The tracks may be hardly visible especially when using high 
resolution video.

In the Track Plot Settings pane click the Show/Hide tab. Under Features, adjust the 
following:

▪ Line thickness. Adjust the thickness of the trails and the segments joining 
the body points (Connectors).

▪ Dot size. Adjust the size of the body points visualized.

Customize the missing sample points
Missing sample points are always visualized in the track plot. You can change the 
color of missing points to distinguish them more easily from the actual data. The 
current color for missing points is indicated next to Missing Samples Color at the 
bottom of the Colors tab in the Track Plot Settings pane. To change the color for 
missing points, click this button and select the new color in the Color window.

Notes

▪ Remember that within a sample, nose-point and tail-base can be missing 
independently. For example, the nose-point may be missing, while the 
corresponding tail-base may not. However, if the center-point is missing, 
then the other two points are too. 

▪ If the experiment is set to Only center-point detection or Color marker 
tracking, the term sample coincides with the only point (center). 
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Customize the background

Background color or image

Click the Show/Hide button on the toolbar and select Background. In the 
Background window, you can choose between the following:

▪ Plain. The background is uniform. Click the button next to it and choose the 
color you require. Click Other to select among more colors.

▪ Captured image. The background image captured in the Arena Settings 
that was used to acquire the data. This image does not change as you play 
the tracks back.

▪ Video file. The video footage from the video file used to acquire the data. 
The video file is synchronized with the track as you play it back.
TIP Select Video file every time you want to compare the track data with the 
orientation and behavior of the animal. For example, when you want to 
verify that the nose point and the tail base point have been detected 
properly.

Arenas

Click the Show/Hide button on the toolbar and select Arena Features. Select the 
arena features you want to have displayed superimposed on the background.
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Select the samples to edit
What do you want to do?

▪ Select samples manually
Choose this option to select a single sample or one or more ranges of 
samples.

▪ Select samples automatically
Choose this option to let EthoVision find the samples that match a specific 
criterion. For example, find all missing samples to interpolate them.

IMPORTANT  If you select a body point in the video image, all body points of that 
sample are automatically selected, no matter whether they are actual data points or 
missing points.
670



Select samples manually
To select a single sample
Do one of the following:

▪ Hover the mouse on a body point. The mouse pointer changes to a four-
headed arrow. 

Next, click the point. The sample is highlighted in the track and in the 
Sample List.

To cancel the selection, press Esc or click on the background image.

▪ Click the Show/Hide button on the toolbar and select Sample List. In the 
Samples List window, click any cell corresponding to the sample you want 
to select. Scroll down the list if necessary to locate the sample. The line is 
highlighted in green.

Next, right-click the row and select Jump to Time to display the selected 
samples on the plot. 

NOTE  If you click the Time column, you select all subjects for that sample.
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To select a range of samples
You can select a range of samples in different ways.

Select a range of samples with the mouse

1. Press and hold your left mouse button, and drag the mouse like when 
drawing a rectangle. 

2. All samples within this rectangle are selected. 
3. Release the mouse button.

NOTES

▪ Use this method to quickly select samples in a specific region.
▪ This method is not handy if you want to select one subject in a trial with 

multiple subjects. Rather use the Sample List (see below). 
▪ To cancel the selection, press Esc.
▪ NOTE  If body points lie outside the selection rectangle are selected, but 

they belong to the samples at least partially included in the rectangle, they 
are selected anyway. In the example above, some tail-base and center-
points outside the rectangle are selected (see the points indicated by the 
arrows) because their corresponding nose-points and/or center points lie 
within the rectangle.

Select the first and last samples

1. Click the first sample of the range you want to select. 
2. Press and hold down the Shift key.
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3. Click the last sample of the range you want to select. The sample range is 
highlighted.

NOTES

▪ To cancel a range selection, press Esc or click on the background image. To 
select another range, repeat steps 1 to 2. 

▪ You cannot select multiple sample ranges with this method.

Choose the sample range from the Samples List

Choose this method when the ones described above do not allow you to easily 
select a range because of the high density of sample points.

1. Choose Show/Hide > Samples List. 
2. In the Samples List window, click a cell corresponding to the first sample of 

the range. The line is highlighted in green. 
TIP  Clicking a row in the Sample List does not move the video to that 
position. Double-click that row to move the video, so you can see where the 
subject is at the time you have just selected.

3. Press and hold the left mouse button, and drag down to the last sample 
you want to select. Release the button when ready.
Right-click one of the rows highlighted in green and select Jump to Time 
to display the selected samples in the plot.

TIP  The time highlighted in blue always corresponds to the current video image. 
The current sample is highlighted (white fill, and orange outline).
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Notes
▪ To select samples for all subjects in the arena, click the cell in the Time 

column. for the first sample of the range, then drag down to the last sample 
you want to select.

▪ You can also select samples for two or more subjects that are adjacent in 
the Sample List (e.g. Subject 1 and 2). Click the first sample for Subject 1, 
and drag down to the last sample you want to select for Subject 2.
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Select samples automatically
Aim
To easily find:

▪ Missing points. 
▪ Samples separated by a distance greater or smaller than a specific value. 

For example, to find points lying far from the normal path.
▪ Samples with a surface area greater or smaller than a specific value. For 

example, to find all points where the detected blob is too large to be the 
actual subject.

▪ Samples with the distance between nose-point and tail-base greater or 
smaller than a specific value.

To access this function
Choose Acquisition > Edit Tracks, and select the trial you want to view.

Procedure
1. On the toolbar, click the Auto Select button. 

2. In the Auto Select Samples window, under Select choose the option you 
require. For more information, see the notes below.
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3. Under Scope:
▪ Select the arena you want to search. If you want to find samples in all 

arenas, select All arenas.
▪ Select the subject you want to search. If you want to find samples in all 

subjects, select All subjects. 
4. Click Select All.

Result: The samples matching the criterion are highlighted in the track plot. 
In the Samples List, the corresponding rows are highlighted in green.

5. If you chose Missing samples in step 2, click the Next>> and <<Previous 
buttons to move to the next or previous missing sample, respectively. 
There, you can decide whether to Interpolate points or leave the sample as 
missing.

6. If necessary, change the settings under Select and click the Select All 
button. When you are satisfied with the selection, click Close. 

Options

Missing samples

Option Missing samples. Choose this option to select all missing samples in the 
track, for example to interpolate them.
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Sample distance

EthoVision XT selects all the non-missing points separated from the previous or the 
next by a distance greater or smaller than the threshold you specify. To select 
samples, EthoVision XT always uses the distance between center points.

In the following example with two short tracks, the open circles represent the 
samples selected after using a distance threshold, indicated with the segment.

NOTE Using > and < does not result in complementary selections. Some samples in 
the figure above are selected in both cases.

TIP  To remove outliers, for example data points resulting from detection of 
reflections in a water maze, select > and enter a value of distance. This value must 
be greater than a realistic estimate of the maximal distance that the subject could 
move between two consecutive samples. Note that this value also depends on the 
sample rate. The higher the sample rate, the shorter the distance moved by the 
subject between two consecutive samples. Next, do Delete points and then 
Interpolate points to replace the outliers.

Surface area

For this option, specify the value in the measurement unit selected in the 
Experiment Settings.
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Nose-tailbase length

This is only available if your experiment is set to Center-point, nose-point and tail-
base detection. Nose-tailbase length is the total length of the segments between 
nose-point and center-point, and that between center-point and tail-base point.

Restrict to samples visible in plot

Select this option if you want to select only the samples that match the Select 
criterion and that are currently displayed in the track plot. The other samples that 
match the criterion but are not displayed, are not selected. 

NOTE  If you select this option and then play back the track, the samples that are not 
currently visualized, but that match the selection criterion under Select, are not 
selected. To have them selected, pause the video and click Select all once again.

To deselect samples
Do one of the following:

▪ Press Esc.
▪ Click anywhere on the background image that is not a point.
▪ Right-click anywhere on the background image.
679



Swap subjects and body points
What do you want to do?

Swap subjects

▪ Swap subjects
▪ Prepare the data in multi-subject trials

Swap body points

▪ Swap nose-point and tail-base
▪ Swap nose-point and tail-base point manually
▪ Swap nose-point and tail-base point automatically
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Swap subjects
Aim
To exchange the identities of two subjects within one sample (or range of samples, 
or the entire track), after checking that these were assigned incorrectly by 
EthoVision XT.

Below: An example of subject identity swap. 1. before the swap (Subject 1 = yellow 
track. Subject 2 = red track). 2. Moment of subject swap; the mouse with yellow 
track becomes Subject 2 and the mouse with red track becomes Subject 1 (see the 
last samples exchanged between the yellow and the red tracks). 3. After the swap.

To correct the subject identity swap, swap the subjects for all samples beginning 
from time 2, up to a new swap (if present) where subjects are labeled correctly 
again.

NOTES

▪ If a large number of samples contain body points assigned to the wrong 
subject, it may mean that the detection settings defined to discriminate 
between subjects are not optimal, or that you need to improve the lighting 
or the color marking of your setup.

▪ You can click Save on the toolbar so that if you are editing many swaps and 
make a mistake, you do not loose your previous edits. See Saving the track 
edits.

Procedure
1. If you work with multiple arenas, choose first the arena in the Samples List.
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2. Play the track until you find samples with wrongly-assigned subjects. 
TIP  Play frame-by-frame to position the video when the first samples are 
swapped (see the figure below). 

3. Select the sample (or range of samples) in which you want to swap the 
subjects. To do so, in the Samples List, double-click the time value 
highlighted in blue, then drag to select the rows corresponding to all the 
samples to swap. The last row selected should be immediately before the 
next swap (where body points are assigned correctly again).
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IMPORTANT  If you drag on the Time column, all subjects in the trial are 
selected. If you have more than two subjects (for example, three subjects 
and you want to swap Subject 1 and 3), do not drag in the Time column. 
Instead, select the cells of one of the two subjects to swap. In the next step 
you will be asked to select the other subject. 
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Result: The selected samples are highlighted. 

TIP  To swap subject identity throughout an entire track, click the header for 
one of the two subjects (e.g. click the header Subject 1).

4. Click the Swap subjects button on the toolbar, or press D.

5. If you have more than two subjects, the Swap Subject window appears. 
Select Swap Selected Samples. Select the second subject of the pair you 
want to swap, then click Apply.
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Result: The subjects in the selection are swapped. You can check this in the 
Samples List, where the coordinates and the area are swapped between 
subjects and for the rows selected.

Notes
▪ To search for subject swaps, plot the dependent variable Distance moved in 

the Integrated Visualization. The peaks in the plot appearing for two 
subjects indicate a quick displacement of the body points, that is a suspect 
subject swap.

▪ To quickly swap two subjects for just one sample, drag the mouse around 
the subject's body points in the video window. Make sure that the Track 
Editor only display one sample.

Then click the Swap subjects button .

▪ In the Time column of the Samples List, the cell highlighted in blue 
corresponds to the sample highlighted in white in the video window.

▪ If you select several samples and choose to have one sample every n-th 
visualized, you also swap the body points in the selected range that are not 
visualized.

▪ In the Swap Subjects window, select Swap all samples to swap the subjects 
for the entire track length.
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Prepare the data in multi-subject trials
Aim
To fix potential identity swaps after tracking multiple subjects with the Deep 
learning body point detection technique.

This topic applies to
Experiments set as follows: (see Experiment settings)

▪ Number of Subjects per Arena: 2.
▪ Tracked Features: Center-point, nose-point and tail-base detection.
▪ Body Point Detection Technique: Deep learning.

Background information
When EthoVision XT tracks unmarked subjects, there is chance that subject identity 
is swapped. This could occur for example when two subjects come into contact with 
each other. In the example below, the dotted line is the true trajectory of the two 
subjects. After the crossing, the subject orange is labeled as blue, and blue is labeled 
as orange.

To reduce or entirely remove identity swaps, when using Deep learning, the 
software works in two steps: 

▪ Step 1 (Tracking) - The software finds and tracks the subjects’ body points.
▪ Step 2 (Data Set Preparation) - The software reviews the tracks and sorts 

them based on the visual differences between the subjects. This step is 
carried out after tracking, and automatically when you calculate/visualize 
the data. As a result, the occurrence of identity swaps is reduced.
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Recognition of individuals is based on the differences in the appearance of the 
subjects’ fur. For how to mark your subjects, see the recommendations in Deep 
learning: Requirements

Procedure
The Data Set Preparation is done automatically the first time that you calculate the 
statistics or visualize the tracks. You can also run this procedure manually in the 
Track Editor.

1. Choose Acquisition > Edit Tracks. 
2. Select one trial from the list on the toolbar that is marked with (not yet 

prepared). 
3. Click Prepare Data.
4. Wait until the trial name shows “(ready)”. Depending on a few factors, 

including the length of the video and its resolution, this process may take 
some time.

5. You can now edit the tracks or run analysis.

Error messages
If for any reason, the Data Set Preparation procedure fails for at least one trial/
arena, the Data Preparation Report shows in which trial and arena that happened, 
and what the possible causes could be.
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▪ Not enough data points available to reliably train the network. This 
occurs if the trial was short, or the two animals were separated for too short 
time. Another possibility is that the animals were separated, but at least one 
of them was curled up for long time. In all those cases the software cannot 
create a high number of reliable images of the two subjects.
In general, we recommend to acquire a trial of at least five minutes, at the 
maximum sample rate (25 samples/s or higher).

Although the message may sound pessimistic, there are cases when the 
individual discrimination worked well. For example when the visual 
difference between the two subject is very clear. In such a situation a 
relatively small number of video frames may still be ok to create a reliable 
network for individual discrimination. 

Check the identity labels of the two animals and edit the tracks when 
necessary.

▪ No data points available to train the network. This could occur when 
tracking was so bad because of poor detection (e.g. not enough contrast, or 
presence of reflections) or because the two subjects were in contact for the 
entire duration of the trial. In such a situation there are no data points at all 
available for training the network; individual discrimination fails, no matter 
how long the trial lasted. 
We advise to check the lighting conditions, the contrast between the 
subjects and the background, and repeat the trial.

▪ The subjects look too similar. This occurs when the two subjects are not 
marked and there is no significant difference in their visual appearance. 
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Check the suggestions about marking animals: Deep learning: 
Requirements > Individual marking (for two-subject tracking)

Notes
▪ The Data Set Preparation may take some time, depending on the length of 

the video and the power of the GPU.
▪ The Data Set Preparation is not applied to trials where the subjects are 

tracked with the Contour-based technique for body point detection. For the 
difference between Contour-based and Deep learning, see Body point 
detection technique.

▪ The trial where data preparation failed is still added to your results table. 
However, there may be significant identity swaps. There are two options:
▪ Open the trial in the Track Editor and fix the identity swaps. See Swap 

subjects
▪ Exclude the problematic trials in your Data profile. See Filter tracks

▪ Check that you have the latest version of the driver for the secondary 
graphics card which does most of the work in deep learning - based 
tracking.

See also

▪ Advanced detection settings for tracking multiple unmarked subjects
▪ Introduction to editing tracks
▪ Swap subjects
▪ Deep learning: Basics
▪ Deep learning: Requirements
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Swap nose-point and tail-base
Aim
To exchange the nose-point and the tail-base within a sample (or range of), after 
checking that these were assigned incorrectly by EthoVision XT.

In the example below, the nose-point and the tail-base point are assigned 
incorrectly (left). The Swap action puts the nose-point and the tail-base point back 
in the correct place.

To check that nose-point and tail-base were mistakenly exchanged, choose 
Analysis > Results > Integrated Visualization. Play back the tracks with the video 
on the background. Check that the nose-point and tail-base do correspond to the 
actual orientation of the subject.

Procedure
Choose Acquisition > Edit Tracks. 

Choose one of the two options:

▪ Swap nose-point and tail-base point manually. Look for the samples with 
exchanged nose-point and tail-base, and give the Swap command for those 
samples.

▪ Swap nose-point and tail-base point automatically. Define a criterion for 
automatic detection of changes in orientation of the nose-point and tail-
base. EthoVision XT searches your tracks for the samples where a sudden 
change in orientation has occurred. It is up to you to swap nose-point and 
tail-base for those samples.

Notes
▪ By selecting the tracking methods Rodents / For occlusions or Adult Fish 

/ For occlusions, you can minimize the occurrence of nose-tail swaps. 
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However, this method requires much processor load, so make sure you do 
not miss samples.

▪ If a large number of samples contain wrongly-assigned nose-point and tail-
base, it may mean that the detection settings for nose-point and tail-base 
detection are not optimal, or that you need to improve the lighting or other 
settings of your setup.

▪ You can click Save on the toolbar so that if you are editing many swaps and 
make a mistake, you do not loose your edits.

▪ When you swap nose- ant tail-base points, the Head direction line is 
recalculated too. This influences the calculation of Head direction, Head 
directed to zone and Turn angle and Angular velocity when they are based 
on Head direction.
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Swap nose-point and tail-base point 
manually
Aim
To correct body point swaps that may have occurred when tracking the nose-point 
and the tail-base point.

Procedure
1. Play the track until you find samples with wrongly-assigned nose-point and 

tail-base. See To check that nose-point and tail-base were mistakenly 
exchanged, choose Analysis > Results > Integrated Visualization. Play back 
the tracks with the video on the background. Check that the nose-point and 
tail-base do correspond to the actual orientation of the subject.

2. Select the sample (or range of) in which you want to swap the nose-point 
and tail-base.
Result: The selected samples are highlighted.

3. Click the Swap nose and tail button on the toolbar, or press the W key.

Result: The nose-point and tail-base within each sample in the selection are 
swapped. In the Samples List, the coordinates are swapped between Nose-point 
and Tail-base for those samples.

Notes
▪ When you swap nose- and tail-base points, the Head direction line is 

recalculated as the prolongation of the segment joining the center-point 
and the tail-base point. This influences the calculation of Head direction, 
Head directed to zone and Turn angle and Angular velocity when they are 
based on Head direction.
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Swap nose-point and tail-base point 
automatically
With automatic swapping, EthoVision looks for the samples where the subject 
made a turn exceeding a user-specified threshold relative to the previous sample. 
These turns are interpreted as nose-point and tail-base being incorrectly assigned. 
You can then select those samples and let EthoVision exchange the corresponding 
nose-point and tail-base. 

Use this method when a large number of consecutive samples have body points 
wrongly assigned.

What does 'turn' mean here?
Turn is referred to the change in orientation of the nose-tail base vector. The nose-
tail base vector is the vector connecting the nose-point and the tail-base point 
within a sample (see the dotted arrow in the picture below). With automatic 
swapping, if the change in the vector's direction from sample n to n+1, is larger 
than the angle you specify, the sample n+1 is considered for swapping. Then, it is 
up to you to decide whether to swap the points. 

If the nose-point or the tail-base is missing, the nose-tail base vector is the vector 
connecting the center with the other point. If both nose- and tail-base points are 
missing, the sample is not considered for swapping anyway.

If samples following n+1 have a vector's turn lower than the specified threshold, 
they too are assumed to have nose-point and tail-base detected wrongly. Therefore, 
they are included in the swapping interval (see samples under B in the figure 
below). 

EXAMPLE  A: the body points are assigned correctly. B: the nose-tail base vector 
(indicated with the black arrow) makes a turn greater than the specified threshold 
(for example, 150°). This is the start of the swapping interval. C: a new significant 
turn of the nose-tail base vector is found. Samples between B and C (not included) 
are swapped. The samples after C are considered correct, until a new significant 
turn is found.
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To swap body points automatically
1. Position the track at the beginning and check whether the first sample in 

your track is orientated correctly.
To check this: If you have tracked data from a video file, make sure that the 
video file is on the background. If you have tracked live, make sure that the 
nose-tail base orientation matched the direction of movement.

2. Click the Auto Swap button on the toolbar, or press Ctrl+F.
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3. In the Auto Swap Nose-Tail window, under Find Interval, do the following:
▪ From the Find nose-tail swaps in the track list, select the arena and 

the subject you want to search. For single-arena setups and single-
subject setups, only one arena/subject is available, so go to the next 
step.

▪ In the Turning angle threshold field, enter the threshold angle. The 
first sample with a change in orientation of the nose-tail base vector 
larger than this threshold is considered for swapping.

4. Click the Next >> button.
Result: A number of samples are highlighted (selected). Under Find 
Interval, the following times are displayed:

▪ Start sample found at: The time of the sample in the track with 
turning angle greater than the threshold relative to the previous 
sample. It is the start of the interval of samples considered for 
swapping. 

▪ Stop sample found at: The time of the sample immediately preceding 
the sample with turning angle greater than the threshold. It is the end 
of the interval of samples considered for swapping. 

5. Do one of the following:
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If the first sample of the selected interval in your track is oriented correctly, 
click the Next >> button until the first sample of the new interval is not 
oriented correctly. 

If the first sample of the selected interval is not oriented correctly, this is the 
start of the interval of samples to be swapped. Proceed to step 6.

6. Once you have selected an interval of samples that does not match the 
orientation of the animal, do one of the following:
▪ If you want to let EthoVision XT swap the intervals of samples 

throughout the track based on the above criteria, select the option 
Automatically swap the current selection and swapped intervals in 
the remainder of the track, and click the Swap button in the Auto 
Swap Nose-Tail window.

▪ If you only want to swap the selected interval, make sure that the 
option above is cleared and click the Swap button in the Auto Swap 
Nose-Tail window.

Result: The nose-point and tail-base in the selected intervals are swapped. 

7. Do one of the following:
▪ If you want to search for the next interval to be swapped, go back to 

step 5.
▪ If the track contains only samples oriented correctly, click the Close 

button.
To swap nose-point and tail-base in another arena, select that arena from the 
appropriate list.
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Notes
▪ When you click Next>> for the first time, the interval from the start of the 

track (0:00:00.000) to the first change in the nose-tail vector orientation 
greater than the threshold is displayed. If you click the Next>> button more 
times, other intervals are displayed depending on where in the track other 
significant turns are found.

▪ Select the Automatic swap option above only if you are confident that the 
angle threshold specified in step B results in identifying the correct intervals 
to be swapped. This usually happens when you have checked the intervals 
yourself a few times. 

▪ If you select points outside the Auto Swap Nose-Tail window, the Start 
sample found at and Stop sample found at fields show <Selection 
changed>. In this case the Automatic swap option is not available. Click the 
<<Previous button to return to one of the sample intervals found by the 
program. 

▪ If you want to view the movement of the subject around the selected 
sample, click the Play button in the Preview Interval group. If you want to 
view additional samples immediately before the start and after the end of 
the selected interval, enter the number of such samples in the Expand 
preview with box.

▪ To go back in the track and select the previous intervals that start and stop 
at samples where the turn angle exceeds the threshold, click the 
<<Previous button.

▪ If you want to undo the swap action, click the Swap button again.
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Delete, move and interpolate points
What do you want to do?

▪ Delete points
▪ Move points
▪ Interpolate points

Learn about
▪ More information about interpolation
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Delete points
Aim
To remove a sample (or some of the points of your sample) from your data set. 

Deleting points means that they are set to missing.

IMPORTANT If you delete a point, you cannot recover the original coordinates, you 
can only interpolate it. If you delete an entire sample, the surface area is also lost. If 
you are not sure about the consequences of setting points to missing, save the edits 
first. You can always return to your original track data.

Procedure
1. Select the sample (or range) that contains the points you want to set to 

missing. 
2. Do one or more of the following:

If your track contain only center-points, click the Set to missing button on 
the toolbar or press Ctrl+Del. 

If your data also contains nose-point and tail-base, to set all points to 
missing, click the Set to missing button or press Ctrl+Del. 

To set only nose-points to missing, click the Set nosepoint to missing 
button or press Ctrl+Shift+M.

To set only tail-base points to missing, click the Set tailbase to missing 
button or press Ctrl+M.

What “Set to missing” means
▪ If you have set the whole selection to missing:
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▪ If you have set only the nose-points to missing:

▪ If you have set only the tail-bases to missing:

Missing points are shown as linear interpolations between the non-missing 
points of their own type. However, their coordinates are not in the track 
data, and are not subject to analysis. For example, if sample n is missing, the 
distance moved between the two non-missing points n–1 and n+1 is given 
by the straight line connecting the two points of the same type (nose-point 
to nose-point, etc.). 

▪ In the Samples List, the points' X,Y coordinates are removed from the 
Samples List. If you set the sample to missing, the surface area is also 
removed. Missing values are indicated by "-". 

▪ If you set a nose-point to missing, the Head direction value for that sample 
is removed.
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Move points
Aim
To change the X,Y coordinates of a point on the track plot.

Procedure
1. Hover the mouse on the point you want to move. The mouse cursor 

changes to a four-headed arrow. 

2. Press and hold the left mouse button and drag to the position you require.
3. Release the mouse button. The point is moved to the new position and its 

X,Y coordinates are updated in the Samples List. 

4. To de-select the point, press Esc or click on the background image.

Notes
▪ If you move a missing sample, this becomes non-missing and therefore 

included in your data.
▪ You cannot move a sample outside the arena.
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, a sample is made of three points (no matter whether those are 
actual data points or missing). You cannot move a sample as a whole, you 
must move each point separately (center-, nose-, and tail-base points).

▪ If you move the nose-point, the corresponding value of Head direction for 
that sample is unchanged.
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Interpolate points
Aim
To replace one or more missing points (or samples) or points clearly misplaced with 
points calculated on the basis of the position of the first previous and next non-
missing points. 

If your experiment is set to Center-point, nose-point and tail-base detection, you 
can choose between two types of interpolation: interpolate all selected body points 
or the center-points only (see below). 

Procedure
1. If you want to interpolate non-missing points clearly misplaced, set them 

first to missing (see Delete points). In other cases go to step 2.
2. Select the missing sample (or the range of) you want to interpolate.

TIP  To select missing samples automatically, click the Auto Select button 
on the toolbar, then choose Missing samples. Click the Next>> button to 
move the video to the next missing sample.

3. Click one of the following buttons on the toolbar:
Interpolate the selection (or press Ctrl+I). Click this button if you want to 
interpolate all the body points of the selected samples. See the notes below 
for how points are interpolated.

Interpolate center points (or press Ctrl+Shift+I). Click this button if you 
want to interpolate the Center points for the selected samples, and leave 
the nose-point and tail-base as they are currently (no matter whether 
missing or not).

If your experiment is set to Only center-point detection, only the first 
button is available. Click that button to interpolate the center-points.
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4. A message appears after you have clicked the interpolate buttons, 
informing you that EthoVision XT has extended the range of samples to be 
interpolated, if needed (see the note below). Click Yes if you want to 
continue. If you are not sure about the result of the interpolation, click 
Cancel.

Notes
▪ The interpolated points are highlighted in the track plot and get the color 

of non-missing points. In the Samples List, the points obtain X,Y 
coordinates.

▪ The Subject area is interpolated linearly.
▪ When you visualize the data, missing points are shown as linear 

interpolation between the first previous and next valid points. However, 
their coordinates are not calculated (you can check this in the Samples List). 
This means that missing points are actually not in the data set. If you want 
to include them in your data set, you must first interpolate them. 

▪ In some cases interpolation may result in points being located outside the 
arena. In those cases, they are automatically set to missing. This could be 
the reason why you still see missing points after you have carried out 
interpolation. 

▪ If you are not sure whether interpolation gives good results, save the edits 
first. See Saving the track edits

▪ If you interpolate the nose- and tail-base points, the Head direction line is 
recalculated as the prolongation of the segment that joins the center-point 
and the nose-point after interpolation.

This has consequences on all variables based on the Head direction line: 
Head direction, Head directed to zone and Turn angle and Angular velocity 
when they are based on head direction.
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More information about interpolation
Interpolation range
To interpolate points, EthoVision XT needs complete samples immediately before 
and after the sample to be interpolated. 'Complete samples' means that:

▪ For Only center-point detection, the Center point of the adjacent samples 
must not be missing.

▪ For Center-point, nose-point and tail base detection:
▪ If you chose Interpolate the selection on the toolbar, all the three 

points of the adjacent samples must not be missing.
▪ If you chose Interpolate center points on the toolbar, the Center-point 

of the adjacent samples must not be missing.
If the samples adjacent to the selected range are not complete, EthoVision XT 
searches for the first complete sample before and after that sample (or range). 
Therefore, all (incomplete) samples in the middle are included in the range to 
interpolate.

EXAMPLE  The missing samples 5 and 6 in the picture below have been selected for 
interpolation. Samples 4 and 7 are adjacent to the range, but not complete: sample 
4 lacks the nose-point, while sample 7 lacks the tail-base point (missing points and 
connectors look faded here).

▪ If you choose to interpolate the entire selection, EthoVision XT needs the 
coordinates of the three points for both adjacent samples in order to 
calculate the coordinates of the three points of samples 5 and 6. Therefore, 
samples 4 and 7 are not used. Instead, the complete samples 3 and 8 are 
used as adjacent samples, so the interpolating range is extended to 
samples 4 and 7 (see the open dots below). The coordinates of the missing 
points of samples 4 to 7 are calculated.
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▪ If you interpolate only the center points, EthoVision XT needs the 
coordinates of the center points for the adjacent samples in order to 
calculate the coordinates of the center-points 5 and 6. Sample 4 and 7 are 
used because they are the first previous and next samples with valid center-
points, respectively. The interpolating range is not extended (see the open 
dots below). The coordinates of the missing center-points, not nose-point 
and tail-base points, of samples 5 and 6 are calculated. 

How the center point is interpolated
The center-points of the selected samples are a linear interpolation between the 
first previous non-missing center-point and the first next non-missing center-point 
found around the interpolating (expanded) range.

Below: Linear interpolation of two center points. Left: Select the two points. Right: 
After interpolation. The arrows indicate the interpolated points.
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If your track contains nose-point and tail-base, interpolation of center-points is 
independent of whether you choose to also interpolate nose-point and tail-base. In 
any case, center-points are interpolated first.

How the nose-point and tail-base point are interpolated
Nose-points and tail-base points are always interpolated after the center-points 
have been found (see above), and their interpolation is dependent on the 
orientation of the non-missing nose-points and non-missing tail-base points 
immediately preceding and following those missing samples, respectively.

Before interpolation, the missing points are indicated as a linear interpolation 
between the first previous and the first next non-missing points of their type. 

The direction of movement does not play any role in interpolation. 

Consider the following example with three missing samples (missing nose- and tail-
base points are not shown for clarity):

First, center points are linearly interpolated:

Second, for the two adjacent non-missing samples, the program determines: 

▪ The length of the segment joining the center and the nose- (or tail-base) 
points.

▪ The angle formed by this segment and the horizontal x-axis generating 
from the center point (this angle can be either positive or negative 
depending on whether the segment lies above or below the axis).

The picture below shows this step for the nose point only: 
706



Third, the program calculates the interpolated values of segment length and angle 
for the missing points, using linear interpolation of the values obtained in the 
previous step.

So for example:

▪ If the length of the center-nose point segment for the two adjacent samples 
is 50 and 10 mm, respectively, then the length of the three segments joining 
the interpolated nose-points and their center points will be 40, 30 and 20 
mm respectively.

▪ If the orientation of the center-nose point segment for the two adjacent 
samples is 90 and -10 degrees, respectively, then the orientation of the 
three segments joining the interpolated nose-points and their center points 
will be 65, 40 and 15 degrees respectively.

The second and third step is repeated to interpolate the tail-base points.

Interpolating points at the beginning or end of the track
If the range of missing points to interpolate is at the beginning or the end of the 
track, the missing points are not interpolated. This is also the case when you want to 
interpolate nose- or tail-base points at the beginning/end of the track and the 
corresponding center points are non-missing.
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Synchronize video and tracks
Aim
To correct the delay between video image and tracks in the various visualizations: 
Track Editor, Track Visualization, Integrated Visualization.

NOTE  Normally you do not need to edit the Offset between video and tracks, 
because this is calculated by the software. Follow the procedure below if you notice 
that the tracks are lagging behind the video, like in the example below.

Prerequisites
You acquired data using the method Live tracking and Save video.

Procedure
See Troubleshooting: Data visualization > There seems to be a delay between video 
and track
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Manage your edits
Learn about

▪ Saving the track edits

What do you want to do?
▪ Save the track edits
▪ Undo track edits
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Saving the track edits
Aim
To save edits done up to that time. If you make more changes after saving, and you 
are not satisfied with those changes, you can always recover the edits made at the 
point of Save.

NOTE  This and the following topics apply to editing tracks and manually-scored 
behaviors.

EXAMPLE  You want to interpolate points, but are not sure whether the result is 
satisfactory. Click Save to create a copy of the track with the current edits, then do 
the interpolation:

▪ If the result of interpolation is good, click Save again. This replaces the 
previous track edits.

▪ If the result is not good, you can revert to the data of the last Save by 
clicking Undo.

What is the difference between saving the experiment and 
saving in the Track Editor?

Save experiment

To save your edited tracks at any time, choose File > Save Experiment or press 
Ctrl+S. However, once you have saved the data, you cannot revert to the first edit. 
In other words, you cannot undo any save action. However, you can always return to 
your original track data.

Save in the Track Editor

With Save in the Track Editor you can revert to the previous set of changes. You do 
so with the Undo action. This is handy when you want to make sure you can recover 
the data after you carry out some editing.

IMPORTANT  The Save action persists until you close the experiment. If you save, 
then make further changes to the data and close the experiment, all changes are 
saved but when you re-open the experiment you cannot revert to the Save point.

Notes
▪ Every time you click Save, the new copy replaces the previous one. This 

means that you can always keep only one copy of edited data.
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▪ The original (unedited) data are always stored in your experiment. To revert 
to the original tracks, and discard all changes, click the Undo all button on 
the toolbar.

▪ Auto save in EthoVision XT works like a normal Save command. Therefore, if 
an auto save action occurs, all changes made so far to the currently edited 
trial are applied. However, if you make further changes and an auto save 
action occurs, you can always revert to the saved copy that was made 
before the auto save action. To alter your auto save settings, choose File > 
Preferences > Auto Save.

See also

▪ Save the track edits
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Save the track edits
Aim
To create a copy of your tracks and manually-scored behaviors, that serves as a 
restore point. In the case you make further changes and you are not satisfied with 
them, you can revert to the restore point.

Prerequisites
▪ You have acquired at least one trial.
▪ Open the Track Editor (Acquisition > Edit Tracks). 

Procedure
1. Edit the Tracks.
2. When you want to save the changes, click the Save button on the toolbar.

3. Continue with editing. 
4. If you are not satisfied with the changes, click Undo to return to the saved 

copy.

Notes
▪ The tracks that are visualized and analyzed are always include the changes 

you made. If you want to visualize or analyze the original data, click the 
Undo all button on the toolbar. However, keep in mind that you lose the 
edits!
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Undo track edits
Aim
To revert to previously saved data after you have changed the data further and you 
do not want to keep the last edits.

NOTE  The procedure below is also valid when you edit data in the Manual Scoring 
screen. There you also find the Save and Undo buttons.

Prerequisites
▪ In the Track Editor, or in the Manual Scoring screen, you have done edits 

after saving the data at least one time.

Procedure
1. Click the Undo button on the toolbar. 

Result: A message appears, asking you whether you want to lose the 
changes since the last save.

2. If you click Yes, the original track plot is restored.
If you click No, you return to the main screen without losing the changes.

Notes
▪ To return to the original data, click Undo all. However, keep in mind that 

you lose all changes.
▪ If you edit data in one trial and then select another trial in the trial selection 

list on the toolbar, the changes you have made to that trial are saved 
automatically, including those you made after saving. 

▪ If you open another EthoVision XT screen, for example, to calculate 
statistics, or close the experiment after making changes to the track, those 
changes are saved, and retained when you switch back to the Track Editor 
screen. However, the saved copy (restore point) is always deleted when 
closing the experiment. Therefore, you cannot revert to the saved copy.
Consider the following sequence of actions:
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1. Edit data, then click Save.

2. Make a second run of changes, then close the experiment.

3. Re-open the experiment and choose Acquisition > Edit Tracks. 

The screen shows also shows the second set of changes made, but you 
cannot revert to the saved copy (restore point). 
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Smooth the Tracks

Main topics and tasks
▪ Why smooth the tracks?  716
▪ Apply The Lowess smoothing method  718
▪ Apply The Minimal Distance Moved smoothing method  722
▪ Apply The Maximum Distance Moved smoothing method  725
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Why smooth the tracks?
In any tracking system, there are three sources of noise that potentially affect the 
values of dependent variables such as Distance moved or Velocity:

▪ System noise. The noisy output of tracking systems means that when you 
track an object that does not move, the position of the object irregularly 
oscillates between two or more locations. This way the track may show 
continuous movement of the object that corresponds to a real-world 
distance of, for example, 1 cm, while in fact the animal is sitting still. As a 
result, the data show that the immobile object traveled quite a distance.

▪ Outliers resulting from tracking noise. Occasionally the tracking system 
generates a single outlier which obviously affects a dependent variable such 
as Velocity.

▪ Small movements of the animal ('body wobble'). When you track a moving 
animal using a high sample rate, sideways movements from the wobbling 
of the animal's body are also tracked. This results in an overestimation of, 
for instance, the total distance moved.

Smoothing methods

Smoothing (Lowess)

Use this method to eliminate small movements, such as body wobbling during 
locomotion, that might affect dependent variables such as total distance moved. 
See The Lowess smoothing method

Minimal Distance Moved

Use Minimal Distance Moved when the animal sits still, yet the body points move 
slightly due to system noise or breathing. See The Minimal Distance Moved 
smoothing method

Maximal Distance Moved

Use Maximal distance moved to remove outliers due to erratic detection, for 
example in a water maze test when some water reflection is detected as the subject, 
or in DanioVision experiments when the subject does not move and EthoVision XT 
detects the margins of the well as the subject. See The Maximum Distance Moved 
smoothing method
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Track smoothing during acquisition
The track smoothing methods listed above affect the tracks after acquisition. In 
some cases you may already want to smooth the track during acquisition. This may 
especially be the case if you use Trial and Hardware Control. As an example, if the 
center-point of an animal is detected in a zone, you want the pellet dispenser to 
drop a pellet. If the detected center-point is moving rapidly because of noise, this 
may result in a number of consecutive pellets to be dropped, every time the center-
point crosses the border of the zone. Track smoothing does not solve this problem. 
Instead, use Track noise reduction in the detection settings to smooth the tracks 
during data acquisition.
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The Lowess smoothing method
Lowess stays for Locally weighted scatter plot smoothing. This method fits a curve 
to the dataset, using a least square regression modified as follows:

▪ The Lowess method uses a moving time window (or half size window) that 
contains a subset of sample points.

▪ The Lowess method uses a 2-degree (non-linear) polynomial fit. This fit is 
applied to the center-point. If you use center-point, nose-point and tail-
base detection, the fit is also applied to the angle between center-point and 
nose-point and between the center-point and tail-base. (see Notes below).

▪ The Lowess method is weighted; sample points nearest to the point being 
fitted have a larger influence on the fit than sample points further away.

The Lowess method has been successfully applied on track data from EthoVision.

To apply Lowess smoothing
1. Choose Acquisition > Track Smoothing Profile > Open.
2. Select the Smoothing (Lowess) check box and click the Edit button.
3. Change the number of sample points in the Half window size list.

The default value is 10 which is the recommended value. Selecting a larger 
half window size results in a smoother path. Selecting a smaller half window 
size results in a path that more resembles the original path. With a lower 
sample rate, you should use a larger half window size to get the same 
smoothing as with a higher sample rate.
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Notes
▪ Smoothing is applied after data acquisition and after data editing, but 

before the Minimal Distance Moved method. The smoothed data, not the 
original data, are used for analysis and for export. Applying Smoothing 
does not change the original data.

▪ Smoothing and body points. Smoothing is applied to the center-point, and 
subsequently, if you also tracked the nose-point and the tail-base, to the 
angle formed by the three body points.

▪ Smoothing and missing samples. When up to 200 consecutive samples are 
missing, they are interpolated (see Interpolate points). Next, their x,y 
coordinates are re-calculated based on the Lowess method. The Subject 
area for missing samples is interpolated linearly, but is not smoothed.
If the subject is missing for more than 200 samples (this corresponds to 8 
seconds for a sample rate of 25), that track segment stays missing, and is 
not smoothed.

▪ Smoothing of Live Mouse Tracker data. When you apply Lowess smoothing 
to Live Mouse Tracker data, EthoVision XT takes the 3D coordinates of the 
body points (x-, y- and z-coordinates). The 3D position of the nose-point 
and the tail-base point are represented with spherical coordinates bound to 
the center-point. 
▪ For example, the coordinates of the nose point are based on the length 

r and angles θ and ϕ of the segment joining the center-point and the 
nose-point. The z-coordinate of the nose- (or tail-base) point includes 
the angle θ formed between the x-y plane and the segment joining 
that body point and the center-point.

▪ Smoothing of Live Mouse Tracker data is done as described in How the 
nose-point and tail-base point are interpolated, with the difference that 
the vectors and the angles are drawn in 3D instead of 2D like in typical 
EthoVision XT nose-tail data.
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▪ Smoothing and hidden zones. Samples assigned to a hidden zone are 
smoothed too. For this reason, after smoothing with the Lowess method, 
part of the samples in the hidden zone are “moved” outward, producing the 
effect shown below. Those samples add up to the total distance moved in 
your results. How many samples are moved depends on the original 
trajectory.
Below: An example of the effect of Lowess smoothing on the location of 
samples originally assigned to a hidden zone. After smoothing, part of the 
samples assigned to the hidden zone center are moved toward the adjacent 
samples outside the zone. A similar effect can be seen when the animal 
exits the hidden zone.

See also

▪ For more information on the Lowess method, see http://en.wikipedia.org/
wiki/Lowess. 

▪ For more information on the application of the Lowess method on 
EthoVision tracks, see:
▪ Drai and Golani, 2001. SEE: a tool for the visualization and analysis of 

rodent exploratory behavior, Neurosci. & Biobehav. Rev. 25(5): 409-426.
▪ Hen, I. et al. 2004. The Dynamics of Spatial Behavior: How can robust 

smoothing techniques help? J. Neurosci. Methods 133(1-2): 161-172.
▪ Kafkafi, N. et al., 2005. Genotype-environment interactions in mouse 

behavior: a way out of the problem, Proc. Natl. Acad. Sci. USA, 102(12): 
4619-4624.
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The Minimal Distance Moved smoothing 
method
Aim
To filter out small movements of the subject’s center point that are caused by 
random noise, not to the subject’s spatial displacement.

Working principle
With the Minimal Distance Moved method, you can pick out the data when the 
subject moved a minimal distance from one sample to the next. 

▪ When the distance moved between the current and the previous sample is 
above (or equal to) the threshold for Minimal Distance Moved, the current 
sample is used for analysis.

▪ If the distance moved between the current and the previous sample does 
not exceed the threshold, the current sample is “moved back” to the 
previous sample.

The result of this filter is that small movements of the body points, supposedly due 
to noise, are removed, and the trajectory of the subject becomes simpler.

Procedure
1. Choose Acquisition > Track Smoothing Profile > Open.
2. Select the Minimal Distance Moved check box and click the Edit button.
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3. Under Select, enter the Minimal Distance Moved threshold.
4. Choose one of the two options (see below for an example):

Direct (A > MDM). To select samples on the basis of the shortest distance 
(beeline distance) between samples. Select Direct to exclude movements 
such as breathing, when the animal is sitting still. 

Along the path (B + C + D > MDM). To select samples on the basis of the 
actual path between samples. Select Along the path whenever you want to 
filter samples according to the distance moved along the path. 

5. Click OK.

Notes
▪ Minimal Distance Moved is only applied to the center-point.
▪ Under some circumstances, using the Minimal Distance Moved filter might 

affect dependent variables other than Distance Moved and Velocity. To 
apply Minimal Distance Moved to some dependent variables, not others, 
create two Track Smoothing profiles: one with Minimal Distance Moved 
selected, the other without Minimal Distance Moved selected. Run batch 
calculations using both smoothing profiles.

Direct vs. Along the path Minimal Distance Moved
As shown by the case of Distance moved in the figure, calculation of the dependent 
variables is affected by what Minimal Distance Moved option you choose.
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▪ Direct (left). The program calculates the shortest distance between a 
sample and the next (AB, dashed line). If this distance is shorter than the 
threshold distance MDM, sample B is set to sample A. Then the program 
calculates the distance to the second next sample (AC), etc. until it finds a 
segment (AD) longer than MDM. Samples B and C are both set to sample A. 
This procedure is then repeated up to the end of the track.

▪ Along the path (right). EthoVision XT calculates the distance between a 
sample and the next (AB, dashed line). If this distance is shorter than the 
distance threshold, sample B is set to sample A. Then the program 
calculates the cumulative distance along the path to the second next 
sample (AB + BC, etc.) In this example, sample B is set to sample A. 
However, the distance AB + BC is greater than MDM, so C stays in its place. 
Next, the sample D is set to sample C because CD < MDM. However, CD + 
DE is longer than MDM, so sample E stays in its place. The procedure is 
repeated up to the end of the track.

In both cases, all five samples are selected for analysis. However, some samples 
have been “moved” to a previous sample in such a way that their own value of 
distance moved is zero.

▪ With the Direct method, samples B and C overlap with A, and E with D.
▪ With Along the path, sample B overlaps with A, and D with C. 

The resulting total distance moved can therefore differ depending on which option 
is chosen.
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The Maximum Distance Moved 
smoothing method
Aim
To remove outliers in the track, due to erratic detection of objects within the arena. 
For example, in a DanioVision experiment, if detection is not optimal, the margin of 
the well is sometimes detected as the fish.

IMPORTANT  If you see many errors, adjust the Arena Settings and/or the Detection 
Settings.

Procedure
1. Choose Acquisition > Track Smoothing Profile > Open.
2. Select the Maximum Distance Moved check box and click the Edit button.

3. Enter the threshold value of distance moved, above which the sample will 
be set to missing. If the distance moved from sample 1 to 2 is longer than 
the threshold, sample 2 is set to missing.

4. Click OK.
5. Plot the tracks to see the result.
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Notes
▪ TIP  To know which value of distance to use as a threshold, plot the values of 

distance moved in the Integrated Visualization, and look at the spikes 
corresponding to the outliers. Take a value well below the value of the 
spikes. Be aware that a threshold being too low can remove good data.

Result (compare this with the picture at the top): 

▪ The Maximum Distance Moved method is applied after data editing, and 
after the Smoothing (Lowess) and the Minimal Distance Moved methods 
(when selected). The smoothed data, not the original data, are used for 
analysis and for export. Applying the Maximum Distance Moved method 
does not change the original data.
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Introduction to Data 
Analysis

Main topics and tasks
▪ Overview of data analysis  728
▪ Analysis advisor  733
▪ Basics of data selection  754
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Overview of data analysis
Learn about

▪ Analysis functions
▪ Important terms in data analysis
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Analysis functions

For data preparation:
▪ Data Profiles. For choosing the data points subject to analysis. You can 

filter tracks, create groups, select specific time periods or track segments, 
etc.

▪ Analysis Profiles. For choosing the behavioral endpoints, like speed, 
distance moved, time spent in a zone, etc.

For the analysis results:
▪ Statistics and Charts. For obtaining a table with summary statistics of the 

dependent variables per trial and summary statistics and charts per group 
of trials.

▪ Track Visualization. For visualizing data as tracks plotted over a static 
background video image.

▪ Heatmap Visualization. For visualizing the location where your animals 
spent most time.

▪ Integrated Visualization. For visualizing the track together with video, and 
plotting dependent variables against time.

▪ Export (Raw Data, Statistics and GLP log). To export raw data, dependent 
variables and their summary statistics, and the GLP log (available with the 
Quality Assurance module).
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Note
In general, the analysis results depend on a few factors:

▪ Whether you applied Noise reduction during acquisition.
▪ Whether the tracks are smoothed, and how.
▪ Which tracks and data points are selected in the current Data profile.
▪ Which dependent variables and statistics are selected in the current 

Analysis profile.
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Important terms in data analysis
Dependent variables
In EthoVision XT, a Dependent variable is a variable that quantifies the behavior of a 
subject or marks an event occurred in a trial.

▪ EXAMPLE 1  To quantify locomotor activity, choose Distance moved, or 
Velocity, or Movement as Dependent variables. 

▪ EXAMPLE 2  To calculate how many food pellets were dropped by a pellet 
dispenser, choose Hardware continuous as a Dependent variable.

Dependent variables are calculated for each sample of the track, when data are 
available. The table below shows the Distance moved calculated for a few samples. 
X and Y are the coordinates of the center of the subject's body. Note that distance 
moved is not calculated at time = 0, because there is no previous sample to use as a 
reference.

Time X Y Distance moved

0 -8.7393 -26.1678  – 

0.08 -6.8267 -26.9699 2.0740

0.16 -4.7220 -27.0748 2.1074

0.24 -3.2380 -26.6227 1.5513

State dependent variables

Some dependent variables are state variables, that is, they have discrete values. For 
example, In zone with values 1 (in zone) and 0 (not in zone). The following table 
shows the In zone variable calculated for the zone A and for a few samples. When 
the animal’s body point is found within zone A, then In zone=1, otherwise In 
zone=0. In the example below, the subject's center point enters the zone at 0.16 s.

Time X Y In zone

0 -8.7393 -26.1678 0

0.08 -6.8267 -26.9699 0

0.16 -4.7220 -27.0748 1

0.24 -3.2380 -26.6227 1
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Statistics
In EthoVision XT, Statistics are descriptive statistics of the per-sample values of a 
Dependent variable. 

▪ EXAMPLE 1  To quantify locomotor activity, choose the Total statistic for the 
dependent variable Distance moved. Choose the Mean statistic for the 
dependent variable Velocity.
The Total distance moved is the sum of the per-sample values of distance. In 
the example of the table above, the total is 5.73 cm. 

▪ EXAMPLE 2  To calculate the time spent in zone, choose the Total statistic for 
the dependent variable In zone.

Trial statistics vs. Group statistics
For each dependent variable you can specify two types of statistics:

▪ Trial Statistics
Statistics calculated per trial.

EXAMPLE  Your experiment contains 100 trials of one animal in one arena. 
Choose Total as a Trial Statistic for the dependent variable Distance moved. 
You obtain 100 values of Total Distance moved.

▪ Group Statistics
Summary statistics of the Trial Statistics, calculated over all the trials 
specified in the data profile, or in a group. 

EXAMPLE  You have defined two groups of tracks, Treated and Saline, and 
you want to calculate the Mean and Standard deviation of Distance moved 
and other variables per group.

In the example above with the 100 trials, with Group Statistics you would 
obtain the average and standard deviation of the 100 values of distance 
moved.
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Analysis advisor
What do you want to do?

▪ Simple calculations (e.g. total distance moved, average velocity)
▪ Zone visits (entries and time spent)
▪ Other analyses with zones
▪ Analysis in relation to the path
▪ Analysis of regular time intervals
▪ Analysis of event transitions and sequences

Notes
▪ To analyze groups of tracks, define first your groups in the Data profile. See 

Define groups of tracks.
▪ TIP  If none of the dependent variables represents an adequate behavioral 

endpoint for your research question, please contact Noldus, so we can 
discuss your analysis requirements. EthoVision XT contains functions which 
can process the raw data based on JavaScript code. See Custom Variables

▪ For information on analysis related to specific apparatuses, like the Open 
Field, the Morris Water Maze, the Novel Object Recognition and others, see 
also the EthoVision XT 18 - Application Manual, which you can find here:
Other Documentation
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Simple calculations (e.g. total distance 
moved, average velocity)
What do you want to do?

▪ Calculate the results for the whole arena
▪ Calculate the results per zone

Calculate the results for the whole arena
1. TIP  Smooth the tracks to get more realistic measures of distance. See 

Smooth the Tracks.
2. In the Experiment Explorer, click an Analysis profile, and then click the 

button next to the dependent variable if it is not already selected. For 
example, Distance moved or Velocity. In the Trial Statistics tab, select the 
statistics you want to calculate (for example, Total for Distance moved, and 
Mean for Velocity).

3. In the Experiment Explorer, click Statistics and Charts, then click the 
Calculate button.

Calculate the results per zone
1. Create a new Data profile or open an existing one.
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2. Click the Settings button on the Result box. In the Result Settings window, 
select Results per zone.

3. Under Settings - For zones, select the zones you want to analyze your data 
for.

4. Under Settings - For body points, select which body points should be in 
the selected zones. This option is only available if you track the three body 
points.

5. Click OK.
6. In the Analysis profile, define the variables you want to calculate.
7. In the Experiment Explorer, under Results, click Statistics and Charts, then 

click the Calculate button.

Notes
▪ The Zone exit threshold works this way: once the animal’s body point is 

detected in the zone, the animal is considered to be in the zone until its 
distance from the zone border exceeds that threshold. Use this option to 
remove false re-entries resulting from random movements of the body 
point around the zone border. 
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If you enter a value greater than 0, you make sure that when the animal 
exits the zone border for a short distance (less than the threshold), that data 
will be included in the results, for that zone. Click the button  next to 
this option for an example. For more information, see In zone.

▪ Select the Apply to all results if you want to copy the settings specified in 
the Results Settings window to other Result boxes. This applies if you have 
defined more than one Result box in that Data profile.
736



Zone visits (entries and time spent)
What do you want to do?

▪ Calculate the number of entries and time spent in specific zones
▪ Calculate the number of entries and total time spent in two or more zones
▪ Calculate the number of entries and time spent in an intersection of zones
▪ Analyze the visits to target zones and errors
▪ Find out which zone the subject visited first
▪ Count the number of times that the subject was in a zone for more than N 

seconds
▪ Calculate the time that the three body points were in a zone

Calculate the number of entries and time spent in specific 
zones

1. In the Analysis profile, under Location, click the button next to In zone. 
Specify the zones you are interested in. In the Trial Statistics tab, select 
Frequency (for zone entries) and Cumulative Duration (for time spent).

2. Click Statistics and Charts, then Calculate.
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Calculate the number of entries and total time spent in two or 
more zones
If you want to group results for two or more zones, like the open arms of an 
Elevated plus maze:

1. In step 1 above, specify the zones you are interested in, and make sure that 
When in any of the selected zones is selected. In the Trial Statistics tab, 
select Frequency and Cumulative Duration.

2. Click Statistics and Charts, then Calculate.
Alternatively, in the Arena Settings make a Cumulative zone from the selected zones 
and calculate the frequency and cumulative duration in this zone.

Calculate the number of entries and time spent in an 
intersection of zones
When two zones are defined in different layers, it is possible to analyze their 
intersection. In this example, the intersection of the quadrant “North-West” and the 
annulus-shape “Maze border”.
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1. In the Analysis profile, under Location, click the button next to In zone. 
Specify the zones you are interested in, and make sure that When in all 
selected zones is selected. In the Trial Statistics tab, select Frequency and 
Cumulative Duration.

2. Click Statistics and Charts, then Calculate.

Analyze the visits to target zones and errors
For example, in a Barnes maze test, calculate how many non-target holes were 
visited and the time to the first visit to the escape hole (target visit).
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1. In the Analysis profile, specify the dependent variable Target visits and 
errors. Select the target zones and the non-target zones. In the Trial Statis-
tics tab, select Total number and Latency to First.
NOTE  Latency is always calculated from the start of the track, even when 
you define time bins and nesting intervals.

2. Click Statistics and Charts, then Calculate.
Use the variable Target visits and errors also for a Radial-arm maze test.

Find out which zone the subject visited first
For example, in a dual choice test, in a T maze, leaf disc, or a Y-maze, etc.

1. In the Analysis profile, specify the dependent variable In zone. In the Trial 
Statistics tab, select Latency to first.
NOTE  Latency is always calculated from the start of the track, even when 
you define time bins and nesting intervals.

2. Click Statistics and Charts, then Calculate.
3. Under Export, click Statistics. In the exported file check which zone has a 

lower Latency value.
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Count the number of times that the subject was in a zone for 
more than N seconds

1. In the Analysis profile, specify the dependent variable Free interval. Define 
an interval:
From. Dependent variable: In zone (specify the zone in the settings); 
Statistic: Current Duration > N seconds. 

To. Dependent variable: In zone (specify the same zone); Statistic: Current; 
Value: When not in zone = true. 

2. In the Trial Statistics tab, select Frequency.
3. Click Statistics and Charts, then Calculate.

If you want to calculate the actual duration of each of those visits, export the results 
table, then add N seconds to each result under Cumulative duration.

Calculate the time that the three body points were in a zone
With this solution, the animal is considered

▪ in a zone only when all its body points are within the zone
▪ out of the zone only when all its body points are outside the zone

EXAMPLE  A Y-maze test, with arm zones A, B, C.

1. In the Arena Settings, define the main zones of interest.
2. In the Arena Settings, create additional zone groups, one for each main 

zone. In the example of a Y-maze, 3 zone groups. In each group, define a 
cumulative zone, including all zones but the focal zone. For example, “Other 
than A”, “Other than B”, etc. Each of these cumulative zones must be in 
separate zone groups. See Cumulative zones

3. In the Analysis profile, from each main zone A, B, C, define a Free Interval, 
which goes from In zone (Frequency > 0, for zone 1, with all three points) 
to In zone (Current = true, for “Other than zone 1”). Repeat this step to 
create more Free intervals.

4. Calculate the statistics or visualize the Free interval.
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Other analyses with zones
What do you want to do?

▪ Calculate path length and speed for specific zones
▪ Calculate path length and speed for a combination of zones
▪ Calculate the distance traveled before reaching the platform in a Morris 

water maze
▪ Calculate the distance traveled or time before entering a zone
▪ Calculate the distance traveled or time before a specific zone visit
▪ Find where a behavior occurred
▪ Find out when the subject disappears from the arena

Calculate path length and speed for specific zones

In this case you calculate dependent variables for track segments. First, you specify 
the track segments When in zone with a Data profile and then you choose the 
dependent variables in an Analysis profile.

1. In the Data profile, in the Result box, click the Settings button and then 
select Results per zone. Specify the zones you are interested in.
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2. In the Analysis profile, click the button next to the dependent variable you 
require, e.g Distance moved or Velocity. In the Trial Statistics tab, select the 
statistic (e.g., Total for distance moved and Mean for velocity).

3. Click Statistics and Charts, then Calculate.

Calculate path length and speed for a combination of zones
1. In the Data profile, in the Components pane, under Nesting click the but-

ton next to In zone. Specify the zones you are interested in. Select the 
option that you require:
▪ When in any of selected zones to analyze when the animal was in one 

or another zone.
▪ When in all selected zones to analyze when the animal was in all the 

zones simultaneously. This assumes that the zones are at least partially 
overlapping: for instance, a quadrant and a border zone in a water 
maze. If zones are not overlapping, data are not selected since the 
subject’s body points cannot be in two non-overlapping zones at the 
same time.

For more information, see Nesting over In zone.

2. In the Analysis profile, click the button next to the dependent variable (e.g. 
Velocity).

3. Click Statistics and Charts, then Calculate.

Calculate the distance traveled before reaching the platform in 
a Morris water maze
Use the function Free Interval in the Data profile to select the interval from the track 
start to when the animal stays on the platform for say five seconds. 

1. In the Data profile, in the Components pane, under Nesting click the but-
ton next to Free interval. Specify the interval: 
▪ Start criterion: Time (Track start).
▪ Stop criterion: Dependent Variable In zone. Statistic: Current duration 

>=5 s”. 
▪ Select Ignore last interval if incomplete. This will consider only cases 

when the animal reaches the platform.
2. In the Analysis profile, click the button next to the Distance moved. In the 

Trial Statistics tab, select Total.
3. Click Statistics and Charts, then Calculate.
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EthoVision XT only gives results for those trials where the animal stayed on 
the platform for five seconds (here below, Trial 1). In all other cases, 
including when the animal swims over the platform, but does not stop 
there, EthoVision XT shows “-”; see Trial 2.

Calculate the distance traveled or time before entering a zone
For example, in a Barnes maze, you want to calculate the Total distance moved 
before the animal enters a zone.

For distance traveled

1. In the Data profile, in the Components pane, under Nesting click the but-
ton next to Latency to zone. Specify 1st visit, the zone and keep Interval 
before zone visit selected.

2. In the Analysis profile, click the button next to the Distance moved. In the 
Trial Statistics tab, select Total.

3. Click Statistics and Charts, then Calculate.
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For time

If you want to know the time before the animal enters a zone, you do not need a 
Data profile.

1. In the Analysis profile, click the button next to the In zone. Choose the 
zone and in the Trial Statistics tab, select Latency to first.
NOTE  Latency is always calculated from the start of the track, even when 
you define time bins and nesting intervals.

2. Click Statistics and Charts, then Calculate.

Calculate the distance traveled or time before a specific zone 
visit
In this example, we want to know the distance traveled or the time taken to stay in a 
zone for more than a specific time.

For distance traveled:

1. In the Data profile, in the Components pane, under Nesting click the but-
ton next to Free interval. Specify the interval “From Time (track start) to 
[dependent variable]. For example,
“From track start to Current duration >=20 s”. This will pick out the interval 
until the animal stays in a zone for at least 20 s.

2. In the Analysis profile, click the button next to the Distance moved. In the 
Trial Statistics tab, select Total.

3. Click Statistics and Charts, then Calculate.

For time:

1. In the Analysis profile, under Custom Variables click the button next to the 
Free Interval. Define the interval. In the Trial Statistics tab, select Cumula-
tive duration.

2. Click Statistics and Charts, then Calculate.

Find where a behavior occurred
The term “Behavior” here indicates a state like Movement, Mobility, Activity, Body 
elongation, behaviors scored manually, or behaviors detected automatically.
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Quantitative analysis

If you are interested in quantitative results (for example, the number of occurrences 
per zone). Specify the zones in a Data profile and select the behavior in an Analysis 
profile.

1. In the Data profile, in the Result box, click the Settings button and then 
select Results per zone. Select the zones you are interested in.

2. In the Analysis profile, select the behavior you are interested in. In the Trial 
Statistics tab, select Frequency.

3. Click Statistics and Charts, then Calculate.

Qualitative analysis

If you are interested in a visualization. Select the behavior and optionally the zones 
of interest in a Data profile and then create a heatmap of the frequency of visits to 
the zones.

1. In the Data profile, in the Components pane, under Nesting, click the but-
ton next to the behavior you want to visualize.
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OPTIONAL  If you are interested in particular zones, in the Result box, click 
the Settings button and then select Results per zone. Specify the zones 
you are interested in.

2. Click Heatmap Visualization, then Plot Heatmaps.

Find out when the subject disappears from view
There are situations when you want to know when the subject is no longer found in 
the arena. In the wire hanging test, used to evaluate abnormalities in muscle 
strength, the time that the subject remains hanging on the wire needs to be 
recorded. A way to do this is to measure the time until the subject falls from the 
wire and disappears from view.

1. Make sure that the camera view does not include the bottom of the experi-
mental cage. So when the animal falls, the software does not see it any-
more.

2. In the Arena Settings, define a hidden zone at the bottom of the arena. 
Define an entry zone that should occupy the lower half of the arena. Make 
sure that the entry zone partly overlaps with the hidden zone. See Shelters 
and other hidden zones

3. Acquire the tracks. When the subject falls, its center point is first found in 
the entry zone, then it disappears, so it is automatically assigned to the 
hidden zone.

4. In the Analysis profile, click the button next to In Zone. Select the hidden 
zone and on the Trial statistics tab choose Latency to first.

5. Click Statistics and Charts, then Calculate.
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Analysis in relation to the path
What do you want to do?

▪ In a water maze experiment, calculate the initial heading angle
▪ Split the track in a number of segments based on the distance traveled

In a water maze experiment, calculate the initial heading angle
That is, calculate the deviation from the optimal route, for example in the first 15 
cm of the swim path.

Specify the track segment From track start until the animal swam 15 cm with a Data 
profile. Then select the dependent variable Heading to point in an Analysis profile.

1. Smooth the tracks to obtain a swim path less influenced by noise. 
2. In the Data profile, in the Components pane, under Nesting, click the 

button next to Free Interval. Specify the interval “from Track start to Total 
distance moved >= 15 cm”. See Nest over a Free interval

3. In the Analysis profile, specify the dependent variable Heading to point. 
Select the center point of the platform. In the Trial Statistics tab, select 
Mean.

4. Click Statistics and Charts, then Calculate.
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Split the track in a number of segments based on the distance 
traveled

Specify the track segments in the analysis profile.

1. In the Analysis Profile, under Custom Variables, click Free interval. Specify 
the interval “From Distance moved - Total >=0” “To Distance moved - 
Total >=100 cm”. Select the option Calculate statistics per interval. In the 
Trial Statistics tab, select Cumulative Duration. 

2. Click Statistics and Charts, then Calculate.

Results

The duration is shown in the columns, for each 1-m segment (interval occurrence 1, 
interval occurrence 2, etc.).

See also

▪ Free interval in the Analysis profile
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Analysis of regular time intervals
Split the track in a number of regular intervals, and then 
calculate statistics for each interval

Specify the track segments in a Data profile and select the dependent variable 
Distance moved in an Analysis profile.

1. In the Data profile, in the Result box, click the Settings button and then 
select Results per time bin. Specify the length of the single time interval.

2. In the Analysis profile, specify the dependent variable. In the Trial Statistics 
tab, select the statistic (for example, Total for Distance moved).

3. Click Statistics and Charts, then Calculate.
751



Analysis of event transitions and 
sequences
What do you want to do?

▪ Calculate transitions between zone visits
▪ Analyze bouts of behavior

Calculate transitions between zone visits
For example, how many times did the subject go from zone A to zone B? Or, in a Y-
maze experiment, how many times did the subject go from zone A, to B, then C? Or, 
in a radial maze experiment, how many 8-arm visits were made without any revisits?

1. In the Analysis profile:
For zone alternations (like in a Y-maze test), choose the dependent variable 
Zone alternation. See Zone alternation

For transitions in general, choose Zone transition and define the sequence 
(for example, in a radial maze test, Arm 1 > Arm 3 > Arm 5).

Select the sequence of zone visits. If necessary, select more sequences. See 
Zone transition.

In the Trial Statistics tab, select the statistic Total number.

2. Click Statistics and Charts, then Calculate.
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Analyze bouts of behavior
If you define a bout of behavior as a group of events where the interval t between 
them is lower than a specified limit (t < tmax), you can detect those bouts with the 
Free intervals function. For example, look for bouts of movement, where single 
instances of the state Moving are separated by less than five seconds. 

In the Analysis profile, choose the dependent variable Free interval.

For an example, see Detect bouts of behavior in Examples of Free intervals in the 
Analysis profile.
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Basics of data selection
Aim
To carry out analysis on a selection of data, not all data.

Learn about
▪ The Data Profiles screen
▪ Create your data selection
▪ Work with data selection boxes

Notes
▪ You can create as many Data profiles as you want, containing different 

criteria for data selection.
▪ Data selection is optional. If you do not select data, the default data 

selection profile is used, which contains all data in your experiment.
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The Data Profiles screen
To access the Data Profiles screen

▪ Choose Analysis > Data Profile > New. Enter a name for the new Data 
profile and click OK.

▪ In the Experiment Explorer, in the Analysis folder, right-click Data Profiles, 
select New, enter a name and press Enter.

You can also open an existing data profile. Choose Analysis > Data Profile > 
Open.

Default Data profile
The Data Profile contains two selection boxes:

▪ The Start box (left) contains all tracks currently stored in the experiment.
▪ The Result 1 box (right), contains the data used for analysis. The two boxes 

are connected through an arrow. This means that in the default Data profile 
all data are used for analysis.

See Create your data selection
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Create your data selection
By default, all tracks in your experiments are selected. To refine your selection:

1. In the Components pane, click the button next to the variable you want to 
use.
If you do not see the Components pane, click the Show/Hide button on 
the toolbar and select Components.

2. A new box appears in the top-left corner of the Data Profiles window, and a 
new window appears on top, listing all possible values or characteristics of 
the chosen variable. For example, which treatment level you want to select 
for analysis. Choose the values that specify your selection and click OK.

3. Drag the box over the arrow that connects the two preexisting boxes. When 
the arrow turns white, release the mouse button.

If you do not see all buttons as shown above, click the More button.
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To create complex selections
You can define complex data selections by inserting two or more selection boxes in 
the sequence. 

▪ See Combining selection boxes

To create different selections in the same Data profile
By clicking the button next to Result (last button in the Components pane), you get 
a new Result box.

Additional Result boxes allow you to view the results in the same table for different 
data selections. For example, create groups based on an experimental treatment 
and compare the results. 

▪ See Define groups of tracks.
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Work with data selection boxes
This topic contains instructions for the basic operations with selection boxes. See 
also Create your data selection

Move a selection box
1. Click the margin of the box. The mouse cursor changes to a four-headed 

arrow.

2. Drag the box to the position you require.
3. Release the mouse button. The new box is inserted.

To move a group of selection boxes:

1. Draw a box around the boxes you want to move or click on the boxes you 
want to select while holding the Ctrl key.
As a result, the border of the selected boxes becomes darker.

2. Hover the mouse on the margin or the colored area of one of the selected 
boxes. The mouse cursor changes to a four-headed arrow.

3. Drag the group of boxes to the position you require.

Insert a box in a data selection sequence
1. Drag the selection box between two boxes, until the connecting arrow turns 

white.
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Connect two selection boxes
1. Point the mouse to the center of the first box, press and hold the left mouse 

button and drag toward the center of the other box.

2. Release the mouse button when the pointer has reached the center of the 
other box. The two boxes are connected. 

You cannot create connections from the Result box to any other box, and from any 
box to the Start box.

Change the selection criteria in a selection box
Follow the instructions below when you have inserted a selection box, and you want 
to adjust the settings to restrict/widen your selection. For example, when you have 
selected drug dose = 0.01 and 0.05 in the first instance, and you want to remove 
0.05. 

1. Locate the selection box that specifies the criterion you want to change.
2. Click the Settings button. 
3. Select the appropriate values in the window that appears.

Copy and paste a selection box
Follow this procedure to quickly duplicate Filter, Nesting and Results boxes. If 
needed, you can always change the settings in the new selection box that is created.

1. Select one or more selection boxes in the Data profile.
2. Choose Edit > Copy, or right-click and choose Copy, or press Ctrl+C.
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3. If necessary, open the Data profile where you want to copy the boxes to.
4. Choose Edit > Paste, or right-click and select Paste, or press Ctrl+V.

Note that the new selection box is given the same name as the original one, 
followed by a number (2), (3), etc.

Delete a selection box
1. Click the title of the box so the mouse pointer changes to a four-headed 

arrow.
To select a group of selection boxes, draw a box around the selection boxes 
that you want to delete, or click on each of those boxes while holding the 
Ctrl key.

2. Press Delete, or choose Edit > Delete, or right-click and choose Delete. 
You cannot delete the Start box. You can delete a Result box only if another one 
has been inserted in the Data Profiles window.

If you delete a box within a sequence, the arrows connecting the adjacent boxes are 
lost. Therefore, you must re-connect the adjacent boxes (see above).

Delete a connecting arrow
1. Click the connecting arrow you want to delete. The arrows turns bold to 

show it is selected.
2. Press Delete. The arrow is deleted.
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Create a new Result box
Create a new Result box when you want to display analysis results from different 
data selection criteria at the same time. For example, to calculate statistics for two 
groups of tracks.

1. In the Components pane, under Common elements, click the button next 
to Result.

The new Result box appears in the top-left corner of the Data Profiles 
window. Connect the selection box to other boxes.

2. Drag the new Result box to the right-hand side of the Data Profiles 
window, below the first Result box.
TIP  Click Settings in the Result box and edit its name (see below).

3. Complete the selection sequence by making a branching so that each data 
selection criterion ends up in its own Result box.

See also

▪ Multiple selections in a data profile

Edit the Result box name
The Result boxes are named automatically as you create them: Result 1, Result 2, 
etc. 

The Result box name is shown in the Analysis results (statistics and track plots), so it 
is good to give a name that reminds you from which data selection that result 
comes from. 

1. Click the Settings button in the bottom-right corner of the box.
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2. Enter the new name in the Name field.

Snap to grid
The data selection boxes automatically snap to a grid. You can change this by 
clicking the Show/Hide button on the toolbar and selecting/deselecting the two 
Grid options (Snap to Grid and Show Grid).

Zoom in and out
The toolbar of the Data Profiles window shows three zoom icons:

▪ Zoom in (Ctrl+.). Click this button until all data selection boxes fit in the 
window.

▪ Zoom out (Ctrl+,).

▪ Fit all. Click this button to fit all data selection boxes into the window.

The Data Profiles window is ‘dynamic’: this means that it expands when you move 
data selection boxes to the right. In this case, you can navigate ‘from left to right’ in 
the Data Profiles window by using the scrollbar at the bottom. use the Zoom to fit 
button on the toolbar to make all data selection boxes visible.
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Analyze Entire Tracks

Main topics and tasks
▪ Filter tracks  764
▪ Analyze groups of tracks  772
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Filter tracks
What do you want to do?

▪ Filter tracks
▪ Variables available for filtering
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Filter tracks
What is Filtering?
Filtering is the process of picking out entire tracks, either manually or based on the 
value of independent variables (System or User-defined). Filtered tracks and the 
corresponding video and external (physiological) data are subject to analysis.

Unlike filtering, Nesting picks out segments of tracks. You can combine Filter and 
Nesting criteria. 

▪ See Basic rules for combining selection boxes.

To filter tracks
1. Create a new data profile or open an existing one.
2. Locate the variable in the Components pane that you want to use for 

filtering data, and click the corresponding button.
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If you do not see item you are looking for, click the button next to More. 

See the next section for details on the independent variables available for 
filtering. 

3. A Filter box appears in the top-left corner of the Data Profiles screen. The 
Independent Variable values window opens on top.

4. Select the values of the variable for the tracks you want to analyze, and click 
OK.

5. Drag the Filter box to the desired position in the selection sequence 
between the Start and the Result box.

6. Repeat steps 2 to 5 to add more Filter boxes and refine your selection. 

Notes
▪ Scope of the variable. Within a single trial, you can select different data sets 

depending on the Scope of the variable used (Trial, Arena or Subject). 
Depending on your setup, a trial may consist of one or more arenas. On its 
turn, each arena can include one or more subjects.
▪ By filtering by a variable with Trial scope, you analyze all data for the 

trials that you specify, no matters how many subjects and arenas those 
trials contain. 
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▪ By filtering by a variable with Arena scope, you analyze all subjects 
recorded in the arenas that you specify, and you ignore the data 
recorded in other arenas in the same trial.

▪ By filtering by a variable with Subject scope, you analyze the tracks 
referring to the subjects that you specify, and ignore the tracks of other 
subjects recorded in the same arena and trial. 

▪ If the Independent variable values window does not list any value available 
for selection, it means that no values have been assigned to any trial in the 
Trial List.

▪ You can combine different filtering criteria to create complex data 
selections. To do so, insert multiple Filter boxes in the same sequence.

▪ You cannot filter tracks according specific values of external (physiological) 
data. For example, filter all tracks for which average heart rate was higher 
than 600 bpm. 

▪ If you want to edit an existing Filter box, click the Settings button of that 
box.

See also

▪ Create your data selection
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Variables available for filtering
System variables

▪ Start time. Filters the tracks belonging to the trials started at the times you 
select from the list. 
Tracks acquired from video files have the time of creation of the video files 
as their start date/time. 

Tracks that belong to the same trial have equal Start Time (that is, the time 
you started the Trial). If you have applied Trial Control with Start conditions, 
actual data recording may have started at different times in each track. 
Therefore, if you want to select individual tracks according to when actual 
data recording started, filter tracks by the variable Recording after (see 
below). 

▪ Video file. Filters the tracks recorded from the video files you select from 
the list.

▪ Tracking source. Shows the camera source if you track live. Since 
EthoVision allows one camera source per experiment, this variable will show 
only one camera.

▪ Trial Duration. Filters the tracks belonging to the trials of the duration you 
select from the list. 
Tracks that belong to the same trial have equal Trial Duration (that is, the 
difference between the Stop time and the Start time of the trial). If you have 
applied Trial Control with Start or Stop conditions, the duration of actual 
data recording may be different for each track. Therefore, if you want to 
select individual tracks according to the duration of actual data recording, 
filter tracks by the variable Recording Duration (see below). 

▪ Arena settings. Filters the tracks recorded using the Arena Settings profile 
you select from the list.

▪ Trial name. Filters the tracks belonging to the trials you select from the list.
Tracks recorded in the same trial have the same Trial name. If you want to 
select individual tracks, filter by the variable Arena name or Track (see 
below).

▪ Arena name. Filters the tracks recorded in the arenas you select from the 
list.
This option is handy if you have a multiple arena setup, and you want to 
analyze data from some arenas, not others.
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▪ Subject name. Filters the tracks of the subjects you select from the list 
(available when tracking multiple subjects per arena).

▪ Track. Filters the tracks you select from the list.
Each track name corresponds to data of one individual subject recorded in 
one arena and in one session (trial). If you want to select data according to 
the recording sessions (which, in the case of multiple arena setups, may 
contain multiple tracks), filter by Trial name (see above).

▪ Recording after. Filters the tracks that started a specific time after the start 
of the Trial. Select this time from the list.
This option is handy if you apply Trial Control with Start conditions. If this is 
the case, actual data recording for each track may have started later than 
the trial's start time. You can filter tracks started a certain time after the 
start of the Trial they belong to. For example, in a multiple arena setup, Trial 
1 started at 10:23:00, but actual data recording started after 5 seconds in 
Arena 1 and after 30 seconds in Arena 2. You can select those time lags 
from the list to filter specific tracks.

If you do not use Trial Control with Start conditions, data recording starts at 
the start of the Trial. In this case, the Filter Variables window for Recording 
after shows only the ‘0’ value. 

▪ Recording duration. Filters the tracks recorded for the time you select 
from the list.
This option is handy if you apply Trial Control with Start and Stop 
conditions. If this is the case, actual data recording may be shorter than the 
trial duration. You can filter tracks that have a certain duration, independent 
of the trial's duration. For example, in a two-arena setup, a trial lasted 15 
minutes. In Arena 1, actual data recording lasted 15 minutes while in Arena 
2 12 minutes because a Stop condition was met for that arena before the 
trial stopped. You can select those duration values from the list to filter 
specific tracks. 

If you do not use Trial Control, actual data recording lasts as long as the 
Trial, so Recording duration is the same as trial Duration (see above). In this 
case, the Filter Variables window for Recording Duration shows the same 
values as that for Duration. 

▪ Video start time. Filters the tracks recorded from the video file created (or 
last saved) on the date and time you select from the list.

▪ Detection settings. Filters the tracks recorded using the Detection Settings 
profiles you select from the list.
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The Detection profile variable has Trial Scope; this means that within a trial, 
all tracks have the same Detection Profile. If you want to know which 
Detection Settings were used for a specific trial, open the Trial List.

▪ Trial control settings. Filters the tracks recorded using the Trial Control 
profile you select from the list.
If you want to know which Trial Control profile was used in a certain trial, 
make sure the System Variable Trial control settings is selected for display in 
the Trial List.

▪ Sync status. Filters the tracks corresponding to the status of the 
synchronization between track and co-acquired external data. 
Planned. Filters the tracks for which no external data co-acquisition has 
been carried out.

Acquired. Filters the tracks for which co-acquisition was carried out.

▪ Missed Samples - Filters the tracks corresponding to the proportion of 
missed samples caused by, for example, a too high processor load. 

▪ Subject not found - Filters the tracks corresponding to the proportion of 
samples which were processed by EthoVision but in which no subject was 
detected.

User-defined variables
This list depends on the variables that have been defined in the Trial List. 

Click the button next to the variable you want to use as a criterion for filtering data.

See also the note about the Scope of the variable in To filter tracks.

External data
If you import external data into one or more trials, in the Components pane under 
Filter then type of physiological variables are listed. Click the button next to the 
variable you want to use to filter data.
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In the window that appears on top, select the imported data files you want analyze. 
Tracks linked with those data files are selected for analysis.

If you filter by External data, the data being subject to analysis also includes the 
tracks and the video files associated.

What track data are selected with external data files depends on how you linked the 
external data files to the track data during import (whether at the Trial, Arena or 
Subject level; see Import external data: General information). For example, if ECG 
data files are linked at the Trial level, entire trials are filtered. If ECG data files are 
linked to Subjects, only the tracks for the subjects linked to those ECG files are 
filtered.

See also

▪ Import external data in EthoVision XT
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Analyze groups of tracks
What do you want to do?

▪ Define groups of tracks
▪ View the results for groups of tracks
772



Define groups of tracks
Aim
To compare groups of tracks. For example, to compare the tracks of animals treated 
with a drug with the tracks of control animals. 

You can easily create groups by filtering tracks according to one or more 
independent variables, and linking that filter criterion to a specific Result box.

Procedure
1. Create a new Data profile.
2. To add a Result box, in the Components pane under Common elements 

click the button next to Result.

The new Result box is by default named Result 2. Place this box 
somewhere under the Result 1 box.

3. Connect the Start box to the Result 2 box.
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4. Filter your tracks by the independent variable Treatment Level:
▪ Click the button next to Treatment Level. Choose Control and place the 

resulting Filter box between Start and Result 1.
▪ Click again the button next to Treatment Level. Choose Treated and 

place the resulting Filter box between Start and Result 2.
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5. The Data Profiles window should look like this:
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The two Result boxes receive the data filtered according to the independent 
variable Treatment Level. Result 1 receives five tracks filtered with 
Treatment Level = Control. Result 2 receives other five tracks filtered with 
Treatment Level = Treated.

6. TIP  The name of the Result box is shown in the results (statistics and track 
plots), so it is good to give a name that reminds you from which data 
selection that result comes from. Click Settings in a Result box and rename 
it. For example, rename Result 1 to Control group.

See also

▪ Edit the Result box name
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View the results for groups of tracks
Prerequisite
You have defined one or more groups of tracks.

To view the results for groups of tracks
1. Create a new Analysis profile and choose the dependent variables (for 

example, Distance moved).
2. In the Experiment Explorer, under Results, choose the option you require 

(Calculate Statistics, Heatmaps etc.).
In the analysis results, you can see which output is produced by which Result box. 
Look up the Result header. For example, in the Statistics & Charts screen, click 
Group Statistics and Charts:

In the Heatmaps screen, click Group Mean and then click the Plot Heatmaps 
button.
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Analyze Track Segments

Main topics and tasks
▪ Analyze track segments: main concepts  779
▪ Nesting over time  783
▪ Nesting using zones  787
▪ Nesting over behavioral states  795
▪ Nesting over a Trial Control state  820
▪ Nesting over a Free interval  822
▪ Nesting over a Multi condition  829
▪ Nesting over External data  831
▪ Nesting over Subjects  832
▪ Results per time bin  840
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Analyze track segments: main 
concepts
Learn about

▪ Analyzing track segments
▪ How to select track segments
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Analyzing track segments
In EthoVision XT you can pick out segments of tracks specified by time intervals or 
the behavior of the subject. To do so, use the Nesting function in the Data profile.

When Nesting is activated, analysis is carried out on the samples within those track 
segments, and the corresponding video and external (physiological) data. The track 
segments outside the selection are not included in the analysis.

Below: A track represented by samples on a time line. The sketch shows a mouse 
entering a zone someway in the middle of the track, then sniffing air towards the 
end. The time lines at the bottom represent the samples selected for analysis when 
nesting over a zone, over time (for example, the first half of the track), or over a 
behavior (in this example, sniffing), respectively. 

An important difference
Selecting a variable in the Data profile is not the same as selecting the same 
variable in the Analysis profile. For example:

▪ When you choose In zone under Nesting in the Data profile, you select the 
samples when the animal was in a zone. Then, in the Analysis profile you 
choose a dependent variable, like Velocity. As a result, EthoVision XT 
calculates the velocity of the subject when it was in the zone.
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▪ When you choose In zone under Location in the Analysis profile, EthoVision 
XT calculates statistics for the variable In zone, for example, the time spent 
in a zone, or the number of zone entries, but not the velocity of the subject 
when it was in that zone.

Nesting options
▪ Nesting over time, to analyze a time interval defined by a Start time and a 

Stop time.
EXAMPLE  Analyze the first 15 minutes or each track. 

▪ Nesting over zones, to analyze the track segments when one or more 
subjects are within a zone or a combination of zones.
EXAMPLE  Analyze the behavior of the mouse when its nose point was in a 
zone defined around the novel object.

▪ Nesting over behavioral states, to analyze the track segments 
corresponding to the state of one or more subjects (for example, 
Movement, or Grooming).This option includes manually-scored behaviors 
and behaviors recognized automatically. 
EXAMPLE 1  Analyze all the samples collected when the animal's body was 
stretched (this can be done with the Body elongation dependent variable).

EXAMPLE 2  Analyze the locations where the animal was sniffing.

▪ Nesting over trial control states, to analyze the track segments 
corresponding to the time between two events of Trial Control.
EXAMPLE  Analyze the time from when the cue light switched on to when the 
mouse consumed the food item delivered.

▪ Nesting over subjects, to analyze the track segments based on the behavior 
of another subject. This is available when your arena contains multiple 
subjects, like in a social interaction test. 
EXAMPLE  The researcher wants to analyze the track segments of Subject 1 
when Subject 2 was In proximity of Subject 1.

Notes
▪ Track segments defined with Nesting are left-closed [A, B). That is, the start 

sample A, not the stop sample B, is included in the analysis.
▪ To analyze entire tracks, use the Filter function. See Filter tracks.
▪ You can also combine Filter and Nest boxes to create complex selections. 

See Complex Data Selections
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How to select track segments
1. Create a new data profile or open an existing one. 
2. Locate the variables under Nesting or Nesting over Subjects in the 

Components pane that you want to use to select track segments, and click 
the corresponding button.
A Nest box appears in the top-left corner of the Data Profiles screen. A new 
window opens on top.

3. Select the values that define the track segments you want to analyze, and 
click OK. See the next topics for details.

4. Drag the Nest box to the desired position between the Start and the 
Result box. See Insert a box in a data selection sequence.

5. Repeat steps 2 to 4 to add more Nest boxes and refine your selection. 
If you want to edit an existing Nest box, click the Settings button in that 
box.

6. Choose Analysis > Results > then one of the options available to obtain 
numerical and graphical results for the track segments selected.

Notes
▪ If you have tracked two or more subjects per arena, you have two main 

nesting options: 
▪ Nesting: Choose this category if you want to analyze the track 

segments that correspond to the behavior of the subject of that track.
▪ Nesting over Subjects: Choose this category if you want to analyze 

the track segments that correspond to the behavior of subjects other 
than the subject of that track, or a combination of subjects. See Nesting 
over Subjects.
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Nesting over time
Aim
To pick out the samples in one time interval, from time tstart to time tend.

Procedure
1. In the Data Profile, under Nesting click the button next to Time.

NOTE  Choosing Time under Nesting over subjects leads to the same data 
selection.

2. In the Time window, enter the Interval start and Interval end.
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▪ Relative time is the time since the start of the track. Enter the relative 
time. In EthoVision XT 17.5 and later, you can specify any time within 
the trial, even after 24 hours.

▪ Track start/Track end mark the start and end of each track, 
respectively. Therefore, they may mean different relative times between 
tracks.

3. Complete the procedure from step 4 in How to select track segments.
EXAMPLES

▪ To analyze the first 10 minutes of each track:

▪ To analyze the from 10 minutes to the end of each track:

Notes
▪ Time intervals are applied in each track independently (see also the notes 

below).
▪ Default: Interval start 0:00:00.000 (h:mm:ss.fff), Interval end 0:00:30.000.
▪ 0:00:00.000 represents the time that tracking started for that arena. With 

multiple arenas, tracks may actually start at different times within the same 
trial (see below).

▪ If you want to split the data in regular intervals (for example, a one-hour 
recording in six 10-minutes intervals), do not nest over time. Instead, in the 
Data profile choose Results per time bin on page 840.

▪ TIP  If you want to select a track segment that lasts some time relative to an 
event (for example, select the 10 seconds after the presentation of a 
stimulus, or select up to when an object is explored for 1 minute), then 
choose Free interval instead. See Nesting over a Free interval.
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▪ Nesting over time when working with multiple arenas. if you apply Trial 
Control with Start and Stop conditions for each arena separately, actual data 
recording may start and stop at different times in each arena.
The example below shows the effect of Nesting over the first minute of the 
tracks, in an experiment with two arenas. Dots represents the samples on 
the timeline. Tracking started automatically as soon as the animal was 
detected in the arena. Because the mouse in Arena 1 was released (and 
therefore detected) earlier than in Arena 2, tracking started earlier in that 
arena. The tracks have equal duration set in the Trial Control Settings, for 
example 5 minutes. When nesting over time, we select the first minute of 
each track (from Track start to 0:01:00.000). As a result, the two track 
segments do not overlap completely on the time line.

▪ Nesting over time when working with multiple subjects per arena. Within an 
arena, tracking starts at the same time for all subjects. Therefore, nesting 
over time results in the same interval being selected for all the subjects.
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Note that tracking starts for all subjects even when one is not released yet 
in the arena. In that case the track for that subject starts with missing 
samples.
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Nesting using zones

▪ Nesting over In zone
▪ Nesting over Latency to zone
▪ Nesting over Head directed to zone
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Nesting over In zone
Aim
To pick out the data collected when one or more subjects were in a specific zone, or 
in a combination of zones.

Nesting over In zone is only necessary when you want to analyze track segments by 
combining zones or subjects. If you simply want to calculate statistics of distance, 
velocity etc. for each zone, without combining subjects or zones, see Calculate the 
results per zone.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on that subject being in specific zones, 
choose In zone under Nesting. See the procedure below. See also B in 
Nesting vs. Nesting over subjects.

▪ To select data of a subject based on other subjects being in specific zones, 
choose In zone under Nesting over Subjects. There you find the Actors 
tab where you can specify which subjects (Actors) were in the selected 
zone(s). For an example, see C, D in Nesting vs. Nesting over subjects. See 
the procedure in Nesting over subjects.

Procedure
1. In the Data Profile, under Nesting click the button next to In Zone.
2. In the In Zone window, under In the following zones, deselect Arena and 

select the zones in which the animal must be.
3. Choose the remaining options to specify which combination of zone (any, 

all, not in any) and body points. For explanation, see Dependent Variables in 
Detail > In zone.

4. Click OK. Proceed with step 4 in How to select track segments.

Notes
▪ If your experiment is set to Only center-point detection, the From 

following body points options are not available. Calculations are based on 
the center-point of the body.

▪ Select When in all selected zones only when the zones are overlapping at 
least partially (for example, North Quadrant and Center of an open field). If 
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two zones are not overlapping, selecting When in all selected zones 
results in no data being selected, because a body point can never be in two 
different locations at the same time.

Application examples
EXAMPLE 1  A Center zone has been defined in an open field. When you do Nesting 
and choose Center under In the following zones, the samples in the center of the 
open field are selected for analysis. When you visualize the track, selected samples 
are displayed in bright colors; non-selected samples are dimmed out (see below).

EXAMPLE 2  For the same open field as above, but when also tracking the nose and 
tail-base points, if you select the three body points and select All selected points 
from the list, a sample is only selected when the three body points are within the 
Center zone. In the example below, the tail-base is outside the Center zone 
(highlighted in yellow). Therefore, that sample is not selected for analysis.
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Nesting over Latency to zone
Aim
To pick out the data collected before or after the subject has entered a specific 
zone.

EXAMPLE  Calculate the velocity of the subject up to when it entered a zone for the 
first time.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the latency to enter a zone by that 
subject, choose Latency to zone under Nesting. See the procedure below.

▪ To select data of a subject based on the latency to enter a zone by other 
subjects, choose Latency to zone under Nesting over subjects. There you 
find the Actors tab where you can specify which subjects (Actors) entered 
the selected zone. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Latency to zone.
2. In the Latency to Zone window, under Settings, next to Latency to, choose 

which zone visit you want to use for your data selection.
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3. Select the zone of interest and choose from the list at the bottom of the 
window whether you want to analyze the Interval before zone visit (as in 
the example above, under Aim) or the Interval after zone visit.

4. Click the Body Points tab (when available), and specify the body points that 
Latency is based on. Next, select one of the following:
▪ All selected points. The data is analyzed before/after all the selected 

body points were simultaneously in the zone.
▪ Any selected point. The data is analyzed before/after at least one of 

the selected body points entered the zone.
5. Click OK. Proceed with step 4 in How to select track segments.

Note
▪ If you select Latency to zone under Nesting, different subjects in the same 

arena are analyzed in different track segments because the nesting criterion 
is defined based on each subject separately.

▪ If you select Latency to zone under Nesting over Subjects, different 
subjects are analyzed in the same track segments, because the nesting 
criterion is determined by the Actors specified and is valid for all the 
subjects. See Nesting over Subjects
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Nesting over Head directed to zone
Aim
To pick out the data collected when the head of the subject (or more subjects, 
named Actors) is pointing to a zone or a circular area around a point. The zone or 
point must be defined in the Arena Settings.

EXAMPLE  Calculate the velocity of the subject every time it was pointing to the 
target zone.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on when that subject points to a zone, 
choose Head directed to zone under Nesting. See the procedure below.

▪ To select data of a subject based on when other subjects point to a zone, 
choose Head directed to zone under Nesting over subjects. There you 
find the Actors tab where you can specify which subjects (Actors) were 
pointing to the selected zone. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Head directed 

to zone.
2. In the Head Directed to Zone window, select:

▪ The Zone of interest (a zone or a point of interest + a specific radius). 
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▪ When to calculate the Head directed to zone state. Use this option to 
restrict the selection criterion (e.g. calculate Head directed to zone only 
when the subject was in an area around the target zone, not the entire 
arena). 

For details about how Head directed to zone is calculated, see Dependent 
Variables in Detail > Head directed to zone.

3. Click OK. Proceed with step 4 in How to select track segments.

See also

▪ Nesting over Subjects
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Nesting over behavioral states

Aim
To pick out the data collected when the subject was in a specific behavioral state. 
Click the options here below for information.

▪ Nesting over Activity state
▪ Nesting over Acceleration state
▪ Nesting over Body elongation state
▪ Nesting over Body angle state
▪ Nesting over Movement
▪ Nesting over Mobility state
▪ Nesting over Proximity
▪ Nesting over Body contact
▪ Nesting over Relative movement
▪ Nesting over Side by side
▪ Nesting over behaviors scored manually
▪ Nesting over behaviors of Rat/Mouse Behavior Recognition
▪ Nesting over behaviors of Live Mouse Tracker

IMPORTANT You may have defined thresholds during acquisition for behavioral 
states, like Movement, Activity state or Mobility State in the Analysis Results and 
Scoring Pane. Those thresholds are not copied to Data Selection. So you have to 
adjust the thresholds here as well.
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Nesting over Activity state
Aim
To pick out data the data collected when the subject was in one of the states 
defined by the dependent variable Activity state.

EXAMPLE  Select all samples when the rat was in inactive (freezing), and based on 
this selection, make a heatmap to highlight where freezing occurred.

Procedure
1. In the Data Profile, under Nesting click the button next to Activity state.
2. In the Activity State window:

▪ Under Outlier filter, enter an Averaging interval to smooth the values 
of acceleration.

▪ Under Number of states, enter how many different categories you 
want to split the data in.

▪ Under Thresholds, enter the thresholds that defines the various 
activity states.

▪ Under Calculate nesting for, select the state that the intervals are 
based on.

▪ Under State duration threshold, enter the minimal duration of the 
state chosen in the previous step.

For details about how Activity state is calculated, see Dependent Variables 
in Detail > Activity state.

3. Click OK. Proceed with step 4 in How to select track segments.

Notes
▪ You can only nest over Activity state if you selected Activity analysis in the 

Experiment Settings, and for experiments with one subject per arena.
▪ If you want to select track segments based on more states (e.g. Active and 

Highly active), create one Nest box for each state, and combine them with 
OR logic. This selects the time when the subject was in one of those states 
(e.g. either Active or Highly active). See Basic rules for combining selection 
boxes

▪ For Activity state, it is possible to select different thresholds for nesting (see 
above) and for analysis (see Activity state in the Analysis profile). You 
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should either use the same thresholds or make the thresholds in your 
analysis profile more restrictive, so that the variable specified in the 
Analysis profile is in effect a fine-tuning of your nesting criteria.
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Nesting over Acceleration state
Aim
Pick out the data collected when one or more subjects were in one of the states 
High acceleration or Low acceleration.

EXAMPLE  Select the time intervals when the fish performed swim bursts (for this, use 
Acceleration state). Next, calculate how much time the fish was in the stimulus zone 
compared with the rest of the arena during those time fragments (for this, use the 
variable In zone).

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Acceleration state of that subject, 
choose Acceleration state under Nesting. See the procedure below.

▪ To select data of a subject based on the Acceleration state of other subjects, 
choose Acceleration state under Nesting over Subjects. There you find 
the Actors tab where you can specify which subjects (Actors) were in a 
certain Acceleration state. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Acceleration 

state.
2. In the Acceleration State window:

▪ Under Outlier filter, enter an Averaging interval to smooth the values 
of acceleration.
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▪ Under Threshold, enter the threshold that defines the state High 
acceleration and Low acceleration.

▪ Under Calculate nesting for, select the state that the intervals are 
based on.

For details about how Acceleration state is calculated, see Dependent 
Variables in Detail > Acceleration state.

3. Click the Body Points tab (when available), and specify the body points that 
Acceleration is based on. Choose whether Acceleration state is based on all 
the chosen points being in the same state simultaneously (All selected 
points) or at least one being in that state (Any selected point).

4. Click OK. Proceed with step 4 in How to select track segments.

See also

▪ Nesting over Subjects
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Nesting over Body elongation state
Aim
To pick out data collected when the subject was in one of the Body elongation 
states: Stretched, Normal or Contracted.

EXAMPLE  Analyze the time that the subject spent in the zones Object and Rest of 
arena when it was in the Stretched state. The aim is to test whether the subject spent 
more time stretched near the object than when in the rest of the arena.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Body elongation state of that 
subject, choose Body elongation state under Nesting. See the procedure 
below.

▪ To select data of a subject based on the Body elongation state of other 
subjects, choose Body elongation state under Nesting over Subjects. 
There you find the Actors tab where you can specify which subjects 
(Actors) were in a certain Body elongation state. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Body 

elongation state.
2. In the Body Elongation State window:

▪ Under Outlier filter, enter an Averaging interval to smooth the body 
elongation values.
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▪ Under Threshold, enter the thresholds that defines the states 
Stretched, Normal and Contracted.

▪ Under Calculate nesting for, select the state that the intervals are 
based on.

For details about how Body elongation state is calculated, see Dependent 
Variables in Detail > Body elongation state.

3. Click OK. Proceed with step 4 in How to select track segments.

See also

▪ Nesting over Subjects
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Nesting over Body angle state
Aim
To pick out data collected when the subject was in one of the body angle states: 
Straight or Bent (with the Bent state which can be further split into Bent 
counterclockwise and Bent clockwise).

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Body angle state of that subject, 
choose Body angle state under Nesting. See the procedure below.

▪ To select data of a subject based on the Body angle state of other subjects, 
choose Body angle state under Nesting over subjects. There you find the 
Actors tab where you can specify which subjects (Actors) were in a certain 
Body angle state. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Body angle 

state.
2. In the Body Angle State window:

▪ Under Outlier filter, enter an Averaging interval to smooth the body 
angle values.

▪ Under Threshold, enter the angle value that defines the state bent. 
▪ Under Calculate nesting for, select the Body angle state that defines 

the intervals.
For details about how Body angle state is calculated, see Dependent 
Variables in Detail > Body angle state.

3. Click OK. Proceed with step 4 in How to select track segments.

See also

▪ Nesting over Subjects
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Nesting over Movement
Aim
To pick out the data collected when the subject was in one of the movement states: 
Moving or Not moving.

EXAMPLE  Calculate the average Head direction (an estimate of body orientation in 
fish) when the subject was Moving.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Movement state of that subject, 
choose Movement under Nesting. See the procedure below.

▪ To select data of a subject based on the Movement state of other subjects, 
choose Movement under Nesting over subjects. There you find the 
Actors tab where you can specify which subjects (Actors) were in a certain 
Movement state. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Movement.
2. In the Movement window:

▪ Under Outlier filter, enter an Averaging interval to smooth the 
velocity values.

▪ Under Threshold, enter the Start velocity and the Stop velocity that 
the states Not moving and Moving are based on.
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▪ Under Calculate nesting for, select the Movement state that defines 
the intervals.

NOTE  The default values are an example and may not apply to your 
experiment. The threshold values also vary between species. If the subject is 
very slow, like a walking tick, you must reduce the two thresholds to detect 
true movement. See also Dependent Variables in Detail > Movement.

3. Click the Body Points tab (when available), and specify the body points that 
Movement is based on. Choose whether Movement is based on all the 
chosen points moving simultaneously (All selected points) or not (Any 
selected point).

4. Click OK. Proceed with step 4 in How to select track segments. 

Notes
▪ In some cases the number of samples available for smoothing can be less 

than the averaging interval entered. For example, in tracks with missing 
samples or at the beginning of the track. In such cases EthoVision XT uses 
the samples available in the specified interval. See Averaging interval

▪ When the velocity is between the two thresholds, the current state of the 
subject does not change relative to the previous sample.

▪ For Movement, it is possible to select different thresholds for nesting (see 
above) and for analysis (see Movement in the Analysis profile). You should 
either use the same thresholds or make the thresholds in your analysis 
profile more restrictive, so that the variable specified in the Analysis profile 
is in effect a fine-tuning of your nesting criteria.

See also

▪ Nesting over Subjects
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Nesting over Mobility state
Aim
To pick out data collected when the subject was in one of the Mobility states: 
Immobile, Mobile or Highly Mobile.

EXAMPLE  Calculate the average velocity for when the subject was in the state Highly 
mobile.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Mobility state of that subject, 
choose Mobility state under Nesting. See the procedure below.

▪ To select data of a subject based on the Mobility state of other subjects, 
choose Mobility state under Nesting over subjects. There you find the 
Actors tab where you can specify which subjects (Actors) were in a certain 
Mobility state. See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Mobility state.
2. In the Mobility State window:

▪ Under Outlier filter, enter an Averaging interval to smooth the 
Mobility values.

▪ Under Threshold, enter the thresholds of the mobility variable that 
define the states Immobile, Mobile and Highly mobile. 
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▪ Under Calculate nesting for, select the Mobility state that defines the 
intervals. 

For details about how Mobility state is calculated, see Dependent Variables 
in Detail > Mobility state.

3. Click OK. Proceed with step 4 in How to select track segments. 

Notes
▪ For Mobility state, it is possible to select different thresholds when you 

define Mobility state in Nesting (see above) and in the Analysis profile (see 
Calculate statistics: procedure). You should either use the same thresholds 
or set the thresholds in your analysis profile more restrictive, so that the 
variable specified in the Analysis profile is in effect a fine-tuning of your 
nesting criteria.

▪ In some cases the number of samples available for smoothing can be less 
than the averaging interval entered. For example, in tracks with missing 
samples or at the beginning of the track. In such cases EthoVision XT uses 
the samples available in the specified interval. See Averaging interval

Notes
▪ If you select Mobility state under Nesting over subjects, and you select 

two or more subjects in the Actors tab of the settings window, you have the 
following options:
▪ To analyze the track segment when at least one of those subjects was in 

the selected Mobility state, choose Any selected subject. 
▪ To analyze the track segments when all the selected subjects were in 

the selected Mobility state simultaneously, choose All selected 
subjects. 

See also

▪ Nesting over Subjects
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Nesting over Proximity
Aim
To pick out data collected when one or more subjects (Actors) were within a user-
defined distance from one or more other subjects (Receivers).

EXAMPLE  Calculate the average mobility when the subject was in proximity of other 
subjects.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Proximity behavior of that subject, 
choose Proximity under Nesting. In the Receivers tab you specify which 
subject was in proximity of the focal subject. See the procedure below.

▪ To select data of a subject based on the Proximity behavior of other 
subjects, choose Proximity under Nesting over Subjects. There you find 
the Actors tab and the Receivers tab where you can specify which subjects 
(Actors) were in proximity of which other subjects (Receivers). See Nesting 
over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Proximity.
2. In the Proximity window, select the Proximity state that defines the intervals 

to analyze.
▪ Enter the In proximity threshold and the Not in proximity threshold.
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▪ Under Calculate nesting for, choose which state defines the intervals.
For details about how proximity is calculated, see Dependent Variables in 
Detail > Proximity.

3. Click the Body Points tab (when available), and specify the body points that 
define proximity. Choose whether proximity is based on all the chosen 
points being in proximity simultaneously (All selected points) or not (Any 
selected point).

4. Click OK. Proceed with step 4 in How to select track segments. 

See also

▪ Nesting over Subjects
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Nesting over Side by side
Aim
To pick out data occurring when two subjects were side by side within a proximity 
threshold distance.

EXAMPLE  Calculate the average velocity of the subject when it was side-by-side with 
another subject, pointing to the same direction.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Side-by-side behavior of that 
subject, choose Side by side under Nesting. In the Receivers tab you 
specify which subject was side-by side with the focal subject. See the 
procedure below.

▪ To select data of a subject based on the Side-by-side behavior of other 
subjects, choose Side by side under Nesting over Subjects. There you find 
the Actors tab and the Receivers tab where you can specify which subject 
(Actor) was side by side with which other subjects (Receivers). See Nesting 
over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Side by side.
2. In the Side by side window, either enter the proximity threshold distance or 

accept the default value (see below for details). 
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3. Under Calculate nesting for, choose which state of the Side by side 
variable defines your selection: either Side by side, same direction or Side 
by side, opposite direction.
For details about the Side by side variable, see Dependent Variables in Detail 
> Social > Side by side.

4. Click the Receivers tab and select which subjects should be in proximity 
with the focal subject

5. Click OK. Proceed with step 4 in How to select track segments.

Note
▪ The default proximity threshold distance is 5.26 cm. This corresponds to the 

threshold used in Live Mouse Tracker, that is, 2 x 15 = 30 pixels, where 15 is 
the original value of MAX_DISTANCE_HEAD_HEAD_GENITAL_THRESHOLD in 
Live Mouse Tracker, and the scale factor for converting pixels to cm is 10/57.

▪ If you select multiple subjects A, B, etc. in the Receivers tab, and select the 
option All selected subjects, then the track segments are selected when 
the focal subject was side by side with A, B, etc. simultaneously. That may 
not occur often. Instead, select Any selected subject if you want to analyze 
the track segments when the focal subject was side by side either with A, or 
B, etc. 

See also

▪ Nesting over Proximity
▪ Nesting over subjects
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Nesting over Body contact
Aim
To pick out the track segments corresponding to when one the subject was in 
contact or not in contact with another subject.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on that subject being in contact with any 
other subject, choose Body contact under Nesting. In the Receivers tab 
specify which subject was in contact with the focal subject. See the 
procedure below.

▪ To select data of a subject based on when other subjects were in contact 
with any subject, choose Body contact under Nesting over Subjects. 
There you find the Actors tab where you can specify which subjects were in 
contact with any other subject. See the notes below and also Nesting over 
subjects.

Procedure
1. In the Data Profile, under Nesting click the button next to Body contact.
2. In the Body contact window, select the state that defines the intervals to 

analyze. 
For details on how Body contact is calculated, see Dependent Variables in 
Detail > Body contact.

3. Click OK. Proceed with step 4 in How to select track segments. 

Notes
▪ TIP  You can nest over “No contact” to filter out all the instances of body 

contact. For example, if contact situations result in subject identity swaps or 
nose-tail swaps. 

▪ If you select Body contact under Nesting over subjects, the Actors tab is 
also available. The track segments are selected based on the Body contact 
of the Actors. For example, if the arena contains three subjects and in the 
Actors tab you select Subject 1 and Subject 3, the data are selected when 
both Subject 1 and 3 are in contact with any subject, or when at least one of 
them is in contact with any other subject. For details and examples, see 
Nesting over subjects. With Nesting over subjects, you cannot specify 
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body contact between two specific subjects. If you select Subject 1 and 
Subject 3 in the Actors tab, you will not get the track segments when those 
two subjects are in contact. Instead, you get the track segments when, 
depending on the options you choose, both subjects (or at least one) are in 
contact with any subject.
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Nesting over Relative movement
Aim
To pick out data collected when one or more subjects (Actors) were moving to or 
away from one or more other subjects (Receivers).

EXAMPLE  Analyze the velocity when the subject was moving away from another 
subject.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the Relative movement of that subject, 
choose Relative movement under Nesting. In the Receivers tab you 
specify which subject the focal subject was moving to/from. See the 
procedure below.

▪ To select data of a subject based on the Side-by-side behavior of other 
subjects, choose Side by side under Nesting over Subjects. There you find 
the Actors tab and the Receivers tab where you can specify which subject 
(Actor) was moving to/from which other subjects (Receivers). See Nesting 
over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to Relative 

movement.
2. In the Relative Movement window:

▪ Enter the Maximum interaction distance.
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▪ Enter the Minimum velocity that defines movement. 
▪ Under Calculate nesting for, choose the state that defines the 

intervals.
For details about how Relative movement is calculated, see Dependent 
Variables in Detail > Relative movement.

3. Click the Body Points tab (when available), and specify the body points that 
define movement. Choose whether movement is based on all body points 
moving simultaneously (All selected points) or not (Any selected point).

4. Click OK. Proceed with step 4 in How to select track segments.

Notes
On the Receivers tab: 

▪ To select the samples when one subject moves to the other, select both 
subject 1 and subject 2, and choose Any selected subject from the list.

▪ To select the samples when one specific (focal) subject moves toward other 
subjects simultaneously, do not select the focal subject under Receivers. 
Select all the other subjects and choose All selected subjects from the list.

See also

▪ Nesting over Subjects
▪ Dependent Variables in Detail > Relative movement
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Nesting over behaviors scored manually
Aim
To can pick out the track segments in which a behavior was scored manually. To 
learn more about manually scoring behaviors, see Manual scoring settings and 
Score behaviors manually during acquisition.

EXAMPLE  You manually scored freezing behavior, and you want to visualize where in 
the arena it occurred during the trial. First, nest over the manually-scored behavior 
Freezing (see below for the procedure), then create the heatmaps.

Nesting vs. Nesting over Subjects
Notice the difference when there are multiple subjects in the same arena:

▪ To select data of a subject based on the behavior of that subject, choose 
that behavior under Nesting. See the procedure below.

▪ To select data of a subject based on the behavior of other subjects, choose 
that behavior under Nesting over Subjects. There you find the Actors tab 
where you can specify which subject (Actor) was performing that behavior. 
See Nesting over subjects

Procedure
1. In the Data Profile, under Nesting click the button next to the behavior’s 

name, or the group of behaviors it belongs to.
2. In the window that appears, select the behavior and click OK.

If you want to analyze the track segments in which the behavior was not 
active, select Not [behavior name].

3. Click OK. Proceed with step 4 in How to select track segments.

Notes
▪ If the behavior is part of a mutually-exclusive group, under Nesting you see 

the name of the group, not the individual behavior.
▪ If you select a behavior from a mutually-exclusive group, the other 

behaviors of the same group are automatically left out of analysis and 
visualization.
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Nesting over behaviors of Rat/Mouse 
Behavior Recognition
Aim
To pick out the samples collected when the subject was in one or more of the 
behavioral states detected using the Rat or Mouse Behavior Recognition function:

EXAMPLE  You want to visualize where in the arena Grooming occurred. First, nest 
over Grooming (see the procedure below), then create heatmaps.

Procedure
1. In the Data Profiles screen, under Nesting, click the button corresponding 

to the behavior you want to use to select the track segments.
2. In the window that appears, select the properties and which state you want 

to consider for nesting. Then, click OK. See also Behavior Recognition in the 
Analysis profile.
If you want to analyze the track segments in which the behavior was not 
active, select Not [behavior name].

3. Click OK. Proceed with step 4 on How to select track segments.

Options

Behavior decision method

The Behavior decision method acts as a filter that you can use to ignore samples 
where the behavior’s probability is below a certain value. Default means that 
EthoVision uses the original scores (thus no filtering based on probabilities).

The figure below shows the effect of Behavior decision method on the track 
segment selected for analysis. Top: The probability of Grooming, and another 

Digging (only for mice) Rearing unsupported

Drinking Rearing supported

Eating Resting

Grooming Sniffing

Jumping (only for rats) Walking

Merged behavior
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behavior plotted against time (for simplicity, other behaviors are ignored here). 
Bottom: When Nesting over Grooming. With Default selected, analysis is done on 
the samples for which the probability of Grooming exceeds the probability of any 
other behavior (default behavior recognition). With a set Probability > 50%, 
analysis is done on the samples for which the probability is higher than 50%. The 
higher the value, the more conservative the selection.

▪ If you want to select the samples when a behavior probability was lower 
than a certain value, choose that value, then under Calculate nesting for, 
select Not [behavior name].

▪ To choose a specific probability threshold, it is best to view the per-sample 
values of probability for that behavior. In the Analysis profile, under Rat/
Mouse Behavior Recognition select Behavior probability, and select the 
behavior(s) you are interested in. Choose Plot Integrated Data to see the 
probability values plotted against time.
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Notes (all behaviors)
▪ This nesting option is only available if you have the Rat or Mouse Behavior 

Recognition add-on module.
▪ Since Hopping (mouse behavior) and Twitching are events with no duration, 

it is not possible to nest over those behaviors.
▪ If you want to pick out samples based on two or more behaviors and 

analyze them together as if they were one (for example, Rearing 
unsupported and Rearing supported), click next to Merged Behavior 
instead. See Notes about Merged behavior

▪ If you want to calculate duration of a behavior as a percentage of a track, 
but excluding the time scored as Unknown, make two nesting criteria, one 
with [behavior name] and the other with Not [behavior name] selected. 
Combine the resulting boxes with OR logic and then in the Analysis profile 
define the behavior you are interested in, and under Trial statistics choose 
the statistic Cumulative Duration within Nesting (%).

▪ The Behavior duration threshold acts as a filter to ignore short transitions 
between states. See also Behaviors detected with Behavior recognition in 
the Analysis profile.

Notes about Merged behavior
▪ Nesting over Merged behavior. When you select multiple behaviors under 

Merged behavior, the track segments are selected in which the subject was 
in one of the selected states, and then combined with OR logic.

▪ Nesting over “Not” Merged behavior. The Merged Behavior window does not 
allow you to select Not [behavior name]. If you want to select the samples 
when two or more behaviors were not active, then make a Nesting criterion 
for each behavior, selecting Not [behavior name], then place the resulting 
Nest boxes in a linear sequence (see Basic rules for combining selection 
boxes). 
Note that the track segments are not selected when the behavior is 
Unknown, or when no behavior is scored in that segment (this is 
represented as a gap between behaviors).
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Nesting over behaviors of Live Mouse 
Tracker
Currently it is possible to select track segments based on the behavior Look of Live 
Mouse Tracker data. Data are selected when they occur at the same time as the 
chosen state. 

Procedure
1. In the Data profile, under Nesting, or Nesting over Subjects, choose Look.
2. Choose the state of this variable, either Look_up or Look_down. 

▪ To select data of a subject based on the Look behavior of that subject, 
choose Look under Nesting.

▪ To select data of a subject based on the Look behavior of other 
subjects, choose Look under Nesting over Subjects. There you find 
the Actors tab where you can specify which subject (Actor) performed 
that behavior. See Nesting over subjects

3. Click OK. Proceed with step 4 in How to select track segments.

See also

For an overview of Live Mouse Tracker analysis variables, see Live Mouse Tracker.
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Nesting over a Trial Control state
Aim
To pick out the track segments corresponding to a Trial Control state. A Trial Control 
state is an interval defined by two events occurred during the trial (a condition met, 
a sub-rule started, an action taken etc.). To learn more about Trial Control states, see 
Trial Control state in the Analysis profile.

EXAMPLE Calculate the average velocity of the subject between the time that the 
light went on to the time that the pellet was given.

To nest over a Trial Control state
1. In the Data Profile, under Nesting click the button next to Trial Control 

state.
2. In the Trial Control State window, select the Trial Control elements that 

define the start and the stop of the interval to analyze. 
For details about how you can define a Trial Control state, see Dependent 
Variables in Detail > Trial Control state.

3. Click OK. Proceed with step 4 in How to select track segments.

Notes
▪ If the Trial Control state occurs more times in your trial, like those defined 

with events in a subrule, there will be multiple selection intervals in one 
trial. You have the following options:
▪ Select Calculate result for interval if you want to restrict your 

selection to just one interval, for example the first one, or the third one. 
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Next to For consecutive intervals, enter the number of the interval (1 
for the first).

▪ Leave Calculate result for interval not selected if you want to select 
all the resulting intervals. Analysis is based on all those intervals 
merged in one.

▪ The Actors tab in the Trial Control state window is of no use, because Trial 
Control states occur at the trial and arena level, independent of the 
subjects. You cannot assign a Trial Control state to a specific subject.
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Nesting over a Free interval

With Nesting over a Free interval you can define the beginning and the end of a 
track segment, and analyze the dependent variables within that segment.

For example, define an interval that goes from the start of the track to when the 
subject has explored an object for a total of 30 seconds. Then, analyze the zones 
that the subject visited, or calculate the average speed in that interval.

▪ Nest over a Free interval
▪ Examples of Nesting over a Free interval

See also:

▪ Free interval in the Analysis profile
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Nest over a Free interval
Aim
To pick out the track segments corresponding to a Free interval, i.e., the interval 
included between event (or time) A and event (or time) B. See Examples of Nesting 
over a Free interval

EXAMPLE  Analyze the mobility of the subject in the five seconds immediately 
following administration of a stimulus. In this example, event A is the onset of the 
stimulus. Event B occurs 5 seconds after A.

Nesting vs. Nesting over Subjects
If your trials contain multiple subjects in the same arena and you want to analyze 
data of one subject based on the behavior of another subject, click Free Interval 
under Nesting over Subjects. See Free interval based on multiple subjects.

Procedure
1. In the Data Profile, under Nesting click the button next to Free Interval.
2. In the Free Interval window, specify the criteria that define the start and 

stop of the interval.
For details about how you can define a free interval, see Dependent 
Variables in Detail > Free interval.

3. Click OK. Insert the resulting Nest box in the appropriate position between 
the Start and the Result box. See How to select track segments
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Notes
▪ IMPORTANT  If a start criterion is not met in a track, EthoVision XT does not 

select any interval for that track.
▪ The following dependent variables are not available for the definition of 

start/stop criteria: Activity state, Acceleration state, and the behaviors of Rat 
and Mouse Behavior Recognition.

▪ Note the difference:
▪ You define a Free Interval in the Data Profile when you want to analyze 

any dependent variable within the resulting track segment. For example, 
to calculate the average velocity of the subject in a certain track 
segment.

▪ You define a Free Interval in the Analysis Profile when you want to 
analyze the interval itself. For example you can calculate the duration of 
an interval. However, you won’t get, for example, the average velocity 
in the resulting track segment. See Free interval in the Analysis profile

▪ Multiple occurrences of the interval. If the interval defined in the Data profile 
results in multiple occurrences within a track, you can nest over a specific 
interval occurrence. Select Calculate results for interval and enter the 
number of the occurrence. For example, 10 to nest over the 10th 
occurrence of the interval. Other occurrences are not used in the analysis. 

If you do not select Calculate results for interval, analysis is done in all 
occurrences merged into one result.

▪ Nest over a Free interval based on external data. If you imported external 
(physiological) data, you can analyze the track segments that correspond to 
a free interval based on external data. For example, Nest over a Free interval 
that goes from the track start to when Heart rate reaches 400 bpm. 
TIP   If you want to select the track segments between two values of external 
data, for example from Heart rate = 300 to Heart rate = 400, then choose 
Nest over external data (state) instead. 
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Examples of Nesting over a Free interval
Example 1: Analyze the first 20 cm of swim path in a water 
maze

Aim

Suppose you want to analyze the movement of the subject in the initial swim path, 
say in the first 20 cm. A Data profile with Free interval “From track start to Total 
distance moved 20 cm” is defined.

The double arrow indicates the duration of the resulting interval. In the Analysis 
profile you can then for example define the heading angle of the subject, which will 
be calculated for that interval.

Solution

In the Data profile, under Nesting choose Free interval, with:

▪ Start criterion: Track start.
▪ Stop criterion: Dependent variable Distance moved, Statistic Total, is >= 20 

cm.
Note that the Total Distance moved is unlikely to be exactly 20 cm at a given sample 
time; for this reason, the end criterion says “>= 20 cm”.

Next, in the Analysis profile choose the variable you want to calculate, for example 
Heading to point, or Turn angle. Then choose Analysis > Results > Statistics and 
Charts.
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See also

▪ Analysis advisor: Analysis in relation to the path

Example 2: Analyze the time up to when the subject has 
explored an object for 30 seconds

Aim

In a novel object experiment, the trial lasts for example 5 minutes. Subjects often 
differ in the amount of time spent exploring the objects. The researcher wants to 
analyze the same exploration time across subjects, for the object labeled as zone 
“Familiar object”.

Solution

In the Data profile, under Nesting choose Free interval, with:

▪ Start criterion: Track start.
▪ Stop criterion: Dependent variable In zone, Statistic Cumulative duration, is 

>=30 s. In zone is a dependent variable defined for the zone “Familiar 
object” and the body point “nose-point”.

Next, in the Analysis profile choose the variable you want to calculate, for example 
In zone, to calculate the number of exploration events in the 30 s of exploration 
time. Then choose Analysis > Results > Statistics and Charts.

See also

▪ Zone visits (entries and time spent)
▪ Other analyses with zones

Example 3: Compare two intervals, 5-s before vs 5-s after a 
stimulus

Aim

In a DanioVision experiment, a white light stimulus is presented to zebrafish larvae. 
The researcher wants to compare the movement parameters of the animals in the 5 
s before the onset of the stimulus, with those in the 5 s thereafter.
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Solution

In the Data profile, create two Free intervals based on Trial Control.

The first free interval goes from 5 seconds before “Action: Light on” to 0 s after start 
event (which is “Action: Light on”).

The second free interval goes from 0 s before “Action: Light on” to 5 s after start 
event (which is “Action: Light on”).

Connect the two Nest boxes to different Result boxes. To create an additional 
Result box, under Common elements click the button next to Result. See Multiple 
selections in a data profile
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Next, in the Analysis profile choose the variable you want to calculate, for example 
Movement, to quantify movement in the selected periods of time. Then choose 
Analysis > Results > Statistics and Charts.
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Nesting over a Multi condition
Aim
To pick out the track segments corresponding to a Multi condition. To get an idea of 
what a Multi condition is, see Multi condition in the Analysis profile.

You can also define complex selections by combining two or more Nesting boxes. 
See Multiple nesting criteria. However, there are limitations. For example, you 
cannot select the points when “Distance to zone was less than 10 cm” using a Nest 
box. However, you can do that by creating a Multi condition.

EXAMPLE  Select all the points in the track when (a) the subject’s Body elongation 
state was Stretched and (b) its Distance from the zone Object was less than 10 cm. 
Then, create a heatmap.

Procedure
1. In the Data Profile, under Nesting click the button next to Multi condition.
2. In the Multi Condition window, specify the single conditions that define the 

Multi condition.
3. Combine the conditions with either All conditions are true (AND logic) or 

Any condition is true (OR logic).
For details, see Dependent Variables in Detail > Multi condition.
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4. Click OK. Insert the resulting Nest box in the appropriate position between 
the Start and the Result box. See How to select track segments

Nesting vs. Nesting over Subjects
If your trials contain multiple subjects and you want to analyze one subject in Multi 
condition based on the behavior of another subject, click Multi condition under 
Nesting over Subjects. See Nesting vs. Nesting over subjects

Notes
▪ Note the difference:

▪ You define a Multi condition in the Data Profile when you want to 
analyze any dependent variable within the resulting track segment. For 
example, to calculate the average velocity of the subject when a Multi 
condition is true.

▪ You define a Multi condition in the Analysis Profile when you want to 
analyze the interval itself. For example when you want to know the total 
duration of the Multi condition being true. However, you won’t get, for 
example, the average velocity in the resulting track segment. See Free 
interval in the Analysis profile
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Nesting over External data

Aim
To pick out the track segments and the associated external data corresponding to a 
specific range of values in the external data signal.

EXAMPLE  Select all intervals when heart rate was above a certain value. Then analyze 
distance moved, velocity, and movement.

Procedure
1. In the Data profile, under Nesting, click the Add button next to [data set 

name] state.
2. Define the state variable. For details, see External data - state in the Analysis 

profile.
3. Click OK. Proceed with step 4 on How to select track segments.

Notes
▪ The track segments are based on the values of external data calculated on 

the re-sampled signal, not the original (imported) signal.
▪ If you have chosen the variable under Nesting over Subjects, the Actors 

tab is also available. Select the subjects whose state define the nesting 
intervals. If you select two or more subjects, select: 
▪ Any selected subject. To analyze the time that at least one subject was 

in that state.
▪ All selected subjects. To analyze the time that all subjects were in that 

state simultaneously.
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Nesting over Subjects
Learn about

▪ Nesting vs. Nesting over subjects
▪ Nesting over subjects

See also

▪ How to select track segments
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Nesting vs. Nesting over subjects
Aim
To select track segments based on the behavior of one or more subjects. In 
experiments with multiple animals per arena, the Data profile offers two types of 
nesting options, 

Prerequisite
▪ You have the Social Interaction Module.

Nesting
To analyze the track segments of a subject based on that subject’s behavior, choose 
an option under Nesting, and follow the procedure on How to select track 
segments on page 782.

Result: Each subject will be analyzed in different track segments (intervals), 
according to its own behavior (see B in the figure below).

Nesting over Subjects
To analyze the track segments of a subject based on the behavior of a specific 
subject (or combination of subjects, called Actors), choose an option under 
Nesting over Subjects, and select the Actors. See Nesting over subjects on 
page 837.

Result: Within the same arena, subjects will be analyzed in equal track segments, 
according to the behavior of the Actors (see C and D in the figure below).
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Notes
▪ Arenas are independent replicates. Therefore, nesting intervals are applied 

to each arena separately depending on the state of their subjects.
▪ Selecting Time under Nesting or Nesting over Subjects makes no 

difference, because within one arena the tracks of multiple subjects start at 
the same time.
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Effect of Nesting in one arena with three animals. Dotted lines: tracks. Black bars: 
time intervals when a behavioral state or Trial Control state is active (for example: In 
zone for the variable In zone, or Highly mobile for Mobility). White bars: data 
selected for analysis. A: Original data. B: Results of Nesting. Track segments are 
selected according to the state of the corresponding subject. C: Results of Nesting 
over Subjects, with one subject selected in the Actors tab. D: Results of Nesting 
over Subjects, with two or more subjects selected in the Actors tab. For reasons of 
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space, the combinations “Any/All of Subjects 1 and 3” and “Any/All of Subjects 2 and 
3" are not displayed.
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Nesting over subjects
Aim
To analyze the track segments of a subject based on the behavior of a specific 
subject or combination of subjects, called Actors.

This option is only available if you track two or more subjects simultaneously in the 
same arena.

Prerequisites

Procedure
1. In the Data profile, choose the variable under Nesting over Subjects.
2. Click the Actors tab of the nesting window. See also How to select track 

segments

3. Select the actors of the behavior defining the interval. Select the subject 
that should show the behavior of interest. If you select two or more subjects 
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in the Actors tab, select one of the two options from the list immediately 
below the Subjects box:
▪ All selected subjects: To analyze the samples when all the actors show 

that behavior simultaneously. 
▪ Any selected subject: To analyze the samples when at least one actor 

shows that behavior.

4. If the Actors tab also contains the Body points options, select one or more 
body points of the subjects selected above. 

5. For the dependent variables of social interaction, a Receivers tab is also 
available. Receivers are the subjects towards which the behavior of the 
Actor is directed. For example:
▪ To analyze when Subject 2 is moving to Subject 1, Subject 2 is the 

Actor and Subject 2 is the Receiver. 
▪ To analyze when Subject 1 is in proximity of Subject 2, Subject 1 is the 

Actor and Subject 2 is the Receiver. 
Click the Receivers tab and select the subjects that you want to define 
Receivers (see an example below). 

6. Click OK. Proceed with step 4 in How to select track segments. 
IMPORTANT Be careful when selecting the same subject under Actors and Receivers. 
In such case you may also get unwanted selections, for example Subject 1's nose 
point (Actor) In proximity of Subject 1's tail base (Receiver). The resulting selection 
has little meaning.

EXAMPLES

▪ Social interactions. You want to analyze the time that the nose-point of 
Subject 1 was in proximity of the tail-base point of Subject 2 (ano-genital 
sniffing).
Solution: Subject 1 is Actor, Subject 2 is Receiver.

▪ Under Nesting over Subjects, click the button next to Proximity.
▪ In the Actors tab select Subject 1 and deselect Subject 2. Under Body 

points, select Nose-point only. 
▪ In the Receivers tab select Subject 2 and deselect Subject 1. Under 

Body points, select Tail-base point only.
If you want to select the time that the nose point of Subject 1 was in 
proximity of the tail-base point of Subject 2, or vice versa, create two 
nesting boxes, one that specifies Subject 1's nose in proximity of Subject 2's 
838



tail base, and the other that specifies Subject 2's nose in proximity of 
Subject 1's tail base. Next, combine the two boxes with OR logic (see Basic 
rules for combining selection boxes).

▪ One Actor, no Receivers. You want to select the track segments when Subject 
2 was moving, and quantify the distance moved by other subjects in that 
period of time.
Solution: Subject 2 is the Actor. Under Nesting over Subjects, click the 
button next to Movement. 

▪ In the Actors tab select Subject 2 and deselect the other subjects. 
▪ In the Analysis profile, select Distance moved. The statistics results 

refer to each subject in the specified interval.
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Results per time bin
Aim
To split tracks into segments of equal duration. You can then show results for each 
time bin. Time bins are different from Nesting over time.

Procedure
1. In the Data profile, click the Settings button on the Result box. 

If your data profile contains more Result boxes, open the one 
corresponding to the data you want to be split in time bins.

2. In the Result Settings window, select Results per time bin.
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3. Under Settings, select:
▪ The Length of the single interval (range: 0.001 second to 24 hours).
▪ Ignore last time bin if incomplete. To exclude the last interval in the 

case this is of a shorter duration than the Length you have set. 
▪ Apply to all Results. Select this option if your data profile contains 

more than one Result box and you want to apply time bins to all of 
them.

4. Click OK.

Notes
▪ Results per time bin is applied for each track separately.

▪ In a setup with multiple arenas, tracking can start at different times for 
each arena, depending on when the Trial Control's Start conditions are 
met in the arenas. Therefore, the same time interval may refer to 
different 'real' times for different arenas.

▪ In a setup with multiple subjects per arena, tracking starts 
simultaneously for all the subjects in each arena. Therefore, the same 
time interval refers to the same 'real' time for all the subject in that 
arena.

▪ If you select a time bin length that is short compared to the sample rate, 
bear in mind that (1) Increasing the number of time bins increases the 
calculation time. (2) If the length of the time bins is shorter than the sample 
time, only some of the time bins will contain a sample.
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▪ If the length of the time bins is not a multiple of the sample length, the time 
bins will differ in the number of samples they contain. For example with a 
sample rate of 1 per second and a time bin length of 1.5 second, half the 
time bins will contain 1 sample and the others will contain 2. 

▪ If you use time bins in combination with Nesting or Filtering, the time bins 
outside the data selection are shown in the table headers but with no 
results. In the example below, time bins of 10 seconds were used and a time 
interval was created with Nest over Time from 20 to 30 seconds.

▪ If you specify more than 1000 time bins in your Data profile, the group 
charts are not displayed. See Group charts
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Complex Data Selections

Main topics and tasks
▪ Combining selection boxes  844
▪ Multiple selections in a data profile  854
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Combining selection boxes
Selection boxes can be combined in a variety of ways to create complex data 
selections.

Learn about
▪ Basic rules for combining selection boxes
▪ Order of selection boxes in a sequence

What do you want to do?
▪ Use Multiple filters
▪ Use Multiple nesting criteria
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Basic rules for combining selection boxes
Boxes in a linear sequence = AND logic
When you line up boxes in a single sequence, the data in the Result box (and thus 
selected for analysis) satisfy all conditions set by the boxes (AND logic).

EXAMPLE  Select the samples in the center of the open field (Nest; second box), AND 
only for subjects with the value of the independent variable Treatment = Injected 
(Filter; third box).

Boxes in parallel = OR Logic
When you split a sequence in two or more branches which end in the same Result 
box, the data in the Result box (and thus selected for analysis) satisfy either one 
condition or another set in those branches. (OR logic).

EXAMPLE  Select all samples when the animal was either Moving (Nest, top box) OR 
Mobile (Nest; bottom).
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Multiple filters
To filter by two or more values of a variable
Specify those values in one Filter box.

EXAMPLE  A Morris water maze experiment contains a number of trials of different 
type, either training or probe. Training trials are marked with t1, t2, etc. according to 
their position in a sequence, using the user-defined variable Trial type. You want to 
analyze the tracks for type t1 and t2, not probes (p). 

1. Create a Filter box corresponding to the filtering variable. 
2. Specify the values of the variable.
3. Insert the Filter box in the sequence.
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To filter by two or more variables
Create one box per variable. 

Connect them between the Start box and the Result box using the logic you 
require. See Basic rules for combining selection boxes.

EXAMPLE  Your experiment contains a number of tracks recorded for two groups of 
subjects, Young and Aged, and on a variable number of days after the treatment. 
You want to calculate the statistics for the Young subjects, and for the Day 1 after 
the treatment.

We assume here that Group and Day have been entered as user-defined variables. 
Since the selection criteria depend on different variables, place the Filter boxes one 
after the other; which comes first does not matter.
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Multiple nesting criteria
To nest over multiple values of the same variable

▪ For variables like In zone, specify those values in one Nest box. 
▪ For variables with more than 2 states, like Body elongation state, Activity 

state and Mobility state, create one Nest box per value, and combine the 
resulting boxes with OR logic.

EXAMPLE 1  With the variable In zone

You want to visualize the track segments when the subject was entirely in one of the 
open arms of the Elevated plus maze. Each open arm has been defined as a zone.

1. Create a Nest box corresponding to the variable; in this example, In zone. 
2. Specify your selection.
3. Insert the Nest box in the sequence.

Analysis is done on the samples collected when the center point, nose-point and 
tail-base of the subject were all in either in open arm 1 or in open arm 2 of the plus 
maze.

NOTES

▪ If the zones do not overlap, from the In the following zones list select 
When in any of the selected zones (OR logic).

▪ If the zones do overlap, and you want to select the time when the subject 
was in the intersection of those zones, from the In the following zones list 
select When in all selected zones (AND logic).
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EXAMPLE 2  With the variable Activity state

You want to select the track segments when the subject was either Active or Highly 
active. It is assumed here that Activity state is defined with 3 possible states: 
Inactive, Moderately active, Highly active.

1. Create a Nest box for the variable Activity state. Under Calculate nesting 
for, choose Moderately active.

2. Create a second Nest box for Activity state. Under Calculate nesting for, 
choose Highly active.

3. Combine the Nest boxes with OR logic. See Boxes in parallel = OR Logic.
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To nest over two or more variables
Create one Nest box per criterion. 

To refine nesting according to two or more nesting criteria, create the 
corresponding Nest boxes and connect them between the Start box and the Result 
box using the logic you require. 

EXAMPLE  You want to visualize the track segments when the animal was completely 
in the center of the open field AND its body was stretched. The center of the open 
field was defined as a zone.
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If you want to nest over multiple values of the same variable (for example, nest over 
Highly mobile AND Mobile of the variable Mobility), create one Nest box per value 
and connect them using the logic you require (AND, OR or Multiple Results).
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Order of selection boxes in a sequence
In some instances the order in which you place selection boxes in the Data selection 
sequence may be important

Filter boxes
▪ If two or more Filter boxes refer to different variables (for example, one to 

filter trials, another one to filter drug doses), then the order you place the 
Filter boxes in does not matter. 

▪ If two or more Filter boxes refer to the same variable, then selection will 
only work if the elements selected in the second box are also selected in the 
first box. 

EXAMPLE  If you filter male subjects in one Filter box and female subjects in the 
second Filter box, the selection contains no data. 

Nest boxes
The order you place the Nest boxes relative to Filter boxes does not matter.
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Multiple selections in a data profile
You can create different data selections in the same Data profile. Each sequence of 
boxes must end in a separate Result box. When you analyze the data using that 
Data profile, the results (statistics, track plots, or heatmaps) are displayed for each 
selection separately.

TIP With large data sets, you may have a large number of possible data selections. 
Create multiple Data profiles, each specifying one of those selection criteria, and 
then run batch calculations for each combination between Data profiles and 
Analysis profiles.

EXAMPLE  Tracks have been recorded for a number of animals at Day after treatment 
1 and 2. Day after treatment is an independent variable. You want to calculate 
statistics for the two groups separately, but also with all tracks pooled together.

Connect each Filter sequence to a separate Result box. To add a Result box, click 
the button next to Result in the Components pane.

The first Result box receives the data after filtering with the independent variable 
Day after treatment = 1. The second Result box receives the data after filtering with 
Day after treatment =2. The third Result box receives all data. The statistics are 
calculated separately for each criterion.
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TIP  click the Settings button in a Result box to change its name, Enter a name 
associated with the selection (for example, “Day 1”). You will see this name in the 
results table.

In the analysis results, you can see which output is produced by which Result box. 
Look up the Result header.

See also

▪ Analyze groups of tracks
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Visualize Data

Main topics and tasks
▪ Introduction to Data visualization  857
▪ Plot tracks  863
▪ Plot heatmaps  873
▪ Plot integrated data  896
▪ Customize tracks and plots  916
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Introduction to Data visualization
Learn about

▪ Important terms in data visualization
▪ Useful things to know in data visualization
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Important terms in data visualization
Track plot
Visualization of one or multiple trials, where the subject’s position is displayed over 
a static (background) image. Use track plots to visually inspect trials and compare 
the effect of experimental treatments. 

▪ See Plot tracks

Heatmap
Visualization of one or multiple trials, where the density of sample points is 
represented as a color. It is useful to find hotspots. 

▪ See Plot heatmaps
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Integrated data
Combines visualization of tracks (see above) with video (when present), and 
dependent variables and external data (when present) plotted against time. 

▪ See Plot integrated data
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Useful things to know in data 
visualization
To visualize the data
Do one of the following:

▪ Choose Analysis > Results > one of the options Plot Tracks, Plot 
Heatmaps, or Plot Integrated Data.

▪ In the Experiment Explorer, under Results, click Track Visualization, 
Heatmap Visualization, or Integrated Visualization.

To visualize a specific data set
On the toolbar, choose the Track Smoothing profile, Data Profile and Analysis 
Profile, and a trial (for Integrated visualization).

To customize track colors, data points etc.
Choose the options on the right-hand pane.
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See also

▪ Customize tracks and plots

To customize the elements on your screen
Click the Show/Hide button at the top-right corner and choose the options you 
require.

See also

▪ Customize tracks and plots

To move and resize windows
▪ To move a window, click its title bar and drag it to the desired position. You 

can either dock a window or let it float on the screen.
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▪ To resize a window, point with your mouse to the window's left or top 
margin so the mouse pointer turns to a double arrow. Drag the margin to 
the desired position.
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Plot tracks
What do you want to do?

▪ Plot tracks
▪ Sort track plots
▪ View and play back tracks
▪ Export track plots
863



Plot tracks
Aim
Choose Track Visualization to visualize a set of tracks. This function is particularly 
useful when you want to have an overview of your data acquired so far. If you want 
to visualize data from one specific trial together with video or external data, see Plot 
integrated data.

Procedure
1. Choose Analysis > Results > Plot Tracks, or in the Experiment Explorer, 

under Results, click Track Visualization.
2. On the toolbar, choose the Track Smoothing profile and the Data profile 

that you want to use. The two profiles define the samples to plot.

3. See Customize tracks and plots on page 916.

Notes
▪ If you want to plot tracks in colors depending on the value of a dependent 

variable, like velocity, make sure that that variable is defined in one of the 
Analysis profiles. Then, repeat the steps above and choose the correct 
Analysis profile.

▪ If your data selection contains nesting criteria, all samples are plotted, 
however the samples excluded by nesting are displayed in a different color.

▪ You may sometimes get the following message:
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You have recorded data with more than one Arena Settings, and the layout 
of the plot matrix is such that tracks obtained with different Arena Settings 
are expected to be plotted in the same plot. Add the independent variable 
Arena Settings to the layout (see Sort the track plots by a new variable). 
Alternatively, in your Data profile filter data from one of the Arena Settings.

▪ Sometimes a variable number of cells in the plot matrix are empty. This is 
caused by the fact that there are no tracks corresponding to the values of 
the independent variable specified in the plot headers. To create a more 
compact matrix, choose a different set of independent variables to sort 
track plots (see Sort track plots).
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Sort track plots
Aim
Track plots are displayed in the form of a matrix. You can sort rows and columns 
according to one or more independent variables. 

EXAMPLE  Subjects of both sexes were assigned to two different treatment levels 
(drug or saline). You want to visualize tracks according to Subject sex (on the rows) 
and Treatment (on the columns).

By default, plot headers do not include the name of an independent variable and 
the variable's value for that row/column. To show the variables' name, right-click a 
header and select Show Name. The values of the variables and the resulting sorting 
order are not removed. To hide the variables' name, right-click the header and 
deselect Show Name.

Sort the track plots by a new variable
Do one of the following:
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▪ Click the Show/Hide button on the toolbar, and select Layout. In the 
Layout window, select Arrange by headers. Under Available, click the 
variable you want to use. Next, click one of the buttons next to On 
Columns or On Rows, depending on whether you want to sort columns or 
rows by that variable. 

▪ Right-click the header of a column or a row, depending on where you want 
to place the new variable. Next, select Insert. In the Select Independent 
Variables to Insert window, from the Independent Variable Name list, 
select the variable you want to use, then click OK.

NOTE  The variable list does not include the variables already present in the plot 
headers.

Remove a sorting variable
Do one of the following:

▪ Click the Show/Hide button on the toolbar and select Layout. Click the 
variable name under On Columns or On Rows, and click the deselect 
button next to it. 

▪ Right-click a header for that variable and select Delete.
If you remove all variables from one side of the matrix, the headers will be empty. 
All tracks are plotted on one row or column. 

Sort the plots in ascending or descending order
By default, track plots are sorted in ascending order of the corresponding variables 
(numeric or alphabetic). 

▪ To sort variable values in descending order, right-click a header for that 
variable and select Sort Descending.

▪ To sort variable values in ascending order, right-click a header for that 
variable and select Sort Ascending.

You cannot change the plot order from the Layout window.

Re-arrange multiple sorting levels
When two or more variables are inserted or moved to the same side of the matrix, 
they form a multi-level structure. In the example below, plots are first sorted by 
Subject sex (top level), and then by Treatment (bottom level).
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To re-arrange sorting levels, do one of the following:

▪ Click the Show/Hide button on the toolbar and select Layout. Click the 
variable you want to move. To move the variable one level up, click the Up 
button. To move the variable one level down, click the Down button.

▪ Right-click a track plot header for a variable. To move a variable one level 
up, select Move up. To move a variable one level down, select Move down. 
Or click a header for that variable, and drag it to a lower or upper level.

In the example below, the variable Treatment has been moved above Subject sex. As 
a result, plots are first sorted by Treatment, then by Subject sex (compare this with 
the previous figure).

Swap variables from columns to rows and vice versa
You can re-arrange your plots by moving the variables shown in the rows to 
columns and vice versa. Do one of the following:

▪ Click the variable name under On Columns or On Rows, and click the Place 
Horizontal or Place Vertical button. 

  

▪ Right-click a row/column header for that variable and select Place 
Horizontal or Place Vertical, or click a row/column header and drag it to a 
new position.
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View and play back tracks
Zoom the track plots in and out
The Zoom buttons are located on the toolbar.

▪ To zoom in, click the Zoom in button or press Ctrl+. .

▪ To zoom out, click the Zoom out button or press Ctrl+, .

▪ To fit all track plots on the screen, click the Fit all button .

To zoom in/out to predefined percentages, from the Show/Hide menu, select 
Zoom level, and choose one of the values available (6% to 800%).

Customize the length of tracks
See Customize the elements and length of the tracks on page 917.

Play back the tracks
Click the buttons in the Playback Control window. See Playback Control, Acquisition 
and Visualization

View the tracks in multi-arena setups
In trials with multiple arenas, all tracks are played back starting from the first 
sample. If the tracks started at different times in different arenas, the samples 
visualized at a given time refer to different 'real times' in those arenas. 

To preserve the time difference between arenas, choose Integrated Visualization.

Below: In a multi-arena setup, data recording may start at different times in 
different arenas. When tracks are plotted together, their starting times are aligned. 
This means that samples visualized simultaneously for the two arenas may refer to 
two different moments in the real time line.
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Export track plots
Export a single track plot

1. Click the plot you want to export, so that its border becomes highlighted in 
red.

2. On the toolbar, click the Export image icon.

3. Under Export, choose Selected plot.
4. Select the image resolution in pixels.
5. Click Export. In the Export Image window, enter the name and location of 

your image file, choose the image format and click Save.

Export multiple plots as separate files
Each plot is exported as a single image file. 

1. Hold the Ctrl key down and click the plots you want to export. If you do not 
make a selection, all plots will be exported. 

2. On the toolbar, click the Export image icon.

3. Under Export, choose To separate image files.
4. Select the image resolution in pixels, and click Export.

Export multiple plots as one file
The matrix grid is exported as a single image file.

1. Select the plots you want to export. If you do not make a selection, all plots 
will be exported. 

2. On the toolbar, click the Export image icon.

3. Under Export, choose To one image file.
4. Select the image resolution in pixels, and click Export.
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Notes
▪ The available image resolutions depend on the aspect ratio of the original 

background pictures. The zoom level chosen for the plots affects the default 
resolution.

Available image formats
▪ Portable Network Graphic (*.png) (default). A picture format using 

lossless compression. 
▪ JPEG file (*.jpg). A compression format for color images, particularly 

photographs. It can reduce file sizes to about 5% of their original size, but 
some detail might be lost in the compression.

▪ Windows Bitmap (*.bmp). A non-compressed format generally resulting 
in large files.

▪ Graphics Interchange Format (*.gif). A lossless format limited to 256 
colors. This makes the GIF format suitable for storing graphics with 
relatively few colors such as simple diagrams.
872



Plot heatmaps
Learn about

▪ Heatmaps in EthoVision XT
▪ The heatmap color scale

What do you want to do?
▪ Plot heatmaps
▪ Choose the Merging method for heatmaps
▪ Customize the heatmaps
▪ Arrange heatmaps
▪ Choose the Heatmap colors
▪ Export the heatmaps
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Heatmaps in EthoVision XT
What are heatmaps?
A heatmap is a graphical representation of the subject’s position in the 2D space 
where the density of utilization of a specific place is represented as a color. 
Heatmaps facilitate identification of “hotspots” and clustering of data points.

Choose Heatmap Visualization to generate heatmaps. 

You can generate heatmap for single tracks or groups of tracks, and sort heatmaps 
according to various criteria. You can combine heatmaps with data selection to 
visualize for example the subject’s position while it shows a specific behavior. 
Finally, you can export heatmaps to a high-resolution graphics file.

How are heatmaps created?
In EthoVision XT, a track is a group of sample points, each with x an y coordinates. If 
one sample is found at specific coordinates, the frequency (= number of samples) 
for the corresponding pixel in the video image is 1. If more samples are found 
exactly on that pixel, for example when the subject returns to the same location, or 
when it sits still for some time in that location, then the frequency for that pixel is 
higher: 2, 3, 4, etc. 

IMPORTANT  Here by frequency we mean the number of samples that are found on a 
specific pixel, not the number of entries in a zone or the like. The number of 
samples can be plotted in a 2D histogram, where the length of each column 
indicate how much time the body point of the subject was found exactly at that 
location.
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The heatmap is created from that histogram, based on the concept of kernel density 
estimation. At each pixel, the probability is calculated to find the subject at that 
specific location. The density function states that there is some (lower) probability 
to find the subject also in the surroundings of the focal pixel. This can be 
represented with a bell-shaped three-dimensional curve.

The Kernel density function is calculated at each location. The single 3D bell curves 
for neighboring locations are merged together, resulting in higher and wider 
curves.

However, heatmaps in EthoVision XT are a 2D representation of the hilly landscape 
that results from the kernel density estimation. It’s like viewing the hills and valleys 
from the top. The colors represent the altitude of the landscape.

In EthoVision XT, the colors may represent the cumulative time in a particular pixel, 
or the fraction of the track that is found of that pixel. This depend on what you 
choose under Color level. 
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Examples of heatmaps

Morris water maze test

In this example, we compare the swim pattern between two groups of rats in probe 
trials. The young rats (right) display more focused search then the old ones (left).

Zebrafish in a novel tank diving test

In this example we want to show the bias toward top-swimming after the fish was 
treated with an anxiolytic drug. The two zones, Top and Bottom, are outlined in 
white.
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Novel Object Recognition test

In this test the subject explores two objects, one familiar and one novel. The 
heatmap clearly show the difference in the “density” of location points around the 
two objects. The two object zones are outlined in white.

Mosquito in a wind tunnel

A mosquito tends to reach the odour source located behind the upwind screen of 
the flight chamber. The middle of the screen is indicated with a cross.
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Notes

▪ Be careful when interpreting color heatmaps. First, the colors lack the 
natural perceptual ordering found, for example, in gray scale color maps. 
The changes between colors lead to perception of gradients that aren't 
actually present, making actual gradients less prominent.

See also

▪ The heatmap color scale
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The heatmap color scale
Aim
To help estimate how much time the subject spent in a region of the arena. 

Because heatmaps create gradients by definition, they are not meant to accurately 
measure the time that the subject spent in a certain zone. For that, calculate the 
statistics for the variable In zone. See Analysis advisor

To access this option

Choose Analysis > Results > Plot Heatmaps.

Locate the scale at the right-hand side of the heatmap.

Scale maximum
You find the maximum value at the top of the scale. It is expressed in:

▪ Seconds, if you choose Cumulated as a Merging method for heatmaps.
▪ A fraction of the track duration, if you choose Mean as a Merging method 

for heatmaps (see also a note below).
To calculate the maximum, EthoVision XT finds the pixel of the heatmap with the 
highest number of recorded positions and calculates the total time spent in a 
circular area around that position. The circular area depends on the Color 
smoothing that is currently set. The larger the smoothing value, the larger the 
circular are around the maximum, the higher the value in the scale because more 
point locations around the “peak” pixel are included in the calculation.

This correction is made because the highest absolute density of sample points 
(shown in dark red by default) is usually found in one or few pixels per track; taking 
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only the cumulated time for those pixels would do not provide a realistic estimate 
of the time spent by a subject in a certain location.

Scale minimum
You find the minimum value at the bottom of the scale. This is always zero seconds 
(or fraction of the track duration; see above for Maximum). It represents the 
locations where the subject was never found.

Notes
▪ The scale is plotted independently for each heatmap. The Maximum value 

only depends on the original data points that form that heatmap.
▪ In order to make a good judgment when comparing heatmaps, make sure 

that the total track duration is the same or very similar between groups or 
subjects.

▪ If you choose Over heatmap as Color level, the scale maximum also 
changes. For example, the maximum for that heatmap is represented with 
blue or green, not red. That happens because the overall maximum is found 
in other heatmaps. See Heatmap colors

▪ If you choose Mean instead of Cumulated as a Merging method for 
heatmaps, the maximum is expressed as a fraction of the total time that the 
subject was in that region. If the subject keeps moving across the arena, this 
value can be rather low, for example 0.01. It means that the region of peak 
occurrence contained 1% of the positions.

See also

▪ Customize the heatmaps
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Plot heatmaps
Aim
To create heatmaps from the tracks currently selected in the Data profile.

Procedure
1. Choose Analysis > Results > Plot Heatmaps, or in the Experiment 

Explorer, under Results, click Heatmap Visualization.
2. On the toolbar, choose the Track Smoothing profile and the Data profile 

that you want to use. The two profiles specify the set of samples to be used 
in the heatmaps.

3. In the Heatmap Settings pane, click the Show/Hide tab. Choose the 
Features (body points) and the Subjects to visualize.

4. Under Presets, click one of the buttons to arrange the layout. See Arrange 
heatmaps on page 887.
Under Merging, specify how EthoVision should normalize data of different 
tracks when putting them in a single heatmap. See Merging method for 
heatmaps on page 883.

5. Click the Plot Heatmaps button.

6. OPTIONAL  Customize the heatmaps on page 885.
7. OPTIONAL  Export the heatmaps on page 894.

Notes
▪ By default, heatmaps are displayed with overlay text and without arena and 

zone outlines.
▪ If your video image includes two or more arenas, the heatmap is calculated 

across arenas, not per individual arena. This means that, if the track in one 
881



arena has fewer samples than the track in another arena, the heatmap in 
the first arena is less likely to show high-density colors. For example:

This is generally not a problem in DanioVision or PhenoTyper experiments 
because the track duration is comparable between arenas. For other setups, 
compare heatmaps from different arenas only when the duration of the 
tracks is more or less the same, or export the tracks and create the 
heatmaps in an external application.

▪ If you want to know where a behavior occurs, in your Data profile nest over 
that behavior (see Nesting over behaviors scored manually or Nesting over 
behaviors of Rat/Mouse Behavior Recognition), and then plot the 
heatmaps.

▪ When you combine tracks from different arena settings, the corresponding 
heatmaps may have different size and aspect ratios. The tracks are first 
aligned at the upper-left corner before they are combined. Therefore, a 
specific point in the combined heatmap may represent different locations 
for different tracks.
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Merging method for heatmaps
Aim
To specify how data of different tracks are merged in one heatmap.

Procedure
1. Choose Analysis > Results > Plot Heatmaps, or in the Experiment 

Explorer, under Results, click Heatmap Visualization.
2. In the Heatmap Settings pane, click the Show/Hide tab. Choose one of the 

options under Merging method.

Cumulated
Each sample in a track gets a weight equal to 1/sample rate. Therefore, the color of 
a pixel in the heatmap represents the total time that the subject(s) body point was 
at that location. Choose this option when you want to make a heatmap based on all 
the possible locations of the animals for a group of tracks. With this method, a 
subject’s position is over-represented in tracks longer than others.

Mean
Each sample in a track gets a weight equal to 1/track length. The color of a pixel 
represents the average proportion of a track that is found at that location. Choose 
this option when you want to make a heatmap that represents the average 
distribution for that group, and you want to compare averages between two or 
more groups of tracks.
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EXAMPLE  Consider two tracks, recorded at 25 samples/s. One track is 10 samples 
long, the other 1000 samples long. The total track duration is 1010/25 = 40.4 
seconds. A subject’s center point is found at location P two times in track 1 (=20% 
of track 1), and 100 times in track 2 (=10% of track 2). When the two tracks are 
merged:

▪ With Cumulated, the color of pixel P represents a total time of (2 x 1/25) + 
(100 x 1/25) = 4.08 s. This means that, in total, 4.08s / 40.4 s = 10.1% of the 
data points are at that location. The longer track has a greater weight in this 
calculation.

▪ With Mean, the color of pixel P represents [(2/10) + (100/1000)]/2 = 0.15 = 
15% of the track duration. This means that on average, 15% of the data 
points are at that location. Short and long tracks have the same weight in 
this calculation.

Notes
▪ Merging makes sense when two or more tracks share the same value of an 

independent variable chosen as a header. For example, two tracks with the 
same of Treatment level = Control. If Control is one of the headers, the two 
tracks contribute to the same heatmap.
884



Customize the heatmaps
Aim
To choose which text, arena feature or background image to be displayed with the 
heatmaps.

How to access these options
Click the Show/Hide button on the toolbar.

Show and hide the overlay text
To facilitate orientation in a heatmap matrix, you can display the value of 
independent variables used to arrange the heatmaps, and the number n of tracks 
used to create the current heatmap: Merged heatmaps: [n].

1. From the Show/Hide menu, select Text Features.
2. Under View, select Show information if you want to see overlay text over 

the heatmap. 
3. Under Text properties, choose the text Fill color and Opacity.

NOTE  Even when selecting Show information, the overlay text is not shown if that 
information is redundant. For example, independent variables are not shown when 
the heatmaps have headers; For the same reason, the Merged heatmaps: [n] text is 
not shown when heatmaps are based on single tracks.

Show and hide arenas, zones and points
1. From the Show/Hide menu, select Arena Features.
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2. In the Arena Features window, choose the arenas, zones, zone centers and 
points of interest you want to view over the heatmap.

3. Select the feature outline color. Next, click OK.
NOTE  Arenas and zones are displayed as outlines, not semi-transparent regions like 
in the Track Visualization. Zone centers and points of interest are displayed as 
crosses.

Customize the background of the heatmap
1. From the Show/Hide menu, select Background.
2. Choose:

▪ Plain - by range minimum to have a uniform background that is the 
same as the color for the minimum value in the heatmap. To change 
the color, click the Colors tab in the Heatmap Settings window and 
change option under Display.

▪ Plain - custom to have a uniform background. Click the button next to 
this option to select a color. To select colors other than the basic ones, 
click the button Other.

▪ Captured image to have the image captured in the Arena Settings as a 
background. 

If a heatmap is based on tracks with different Arena Settings, it is displayed with the 
background in the color currently selected next to Plain - custom.

Zoom the heatmap in/out
You can find the Zoom in (Ctrl+ .) and Zoom out (Ctrl+ ,) buttons on the toolbar.

To fit all heatmaps on the screen, click the Fit all button.

To zoom in/out to predefined percentages, from the Show/Hide menu, select 
Zoom level, and choose one of the values available (6% to 800%).
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Arrange heatmaps
You can arrange heatmaps in two ways: with Layout Presets (below), or manually 
arranging headers in the matrix (Custom layout).

With Layout presets
In the Heatmap Settings pane, click the Show/Hide tab. Under Layout presets, 
click one of the following:

▪ Adjacent. The heatmaps are arranged from left to right, and from top to 
bottom to fill the screen as much as possible. The following order is used: 
first Result container, then trial name, then subject name, then body point. 
With Adjacent, each heatmap represents a single track per arena. Tracks 
from multiple arenas are combined in the same heatmap. With this preset, 
the Merging method Cumulated is selected automatically. 
Clicking Adjacent is the same as selecting Show/Hide > Layout > 
Arrange adjacently.

▪ Trials. The matrix is arranged in this way:
▪ On rows: Trial names.
▪ On columns: Result containers, subject names and body-points (if more 

than one), in this order.
With Trials, each heatmap represents a single track, and the Merging 
method Cumulated is selected automatically.

▪ Time bins. This button is available if you define time bins for at least one 
Result container in your Data profile. Choose this option for example to 
inspect behavioral changes over time. The matrix is arranged this way:
▪ On rows: Result containers, trial names, subject names, and body points 

in this order.
▪ On columns: Time bins ordered by starting time.
With Time bins, each heatmap represents a segment of a single track.
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With the Time bins preset, the Merging method Cumulated is selected 
automatically.

▪ Group Mean. Choose this option when you create two or more Result 
containers in your Data profile and you want to compare the corresponding 
heatmaps, just like you would do with Group statistics, or when you just 
want to inspect the behavior of a whole group of tracks.
The matrix is arranged this way: 

▪ On rows: No independent variable. Heatmaps are always arranged in 
one row.

▪ On columns: Result containers, subjects and body-points in this order.
With Group mean, each heatmap always represents a group of tracks, 
unless a Result container only contains one track. The Merging method 
Mean is selected automatically.

NOTE  This button is not available in experiments defined as DanioVision 
experiment. 

Custom layout
Besides the Layout presets, you can re-arrange the heatmaps by moving and 
adding/removing the matrix headers.

1. In the Heatmap Settings pane, under Presets click the Custom button, or 
click the Show/Hide button on the toolbar and select Layout.

2. In the Layout window, select Arrange by headers.
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3. To place headers on the other side of the matrix, select the corresponding 
element under On Columns / On Rows and click the Place Horizontal or 
Place Vertical button.

To alter the sorting order, select an element and click the arrow buttons to 
place it in a upper/lower position.

To add a header, select the corresponding element under Available and 
click the arrow button next to On Columns or On Rows, depending on 
whether you want to place the new header.

To remove a header, select its name under On Columns, or On Rows and 
click the arrow button.
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Notes
▪ TIP You can also re-arrange the heatmaps from the matrix itself.

▪ Right-click a header and select Place Horizontal/Place Vertical to 
place the headers on the other side of the matrix; or Move Up/Move 
Down to modify the sorting order. 

▪ To add an independent variable as a new header, right-click the header 
row/column and select Insert, then choose the independent variable.

▪ To remove an independent variable as a header, right-click it and select 
Delete.

▪ You can only remove a header if that does not generate ambiguities in the 
heatmap matrix. For example, if your Data profile contains two Result 
containers, you cannot remove the Results header. For the same reason, you 
cannot delete the Body Points header because mixing body points in a 
heatmap does not make sense.

▪ The Arrange adjacently option is equal to clicking the Adjacent button 
under Presets.

See also

▪ Sort track plots
▪ Merging method for heatmaps
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Heatmap colors
Color range

In the Heatmap Settings pane, click the Colors tab. Under Select range, select one 
of the five color ranges:

▪ From dark blue to dark red (default).
▪ From dark blue to white.
▪ From green to red.
▪ A custom range where the end colors can be changed.
▪ A custom range where the end and middle colors can be changed.

For the last two options, to change a color, click the corresponding button and 
choose the color you require.

The end colors represent the minimum and the maximum density of data points per 
pixel. Whether the colors represent the same value in different heatmaps depends 
on what you choose as Color level (see below).

Color level
In the Heatmap Settings pane, click the Colors tab. Under Color level, specify how 
the color range is mapped to the range of location frequencies between different 
heatmaps:
891



▪ Per heatmap. When you choose this option, the colors are mapped to the 
range of density of points in each heatmap separately. This means that a 
specific color may represent different densities of points in different 
heatmaps. Choose this option to compare the utilization of space within 
heatmaps.

▪ Over heatmaps. When you choose this option, The colors are mapped to 
the global range of density of points, calculated over all the heatmaps 
plotted on your screen. This means that a specific color represents the same 
density of points in different heatmaps. Choose this option to compare the 
utilization of space between heatmaps. 
When you choose this option: 

▪ The maximum color (e.g. dark red) is only displayed in the heatmap(s) 
with the highest absolute value of point density. 

▪ The way heatmaps will look like also depends on what Merging 
method for heatmaps you choose.

Color smoothing
With Smoothing, you can specify the distance around a point at which the influence 
of the point will be felt when determining the color. Larger values result in greater 
smoothing, but smaller values may show finer details and variation. 

1. In the Heatmap Settings pane, click the Colors tab.
2. Under Smoothing, choose the smoothing intensity (range 1 - 125).

Choose a small value when you work with small arenas, like in well plates, 
and when you want to view small-scale differences in location.

Notes
▪ If your trials include two or more arenas, the options Per heatmap/over 

heatmaps do not have an effect on the difference in the color mapping 
between arenas. However, the duration of the tracks in two different arenas 
may influence the heatmaps. See an example in Plot heatmaps
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▪ The value of Smoothing is the standard deviation of the Gaussian kernel 
density function centered on a sample. The heatmap is created by summing 
up the density functions for the selected data points. Smoothing also 
influences how many points are represented by a multicolor blob. The 
following example, shows heatmaps created from two data points. A: with 
Smoothing = 1 pixel. B: with Smoothing = 3 pixel.
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Export the heatmaps
You can export a single heatmap, some heatmaps or the whole matrix of heatmaps 
to image files. A great advantage of this function compared to copy and paste is 
that you can rescale the heatmap to a resolution higher than that of the original 
video, resulting in quality pictures ready for publications.

Export a single heatmap
1. Click the heatmap you want to export, so that its border becomes high-

lighted in red.
2. Right-click the heatmap and select Export image, or on the toolbar click 

the Export image icon.

3. Select the image Resolution (width x height) in pixels.
4. Click Export. In the Export Image window, enter the name and location of 

your image file, choose the image format and click Save.
TIP  You can also copy and paste single heatmaps: click a heatmap, right-click and 
select Copy or press Ctrl+C, then paste the picture to an external program. You 
cannot copy/paste multiple heatmaps.

Export multiple heatmaps
1. Select the heatmaps you want to export.

▪ To export all heatmaps in the matrix, make sure that no heatmap is 
highlighted. Click outside the heatmaps area to remove any selection.

▪ To export multiple, non-adjacent heatmaps, hold Ctrl down and click 
the individual heatmaps.

▪ To export multiple, adjacent heatmaps, hold Shift down, then click the 
first, then the last of the heatmaps you want to export.

Result: The border of the selected heatmaps becomes highlighted in red.

2. On the toolbar click the Export image icon.

If you have selected some heatmaps, you can also right-click anywhere over 
the selected heatmaps and choose Export image.
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3. Under Export, choose one of the options: To separate image files or To 
one image file.

4. Select the image Resolution (width x height) in pixels.
TIP To ensure that each heatmap has a sufficient resolution, under Export 
select first To separate image files, select the resolution you require and 
then choose To one image file. The image resolution (width, height, or 
both) is increased by a number of times depending on how many heatmaps 
are in the rows and columns.

5. Choose Independent variable as overlay to have the trial information 
(headers) displayed on the exported images.

6. Click Export. In the Export Image window, enter the name and location of 
your image file, choose the image format and click Save.

Notes
▪ The available image resolutions depend on the aspect ratio of the original 

background pictures. The zoom level chosen for the plots affects the default 
resolution.

▪ To choose the appropriate information to display on the heatmaps, see 
Custom layout in Arrange heatmaps.

▪ The suggested export file name is Heatmap Image + a progressive number. 
For heatmaps exported to separate files, the name of the exported file is 
the name you enter in the Export Image window followed by the row 
headers and the column headers. For example Heatmap Image 0001 - Trial 
1 - Center point.
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Plot integrated data
What do you want to do?

▪ Plot integrated data
▪ View and interpret variable plots
▪ Customize the dependent variable plots
▪ Export the integrated visualization
▪ Create a video from your data

Learn about
▪ Dependent variable plots
▪ External data plots
▪ Trial control events pane
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Plot integrated data
Choose Integrated Visualization to visualize a set of tracks obtained from one 
tracking session (trial), together with video, external data (if applicable), and plots of 
your dependent variables (including manually scored behaviors and external data).

This function is particularly useful when you want to compare tracks with the 
corresponding video.

IMPORTANT You can visualize up to 200 plots at the same time. If the number of 
subjects/arenas times the number of dependent variables currently selected 
exceeds this limit, filter the subjects or arenas in your Data Profile, or remove some 
dependent variables from your Analysis Profile. 

Prerequisite
Make sure that the dependent variables you want to plot are specified in 
the active Analysis profile.

To plot integrated data
1. Choose Analysis > Results > Plot Integrated Data, or in the Experiment 

Explorer, under Results, click Integrated Visualization.
2. On the toolbar, choose the Track Smoothing profile, the Data profile and 

the Analysis Profile that you want to use.

3. On the toolbar, choose the selection result and the trial you want to 
visualize. By default, the first trial is selected. To select the next/previous 
trial, click the buttons next to the drop-down list.
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The selection result list is available if your current Data profile includes two 
or more selection results.

4. OPTIONAL  Customize tracks and plots on page 916.
5. View and interpret variable plots on page 901.

Notes
▪ In the Integrated Visualization screen you can also find one or more 

External Data plots, depending on how many external data files have been 
imported in that trial. See External data plots

▪ Not all playback speeds might be available. Depending on the video 
format, you may not be able to play the video at a specific speed.

▪ If your data selection contains nesting criteria, all samples are plotted but 
the samples excluded by nesting are shown shaded.

▪ You can visualize up to 200 plots per trial. If the number of dependent 
variables in your analysis profile times the number of subjects/arenas 
exceeds this limit, a message informs you that not all charts are visualized. 
Filter the subjects/arenas in your Data Profile, or remove some variables in 
your Analysis Profile.

▪ The begin time in the video window is the time of the first sample acquired 
in all arenas. 

▪ The end time in the video window is the time of the last sample from all 
arenas. Within each arena, the last sample is marked by the message End of 
track over the top-left corner of the corresponding arena. 

▪ For multi-arena setups, the tracks are synchronized, that is, samples of 
different arenas visualized at a given moment were acquired at the same 
absolute time.
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Dependent variable plots
Dependent variable plots show the values of the dependent variables selected in 
your active Analysis profile, on a time line. Dependent variables are displayed in 
different ways depending on their type (see the picture below):

▪ States like In zone: colored bars indicating the state’s duration. 
▪ Point events like Rotation: vertical segments indicating the event’s 

occurrence, with no duration.
▪ Continuous variables like Velocity: values are plotted as a time series, with 

one value per sample time, 

Procedure
To plot a dependent variable:

1. Define the variable. Calculate statistics: procedure.
2. See Plot integrated data.

Scope of the Dependent variable plot
When the trial includes more than one arena or subject, the plot’s header indicates 
which arena and the subject it refers to.
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Why use Dependent variable plots?
Use Dependent variable plots are especially useful:

▪ To check whether you set correct thresholds for state variables like Body 
elongation, Movement, Mobility and Activity.
a) Open your analysis profile, double-click the variable's name and enter 
your best estimate for the thresholds. 

b) Plot integrated data. Play back your data, watch the video and check 
whether the states shown in the plot correspond with the states of the 
animals in the video.

If necessary, repeat steps a and b.

▪ To check that you have scored behaviors manually at a good level of 
accuracy.
a) In your Analysis profile, select the manually scored behaviors you want to 
check.

b) Plot integrated data. Play back your data, watch the video and check 
whether the states shown in the plot correspond with the behavior of the 
animals in the video.

If necessary, export the data to The Observer XT, where you can correct the 
errors.

▪ To view the behaviors of Behavior Recognition together with their 
probability values. This helps when you want to refine the definition of 
those behaviors based on their probability value. 

▪ To check whether your Trial Control Settings do what you want them to do. 
You can visualize Trial Control events and Trial Control states. For more 
information about Trial Control, see the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.
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View and interpret variable plots
Effect of data selection on plots
If the data profile contains nesting criteria, the selected intervals are shown with a 
white background. The non-selected intervals are shown semi-transparent enabling 
you to see the excluded data in these intervals.

This example shows a plot of the dependent variables ‘Distance moved’ and ‘In 
zone’ after nesting over the border zone of the open field.

If the data profile contains time bins, these are not visualized.

Navigate through the data
Use the scrollbar at the bottom to run through the visualization. The hairline 
represents the current time in the trial, and is always fixed in the middle of the plot 
area. For numerical variables, the current sample is highlighted with a circle.

The current value of the variable is also shown near the variable name. 
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To move from the start to the end of the trial, you can also:

▪ Click anywhere in the plot, hold the left mouse button and drag the 
background.

▪ Hold the Shift key down and scroll with the mouse wheel. This way you 
zoom in/out while the cursor moves forward/backward by one time span.
NOTE  Each wheel step corresponds to the time span chosen from the 
Show/Hide menu.

If part of the data plot is not visible at the current zoom level, you can either zoom 
out or move the plot line. Use the scrollbar at the right end of the plot area, or drag 
the background of the plot. See also View and interpret variable plots

TIP To visualize the whole vertical data range, zoom out the plot until you no longer 
see the vertical scrollbar.

Visualize a single variable value
▪ For discrete variables (states or events). Each state or event is shown as a 

colored bar. When a variable includes multiple states like In zone (with 
different zones being defined) or Mobility (with its states Immobile, Mobile, 
Highly mobile), these are shown as parallel channels.
Keep the mouse pointer above a colored bar. A tool tip is shown with the 
following information:

▪ The name of the dependent variable.
▪ Label: the name of the state or event.
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▪ Time: The sample time the mouse pointer points to.
▪ Duration: the length of the state, in seconds. For point events like 

Rotation or Trial Control events, the duration is not shown.
▪ For numerical variables (including external data). Values are connected with 

lines. Keep the mouse pointer over the data plot. A tooltip is shown with the 
following information:

▪ The name of the dependent variable.
▪ The sample Time selected.
▪ The value of the dependent variable at that time. This is indicated by a 

circle on the plot line.
IMPORTANT Although the plot lines may look continuous, the numerical variable 
values are not interpolated and do not become continuous. For data selection and 
analysis, the discrete samples are used.

Resize the plots
▪ Resize the time window displayed. Point to the y-axis in the upper part of the 

plot, so the mouse pointer turns to a double arrow. Drag the y-axis to the 
desired position to resize the time window.

▪ Resize the width of the plot. Point to the lower margin of the gray cell on the 
far left of the plot so the mouse pointer turns to a double arrow. Drag the 
margin to the desired position to have a larger or narrower plot. 

NOTE  The data of continuous variables are stretched/condensed when you resize 
the plot, but the range of data does not change. 
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Adjust the time scale (x-axis) 

Do one of the following:

▪ Click the Zoom in or Zoom out button on the toolbar, then click the 
time scale one or more times. 

▪ Right-click the plot and select Zoom in or Zoom out. Next, click the time 
scale one or more times.

▪ Press (Ctrl+ .) and (Ctrl+ ,) to zoom in/out, respectively. 
▪ Click the time scale, hold the Ctrl key down and turn the mouse wheel 

forward (to zoom in) and backward (to zoom out).
For the first two methods: To stop zooming in/out and return to the normal mouse 

pointer, click the No Zoom button  on the toolbar, or right-click the plot and 
select No zoom.

Notes

▪ Every time you zoom in/out, the plot scale is enlarged or reduced by a 
factor of 2. 
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▪ The shortest time that you can display is 0.1 seconds, the maximum time 
seven days.

▪ When you zoom in/out by clicking the plot, the clicked time becomes the 
new current time.

Set a specific time span
The time span is the duration of the time visible in the time axis at any moment. To 
set a specific time span, click the Show/Hide button on the toolbar, then click Time 
span and select one of the values available (minimum 5 sec; maximum 1 hour).

NOTE  The available values depend on the length of your trial. For example, if your 
trial is 10 minutes long, the 30 minutes and the 1 hour options are not available. 

Zoom the y-axis in/out 
You can adjust the range of values for continuous variables (dependent variables 
and external data). If you have two or more continuous data plots, the variable scale 
changes only for the plot you have clicked.

1. Do one of the following:

▪ Click the Zoom in button or the Zoom out button on the 
toolbar. 

▪ Right-click the plot and select Zoom in or Zoom out.
Result: The mouse pointer turns to a magnifier symbol. 
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2. Click the y-axis scale one or few times. 

3. To stop zooming in/out and return to the normal mouse pointer, click the 
No Zoom button on the toolbar, or right-click the plot and select No 
zoom.

Every time you zoom in/out, the plot scale is enlarged or reduced by a factor of 2.

TIP To zoom in/out the y-axis in all plots, hold the Ctrl and Alt keys down and scroll 
with the mouse wheel.
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Customize the dependent variable plots
Show and hide the plots
Click the Show/Hide button, select Dependent Variables and then choose the 
items you want to display. By default, all external data files are selected for that trial 
unless the associated tracks have been filtered out in the Data selection.

Sort the plots
You can change the order in which data plots are displayed by dragging them up 
and down on the screen. 

1. Click the leftmost column next to the plot you want to move.
Result: The cursor changes and the plot border is highlighted in red. 

2. Drag the plot up or down to the position you require. Release the mouse 
button to insert the plot.

You can also sort plots by dependent variable, subject name, or arena name. To do 
so:

1. Click the Show/Hide button, then select Chart Sorting.

2. In the Chart Sorting window, if there are multiple sorting factors, like 
dependent variables and arena names, choose them under Sort order.

3. Under Variable order, click the arrow buttons to sort the dependent 
variables. 
907



Change the color of a plot
1. Click the square symbol next to the name of the body point, subject, or 

behavioral state.

Alternatively, click next to the data line (for numerical variable plots) or the 
color bar (for the discrete variables).

2. In the Color window, choose a new color and click OK.
NOTE  For color bars, you can also choose a hatch pattern. 

Show and hide the data points
Click the Show/Hide button on the toolbar, and select/deselect Show Graph Data 
Points.
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Specify the time mode
You can choose to display time values on the x-axis as elapsed time, remaining time 
(that is, time to the end of the trial) or the actual time. 

1. Right-click the top-left corner of the chart with the time label. 

2. Select one of the following:
▪ Relative time. The time elapsed since the start of the trial. The 

0:00:00.00 time on the far left side corresponds to the start of the trial. 
▪ Remaining time. The time to the end of the trial. The 0:00:00.00 time 

on the far right side corresponds to the end of the trial. 
▪ Absolute time. The actual date and time the trial was acquired (for 

example 11/13/2017 16:29:30.00). 
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External data plots
External data are shown in the form of X-Y plots. The start and end time of the 
tracks does not always coincide with the start and end time of the co-acquired 
external data. When you visualize the integrated data, you can only view the 
external data acquired in the same time interval as the tracks associated with the 
external data file. External data samples acquired before the start and after the end 
of the tracks are not plotted. 

The hairline shows the current video/track position. The current value of heart rate 
is shown next to the data set name.

By default the external data are not plotted in the Integrated Visualization.

Plot the original signals
1. Choose Show/Hide > Dependent Variables.
2. Select the [data set name] (original signal) that you require. 

By default the original signal is plotted in green. 
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Plot the resampled signals
1. Define the re-sampled signal in the Analysis profile. See External data (resa-

mpled).
2. Choose Analysis > Results > Integrated Visualization.

By default, resampled signals are plotted in red.

▪ Select Show/Hide > Show Graph Data Points to better view the original 
and resampled signals.

▪ If you upsample a signal with a sample rate much lower than the EthoVision 
sample rate, and you choose Missing value as the Upsampling method, it 
may be difficult to see the data points. Choose Show/Hide > Show Graph 
Data Points and zoom in the plot.

Synchronize the external data with the tracks
Click the Synchronize External Data button.

Either change the Start date and time and Stop date and time, or move the 
external data plot to the correct position. For details, see Synchronize data 
manually after import.

The plot’s titles
The titles are shown at the left of the plots and vary according to what level the 
external data have been linked at.

▪ If linked to the subject level, the title shows the Arena and Subject names.
▪ If linked to the arena level, the title shows the Arena name.
▪ If linked to the whole trial, the title is not shown.

In the example below, the first plot was linked at the Arena level, the second at the 
subject level.

See also Customize tracks and plots.
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Trial control events pane
The Trial Control Events pane gives you an overview of the events that occurred 
during the trial as a result of the Trial Control Settings you specified.

The corresponding Trial Control profile is shown below.

The first condition (the center-point of the mouse is in the arena for more than 2 
second) is met after 2 seconds. At that moment the track is started. One minute 
later, the track is stopped. During playback, the hairline indicates the current 
position.

Customize the visualization of the Trial Control Events pane
By default, the Trial Control Events pane is shown in the lower right corner of the 
screen. Choose one of the following options to change the visualization of the pane:

▪ To show the pane, click the Show/Hide button on the toolbar and select 
Trial Control Events.

▪ To move the pane, click its title bar and drag it to the desired position. You 
can either dock the pane or let it float on the screen.

▪ To resize the pane, point with your mouse to either the pane's upper margin 
or its left margin so the mouse pointer turns to a double arrow. Drag the 
margin to the desired position to have a larger pane. Alternatively, click the 
small black triangle in the upper right corner of the pane to have a full view 
of the pane and hide the Track Plot Settings pane.
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Export the integrated visualization
Aim
To export Dependent variable plots in form of image files.

Procedure
1. Make sure that no other window is on top of the plots. Zoom the plots in/

out to reach the level of detail you require for the export picture.
2. On the toolbar, click the Export image icon.

3. In the Export Image window, enter the name and location of your image 
file. 

4. From the Save as type list, select one of the available formats, then click 
Save.

See also

▪ Adjust the time scale (x-axis)
▪ Zoom the y-axis in/out
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Create a video from your data
Aim
To export the animated track and the plots of the dependent variables to a video 
file, for instance for presentation purposes.

Procedure
1. Choose Analysis > Results > Integrated Visualization. 
2. From the toolbar, select the Analysis profile that contains the variables to 

plot.
3. If you do not want the Track Plot Settings pane be part of the screen 

capture, click the Show/Hide button on the toolbar and deselect Track 
Plot Settings.

4. Position the video where you want your recording to start, or click the 
Jump to begin button to start from the beginning of the trial.

5. Click the Start screen recording button.

6. In the Screen Recording window, under Region, choose whether you want 
to capture the Video, tracks and plots (see the example below, left) or the 
Full screen (right):
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Note that with Full screen you also record the Experiment Explorer and the 
desktop (if visible).

7. Choose the Frame rate (default: 25 fps) and the Resolution (default width: 
1280; see the note below).

8. Choose the video file Saving location and File name.
9. Click Start. EthoVision XT shows the message:

10. Play the video at the speed you require. 
11. To stop screen recording, click the Stop screen recording button.

Notes
▪ If you choose Video, tracks and plots, the Track Plots Settings pane is also 

recorded. To remove this from your video, see step 3.
▪ Video resolution is available in a number of steps. The values of width are 

320, 480, 640, 800, 1024, 1280 (default), and 1600 pixels. The values of 
height are adjusted in each step, based on the Region option you choose, 
and the current size of the EthoVision screen.

▪ The video file is saved in DivX format; the file extension is *.mpg.
▪ The suggested video file name is Screen Recording n, where n is a 

progressive number (0001, 0002, etc.).
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Customize tracks and plots
What do you want to do?

▪ Customize the elements and length of the tracks
▪ Customize the track colors
▪ Display background, arenas and zones
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Customize the elements and length of the 
tracks
Aim
To optimize visibility of data points.

To access these options
Choose Analysis > Results > Plot Tracks or Plot Integrated Data. In the Track Plot 
Settings pane, and click the Show/Hide tab.

What do you want to do?
▪ Show and hide body points
▪ Adjust line thickness and dot size
▪ Show and hide subjects
▪ Show part of the track

Show and hide body points
Under Features, select the following:

▪ Nose-point (only for nose-tail tracking).
▪ Center-point.
▪ Tail-base (only for nose-tail tracking).
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▪ Connectors (only for nose-tail tracking) to display the line connecting the 
nose-point and the tail-base to the center-point.

To view the body points, select the option under Sample next to that body point. 

To view the line connecting samples for a body point, select the Trail option next to 
that body point.

The nose-point is always represented by a filled triangle, the center-point by a filled 
circle and the tail-base by a filled square. You cannot change the shape of body 
points in your tracks.

Adjust line thickness and dot size
In the Show/Hide pane on the right, under Features, choose a value for:

▪ Line thickness. This changes the thickness of the tracks and the 
connectors, that is, the segments joining the body point.

▪ Dot size. This changes the size of the body points along the tracks.

Show and hide subjects
When you track multiple subjects in the same arena, under Subjects select the 
Visible option for the subjects you want to have displayed and clear the selection 
for the others.

Show part of the track
Under Filter, choose how many samples you want to display at the same time.

▪ Last ... seconds. Choose this option to visualize only part of it, for instance 
only the last 5 seconds.
918



▪ Every ... sample. If the subject moves slowly, the samples are very dense. 
Choose this option to visualize, for example, every 5th sample.

Tips
▪ To show the entire track, deselect Last ... seconds and click the Jump to 

End button in the Playback Control window.

▪ To show all samples in the track, select Every ... sample and enter 1. 

▪ To only show the last sample, select Every ...  sample, and enter 0 next to it. 
Make sure that in the Features box the option under Sample is selected for 
the body point you want to plot (see above in this topic).
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Customize the track colors
Aim
To plot data in colors depending on the subject, the treatment level, or other 
variables of interest.

To access these options
Choose Analysis > Results > Plot Tracks or Plot Integrated Data. In the Track Plot 
Settings pane, and click the Colors tab.

Specify how colors should vary, for example between arenas, or within tracks.

Subject
Under Level, select Subject. To change the color for a subject and a body point, 
click the corresponding cell under Settings.
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▪ If you tracked more than one subject per arena, choose this option to have 
the tracks of different subjects displayed in different colors. By default, 
different subjects have different colors for the center-point, and the same 
color for the nose- and tail-base points.

▪ If you tracked subjects in multiple arenas, the track of Subject 1 in Arena 1 is 
displayed in the same color as that of Subject 1 in Arena 2, Arena 3, etc.

Track
Under Level, select Track to have tracks in colors based on the value of an 
independent variable, for example to show subjects in colors based on the 
treatment level.

1. Select an independent variable from the Variable list.
2. Click the buttons next to Color Range and select the colors that you want 

at the ends of the range. Next, click Apply to assign colors automatically.
Alternatively, for each value of the variable selected, click the color cell and 
choose the color you want to assign to the tracks with that value.

3. Do the same for each subject in the arena.

Sample
Under Level, select Sample to have the samples within tracks displayed in a color 
depending on the value of a dependent variable, for example velocity. This way you 
can see where changes in behavior took place.
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1. Select a dependent variable from the Variable list.
The list shows the dependent variables selected in the currently active 
Analysis profile. If you do not see the variable you want, open the Analysis 
profile and include that variable, or from the list on the toolbar select the 
analysis profile that contains the variable.

2. Click the cell under From/To and choose a color for the lowest/highest 
value of the dependent variable, respectively. EthoVision calculates the 
spectrum of colors in between and shows it in the middle cell.
The lowest and highest values are shown under From and To. For State 
variables, those are false and true. For continuous variables, those are the 
minimum and maximum value measured for that variable in the trial. For 
example, 0 to 33.37 for Distance moved.

3. If you tracked more than one subject per arena, repeat step 2 for each 
subject.

Below: Example of a track plot where Sample is selected under Level. Samples are 
displayed in red when the subject was in any of the closed arms of the Elevated plus 
maze. In the Analysis profile, a dependent variable In zone is defined for the Center-
point in any of the closed arm (the When in any of the selected zones option is 
selected in the In zone settings dialog). When plotting the tracks, samples in any of 
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the open arms are displayed in the color selected for the true value of the In zone 
variable. Other samples are displayed in the color under false.

Customize the color of missing samples
Missing sample points are always visualized in the track plot. You can change the 
color of missing samples to distinguish them more easily from the actual data. The 
current color for missing samples is indicated next to Missing Sample Color. To 
change the color for missing samples, click the button and select a new color in the 
Color window. 
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Display background, arenas and zones
Aim
To customize how the background image, the arena and the zones are displayed in 
Track Visualization or Integrated Visualization.

Customize the background (for Track Visualization)
1. Choose Analysis > Results > Plot Tracks.
2. On the toolbar, click the Show/Hide button and select Background.
3. Select one of the following, then click OK.

▪ Plain. To have a uniform background. Click the button next to this 
option to select a color. To select colors other than the basic ones, click 
the button Other. 

▪ Captured image. If you want to have the captured image from the 
Arena Settings as background. 

Show/hide the video image (for Integrated Visualization)
Choose Analysis > Results > Plot Integrated Data.

The Video window is shown by default. To hide the Video window, click the Show/
Hide button on the toolbar and deselect Video Window.

Show/hide arenas and zones in the track plots
Arenas, zones and points can be displayed on top of the background as overlay 
objects. The color of each arena and zone depends on the color chosen in the Arena 
Settings.

1. Choose Analysis > Results > Plot Tracks or Plot Integrated Data.
2. Click the Show/Hide button on the toolbar and select Arena Features.
3. Select the arena feature you want to have displayed.

Arenas and zones are shown in a semi-transparent color, so their appearance also 
depends on what you select as background. 

If you want to change the color of an arena or zone group, open the appropriate 
Arena Settings, click the correct Color row and select the color of your choice.

For a multi-arena setup, you cannot select to view some arenas and not others.
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Calculate Statistics

Main topics and tasks
▪ Calculate statistics  927
▪ The statistics result  945
▪ Group charts  965
▪ Batch statistics calculation  976
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Calculate statistics
What do you want to do?

▪ Calculate statistics: procedure
▪ Edit the Analysis profile
▪ Export the statistics result

Learn about
▪ Statistics available
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Calculate statistics: procedure
Aim
To calculate descriptive statistics of one or more dependent variables.

Prerequisite
▪ You have smoothed data (optional).
▪ You have selected data in a Data profile (optional).

To calculate statistics
1. Choose Analysis > Analysis Profile > Open (to open an existing profile) or 

New (enter a name for the new profile), then click OK.
2. Choose the dependent variable. Click the Add button next to the 

dependent variable you want to use for analysis. If you do not see that 
variable name, click the More button.

TIP In most cases Distance moved and Velocity are already selected.

3. In the dependent variable-specific tab, select the properties of the 
dependent variable. 
For details on dependent variables, see Dependent Variables in Detail.

4. Choose the Trial statistics. Click the Trial Statistics tab, and choose the 
statistics you want to calculate for each trial.
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5. Choose the Group statistics. Click the Group Statistics tab, choose the 
statistics you want to calculate as a summary for a group.

EXAMPLE  You want to calculate the average and standard error of the Total 
distance moved, for Control and Treated subjects (we assume here that you 
create such groups in the Data profile; see Analyze groups of tracks.

Choose Distance moved as a dependent variable, Total as a Trial statistic, 
and Mean and Standard Error as Group statistics.

6. Repeat steps 2 to 5 to add more dependent variables.
7. Choose Analysis > Results > Statistics and Charts, then click the 

Calculate button on the toolbar.

8. The Statistics and Charts table appears on the screen.
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Notes
▪ Some dependent variables are available if you have one or more of the 

following add-on modules: Social Interaction, Rat/Mouse Behavior 
Recognition, Trial and Hardware Control.

▪ You only can select specific body points if your experiment is set to Center-
point, nose-point and tail-base detection.

▪ You can change the properties or delete a dependent variable already 
selected. You can also add multiple instances of a dependent variable, with 
different settings. See Edit the Analysis profile

▪ You can also calculate statistics in batch mode. See Batch calculation

See also

▪ The statistics result
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Statistics available
Statistics are a summary of the values of the dependent variable calculated for all 
the samples in your tracks (or the segments you have selected in the active Data 
profile).

For each dependent variable you select in the Analysis profile, you can choose Trial 
Statistics and Group Statistics. Click on the corresponding tab to select the 
statistics you want to have in the results table.

See also

▪ List of Trial statistics
▪ List of Group statistics
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List of Trial statistics
Aim
Trial Statistics give you summary statistics of individual trials. If a trial includes two 
or more tracks (subjects), the statistics are by default shown for each subject 
separately.

In the figure below, you find an example of how Trial statistics results are created, 
The Data profile filters tracks and/or intervals within tracks. If the Data profile 
contains groups of tracks, these groups are ignored in the results. To view results 
per group, choose Results > Group Statistics and Charts.

Below you find information about the Trial statistics.

Cumulative Duration
The cumulative duration of the state variable in the whole track, or in the track 
segment selected. For example, the time that the animal spent in a zone (for the 
variable In zone), or the time that the subject was in the state Mobile. 

When a state does not occur at all in a track or track segment, the value of 
Cumulative duration is zero.

Cumulative Duration (%)
The Cumulative Duration divided by:

▪ If you do not define time bins: The duration of the track (this corresponds 
to the Recording duration independent variable, not Trial duration). This is 
also the case when you define nesting intervals or results per zone.
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▪ If you define time bins: The duration of a time bin defined.
This statistic is expressed as percentage.

Cumulative Duration within Nesting (%)
The Cumulative Duration divided by:

▪ If you calculate results per zone: The total time the animal is in the zone.
▪ If you defined track segments with Nesting: The total duration of the track 

segments defined.
▪ If you defined time bins: The duration of a time bin defined.
▪ If you combine any of the three above: The duration of the time period 

shared by all selection criteria (the time periods of each criterion are 
combined with AND logic).

This statistic is expressed as percentage.

Frequency
The total number of occurrences of a state (only for state variables).

Latency to First
The time from the start of the track to the first occurrence of the behavior (for 
example, the first time in the track that the animal is in a zone). Latency is always 
calculated from the start of the track, even when you define time bins and nesting 
intervals. See the note below.

Latency to Last
The time from the start of the track to the last occurrence of the behavior. Latency is 
always calculated from the start of the track, even when you define time bins and 
nesting intervals.

Notes about Latency to First/Last

▪ Latency to First and Latency to Last are calculated from the start of the 
track. This is the time when EthoVision XT collects the first sample (missing 
or not). If the animal is not yet in the arena, and tracking has started, 
EthoVision XT collects a number of missing samples. The time that the 
animal is missing is included in Latency to First/Last. Obviously this 
overestimates the “true” latency, which should be calculated from the time 
that the animal is released. To prevent this from occurring, make sure that 
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the Trial Control rule includes a Start track condition in such a way that 
tracking only starts when the animal is first found in the arena.
TIP  To calculate the time from an event to another event in the trial, select a 
Free interval in the Analysis profile. See Free interval

▪ When two or more animals are tested simultaneously in the same arena, 
The meaning of Latency to First/Last much depends on how you set this 
condition. Suppose you start your trial by releasing one animal, then a little 
later the second animal. You want to calculate the Latency of “In Zone A” for 
both subjects. Consider the two scenarios: 
▪ If you set the Trial Control to start tracking when any subject is found in 

the arena, tracking starts when the first animal is released. Latency is 
calculated from that point also for the second animal, which enters the 
arena later. This means that Latency for this animal will be 
overestimated.

▪ If you set the Trial Control to start tracking when all subjects are found 
in the arena, tracking starts when both animals are found. That is, when 
the second animal is released and the first is detected (also when in a 
hidden zone). Latency is calculated from this point, so Latency for the 
second animal is correct. However, for the first-released animal, the 
time that it was in the arena before the second was released is not 
counted in Latency. This means that Latency may be underestimated, 
for example when the first animal enters Zone A before the second 
animal is released. For this reason, try to release the animals at the 
same time, or one immediately after the other.

Mean
▪ For linear variables like Distance moved, Velocity, Distance to zone, or 

Distance between subjects, and the variables Turn angle, Angular Velocity 
and Meander, the arithmetic mean is used, that is, the sum of the per-
sample values divided by the number of samples. 

▪ For the angular variables Heading, Head direction, and Heading to Point, the 
mean is calculated according to the circular mean formula, where  is the 
per-sample angle, and N is the number of samples:

The circular mean value can also be represented by the angle of the vector 
resultant R obtained by summing up all the vectors that represent the per-
sample angle values. 
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▪ For state variables like In zone, Movement and the behaviors scored 
manually or automatically recognized, the sum of the duration of 
occurrences of the state, divided by the number of occurrences.

Minimum
The lowest value of the variable.

NOTE  For the state variables, this is the minimum duration of the instances of a 
state, for example Moving. When the state does not occur at all in a track or track 
segment, the value of Minimum is zero.

Maximum
The highest value of the variable.

NOTE  For the state variables, this is the maximum duration of the instances of a 
state, for example Moving. When the state does not occur at all in a track or track 
segment, the value of Maximum is zero.

Number of samples
The total number of valid values of that variable (only for numerical variables like 
Distance moved). 

Standard Error
The standard deviation divided by the square root of the number of samples. This is 
also the case for angular variables Heading, Head direction, and Heading to Point.

Standard Deviation
For most variables, also including Turn angle, Angular Velocity and Meander, the 
sample standard deviation of the mean:

where:

x is the individual variable value, and x the mean of the variable;

N is 
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▪ For numerical variables like Distance moved or Velocity, the number of 
samples used to calculate the mean;

▪ For state variables like In zone, Mobility and the behaviors scored manually 
or automatically recognized, the number of occurrences of the state used to 
calculate the mean (for example, when a subject visited a zone 4 times, then 
N=4).

For the angular variables Heading, Head direction, and Heading to Point, the circular 
standard deviation is given by 

where R is the resultant vector length (see the text above for the circular mean) and 
N the number of samples.

Total
The sum of all the values.

Variance
▪ For most variables, including Turn angle, Angular Velocity and Meander, the 

square of the standard deviation. 
▪ For the angular variables Heading, Head direction, and Heading to Point, the 

variance is given by 1 - R/N, where R is the resultant vector length (see the 
text above for the circular mean) and N the number of samples.

Notes (for all statistics)
▪ Not all statistics listed above are available for every dependent variable. To 

view the list of statistics for a specific variable, double-click its name under 
Selected Dependent Variables and click the Trial Statistics tab.

▪ Values of latency and duration can only be a multiple of the sample interval 
(= 1 second divided by the sample rate).

▪ To add or remove statistics for a dependent variable, double-click that 
variable under Selected Dependent Variables and change your selection.
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List of Group statistics
Aim
Group statistics are a summary of trials in a specific experimental group. Here a 
“group” refers to the tracks selected in a Result box in the Data profile. See Define 
groups of tracks

Choose between Group mean and 5 number summary.

NOTE  Group statistics are not available when you only select Standard deviation, 
Standard error or Variance as Trial statistics.

Group mean
▪ For most variables, including Turn angle, Angular Velocity and Meander, the 

Group mean is the arithmetic mean of the trial statistics, calculated for each 
group.

▪ For the variables Heading, Head direction, and Heading to Point, the group 
mean is calculated as the circular mean, with N being the number of trials in 
the group.

If you select Group mean, the following options are available:

▪ Standard Deviation. For most variables, the sample standard deviation of 
the trial statistics, calculated for each group. For the variables Heading, 
Head direction, and Heading to Point, the group standard deviation is 
calculated as the circular standard deviation (see above), with N being the 
number of trials in the group.
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▪ Standard Error. The Standard deviation divided by the square root of the 
number of tracks used to calculate the Standard deviation. This is also the 
case for angular variables Heading, Head direction, and Heading to Point.

5 number summary
This is the Minimum, the Lower quartile, the Median, the Upper quartile and the 
Maximum value of trial statistics calculated for each group. 

The method used to calculate quartiles is the N + 1 Basis interpolation, which is also 
used in SPSS. If the sample size is lower than 3, the lower quartile is the same as the 
minimum and the upper quartile is the same as the maximum value, which is also 
the same as in SPSS.

NOTE  With 5 number summary you can also plot data in form of Box and whiskers 
charts. You can also show the original data points for better interpretation. See 
Group charts > Customize the group charts

See also

▪ List of Trial statistics
▪ Define groups of tracks
▪ View the results for groups of tracks
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Edit the Analysis profile
Aim

▪ To change the properties and settings of a dependent variable
▪ To make multiple instances of a dependent variable
▪ To rename a dependent variable
▪ To remove a dependent variable from the Analysis profile

After editing the Analysis profile, re-run analysis (Analysis > Results > ...).

To modify the properties of a dependent variable
You can change the properties of a dependent variable at any time, for example to 
add one more statistic.

1. Open the Analysis profile that contains the dependent variable you want to 
modify. 

2. Under Selected Dependent Variables, double-click the dependent 
variable.

3. Edit the variable's properties.
For how to modify the variable's properties, choose the variable in 
Dependent Variables in Detail and see the How to specify section.

4. Choose Analysis > Results > Statistics and Charts, then click the 
Calculate button.

You can also modify a dependent variable directly in the Statistics result. Right-click 
the dependent variable header and select Properties. Change the properties of the 
variable, then click the Calculate button.

To calculate multiple instances of a dependent variable
You can add multiple instances of a dependent variable to an Analysis profile. This is 
handy when you want to compare the effect of different settings on the same 
dependent variable. For example, two instances of Mobility with different Mobility 
thresholds.
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1. Open the Analysis profile that contains the dependent variable.
2. Right-click the dependent variable under Selected Dependent Variables 

and select Duplicate. A new row is appended under Selected Dependent 
Variables.

3. Double-click the new row and set the properties you require for the new 
instance of the dependent variable.

Additional instances of a dependent variable are given names with a progressive 
number (for example, Distance moved 2, Distance moved 3, etc.). You can rename 
those variables (see below). 

To rename a dependent variable
1. Open the Analysis profile that contains the dependent variable.
2. Under Selected Dependent Variables, right-click the variable's name and 

select Rename.
3. Type in the name you want to give and press Enter.

To remove a dependent variable from the Analysis profile
Under Selected Dependent Variables click the variable’s name and press Delete, 
or right-click the variable's name and select Delete.
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Export the statistics result
Aim
To export the statistics of the dependent variables in the results table to an external 
program. For example, export the values of average velocity to SPSS.

Prerequisites
▪ The statistics result is open on your screen.
▪ Select the Data profile and Analysis profile from the lists on the toolbar.

▪ If the table layout does not match the requirements of the program you 
want to export the result to, see The statistics result.

Procedure
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1. Choose Analysis > Export > Statistics, or in the Experiment Explorer under 
Analysis > Export, click Statistics.

2. Under Export, choose to export Trial Statistics or Group Statistics.
3. Click the Browse button to select the location for your export file. Its 

suggested location is the Export Files folder located in your experiment 
folder.

4. Under File Type, select either ANSI text (*.txt), Excel (*.xlsx), or Unicode 
text - default (*.txt).

5. Next to Missing value representation, enter the character that you want 
to export when the value for a particular cell is missing. 

6. For text export, enter the Delimiter character you want to use to separate 
columns in the exported file.

7. Click OK.

Options
▪ Missing value representation. Missing values in a statistic result are 

statistics that could not be calculated for that particular cell. For example, if 
the subject never visited a zone during trial 2, the result for the statistic 
Latency to first and for the dependent variable In zone “-”.

By default, missing values are exported as “-”. Make sure the destination 
program recognizes the character you specify as missing value.

▪ Merge column headers (selected by default in new experiments). Keep this 
option selected if you want to export to applications like Excel or SPSS. In 
this example, the column headers are merged after export to Excel.

If you do not select this option, each of the four column headers in the 
results table above will appear in separate rows in the export file.
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Note that the order of the text elements in the header depends on the 
order of the headers in the results table. You can change the order using the 
Layout function. Modify the layout of the results table

Here an example where the units cm were at the bottom level of the results 
table. They are now at the end of the header.

Notes
▪ The name of the export file is Statistics-[Experiment name]. If you export 

results multiple times to the same location, EthoVision attaches a number 
at the end of the file name: (1), (2), etc.

▪ Choose Unicode text to export according to the Unicode character set. 
This supports most world languages, including Chinese. Choose ANSI text 
to export the data as text files according to the ANSI character set. Choose 
this option only if the application in which you will open the exported file 
cannot handle the Unicode character set.

▪ The values exported have a variable number of decimals, depending on the 
number of integers. The total number of significant digits exported is 
always six (for example, 1.23456 or 1234.56), or seven if the unsigned 
number is smaller than one (0.123456).
Because of the restriction mentioned above, there may be a very small 
difference between the values in the results table and in the export file. This 
difference is in the order of 1/10000th of the measurement unit; see below 
for an example (left: results table; right: export file in text format).

▪ To change the layout of the exported table, follow Modify the layout of the 
results table and then export the results.
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Export settings for specific applications
▪ For R: Export to text. Make sure that R can recognize “-” as a missing 

value. Use the na.strings to include all possible “no data” characters or 
strings, for example:
loadfile <- read.table("exportfile.txt" , header = TRUE , sep=";" , 
na.strings = c("-" , “NODATA”, ....) )

▪ For SPSS: Select the option Merge column headers. 
▪ For Systat: Each case must be written in one line. Separator (for text files): 

space or comma.
▪ For SAS: For text files, use the DELIMITER option to specify the text 

delimiter if this is other than space. For Excel files, use the PROC IMPORT 
procedure with the SHEET option to specify the worksheet to import. Use 
the GETNAMES option to read variable names from the first row of the 
worksheet.

See also

▪ Export the raw data (track and dependent variables)
▪ File management: Export data
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The statistics result
Learn about

▪ Trial Statistics result
▪ Group Statistics result

What do you want to do?
▪ Modify the layout of the results table
▪ Sort the results table

See also

▪ Export the statistics result
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Trial Statistics result
Aim
The Trial Statistics tab gives the statistics for each trial separately. 

Procedure
Choose Analysis > Results > Statistics and Charts. The Trial Statistics tab opens.

Default layout
In the Trial Statistics table, each row corresponds to a subject tracked in one arena 
during a specific trial (see also the figure below). 

The row headers (A) tell you which Trial, Arena and Subject a specific cell 
corresponds to. Remember that, depending on your experiment design, one Trial 
may contain one or more Arenas, and one arena may contain one or more Subjects.

The column headers (B) show the type of dependent variable (e.g. velocity), the 
body point (e.g. center point), the type of statistic (e.g. mean) and the measurement 
unit.

Additional headers appear depending on your data selection:

▪ Selection results. If you define two or more Result boxes in the Data profile, 
the name of the boxes are shown in the first cell (C).

▪ Time bins. If you selected Results per time bin in your Data Profile, extra 
rows are added, one per time bin, and the headers show the corresponding 
time periods. For example: 0:00:00 - 0:00:20, 0:00:20 - 0:00:40, etc. (D).

▪ Results per zone. If you selected Results per zone in your Data Profile, the 
zone names are displayed on rows, together with the body points in those 
zones (E).

What you see in the result table depends on which Data profile and the Analysis 
profile are selected on the toolbar.

Trial statistics with Selection results and Time bins:
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Trial Statistics with Results per zone:
947



Group Statistics result
Aim
The Group Statistics & Charts tab shows the statistics for the groups of trials 
defined in your Data Profile.

▪ In the Group Statistics result table, each group is labeled as the 
corresponding Result container in the Data profile. The statistics are 
calculated for the trials/arenas/subjects included in that Result container. 
For how to group data, see Analyze groups of tracks.

▪ The dependent variables (e.g. velocity) are those specified in the currently-
selected Analysis profile.

NOTE  If you use the default Data profile, all trials are grouped. The Group Statistics 
& Charts table shows the statistics for all trials together.

Procedure
Choose Analysis > Results > Statistics and Charts and click the Group Statistics 
& Charts tab.

Example
In the following example, the Data profile includes two Result containers: Result 1 
for treated subjects, Result 2 for control subjects. The groups have been created 
with Filter boxes, each selecting a value of the independent variable Treatment, 
Control or Treated. Each Result Container contains two tracks.
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The Group Statistics table looks like this:

The statistics are displayed for each Result container. Result 1 contains the tracks 
marked as Treated; Result 2 contains the tracks marked as Control.

In addition, a chart is created automatically for each dependent variable in the 
table. See Group charts

How to read the Group statistics
▪ Statistics should be read as follows: [Lower level header] of [Higher level 

header] is [value in cell]. For example:
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415.3275 cm is the Mean of the per-trial Total Distance moved for the 
tracks contained in Result 1.

▪ N is the number of tracks used to calculate the group statistic for that 
dependent variable.

▪ Group statistics are split in multiple rows when you define results per time 
bin and/or zone. In the example below, results are split per zone defined in 
the Data profile, under Results per zone. See Calculate the results per zone

▪ By default, user-defined independent variables are displayed in the table. To 
show more independent variables, click the Show/Hide button and choose 
Independent Variables.

▪ If tracks in a group have different values of an independent variable, the 
text [multiple values] is displayed for that group:

How group statistics are calculated
For most dependent variables, The group Mean is the arithmetic mean of the values 
of the dependent variable reported in Trial Statistics. For angle variables like 
Heading, Heading to point, and Head direction, (but not for Turn angle) the circular 
statistics are used.

Group statistics are not weighted. For example The total distance moved is 100 cm 
for trial 1, and 200 cm for trial 2. The resulting group mean is 150, independent of 
how many samples each track is made of.

Similarly, the group Standard error, Standard deviation, and the 5-number summary 
(Minimum, First Quartile, Median, Third Quartile and Maximum) are calculated from 
the single values of the dependent variables reported in Trial Statistics.
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Notes
▪ The number of decimals in the Trial Statistics and Group Statistics is fixed to 

four. When exporting the results table, the number of decimals varies 
depending on the number of integers in the value. See Export the statistics 
result

▪ The dependent variables displayed in Group Statistics & Charts are those 
defined in the Analysis profile chosen from the list in the toolbar.

▪ The statistics displayed in Group Statistics & Charts are those selected 
under Group Statistics for that variable in the currently active Analysis 
profile. Group statistics are always measures of central tendency, either a 
Mean (with Standard deviation and/or Standard error) or the 5-number 
summary (Minimum, First Quartile, Median, Third Quartile and Maximum). 
You cannot calculate, for example, the group total of distance moved.

▪ The group statistics can be calculated for all the trial statistics, except for 
the standard error, the standard deviation and the variance. For example, 
you cannot calculate the group mean of the trials’ standard deviations of a 
variable.

▪ To add and remove statistics, right-click any column header for the 
dependent variable for which you want to add or remove the statistics, and 
select Properties. On the Trial Statistics and Group Statistics tabs, select 
the statistics that you require.

▪ See also Analyze groups of tracks.
951



Modify the layout of the results table
Aim
To make sure your results are grouped and displayed in the most useful way 
possible. This is particularly the case when exporting the results to another 
application.

NOTE  This applies to Trial Statistics and Group Statistics.

Prerequisites
▪ You have run analysis (Analysis > Results > Statistics and Charts > 

Calculate).

General procedure
Click the Layout button on the toolbar, or choose Show/Hide > Layout.

By default, the results table shows the dependent variables and their statistics on 
the columns, and the trials on the rows. In the following example you can see how 
you can customize the layout of the table.
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What do you want to do?
▪ Add a header to the table
▪ Remove a header from the table
▪ Special headers in the Layout window
▪ Move a header between rows and columns
▪ Swap rows and columns
▪ Modify the table hierarchy
▪ Show and hide part of the table
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▪ Remove empty rows or columns
▪ Reset the table layout
▪ Move the headers in the Group statistics results table

Add a header to the table
EXAMPLE  In the Trial Statistics page, add the independent variable Treatment, so that 
each row (trial) is labeled with the value of Treatment, either Compound or Vehicle.

1. Click the Layout button on the toolbar.
2. In the Available box, click the header you want to add.
3. Click the arrow button which points to the On Rows box.

4. OPTIONAL  Move the header up in the list to have trials separated based on 
the values of Treatment.

NOTES

▪ If you click the arrow button which points to On Columns, the variable is 
placed in columns.

▪ TIP  To add a new dependent variable, do this in the Analysis profile, then 
return to Analysis > Results > Statistics and Charts.

Remove a header from the table
EXAMPLE  Remove the Arena name from your table headers.
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1. Click the Layout button on the toolbar.
2. In the On Columns/On Rows box, click Arena.
3. Click the arrow button which points to the Available box.

▪ To remove measurement units, in the Layout window de-select 
Measurement units.

▪ To remove the detail of a dependent variable, like the body point name, in 
the Layout window de-select Detail about variable.

NOTE  Removing an element from the headers does not aggregate the results under 
that header. For example, if you remove Arena all results are still displayed for each 
arena separately. If you want to aggregate results, see Define groups of tracks.

Move a header between rows and columns
EXAMPLE  The dependent variables (Velocity, In zone, etc.) are placed in columns. 
Move them to the rows, so that each row represents one trial*dependent variable 
combination.

1. Click the Layout button on the toolbar.
2. In the On Columns box, click Variable with detail.
3. Click the arrow button which points to the On Rows box.
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Swap rows and columns
Select each item under On Columns and move it to On Rows. Next, select the items 
originally under On Rows and move them to On Columns.

Modify the table hierarchy
To place a header to a higher level in the table, click the element in the On Columns 
or On Rows box, and then click the Up button.
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To place an element lower in the table hierarchy, click the element in the On 
Columns or On Rows box, and then click the Down button.

NOTE  It is not possible to put Time bin above the Selection Result.

Show and hide part of the table
1. Click the Show/Hide button at the top-right corner and select the corre-

sponding element.
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2. In the window that appears, select the trials, arenas, subjects, et. that you 
want to have in the table.

3. Click OK.

Remove empty rows or columns
TIP  Do this if you have many rows or columns that are empty, and you want to 
export only the rows and columns with significant results.

In the Layout window, select Hide empty rows or columns.

NOTE  Rows and columns are not removed if at least one dependent variable is 
calculated for that row or column.

Reset the table layout
To return to the default layout, click the Layout button and in the Layout window 
click the Reset Default button.

Move the headers in the Group statistics results table
The results of group statistics shows the group statistic under the trial statistic. In 
the example below, you find the group statistic Mean under the trial statistic Total 
for distance moved. This means that the result is the mean value of the total 
distance moved calculated for each trial in that group.

When you click the Layout button, the item Group Statistic with units is selected 
under On Columns. 
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You can move the Group statistics headers and the units to the table rows or move 
them to a higher level in the table. 

▪ Move a header between rows and columns
▪ Modify the table hierarchy
▪ TIP  To have the track groups in different columns, not rows, select 

Selection Result and move it to On Columns.

Special headers in the Layout window
▪ Statistic with unit and Group statistic with unit show the names of the 

trial statistics and group statistic selected in the Analysis profile, 
respectively. If you move those headers in the table, the measurement units 
are moved to the same location.

▪ Selection Result refers to the dataset specified in the Results boxes of the 
Data profile. If the Data profiles includes two or more Result boxes, for 
example to group tracks, the headers for the corresponding boxes are 
automatically added to the table.
NOTE  If you remove Selection Result from the rows and columns, the 
results for different groups are still kept separate, because the Data profile 
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that specifies those groups is still active; only the headers disappear. If you 
want to merge results, use another Data profile.

▪ Time bin refers to the times bins defined in the Results box of your Data 
profile. If you do not define time bins in the Data profile, and select Time 
bin in the Layout window, the headers Start-End are added; no time bin is 
created. See Results per time bin

▪ Zone refers to the zones specified in the Results box of your Data profile. If 
zones are not specified, analysis is done for the whole arena and the table 
shows In Arena. See Calculate the results per zone 

▪ The independent variables that you have defined are not shown in the table 
by default. To export the table with the independent variable values as an 
analysis factor, click the Layout button and move that variable to On Rows 
or On Columns depending on how your statistics program treats analysis 
factors.
EXAMPLE  An independent variable Group with possible values Mutant and 
WT has been defined in the Trial List. To have the values of this independent 
variable displayed for each trial, click Layout, select the variable Group on 
the left and move it to the On Rows box. 

▪ Missed samples. This is the percentage of samples that EthoVision XT 
could not analyze. To reduce this percentage, see Factors affecting the 
occurrence of missing samples in Sample rate
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▪ Subject not found. This is the percentage of the analyzed samples in which 
EthoVision XT could not find the subject. A lower value indicates high 
reliability of data. To reduce this value further, optimize the lighting 
conditions and adjust the Detection Settings to improve detection rate.

▪ If you select track segments with Nesting, there is no special header for 
them. However, remember that the results are calculated over the track 
segments defined, not the entire tracks.

See also

▪ The statistics result
▪ Trial Statistics result
▪ Group Statistics result
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Sort the results table
Aim

▪ To sort the results table based on the row headers.
▪ To sort the results table based on the values in a column.
▪ To change the order of and group the dependent variables in the results 

table.

Prerequisites
▪ You have run analysis (Analysis > Results > Statistics and Charts).

Procedure

Sort the table rows based on their headers

EXAMPLE  Sort the results table based on the header Treatment, an independent 
variable with values Drug and Vehicle.

1. Click the Layout button and under On Rows move Treatment to the high-
est position in the list. See Modify the layout of the results table

2. Right-click one of the headers you want to sort, and select Sort Ascending 
or Sort Descending.
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NOTE  If you sort the rows based on the headers on the second, third, etc. column, 
the rows are sorted only within that level, not globally. For example:

To have all rows marked with Subject 1 at the top of the table, then all rows with 
Subject 2, etc., click the Layout button and move Subjects to the top of the list 
under On Rows, then sort the subject headers.

Sort the table rows based on the cell values

EXAMPLE  Sort the table based on the values of Frequency of zone entries.

Right-click one of the cells containing the values you want to sort, and select one of 
the two sorting options.

Sort the dependent variables in the results table

EXAMPLE  Sort the results table by the dependent variables; first, Distance moved, 
then Movement and then In zone.
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1. Click the Show/Hide button at the top-right corner and select Dependent 
Variables.

2. In the window that appears, select a dependent variable and click the Up 
and Down buttons to move a variable to a higher/lower position in the 
table.

Result: The dependent variable at the top of the list in that window is shown 
in the first row or column in the result table.
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Group charts
Learn about

▪ Group charts

What do you want to do?
▪ Customize the group charts
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Group charts
How to read the group charts
Charts are generated automatically from the results in the Group Statistics & Charts 
table.

In this example, charts are generated for the dependent variables Distance moved 
(here shown on top), Velocity and In zone (on the other two tabbed pages). The 
horizontal axis shows the zones (In Border and In Center). Two data series (from the 
Result containers Control and Treated) are plotted.
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Chart tabs
Each tab refers to a dependent variable defined in the Analysis Profile. 

A tab may contain one or more charts, one for each Trial Statistic specified for that 
dependent variable.

Notes
▪ A chart is not created for the Trial statistics Standard Deviation, Standard 

Error and Variance.
▪ Charts in EthoVision XT have limited formatting options and are mainly 

meant for inspection purposes. If you want to make a chart for a 
publication, export the statistics table to Excel or a statistics program. 

▪ If you delete a dependent variable and subsequently add it again to the 
Analysis profile, the properties of the new chart are set to default. 

▪ Chart settings are stored for each combination of data profile and analysis 
profile. If you make an exact copy of a data/analysis profile, the resulting 
charts have default settings.

▪ Effect of Data selection: Results per time bin
If in the Data profile you specify Results per time bin, time bins are always 
shown on the horizontal axis. The first value is 0:00:00 and represents the 
results calculated in the first time bin (for example from 0 s to one minute).
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▪ Effect of Data selection: Results per zone
If in the Data profile you specify to Calculate the results per zone, you can 
show the zones on the horizontal axis or as data series. See Customize the 
group charts

▪ If you specify both time bins and results per zone, time bins are displayed 
on the horizontal axis and zone statistics as data series.

▪ If you specify more than 1000 time bins in your Data profile, the group 
charts are not displayed.

To export group charts
You can export one chart at a time. To export a chart as an image file, do one of the 
following:

▪ Right-click the chart and select Export Chart.
▪ Click the chart and then click the Export Chart button just above the chart.

The default file name is the same as the chart title.

Four formats are available: Portable Network Graphics (*.png), JPEG file (*.jpg), 
Windows bitmap (*.bmp), and Graphics Interchange Format (*.gif).

To copy the chart to an external program, right-click the chart and select Copy, then 
paste it to the other program.
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Customize the group charts
How to access these options
Do one of the following:

▪ Double-click the chart.
▪ Right-click the chart and select Chart Properties.
▪ Click the Edit Chart Properties button (if there are more charts in the same 

tab, the first one is selected by default. To customize another one, first click 
the chart you want to edit).

TIP To apply the same properties to all charts in the same tab, make the changes in 
one chart and then click Apply to All.

What do you want to do?
▪ Change chart type, size and title
▪ Arrange the data in the chart
▪ Show the error bars
▪ Sort the element of a chart
▪ Change colors, fill patterns, dot size and bar width
▪ Edit axes, gridlines, and legend
▪ Apply the changes to other charts
▪ Reset to default charts

TIP  If you want to make a Box and whiskers chart, you must first specify 5 number 
summary as a group statistic for the variable of interest. You can do this in two 
ways: (1) in the Analysis profile, open the variable settings window and locate the 
Group Statistics tab. Or (2) in the statistics result table, right-click the variable name 
and choose Properties then locate the Group Statistics tab.

Change chart type, size and title
Click Chart in the Chart Properties window.
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▪ Chart type. Choose between Bars, Lines, Box and whiskers, and Box, 
whiskers and data points.
By default, a Bars chart is created. However, if you define time bins, a line 
chart is created; if you specify 5-number summary in Group Statistics, a box 
and whiskers chart is created. Select a different type from the list (when 
applicable). 

Choose Box, whiskers and data points if you also want to plot the data 
points that generated the charts. Note that each dot represents the value of 
a variable calculated for a specific trial. 

▪ Chart width. Move the slider or click the arrow buttons to select the 
required width (range 50-500).
TIP To change the width of a chart, you can also drag the vertical line at the 
right of the chart.
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To change the height of the chart, drag the upper margin of the chart 
window.

▪ Display chart title. Enter the title you require. The default is [name of 
dependent variable] - [name of statistic].

Arrange the data in the chart
Click Data selection in the Chart Properties window.

▪ Specifiers. These are elements that can create independent data series. 
What you see under Specifiers much depends on the variable you want to 
analyze. They can be single body points (e.g. center-point for the variable 
Distance moved), subjects, variable states (e.g. Mobile, Immobile and Highly 
Mobile for Mobility), manually-scored behaviors (Grooming and Not 
Grooming for the behavior Grooming), or combinations of elements, for 
example Proximity of Nose point to another subject’s center-point.
Select the specifier that you require.

▪ Data Series. Choose the categories that you want to appear in the legend.
If you select Specifiers, for each category on the horizontal axis you get as 
many data series as the specifiers selected. Note that if you only have one 
item in the Specifiers box (see above), Specifiers is not in this list.

EXAMPLE 1  You have the two subjects Control and Treated and selected 
Relative movement in the Analysis profile and selected the body point Nose 
point for the actor and Tail base for the receiver. The Specifiers of the Chart 
for Relative movement are Moving to / Nose point / Control - Tail base; 
Moving from / Nose point / Control - Tail base; No movement / Nose point 
/ Control - Tail base; etc.

EXAMPLE 2  You track the center-point of one animal, specified the zones 
Center and Border, and selected the dependent variable In zone in the 
971



Analysis Profile. The Specifiers of the Chart for In zone are Border / Center-
point and Center / Center-point. 

▪ If you select Results, you get as many data series as the combinations 
[Result containers]*[Specifiers]. The Results are the names of the Result 
containers of your Data Profile. 

▪ If you select Results/Zones, you get as many series as the 
combinations [Result containers]*[Zones selected in Results per zone in 
the Data profile]*[Specifiers].

▪ If you select Zones, you get as many series as combinations [Zones 
selected in Results per zone in the Data profile]*[Specifiers].

▪ If you select an independent variable, you get as many data series as 
combinations [independent variable values]*[Specifiers].

IMPORTANT A category or independent variable is listed only when it 
identifies each group uniquely. For example, if tracks in a group (selection 
in the Result container of your Data Profile) have two or more different 
values of Treatment level, this variable is not shown in the list. In this case, 
the Group Statistics table shows [multiple values] in the header.

▪ Horizontal axis. Select what you want to have as the categories on the 
horizontal axis.
▪ Results. To have the groups defined in your Data Profile as the 

categories.
▪ [Independent variable name]. To have for example treatment levels or 

Dosage values as the categories (but see the note above).
▪ Zones, or Results/Zones, (when applicable). 
▪ Time bins is selected by default when you defined time bins in your 

Data Profile.
TIP To combine two independent variables, choose one as Data series and 
the other as Horizontal axis (see the figure below).
972



Show the error bars
Click Data selection in the Chart Properties window. Select Show error bars when 
you want to plot the standard deviation/standard error as error bars. 

The option is only available when the statistic is selected under Group Statistics for 
that dependent variable. To add the statistic, right-click the header of the 
dependent variable in the Group statistics and Charts tab and click Properties. 
Click Group Statistics and select the statistic you require.

Sort the element of a chart
1. In the Chart Properties window, click Data sort order.
2. Here you can change the sort order of the categories for both horizontal 

axis and data series. Choose Alphabetical (Ascending or Descending) or 
Manual (click a category and then click the arrow buttons to move it up/
down).

Change colors, fill patterns, dot size and bar width
1. In the Chart Properties window, click Series format.
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2. Select either Color or Pattern.
3. Under Elements, choose the color or pattern for each item. 

These element may include, depending on the type of chart: 

▪ Body points.
▪ Subjects.
▪ The type of behavior (e.g. Moving vs. Not Moving).
▪ The Median (when you choose a Box and whiskers chart) and the 

Datapoints (when you choose Box, whiskers and data points chart).
NOTE  Pattern fill is only available when you choose a Bars or Box and 
whiskers chart.

4. The following options are available for some chart types:
▪ Dot size. Select the size of the dots. This applies to Box, whiskers and 

data points. NOTE  All dots lie on the vertical middle line of the box plot. 
It is likely that individual points overlap and are therefore visible.

▪ Bar width / Box width. Select the bar/box width (range 0-100). Note 
that for Box and whiskers charts, this also changes the width of the 
whiskers.

▪ Gap between bars. Move the slider or click the arrow buttons to select 
the required gap between adjacent bars (range 0-100).
974



Edit axes, gridlines, and legend
In the Chart Properties window, click Axes and Legend.

For the Vertical axis:

▪ Select Display vertical axis title and enter the new title. The default title is 
[name of trial statistic] [unit].

▪ Next to Scale min and Scale max, set minimum and maximum value of the 
vertical axis automatically (Auto), or select Fixed and enter the values you 
require.

▪ Select or deselect Display gridlines.
For the Horizontal axis: 

▪ Select Display horizontal axis title and enter the new title. The default title 
is the name of the category selected as Horizontal axis.

For the Legend:

▪ Select Display legend.
The legend lists the possible combinations of specifiers and the item 
selected under Data series, separated by “/”.

Apply the changes to other charts
Click Apply to All at the bottom of the Chart Properties window. This copies the 
settings to all charts on that tab, not in other tabs. 

Reset to default charts
Click Reset to Default at the bottom of the Chart Properties window. This resets the 
current chart to default, not other charts. 

Notes
▪ In Box and whiskers charts, the box includes from 25% (first quartile) to 

75% (third quartile) of the data points; the range of data is also named 
interquartile range. The whiskers include the whole range of the data, 
including potential outliers.

▪ If you deselect an element from the Show/Hide menu, this element is 
removed from the statistics table, not from the chart.

▪ To remove a statistic from the chart, right-click the header of the dependent 
variable in the table, and click Properties. Click Group Statistics, and 
deselect that statistic.
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Batch statistics calculation
What to you want to do?

▪ Run Batch calculation

See also

▪ Auto-start data analysis
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Batch calculation
Aim
Batch calculation helps you perform calculations in multiple runs, each with a 
particular combination of track smoothing settings, data profiles and analysis 
profiles. It is handy when you have large data sets that take hours to analyze. In that 
case you can start batch calculation at the end of the day, and return the next day to 
collect the results.

Each analysis run is based on a combination of three profiles:

▪ Track Smoothing profile (for smoothing tracks and filtering noise).
▪ Data profile (the trials and samples subject to analysis).
▪ Analysis profile (the dependent variables and their statistics).

TIP  When you carry out batch data acquisition, it is also useful to couple this with 
batch statistics calculations, so that analysis is started automatically after acquisition 
of the last trial has ended. See Auto-start data analysis.

To run batch calculation
1. Make sure that all Track Smoothing profiles, Data profiles and Analysis pro-

file that you want to use are defined in the Experiment Explorer.
2. Choose Analysis > Results > Statistics & Charts, or in the Experiment 

Explorer, under Results, click Statistics & Charts.
3. Click the Batch button.

4. In the Batch Calculation window, do one of the following:
▪ If you want to carry out batch calculation for all the combinations of 

Track smoothing profiles, Data profiles and Analysis profiles, click Add 
all. 

▪ If you are interested in specific combinations of profiles, select the 
combination of profiles that you want to use, and click Add. Repeat this 
step for all the combinations you require. 

TIP To remove a profile combination, click that combination in the list and 
then click Delete. To select multiple combinations, click each combination 
while holding the Ctrl key down.
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TIP To minimize processing time and disk space occupied by the results, 
make sure that when you select Add all, the Track smoothing, Data and 
Analysis profiles in your experiment are those you want to use for analysis. 
Remove any duplicate or non-interesting profiles.

5. The Batch Calculation window lists the combinations selected for 
calculation.

6. Click Calculate when you are ready. To retrieve the results for a particular 
combination of profiles, select this combination from the lists on the 
toolbar.

7. Export the results. Note: You can export the result for one combination of 
profiles at a time. See Export the statistics result.

Note
▪ Batch statistics calculations create a number of temporary files. For this 

reason, they may require large disk space, especially when you analyze 
large amount of data. These files may also make backup files excessively 
large. Before backing up an experiment, make sure to remove unnecessary 
files to create a smaller backup file. For more information, see Back up an 
experiment.
978



Dependent Variables in 
Detail

Main topics and tasks
▪ Movement  981
▪ Location  995
▪ Path  1006
▪ Direction  1020
▪ Body  1044
▪ Social  1074
▪ Behavior Recognition  1103
▪ Manually scored behavior  1114
▪ Trial Control  1116
▪ External Data  1124
▪ Custom Variables  1133
▪ Live Mouse Tracker  1190

Notes
▪ You can use dependent variables:

▪ In Trial Control. For example to start tracking when a specific behavior 
or event occurs.

▪ In the Data profile. For example, to select the intervals when the subject 
was moving.

▪ In the Analysis profile. For example, to calculate statistics of distance, 
velocity or specific behaviors.
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▪ Some dependent variables are only available if you have one of the add-on 
modules installed: Trial and Hardware Control, Social Interaction, Rat/
Mouse Behavior Recognition and Live Mouse Tracker.

▪ If none of the dependent variables cannot help quantify behavior of your 
subjects, please contact Noldus, so we can discuss your analysis 
requirements.
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Movement

▪ Distance moved  982
▪ Velocity  984
▪ Movement  988
▪ Acceleration  991
▪ Acceleration state  993
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Distance moved
Definition
The distance traveled by the center, nose or tail-base point of the subject from the 
previous sample to the current one. It is calculated as:

where:

▪ DMk = Distance moved from sample k–1 to sample k

▪ Xk-1, Yk-1 = X,Y coordinates of the center, nose or tail-base point at sample 
k-1, 

▪ Xk, Yk = X,Y coordinates of the center, nose or tail-base point at sample k-1.

How to specify Distance moved
1. Click Add next to Distance moved.
2. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points for which 
you want to calculate the distance.

▪ Because it is based on change in X,Y coordinates, Distance moved needs 
two valid (non-missing) samples. A missing sample in your track results in 
missing Distance moved values in that and in the next sample. Make sure 
that the proportion of missing samples is low (less than 1%).

▪ Sample rate influences the values of Distance moved. When tracking at too 
low a sample rate, parts of the actual path are cut off, resulting in an 
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underestimation of per-sample (and total) Distance moved. If, on the other 
hand, the sample rate is too high, EthoVision XT catches the wobbling of 
the body's center point of the walking animal, causing extra apparent 
movement, and therefore an overestimation of per-sample (and total) 
Distance moved. See Track Smoothing for a description of how to filter out 
small movements.

Applications
Distance moved is often used to give a general measure of activity. It is also used as 
the basis for calculating other parameters such as velocity (see below). 

In rodent models of aging, the total and maximum distance moved are used to 
calculate the frailty index. See Parks et al. (2012) J. Gerontol. A 67(3): 217-227.
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Velocity
Definition
The distance moved by the center, nose or tail-base point of the subject per unit 
time.

Velocity is obtained by dividing Distance moved by the time difference between a 
sample and the previous one:

where Vk = velocity at sample k (expressed in the unit you have defined in the 
Experiment Settings) and DMk = Distance moved at sample k. 

How to specify Velocity
1. Click the Add button next to Velocity.
2. Under Outlier filter, specify the Averaging interval. Leave 1 if you want to 

keep the raw data; enter a value to smooth the values using a running 
average method. See Averaging interval

3. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points for which 
you want to calculate the velocity.

▪ Sample rate influences the calculation of Distance moved, and therefore 
Velocity. When tracking at too low a sample rate, parts of the actual path 
are cut off, resulting in an underestimation of per-sample Velocity. If, on the 
other hand, the sample rate is too high, EthoVision XT catches all random 
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movements and wobbling of the body point of the walking subject, causing 
extra apparent displacement, therefore an overestimation of Velocity.
See Track Smoothing for a description of how to filter out small 
movements.

▪ Because it is based on change in distance moved, Velocity needs two valid 
(non-missing) samples. A missing sample in your track results in missing 
Velocity values in that and in the next sample. Make sure that the 
proportion of missing samples is low (less than 1%).
You can view the proportion of missing samples as one of the System 
Variables in the Trial list.

Application
▪ Apart from the obvious applications of this dependent variable, the mean 

velocity is sometimes used as a measure of general activity (for example, 
Nilsson et al. 1993, J. Exp. Biol. 180, 153-162; Winberg et al. 1993, J. Exp. Biol. 
179, 213-232).

▪ TIP  Define Velocity and Movement in the same Analysis profile to find out 
which averaging interval results in the best match between movement 
bouts and video.

▪ In rodent models of aging, the average velocity is used to calculate the 
frailty index. See Parks et al. (2012) J. Gerontol. A 67(3): 217-227.
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Averaging interval
Aim
To smooth the values of a dependent variable.

This topic applies to
Dependent variables: Acceleration state, Activity, Activity state, Body angle state, 
Body elongation, Body elongation state, External data (resampled), External data - 
state, Mobility, Mobility state, Movement, Velocity. 

The dependent variable can be in a condition defined in the Trial Control Settings, 
in the Analysis profile and in the Data profile. Setting the Averaging interval in one 
part of EthoVision XT does not influence the value of the same variable in the 
others.

How to access this option
In the Trial Control Settings, in the Analysis profile or in the Data profile select the 
dependent variable and locate Outlier filter.

How Averaging interval works
▪ When Averaging interval is 1, the outlier filter is off, thus the values of the 

variable are not smoothed.
▪ When Averaging interval is 2 or larger, EthoVision XT replaces the per-

sample value of the dependent variable with the average calculated over 
the number of samples specified by the interval. 

The table below shows how EthoVision XT re-calculates a variable V in a few 
samples when Averaging interval is set to 2. Note how the average (avg) is obtained 
when values of the dependent variable are missing. Remember that velocity V at 
time t is only calculated when there are valid samples at time t and t-1. See Velocity
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Notes
▪ Note the difference between Track Smoothing and the Outlier filter (this 

topic):
▪ With Track Smoothing, you smooth the raw x,y coordinates. This has 

also an effect on the dependent variables calculated based on those 
coordinates, for example Distance moved. See Smooth the Tracks 

▪ With Outlier filter, you smooth the values of the dependent variable, 
for example velocity or mobility, after they are calculated from the raw 
data. The Outlier filter is useful when you want to calculate state 
variables. Apply the Outlier filter, for example, when you want to 
smooth Velocity to calculate the Movement states, which are based on 
velocity; or smooth Mobility when you want to calculate Mobility state.

▪ If you combine Track Smoothing with Outlier filter, the dependent variable 
is calculated with the Outlier filter after the raw coordinates are smoothed 
with Track Smoothing. 

Sample Valid (•) or 
missing (-)

Original value Smoothed value when averaging 
interval = 2

1 • V1 V1

2 • V2 avg (V1, V2)

3 • V3 avg (V2, V3)

4 - not calculated avg (V3, [no value]) = V3

5 - not calculated avg ([no value], [no value]) = [no value]

6 • not calculated avg ([no value], [no value]) = [no value]

7 • V7 avg ([no value], V7) = V7
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Movement
Definition
A discrete (state event) variable, based on one of the body points, with two possible 
states, Moving and Not moving:

▪ The state is Moving if the running average velocity of the body point 
exceeds the user-defined Start velocity. 

▪ The state remains Moving until the running average velocity drops below 
the user-defined Stop velocity.

▪ The state then becomes Not moving until the running average velocity 
reaches the Start velocity again.

In order to reduce the sensitivity of this dependent variable to brief changes in 
velocity, the data can be smoothed by taking the running average of the last k 
samples. This number is referred to as the averaging interval. 

When a body point is missing for more than three samples, the current Movement 
state ends and the remaining missing samples are ignored.

In the following example, the velocity initially lies between the Stop velocity and the 
Start velocity. Therefore, the Movement state is undefined. When velocity exceeds 
the Start value, Movement is given the value Moving. When velocity drops below 
the Stop value, Movement is given the value Not moving.
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How to specify Movement
1. Click the Add button next to Movement.
2. In the Movement tab, enter the following: 

▪ Averaging interval: The number of samples over which the running 
average velocity is based. The default value is 1, that is, velocity is not 
smoothed before calculating the Movement variable.

▪ Start velocity: The velocity above which the subject is considered to be 
moving.

▪ Stop velocity: The velocity below which displacements of the subject’s 
body points are no longer attributed to locomotion but to system 
noise, body wobble or pivoting on the spot.

NOTE  The default values are an example and may not apply to your 
experiment. The threshold values also vary between species. If the subject is 
very slow, like a walking tick, you must reduce the two thresholds to detect 
true movement. See also a note below. 

3. Under Calculate statistics for, select either one of them, or both.
▪ Moving: To calculate statistics for when the subject is moving.
▪ Not moving: To calculate statistics for when the subject is not moving.

4. Complete the procedure to add the variable See Calculate statistics: 
procedure.

Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points for which 
you want to calculate movement.

▪ To find the optimal Start velocity, plot the values of Velocity and take note 
of the values when the animal moves in the video. Do this for a couple of 
videos. The Start velocity should be just below those values. Similarly, to 
find the optimal Stop velocity, take note of the values of velocity when the 
animal sits still. The Stop velocity should be just above those values. 
Obviously, a more objective evaluation could come from a statistical 
approach (e.g. to find cutoff values that discriminate between different 
behaviors, moving vs not moving). 

▪ By increasing the averaging interval, you can increase the reliability of 
movement detection. A running average velocity based on more samples 
diminishes the effect of random changes in velocity due to noise. However, 
a drawback of increasing the averaging interval is that it causes a delay in 
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the determination of a state transition, proportional to the length of the 
interval. See Averaging interval

▪ Values of velocity between Start velocity and Stop velocity result in no 
change in the current state of the subject (moving or not moving). The 
smaller the difference between the two threshold velocities, the more likely 
that transitions between the states Moving and Not moving are scored. By 
defining such a buffer, you prevent overestimation of transition rates 
because of a velocity joggling just around the movement threshold.

Application
Like Velocity, Movement provides information on the subject's locomotor activity.

In rodent models of aging, the total duration of Moving, both in seconds and as 
percentage of the trial time, are used to calculate the frailty index. See Parks et al. 
(2012) J. Gerontol. A 67(3): 217-227.
990



Acceleration
Definition
Acceleration at sample k is obtained by dividing the difference in Velocity, by the 
time difference between that sample and the previous one:

Where:

▪ Ak = Acceleration at sample k,

▪ Vk = Velocity at sample k.

How to specify Acceleration
1. Click the Add button next to Acceleration.
2. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points for which 
you want to calculate acceleration.

▪ Because it is based on change in velocity, Acceleration needs three valid 
consecutive samples. A missing sample in your track results in missing 
Acceleration values in that and in the next two samples. See also the notes 
under Velocity.

▪ Acceleration is sensitive to random changes in velocity between 
consecutive samples due to noise. Check the track and velocity plot to see if 
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changes in velocity represents true acceleration. If necessary, apply Lowess 
smoothing to the tracks.
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Acceleration state
Definition
A discrete (state event) variable, related to one of the body points, with two possible 
states, High acceleration and Low acceleration. At any sample time:

▪ The state is High acceleration when the running average acceleration 
exceeds the High acceleration above threshold.

▪ The state is Low acceleration when the running average acceleration is 
below the High acceleration above t threshold.

The running average acceleration is calculated according to the formula for 
Acceleration for each sample, over the number of samples specified by the 
Averaging interval. 

How to specify Acceleration state
1. Click the Add button next to Acceleration state.
2. In the Acceleration State tab, enter the following:

▪ Averaging interval. This is the number of samples over which the 
running average acceleration is based. The default value is 1, that is, 
acceleration is not smoothed before calculating the Acceleration state 
variable.

▪ High acceleration above. The acceleration above which the animal 
must be considered in the High acceleration state.

3. Under Calculate statistics for, select the state you want to analyze, High 
acceleration and/or Low acceleration.

4. Under State duration threshold, next to Exclude instances shorter than, 
enter the minimum duration of the Acceleration state (see the note below).

5. In the Body Points tab (if present), select the body points for which you 
want to calculate Acceleration state.

6. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ Enter zero as High acceleration above to distinguish between positive and 

negative acceleration.
▪ To find the optimal High acceleration above threshold, run a few test trials 

and in the Integrated Visualization plot the values of Acceleration and 
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Acceleration state. Adjust the threshold value in such a way that the state 
High acceleration is scored only when the animal shows bursts of rapid 
movement in the video.

▪ We advise you to use an Averaging interval greater than 1 to remove the 
effect of random changes in velocity between consecutive samples that 
would result in false transitions between Low and High acceleration. 
However, the greater the Averaging interval, the longer the delay in the 
determination of a state transition. See Averaging interval

▪ The State duration threshold is the minimum duration of the set of 
consecutive samples with Acceleration above (or below) the High 
acceleration above threshold required in order to be scored as the 
corresponding state. If the set of samples passes the threshold, the samples 
are scored as the state. If the set of samples does not pass the threshold, 
the previous state ends, but no new state is defined. Use this option to filter 
out brief transitions between High and Low acceleration caused by body-
point jitter or noise detection.

Applications
Use Acceleration state to mark bursts of rapid movement, like swimming bursts in 
fish.
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In zone
Definition
A discrete (state event) variable with two possible states, In zone and Not in zone, 
depending on whether the body point chosen is within a zone (or group of zones). 

The state for a specified zone is determined for each sample by comparing the 
coordinates of the chosen body point with the coordinates that make up the zone 
of interest. 

How to specify In zone
1. Click the Add button next to In zone and click the In zone tab in the win-

dow that appears.
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2. Under In the following zones, select the zones you want to analyze. For 
example, if you want to calculate the total time the animal was in Zone 1, 
select Zone 1.
If you have chosen two or more zones, select how body points should be 
analyzed:

▪ For each selected zone: The body points are analyzed in each zone 
separately.

▪ When in any of the selected zones: The body points are analyzed 
when in any of the selected zones. 

▪ When in all selected zones: The body points are analyzed when in all 
those zones simultaneously.

▪ When not in any of the zones: The body points are analyzed that are 
in none of the selected zones. 

3. Under From following body points, select the points you want to consider 
for the calculation. For example, select Nose-point if you want to calculate 
the statistics of the time the nose point was in a specific zone. By default, 
Center-point is selected.
If you have chosen two or more body points, select one of the following 
from the list:

▪ For each selected point: Statistics are calculated for each point 
separately.

▪ If any point is in zone: Statistics are calculated for when any of the 
selected points is in the zone.

▪ When all points are in zone: Statistics are calculated for when all the 
selected points are in a zone simultaneously.

4. Under Threshold, enter the Zone exit threshold. That is, once the animal’s 
body point is detected in the zone, the animal is considered to be in the 
zone until its distance from the zone border (when outside the zone) 
exceeds that threshold. Default: 0 cm. Use this option to remove false re-
entries resulting from random movements of the body point around the 
zone border. The following example shows the effect of the threshold for 
different trajectories. The frequency is shown for In zone.
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5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ If your experiment is set to Only center-point detection or Color marker 

tracking, the In zone variable is calculated for the center-point.
▪ To find a good Zone exit threshold for In zone, plot the values of Distance 

moved for the body point you are interested in. For instance, in a Novel 
object test, plot the distance moved for the nose-point while the subject 
explores an object, that is, while its nose-point is within the border of the 
zone “object”. Take note of the variation in the per-sample distance moved 
and set the Zone exit threshold higher than this range.
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▪ If two zones are adjacent, that is, not overlapping, the subject’s body point 
is supposed to be either in one or the other zone. However, when the zone 
exit threshold is greater than zero, the subject’s body point may not yet be 
outside zone 1, and (by definition) be already in zone 2. To prevent this, re-
define the two zones in such a way there is a gap between the two, with its 
width at least the same as the threshold.

▪ When you export In zone as raw data, the values are exported for each 
sample time, with possible values 0 (Not in zone), 1 (In zone), or “-” 
(unknown). See Export the raw data (track and dependent variables)

▪ When a body point is missing for more than three consecutive samples, the 
In zone state ends and the remaining missing samples are not assigned to 
any state (neither In zone or Not in zone). 

▪ If you analyze the time that the subject spent in a zone that includes a 
hidden zone, the results are only given for when the subject is visible (and 
therefore detected) in the larger zone. If you want to calculate the total time 
in that zone including the time spent in the hidden zone, select both zones 
in the In zone settings (step 2 above), and sum up the time values for the 
two zones reported in the results table.

Application
In zone is a standard variable for any study involving the usage of space by animals. 
For example:

▪ Open field: How much time did the animal spend by the walls, and how 
long did it take to cross the open center? (for example, Berendsen et al. 
1994, Behav. Pharm. 5 (Suppl. 1): 81).

▪ Maze studies: How many errors did the animal make? (for example, Ploeger 
G.E. 1995, PhD thesis, Utrecht University) How long did it take to get to the 
target (Ploeger et al. 1994, Behav. Neurosci. 108, 927-934) How many times 
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did the animal enter the open arms in a plus maze? (Law et al. 2003. J. 
Neurosci. 23: 10419-10432).

▪ Four-way olfactometer: How much time did the animal spend in the treated 
odor field? When did it first enter one of the arms? (Kaiser and de Jong 
1994, Behav. Proc. 30: 175-184).

▪ Water-maze: How much time does the animal spend in an 18-cm wide path 
(Whishaw's corridor) from the starting location to the platform, designated 
as the correct route? If a rat deviated from this route, it received a maximum 
of one error on that trial (Whishaw's error, Whishaw 1985, Behav. Neurosci. 
99(5): 979-1005), indicating that it did not show a direct swim path.
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Distance to zone
Definition
The shortest distance between a subject's body point (or selection of points) and a 
zone (or group of zones). You can calculate the distance regardless of where the 
body point is, or assuming that the point is always outside the zone (in the latter 
case, the distance is set to zero when the body point enters the zone).

The calculation of this variable is performed in two steps: 

1. The coordinates of the point on the zone border that is closest to the coor-
dinates of the body point for the current sample are found.

2. The distance in a straight line between the two coordinates is calculated.

How to specify Distance to zone
1. Click the Add button next to Distance to zone and click the Distance to 

zone tab.
2. Under To the following zones, select the zones you want to consider for 

the calculation. For example, if you want to calculate the mean distance to 
Zone 1, select Zone 1. By default, Arena is selected.  
If you have chosen two or more zones, select how the zones should be 
analyzed:
▪ For each of the selected zones. Zones are analyzed separately.
▪ Shortest distance to any zone. For each sample, EthoVision XT 

chooses the zone that is currently closest to the point(s) you have 
chosen, and uses the resulting distances for calculating the statistics.

3. Select the Include if in zone option if you want to calculate the distance to 
the border of a zone of interest, regardless of whether the subject is outside 
or inside the zone. If you want to calculate the distance to the border of the 
zone when the subjects is outside the zone, leave this option cleared. See 
one of the Notes below.

4. Under From following body points, select the points you want to consider 
for the calculation. For example, select Nose-point if you want to analyze 
the distance between the nose-point and a specific zone. By default, 
Center-point is selected.
If you have chosen two or more body points, select one of the following 
from the list:

▪ For each selected point. Statistics are calculated for each point 
separately.
1001



▪ Shortest distance to any point: For each sample, EthoVision XT 
chooses the body point that is currently closest to the zone, and uses 
the resulting distances for calculating the statistics. 

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ If you have selected Include if in zone in the Distance to zone tab of the 

variable's properties window, and the body point’s coordinates lie inside the 
zone, the Distance to zone is greater than 0.
EXAMPLE  Effect of the option Include if in zone on the distance to zone 
(DZ, dotted lines) for three consecutive samples 1, 2 and 3. The zone is 
shown in gray. When the option is not selected, and the sample 3 is within 
the zone, DZ for that sample is zero. When the option is selected, DZ for 
sample 3 has a value larger than zero.

▪ If your experiment is set to Only center-point detection or Color marker 
tracking, the body point options are not available. Calculations are based 
on the center point.

Application
Two examples of how you can use Distance to zone with Include if in zone not 
selected:

▪ In a Morris water maze test with the hidden platform defined as a zone, 
Distance to zone can measure the animal’s progress towards the platform. 
You can select the Total statistic to give a measure of the cumulative 
distance to zone (for training trials) and the Mean statistic to give a 
measure of average proximity (for probe trials; Gallagher et al. 1993. Behav. 
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Neurosci. 107: 618-626). See also the chapter The Morris water maze test in 
the EthoVision XT 18 - Application Manual for the exact procedure. You can 
also divide the maze into quadrants to give a more fine-grained analysis of 
behavior during the trial. 

▪ In a study of territorial behavior, the resident’s territory could be defined as 
a zone. You can then measure how close the intruder comes to that area.

One example of how you can use Distance to zone with Include if in zone selected 
is the following: 

▪ In a study of anxiety, one could define an entire open field as a zone, and 
then use Distance to zone to measure to what extent animals dare to move 
away from the wall. More generally, if you are interested in the distance 
between a subject and the edge of an open field or the border of an 
Elevated plus maze, you can select the complete arena as a zone.
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Distance to point
Definition
The shortest distance between a subject's body point and one or more points.

The calculation of this variable is performed in two steps: 

1. The coordinates of the defined point(s) and the body point(s) for the cur-
rent sample are found.

2. The distance in a straight line between the coordinates is calculated.
If your experiment is set to Only center-point detection or Color marker tracking, 
the body point options are not available. Calculations are based on the center point. 

How to specify Distance to point
1. Click the Add button next to Distance to point and click the Distance to 

point tab. 
2. Under To following points, select the points you want to consider for the 

calculation. For example, if you want to calculate the mean distance to Cue 
1, select Cue 1. By default, Arena (that is, the center of the Arena) is 
selected.
If you have chosen two or more points, select how the points should be 
analyzed:

▪ For each of the selected points: Points are analyzed separately.
▪ Shortest distance to any points: For each sample, EthoVision XT 

chooses the point that is currently closest to the body point(s) you have 
chosen, and uses the resulting distances for calculating the statistics.

3. Under From following body points, select the points you want to consider 
for the calculation. For example, select Nose-point if you want to analyze 
the distance between the nose-point and a specific point. By default, 
Center-point is selected.
If you have chosen two or more body points, select one of the following 
from the list:

▪ For each of the selected points: Statistics are calculated for each point 
separately.

▪ Shortest distance to any point: For each sample, EthoVision XT 
chooses the body point that is currently closest to the point, and uses 
the resulting distances for calculating the statistics.
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4. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ If your experiment is set to Only center-point detection or Color marker 

tracking, the body point options are not available. Calculations are based 
on the center-point.

▪ The center point of a zone can lie outside the zone itself. This occurs when 
the zone is ring-shaped or very asymmetrical.

Applications
Below are two examples of how Distance to point is of particular use in studies of 
spatial orientation:

▪ When analyzing the flight behavior of an insect in an odor plume, the 
plume itself can be defined as a zone, while the upwind odor source is 
regarded as a point. Using Distance to point, you can measure the insect’s 
progress towards the source at any moment in time.

▪ In an open field test, using the center point of the central area of the arena, 
Distance to point can be used to measure how far the animal ventured into 
the central area.
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Meander
Definition
Meander is the change in direction of movement of a subject relative to the distance 
moved by that subject. It provides an indication of how convoluted the subject’s 
trajectory is. Meander can be relative or absolute:

▪ Relative Meander: The change in direction is signed. With a default position 
of the Calibration axes (x-axis pointing to the right; y-axis pointing upward), 
a clockwise turn is scored as negative value because turn angle is negative; 
a counterclockwise turn is scored as positive. With other orientations of the 
x- and y-axes, the same turn may have different sign, depending on the 
relative turn angle. See Turn angle for how turns are given positive vs. sign.

▪ Absolute Meander: The turn angle that measures the change in direction is 
unsigned. Meander is therefore always positive.
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Calculation

Where RMk is Relative Meander, RTAk is the Relative Turn angle and DMk is the 
Distance moved at sample k. 

Absolute Meander is the absolute value of the Relative Meander.

You can calculate Meander in two ways:

▪ Based on body points: Meander is calculated from the turn angle and the 
distance moved of the specified body point, as shown in the figure above.

▪ Based on Head direction: Meander is calculated from the turn angle based 
on the Head direction line and the distance moved by the nose point.

Range
Given the formula above, Relative Meander can range from -∞º/cm to +∞º/cm, 
while Absolute Meander from 0/cm to +∞/cm. When DM is very small, Meander 
can get high, unrealistic values. One case when DM is very small is when you use a 
high sample rate and the subject does not move significantly. 

TIP  Before running analysis, make sure you use Track Smoothing to remove very 
small values of distance moved from your tracks.

See also Troubleshooting: Statistics > I get unrealistic values of path shape and 
direction
1008



How to specify Meander
1. Click the Add button next to Meander and click the Meander tab. Select 

Absolute or Relative.
2. Select Head direction meander (body point is ignored) if you want to 

calculate meander based on the head direction line.
3. Click the Body points tab and select the body points for which you want to 

calculate meander. By default, Center-point is selected.
4. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ If your experiment is set to Only center-point detection or Color marker 

tracking, the Body points tab is absent. Calculations are based on the center 
point.

▪ Meander is very sensitive to small, random movements of the body points. 
When the animal sits still, Meander can get very high, unrealistic values. To 
remove such small movements from your data, Smooth the Tracks, then run 
analysis.

Application
▪ The Relative Meander is a measure for the direction of turning per unit 

distance. This dependent variable can be of additional value to other turn 
bias variables, such as relative Turn angle and relative Angular velocity, since 
the turn bias is ‘corrected’ for the distance moved. For instance, if two 
individuals move at different speeds, the two can have very different values 
for the mean relative Turn angle, but at the same time have identical values 
for the mean relative meander.

▪ The Absolute Meander is often used in combination with the dependent 
variables absolute Turn angle and absolute Angular velocity to study 
turning rates. Bell (1991) reports that in most studies, when plotting the 
values, absolute Meander generates a smoother curve than absolute 
Angular velocity. This is caused by the fact that the latter dependent 
variable is influenced both by speed as well as by real turning rate. See Bell 
(1991). Searching Behaviour: The Behavioural Ecology of Finding Resources. 
Chapman & Hall, London.

▪ In rodent models of aging, the average meander is used to calculate the 
frailty index. See Parks et al. (2012) J. Gerontol. A 67(3): 217-227.
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Target visits and errors
Definition
An event marking the time when the animal visits a zone defined as target, or non-
target (error) zone.

How to specify Target visits and errors
1. Click the Add button next to Target visits and errors.
2. In the Target Visits and Errors tab, under Settings, choose the Target 

zones and the Non-target zones.
Under Threshold, enter the Zone exit threshold. That is, once the animal 
is detected in the zone, the animal is considered to be in the zone until its 
distance from the zone border exceeds that threshold. Use this option to 
remove false re-entries resulting from random movements of the body 
point around the zone border. Click for an example.

3. Under Calculate Statistics for, select the options you require:
▪ Target first visits: Visits to zones defined as targets.
▪ Target revisits: Revisits to the target zones (to analyze working 

memory). 
▪ Non-target first visits: First visits to non-target zones.
▪ Non-target revisits: Revisits to non-target zones (to analyze reference 

memory).
▪ Total errors: The total number of non-target zone visits and target 

zone revisits.
4. In the Body points tab, select the body point(s) you want to use for 

calculation.
If you have chosen two or three body points, select one of the following 
from the list:

▪ Each point: Visits are scored for each point separately. This results, for 
example, in one value of Successes for Center-point, and one value of 
Successes for Nose-point.

▪ Any selected point: Visits are scored no matter which selected point 
enters a zone.

▪ All selected points: Visits are scored when all the selected points are in 
a zone simultaneously.
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5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Below: Visualization of Target visits and errors scores in a radial-arm maze. Left: the 
mouse visits an arm for the second time. This is scored as Target revisit; Total 
errors is also scored. Right: the mouse visits an arm for the first time. This is scored 
as a Target first visit.

Application
▪ In a Barnes maze experiment, use Target visits and errors to analyze spatial 

reference memory. Calculate the number of successes and errors and their 
latencies, and compare those figures between probe trials (with escape 
hole being closed) and training trials. TIP: Select Nose-point to estimate 
nose pokes.

▪ In a Radial-arm maze experiment, use Target visits and errors to analyze 
working memory. Define the baited ends of the maze as targets. Calculate 
the number of target first visits and target revisits. To calculate the time 
needed to visit all arms, choose the Trial Statistic Latency to Last and in the 
results locate this statistics in the Target first visits column. 
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NOTE  Latency is always calculated from the start of the track, even when 
you define time bins and nesting intervals. 

▪ See also the EthoVision XT 18 - Application Manual for more information 
on the Radial-arm maze test.
1012



Zone alternation
Definition
An event scored when the animal visits specific zones in:

▪ Alternations: Multiple entries into different zones, with no reentries, in 
overlapping sets of zone entries. For example, for a Y maze with three zones 
A, B and C, the sequence of zone entries ABC is an alternation.

▪ Revisits: Multiple entries into the same zone. They can be direct (for 
example, AA) or indirect (for example, ABA).

EXAMPLE

Consider, the zone entry sequence in a Y-maze: ABCBACBCAB. The eight 
overlapping 3-zone entry sequences are: ABC, BCB, CBA, BAC, ACB, CBC, BCA, CAB.

Of these, six are alternations (underlined): ABC, BCB, CBA, BAC, ACB, CBC, BCA, CAB

Alternation is often calculated together with the maximum possible number of 
alternations for the given sequence (that is, the total number of zones entries minus 
2). In this example, it is 10-2 = 8.

The sequence above results in zero direct revisits, and two indirect revisits:

ABC, BCB, CBA, BAC, ACB, CBC, BCA, CAB

How to specify Zone Alternation
1. Click the Add button next to Zone alternation.
2. In the Zone Alternation tab, under Settings, choose the zones that define 

the alternation.
3. Under Threshold, enter the Zone exit threshold. That is, once the animal 

is detected in a zone, the animal is considered to be in the zone until its 
distance from the zone border exceeds that threshold. Use this option to 
remove false re-entries resulting from random movements of the body 
point around the zone border. Click for an example.

4. Under Calculate Statistics for, select the options you require:
▪ Alternations: To calculate statistics of alternations (ABC, ACB, etc.).
▪ Max alternations: To count the maximum possible alternations given 

the sequence of zone entries in your data (see a note below).
▪ Direct revisits: To calculate statistics of the direct revisits (AA, BB, etc.). 
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▪ Indirect revisits: To calculate statistics of the indirect revisits (ABA, 
ACA, etc.).

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Applications
In a T-maze or Y-maze experiment, you can use Zone alternation to analyze 
Spontaneous Alternation. See Hughes (2004) Neuroscience & Biobehavioral Reviews, 
28(5), 497-505.

▪ In the Zone alternation tab, select the arm zones. If the arm zones are 
separated by a Center zone in the same zone group, do not include the 
Center zone.

▪ Also select Max alternations. The ratio Alternations/Max alternations 
expressed in percentage gives the spontaneous alternation index. An 
alternation index around 50% indicates random arm selection.

Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points you want to 
use for calculation.
If you have chosen two or three body points, select one of the following 
from the list:

▪ Each point: Alternations and revisits are scored for each point 
separately.

▪ Any selected point: Alternations and revisits are scored no matter 
which selected point enters a zone.

▪ All selected points: Alternations and revisits are scored when all the 
selected points are in a zone simultaneously.

▪ Max alternations measures the maximum number of alternations that are 
possible with the actual data and given that number of zones considered. It 
is calculated in the following way: 
Max Alternation = Total visits - (Number of zones -1)

▪ Where Total visits is the total number of zone visits;
▪ Number of zones is the number of zones chosen under Settings; for the 

Y maze this is 3, for the plus maze it is 4.
EXAMPLE   You have a sequence of 22 visits to zones A, B, and C. Max 
alternations is 22 - (3 zones -1) = 22 - 2 = 20. The number of visits is 
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diminished by two to account for the fact that the last two visits in the 
sequence are not part of complete alternations, because the remaining 
visits are unknown. A value of 20 means that if the animal had visited each 
zone after visiting the other two in the previous two visits (ABCABC, etc.), it 
would have made 20 consecutive alternations (ABC, BCA, CAB; see the 
definition above). An example of the procedure can be found in Ragozzino 
and Gold (1994), Journal of Neuroscience 14(12), 7478-7485.

▪ In Integrated Visualization, a Max alternations event is scored from 
completion of the first set of entries and for each new zone entry from that 
point. In the Statistics results, the total number of those events is shown 
under Frequency.

▪ Direct revisits are evaluated in 2-zone entry sequences, also ignoring 
entries in zones not selected in step 2 above. For example, the sequence 
ADA results in one direct revisit (AA) when D is not selected.

▪ Indirect revisits are evaluated in 3-zone entry sequences, also ignoring 
entries in zones not selected in step 2 above. For example, the sequence 
ABDAB results in the indirect revisits ABA and BAB when D is not selected.

▪ Direct revisits and indirect revisits are calculated when you select at least 
two and three zones, respectively.
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Zone transition
Definition
This is the number of times an animal visits two or more zones in a sequence. For 
example, in a T-maze study, the transition Long Arm > Left Arm > Right Arm.

A Zone transition is scored when the animal enters the last zone of the sequence.

How to specify Zone transition
1. Click the Add button next to Zone transition.
2. In the Zone transition tab, to add a sequence click the Add button.

3. Select a zone and click  or double-click a zone to include it in the 
sequence you want to define. Repeat this step to add more zones and 
complete the sequence.
Under Zone sequence you can view the current selection. 

If the sequence is not correct, click and select the correct zones.

4. When ready click Add. Repeat steps 2-3 to add more sequences. 
5. Depending on which option under Settings you select, you can get 

different results. See the notes below.

6. Under Threshold, enter the Zone exit threshold. That is, once the animal is 
detected in a zone, the animal is considered to be in the zone until its 
distance from the zone border exceeds that threshold. Use this option to 
remove false re-entries resulting from random movements of the body 
point around the zone border.

Click for an example.
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7. Click the Body points tab, select the body point(s) you want to use for 
calculation.

8. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Zone transition counting options
For all options below, the zone transitions found in the data are marked in green. 
Zone transitions ignored are marked in red. The numbers in blue show the statistic 
Total number.

▪ Allow intermediate visits to any zone
With this option the sequence ABC is found in the zone visit data ABDC, 
where D represents any zone defined.

In the following example, the zone sequence CAB has been defined. A total 
of four transitions have been found.

▪ Allow intermediate visits to zones not in the sequence
With this option the sequence ABC is found in the zone visit data ABDC, 
just like in the example above, because D does not belong to the sequence 
defined. However, the same sequence ABC is not found in the zone visit 
data ABAC, because the second A is defined in the sequence.

In the following example, two transitions CAB have been found. The last 
two sequences are ignored.

▪ Only count direct transitions
With this option, sequences with intermediate visits to any zone are 
ignored.
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Do not use this option if your focal zones are not adjacent (for example, 
zones for a novel object and a familiar object), the arena includes multiple 
zone groups. In that case, direct transitions from the focal zones may not be 
counted if the subject crosses a third zone in another zone group. However, 
if your arena only includes one zone group with the non-adjacent zones, 
the results are reliable.

▪ Include overlapping sequences
You can apply this additional option to any of the options above. 
Overlapping sequences may occur if the first zone of the sequence defined 
is visited again before the previous instance is completed. Consider the 
following zone visit data:

...BABAB...

When looking for the sequence BAB, two overlapping sequences BAB are 
found:

...BABAB...

...BABAB...

Consider the following zone visit data:

...BABABAB...

If the option Include overlapping sequences is selected, the sequence 
BAB is found three times.

If the same option is not selected, the sequence BAB is found two times.

However, overlapping sequences that are completed at the same time point 
(that is, the same zone visit) are counted as one. In the following example, 
the sequence CAB is defined, and the method Allow intermediate visits to 
any zone is used. The two sequences CAB ending at the same visit to B are 
scored as one. Note that transitions are scored at the end of the last zone 
entry.
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Notes
▪ The Body Points tab is only available if your experiment is set to Center-

point, nose-point and tail-base detection.
▪ When you visualize the Zone transition variable, only the end of the 

transitions (which equals the last zone entry) is marked on the time plot. 
EthoVision does not calculate the duration of the transition.

▪ To delete a sequence, select that sequence under Settings and click the 
Delete button.

▪ Effect of missing samples. A transition from Zone 1 to Zone 2 is also counted 
when the subject enters Zone 1, then it becomes missing before exiting the 
zone, it is found again outside Zone 1 and finally enters Zone 2.

Applications
▪ In a Novel object test, calculate the number of transitions from the zone 

Familiar object to the zone Novel object, and from Novel object to Novel 
object. Or in a PhenoTyper or home cage test, calculate the transitions 
between the different corner visits. When the focal zones are not adjacent, 
select Allow intermediate zone visits.

▪ For Y-maze tests, see Zone alternation.
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Direction

▪ Heading  1021
▪ Heading to point  1024
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▪ Angular velocity  1040
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Heading
Definition
The direction of movement of the nose, center or tail-base point of the current 
sample relative to a line parallel to the x-axis in the coordinate system. 'Compass 
heading' and 'compass angle' are synonyms for Heading. See also Heading to point

Calculation
Heading is calculated in three steps:

1. The smallest angle  is found between the reference line and the vector 
connecting the samples k–1 and k.
The figure below shows the relationship between the angle formed by 
the segment joining samples k-1 and k, the horizontal line parallel to the x-
axis, and the dependent variable Heading (HE). Four cases are illustrated, 
corresponding to the possible directions an animal’s body point can be 
moving relative to the x-axis. Here, it is assumed the x-axis is horizontal and 
pointing to the right, and the y-axis is pointing upward.

2. The value of  is calculated according to the formula:
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Where:

▪ DMk is the distance moved at sample k.

▪ Xk and Xk-1 the x-coordinates of the center, nose or tail-base point at 
sample k and k–1, respectively. 

Because the way  is defined, it can only range from 0° to 90°.

3. How to convert  to Heading depends on the direction of movement 
between samples k–1 and k. The relation between Heading and  is 
determined by the following rules (see step 1 above).
- If X  0 and Y  0, then Heading = .

- If X  0 and Y < 0, then Heading = - . 

- If X < 0 and Y  0, then Heading = -(180 - ). 

- If X  0 and Y > 0, then Heading = 180 - . 

Where X = Xk - Xk-1 and Y = Yk - Yk-1.

Range
Heading ranges from -180° to +180°.

How to specify Heading
1. Click the Add button next to Heading.
2. Complete the procedure to add the variable. See Calculate statistics: 

procedure.
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Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points for which 
you want to calculate heading.

▪ The mean, standard deviation and variance are calculated with circular 
statistics. See Statistics available.

▪ Heading is calculated relative to the orientation of the x-axis you have 
chosen in the Arena Settings used for that trial. By default, the x-axis is 
horizontal and pointing to the right. If the x-axis is not horizontal or is 
pointing to another direction, Heading is calculated based on that axis 
direction.

Application
Heading is used in studies of spatial orientation. For example, you can use it to 
determine the direction of flight of a moth relative to the direction of the air flow in 
a wind tunnel. In a Morris water maze test, you can use this variable to measure 
initial heading of the path after releasing the animal in the basin.
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Heading to point
Definition
The direction of movement of the nose, center or tail-base point of the current 
sample relative to a point of interest. See Define zones and Draw a point

If your experiment is set to Center-point detection or Color marker tracking, 
calculations are based on the center point. 

Calculation
Heading to point is calculated in a way similar to Heading. The difference is that for 
Heading to point the reference line is the line that connects the previous sample and 
the point of interest. For Heading, the reference line is the line parallel to the x-axis.

Heading to point for sample k is the angle  formed by the segment joining the 
samples k-1 and k, with the line connecting sample k-1 and the point P (a point of 
interest or the center of a zone).

Range
Heading to point ranges from -180° to +180°. The closer to zero Heading to point is, 
the straighter the subject moves toward the point. Negative values occur when the 
subject moves to the right of the point; positive values in the other case.

Below: Example of Heading to point with positive and negative values in a water 
maze test. The platform has been specified as a target point. The chart shows 
Heading to point in the Integrated visualization (Analysis > Results > Integrated 
Visualization). 
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How to specify Heading to point
1. Click the Add button next to Heading to point.
2. From the Point of interest list, select the center of the Arena, center of 

gravity (COG) of a zone or a point you defined in the Arena Settings.
3. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ If your experiment is set to Center-point, nose-point and tail-base 

detection, click the Body points tab and select the body points for which 
you want to calculate heading to point.

▪ The mean, standard deviation and variance are calculated with circular 
statistics. See Statistics available

Applications
Use Heading to point to measure the subject’s orientation relative to a point of 
interest.

▪ Morris water maze. Use Heading to point to determine the Heading angle 
error. The Heading angle error is usually determined after the animal has 
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traveled a minimum distance, or after the first few seconds of each track. 
The Heading angle error at this point is the deviation from a direct line from 
starting point to center of the platform.
Below: The Heading angle error () in a water maze. The first two samples 
of the track are displayed. The arrow indicates the release point. 

How? First, in the Data profile under Nesting choose Time, and select for 
example from 0 to 2 seconds. This means that analysis is done on the data 
points of the first two seconds of the track. Next, in the Analysis profile 
choose Heading to point and select the platform as point of interest. As 
Trial Statistic, choose Mean. For other water maze output variables, see also 
the EthoVision XT 18 - Application Manual.

▪ Novel object test. Use Heading to point to determine the subject’s 
movement relative to an object. The assumption is that an animal is 
interested in a novel object when it is heading towards the center of the 
object.
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Head direction
Definition
The smallest angle formed by the Head direction line of the current sample relative 
to a line parallel to the x-axis in the coordinate system. See also Head directed to 
zone

The Head direction line is determined for each sample, based on the contour of the 
detected subject. It originates from the nose-point but it does not necessarily pass 
through the center-point. The angle  is assigned to the dependent variable Head 
direction for that sample.

NOTE  Head direction is not available if your experiment is set to:

▪ Center-point detection.
▪ Color marker tracking.
▪ Live Mouse Tracker.
▪ Center-point, nose-point and tail-base detection, with two subjects per 

arena tracked with Deep learning.

Examples
Below: An example of Head direction when exported in the raw data file (Analysis > 
Export > Raw Data; locate the Head direction column). 

The angle is negative (-180°, 0] when the Head direction line departing from the 
nose-point lies left to the line parallel to the x-axis. The angle is positive [0, +180°] 
in the opposite case (in this example the x-axis is in the default position; it is 
horizontal and points to the right). The top-left picture shows the Head direction at 
the sample highlighted below. 

IMPORTANT  Note that the value of Head direction depends on the orientation of the 
x-axis set in the Arena Settings.
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Range
Head direction ranges from -180° to +180°. Therefore, values like -179 and +179 
represent very similar orientations (head pointing to the left). Take this into account 
when interpreting the raw data.

How to specify Head direction
1. In the Analysis profile, click the Add button next to Head direction.
2. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ Head direction is a very different thing than the Turn angle based on the 

nose point. The latter variable measures the direction of movement, not the 
orientation of the head. See Turn angle

▪ You can check the head direction line during data acquisition. Click the 
Show/Hide button on the toolbar, select Track Features and make sure 
Head direction is selected. Next, let the animal move in the arena or play 
the video file. The real time Head direction values are shown in the Analysis 
Results and Scoring pane.

▪ The mean, standard deviation and variance are calculated with circular 
statistics. The mean Head direction represents the average orientation of 
the animal relative to the x-axis. See Statistics available
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▪ Head direction is calculated relative to the orientation of the x-axis you have 
chosen in the Arena Settings used for that trial. By default, the x-axis is 
horizontal and pointing to the right. If the x-axis is not horizontal or is 
pointing to another direction, Head direction is calculated based on that 
axis direction.

▪ NOTE  If you swap nose- and tail-base points, or interpolate those two 
points, the Head direction line is recalculated as the angle formed by the 
segment joining the nose-point and the center-point and the x-axis (see the 
figure below).

▪ If you edit the position of the nose-point or center point, the value of Head 
direction does not change.

▪ Be careful when interpreting values of Head direction relative to objects, for 
example two zones, or values extracted from different arenas.
EXAMPLE  In a mirror test, we want to measure the head direction of the fish, 
and compare the data between two arenas. The mirror is placed at opposite 
sides in Arena 1 and Arena 2. You can see that the same orientation relative 
to the mirror is measured with different angles:

▪ For a negative angle in Arena 1: Angle in Arena 2 = Angle in Arena 1 + 
180° (see the figure below, top).

▪ For a positive angle in Arena 1: Angle in Arena 2 = Angle in Arena 1 - 
180° (bottom).

To compare the results between arenas, convert angles from Arena 2 to 
Arena 1 (or vice versa).
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Applications
Head direction is useful for studies of spatial orientation and searching behavior. For 
this you can, for example, use the average and variation in Head direction.
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Head directed to zone
Definition
A discrete (state event) variable that is scored when the subject’s head is directed 
towards a zone or a circular area around a point. See Define zones and Draw a point

NOTE  Head directed to zone is not available if your experiment is set to:

▪ Center-point detection.
▪ Color marker tracking.
▪ Live Mouse Tracker.
▪ Center-point, nose-point and tail-base detection, with two subjects per 

arena tracked with Deep learning.

Calculation
1. The Head direction line is calculated. See Head direction
2. If the Head direction line crosses the zone of interest (or a circular area 

around a point), the value of Head directed to zone for that sample is set to 
1. The samples with 1 are used to calculate the duration of Head directed to 
zone.

The figure below shows Head directed to zone in the exported data file (Analysis > 
Export > Raw Data). Two samples are highlighted, one when the head is directed 
to the zone (circle), the other when it is not.
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How to specify Head directed to zone
1. Click the Add button next to Head directed to zone.
2. In the Head directed to zone tab, under Zone of interest select a Zone or 

a Point. For the latter, you can select either a point you defined in the Arena 
Settings or the center of a zone. 
Because a point has an infinitely small surface area, you need to define a 
circular zone around the point. The default radius is 0.1 cm. The smaller the 
radius around a point, the less likely it is that the animal's head is exactly 
directed at this point.

3. Next, you can specify when Head directed to zone should be calculated, 
depending on the location of the animal:
▪ Calculate when: From this list you select the body point that should be 

in the zone selected in the In list. If you select All detected body 
points, Head directed to zone is only calculated when all three body 
points are in the zone selected in the In list. 

▪ In: Select one of the zones from this list.
4. Complete the procedure to add the variable. See Calculate statistics: 

procedure.
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Notes
▪ Head directed to zone is based on the Head direction variable, which in turn 

depends on which method is used to track the nose-point. See Head 
direction

▪ Head directed to zone is not available if your experiment is set to Only 
center-point detection or Color marker tracking.

▪ If you swap the nose-point and the tail-base point in the Track Editor, the 
Head direction line is updated, and it is calculated as the prolongation of 
the segment joining the nose-point and the center-point. Head directed to 
zone is calculated based on the new angle.

▪ If you edit the position of the nose-point or the center-point in the Track 
Editor, the value of Head directed to zone does not change.

Applications
Head directed to zone is especially designed for use in the Novel object test. 
Exploration of a novel object is normally defined as directly attending to the object 
when the head is within a 2 cm radius of the object (Ennaceur and Delacour (1988) 
Behavioural Brain Research, 31, 47-59). In EthoVision XT, you calculate Head directed 
to zone when the Nose-point of the animal is within a 2 cm radius from the center of 
the zone you have drawn around the novel object.
1033



Turn angle
Definition
The change in direction of the nose, center, tail-base point or Head direction line 
between two consecutive samples. 

Calculation
You can calculate Turn angle in two ways, based on body points or the Head 
direction line.

Based on body points

Turn angle is calculated as the difference between two subsequent values for 
Heading of the specified body point:

▪ Heading = Headingk - Headingk-1

▪ If Heading < -180°, then Relative Turn angle = Heading +360°.
▪ If Heading  +180°, then Relative Turn angle = Heading -360°.
▪ Else Relative Turn angle = Heading.

In the example below, there is a turn to the right (clockwise) at sample k. The 
heading HEk-1 is positive, while HEk is negative. As a result, the difference HEk - HEk-
1 is negative. For the default axis orientation shown in the figure below, a clockwise 
turn corresponds to a negative Turn angle. A counter-clockwise turn corresponds to 
a positive Turn angle.

Based on Head direction 

Turn angle is calculated as the difference between two subsequent values for Head 
direction (see the figure below, left). This value is independent of the position of the 
body points:

▪ Head direction = Head directionk - Head directionk-1
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▪ If Head direction < -180° then relative Turn angle = Head direction 
+360°.

▪ If Head direction  +180° then relative Turn angle = Head direction -
360°.

▪ Else relative Turn angle = Head direction.
The Turn angle based on head direction depends only on the samples k–1 and k, 
while the Turn angle based on a body point depends on the last three samples (k–2, 
k–1 and k. See the example below.

NOTE The Head direction line is calculated using the subject’s contour. If you swap 
nose- and tail-base points, or interpolate those two points, the Head direction line 
is not recalculated using the contour, instead as the prolongation of the segment 
joining the nose-point and the center-point. Turn angle is then calculated based on 
those head direction lines.

Absolute vs. Relative Turn angles
▪ Absolute Turn angle: The difference in direction is unsigned. Absolute Turn 

angle ranges from 0° to +180°. 
▪ Relative Turn angle: The difference in direction is signed. With a default axis 

orientation, a clockwise turn is signed negative, and a counterclockwise is 
signed positive. Therefore, the Relative turn angle ranges from -180° to 
+180°. Relative angles help you distinguish between clockwise turns and 
counterclockwise turns.

Absolute and Relative turn angles result in different averages. Consider for 
example two angles, -10° and +40°. The average relative turn angle is (-10°+40°)/2 
= 15°. The average absolute turn angle is (10+40)/2 = 25°.
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TIP Use the picture below to know the sign of a turn. With the default axis 
orientation, a clockwise (right) turn means a negative turn angle. A counter-
clockwise t (left) turn means a positive angle.

Whenever you use a coordinate system other the default one, rotate the image to 
know the sign of the turn. For example, a right turn on a coordinate system with the 
x-axis flipped gets a positive value:

How to specify Turn angle
1. Click the Add button next to Turn angle and click the Turn angle tab. 

Select Absolute or Relative. 
2. Select Head direction turn angle (body point is ignored) if you want to 

calculate turn angle based on the Head direction line.
3. Click the Body points tab. Select the body points for which you want to 

calculate the turn angle. By default, Center-point is selected.
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If your experiment is set to Only center-point detection or Color marker 
tracking, this tab is absent. Calculations are based on the center point.

This tab is not available if you choose the option in step 2.

4. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Below: Relative and absolute turn angle based on the change in direction of the 
Head direction line. Top: dependent variables visualized in Integrated visualization 
(Analysis > Results > Integrated Visualization). First chart: Relative turn angle, 
showing positive and negative values for left and right turns of the head, 
respectively. Second chart: Absolute turn angle. Bottom: dependent variables when 
exported in the raw data file (Analysis > Export > Raw Data). 

Relative Turn angle and axis orientation
Relative Turn angle depends on the orientation of the x- and y- axes in the Arena 
Settings used for that trial. By default, the x-axis is horizontal and pointing to the 
right. A clockwise turn is scored as a negative value, and a counterclockwise is 
scored as a positive value. However, if the x-axis is pointing to the left, a clockwise 
turn is scored as a positive value, and a counterclockwise turn is scored as a 
negative value.

Below: The sign of the Relative Turn angle (RTA) depends on the orientation of the 
x- and y-axes. The example illustrates the effect of four different axis orientations on 
a clockwise turn. The sign inside the circles indicates the sign of Heading (HE) 
values. When the difference HEk - HEk-1 is larger than +180° or smaller than -180° 
(examples on the right), the rules described in Heading apply.
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If the axes are swapped, the reference line is now vertical. the Relative Turn angle is 
calculated relative to the vertical axis. Compare the following figure with the 
example at the top-left corner of the figure above.

Notes
▪ The mean, standard deviation and variance are calculated with linear 

statistics.
▪ Turn angle is calculated in a way different from that in EthoVision 3. This is 

because Turn angle is based on Heading, which is set consistent with Head 
direction.

▪ Turn angle is very sensitive to small, random movements of the body points. 
When the animal sits still, Turn angle can get very high, unrealistic values. To 
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remove such small movements from your data, Smooth the Tracks, then run 
analysis.

▪ Turn angle should not be confused with turn bias or turning rate. These are 
actually synonyms for the dependent variables Relative Angular velocity and 
Absolute Angular velocity, respectively.

Application
Assessing turn angles can be helpful for detecting stereotypic movements. In this 
case, consecutive turn angles tend to have large values (for example, in circling 
behavior of rodents), or show repeating patterns (for example, rocking or waving). 
For better quantification of biases in the left/right direction, first filter the data with 
the Minimal Distance Moved method, to ignore points where the animal does not 
move significantly.

Cumulative Turn angles are used to calculate rotations. See Rotation
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Angular velocity
Definition
The change in direction of movement of the nose, center, tail-base point or Head 
direction line between two consecutive samples, calculated per unit time. Angular 
velocity is expressed in degrees/second (°/s) and can be either positive or negative 
(see below).

Calculation

Where:

▪ RAVk is the Relative Angular velocity for sample k.

▪ RTAk is the Relative Turn Angle for sample k.

▪ tk-tk-1 is the time difference between the current and the previous sample.

Angular velocity can be calculated based on body points or the Head direction line:

▪ Based on body points, as in the figure above. The angular velocity is 
calculated from the turn angle of the specified body point (nose, center or 
tail-base; see below).

▪ Based on Head direction. The angular velocity is calculated from the turn 
angle based on Head direction. 

IMPORTANT  Note that calculating Angular velocity from Head direction is not the 
same as calculating it from the nose-point. This is because Turn angle (and 
therefore Angular velocity) at sample k based on a body point depends on the last 
three samples k–2, k–1 and k, while Turn angle based on Head direction depends 
only on the samples k–1 and k.
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Range
The minimum and maximum angular velocity depend on the time between two 
samples. For example, if the sample rate is 25, the maximum attainable turn (+180°, 
see Turn angle) results in an angular velocity of 180/0.04= 4500°/s. 

Absolute vs. Relative Angular velocity
▪ Absolute Angular velocity: The rate of change in direction is unsigned. Also 

known as Turning rate. 
▪ Relative Angular velocity: The rate of change in direction is signed. 

Depending on the orientation of the x- and y-axes, a clockwise turn is 
scored as positive or negative value, a counterclockwise turn is scored with 
opposite sign (see the relative Turn angle). Turn bias (degrees/s) and circling 
tendency are synonyms for this variable. 

The difference between relative and absolute Angular velocity is best explained by 
looking at the mean values of the two dependent variables in the following 
example:

Time Absolute Ang. vel. Relative Ang. vel.

0.04 10 -10

0.08 45 45

0.12 35 -35

Mean 30 0

The mean absolute Angular velocity reflects the amount of turning, whereas the 
mean relative Angular velocity gives a better indication of the overall direction of 
turning.

How to specify Angular velocity
1. Click the Add button next to Angular velocity and click the Angular 

velocity tab. Select Absolute or Relative. 
2. Select Head direction angular velocity (body point is ignored) if you 

want to calculate angular velocity based on head direction.
3. Click the Body points tab. Select the body points for which you want to 

calculate the velocity. By default, Center-point is selected.
4. Complete the procedure to add the variable. See Calculate statistics: 

procedure.
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Notes
▪ If your experiment is set to Only center-point detection or Color marker 

tracking, the Body points tab is absent. Calculations are based on the center 
point.

▪ If the body point turns more than 180° between one sample and the next, 
the direction of turning is calculated incorrectly. In the example below, the 
subject makes a fast counterclockwise turn of 270° between time 2 and 3 
(left). The program interprets this as a 90º clockwise turn (right). 

As a result, Angular velocity gets a value smaller than expected, and in case 
of relative Angular velocity a false sign. This kind of error occurs when the 
sample rate is too low and the subject makes very fast turns. To prevent this 
kind of error, set the sample rate at such a level that it is practically 
impossible for the subject to make a turn more than 180° between two 
subsequent samples.

▪ The Head direction line is calculated using the subject’s contour. However, if 
you swap nose- and tail-base points, or interpolate those two points, the 
Head direction line is not recalculated using the contour, instead as the 
prolongation of the segment joining the nose-point and the center-point. 
Angular velocity is then calculated based on those head direction lines.

Applications
▪ The absolute Angular velocity is used to express the amount of turning per 

unit time. Generally, a high value of this dependent variable is associated 
with local search, for instance in response to non-volatile semiochemicals 
(Bell (1991) Searching Behaviour: The Behavioural Ecology of Finding 
Resources. London: Chapman & Hall).

▪ The relative Angular velocity measures the speed of change in direction of 
movement. The mean of this dependent variable can be used to assess turn 
bias or circular tendency, the tendency of a subject to turn to a specific 
direction. Studying this helps detecting peculiarities or abnormalities of 
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behavior (for instance, stereotypic movements, reaction to toxic substances, 
etc.).
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Activity
Definition
The dependent variable Activity is only available when you selected Activity 
analysis in the Experiment Settings and you track only one subject per arena. 
Activity gives the percentage changed pixels in the entire arena between current 
sample and previous sample. 

Calculation
See step 1 and 2 in Activity state for information on how this percentage of 
changed pixels is calculated. With the dependent variable Activity state, you can 
calculate how much time and how often your subject was inactive, moderately 
active and active and highly active. With the dependent variable Activity, you can 
calculate the average activity of your subject. 

How to specify Activity
1. Click the Add button next to Activity. 
2. Under Outlier filter, select the Averaging interval. This is the number of 

samples over which the running average mobility is based. The default 
value is 1, that is, the current value of Activity is only based on the current 
image. See Averaging interval
See Activity state for more information.

3. Complete the procedure to add the variable. See Calculate statistics: 
procedure.
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Activity state
The dependent variable Activity state is only available when you selected Activity 
analysis in the Experiment Settings and you track only one subject per arena. With 
Activity state you can calculate how long and how frequent your subject has been in 
different activity states. These states depend on the total pixel change within the 
arena between a sample and the previous sample. The number of states and their 
thresholds are user-defined. 

When the subject goes missing for more than three samples, the current Activity 
state is ended and the remaining missing samples are ignored.

Calculation

Step 1 - Calculation of proportion of pixel change

All pixel coordinates in the arena, so not only of the detected subject, are 
determined immediately after they have been detected. The gray scale values of all 
pixels are compared with the previous sample to determine the number of changed 
pixels in the arena between the two. The formula for Activity is simply the number 
of changed pixels for the current sample k divided by the total number of pixels in 
the arena:

Activity is calculated by taking every pixel and comparing it between the current 
image and the previous one. If all the pixels are the same, there is zero activity. If all 
the pixels are different, there is 100% activity. If the animal is moving and increases 
its velocity (whilst keeping the same shape) there will be an increase in activity, 
because the pixels belonging to the animal are increasingly different as it moves 
faster.

Step 2 - Running average

To smooth the values of Activity, an Averaging interval is used. This gives you the 
option to specify the number of samples for calculating a running average of 
Activity. The Activity percentage is summed over the number of samples that you 
specify, and divided by the number of samples. This way, sudden changes in surface 
area caused by such factors as the animal entering a shadowed area, or a reflection, 
are smoothed out.

NOTE  When you export the dependent variable, each row in the export file contains 
the Activity value, but not the averaging interval.
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Step 3 - Calculation of the Activity state dependent variable

The Activity state variable is established for each sample, according to the value of 
running average Activity relative to the thresholds. You can define between two and 
four states, varying from Inactive (below the lowest threshold) to Highly active 
(above the highest threshold). 

How to specify Activity state
1. Click the Add button next to Activity State.
2. Enter the following: 

Averaging Interval: The number of samples over which the running 
average mobility is based. The default value is 1, that is, the current value of 
Elongation is only based on the current image.

3. Under Number of states, select the number of activity levels you are 
interested in. The following options are available, dependent on the 
number of states:
2 states: Highly active above and Inactive below.

3 states: Highly active above, Moderately active between and Inactive 
below. 

4 states: Highly active above, Active between, Moderately active between 
and Inactive below. 

4. Under Thresholds, specify thresholds for the states defined in step 3. 
You can enter a number with up to two decimals.

▪ Under State duration threshold, in the field next to Exclude instances 
shorter than, enter how long a state must last before it is scored as 
one of the four Activity states. If the duration passes this threshold, the 
samples in this time length are scored as one of the four states 
according to the criteria above. If the duration does not pass the 
threshold, the previous state ends, but no new state is defined. When 
you visualize Activity state in the Integrated Visualization, this is 
displayed as a gap between two adjacent color bars, which represent 
the scored activity states.

▪ Under Calculate statistics for, select at least one of the states defined 
in step 3.

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

To find the optimal activity thresholds, run a few test trials and check in the Analysis 
Results and Scoring pane the values of Activity when the animal shows such 
1047



behavior. These values are calculated real-time during acquisition. See an example 
in Fear conditioning: view Activity state.

Notes
▪ IMPORTANT The Activity detection thresholds set in Acquisition are not used 

in analysis. When you specify Activity in your Analysis profile, enter the new 
values in the appropriate fields.

▪ In some cases the number of samples available for smoothing can be less 
than the averaging interval entered. For example, when there are missing 
samples or at the beginning of the track. In such cases EthoVision XT uses 
the samples available in the specified interval. For example, the value of 
Activity for the first sample of the track is always calculated over one 
sample.

▪ You set the thresholds during acquisition, but you can override them when 
calculating statistics to produce new values for Activity state. To see what 
the original values of Activity state thresholds were (unless you have 
changed them while acquiring data), open the Acquisition module and click 
the button under Activity in the Analysis results and Scoring pane. 

Frequently asked questions about Activity
1. What is the difference between Activity and Mobility?

Activity is the percentage change in all pixels in the arena between the 
current sample and the previous sample. This is independent of the 
detected subject.

Mobility is the percentage pixel change between the current sample and 
the previous sample in the detected subject only. See Mobility

2. When should I use Activity and when should I use Mobility?
Use Activity when the dependent variable Mobility does not give satisfying 
results, or if detection of your subject is difficult. This can be the case when 
bars of the shock grid floor in the background complicate detection of the 
animal’s surface area, or when the animal is very large compared to the 
arena size. 

3. Does Activity detection depend on the size of the subject relative to the 
arena?
Yes. Activity is calculated as the number of changed pixels divided by the 
total number of pixels in the arena. The smaller the subject relative to the 
arena, the smaller the activity will be. When your animal is very large in 
comparison to the arena size, for example when you have a rat in a small 
cage, activity detection is generally more suitable than mobility detection. 
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4. Does Activity detection depend on the video resolution?
Yes. The higher the video resolution, the greater the number of pixels that 
change when the subject moves. Therefore, when you have a high video 
resolution, it is less likely that a small movement of the subject results in an 
abrupt change in activity.

However, this effect is present at very low resolution (for example, when the 
subject is less than 100 pixels large). We advise you not to compare values 
of Activity between videos of different resolutions.

5. Does Activity detection depend on sample rate?
Yes. Since Activity is detected from the change in pixels between two 
samples, and the pixel change depends on how frequently the area is 
acquired (that is, the sample rate), Activity depends on the sample rate. All 
being equal, the higher the sample rate, the smaller the pixel change. See 
also the effect of the sample rate on Mobility in Frequently asked questions 
about Mobility. 

Applications
Activity can be used to determine freezing behavior in rodents. Also, it may be used 
to assess inactivity of rodents in a Porsolt Swim Test. Furthermore, the startle 
response of zebrafish larvae can automatically be detected with (in)activity. 
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Body elongation
Definition
Body elongation measures how much the subject’s detected shape differs from a 
circle.

NOTE  Body elongation is not available if your experiment is set to:

▪ Center-point detection.
▪ Color marker tracking.
▪ Live Mouse Tracker (but see Stretch attend posture).
▪ Center-point, nose-point and tail-base detection, with two subjects per 

arena tracked with Deep learning.

Calculation
1. The Body elongation measure E is calculated as follows:

Where:

▪ x,y are the coordinates of the pixels of the subject's contour in the 
current sample.

▪ xc and yc are the coordinates of the center of the subject.

2. The Body elongation value is smoothed at each sample using the optional 
Averaging interval.

Body elongation is expressed as a percentage and ranges from 0% (when the 
subject's shape is perfectly circular) to 100% (when the subject's shape is a line).

How to specify Body elongation
1. Click the Add button next to Body elongation and click the Body Elonga-

tion tab.
2. Enter the Averaging interval. This is the number of samples over which the 

running average elongation is based. The default value is 1, that is, the 
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variable is not smoothed using the values of neighboring samples. See 
Averaging interval

3. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ Body elongation is not calculated with Live Mouse Tracker data.
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Body elongation state
Definition
A discrete (state event) variable with three possible states: Stretched, Normal and 
Contracted, depending on where the running average elongation measure (E) of the 
subject's contour calculated for the current sample lays relative to two user-defined 
thresholds (see Calculation below).

NOTE  Body elongation state is not available if your experiment is set to:

▪ Center-point detection.
▪ Color marker tracking.
▪ Live Mouse Tracker (but see Stretch attend posture).
▪ Center-point, nose-point and tail-base detection, with two subjects per 

arena tracked with Deep learning.

Calculation
1. The Body elongation is calculated for each sample. See Body elongation
2. The running average of Body elongation is calculated for each sample using 

the number of samples specified by the Averaging interval.
3. The Body elongation state variable is determined for each sample:

▪ If the running average elongation percentage is greater than the 
Stretched above value, the state is Stretched. 

▪ If the running average elongation percentage is smaller than the 
Contracted below value, the state is Contracted. 

▪ In all the other cases, the state is Normal. 
Below: Visualization of Body elongation state (top) and Body elongation (bottom). 
The two variables have been set with the same Averaging interval (10 samples). 
Stretched is scored when Body elongation is above 80%. Contracted is scored when 
the resampled variable is below 50%.
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How to specify Body elongation state
1. Click the Add button next to Body elongation state and click the Body 

Elongation State tab. 
2. Enter the following:

▪ Averaging interval: The number of samples over which the running 
average elongation is based. The default value is 1, that is, the 
elongation measure is not smoothed before calculating Body 
Elongation state.

▪ Stretched above: The elongation measure above which the subject is 
considered to be Stretched.

▪ Contracted below: The elongation measure below which the subject is 
considered to be Contracted.

To find the optimal Stretched above and Contracted below, run a few test 
trials and check in the Analysis Results and Scoring pane the values of Body 
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elongation state when the animal shows such behavior. These values are 
calculated real-time during acquisition.

Values of elongation percentage between Stretched above and Contracted 
below result in the subject being scored as Normal.

3. Under Calculate statistics for, select which state you want to calculate 
statistic for: Stretched, Normal o Contracted. Select at least one state.

4. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ The elongation measure is independent of video size and the subject's 

position and orientation. 
▪ When a body point is missing for more than three samples, the current 

Body elongation state ends and the remaining missing samples are 
ignored. 

▪ The Body elongation thresholds set in Acquisition are not used in analysis. 
When you specify the Body elongation dependent variable in your Analysis 
profile, enter the new values in the appropriate fields.

▪ By increasing the averaging interval, you can increase the reliability of 
detection of stretching and contracting. A running average elongation 
based on more samples diminishes the effect of random changes in 
elongation measure between consecutive samples that would be detected 
as state transitions. However, a drawback of increasing the Averaging 
interval is that it causes a delay in the determination of a state transition, 
proportional to the length of the interval. See Averaging interval

▪ In some cases the number of samples available for smoothing can be less 
than the averaging interval entered. For example, when there are missing 
samples or at the beginning of the track. In such cases EthoVision XT uses 
the samples available in the specified interval. For example, the value of 
Elongation for the first sample of the track is always calculated over one 
sample.

▪ In the Detection Settings, under Subject Contour, select Erosion and then 
Dilation to remove the animal's tail from the detected image of the subjects. 
This way you get a more accurate measurement of Body elongation.

▪ Body elongation is not calculated with Live Mouse Tracker data.
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Application
The Body elongation state variable can help you assess the frequency and 
cumulative duration of stretch attend postures in a more objective way.
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Body angle
Definition
The angle formed by the prolongation of the segment joining the tail-base and the 
center-point, and the segment joining the center-point and the nose-point, 
calculated at the current sample.

Range

Absolute Body angle ranges from 0º to 180º. Relative Body angle ranges from -180º 
to +180º.

0º occurs when the nose point, center point and tail base point are aligned. Values 
around ±180º are only hypothetical, because they would imply that the animal is 
completely curled up in such a way that the nose points to the tail base. Values 
higher than 100º often occur with wrong detection of the body points.

How to specify Body angle
1. Click the Add button next to Body angle.
2. In the Body Angle tab, specify whether you want to calculate:

▪ Absolute angle: The unsigned angle.
▪ Relative angle: The signed angle. It is negative when the body is bent 

to the right (clockwise); positive when the body is bent to the left 
(counterclockwise).
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3. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Note
When the nose-point and the tail-base point are swapped, and these are not 
properly corrected in the Track Editor, the value of relative body angle is opposite to 
what it should be. For example, if the actual body angle is +10º, EthoVision XT gives 
-10º. However, absolute angle remains correct. Therefore, if your track contains 
nose-tail base swaps, either correct them in the Track Editor, or use Absolute angle.
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Body angle state
Definition
A discrete (state event) variable with two possible states: Straight and Bent, 
depending on where the running average body angle (see Body angle for its 
definition) of the subject calculated for the current sample lays relative to a user-
defined threshold:

▪ If the running average body angle is greater than the threshold value, the 
state is Bent. This state can be further split in Bent counterclockwise and 
Bent clockwise depending on the sign of the angle.

▪ If the running average body angle is smaller than the threshold value, the 
state is Straight.

The running average body angle is calculated for each sample, over the number of 
samples specified by the Averaging interval.

Below: Visualization of Body angle state (top chart) and Body angle (bottom).Body 
angle state was based on the Body angle values smoothed with averaging interval 
of 5.
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How to specify Body angle state
1. Click the Add button next to Body angle state and click the Body Angle 

State tab.
2. Enter the following:

▪ Averaging interval: The number of samples over which the running 
average body angle is based. 

▪ Body bent above: The angle above which the subject is considered to 
be bent. This value is unsigned and applied to both negative and 
positive Body angles.

3. Under Calculate statistics for, select which state you want to calculate 
statistic for: Straight, Bent, Bent counterclockwise (that is, when the 
running average body angle is positive; see Body angle for its definition), 
and Bent clockwise (when the running average body angle is negative).

4. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ When a body point is missing for more than three samples, the current 

Body angle state ends and the remaining missing samples are ignored. 
▪ Averaging interval. The default value is 1. In that case the body angle state 

is based on the value of Body angle at the current sample. If you select a 
number k higher than 1, EthoVision takes the body angle of the last k 
samples (including the current sample) and replaces the current value with 
the average. See Averaging interval
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Mobility
Definition
The percentage changed pixels of the detected subject between current sample and 
previous sample.

NOTE  Mobility is not available if your experiment is set to:

▪ Live Mouse Tracker (but see Stretch attend posture).
▪ Center-point, nose-point and tail-base detection, when you track two 

subjects per arena with Deep learning.

Calculation

Step 1 - Calculation of the changed area

All pixel coordinates of the subjects are determined immediately after they have 
been detected. Those coordinates are compared with the previous sample to 
determine the number of changed pixels between the two. The changed pixels are 

▪ The subject pixels found in the current sample but not in the previous 
sample AND.

▪ The subject pixels found for the previous sample but not for the current 
sample. 

This can be expressed in the following formula:

CAk = (Ak - Ak-1) + (Ak-1 - Ak)

Where CAk is the changed area for the current sample k, Ak is the area for the 
sample k, and Ak-1 the area for the sample k–1. 

In the example below, CA is the sum of the orange areas when comparing the 
contour of the subject with that at the previous sample. The sum equals the 
symmetric difference between sets of points known in mathematics and is generally 
indicated with delta (). The changed area is shown for samples 2 and 3.
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The changed area (in number of pixels) is available when you export your raw data. 
Open the export file and locate the column named Areachange. Note that 
Areachange is not the same as the difference in Area between the current and the 
previous sample!

Mobility is calculated by taking every pixel identified as the subject and comparing 
it between the current image and the previous one. Note that Mobility also includes 
movement in space (e.g. walking).

Step 2 - Calculation of Mobility

The formula for Mobility is the changed area for the current sample k divided by the 
sum of the current area and the previous area:

Step 3 - Running average

To smooth the Mobility parameter, an Averaging interval is used. This gives you the 
option to specify the number of samples for calculating a running average of 
Mobility. The Mobility percentage calculated as above is averaged over the number 
of samples that you specify. This way, sudden changes in surface area caused by 
such factors as the animal entering a shadowed area and not being identified 
correctly, or a reflection being identified momentarily as the animal, are smoothed 
out. See also Averaging interval

When you export data, you do not export any information about which averaging 
interval was used.
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Range
Mobility ranges from 0% to 100%.

▪ If all the pixels of the detected subject are equal in value between sample k-
1 and sample k, for example when the subject is completely still, Mobility at 
sample k is 0.

▪ If the animal moves and increases its velocity, whilst keeping the same 
shape, there will be an increase in mobility, because the pixels belonging to 
the animal are increasingly different as it moves faster.

▪ when the subject is so fast that its contour at consecutive samples does not 
overlap anymore, then all the pixels are different. CA is maximal and equals 
the sum of the two contours. Therefore, Mobility is 100%.

How to specify Mobility
1. Open an Analysis profile and in the Dependent Variables panel, under 

Body, click the Add button next to Mobility. 
2. Select the Averaging interval. See above Step 3 - Running average for 

more information on the Averaging interval. 
3. Click the Trial Statistics tab and select the statistics you want to calculate.

Notes
▪ When the experiment is set to Color marker tracking, that is, when 

EthoVision only tracks the markers and ignore the body contour of the 
subject, Mobility is calculated based on the surface area of the marker.

See also

▪ Mobility state
▪ Frequently asked questions about Mobility
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Mobility state
Definition
A discrete (state event) variable with three possible states: Highly mobile, Mobile 
and Immobile, depending on where the changed pixels of the detected subject 
between current sample and previous sample (referred to as changed area) lay 
relative to two user-defined thresholds.

▪ For the difference between Mobility and Movement, see Frequently asked 
questions about Mobility.

▪ For the difference between Mobility and Activity, see Frequently asked 
questions about Activity

NOTE  Mobility state is not available if your experiment is set to:

▪ Live Mouse Tracker.
▪ Center-point, nose-point and tail-base detection, when you track two 

subjects per arena with Deep learning.

Calculation
The Mobility state variable is calculated for each sample according to the value of 
the running average Mobility relative to the thresholds:

▪ Below the Immobile threshold, the state is Immobile.
▪ Between the Immobile threshold and the Highly mobile threshold, the state 

is Mobile.
▪ Above the Highly mobile threshold, the state is Highly mobile. 

When the subject goes missing for more than three samples, the current Mobility 
state is ended and the remaining missing samples are ignored.

See also Frequently asked questions about Mobility

How to specify Mobility state
1. Open an Analysis profile and in the Dependent Variables panel, under 

Body, click the Add button next to Mobility state and click the Mobility 
State tab.

2. Enter the following: 
▪ Averaging Interval: The number of samples over which the running 

average mobility is based. The default value is 1, that is, the mobility 
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measure is not smoothed before determining the Mobility state 
variable. 

▪ Highly mobile threshold: The percentage of change in body area 
above which the subject is considered to be Highly mobile. 

▪ Immobile threshold: The percentage of change in body area below 
which the subject is considered Immobile. You can enter a number with 
up to two decimals.

3. Under Calculate statistics for, select at least one of the three following 
options:
▪ Highly mobile: Statistics are calculated for when the subject is 

considered Highly mobile.
▪ Mobile: Statistics are calculated for when the subject is considered 

Mobile.
▪ Immobile: Statistics are calculated for when the subject is considered 

Immobile.
4. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ To find the optimal Highly mobile and Immobile threshold, run a few test 

trials and check in the Analysis Results and Scoring pane the values of 
Mobility when the animal shows such behavior. These values are calculated 
real-time during acquisition. See an example in Porsolt swim test: view the 
Mobility state variable.

▪ Since Mobility is calculated on the detected subject, the gray-scale 
threshold values used in detection also have an influence on the mobility 
variable. If your detection settings are such that only part of the animal is 
detected, then only the mobility for that part is calculated.

▪ In some cases the number of samples available for smoothing can be less 
than the averaging interval entered. For example, when there are missing 
samples or at the beginning of the track. In such cases EthoVision XT uses 
the samples available in the specified interval. For example, the value of 
Mobility for the first sample of the track is always calculated over one 
sample. See Averaging interval

▪ You set the thresholds during acquisition, but you can override them when 
calculating statistics to produce new values for Mobility. To see what the 
original values of Mobility thresholds were (unless you have changed them 
while acquiring data), open the Acquisition module and click the button 
next to Mobility in the Analysis results and Scoring pane. 
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Applications
▪ Mobility can be used to assess general activity, and changes in behaviors in 

specific paradigms. For example, in Porsolt swim tests (for example, Russig 
et al. 2003, Behav. Pharm. 14: 1-18) it allows to detect changes in behavior, 
for example from swimming to floating, more objectively than when 
observing directly.

▪ You can also use Mobility to detect freezing behavior in which case you 
need to set a very low value of Immobile threshold. Mobility can also be 
used to quantify movement of zebra fish embryos within their eggs in a 24-
well plate with back-lighting.

See also

▪ Frequently asked questions about Mobility
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Frequently asked questions about 
Mobility
What is the difference between Mobility and Movement?
Mobility can be defined as the degree of movement of an animal’s body 
independent of spatial displacement of the center or any other body point, which is 
measured by Movement. ‘Independent’ does not mean that mobility is corrected 
for the center-point position, it means that the calculation does not use the x,y 
coordinates of the animal (they are not in the equation used to calculate it). Mobility 
is calculated 100% independent of movement of the coordinates identified as the 
center-point (or the nose/tail point). That means that the center-point can have zero 
movement but high mobility.

For example, imagine that you are tracking a rat in an open field. When the rat 
stands still and grooms, the center of gravity does not move, therefore there is no 
spatial displacement of the subject (the current state for the Movement variable is 
Not moving), however the rat’s head and forelimbs move, resulting in changes in 
the surface area. Although there is no spatial displacement of the body, the current 
state of the Mobility variable is Mobile (depending on the threshold value).

Does Mobility depend on the size of the subject vs. arena?
No. It is dependent on the size of the subject only. Keeping resolution constant, the 
smaller the subject, the smaller the number of pixels that form its image, the more 
likely that any small movement results in a change in area that is detected as 
Mobility.

Does Mobility depend on the video resolution?
Yes. The higher the video resolution, the greater the number of pixels that form the 
image of the subject. Therefore, the less likely that a small movement of the subject 
results in an abrupt change in area. 
However, this effect is present at very low resolution (for example, when the subject 
is less than 100 pixels large). At resolutions provided by video files, this effect is 
negligible.

Does Mobility depend on the sample rate?
Yes. Since Mobility is detected from the change in area of the subject between two 
samples, and the change in area depends on how frequently the subject area is 
acquired (that is, the sample rate), Mobility depends on the sample rate. All being 
equal, the higher the sample rate, the smaller the change in subject area.
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In the example below, the Immobile threshold was set to 2%, and the Highly mobile 
threshold was set to 10%. A certain movement pattern detected with a sample rate 
x determines a change in area of around 15%, which causes EthoVision consider the 
subject Highly mobile.

If the sample rate doubles, more samples are captured in the same time interval, 
therefore the same movement results to a smaller change in area between samples. 
For the intermediate samples, EthoVision XT considers the subject Mobile since the 
change in area is smaller than 10%. The proportion of samples where the subject is 
considered Mobile increases relative to the proportion of samples where the subject 
is considered Highly mobile.

As a general rule, the higher the sample rate, the lower the Immobile and Highly 
mobile thresholds must be.

Does Mobility depend on track smoothing?
The results of Mobility may differ depending on whether you set a Minimum 
Distance Moved filter (see The Minimal Distance Moved smoothing method). 
When you apply this filter, a sample in the track that is very close to that at the 
previous time stamp is given the same coordinates as the previous one. When that 
occurs, the Area change is also set to zero for that sample. This results in a lower 
value of the average Mobility.

In contrast, other track smoothing methods do not influence Mobility. See Smooth 
the Tracks
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If you want to preserve the values of Mobility when the animal is almost completely 
still, instead of using the Minimal Distance Moved filter select the data based on 
Movement. In the Data profile, choose Nesting > Movement. Under Calculate 
nesting for, select Not moving and set the threshold velocities in such a way the 
animal is considered Not moving when its velocity is lower than the Stop velocity 
value. See Nesting over Movement. Next, calculate Mobility.

See also

▪ Movement
▪ Mobility
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Rotation
Definition
This is the number of turns, either clockwise or counterclockwise, of 360° (if not 
otherwise defined).

A rotation can be based on the movement of a body point or on the change in 
direction of a body axis.

Calculation

Body point rotation

The software scores a rotation event when the cumulative turn angle of the chosen 
body point exceeds the threshold value (default: a complete rotation, that is, 360°).

Consider the simplified example in the figure below. Left: the original track, starting 
from the sample a time 0. Here we consider the center point but the calculation is 
the same of the nose-point and the tail-base point. Middle: The turn angles () 
calculated for the body point of samples 1, 2, 3, etc. Right: cumulative turn angle. 
For details about turn angles, see the dependent variable Turn angle.

At sample 7, the cumulative turn angle exceeds 360°. Therefore, a rotation event is 
scored. The cumulative turn angle is reset and consecutive turn angles are summed 
until the cumulative Turn angle, again, exceeds the rotation threshold.

Body axis rotation

This method is based on the turn angle formed between the body axis at two 
consecutive sample times (k-1 and k). As a body axis, you can choose the segment 
joining the center-point and the nose-point, or the segment between the tail-base 
and the center-point.
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The software scores a rotation event when the cumulative turn angle of the chosen 
body axis 1+2+... exceeds the threshold value (default: a complete rotation, that 
is, 360°). Note that the angles depend only on the orientation of the body axis, not 
the position of the body center.

NOTE  This rotation method is only available if your experiment is set to Center-
point, nose-point and tail-base detection.

Which method shall I choose?
▪ Choose Body point rotation if the track clearly shows the rotation 

movement that you want to quantify. For example, a mouse walking along 
the walls of a cage, or a fish larva swimming in a well. In that case the 
trajectory of the center point is sufficient to characterize the behavior.

▪ Choose Body axis rotation if the subject is spinning around its own axis 
and you want to quantify exactly that behavior.

▪ Choose Body axis rotation if the subject is performing micro-rotations and 
you do not want to count them. Micro-rotations occur when the subject 
makes small repetitive movements of the body that cause the center point 
to rotate, while the subject itself does not walk along a circle. Such rotations 
are hardly noticeable in the track plots. That could occur for example while 
a rodent does body grooming. Note that the center point rotates while the 
body axis does not.

If micro-rotations are a problem in your trials and you do not want them 
included in the results, choose this Body axis rotation.

▪ TIP  To eliminate or reduce the detection of micro-rotations when using 
Body-point rotation, apply a track-smoothing filter based on minimum 
distance moved. See The Minimal Distance Moved smoothing method
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▪ More generally, you can use the Minimum Distance Moved filter to rectify 
the trajectory of the subject, so that the software ignores the moments 
when the subject is still or moves little. In this example a MDM of 25 cm was 
used to make the larger-scale rotations more visible: 

 

How to specify Rotation
1. Click the Add button next to Rotation.
2. Under Select, choose one of the two methods Body points rotation or 

Body axis rotation. If you choose Body axis rotation, select which axis you 
want to use to count rotation: Axis: Center-point to Nose-point or the 
Axis: Tail-base to Center-point.

3. Under Settings, select whether EthoVision XT should count rotations in the 
Clockwise direction or in the Counter-clockwise direction. 

4. In the Count every … rotation list, specify how rotations should be 
counted.
The default value of 1 means that every 360° turn in the specified direction 
counted as one rotation. If you select 0.5 in this list, every 180° turn is 
counted as one rotation.

5. By entering a threshold angle in the Threshold box, you can compensate 
for turns in the direction opposite to the one you selected in step 2.
TIP  Visualize the rotation events in the Integrated Visualization to validate 
your choice of the threshold value.

6. Enter a value of Minimum Distance Moved if you want to remove the 
samples for which the distance from the last sample selected in the track is 
too short to represent actual movement. By default this is 2 cm/0.78 inch. 
Turn angles and Rotation are re-calculated according to this filter. If you do 
not want to apply any filter, enter 0.
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7. If you track three body points (center-point, nose-point and tail-base point), 
and you select Body point rotations, in the Body Points tab select the 
body points you want to use to calculate the rotations.

8. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

The role of the threshold angle
Suppose that in figure shown at the top of this page the subject makes a 
counterclockwise turn between sample 2 and sample 3 (2), then it makes a new 
turn in the clockwise direction ((3) before completing a rotation.

The threshold angle allows you to compensate for turns in the opposite direction. In 
this example we are interested in clockwise rotations. Depending on the value of 
the turn angle 2 in the counterclockwise direction, one of the following occurs:

▪ The turn angle 2 is smaller than or equal to the threshold angle. 
EthoVision XT continues to calculate the cumulative turn angle until it 
exceeds the corresponding rotation count. A turn in the opposite direction 
means that the cumulative angle is reduced at that sample.

▪ The turn angle 2 is larger than the threshold angle. EthoVision XT resets 
the cumulative turn angle (R in the figure below) and uses a new series of 
samples to calculate the cumulative turn angle until the latter exceeds the 
corresponding rotation count.

The rationale for applying a threshold angle is that if the animal makes large turns 
in the opposite direction, the trajectory can no longer be described as a circle-like 
pattern, and the subject is likely to have changed its behavior. The counting of 
cumulative turn angle should therefore be reset.

Notes
▪ When you apply a Minimum Distance Moved filter, samples are filtered with 

the Direct method for Minimal Distance Moved. This filter changes the 
1072



values of turn angle at a specific sample. Consider the following example 
(movement is from A to B):

The filter sets samples C and D equal to B since their distance from B is 
shorter than the threshold entered.

The turn angle for sample E is the angle formed with A and B (=C, D). See 
Turn angle

▪ To count both clockwise and counter-clockwise rotations, repeat the steps 
from step 1 and specify the alternative option. As a result, you have two 
instances of the variable Rotation, one for clockwise rotations and the other 
for counter-clockwise rotations. 

Applications
Circling or rotational behavior is used in rats as an indicator of cerebral asymmetry. 
For example, striatal asymmetries in dopamine characteristics, such as dopamine 
levels, metabolites, release and uptake, have been functionally related to an 
increase in rotational behavior (e.g., Carlson and Click, 1989; Schirmer et al., 2007). 
Amphetamine, a dopamine releaser, induces rotations in animals with striatal 
asymmetries, which can be blocked by haloperidol. The animal usually turns away 
from the side of higher dopaminergic activity.
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Distance between subjects
Definition
The distance between a body point of a subject and a body point of another 
subject.

Distance is calculated for each Subject (Actor) relative to other subjects (Receivers). 

Calculation
Formula:

Where DSk is the distance between Actor and Receiver at sample k, Xa,k and Ya,k the 
X,Y coordinates of the selected body point of the Actor at sample k, and Xr,k and Yr,k 
the X,Y coordinates of the selected body point of the Receiver at sample k.

How to specify Distance between subjects
1. Click the Add button next to Distance between subjects.
2. Click the Body points tab and select the body points of the focal subject 

(Actor) you want to use to calculate distance. 
3. Click the Receivers tab. Here, you specify the other subjects (Receivers). 

▪ Under Select, choose the subjects you want to calculate the distance 
from.

▪ Under Body points, select the body points of the subjects selected 
above.

4. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
Distance is calculated for each combination of Actor's body points and Receiver's 
body points. Each row of the result table shows the results for an Actor. For example: 
The row heading shows Subject 1. The column heading Nose point / Subject 2 / 
Center point. This can be read as ‘the cell contains the distance between the nose 
point of Subject 1 and the center point of Subject 2’.
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Applications
This parameter forms the basis for the Proximity dependent variable used in studies 
of social or aggressive behavior. In zebrafish, shoaling behavior is analyzed with 
Distance between subjects; see Green et al. (2012) J. Neurosc. Methods, 210, 266– 
271.
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Proximity
Definition
A discrete (state event) variable with two possible states, In proximity and Not in 
proximity:

▪ The state is In proximity when the distance between the selected body 
points of the focal subject (Actor) and the body points of another subject 
(Receiver) is lower than a user-defined In proximity threshold.

▪ The state is Not in proximity when the distance between the selected body 
points of the Actor and the body points of another subject Receiver is 
greater than a user-defined Not in proximity threshold.

▪ The state does not change from the previous sample when the distance 
stays between the two thresholds. 

If at least one of two subjects' selected body points is missing for more than three 
samples, the current Proximity state ends and the remaining missing samples are 
ignored. 

Calculation
For each sample, the program calculates first the Distance between subjects, then it 
compares this value with the In proximity and Not in proximity thresholds to 
establish the state at that sample.

How to specify Proximity
1. Click the Add button next to Proximity.
2. In the Proximity tab, enter the In proximity and Not in proximity 

distance values that specify when the two subjects are considered in 
proximity to each other. 

3. Under Calculate statistics for, select the state you want to analyze. 
For example, select In proximity if you want to know how often or how 
long the subjects were close to each other. Select Not in proximity if you 
want to analyze when the animals were far from each other. 

4. Click the Body points tab. Select the body points of the focal subject 
(Actor) you want to use to calculate proximity.
If you select two or three points, a drop-down list becomes available. 
Choose: 
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▪ All selected points: A state is assigned only when all selected points 
are in that state relative to the Receiver (Proximity or Not in proximity). 
If body points are in different states, that sample is not used in analysis.

▪ Any selected point: A state is assigned when at least one selected 
body point is in that state relative to the Receiver (Proximity or Not in 
proximity). 

▪ Each point: A state is defined for each point of the Actor. Results are 
displayed for each point separately. 

5. Click the Receivers tab. Here, you specify the other subjects (Receivers). 
Under Select, choose the subjects you want to calculate the distance from.  
If you select two or more subjects, select one of the available options from 
the list:

▪ All selected subjects: A state is assigned only when the Actor is in that 
state for all selected Receiver (In proximity / Not in proximity). If the 
Actor is in different states relative to different Receivers (for example, 
Subject 1 In proximity of Subject 2 and Not in proximity of Subject 3), 
that sample is not used in analysis.

▪ Any selected subject: A state is assigned when the Actor is in that 
state for at least one Receiver (In proximity/Not in proximity).

▪ Each subject: A state is assigned to each combination Actor*Receiver. 
Results are displayed for each Receiver. 

6. Under Body points, select the body points of the Receivers you want to use 
to define proximity. If you select two or three points, select one of the 
available options: 
▪ All selected points: A state is assigned only when all selected points 

are in that state relative to the Receiver (in proximity/not in proximity). If 
different body points are in different states, the sample is not used in 
the analysis. 

▪ Any selected point: A state is assigned when at least one selected 
body point is in that state relative to the Receiver (in proximity/not in 
proximity). 

▪ Each point: A state is defined for each point of the Actor. Results are 
shown for each point separately. 

7. Complete the procedure to add the variable. See Calculate statistics: 
procedure.
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Notes
▪ If the experiment is set to Only center-point detection or Color marker 

tracking, the Body points tab is absent. Calculations are based on the 
center point.

▪ Any selected points: At any sample time, it is possible that the Actor's 
body points are in different states relative to the body points of the 
Receiver. For example, the Actor's nose point being In proximity of the 
Receiver's center point, and the Actor's center point Not in proximity of the 
Receiver's center point. In such cases when you select Any selected point 
(step 4 and 5 above), multiple states can be assigned to that sample.

▪ Any selected Subjects: At any sample time, it is possible that the Actor is in 
different states relative to different Receivers. For example, Subject 1 being 
In proximity of Subject 2 and Not in proximity of Subject 3. In such cases 
when you select Any selected Subject (step 5 above), multiple states can 
be assigned to that sample. You can check multiple states occurring at one 
sample time when exporting the raw data (see Export the raw data (track 
and dependent variables). At a specific sample time, the value of the 
variable is 1 in more than one column, depending on which subject is in 
proximity of the Actor.

Application
Proximity can be used to study the behavioral interactions between individual 
animals, for instance the effects of individual housing vs. group housing on social 
behavior of rats (Spruijt et al. 1992. Physiology & Behavior 51: 747-752), or social 
isolation as a symptom of schizophrenia (Sams-Dodd, 1995. J. Neurosc. Methods 59: 
157-167).
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Body contact
Definition
A discrete (state event) variable with two possible states, In contact and Not in 
contact, based on whether the subject’s body contour is in contact with the body 
contour of any of the other subjects.

NOTE  Body contact is not available or does not give results if:

▪ The tracks were recorded in EthoVision XT 11 or earlier.
▪ Your experiment is set to: 

▪ Color marker tracking.
▪ Live Mouse Tracker - But see Raw Live Mouse Tracker data
▪ Center-point, nose-point and tail-base detection, with two subjects per 

arena tracked with Deep learning.

How to specify Body contact
1. Click the Add button next to Body contact.
2. In the Body contact tab, select the state you want to analyze.

For example, select Body Contact if you want to know how often or how 
long the subjects were in contact during the test.

3. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ An animal’s contour is determined by computer vision, which is unlike 

human vision. This is exemplified when dark animals are tracked: often their 
shadow on the background will be considered part of the animal. Thus, the 
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detected contour is regularly a bit bigger than the human eye would 
observe.

▪ Body contact is not subject-specific. That is, you cannot isolate instances of 
contact for a specific combination of subjects (for example, Subject 1 in 
contact with Subject 3). Instead, use Proximity and specify the two subjects.

▪ Body contact is based on the subject’s contour, while Proximity is based on 
the distance between subject’s body points. For example, two subjects next 
to each other may be in proximity, but not in body contact.

▪ Body contact is affected by the track smoothing methods The Minimal 
Distance Moved smoothing method and The Maximum Distance Moved 
smoothing method. When you apply one of those methods, Body contact is 
recalculated and may be slightly different with respect to when the method 
is not applied. The difference is usually limited to one or a few samples.

Applications
Body contact can be used in any social interaction tests:

▪ To quantify the level of interaction between subjects. Add Body contact in 
the Analysis profile (see above).

▪ To exclude instances of body contact when these result in unreliable 
tracking. In this case, instead of adding Body contact in the Analysis profile, 
in the Data profile choose Nesting over Body contact and select Not in 
contact.

Below: Integrated Visualization of Body contact in a 2-subjects test. 

TIP  In Integrated Visualization, the body contour is not visible. To view the body 
contour, open Acquisition, click the Show Hide button, choose Detection 
Features and select Body contour. 
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Relative movement
Definition
A discrete (state) variable with four possible states: Moving to, Moving from, No 
relative movement, and No interaction.

▪ The state is Moving to when the focal subject (Actor) is moving towards 
another subject (Receiver). 
NOTE 1 An Actor is the subject listed on the rows in the statistics table, or in 
the Integrated Visualization at the left side of each chart. Other subjects in 
the same arena are Receivers.

NOTE 2  The term moving refers to a subject moving faster then a specified 
minimum velocity.

▪ The state is Moving from when the Actor is moving away from the Receiver. 
▪ The state is No relative movement when two subjects are not moving 

relative to each other.
▪ The state is No interaction when the distance between subjects is great 

enough that they can be considered as not interacting.

Calculation
1. To calculate the Relative Movement for sample k, the body points of the 

Actor and the Receiver must be known for sample k and k-1. 
2. The middle point Q is determined on the segment that joins the body 

points of the Receiver for samples k–1 and k.
In this example, A is the body point of the Actor, R of the Receiver. Q is the 
interpolated position of the Receiver’s body point.

3. The distance between the Actor's body point and Q is calculated for 
samples: Dk and Dk-1, respectively.

4. The state of Relative movement is determined:
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▪ If Dk > Dk-1: Moving from

▪ If Dk < Dk-1: Moving to

▪ If Dk = Dk-1: No relative movement

▪ If Dn > Maximum interaction distance (user defined): No interaction.

▪ If the velocity of the Actor is lower than the Minimum velocity (user 
defined): No relative movement. 

From the figure above, one can see that the outcome depends on which 
animal is considered as Actor and which as Receiver. 

Now suppose the other subject is the actor. 

The point Q is defined in the middle of the segment joining the receiver’s 
points Rk-1-Rk. Note that Dk is longer than Dk-1. Therefore, this subject, 
when considered as the Actor, is Moving from the other subject. 

How to specify Relative movement
1. Click the Add button next to Relative movement.
2. In the Relative Movement tab:

▪ Next to Maximum interaction distance, enter the distance above 
which you do not want to consider the subjects as interacting (Default: 
50 cm/16.69 inches).

▪ Next to Minimum velocity, enter the minimum velocity of the actor (A 
in the figures above) for it to be considered as moving from or moving 
to the other subject. Note that the velocity of other subjects does not 
count here.

▪ Under Calculate statistics for, select the states you want to consider. 
By default, all states are selected.

3. Click the Body points tab. Select the body points of the focal subject 
(Actor) you want to use to calculate relative movement. 
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If you select two or three points, a drop-down list becomes available. 
Choose:

▪ All selected points: A state is assigned only when all selected points 
are in that state relative to the Receiver (moving to/from/no 
movement/no interaction). If body points are in different states, the 
state is not assigned to that sample.

▪ Any selected point: A state is assigned when at least one selected 
body point is in that state relative to the Receiver (moving to/from/no 
movement/no interaction). See the note below.

▪ Each point: A state is defined for each point of the Actor. Results are 
shown for each point separately. 

4. Click the Receivers tab. Here, you specify the other subjects (Receivers). 
Under Select, choose the subjects. If you select two or more subjects, select 
one of the available options from the list:

▪ All selected subjects: A state is assigned only when the Actor is in that 
state for all selected Receiver (moving to/from/no movement/no 
interaction). If the Actor is in different states relative to different 
subjects (for example, Subject 1 Moving to Subject 2 and Moving from 
Subject 3), the state is not assigned to that sample. 

▪ Any selected subject: A state is assigned when the Actor is in that 
state for at least one Receiver (moving to/from/no movement/no 
interaction). 

▪ Each Subject: A state is assigned to each selected subject as a separate 
Receiver. Results are shown for each Receiver. 

Under Body points, select the body points of the subjects selected above. If 
you select two or three points, select one of the available options: 

▪ All selected points: A state is assigned when the Actor is in that state 
relative to all selected points of the Receivers (moving to/from/no 
movement/no interaction). If the Actor is in different states relative to 
different Receiver's body points, the state is not assigned to that 
sample.

▪ Any selected point: A state is assigned when the Actor is in that state 
relative to at least one selected body point (moving to/from/no 
movement/no interaction). 

▪ Each point: A state is defined for each body point of the Receiver. 
Results are shown for each Receiver body point separately. 

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.
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Notes
▪ All / Any selected points. At any sample, body points of one subject can 

be in different states relative to another subject's point. Consider the 
example of the figure below. The center point of the Actor A (circles) is 
moving to the Receiver R, while the nose point of A (triangles) is moving 
from the Receiver. For clarity, the Receiver is represented by the center point 
only. Left: The Actor’s center point is moving to R (Dk is shorter than Dk-1). 
Right: The Actor’s nose-point is moving from (Dk is longer than Dk-1).

▪ Selecting All selected points gives no unique state for Relative 
movement at sample k.

▪ Selecting Any selected points gives the state Moving to for the center 
point and Moving from for the nose point at sample k.

▪ Any selected subject: At any sample time, it is possible that the Actor is in 
different states relative to different Receivers. For example, Subject 1 
Moving to Subject 2 and Moving from Subject 3. In such cases when you 
select Any selected Subject, multiple states are assigned to that sample. 
You can check multiple states being assigned to one sample time when 
exporting the dependent variable. At a specific sample time, the value of 
the variable is 1 in more than one column of the export file. In the example 
above, the columns for moving to and moving from will both show 1 in the 
corresponding sample row.

▪ If your experiment is set to Only center-point detection or Color marker 
tracking, the body point options are absent. Calculations are based on the 
center point.

Application
Relative movement can be used to study the effects of individual housing vs. group 
housing on the social behavior of rats (Spruijt et al. 1992. Physiology & Behavior 51: 
747-752; Hol et al. 1999. Behavioural Brain Research 100: 91-97), or for studying the 
behavioral interactions between individually recognized animals.
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The following examples show the behavior of subject 1 (red dot) relative to subject 
2 (green dot).

Moving to:

Moving from:

No movement (Subject 1’s velocity is under the Minimum velocity threshold):

No interaction (Subject 1’s distance from Subject 2 is greater than the Maximum 
interaction distance):

Note that the No interaction state is active even when Subject 1’s velocity exceeds 
the threshold, until the distance between the two subjects goes below the 
Maximum interaction distance.
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Net weighted movement
Definition
The signed, distance-weighted change in distance between two subjects from one 
sample to the next. 

Net weighted movement is weighted by the distance between two subjects. Changes 
in positions of subjects which are at a large distance from each other have a lower 
weight, so they can be distinguished from movements at close distance, which have 
a different biological meaning. 

Unlike Relative movement, this is a continuous variable (in distance units). The Net 
weighted movement is positive if the subject (Actor) is getting closer to another 
subject (Receiver), negative in the other case. 

Calculation
Formula:

NWMn = (Dk-1 - Dk) * abs (DSk - DSk-1) / (max (DSk, DSk-1))

Where:

Dk-1, Dk is the distance between the Actor's body point and the interpolated point 
of the Receiver calculated for two consecutive samples. 

DSk-1, DSk is the distance between subjects for two samples.

In the example of the first figure in the topic Relative movement, the value of the 
variable depends on which subject is considered as Actor and which as Receiver. 
Similarly, Net weighted movement of subject A is positive relative to R. If the other 
subject was the Actor (see the second figure in the topic), the point Q would be 
defined for the other subject in the middle of the Rk-1-Rk segment. In that case Dk 
would be longer than Dk-1, thus Net weighted movement would be negative 
relative to R.

How to specify Net weighted movement
1. Click the Add button next to Net weighted movement.
2. In the Net Weighted Movement tab, under Maximum interaction 

distance, enter the distance above which you do not want to consider the 
subjects as interacting. (Default: 50 cm/16.69 inches)
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3. Click the Body points tab. Select the body points of the focal subject 
(Actor) you want to use to calculate net weighted movement.
If you select two or three points, results are calculated for each point 
separately. 

4. Click the Receivers tab. 
▪ Under Select, choose the subjects you want to consider as Receivers.
▪ Under Body points, select the body points of the subjects selected 

above. If you select two or more subjects and points, results are 
calculated for each combination separately.

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ Net weighted movement is calculated for all the subjects selected in the 

Data profile. Each subject displayed on the rows of your result table is 
considered as Actor. The subjects displayed on the columns are the 
Receivers.

▪ If your experiment is set to Only center-point detection or Color marker 
tracking, the body point options are absent. Calculations are based on the 
center point. 

Application
Net weighted movement can be used as an objective measure for the intensity of 
approach and avoidance behavior (Spruijt et al. 1992. Physiology & Behavior 51, 
747-752). The advantage of this variable relative to Weighted movement to/from is 
that it integrates both. This means that you can analyze, for instance, the movement 
of subjects regardless of the direction towards or away from each other.
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Weighted movement from
Definition
The distance-weighted change in distance between subjects, when a subject (Actor) 
moves away from another subject (Receiver).

Weighted movement from (WMF) is a continuous variable, and is always positive. It 
is calculated only when the state of the Actor is moving from the Receiver (see also 
Relative movement). 

Calculation
Formula:

▪ If Dk - Dk-1 > 0, then 

WMFk = (Dk - Dk-1) * abs(DSk - DSk-1)/(max (DSk, DSk-1))

▪ If Dk - Dk-1  0, or DSk = 0, then 

WMFk = missing value

▪ If DSk-1 > Maximum interaction distance, then

WMFk = missing value

Where:

▪ Dk-1, Dk is the distance between the Actor's body point and the interpolated 
point of the Receiver calculated for two consecutive samples. 

▪ DSk-1, DSk is the distance between the subjects' body points for two 
samples.

In the figure below, A is the body point of the Actor, R of the Receiver. Q is the 
interpolated position between the Receiver’s body points at samples k and k-1.
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Notes
▪ Weighted movement from is equal to the absolute value of Net weighted 

movement, taken for those samples in which the value of NWM is negative 
(the focal subject moves away from another subject). 

▪ Weighted movement from is weighted by the distance between two 
subjects. Changes in positions of subjects which are at a large distance from 
each other have a lower weight, so they can be distinguished from 
movements at close distance, which have a different biological meaning.

▪ From the figure above one can see that the outcome depends on which of 
the two interacting subjects is considered as Actor and which as Receiver. 
This is because formula takes possible differences in speed of approach of 
the subjects into account. In that case, the difference Dk-Dk-1 is positive, 
therefore Weighted movement from R is calculated. If R was the Actor, the 
point Q would be defined for the other subject in the middle of the Ak-1-Ak 
segment. In that case Dk would be shorter than Dk-1, thus Dk - Dk-1 < 0, and 
the dependent variable would not be calculated. 

▪ This dependent variable is not a speed, as time is not involved in its 
calculation. However, the parameter is quadratically sensitive to movement 
of the subject.

How to specify Weighted movement from
1. Click the Add button next to Weighted movement from.
2. In the Weighted movement From tab, under Maximum interaction 

distance, enter the distance above which you do not want to consider the 
subjects as interacting. (Default: 50 cm/16.69 inches)

3. Click the Body points tab. Select the body points of the focal subject 
(Actor) you want to use to calculate the dependent variable. If you select 
two or three points, results are calculated for each point separately.

4. Click the Receivers tab.
▪ Under Select, choose the subjects you want to consider as Receivers.
▪ Under Body points, select the body points of the subjects selected 

above. If you select two or more subjects and points, results are 
calculated for each combination separately.

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.
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Notes
▪ Weighted movement from is calculated for all the subjects selected in the 

Data profile. Each subject displayed on the rows of your result table is 
considered as Actor. The subjects displayed on the columns are the 
Receivers.

▪ If your experiment is set to Only center-point detection or Color marker 
tracking, the body point options are absent. Calculations are based on the 
center point. 

Application
Weighted movement from can be used as an objective measure for the intensity of 
avoidance (Spruijt et al. 1992. Physiology & Behavior 51, 747-752). 
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Weighted movement to
Definition
The distance-weighted change in distance between subjects, when a subject (Actor) 
moves towards another subject (Receiver).

Weighted movement to (WMT) is a continuous variable, and is always positive. It is 
calculated only when the state of the Actor is moving to the Receiver (see also 
Relative movement). 

Calculation
Formula:

▪ If Dk - Dk-1 < 0: 

WMTk= (Dk-1 - Dk) * abs(DSk - DSk-1)/(max (DSk, DSk-1))

▪ If Dk-Dk-1  0, or DSk = 0:

WMTk = missing value

▪ If DSk = 0, and DSk > Maximum interaction distance, then

WMTk = missing value

Where:

▪ Dk-1, Dk is the distance between the Actor's body point and the interpolated 
point of the Receiver calculated for two consecutive samples k-1 and k.

▪ DSk-1, DSk is the distance between the subjects' body points for two 
samples (see Distance between subjects).
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Notes
▪ Weighted movement to is equal to the absolute value of Net weighted 

movement, taken for those samples in which the value of NWM is positive 
(the focal subject moves towards another subject).

▪ Weighted movement to is weighted by the distance between two subjects. 
Changes in positions of subjects which are at a large distance from each 
other have a lower weight, so they can be distinguished from movements at 
close distance, which have a different biological meaning.

▪ From the figure above one can see that the outcome depends on which of 
the two interacting subjects is considered as Actor and which as Receiver. If 
R was the Actor, the point Q would be defined for the other subject (A in 
the figure) in the middle of the segment joining the two consecutive body 
points. In that case Dk would be longer than Dk-1, thus Dk - Dk-1 > 0 (i.e., R 
moves away from A), and the Weighted movement to would not be 
calculated. Instead, Weighted movement from would be calculated.

▪ This dependent variable is not a speed, as time is not involved in its 
calculation. However, it is quadratically sensitive to movement of the 
subject.

How to specify Weighted movement to
1. Click the Add button next to Weighted movement to.
2. In the Weighted movement To tab, under Maximum interaction 

distance, enter the distance above which you do not want to consider the 
subjects as interacting. (Default: 50 cm/16.69 inches)

3. Click the Body points tab. Select the body points of the focal subject 
(Actor) you want to use to calculate the dependent variable. If you select 
two or three points, results are calculated for each point separately. 

4. Click the Receivers tab. 
▪ Under Select, choose the subjects you want to consider as Receivers. 
▪ Under Body points, select the body points of the subjects selected 

above. If you select two or more subjects and points, results are 
calculated for each combination separately.

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.
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Notes
▪ Weighted movement to is calculated for all the subjects selected in the Data 

profile. Each subject displayed on the rows of your result table is considered 
as Actor. The subjects displayed on the columns are the Receivers.

▪ If your experiment is set to Only center-point detection or Color marker 
tracking, the body point options are absent. Calculations are based on the 
center point. 

Application
Weighted movement to can be used as an objective measure for the intensity of 
avoidance (Spruijt et al. 1992. Physiology & Behavior 51, 747-752). 
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Side by side
Definition
The focal subject is side-by-side with another subject. The latter is named receiver 
in EthoVision XT.

Two categories are defined, based on how the subjects are oriented relative to one 
another.

▪ Same direction: the focal subject and the receiver are side by side and 
pointing to the same direction (in the figure below, left).

▪ Opposite direction: the focal subject and the receiver are side by side and 
pointing to the different directions (in the figure below, right).

This variable is available in experiments set to Center-point, nose-point and tail-
base detection. See Tracked features

Calculation
▪ For Side by side, same direction:

▪ EthoVision XT finds the samples where both the distance between the 
nose-point of the focal subject and the nose-point of the receiver and 
the distance between the tail-base point of the focal subject and the 
tail-base point of the receiver are below the specified threshold 
(default: 5.26 cm).

▪ If the two vectors formed by the tail-base point and the nose-point of 
each subjects point to the same directions (that is, the dot product of 
the two vectors is positive), then Side by side, same direction is scored 
for that sample.

▪ For Side by side, opposite direction:
▪ EthoVision XT finds the samples where both the distance between the 

nose-point of the focal subject and the tail-base point of the receiver 
and the distance between the tail-base point of the focal subject and 
the nose-point of the receiver are below the specified threshold 
(default: 5.26 cm).
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▪ If the two vectors formed by the tail-base point and the nose-point of 
each subjects point to opposite directions (that is, the dot product of 
the two vectors is negative), then Side by side, opposite direction is 
scored for that sample.

How to specify Side by side
1. Open an Analysis profile and in the Dependent Variables panel, under 

Social, click the Add button next to Side by side.
2. Under Threshold, enter the maximal In proximity distance acceptable 

between the two subjects’ body points (nose to nose or nose to tail-base).
3. Under Calculate statistics for, select the option Side by side, same 

direction, or Side by side, opposite direction, or both.
4. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure

Note
Side by side is similar to Proximity, however the latter cannot tell whether the 
subjects are oriented in the same or different directions.

See also

▪ Proximity
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Train
Definition
A discrete (state event) variable that is scored when one subject follows (or is 
followed by) one or more subjects at close distance. Trains can be of two, three or 
four subjects.

Examples of trains
▪ Actor > B. EthoVision returns all instances when the actor (or focal subject) 

followed subject B. Here, Actor is the focal subject reported in the results 
table of in the plots of Integrated Visualization. For example, where subject 
A is the actor, the instances of the train A > B are found. Where subject B is 
the actor, no results are found since the train B > B makes no sense. Where 
subject C is the actor, the instances of the train C > B are found, etc.

▪ Actor > Any > Any. This is the predefined train when you create a new 
Train variable. All instances are found where the actor followed two other 
subjects, no matter who they were. For example, when subject A is the 
actor, trains like A > B > C, A > C > B, or A > D > B etc. are found. Similarly, 
where subject B is the actor, trains like B > A > C, B > C > D etc. are found. 
Statistics are given for all the combinations of “Any” subjects pooled 
together. 
1098



▪ B > A. This definition returns all the instances when subject B followed 
closely subject A.

▪ A > Actor > Any. This definition returns all the instances when the focal 
subject was followed by individual A and followed any other subject.

Calculation
The state Train is active when:

▪ The speed of the subjects is higher than the minimum value specified (see 
below).

▪ The distance between the actor’s nose point and another subject’s tail base, 
or the distance between the actor’s tail base point and another subject’s 
nose point is less than the maximum value specified (see below).

How to specify Train
1. Open an Analysis profile and in the Dependent Variables panel, under 

Social, click the Add button next to Train.
2. By default, the variable Train contains a predefined train with three animals: 

Actor > Any > Any. 
▪ To define new trains, follow the steps below.
▪ If you do not want to have the predefined train in this variable, select 

that train definition under Settings and click the Delete button. 
3. Click the Add button to make a new definition of a train.
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The Add Train window opens with the names of the subjects listed on the 
left. 

4. Select the name of the first subject in the train, that is, the one that follows 
the other subjects. Next, either double-click the name or click the double-
arrow button.

As a result, the subject’s name is placed under Train. 

5. Repeat the steps above for the second, third etc. subject that must be part 
of the train definition. 
1100



6. When ready, click the Add button. 

7. As a Result, the new train definition, in this example Actor > A > C, is 
added under Settings.

8. Do one of the following:
▪ To add more train definitions, repeat the steps above beginning from 

step 4. 
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▪ If you are ready with the definitions, click the Close button in the Add 
Train window.

9. Adjust the thresholds if necessary (see below for details).
10. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure

Notes
▪ Maximum distance (nose - tail base). A train is defined only if the 

distance between subjects, measured between the nose-point of one 
subject and the tail-base point of another subject, is less than the value 
specified. This condition must be valid for all the subjects in the train 
definition.

▪ Minimum velocity. A train is defined only if the animals that follow each 
other are faster than the value specified.

▪ Exclude instances shorter than. You can use this setting to filter out 
instances that are too short to have biological meaning.

▪ To delete an existing train definition, select that definition under Settings 
and click Delete. 

▪ To delete an element of the train, in the Add Train window click the Delete 
button. 

Click multiple times until the element is deleted from the definition under 
Train. If necessary, add more elements to complete the train definition.

See also

▪ Dependent variables for Live Mouse Tracker
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Behavior Recognition

The Rat/Mouse Behavior Recognition group of dependent variables is only available 
when you have the Rat or Mouse Behavior Recognition add-on module of 
EthoVision XT, respectively.

▪ Behaviors detected with Behavior recognition  1104
▪ Behavior probability  1112
▪ Merged behavior  1113
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Behaviors detected with Behavior 
recognition
Definitions
See also the reference in Notes.

Digging

Rooting with the muzzle or digging with the front paws in the bedding material (for 
Mouse Behavior Recognition only).

Drinking

The subject licks at the spout of the water bottle.

Eating

The subject eats at the feeder or from the floor, or is eating while holding food in 
front paws.

Grooming

The subject grooms snout, head, fur or genitals. Includes scratching and licking of 
paws during a grooming session.

Hopping

The subjects moves forward with both hind limbs at the same time. Head goes first, 
followed by the rear. Unlike Jumping, Hopping is scored as a point event with no 
duration, and does not interrupt behavior states (for Mouse Behavior Recognition 
only).

Jumping

The subject moves quickly forward with both hind limbs at the same time. Jumping 
interrupts other states like Walking (for Rat Behavior Recognition only).

Rearing unsupported

The subject stands in an upright posture, with front paws not in contact with any 
object. Includes the rise and descend.
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Rearing supported

The subject stands in an upright posture, leaning with front paws against the cage-
wall. Includes the rise and descend.

Resting

The subject rests with hardly any moving, either sits or is lying down. Includes 
sleeping. Apparently no interest in the environment.

Sniffing

The subject makes slight movements of the head, possibly with slight, 
discontinuous body displacement. Includes sniffing the air, the wall, the floor and 
other objects.

Twitching

The subject makes sudden and short movements of the body or head. Includes 
body shake and head shake. Twitching is scored as a point event with no duration, 
and does not interrupt behavior states (for Rat Behavior Recognition only).

Twitching is defined as a point event, that is, an event marking a point in the time 
line, but with no duration.

Walking

The subject moves to another place, and hind legs move as well. 

Note the difference between Walking and Movement: Both dependent variables 
Walking and Movement are based on displacement of the subject’s body point in 
the 2D space. However, Walking is based on many more video frames than 
Movement, and therefore Walking is a more accurate measure of walking behavior.

How to specify a behavior for Behavior recognition
1. Click the Add button next to the behavior you want to analyze.
2. Under Behavior decision method, select:

▪ Default: Statistics will be calculated by using all samples scored as that 
behavior (no filtering based on the behavior’s probability).

▪ Probability greater than: Statistics will be calculated by using only the 
samples for which the probability of that behavior is higher than a 
specific value. Select this value from the list (0-99%).

3. Under Behavior duration threshold, next to Exclude instances shorter 
than, enter how long the current state must last before it changes from the 
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previous state In seconds). If the bout length passes this threshold, the 
previous samples in the bout are included in the new state. If the bout 
length does not pass the threshold, the previous state ends, but no new 
state is defined.

4. Under Calculate statistics for, select which state you would like to calculate 
statistics for. 

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Accuracy
According to our tests, the average recall rate, that is, the proportion of ground 
truth manually-scored behaviors that are correctly recognized, is around 70%. For 
more information, see the paper mentioned below.

▪ Drinking can be confused with Sniffing especially when the Drinking Spout 
Points are not defined.

▪ Make sure to draw the Feeder Zones in the Arena Settings to maximize the 
detection accuracy of Eating.

▪ To maximize accuracy of detection of Rearing supported and reduce false 
positives, carefully draw the Wall zone in the Arena Settings.

Notes
▪ For Twitching and Hopping, which is an event with no duration, the Behavior 

duration threshold and the Calculate statistics for options are not 
available.

▪ For more information on Behavior recognition in EthoVision XT, see the 
following paper:
van Dam, E., J.E. van der Harst, C.J.F. ter Braak, R.A.J. Tegelenbosch, B.M. 
Spruijt, L.P.J.J. Noldus (2013). An automated system for the recognition of 
various specific rat behaviours. Journal of Neuroscience Methods 218 (2), 
214–224.

http://dx.doi.org/10.1016/j.jneumeth.2013.05.012.

▪ The Behavior decision method acts as a filter to ignore samples for which 
the behavior is associated with a low probability, making it easier to extract 
more reliable data. By default, EthoVision XT uses the original scores (thus 
no filtering based on probabilities). See the figure below for an example.
Top: The probability of Grooming, and another behavior plotted against 
time (for simplicity, other behaviors are ignored here). Bottom: When 
defining Grooming in the Analysis profile, consider the following options:
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▪ With Default selected, Grooming occurs every time its probability 
exceeds the probability of any other behavior (default behavior 
recognition).

▪ With Probability greater than 50% selected, Grooming is limited to 
the samples for which its probability is higher than 50%. The higher the 
value, the more conservative the definition.

▪ The Behavior duration threshold acts as a filter to ignore short transitions 
between states. For example, if the behavior Grooming is scored for 0.8 s 
and you select a Behavior duration threshold of 1.0 s, the Grooming state 
does not exceed that threshold, and is therefore excluded from analysis.

▪ For all behaviors but Twitching and Hopping, the percentage statistics are 
calculated including Unknown. For example, when Grooming lasts 30 
seconds, Not Grooming 1 min 30 s, and Unknown 30 s, then the Cumulative 
Duration within Track (%) for Grooming is 30/150 = 20%. If you want to 
exclude Unknown from the percentage, in the Data profile make two 
nesting intervals, one with [behavior name] and the other with Not 
[behavior name], then combine the two Nest boxes in parallel. Next, in the 
Analysis profile specify the behavior and its statistic, Cumulative Duration 
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within Nesting (%). In the example above, the result would be 30/120 = 
25%.

▪ The duration of the behaviors may not add up to 100% of the track 
duration, also when including Unknown. This could result, for example, 
when you filter a behavior using a probability threshold. When visualizing 
behaviors, samples filtered out appear as gaps between behaviors.

▪ When you specify a Behavior probability threshold for one behavior, the 
other behaviors (which are mutually-exclusive by definition) are not re-
calculated according to that setting. Depending on the value of the 
probability threshold, the behavior may become overlapping with other 
behaviors. For example, if you select a probability threshold of 15% for 
Grooming, some parts of the track may be scored as Grooming where also 
Eating was scored based on the default settings (see below). To prevent this 
from happening, either use Default or choose the same probability 
threshold for all behaviors.
Below: Event plots of behaviors Grooming and Eating. Top: Behavior 
probability. Middle: Grooming is defined with a Behavior probability greater 
than 15%. Bottom: Eating is defined with Default probability settings, and is 
scored for most of the time due to the high probability (see the probability 
plot). As a result, Grooming is partially overlapping with Eating, although 
the two behaviors are supposed to exclude each other. With default 
settings, Grooming would not be scored.

See also

▪ How behaviors are scored in Behavior recognition
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How behaviors are scored in Behavior 
recognition
Basic rules
For each sample in your track, EthoVision XT calculates a probability value for each 
behavior (see Behaviors detected with Behavior recognition). The sum of probability 
values is 100%. 

All behaviors but Twitching and Hopping are mutually-exclusive states, that is, only 
one can be assigned to a sample. A behavior is assigned to a sample based on a 
number of decision rules that take into account the probability of that behavior 
relative to that of others, and the behaviors assigned to adjacent samples. See also 
the figure below.

▪ Twitching and Hopping have their own probability, but are not compared 
with that of the others. As a result, Twitching and Hopping are scored 
independent of other behaviors. Each may be assigned to a sample also 
when one of the other behaviors is scored for that sample. For example, 
Hopping when Walking is active.

▪ When two or more behaviors (excluded Twitching and Hopping) have 
similar probability values, and the same behaviors are not scored in 
adjacent samples, or when all behaviors have probability values below 25%, 
then none of the behaviors are scored for that sample. This results in gaps 
between scored behaviors when you visualize them in the Integrated 
Visualization.

Example
Below you see an example of how behaviors are scored based on their per-sample 
probability values. Top: X-Y chart of probability (here ranging from 0 to 1) of five 
behaviors (others are not shown for simplicity). Bottom: The resulting scored 
behaviors. In general, the behavior is assigned to a sample that has the highest 
probability (see for example Sniffing at the beginning of the time line). However, the 
state is smoothed based on the values in a number of samples before and after the 
current sample. For example, at 75 s Sniffing has a lower probability than Twitching, 
but the state Sniffing is still active. Note that Twitching is scored as a point event, 
with no duration, and is represented with a vertical segment.

The gap between scored states is caused by samples where two or more behaviors 
have similar probability values (for example at about 75.9 s, with Jumping and 
Walking having probabilities around 0.5) or the probability is below 0.25 for all 
behaviors. The example is taken from Rat Behavior Recognition data.
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Behavior, “Not” Behavior and “Unknown”
Each behavior type, except Twitching and Hopping, has three complementary, 
mutually-exclusive states. For example, Grooming, Not Grooming and Unknown.

At any sample, the “Not” behavior is automatically scored if the corresponding 
behavior is not scored, unless Unknown is scored for that sample (see below).

Behavior “Unknown”
A behavior type is scored as Unknown in the following cases:

▪ At the beginning of the track if the Trial Control Settings rule does not 
include an additional Time condition that waits three seconds before the 
start of tracking, and in the last portion of the track (see Behavior 
Recognition: Data, performance and accuracy).

▪ When the nose and tail base points are not detected.
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▪ In all cases when the subject is not found or samples are missed for more 
than 0.4 s.

Statistics of Unknown can be calculated for all behaviors except Twitching. The 
statistics are the same for all behaviors. For example, the duration of Unknown 
calculated for Grooming is equal to that of Unknown for Rearing supported.
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Behavior probability
Each behavior is associated with a probability, calculated per sample. Whether a 
behavior state is scored for a specific sample depends on a set of decision rules (for 
details see How behaviors are scored in Behavior recognition).

All behaviors but Twitching and Hopping are mutually-exclusive, therefore the sum 
of their probability values is 1. Twitching and Hopping have a probability too, but 
whether they are scored at a specific time does not depend on the probability of 
other behaviors.

How to specify Behavior probability
1. Click the Add button next to Behavior probability.
2. In the Behavior Probability tab, select the state(s) you would like to 

calculate the probability for.
3. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Application
You may want to filter the occurrences of a behavior based on their probability 
values. If the probability of that behavior is lower than a threshold at a specific 
sample, that sample is left out and the behavior state is re-calculated (see an 
example in Behaviors detected with Behavior recognition).

1. In the Analysis profile:
▪ Add the behavior you are interested in.
▪ Add the Behavior probability variable and, in the window that appears, 

select the same behavior.
2. Plot the integrated data to view the behavior detected and its probability 

together with the video. Check how those states correspond with the 
subject’s behavior in the video.

3. To filter data based on probability, in the Analysis profile click the behavior 
variable, and select a probability value for Behavior probability threshold.

4. Plot the data again to see the result of filtering.
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Merged behavior
You can define a behavior state that includes two or more of the behaviors detected 
automatically. For example, to calculate the overall frequency of Rearing = Rearing 
supported + Rearing unsupported.

How to specify Merged behavior
1. Click the Add button next to Merged Behavior.
2. Under Select behaviors to merge, select which behaviors you would like to 

merge for analysis. 
For example, select Rearing supported and Rearing unsupported to analyze 
the total occurrences of Rearing.

3. Under Behavior probability threshold, select:
▪ Default: Statistics will be calculated by using all samples scored as that 

behavior (no filtering based on the state’s probability).
▪ Probability greater than: Statistics will be calculated by using only the 

samples for which the probability of one of the merged behaviors is 
higher than a specific value. Select this value from the list. See a note 
below. 

4. Under Behavior duration threshold, next to Exclude behavior instances 
shorter than, enter the minimal duration of the merged behavior to be 
considered for analysis. 
NOTE  The threshold is applied to the merged behavior, not the instances of 
single behaviors. For example, two instances of behaviors Rearing 
unsupported and Rearing supported follow each other in the time line. The 
first lasts one second, the other two seconds. When you merge the two 
behaviors and select a duration threshold of 3 seconds, the two behaviors 
are considered for analysis.

5. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Note
The Frequency of Merged behavior may not always be equal to the sum of the 
frequencies of the single behaviors. This can happen, for example, when an instance 
of Rearing supported is immediately followed by an instance of Rearing 
unsupported. Then the frequency of Merged behavior is 1, not 2.
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Manually scored behavior

Definition
Behaviors defined in the Manual Scoring Settings are analyzed as dependent 
variables with discrete states, like In zone, Movement etc.

How to specify a manually scored behavior
1. Click the Add button next to the name of the behavior (or behavior group) 

you want to calculate.
2. In the tab named as the behavior (or the behavior group), select the 

behavior you want to calculate statistics for, and clear the options for the 
behaviors you do not want to include in the table.
▪ For Mutually-exclusive behaviors, the window lists all behaviors of the 

group selected by default. The analysis result will show the statistics for 
each behavior separately. Clear the option for the behavior you do not 
want to analyze.

▪ For Start-Stop behaviors, the window lists the behavior (selected by 
default) and its opposite, indicated by Not [behavior name]. Selecting 
Not [behavior name] means that the program calculates the statistics 
for the time that the behavior was not active (see below).

3. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ Not [behavior name]: For example, if you define Rearing as a Start-Stop 

behavior and score it one time during the test (not at the start of the trial), 
then the results will be (see also the figure below):
Frequency of Rearing = 1.
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Frequency of Not Rearing = 2. The first occurrence of Not Rearing is at the 
start of the trial, and the second occurrence is after you press the Stop code 
for Rearing.

The cumulative duration of Not [behavior name] is the sum of all the 
periods of time that the behavior was not scored.

See also 

▪ Export manually-scored behaviors
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Trial Control

▪ Trial Control event  1117
▪ Trial Control state  1119
▪ Trial Control variable  1123

See also

For Hardware variables related to devices like the Pellet dispenser, the Lickometer, 
PhenoWheel or the PhenoTyper Top Unit, see the Analysis of Trial Control data in 
the EthoVision XT 18 - Trial and Hardware Control - Reference Manual. To open this 
manual, choose Apps > Noldus > EthoVision XT 18 Other Documentation.
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Trial Control event
Definition
A point event, with no duration, defined by an element of Trial and Hardware 
Control (condition, action, rule/sub-rule and reference). 

A Trial Control event has no duration. For Trial Control events you can only calculate 
frequency and latency of first or last occurrence. 

How to specify Trial Control event
1. Click the Add button next to Trial Control event.
2. From the Element list select the Trial and Hardware Control element to be 

analyzed. For example, if you want to analyze the hardware-base action 
‘Drop pellet’ select Action: Drop pellet. 

3. From the Event list, select the state of the element. The options available 
depend on what you have chosen as Element. 

4. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ Statistics of Cumulative duration and Latency can only be a multiple of the 

sample interval (=1/sample rate). For example, when you define a condition 
‘Subject in zone A for >= 3 s’, this condition is met when the time elapsed 
from its activation exceeds 3 s. If the sample rate is 12.5 frames/s (thus the 
sample interval is 1/12.5= 0.08 s), the condition is met at the first multiple 
of 0.08 greater than 3 s, that is 3.04 s. This affects data analysis, for example 
the latency of the event ‘Condition becomes true’ is 3.04 s

▪ For Trial Control events based on Conditions, the sample time at which a 
Trial Control event is scored also depends on the statistic used in the 
condition:
If you use Current to define the condition (for example: “when Current In 
zone= true”), the Trial Control event is scored at the expected sample time. 
For example, when the animal enters the zone (and thus Current= true for 
that sample). See also A in the figure in Trial Control state, where the start 
of the Trial Control state is like a Trial Control event.

If you use any other statistic to define the condition (for example, “when 
Frequency of In zone >= 1), consider the following scenarios:
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▪ - When the condition becomes true after the condition box is activated, 
the Trial Control event is scored at the expected sample time. See How 
the trial control instructions are executed for an explanation of the 
terms true and active.

▪ - When the condition is already true when the condition box is 
activated (for example, a condition “Frequency of In zone =1” is 
activated when the animal is already in the zone), such statistic is only 
evaluated at the next sample (or in the second next sample, in the case 
of Heading). In that case, the Trial Control event is scored one sample 
(or two) later than expected from the condition (see B in the figure in 
Trial Control state). However, for the consecutive frequencies of In zone 
=2, 3, etc, the condition is already active by definition; therefore the 
Trial Control event is scored at the expected time, when the condition 
becomes true.

See also

▪ The EthoVision XT 18 - Trial and Hardware Control - Reference Manual. To 
open this manual, choose Apps > Noldus > EthoVision XT 18 Other 
Documentation.

Application
You can use Trial control event to test whether trial control works as expected. For 
example, visualize the Trial control event ‘condition true’ and plot it together with 
the video to check that the condition is met at the correct time. You can also define 
a Trial control event to calculate the number of occurrences of specific actions like 
dropping a food pellet in a learning experiment.
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Trial Control state
Definition
A time interval specified by two events of Trial and Hardware Control occurred 
during the trial. The interval may also occur in two or more instances if the events 
that mark its start and end occur repeatedly during the trial. 

If an interval occurs in more instances during a trial, you can choose to analyze 
either each occurrence or the sum up the results for all occurrences. See the 
Calculate statistics per interval option below.

How to specify a Trial Control state
1. Click the Add button next to Trial Control state.
2. Next to From, from the Element list select the Trial and Hardware Control 

element that makes the criterion for the start of the interval. From the 
Event list, select the state of that element that makes the start of the 
interval.

3. Next to To, from the Element list select the Trial and Hardware Control 
element that makes the criterion for the end of the interval. From the Event 
list, select the state of that element that makes the end of the interval.
Choose which occurrence of the ending event you want to consider.

4. Select Ignore last interval if incomplete to ignore the interval when the 
Trial Control event that defines the end of the state is not found. If you do 
not select this option, and the end criterion is not met, EthoVision XT 
defines an interval up to the end of the trial.
EXAMPLE  A Trial Control state is defined “from Trial start to when the 
condition “Subject in zone A” becomes true. If the subject never enters 
zone, then the end criterion is never met. If you select the Ignore option, 
the Trial Control state is not defined. If you do not select the option, the 
Trial Control state is defined from the start to the end of the trial.

5. An interval may occur several times in a trial. If your want to have statistics 
for each occurrence, select the Calculate statistics per interval option. 
Next to For consecutive intervals, choose the range of occurrences you 
want to have in the results. 

6. Complete the procedure to add the variable. See Calculate statistics: 
procedure.
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Notes
▪ Do not select Calculate statistics per interval when you want to sum up 

the results from the occurrences of the state interval in the trial. For 
example, to calculate the cumulative duration of the state From condition 
‘In Cue zone’ becomes true To condition ‘In Feeder zone’ becomes true. 

▪ Statistics of duration and latency can only be a multiple of the sample 
interval (=1/sample rate). For example, when you create a condition 
‘Subject in zone A for >= 3 s’, this condition is met when the time elapsed 
from its activation exceeds 3 s. If the sample rate is 12.5 frames/s (thus the 
sample interval is 1/12.5= 0.08 s), the condition is met at the first multiple 
of 0.08 greater than 3 s, that is 3.04 s. This affects data analysis, for example 
the duration of the state ‘From condition active to condition true’ is 3.04 s.

▪ The Frequency of a Trial Control state is determined by the start of the state. 
This means that at the end of a trial, a Trial Control state is counted even if 
there is no stop event.

Trial Control states based on Conditions
The sample time at which a Trial Control state starts (or ends) also depends on the 
statistic used in the condition in the Trial Control rule.

▪ If you use Current to define the condition (for example, “when Current In 
zone= true”), the Trial Control state starts (or stops) at the expected sample 
time. For example, when the animal actually enters the zone (and thus 
Current= true for that sample).

▪ If you use any other statistic to define the condition (for example, “when 
Frequency of In zone >= 1) consider the two scenarios:
▪ When the condition becomes true after the condition box is activated 

(see How the trial control instructions are executed for an explanation 
of the terms true and active), the Trial Control State starts (or stops) at 
the expected sample time (see A in the figure below).

▪ When the condition is already true when the condition box is activated 
(for example, a condition “Frequency of In zone =1” is activated when 
the animal is already in the zone), such statistic is only evaluated at the 
next sample (or in the second next sample, in the case of Heading). In 
that case, the Trial Control state starts (or stops) one sample (or two) 
later than expected from the condition (see B in the figure below). 
However, for the consecutive frequencies of In zone =2, 3, etc, the 
condition is already active by definition; therefore the Trial Control 
State starts at the expected time, when the condition becomes true.

EXAMPLE  A Trial Control condition has been defined in the Trial Control Settings, 
which checks that the statistic Frequency of the dependent variable In zone is >=1 
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for the Center of the open field. A Trial Control state has been defined in the 
Analysis profile, which starts when the condition “Frequency of In zone >=1” is true. 

A1: The animal enters the Center zone (and therefore the condition becomes true) 
after the condition is activated. The Frequency statistic is evaluated at the same 
sample time. A2: Plot of the variables In zone for the Center and the Trial Control 
state. The Trial Control state starts at the expected sample time, that is, when the 
animal actually enters the zone.

B1: The animal is already in the zone when the condition is activated. Therefore, the 
condition becomes true at the same time that it is activated, but the Frequency 
statistic is evaluated at the next sample (here, sample rate = 5/s, thus after 0.2 s). 

B2: Same plot as A2; Here, the Trial Control state starts o.2 s after the In zone state.
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See also

▪ The EthoVision XT 18 - Trial and Hardware Control - Reference Manual. To 
open this manual, in the Apps screen under Noldus choose EthoVision XT 
18 Other Documentation.

Application
You can use Trial control states to test whether trial control works as expected, and 
for analyzing learning behavior. For example, calculate the duration of the Trial 
control state ‘From Cue light ON to Subject in Feeder zone’ to see whether this 
interval decreases during a trial.
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Trial Control variable
Definition
A variable defined in the Trial Control settings. See Actions > To define a Trial 
Control variable

You may want to analyze or visualize the values of a Trial Control variable. For 
example, you defined a variable named Counter, and:

▪ You want to calculate the maximum value that the variable reached during 
different trials.

▪ You want to visualize its values plotted against time.

How to specify a Trial Control variable
1. In the Analysis profile, click the Add button next to Trial Control variable.
2. From the Element list, select the variable you want to analyze.
3. Complete the procedure to add the variable. See Calculate statistics: 

procedure.
4. To visualize the variable on the timeline, choose the Integrated 

Visualization.

Notes
▪ If you want to calculate the time that the Trial Control variable had a specific 

value, in the Analysis profile choose Multi-condition instead. There you 
can select the Trial Control variable and define the selection criteria. See 
Multi condition

▪ If you want to calculate the time based on a From - To criterion, choose 
Free Interval instead. There you can define, for example an interval From 
Trial Control variable = 10 to Trial Control Variable = 15. See Free interval 
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External Data

▪ External data (resampled)  1125
▪ External data - state  1129
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External data (resampled)
Definition
EthoVision XT only analyzes external data after resampling. That is, it does not 
analyze the original data, but a Dependent variable representing the imported 
signal, resampled to the same sample rate as the EthoVision XT sample rate. This is 
accomplished by combining upsampling and downsampling (see below).

Downsampling and Upsampling

Downsampling 

If the sample rate of the external data signal is higher than the EthoVision XT 
sample rate, the signal is downsampled. For each sample k, a new value is 
calculated from the values of the original signal in the interval (k-1; k] (or in multiple 
preceding sample intervals, depending on the Averaging interval chosen). The 
interval is half-closed, that is, all values of the signal between k-1, (not included) and 
k are considered. The new value gets the time stamp of the sample k.

Five methods are available to downsample the signal. 

Below: Effect of downsampling of an external data signal. Left: original signal 
imported in EthoVision XT. Vertical hatched lines represent the EthoVision XT 
sample intervals. Right: Signal upsampled in EthoVision XT using the following five 
methods (for simplicity, only the values for sample k are shown). 1 Last value, 2 
Maximum, 3 Mean, 4 Minimum, 5 Total value.

Upsampling

If the sample rate of the external data signal is lower than the EthoVision XT sample 
rate, the signal is upsampled.
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For each sample k, a new value is calculated from the values present in the sample 
interval (k-1; k] (or in multiple preceding sample intervals, depending on the 
Averaging interval chosen). If no value is found, A new value is interpolated using 
one of the methods available, or replaced by “missing sample” or a zero value.

Below: Effect of upsampling of an external data signal. Left: original signal imported 
in EthoVision XT. Vertical hatched lines represent the EthoVision XT sample 
intervals. Right: Signal upsampled in EthoVision XT in the following four methods: 1 
Last value, 2 Linear interpolation, 3 Missing value, 4 Zero value. 

Averaging interval
With Averaging interval you can smooth the values of the converted signal. This has 
an effect on both resampled and state variables.

▪ With Averaging interval 1, the new value for sample k only depends on the 
original values of the signal in the interval (k-1, k].
EXAMPLE  Downsampling a EEG signal with the Mean value method and the 
Averaging interval of 1. See 3 in the figure under Downsampling.

▪ With Averaging interval x (where x=2, 3,...), the new value for sample k 
depends on the original values of the signal in the interval (k-x, k]. 
EXAMPLE  Downsampling a EEG signal with the Mean value method and the 
Averaging interval of 3. 

Left: Original EEG signal. Right: Signal downsampled with Mean value and 
Averaging interval 3 (for clarity only sample k is shown). Green dots: 
1126



averages in the 3 sample intervals. Red dot: the average of the three 
averages.

Special case: Resampling
If the sample rate of the external data signal is the same as the EthoVision XT 
sample rate, but with different time stamps, the signal is re-sampled to align its 
values to the EthoVision XT samples. Values are shifted to the right.

How to specify an external data variable (resampled)
1. Click the Add button next to the [data set name].
2. Under Select, choose the Downsampling method (default: Mean value) 

and the Upsampling method (default Last value).
3. Under Outlier filter, select the Averaging interval (default: 1).
4. Complete the procedure to add the variable. See Calculate statistics: 

procedure.
5. Plot Integrated Data or calculate the statistics.

Notes
▪ If you upsample a signal with a sample rate much lower than the EthoVision 

sample rate, and you choose Missing value as the Upsampling method, it 
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may be difficult to see the data points. In Integrated Visualization, choose 
Show/Hide > Show Graph Data Points and zoom in the plot.

▪ See also Averaging interval
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External data - state
Definition
Dependent variable with two possible values (0 and 1) calculated from an imported 
data signal, resampled to the same sample rate as the EthoVision XT sample rate. 
The value of the state variable is calculated per sample from the values of the 
corresponding resampled variable, relative to one or two thresholds.

Top: Heartbeat. Bottom: Heartbeat state, defined in the Analysis profile as 
“Heartbeat > 400 bpm, with Downsampling= Mean value, Upsampling= Last value, 
Averaging interval =1”. For clarity, it was renamed to Heartbeat state: hb >400.

How to specify an external data variable “state”
1. Click the Add button next to the [data set name] state.
2. Under Select, choose the Downsampling method (default: Mean value) and 

the Upsampling method (default Last value).
3. Under Outlier filter, select the Averaging interval (default: 1). See 

Averaging interval in External data (resampled).
4. Under State threshold, specify that the state is scored when the Signal is:

▪ above (>=) or below (<=) a threshold value x.
▪ within a range (>= x1 and <= x2) or outside a range (<= x1 and >= x2).

Enter the thresholds you require.

5. Complete the procedure to add the variable.
6. Plot Integrated Data, or calculate the statistics.
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The resulting state (frequency and duration) is much dependent on what you 
choose as downsampling/upsampling methods.

Below: Effect of different upsampling methods on a state variable Temperature 
state. 1 Original temperature signal sampled every minute. 2-5 Variables resampled 
at 25 Hz. The state variable is scored when the resampled value is >= 30 ºC, using 
the methods Last value (2), Linear interpolation (3), Missing value (4), and Zero 
value (5). Note that Temperature state in cases 4 and 5 gives very short states 
(indicated by the arrows), because most of the data points in the corresponding 
Temperature resampled variable are missing or zeros, respectively. See the next 
picture for (4) and (5).

NOTE  When calculating states, if the sample with a valid variable value is followed 
by missing samples, EthoVision XT keeps the calculated value of the state for the 
next three missing samples. 

Below: Zoomed-in view of the previous picture for Temperature state upsampled 
with Missing value (4), and Temperature state upsampled with Zero value (5), 
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around 240 s. A state is scored when the resampled value is >= 30 ºC. For simplicity, 
Averaging interval = 1. When calculating states, if the value of the resampled 
variable is followed by missing values, like in Temperature - “Missing”, the calculated 
value of the state is kept for next 3 samples. This is the reason why the Temperature 
state - “Missing” around time 240 s lasts 4 samples (see 4). In the case of 
upsampling with Zero value, the state is assigned only to the current sample.

How to retrieve states from an imported signal
In the following example, the file containing the data set Phase with possible values 
1, 2 and 3 is imported: 
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If you want to retrieve the original states with their duration:

1. In the Analysis profile, define three Phase state variables, and rename them 
to, for example, Phase 1, Phase 2, and Phase 3. 

2. For each state variable, set the appropriate thresholds. For example, for 
Phase 1: Signal is <= 1.5.

3. Plot the variables to compare them with the original signal.
From top to bottom: original signal, resampled signal, states calculated using 
thresholds. Right: threshold for Phase 1.
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Custom Variables

▪ Free interval
▪ Multi condition
▪ JavaScript continuous
▪ JavaScript event
▪ JavaScript state

See also

▪ JavaScript custom variables
▪ Commands and functions for JavaScript variables
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Free interval
Definition
A segment of track from sample A to sample B, where A and B are determined by a 
time, the value of another dependent variable, a Trial Control event, or the value of a 
signal from a hardware device.

Use cases
Frequent cases:

▪ Group instances of behavior (e.g. Immobile) in a bout.
▪ Filter instances of behavior (e.g. Not moving) longer than one second.

See Examples of Free intervals in the Analysis profile

Calculation
A Free interval is defined by a Start criterion and a Stop criterion. Depending on 
whether and how often the criteria are met within a track, a Free interval may result 
in zero, one or more instances of the interval within the same track.

NOTE  Like all intervals defined with Nesting, a Free interval is left-closed [A, B). That 
is, the start sample A, not the stop sample B, is included in the analysis.

Multiple instances of the same interval definition

When you define a Free interval, this may result in zero, one or more (up to 2000) 
instances of an interval depending on where the Start and Stop criteria are met.

An instance of a free interval starts at the sample time when the Start criterion is 
met, and stops at the sample time when the Stop criterion is met.

A new instance is defined if the Start criterion and Stop criterion are met again, after 
the time in the track that the last Stop criterion was met.

NOTE  Multiple instances of the same free interval definition cannot overlap. An 
interval is NOT defined when its start criterion falls within a previous instance of the 
same interval definition. For example, you define a Free interval that starts when the 
subject enters zone A, to 10 seconds after that time. If a new instance of In zone A 
occurs before the end of the interval (see the green bar marked with 2 in the figure 
below), that instance of In zone is ignored.
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Similarly, if you define a Free interval that goes from track start to when the external 
data Heart rate > 400, then one interval is defined, from Track start to the time 
when Heart rate reaches 400 bpm for the first time. This because the “Track start” 
criterion is met once in each track, no matter how many times Heart rate reaches 
400 bpm.

Multiple free intervals in the Analysis profile

You can define multiple intervals in the Analysis profile, by repeating the procedure 
below. The interval definitions are independent of each other, therefore the 
resulting intervals may be overlapping.

To specify a Free interval
1. In the Analysis Profile, under Custom Variables, click the button next to 

Free Interval.
2. Under Start criterion select the starting point of the interval:

▪ Time. To select a time. For example, Track start (that is, the first 
sample in a track) or an Elapsed time after the track start (format: 
H:mm:ss.fff). For example 0:01:00.00 for one minute after the start. NOTE 
Track start corresponds to the first sample in the track (Recording time 
= 0.0), not the Trial time. For multiple-subject setups, Track start is the 
first sample of the animal detected first.

▪ Dependent Variable. To select the time that a dependent variable has 
a specific value. For example, Distance moved >= 1 m, or frequency of 
In zone >=10. This list also includes behaviors scored manually and 
external data. See Free interval based on a dependent variable
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▪ Trial Control. To select the time that an event in your trial control 
procedure occurs. For example, when a condition becomes true, or a 
command to a hardware device is given. See Free interval based on a 
Trial Control event 

▪ Hardware. To select the time that a Hardware-related variable has a 
specific value. For example, when the number of food pellets dropped 
by a Pellet Dispenser is greater than 10. This option is only available 
when hardware devices are defined in your experiment. See Free 
interval based on hardware

3. Under Stop criterion select the end point of the interval. See above for 
most of the options.
If you choose Time, and under Interval stop you choose Elapsed time, 
you have two options: after track start to stop the interval at a specific 
time after the track start (that is, the first sample in the track); after start 
event to stop the interval a specific time after the event selected as start 
criterion. Note that this “start event” is not the same as the start time of the 
resulting interval, if you set some time before the event (for example, 10 s 
before the frequency of In zone becomes 1). The “start event” is when the 
Frequency of In zone becomes 1. However, the interval starts 10 s earlier. 

4. Select Ignore last interval if incomplete to ignore the interval when the 
stop criterion is not met. If you do not select this option, and the stop crite-
rion is not met, EthoVision XT defines an interval up to the end of the track.

5. A free interval may occur once or more in a track (see above). To analyze 
each instance separately, select Calculate statistics per interval and enter 
the number of intervals you want to view in the results (1 to 2000). To be 
sure you to view all intervals, enter a large number that exceeds a maximum 
possible number of instances per track. See Restrictions in EthoVision XT
To analyze all instances as one, de-select Calculate statistics per interval.

6. Complete the procedure to add the variable. See Calculate statistics: 
procedure.

Notes
▪ Note the difference between Free Interval in the Analysis Profile (this topic) 

and Nesting over a Free interval in the Data Profile.
▪ Define a Free Interval in an Analysis Profile when you want to analyze 

the interval itself, not other dependent variables within that interval. For 
example to calculate the duration of an interval.

▪ Define a Free Interval in a Data Profile when you want to analyze any 
dependent variable within the resulting track segment. For example, to 
calculate the average velocity of the subject in the interval.
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▪ If a start criterion is not met in a track, EthoVision XT does not define the 
Free intervals in that track. 

▪ If a stop criterion is not met in a track, EthoVision XT does the following:
▪ If you selected Ignore last intervals if incomplete, it does not define 

the interval.
▪ If you did not select that option, it defines an interval up to the end of 

the track.
▪ Free intervals in multiple-subjects setups. A free interval is calculated for 

each subject separately, based on the data (dependent variables, behavior 
etc.) for that subject. See Free interval based on multiple subjects 

▪ Free intervals and missing samples. A free interval is not interrupted if one, 
two or three consecutive missing samples occur. With four or more 
consecutive missing samples, the current interval is interrupted and a new 
one starts when the Start criterion is met.

▪ Contiguous intervals. When two instances of a Free interval are contiguous, 
for example when the Interval Start criterion is supposed to be met 
immediately after the Interval Stop criterion for the previous instance is met 
(see Example 3 in Examples of Free intervals in the Analysis profile, where a 
track is split in segments of equal path length), one sample is always 
excluded between the end of an instance and the start of the next instance. 
For example, the first instance goes from time 0 (included) to sample 100 
(excluded), then from sample 101 (included) to sample 250 (excluded). 
Samples 100 and 250 are not included in the analysis. The reason is that the 
statistic used to find the start of the interval is updated one sample after 
the end of the previous interval.

More details

▪ Free interval based on a dependent variable
▪ Free interval based on a Trial Control event
▪ Free interval based on hardware
▪ Free interval based on multiple subjects
▪ Examples of Free intervals in the Analysis profile
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Free interval based on a dependent 
variable
Background
This topic contains details about defining a Free interval. For the main procedure, 
see Free interval.

NOTE  Dependent variable here also includes external data and manually-scored 
behaviors, not behaviors of Rat and Mouse Behavior Recognition.

To specify the dependent variable

In the Free Interval window, under Start criterion or Stop criterion, choose 
Dependent variable.

1. In the Start at / Stop at field, enter the time of the start (or stop) of the 
interval relative to the event described by the variable. 
EXAMPLE 1  To start an interval 1 s before the animal enters a zone, next to 
Start at enter 0:00:01:000 before event.
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EXAMPLE 2  To stop an interval 10 s after the total distance moved reached 
10 m, next to Stop at enter 0:00:10:000 after event.

2. From the Select variable list, choose the dependent variable. 
For example In zone if you want the interval to start or stop when the 
animal enters a zone for the nth time, or has spent a specific time in that 
zone.

3. From the Statistic list, choose the statistic of the dependent variable. For 
example: 
▪ Frequency if you want the interval to start/stop when the animal has 

entered a zone for the 10th time, 
▪ Cumulative Duration if you want the interval to start/stop when the 

animal has spent a specific total time in that zone.
See Statistic: When to use Frequency, Current, or others

4. Click the Settings button to specify the dependent variable more in detail.
For example, which zone the animal should enter to define the stop of the 
interval, or which body points should be in the zone. See Dependent 
Variables in Detail

5. Next to is:, specify which value the statistic should have to define the start/
stop of the interval, using the operators available (<=, >= or false/true).

Return to To specify a Free interval

Notes
▪ The following dependent variables are not available as start/stop criteria: 

Activity state, Acceleration state, and the behaviors of Rat or Mouse 
Behavior Recognition.

▪ A Free interval can only start at the time that, or before (not after) a variable 
reaches the specified value. Similarly, a Free interval can only end at the 
time that, or after (not before) a variable reaches the specified value.

▪ If you have imported external data in an experiment, you can define an 
interval based on the values of the resampled external data, not the original 
(imported) external data. Choose the external data from the Select variable 
list.
See External data (resampled) and Examples of Free intervals in the Analysis 
profile

▪ If you want to define a free interval based on two values of external data, 
for example Heart rate between 300 and 400 bpm) then do not use Free 
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intervals. Instead, use the dependent variable under External data in the 
Analysis profile.

Statistic: When to use Frequency, Current, or others
▪ Frequency. To define an interval that starts/stops when the animal has 

entered a zone or has shown certain behavior (Moving, Highly mobile, 
Grooming, etc.) a number of times.

▪ Current. To define an interval that starts/stops when a variable reaches a 
specific value. For discrete variables (state events or point events) like In 
zone, the Current statistic can be false or true. 
EXAMPLES

▪ For In zone, Current= true means that the interval starts/stop as soon 
as the animal enters the selected zone. Current= false means that the 
interval starts/stops as soon as the animal is outside the selected zone.

▪ For Velocity, Current >= 10 means that the interval starts/stops as soon 
as the animal’s velocity is higher then or equal to 10.

▪ Total. This is used especially with Distance moved. This makes the interval 
starts/end when the animal has covered a specific distance since the start 
of the track or the start of the interval.

▪ Cumulative Duration. To define an interval that starts/stops when the 
animal has been in a certain state (that is, within a specific zone, or in the 
state Highly mobile, etc.) for a specific total time since the start of the track 
or the start of the interval. It does not matter if the subject’s state was 
sometimes interrupted.
EXAMPLE  The interval starts when Cumulative duration of In zone >= 10 s. 
The green dot indicates where the interval starts.
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▪ Current Duration. To define an interval that starts/stop when the animal 
has been in a certain state (within a specific zone, or in the state Moving, 
etc.) for a specific time without interruption.
EXAMPLE  The interval starts when Current duration of In zone = 10 s. The 
green dot indicates where the interval starts.

▪ Latency to first. To define an interval that starts/stops when the time to 
the first instance of an event (for example, the animal being in a certain 
state or within a zone) has reached a specific value. Note that latency is 
always calculated from the start of the track.

How dependent variables are calculated to find the stop of an 
interval
Where in the track an interval ends depends on the value of the statistic of the 
dependent variable used. The following information applies to the statistics Total, 
Frequency, Current Duration, Cumulative Duration, and Latency to first. 

Once the start point of an interval is found, EthoVision XT resets the statistic at that 
point, and starting from the next sample time, updates its value until it matches the 
stop criterion.

▪ If the stop criterion is met, the interval is fully defined.
▪ If the value of the statistic does not match the stop criterion before the end 

of the track, the result depends on whether you select the option Ignore 
last interval if incomplete. See Free interval

EXAMPLE 1  The statistic Frequency for the dependent variable In Zone. A free 
interval is defined that ends when the Frequency of In zone is equal to 2. In the 
figure below, the green bars represent the time when the subject is in the specified 
zone (numbers indicate frequency). The green dots indicate when the Start criterion 
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is met (for sake of simplicity, it can be any criterion). The arrows represent the free 
intervals defined. The red circles show when the statistic Frequency for In zone is 
reset to zero.

EXAMPLE 2  The statistic Total for the dependent variable Distance moved. A 
recurring free interval is defined to split the track in segments of 100-inch distance 
moved. 

▪ Interval start: Dependent variable Distance moved, Statistic Total >= 0.
▪ Interval stop: Dependent variable Distance moved, Statistic Total >= 100.

When the second, third, etc. interval starts, the total Distance moved is reset to zero 
(see the red circles) and updated, starting from the next sample time, until the Stop 
criterion is met.
1142



Other statistics

For other statistics like Current (for example In zone or Not in zone) EthoVision XT 
evaluates the value at the current sample, and checks that the Stop criterion is met.
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Free interval based on a Trial Control 
event
Background
This topic contains details about defining a Free interval. For the main procedure, 
see Free interval.

To specify the Trial Control event

In the Free Interval window, under Start criterion or Stop criterion, choose Trial 
Control and select the following:

1. In the Start at / Stop at field, enter the time of the start (or stop) of the 
interval relative to the Trial Control event specified in the next steps. 
EXAMPLE 1  To start an interval 1 s before a Trial Control condition becomes 
true, next to Start at enter 0:00:01:000 before event.

EXAMPLE 2  To stop an interval 10 s after the Trial Control action “Drop 
pellet”, next to Stop at enter 0:00:10:000 after event.

2. From the Occurrence list, select which occurrence should mark the start of 
the interval (1st to 9th).
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Select 1st if you want to define an interval from the first time that a trial 
control event occurs. Select 2nd, etc. when the trial control event occurs 
repeatedly, for example in sub-rules.

3. From the Element list, select the trial control category (condition, action, 
sub-rule, etc.).

4. From the Event list, select the event. The options differ depending on the 
Element chosen.
▪ For actions, sub-rules: becomes active/inactive. 
▪ For conditions: becomes active/inactive, and becomes true/false.
▪ For sub-rule references: becomes active/inactive, and makes sub-

rule active/inactive. 
Return to To specify a Free interval

Notes
▪ A Free interval can only start at the time that, or before (not after) a Trial 

Control event occurs. Similarly, a Free interval can only end at the time that, 
or after (not before) a Trial Control event occurs.

See also

▪ For information on the meaning of active/inactive, false/true, see How the 
trial control instructions are executed. 

▪ For information on sub-rules and analysis of trial control data, see the 
EthoVision XT 18 - Trial and Hardware Control - Reference Manual.

Difference between Free Intervals based on Trial Control and 
Nesting over a Trial Control state
With Free intervals you can select the same track segments that you can define with 
Nesting over a Trial Control state in the Data profile. The main differences are that:

▪ With a Free interval, you can also specify the number of occurrences of an 
event in the Interval start criterion. For example, define an interval that 
starts when an action is carried out the 3rd time. With Trial Control state 
that is not possible. There, you can only specify the number of occurrences 
in the Interval stop criterion.

▪ With a Free interval, you can combine Trial Control events with other criteria 
(time, dependent variable values, hardware log values). For example, define 
an interval that goes from the time a light switches on, to 1 minute after 
that time.
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Free interval based on hardware
Background
This topic contains details about defining a Free interval. For the main procedure, 
see Free interval.

To specify the hardware state or value

In the Free Interval window, under Interval start or Interval stop, choose 
Hardware and select the following:

1. In the Start at / Stop at field, enter the time of the start (or stop) of the 
interval relative to the Hardware event specified in the next steps. 
EXAMPLE 1  To start an interval 1 s before the PhenoTyper’s white light 
switches on, next to Start at enter 0:00:01:000 before event.

EXAMPLE 2  To stop an interval 10 s after a pellet was dropped, next to Stop 
at enter 0:00:10:000 after event.

2. From the Select device type list, choose the type of device you want to 
use.

3. From the Select name list, select the name of the device of the chosen 
type. The names in this list have been assigned to that device type in the 
Arena - Hardware mapping window in the Arena Settings.
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4. From the Select signal/command list, select the variable or the command 
you are interested in.

5. From the Signal value list, choose which value the signal should have to 
define the start/stop of the interval, using the operators available (<=, >= 
or false/true).

Return to To specify a Free interval

Notes
▪ The Cumulative value option is available for numerical variables like 

Number of pellet drops, Number of licks, Duration of licks, or counts (for 
example, Input 1 L->H count).

▪ When Cumulative value is selected, hardware events are summed up 
and EthoVision “remembers” that at any time. Keep this option 
selected if, for example, you want to start an interval when the Signal 
value is >= 10.

▪ When Cumulative value is not selected, each hardware event is a state 
that lasts one sample time (for example, 0.04 s if the sample rate is 25). 
At any time, EthoVision does not “know” how many events have 
occurred up to that time. De-selecting Cumulative value provides 
results when the Signal value selected is 1. De-select Cumulative 
value when you want to specify multiple intervals, for example for each 
time a pellet is dropped. 

▪ The options under Interval start and Interval stop are based on the 
Hardware state dependent variable. For more information, see also 
Hardware state under Analysis of Trial Control data in the EthoVision XT 
18 - Trial and Hardware Control - Reference Manual. 
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See also

▪ The EthoVision XT 18 - Trial and Hardware Control - Reference Manual. To 
open this manual, on the Windows Apps screen choose Noldus > 
EthoVision XT 18 Other documentation.
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Examples of Free intervals in the Analysis 
profile
For all the examples below, define the interval first, then choose Analyze > Results 
to calculate the statistics or visualize the results. See Free interval

TIP  If you want to define a free interval, to further analyze the events within that 
interval, choose Nest over a Free interval in the Data profile.

Examples
▪ Example 1: From the track start to when the subject is in a zone for a 

specific time
▪ Example 2: From the start of a conditioning routine to when 10 rewards are 

given to the subject
▪ Example 3: Split a track in segments of a specific path length
▪ Example 4: Detect bouts of a behavior
▪ Example 5: From the track start to when external (physiological) data reach 

a specific value
▪ Example 6: Filter the instances of a behavior longer than a certain time

Example 1: From the track start to when the subject is in a zone 
for a specific time

Aim

This Free interval can be used, for example:

▪ Exploratory behavior. Calculate the time that the subject takes to explore 
the novel object for at least 30 s (Cumulative duration).

▪ Learning. Calculate the time me that the animal takes to stay in a zone for 
30 s uninterrupted (Current duration).

Solution

Define a Free interval with:

▪ Start criterion: Track start
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▪ Stop criterion: Dependent variable In zone. The Statistic depends on the 
type of question you want to answer.
In the Novel object test, you want to stop the interval when the subject has 
explored the object for a total of 30 s. Choose then Cumulative duration.

In the learning example, you want to stop the interval when the subject 
enters a zone and stays for 30 s without exiting. Choose then Current 
duration.

Example 2: From the start of a conditioning routine to when 10 
rewards are given to the subject

Aim

In a conditioning experiment, the subject has to stay in a specific zone to obtain a 
food pellet. The action-reward sequence is repeated a number of times in a subrule. 
The researcher wants to know how long it took the subject to get 10 rewards. 

Solution

Create a Free interval with:

▪ Start criterion: Trial Control. Element: Subrule. Event: becomes active.
▪ Stop criterion: Hardware. Device type: Pellet dispenser. Select signal: 

Number of drops >=10. The option Cumulative is selected.

Example 3: Split a track in segments of a specific path length

Aim

Suppose you want to split your tracks in segments of a specific distance moved by 
the subject, for example 1 m, and you want to calculate the duration of each 
segment. 

Solution

Create a Free interval with:

▪ Start criterion: Dependent variable Distance Moved. Statistic: Current ≥ 0 
cm.

▪ Stop criterion: Dependent variable Distance Moved. Statistic: Total ≥ 100 cm.
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To calculate the duration of individual instances, select Calculate statistics per 
interval and enter a number that exceeds the maximum number of interval per 
track.

Below: Plot 1: Per-sample distance moved. Plots 2: Free interval that runs from 
Current Distance moved >=0 to Total Distance moved >=100 cm. Note that the 
faster the animal (i.e. the longer the per-sample distance moved), the shorter the 
resulting interval.

Example 4: Detect bouts of a behavior

Aim

Calculate the number and duration of bouts of a behavior, for example Movement or 
Activity. The single instances of Movement being part of a bout may be separated 
by up to time tmax. In the example below, instances 1 to 5 are grouped in a bout.
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Solution

Create a free interval with:

▪ Start criterion: Dependent variable Movement with state Moving. Statistic: 
Current.

▪ Stop criterion: Dependent variable Movement with state Not moving. 
Statistic: Current Duration ≥ 5 s (tmax). This ensures that the interval ends 
when the animal has not moved for five seconds without interruption. 

In the Trial Statistics tab of the same window, select Mean if you want to know the 
average duration of a bout. 

NOTES

▪ Because each free interval also includes tmax (see the length of the orange 
bars in the figure above, which represent the free intervals), you have to 
subtract that time to obtain the true average duration.

▪ If the event which specifies the end of a bout (in this example, Not moving 
for at least 5 seconds) is never found, the result for that trial is that there is 
no bout at all. The result is one long bout if you de-select the option Ignore 
last interval if incomplete.

▪ For the same reason as described above, if the Stop criterion is not met, the 
last bout of a trial is not detected. For example, when the time between the 
start of Not moving and the end of the trial is less than tmax. You can have 
the last bout detected by selecting the option Ignore last interval if 
incomplete, but the duration of this bout is truncated.

Example 5: From the track start to when external 
(physiological) data reach a specific value

Aim

To calculate the time that it takes for a physiological variable (e.g. heart rate) to 
reach a specific value.
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Prerequisite

The physiological variable has been imported in the trial. See External Data

Solution

Create a Free interval with:

▪ Start criterion: Track start
▪ Stop criterion: Dependent variable Hear rate. The Statistic chosen is Current.

If necessary, click Settings and choose how to re-sample the variable from 
the original signal. See External data (resampled)

The result is shown in the first plot below, together with the plot of Heart rate. 
Choose Analysis > Results > Statistics and Charts to obtain the length of the free 
interval.
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TIP   If you want to analyze the time between two values of external data, for 
example from Heart rate = 300 to Heart rate = 400, then in the Analysis profile 
choose External data (state) instead, not Free interval.

Example 6: Filter the instances of a behavior longer than a 
certain time

Aim

In this example we want to filter the behavioral states (e.g. Not Moving). We want to 
remove the instances of Not Moving that last less than 1 second.

Solution

1. In the Analysis profile create a free interval with Movement as a criterion.  
▪ Start Criterion: Select Dependent variable. 
▪ Start at: Enter there the minimum time duration. In this example, 1 s.
▪ Select variable: choose the behavior. In this example, Movement.
▪ Statistic: Current Duration. 
▪ Settings: Define the behavior state. In this example, Not Moving is 

chosen, based on thresholds Start velocity 2.0 cm/s and Stop velocity 
1.5 cm/s.

▪ Stop criterion: The main difference from the Start criterion is that you 
must select the opposite of the behavior above. In this example, under 
Settings, Moving is selected with the same thresholds as above, and 
the Statistic is Current; then select true. Next to Stop at, leave 0.0 
selected.
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2. In the Integrated Visualization you can check if the free interval works as 
expected. 
▪ The first plot shows the typical Movement variable, with the two states 

Moving and Not Moving).
▪ The second plot is that of the free interval defined above. It plots the 

instances of Not Moving longer than 1 s, while ignoring the shorter 
instances.

3. Calculate the statistics of the free interval.
TIP  In the interval definition, select Calculate results for interval 1 to ... if you 
want results for each instance of the filtered behavior. On the Trial Statistics tab, 
choose the statistic that you need:
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▪ Choose Frequency to know how many instances of the filtered 
behavior occur.

▪ Choose Latency to first to know at what time that behavior occurs, for 
each instance. 

See also

▪ Free interval based on a dependent variable
▪ Free interval based on a Trial Control event
▪ Free interval based on hardware
▪ Free interval based on multiple subjects
▪ Analysis advisor
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Free interval based on multiple subjects
Procedure
When working with multiple subjects per arena, you can define free intervals in two 
ways:

▪ Under Nesting, choose Free interval to define a Free interval for each 
subject separately. The interval is based on the behavior of that subject, not 
the other(s). 
As a result, for each subject a specific time period is selected.

▪ Under Nesting over Subjects, choose Free interval to define an interval 
based on a combination of conditions based on two or more subjects. The 
resulting interval is applied to all subjects.
As a result, the same time period is selected for all subjects.

Example
Your arena contains two subjects. A free interval is defined that goes from Total 
Distance moved >= 100 to Total Distance moved >=200.

▪ If you choose Free interval from Nesting, the start/stop criteria are applied 
per subject, resulting in most cases in different time periods being analyzed 
for each subject.
Below: Time plot of a dependent variable (in this example, Distance moved) 
after defining the Free interval from Nesting. Different time periods are 
analyzed for Subject 1 (from A1 to B1) and Subject 2 (from A2 to B2).

▪ If you choose Free Interval from Nesting over Subjects, the start/stop 
criteria are applied per subject, but the interval are defined after combining 
the criteria based on what is selected in the Actors tab.
Below: Time plots of a dependent variable (in this example distance moved) 
after defining a Free interval from Nesting over Subjects (compare with 
the previous figure). Depending on what is selected in the Actors tab:
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▪ With All selected subjects (top). The time period shared between 
subjects (from A1 to B2).

▪ With Any selected subject (middle). The time period defined by at 
least one subject (from A2 to B1).

▪ With one subject selected (bottom). The time period defined by the 
criterion met by that subject (in this example, subject 2; therefore, from 
A2 to B2).
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Multi condition
Definition
A segment of track that corresponds to the combination of the value of one, two or 
more dependent variables.

Use cases
▪ In Trial Control: Stop the trial when exploration time reaches a specified 

value. 
In a Novel object test, stop the trial when the exploration of an object 
reaches 30 seconds. Exploration is defined as (a) Nose point in the zone 
“object sniffing zone”, and (b) Head direction pointing to the “object 
sniffing zone”. When the total time that (a) and (b) are simultaneously true 
reaches 30 s, stop the trial.

TIP  Define this condition in the Trial Control Settings.

▪ In Analysis: Calculate the time that the animal swims pointing to the 
platform.
In a probe trial of the Morris water maze test, the subject swims for a 
number of seconds around the platform. You want to know how long the 
animal points to the platform while it is swimming. This can be translated to 
(a) Heading to platform less than a user-define angle (for example 10 
degrees) and (b) Velocity higher than a user-define value (for example 10 
cm/s). TIP  Define this in the Analysis profile.

Calculation
The track segments are defined for each condition independently. Then, the track 
segments are combined according to the logic specified (All conditions true = AND; 
Any condition true = OR).

Below: The variable Multi condition marks the time when the animal swims towards 
the platform with a certain speed. Here the multi condition is defined with three 
conditions: (1) Heading to platform less or equal than +15 degrees; (2) Heading to 
platform greater than -15 degrees; (3) Velocity greater than 10 cm/s. Conditions are 
combined with All conditions true. The first plot shows Multi condition; the second 
Heading to point (center of the platform), with both negative and positive values; 
the third plot Velocity.
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To specify a Multi-condition
1. In the Analysis profile, under Custom Variables, click the button next to 

Multi condition.
2. Click the Add button at the right of Add conditions.
3. Choose the variable from the Select variable list.
4. To specify further options, click Settings. Next, specify which values (or 

range of) make the condition true.
5. Click OK. The condition is added to the list.
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6. Repeat the steps 2-5 to add more conditions.
7. Combine the conditions with All conditions are true (AND logic) or Any 

condition is true (OR logic).
8. Complete the procedure to add the variable. See Calculate statistics: 

procedure.

Notes
▪ To define a Multi condition you can use continuous variables, like Distance 

moved, and state variables, like In zone (excluding Activity state and 
Acceleration state). 

▪ Variables that are not available are: variables representing points in time, 
like Rotation, Zone transition, Zone alternation; behaviors of Behavior 
Recognition, and behaviors scored as point events are not available.

▪ To edit a condition, select that condition in the list and click Edit. To delete a 
condition, click that condition and click Delete.

See also

▪ For how to use a Multi condition in Trial Control, see the EthoVision XT 18 - 
Trial and Hardware Control - Reference Manual.

▪ To analyze the track segments based on the Multi condition, see Nesting 
over a Multi condition in the Data profile.
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JavaScript custom variables
Aim
To expand EthoVision XT’s analysis capabilities by introducing calculations, custom 
expression, and search functions in JavaScript code embedded in EthoVision XT.

There is a wide range of questions that can be answered with custom JavaScript 
variables. Here we list a few examples:

▪ Calculate the average of coordinates x and y of a number of subjects.
▪ Calculate the number of subjects present in a zone.
▪ Find the body length of an animal by taking the distance between the nose-

point and the tail-base point.
▪ Calculate the nearest neighbor distance in a school of fish.
▪ Recalculate the coordinates of a subject based on a reference point.
▪ Calculate the running average of a variable.
▪ Find the time when the animal reaches 80% of correct choices in a learning 

test.
▪ Create bins of velocity and assign each sample to one of them depending 

on the speed of the subject.
You can find JavaScript variables ready to use on the EthoVision XT 18 Installation 
package, under Drivers and tools\JavaScript custom variables. You can also find 
the variables on GitHub:

https://github.com/noldus/EthoVision-JavaScriptCustomAnalysis

Simply copy the code to the JavaScript window in an Analysis profile of EthoVision 
XT (see below). You can often customize the code by adjusting specific parameters.

Calculation
When you define JavaScript code in EthoVision XT, the software considers the data 
available at sample Sk and produces a value JSk (numeric, or boolean) based on the 
JavaScript code specified. 
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In the figure above, Sk represents a generic sample, which contains not only the x,y 
coordinates of the subjects but also their body area, elongation and mobility at the 
current time. You can extract a lot of information and process it in the code. 

The output values can be in one of three formats:

▪ A rational number, like the average of speed of three subjects. This is an 
example of JavaScript continuous variable.

▪ A point event, like the event that occurs when a certain variable reaches the 
threshold of 80%. This is an example of a JavaScript event variable.

▪ A state event, like the time that a variable stays above a certain threshold. 
This is an example of a JavaScript state variable.

Remember that the JavaScript code outputs one or more values (depending on the 
code) per sample. Those values are used to calculate Trial statistics and Group 
statistics just like any other dependent variable; for example, the average and the 
standard deviation.

Procedure
1. Open your Analysis profile.
2. Choose of the three options: JavaScript continuous, JavaScript event, 

JavaScript state.
3. Insert the code in the window that appears.
4. Run analysis as usual.
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JavaScript continuous
Definition
A custom variable that processes raw data (for example, the subject coordinates, or 
the distance moved) and produces a numeric value for each sample of the track, 
based on an algorithm.

The JavaScript continuous variable outputs a rational number; other solutions are 
possible with JavaScript state (with a duration) and JavaScript event (with no 
duration). See Commands and functions for JavaScript variables

Use Cases
▪ Subject counter. Count the number of subjects currently present in a zone. 

For example: How many fish swim at the top of the tank? How many fruit 
flies enter each side of the T-maze?

▪ Subject counter. Calculate the ratio between the number of subjects in zone 
A to the number of subjects in zone B.

▪ Body length. Calculate the body length as the distance of the nose-point to 
the tail-base point.

▪ Tail beat detector. Calculate the ratio between the distance moved by the 
tail-base and the distance moved by the center-point. This helps quantify 
tail beats in fish.

▪ TIP  Browse to my.noldus.com, log in or register and choose Downloads > 
EthoVision XT > Drivers and tools. There you can download examples of 
JavaScript continuous variables. Simply copy the code to the JavaScript 
Continuous window in EthoVision XT (see below).

To specify a JavaScript continuous variable
1. In the Analysis profile, under Custom Variables, click the button next to 

JavaScript continuous.
2. In the JavaScript Continuous window, enter the code you require. 

IMPORTANT  Always specify the following functions: Start(), Stop() and 
Process(), even when they do not include code lines. See the figure above 
as an example.

3. Click Check to see if there are syntax errors. Note that this check is not 
thorough and does not guarantee that the code provides meaningful data.
1164



4. Complete the procedure to add the variable. See Calculate statistics: 
procedure

Notes
▪ When you use functions like GetCenter, the coordinates are given in 

millimeters no matter what your measurement units is selected in the 
Experiment Settings. Therefore, all calculations based on coordinates are 
given in millimeters. If your calibration is done in cm, divide the results by 
ten; similarly, values of subject area obtained with the function GetArea are 
in mm2.

▪ Select a Number of outputs other than 1 if the JavaScript variable is made 
of two or more outputs. For example, suppose your code creates three state 
outputs for b1, b2, b3:
SetOutput(0, b1);

SetOutput(1, b2);

SetOutput(2, b3);

Then select 3 as Number of outputs. The value of each output is updated 
at each sample.

▪ JavaScript is not the same thing as Java. Although the two programming 
languages may show similarities in the syntax, there are profound 
differences, for example in the rules that govern how variables and 
functions work.

▪ EthoVision XT uses the Internet Explorer 11-compatible JavaScript engine. 
This engine does not support the following features:
▪ Strict equality operators, for example '===' or '!=='.
▪ Class expression (classes are only available through function 

expressions).
▪ Arrow function expression. 
▪ Fill for arrays.
▪ the Math.hypot function.

See also

▪ JavaScript event
▪ JavaScript state
▪ Commands and functions for JavaScript variables
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JavaScript event
Definition
A custom variable that processes raw data (for example, the subject coordinates, or 
the distance moved) and produces a point event (i.e., with no duration) for each 
sample of the track, based on an algorithm.

Use cases
▪ Zone visits detector. For example, detect when the subject has visited 80% of 

the zones. Use the event to calculate the latency of that event.
▪ TIP  Browse to my.noldus.com, log in or register and choose Downloads > 

EthoVision XT > Drivers and tools. There you can download an example 
of a JavaScript event variable that detects when a subject has visited a 
specific percentage of zones. Simply copy the code to the JavaScript Event 
window and follow the instructions (see below).

Calculation
The main difference with the JavaScript continuous variable is that the value 
specified in SetOutput() is either 0 or 1 and has no duration. 

See JavaScript continuous > Calculation

How to specify a JavaScript event variable
1. In the Analysis profile, under Custom Variables, click the button next to 

JavaScript event.
2. Follow the rest of the procedure in JavaScript continuous > To specify a 

JavaScript continuous variable.

Notes
▪ In the Trial Statistics tab, select Latency to First to calculate the latency of 

the event. Latency of a dependent variable is calculated from the start of 
the track, even when you define time bins and nesting intervals.

See also

▪ JavaScript continuous
▪ JavaScript state
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▪ Commands and functions for JavaScript variables
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JavaScript state
Definition
A custom variable that processes raw data (for example, the subject coordinates, or 
the distance moved) and produces a state (on/off) value for each sample of the 
track, based on an algorithm.

Use cases
▪ Velocity bins. Get the per-sample values of velocity and create velocity bins, 

for example from 0 to 100 mm/s, from 100 to 200 mm/s etc. 

▪ Aggregation detector. Calculate the number of subjects present in a zone 
and set the output of the variable to 1 if the number of subjects exceeds a 
certain threshold. Use this variable for example to calculate the time that 
more than 50% of the subjects cluster in one zone.

▪ TIP  Browse to my.noldus.com, log in or register and choose Downloads > 
EthoVision XT > Drivers and tools. There you can download examples of 
JavaScript state variables. Simply copy the code to the JavaScript State 
window and follow the instructions (see below).

Calculation
The main difference with the JavaScript continuous variable is that the value 
calculated per sample and specified in SetOutput() is either 0 or 1. The variable has 
a duration based on the total number of 1s in the track or selected track segment.

See JavaScript continuous > Calculation

How to specify a JavaScript state variable
1. In the Analysis profile, under Custom Variables, click the button next to 

JavaScript state.
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2. Enter the code in the JavaScript State window. 
3. Next to Number of outputs, select the number of possible states of the 

variable. For example, in the Velocity example described above, select 4.
4. Follow the rest of the procedure in JavaScript continuous > To specify a 

JavaScript continuous variable.

Notes
▪ In the Trial Statistics tab, select Cumulative Duration to calculate the total 

time that the state variable is “on”.

See also

▪ JavaScript continuous
▪ JavaScript event
▪ Commands and functions for JavaScript variables
1169



Commands and functions for JavaScript 
variables
Aim
In this topic you find the commands and functions that you can use to extract 
process tracking data with JavaScript code. 

Get started
We assume that you have basic knowledge about JavaScript. To get started with 
JavaScript we recommend this online compiler:

https://repl.it/languages/javascript

Many courses on the internet concern JavaScript for web page developers. An 
excellent course more focused on JavaScript as a data processing tool can be found 
here:

https://www.youtube.com/watch?v=Bv_5Zv5c-Ts

Extract subject features
Use the functions below to extract the position and other features of your subjects.

▪ GetCenter, GetNose, GetTail
▪ GetSubjectCenter, GetSubjectNose, GetSubjectTail
▪ GetArea, GetChangedArea
▪ GetSubjectArea, GetSubjectChangedArea
▪ GetElongation
▪ GetSubjectElongation
▪ GetViewDirection
▪ GetSubjectViewDirection

Extract other data
▪ GetSampleTime
▪ GetPixelChange
▪ GetDistanceToZone
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▪ GetDistanceToPoi
▪ GetBehaviorEvent
▪ GetCommand
▪ GetSignal
▪ new Point
▪ GetPointPoi

Query data
Use the functions below to ask simple questions, like Is the subject in the central 
zone? The software gives a boolean answer (true/false).

▪ IsInZone (discontinued)
▪ IsSubjectCenterInZone, IsSubjectNoseInZone, IsSubjectTailInZone
▪ IsPointInZone
▪ Point.Equals
▪ IsSubjectActor

Calculate
▪ Distance
▪ Point.Distance
▪ TurnAngle
▪ Heading
▪ SetOutput
▪ SetOutputMissing

GetCenter, GetNose, GetTail
Returns the x,y coordinates of the center-point, nose-point or tail-base point of the 
subjects in a single-subject trial, respectively. Use this function in a single-subject 
experiment, or in a multi-subject experiment to extract the body points of the focal 
subject.

▪ SYNTAX

GetCenter()

GetNose()
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GetTail()

▪ EXAMPLE 1
In the following example, the code verifies if the center point of the subject, 
when found, is in the zone named Zone 1.

const g_Zone = "Zone 1";

(...)

function Process()

{

   var ptC = GetCenter();

   if (ptC)

   {

      g_bInZone = IsInZone(g_Zone, ptC);

   }

▪ EXAMPLE 2
In the following example, we calculate the average x coordinate of the 
center point and the nose point.

var ptC = GetCenter(); 

var ptN = GetNose();

var x_avg = ptC.x + ptN.x;

GetSubjectCenter, GetSubjectNose, GetSubjectTail
Returns the x, y coordinates of a body point of a specific subject in a multi-subject 
experiment. You can use this function to compare the position of different subjects 
in the same JavaScript variable.

See also the sample experiment Subject Counter with JavaScript code XT160, which 
you can find on my.noldus.com, under Downloads > EthoVision XT > Drivers and 
tools.

▪ SYNTAX

GetSubjectCenter(Subject name)

GetSubjectNose(Subject name)

GetSubjectTail(Subject name)

▪ ARGUMENTS

Subject name: the name of one of the subjects as defined in the Experiment 
Settings.

▪ EXAMPLE

In the following loop (not shown entirely), the center point of each subject 
is loaded in the variable pt.
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const g_aSubjects = ["Subject 1", "Subject 2", "Subject 3", ... ]

(...)

for (i = 0; i < g_aSubjects.length; ++i) 

{

   var pt = GetSubjectCenter(g_aSubjects[i]);

(...)

Note that g_aSubject.length function gets the length of the array variable 
g_aSubjects which contains the names of the subjects. The variable 
g_aSubjects is defined at the top of the script.

GetArea, GetChangedArea
Returns the current value of the subject’s area (in practice, the yellow blob that you 
see during tracking), and the area that has changed from the previous sample, 
respectively. Use these functions for

▪ The subject in a single-subject experiment.
▪ The focal subject in a multi-subject experiment. Here “focal” refers to the 

subject for which the statistics are calculated.

Areas are expressed in internal units (mm2), independent of the units selected in the 
Experiment Settings. For information on the Changed area, see Mobility.

▪ SYNTAX

GetArea()

GetChangedArea()

▪ EXAMPLE

var a = GetArea();

var ca = GetChangedArea();

▪ NOTES

GetArea and GetChangedArea are not available when using Deep learning 
with two subjects per arena, because this method does not record the 
subjects’ body contour.

GetSubjectArea, GetSubjectChangedArea
GetSubjectArea returns the current value of the area of a specified subject in a 
multi-subject experiment. 

GetSubjectChangedArea returns the area of the subject in a multi-subject 
experiment that has changed from the previous sample. For information on the 
Changed area, see Mobility.
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The subject’s area is the area of the yellow blob that you see during tracking. It is 
expressed in internal units (mm2), independent of the units selected in the 
Experiment Settings.

▪ SYNTAX

GetSubjectArea(“subject name”)

GetChangedArea(“subject name”)

where Subject name is the name of the subject specified in the Experiment 
settings.

▪ EXAMPLE 1
var a = GetSubjectArea(“Subject 1”);

▪ EXAMPLE 2
// This for loop extracts the area for a number of subjects 

for (i = 0; i < g_aSubjects.length; ++i)

             {

   var AreaSubj = GetSubjectArea(g_aSubjects[i]);

   ...

}

▪ NOTES

GetSubjectArea and GetSubjectChangedArea are not available when using 
Deep learning with two subjects per arena, because this method does not 
record the subjects’ body contour.

GetElongation
GetElongation returns the current value of Body elongation for

▪ The subject in a single-subject experiment.
▪ The focal subject in a multi-subject experiment. Here “focal” refers to the 

subject for which the statistics are calculated.
It is expressed as a number between 0 and 1. To obtain the same as the dependent 
variable Body elongation, multiply it by 100.

▪ SYNTAX

GetElongation()

▪ EXAMPLE

var y = GetElongation();

if (y != null)
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{

   SetOutput(y*100);

}

else

{

   SetOutputMissing();

}

▪ NOTES

GetElongation is not available when using Deep learning with two subjects 
per arena, because this method does not record the subjects’ body contour.

GetSubjectElongation
Returns the current value of Body elongation for a specified subject in a multi-
subject experiment. It is expressed as a number between 0 and 1. To obtain the 
same as the dependent variable Body elongation, multiply it by 100.

▪ SYNTAX

GetSubjectElongation(“Subject name”)

where Subject name is the name of the subject specified in the Experiment 
settings.

▪ EXAMPLE

// This for loop extracts the body elongation for a number of subjects

for (i = 0; i < g_aSubjects.length; ++i)

             {

   var EloSubj = GetSubjectElongation(g_aSubjects[i]);

...

}

▪ NOTES

GetSubjectElongation is not available when using Deep learning with two 
subjects per arena, because this method does not record the subjects’ body 
contour.

GetViewDirection
Returns the current value of the Head direction variable for

▪ The subject in a single-subject experiment.
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▪ The focal subject in a multi-subject experiment. Here “focal” refers to the 
subject for which the statistics are calculated.

It is expressed in radians. Note that the Head direction dependent variable provided 
by EthoVision XT is expressed in degrees. To convert your JavaScript variable to 
degrees, see the example below.

▪ SYNTAX

GetViewDirection()

▪ EXAMPLE

var dir = GetViewDirection();

If you want to extract the head direction in degrees, convert the value of 
head direction to degrees with the following formula:

function toDegrees(angle) 

{

  return angle * (180 / Math.PI);

}

(...)

var dir = GetViewDirection();

angle = toDegrees(dir);

▪ NOTES

GetViewDirection is not available when using Deep learning with two 
subjects per arena, because this method does not record the subjects’ head 
direction.

GetSubjectViewDirection
Returns the value of the Head direction of a specified subject in a multi-subject 
experiment, for the current sample. The value is given in radians. Note that the 
Head direction dependent variable provided by EthoVision XT is expressed in 
degrees. To convert your JavaScript variable to degrees, see the example in 
GetViewDirection.

▪ SYNTAX

GetSubjectViewDirection(“subject name”)

where Subject name is the name of the subject specified in the Experiment 
settings.

▪ EXAMPLE

// This for loop extracts the Head direction in radians for a number of 
subjects

for (i = 0; i < g_aSubjects.length; ++i)
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             {

   var HDirSubj = GetSubjectViewDirection(g_aSubjects[i]);

...

}

▪ NOTES

GetSubjectViewDirection is not available when using Deep learning with 
two subjects per arena, because this method does not record the subjects’ 
head direction.

GetSampleTime
Returns the sample time (in seconds) of the sample currently processed. You can 
use this function to calculate the latency of an event that you cannot obtain through 
the other dependent variables.

NOTE  The sample time in this function is the track time, that is, the time elapsed 
from the start of the track (the first sample), not the start of the trial.

▪ SYNTAX

GetSampleTime()

▪ EXAMPLE

The following example outputs the value of the current sample time. If it is 
not found, a missing value is assigned with the SetOutputMissing 
command (see below).

function Process()

{

   var st = GetSampleTime();

   if (st!= null)

   {

      SetOutput(st);

   }

   else

   {

      SetOutputMissing();

   }

GetPixelChange
Returns the current proportion of pixels in the arena that have changed intensity 
above the specified Activity threshold from the previous video frame. This 
proportion can be between 0 (no pixel in the arena has changed intensity value 
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above the threshold) and 1 (all pixels in the arena have changed intensity value 
above the threshold). A pixel change value of 0.156 (expressed as proportion) 
corresponds to an Activity value without smoothing of 15.6%.

To use this variable, you must select Activity analysis in the Experiment Settings and 
define the threshold value in Activity settings in the Detection settings. For 
information on the pixel change, see Activity.

▪ SYNTAX

GetPixelChange()

▪ EXAMPLE

var a = GetPixelChange();

GetDistanceToZone
Returns the distance of a (body) point from a zone. The distance is zero if the body 
point is within the zone. Distances are expressed in internal units (mm), 
independent of the units selected in the Experiment Settings.

▪ SYNTAX

GetDistanceToZone(Zone, Point)

▪ ARGUMENTS

Zone: the name of the zone as it appears in the Arena Settings; e.g. 
“Platform”.

Point: the name of the point; usually a body point.

▪ EXAMPLE

const g_strZone = "Object";

(...)

function Process()

{

   var ptNose = GetNose();

   var dist = GetDistanceToZone(g_strZone, ptNose);

GetDistanceToPoi
This is similar to GetDistanceToZone; it returns the distance from the specified point 
of interest. Distances are expressed in internal units (mm), independent of the units 
selected in the Experiment Settings. 

▪ SYNTAX

GetDistanceToPoi(Point of interest, Point)
1178



▪ ARGUMENTS

Point of interest: the name of the point of interest as it is defined in the 
Arena Settings.

Point: the name of the point to which distance is determined; usually a body 
point.

GetBehaviorEvent
This command returns the value of an event scored manually using the Manual 
Scoring function. If you work with Live Mouse Tracker, this command also works 
with the events listed under Raw Live Mouse Tracker data in the Analysis profile.

▪ SYNTAX

GetBehaviorEvent(behavior)

GetBehaviorEvent(behavior, receiver)

▪ ARGUMENTS

Behavior: The name of the behavior as in the Manual Scoring Settings or 
listed under Raw Live Mouse Tracker data in the Analysis profile.

Receiver (optional): The name of the receiver, in case of multi-subject 
tracking.

▪ RETURN VALUES

undefined: no behavior event

1: start of a state event

2: stop

4: point event

▪ EXAMPLE

The following code gets the values of the behavior Sleep that was scored. 
The function UpdateState at the top copies the values of Sleep, 1 or 2 to a 
new state variable g_bState with values true or false, respectively.

var g_bState = false;

function UpdateState(evt)

{

   if (evt != undefined)

   {

      if (evt == 1)

      {
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         g_bState = true;

      }

      else if (evt == 2)

      {  

         g_bState = false;

      }

   }

}

function Process()

{

   var evt = GetBehaviorEvent("Sleep");

 

   UpdateState(evt);

    

   SetOutput(g_bState);

}

GetCommand
Returns the event that represent a command to a hardware device.

▪ SYNTAX

GetCommand(Device name, Command name)

▪ ARGUMENTS

Device name: the name of the device specified in EthoVision XT. For 
example, “Device A”. To know the device name, in the Arena Settings click 
the Arena-Hardware Mapping button, under Device name click the cell of 
the device you require and press Ctrl+C. Paste the text into the JavaScript 
code as Device name.

Command name: the name of the command used in the Trial Control 
Settings. For example, “Drop pellet”. To know the command name, open the 
Trial Control Settings, locate the Action box that contains that command 
and click Settings. Take note of the text near Action to perform. Enter this 
text in the JS code as Command name.

▪ EXAMPLE

In the following example, JavaScript reads the command “Drop pellet” of a 
Pellet dispenser with name Device A and outputs the value for each sample 
of the track (1 = drop a pellet; missing value = no pellets dropped).

function Process()
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{

   var DropPellet = GetCommand("Device A", "Drop pellet");

   SetOutput(DropPellet);

}

GetSignal
Returns the value of a hardware signal.

▪ SYNTAX

GetSignal(Device name, Signal name)

▪ ARGUMENTS

Device name: the name of the device specified in EthoVision XT. For 
example, “Device B”. To know the device name, in the Arena Settings click 
the Arena-Hardware Mapping button, under Device name click the cell of 
the device you require and press Ctrl+C. Paste the text into the JavaScript 
code as Device name.

Signal name: the name of the signal that you want to acquire. For example, 
“Number of licks”. To know the signal name, open an Analysis profile, click 
the button next to Hardware continuous, select a Device type, Device, 
and Signal. Take note of the text near Signal, and enter this text in the JS 
code as Signal name.

▪ EXAMPLE

In the following example, JavaScript reads the value of the signal “Number 
of licks” of a lickometer (Device B) and outputs it for each sample of the 
track.

function Process()

{

   var s = GetSignal("Device B", "Number of licks");

   SetOutput(s);

}

new Point
With the new Point statement you can define a point in space.

▪ SYNTAX

new Point(x,y,z)

▪ ARGUMENTS
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x, y, z (z is optional): The coordinates in mm based on the calibration axes 
and origin in the Arena Settings.

▪ EXAMPLE

pt1 = new Point(200, 300);

▪ NOTE

You cannot visualize the position of points defined with JavaScript. To do 
so, define points in the Arena Settings.

GetPointPoi
With this command you can extract the coordinates of a point of interest of the 
center of a zone or arena. Note that GetPointPoi returns the position of the point, 
then you have to extract the coordinates with additional commands (e.g. x = pt.x).

▪ SYNTAX

GetPointPoi(point)

▪ ARGUMENTS

point: The name of the point or the zone or arena, of which you want to 
find the center.

▪ EXAMPLE

const g_zone = "Zone 1";

function Start()

{

}

function Stop()

{

}

function Process()

var pt = GetPointPoi(g_zone);

var xc = pt.x;

var xy = pt.y;

IsInZone
This function has been replaced by other functions in EthoVision XT 18 (see below).

▪ For single-subject tracking: see IsPointInZone
▪ For multi-subject tracking: see IsSubjectCenterInZone, 

IsSubjectNoseInZone, IsSubjectTailInZone. 
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You can still use IsInZone in your code, but it won’t work properly when analyzing 
data points in hidden zones.

IsSubjectCenterInZone, IsSubjectNoseInZone, 
IsSubjectTailInZone
Use this function to determine if a body point of a subject is within a zone. The zone 
must be defined in the Arena Settings. The return value is boolean (true or false).

▪ SYNTAX

IsSubjectCenterInZone(Subject name, Zone name);

IsSubjectNoseInZone(Subject name, Zone name);

IsSubjectTailInZone(Subject name, Zone name);

▪ ARGUMENTS

Subject name: the name of one of the subjects listed in the Experiment 
Settings.

Zone name: the name of the zone of interest defined in the Arena Settings; 
for example, "Zone 1". You can specify the name directly (“Zone 1” with 
quotes), or a variable that contains that name. The zone can be a single 
zone, a cumulative zone, an entry zone, or a hidden zone.

▪ EXAMPLE - ONE SUBJECT

var bC = IsSubjectCenterInZone(“Subject 1”, “Zone 1”);

var bN = IsSubjectNoseInZone(“Subject 1”, “Zone 1”);

var bT = IsSubjectTailInZone(“Subject 1”, “Zone 1”);

or

const g_sZone = "Zone 1"

var bC = IsSubjectCenterInZone(“Subject 1”, g_sZone);

var bN = IsSubjectNoseInZone(“Subject 1”, g_sZone);

var bT = IsSubjectTailInZone(“Subject 1”, g_sZone);

▪ EXAMPLE - MULTIPLE SUBJECTS

var bC1 = IsSubjectCenterInZone(“Subject 1”, “Zone 1”);

var bC2 = IsSubjectCenterInZone(“Subject 2”, “Zone 1”);

IsPointInZone
Use this function to determine if a point (a body point, or a point of interest) is 
within a zone. The zone must be defined in the Arena Settings. The return value is 
boolean (true or false).

▪ SYNTAX
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IsPointInZone(Zone name, Point name)

▪ ARGUMENTS

Zone name: the name of a zone defined in the Arena Settings; for example, 
"Zone 1". 

Point name: The name of a body point or a point of interest defined in the 
Arena Settings.

▪ EXAMPLE

pt = GetCenter();

var b1 = IsPointInZone(“Zone 1”, pt);

or

pt = new Point (10, 10);

var b1 = IsPointInZone (“Zone 1”, pt);

Point.Equals
Checks if two points are equal.

▪ SYNTAX

point1.Equals(point2).

▪ ARGUMENTS

point 1: the first point

point 2: the second point

▪ EXAMPLE

The variable b gets the value 1 if the two points pt1 (the center of the 
subject) and pt2 (a point in space defined with the new statement) have the 
same coordinates.

var pt1 = GetCenter();

var pt2 = new Point(1.0, 2.0);

var b = pt1.Equals(pt2);

▪ ERRORS

If one of the two points is null, the value is not calculated and an invalid 
reference is returned.
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IsSubjectActor
Determines if the subject specified (argument) is currently the actor (focal subject) 
of the track being analyzed. The return value is boolean (true or false). You can use 
this function to skip comparisons and calculations that do not make sense.

▪ SYNTAX

IsSubjectActor(Subject name)

Where Subject name is the name of one of the subjects listed in the 
Experiment Settings.

▪ EXAMPLE

In this example a for loop scans the list of i subjects Subject 1, Subject 2, etc. 
contained in the array g_aSubjects[i] and calculates the distance between 
the focal subject (that is, the subject of the currently analyzed track) and the 
subject i. 

for (i = 0; i < g_aSubjects.length; ++i)

   var ptSubj = GetSubjectCenter(g_aSubjects[i]);

   (...)

   //invoke Distance function

   var Dist = Distance(ptFocal, ptSubj);

Obviously at some point in this loop the focal subject and the subject i are 
the same individual. You can exclude the distance calculation focal-to-focal 
by inserting an extra check.

var b = IsSubjectActor(g_aSubject[i]);

    if b = true

    {

        //invoke distance function

Distance
To calculate the distance between two points, see Point.Distance. You can also use 
the code here below and invoke the function in your script. Distance is expressed in 
internal units (mm), independent of the units selected in the Experiment Settings.

▪ FUNCTION

// Function to calculate distance between two points

function Distance(pt1, pt2)

{

    var dx = pt1.x - pt2.x;

    var dy = pt1.y - pt2.y;

    return Math.sqrt(dx * dx + dy * dy);
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}

▪ EXAMPLE OF FUNCTION CALL

//Get the center point of subject 1 and subject 2

var cSubj1 = GetSubjectCenter(“Subject 1”);

var cSubj2 = GetSubjectCenter(“Subject 2”);

//call distance function

var Dist = Distance(cSubj1, cSubj2);

▪ ERRORS

If one of the two points is null, the value is not calculated.

Point.Distance
Calculates the distance between two points. Distance is expressed in internal units 
(mm), independent of the units selected in the Experiment Settings.

▪ SYNTAX

point1.Distance(point2)

▪ ARGUMENTS

point1: the first point

point2: the second point

▪ EXAMPLE

var pt1 = GetCenter();

var pt2 = GetNose();

var dist = pt1.Distance(pt2);

▪ ERRORS

If one of the two points is null, the value is not calculated and an invalid 
reference is returned.

TurnAngle
Returns the angle in radians between three points. The name suggests that this 
function is restricted to turn angles but you can use it to calculate any angle formed 
by three points in general. See also Turn angle

▪ SYNTAX

TurnAngle(Point 1, Point 2, Point 3)

▪ ARGUMENTS

Point 1: the name of the begin point.
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Point 2: the name of the middle point.

Point 3: the name of the end point. This is the point at the current sample 
time, while Point 1 and Point 2 are the points at two immediately preceding 
sample times.

▪ EXAMPLE

ta = TurnAngle(g_aPoints[0], g_aPoints[1], g_aPoints[2]);

where g_aPoints is an array variable of length 3.

Remember that TurnAngle is in radians. At the top of the code, define a 
function to obtain the value in degrees:

function toDegrees(angle) 

{

  return angle * (180 / Math.PI);

}

(...)

var tadg = toDegrees(ta);

▪ ERRORS

If any of the three points is null, the value is not calculated.

Heading
Returns the value of heading in radians based on two sample points. See Heading

▪ SYNTAX

Heading(Point 1, Point 2)

▪ ARGUMENTS

Point 1: Begin point.

Point 2: End point.

To calculate heading, Point 1 is the point at the previous sample time and 
Point 2 the point at the current sample time.

▪ EXAMPLE

var hd = Heading(g_aPoints[0], g_aPoints[1]);

where g_aPoints is an array variable of length 2.

At the top of the code, define a function to obtain the value in degrees:

function toDegrees(angle) 
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{

  return angle * (180 / Math.PI);

}

(...)

var hdg = toDegrees(hd);

▪ ERRORS

If one of the two points is null, the value is not calculated.

SetOutput
Assigns a value to the JavaScript variable for the current sample time.

▪ SYNTAX

SetOutput(Value)

SetOutput(Output, Value)

▪ ARGUMENTS

Value: the value that you want to assign to the variable at the current 
sample time. 

▪ For JavaScript Continuous variables: a rational number.
▪ For JavaScript State variables: true or false.
▪ For JavaScript Event variables: 0 or 1.
Output: Output number. When the variable has just one value per sample, 
like in most applications, then you do not need to specify Output. When the 
variable has multiple outputs, like in a state variable with 4 possible states, 
specify the output in each line (beginning from zero). For example 

SetOutput(0, bOutput1); //write first state

SetOutput(1, bOutput2); //write second state

SetOutput(2, bOutput3); //write third state

SetOutput(3, bOutput4); //write fourth state

▪ EXAMPLE

if (x != null)

{

   SetOutput(x);

}

▪ ERRORS

If the value is null or undefined, the output will be missing.

▪ NOTES
1188



When the variable has multiple outputs, remember to specify the Number 
of outputs at the bottom of the JavaScript window.

SetOutputMissing
Assigns a missing value to the JavaScript variable for the current sample time.

▪ SYNTAX

SetOutputMissing()

▪ EXAMPLE

In the following example, if the value of x is not null, it is assigned to the 
output of the JavaScript variable; otherwise it is set to missing. 

if (x != null)

{

   SetOutput(x);

}

else

{

   SetOutputMissing();

}

See also

▪ JavaScript continuous
▪ JavaScript state
▪ JavaScript event
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Live Mouse Tracker

In the Analysis profile you find two groups of variables based on Live Mouse Tracker 
data.

Under Raw Live Mouse Tracker data you find basic events of Live Mouse Tracker, 
like Contact and Approach. 

▪ Raw Live Mouse Tracker data
Under Live Mouse Tracker you find more complex variables:

▪ Approach rearing subject
▪ Drink
▪ Follow
▪ Get Away
▪ Group
▪ Make and break group
▪ Make contact
▪ Move
▪ Nest
▪ Nose contact
▪ Nose contact sequence
▪ Out of nest
▪ Rear
▪ Social approach
▪ Stretch attend posture
▪ Social escape
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Notes
▪ You can also use the basic events of Live Mouse Tracker (first group above) 

to carry out custom analysis. For example, analyze Contact events with 
JavaScript code. To extract Live Mouse Tracker events, use the function 
GetBehaviorEvent. See Commands and functions for JavaScript variables 

▪ In the Analysis profile, under Social, you find variables derived from Live 
Mouse Tracker with extended options:
▪ Side by side
▪ Train

▪ In experiments based on Live Mouse Tracker data, some standard 
EthoVision XT variables are not available. See a note in the topic Live Mouse 
Tracker: Workflow
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Raw Live Mouse Tracker data
Aim
You can use the following variables to analyze basic events in the Live Mouse 
Tracker datasets. For example, Contact events.

Approach

Definition and calculation

A discrete (state event) variable that is scored when the focal subject reduces its 
distance to another subject. Approach is based on the approach events detected by 
Live Mouse Tracker and imported in EthoVision XT. Approach events occur when:

▪ The speed of the focal subject is greater than the speed of the other 
subject.

▪ The distance between the two subjects at the sample k-3, that is, three 
video frames before the current one k, is greater than the distance at the 
sample k+3, that is, three video frames after the current one k. 

Detection occurs during data acquisition, therefore outside EthoVision XT, and its 
settings cannot be modified in EthoVision XT.

Contact
A discrete (state event) variable that is scored when the focal subject is in contact 
with another subject. Contact is based on the contact events detected by Live 
Mouse Tracker and imported in EthoVision XT. Contact events occur when the 
distance between the detected contours of the animals gets below a fixed 
threshold. Detection occurs during data acquisition, therefore outside EthoVision 
XT, and its settings cannot be modified in EthoVision XT. For more information, 
please see the Live Mouse Tracker documentation.

NOTE  The dependent variable Body contact under Social behavior in the Analysis 
profile won’t give results with Live Mouse Tracker data, because Body contact can 
only be based on EthoVision XT’s own track data.

Look
Look is a state event variable with possible values Look_up and Look_down.

▪ Look_down: The subject’s head is pointing downward, for example when 
sniffing the substrate.
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▪ Look_up: The subject’s head is pointing upward, for example when rearing 
at the wall.

Rearing
Rearing is a discrete (state event) variable with two possible values, Rearing and Not 
rearing. For how it is calculated, see Rear (you can find this variable under Live 
Mouse tracker). 

The difference between Rearing and Rear is that Rearing includes all rearing events, 
instead of splitting them into two categories, Rear in contact and Rear alone. 

Speed
Speed is imported into EthoVision XT and shown in the Analysis profile under Raw 
Live Mouse Tracker data, but it is not used as an output variable.

Stop
Stop is based on the stop events detected by Live Mouse Tracker and imported in 
EthoVision XT. Stop events occur when the speed of the subject gets below a fixed 
threshold (see Live Mouse Tracker > Stop). Detection of stop events occurs during 
data acquisition, therefore outside EthoVision XT, and its settings cannot be 
modified in EthoVision XT.

TIP  To analyze stop events when the subject is in contact with its cage mates, see 
Stop under Live Mouse Tracker data. 

How to specify Raw Live Mouse Tracker data
1. Open an Analysis profile and in the Dependent Variables panel, under Raw 

Live Mouse Tracker data, click the Add button next to a category.
2. Under Calculate statistics for, select the options you require. 
3. If the Receivers tab is available, there you can specify which subject the 

behavior is directed to. Keep all subjects selected for an overview of all the 
events directed to any individual (A, B, etc.).

4. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Notes
▪ You can also raw Live Mouse Tracker data within JavaScript code to create 

custom analysis variables. For this purpose, use the GetBehaviorEvent 
function. See Commands and functions for JavaScript variables
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▪ Raw Live Mouse Tracker data are not affected by track smoothing. This is 
because the data are stored during acquisition, and not calculated after 
import in EthoVision XT. For example, no matter whether you apply Lowess 
smoothing, the statistics of Contact do not change. On the contrary, Live 
Mouse Tracker analysis variables are affected by track smoothing, just like 
any dependent variable in EthoVision XT.

See also

▪ Dependent variables for Live Mouse Tracker
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Approach rearing subject
Definition
A discrete (state event) variable that is scored when the focal subject approaches 
another subject in rearing posture.

Calculation
This variable combines the variables Social approach and Rear in contact. The state 
Approach rearing subject is scored when:

▪ The focal subject is approaching the other, that is, the distance between the 
two shortens, and that distance is shorter than two times the average body 
length of the approached subject, calculated throughout the entire track.

▪ The speed of the focal subject is higher than that of the approached 
subject.

▪ The approached subject is in rearing posture, defined as any time that 
subject's nose point is at least 40 mm higher than its tail base. Rearing in 
contact occurs within 15 video frames (that is, 0.5 s for video at 30 fps) from 
the end of the Social approach event. 

How to specify Approach rearing subject
1. Open an Analysis profile and in the Dependent Variables panel, under 

Social, click the Add button next to Approach rearing subject.
2. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure

See also

▪ Social approach
▪ Rear
▪ Live Mouse Tracker
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Drink
Definition
A discrete (state event) variable that estimates the time that a subject spent 
drinking.

Drink has two components:

▪ In the water zone: This marks the time that the focal subject is within a 
circular zone that includes the water source.

▪ Drink: The subject is within a smaller circular zone around the water source 
with a radius being half the radius as above. In addition, the subject is 
stopped for more than 2 seconds. Therefore, Drink is a more restrictive 
criterion to estimate the amount of time that the subject spent drinking.

Calculation
Drink is essentially a variable like In zone, because it calculates the time that the 
subject’s center point lies within a zone. In this case the zone is a circle that covers 
the water tank placed at the bottom-right corner of the apparatus. 

▪ If the distance between the subject’s center point and the center of the 
circle is less than the zone radius, then In the water zone is scored for that 
sample. 

▪ A smaller zone concentric to the first zone is also considered. If the distance 
between the subject’s center point and the center of the smaller zone is 
shorter than the zone radius, and if the subject is stopped (see Stop), then 
Drink is scored for that sample. 

How to specify Drink
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Drink.
2. Under Calculate Statistics for, select In the water zone, Drink or both.
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3. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

See also

▪ Dependent variables for Live Mouse Tracker
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Follow
Definition
A discrete (state event) variable that is scored when the focal subject walks directly 
in the path of another subject. 

Calculation
Follow along path is scored when the following conditions are met: 

▪ Both subjects move at a speed higher than 5 pixels per frame.
▪ The two subjects are not in contact with any other subject.
▪ The angle between their direction vectors is smaller than 45°.
▪ The focal subject’s center point lies within a rectangular area drawn based 

on the position of the followed subject. This is checked beginning from the 
current video frame time to the 15th frame before the current one. So the 
software checks that the focal subject enters the path up to 0.5 s after the 
followed subject has been there.

▪ The distance between the two subjects’ center points is smaller than two 
mean body lengths. This mean body length is calculated using all values of 
distance nose-tail base of the followed (i.e., non focal) subject within the 
track.

How to specify Follow
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Follow.
2. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure
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Note
Follow looks similar to a train of two mice. However it depends on the definition of 
the train.

If subject A is following closely subject B, this is scored as A Follows B but also as a 
Train for subject A, when the distance between A and B is shorter than the threshold 
set in the Train settings, and when the train is defined as in the cases below:

▪ A > B.
▪ Actor > B.
▪ Actor > Any.

Note that:

▪ Follow is scored for the subject that follows another one. If subject A follows 
subject B, Follow is scored for subject A, not B.

▪ Train is scored for all the subject involved in the train definition. So when 
subject A follows subject B, an instance of Train defined as A > B is scored 
for subject A and for subject B.

See also

▪ Dependent variables for Live Mouse Tracker
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Get Away
Definition
A discrete (state event) variable that is scored when the focal subject walks away 
from another subject.

Calculation
The variable Get away is scored when:

▪ The speed of the focal subject is greater than or equal to the speed of the 
other subject

▪ The speed of the focal subject or the other subject is greater than the value 
set as threshold (5 cm/s). This threshold cannot be changed as it is hard-
coded. 

▪ The distance between the two subjects increases.
Note that if the other subject is sitting still, Get away is not scored for the focal 
subject, no matter what the latter does.

How to specify Get away
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Get away.
2. Click the Receivers tab.

Under Select, choose the subjects that the focal subject moved away from. 
If you select two or more subjects, select one of the available options from 
the list:

▪ All selected subjects: Get away is scored when the focal subject 
moved away from all the subjects selected above simultaneously.

▪ Any selected subject: Get away is scored when the focal subject 
moved away from any of the subjects selected above.
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▪ Each subject: Get away is scored when the focal subject moved away 
from one of the subjects selected above. The results are displayed for 
each Receiver.

3. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure.

Notes
▪ To calculate this variable, EthoVision XT checks the subject’s speed at time t 

based on the change in the X,Y coordinates between t-1 and t+1, like in the 
original algorithm of Live Mouse Tracker. In EthoVision XT, the Velocity 
variable at time t is calculated based on the change in the X,Y coordinates 
between t-1 and t. See Velocity

Example
Subject A is moving to the left, away from subjects B and D. Accordingly, the state 
events Get away are scored for the two combinations A-B and A-D. The duration of 
the state events depends on when the conditions listed above are valid for each 
combination. Because subject C is still, Get away is not scored for the combination 
A-C. 

In the Trial Statistics results table, with the default layout, the results of Get away are 
shown per subject (on the rows). The columns vary depending on what you chose in 
the Receivers tab (see above).

▪ If you chose Each subject, the columns contain the statistics of Get away 
from specific subjects (for example, From A to D).

▪ If you chose All selected subjects or Any selected subject, a column From 
all of A, B, C, D or From any of A, B, C, D contains cumulative statistics of 
Get away when the subject moved away from all the cage mates 
simultaneously or from any of them, respectively, depending on which 
option you chose.

See also

▪ Dependent variables for Live Mouse Tracker
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Group
Definition
A discrete (state event) variable that is scored when the focal subject is in contact 
with one or more subjects. 

Calculation
EthoVision XT uses the events of type Contact stored in the Live Mouse Tracker 
database.

▪ Group size 2 is scored when the focal subject is contact with only one 
subject. If the animal is in contact with more than one animal the event is 
not scored.

▪ Group size 3 is scored when the focal subject is in contact with only two 
other subjects to form a group of three animals. 

▪ Group size 4 is scored when the focal subject is in contact with three other 
subject to form a group of four animals.

EthoVision XT splits the results depending on who forms each group. For example A 
can form groups of 2 subjects, resulting in groups AB, AC and AD. The overall results 
(AC+AC+AD) are also shown.

How to specify Group
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Group.
2. Specify the Group size. 
3. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure
4. If you wish to have the results for all group sizes in one table, repeat the 

steps above to add a total of three Group variables, one for each group size.
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Applications
You can use Group variable to quantify the tendency of subjects to form groups. For 
example, a mouse model of social deficit may show reduced time spent in groups.

See also

▪ Dependent variables for Live Mouse Tracker
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Make and break group
Definition
A discrete (point event) variable that is scored when the focal subject joins or leaves 
a group of conspecifics. Because it is a point event variable, it has no duration.

▪ Make group of size n (2 to 4). The subject joins a group of n-1 subjects to 
form a group of n subjects in contact with each other.

▪ Break group of size n (2 to 4). The subject leaves a group of n subjects. The 
group is now of size n-1, or does not exist anymore in the case of n=2.

Calculation
EthoVision XT detect the make/break events based on the state of type Group.

▪ If the subject is not in contact with any subject one video frame before the 
start of the event Group, a Make group event is scored.

▪ If the subject is not in contact with any subject one video frame after the 
end of the event Group, a Break group event is scored.

NOTE  In EthoVision XT, a point event is an event with no duration. In contrast, state 
events have a duration.

How to specify Make and break group
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Make and break group.
2. Specify the Group size. This is the final size when making a group, or the 

initial size when leaving a group. For example, enter 3 if you want to have 
the instances when a subject joined other subject to form a group of three 
subjects, or left a group of three, so the group became of two subjects.

3. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure
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Applications
In a study of mouse model of ASD, Shank2 mutant mice observed in a social context 
displayed increased frequency of completing or breaking a group of three or four 
mice (de Chaumont et al. 2019. Nat. Biomed. Eng. 3: 930-942.

Note
While Group is a state event that aims at quantifying the time that a subject was 
part of a group, Make and break group is a point event variable, that is, it tells you 
exactly when the subject joined or left a group.

See also

▪ Dependent variables for Live Mouse Tracker
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Make contact
Definition
A discrete (state event) variable that is scored when the subject approaches another 
one to make contact with it.

Calculation
Make contact is scored when the following conditions are met simultaneously:

▪ The distance between the focal subject and the other subject shortens 
(approach event).

▪ The speed of the focal subject is higher than that of the approached 
subject. If the speeds of the two animals involved in the contact are not 
different enough, Make contact is not computed.

▪ The contact event starts some time during the approach event or 
immediately after the end of the approach event. That is, the video frame 
immediately before a contact event must be within the timeline of the 
approach event.

▪ The contact event lasts more than three video frames. Instances of contact 
separated by one video frame are merged together.

An instance of Make contact starts at the start time of approach and ends at the 
video frame just before the contact event. It does not include the time of contact.

NOTE  In Live Mouse Tracker, contact between subjects is detected when the 
distance between the contours gets below a fixed threshold. Contact is detected 
during data acquisition and its settings cannot be modified in EthoVision XT.

How to specify Make contact
1. Open an Analysis profile.
2. In the Dependent Variables panel, under Live Mouse Tracker click the Add 

button next to Make contact.
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3. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Example
Subject B has made contact with subject C.

See also

▪ Dependent variables for Live Mouse Tracker
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Move
Definition
A discrete (state event) variable that marks the time that the focal subject makes 
some displacement in space. The subject may move alone (here below, left) or in 
contact with any other subject (right).

Calculation
EthoVision XT considers the subject moving for the time between two subsequent 
events of type Stop. Events of type Stop are scored when the speed of the subject is 
lower then the threshold value (5.26 cm/s or 2 5/64 in). This threshold is set in the 
Live Mouse Tracker algorithms and cannot be changed.

How to specify Move
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Move.
2. Under Calculate Statistics for, select Move in contact, Move alone or 

both.
3. Click the Receivers tab. These apply when you select Move in contact.

Under Select, choose the subjects that were in contact with the focal 
subject while it was moving. If you select two or more subjects, select one of 
the available options from the list:

▪ All selected subjects: Move in contact is scored only when the focal 
subject was in contact with all the subjects selected above.

▪ Any selected subject: Move in contact is scored when the focal subject 
was in contact with any of the subjects selected above.

▪ Each subject: Move in contact is scored when the focal subject was in 
contact with one of the subjects selected above. The results are 
displayed for each Receiver. 
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4. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Example
In the Trial Statistics results table, with the default layout, the results of Move are 
shown per subject (on the rows). The columns vary depending on what you chose in 
the Receivers tab (see above).

▪ If you chose Each subject, the columns contain the statistics of Move in 
contact with specific subjects (With A to D). 

▪ If you chose All selected subjects or Any selected subject, a column With 
all of A, B, C, D or With any of A, B, C, D contains cumulative statistics of 
Move when the subject was in contact with all cage mates or any of them, 
respectively, depending on which option you chose. 

Notes
▪ Move may look similar to EthoVision XT’s Movement, with its possible 

states Moving and Not moving. However, the results may not always 
overlap. Movement uses two adjustable speed thresholds, which filter the 
changes in velocity in a different way.

See also

▪ Dependent variables for Live Mouse Tracker
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Nest
Definition
A discrete (state event) variable that is scored when the subject is in contact with 
two or more subjects. All those subjects do not move.

Note that the variable Nest has nothing to do with nest-building behavior.

Calculation
EthoVision XT considers the events of type Contact stored in the Live Mouse Tracker 
database, which overlap with the events of type Stopped. That means that Nest 
includes only instances when the focal subject is in contact with other subjects, like 
in Group, with the additional condition that none of those subjects moves.

Finally, instances of Nest shorter than two samples are removed and adjacent 
instances up to three samples apart are joined to form one instance.

Contrary to Group, EthoVision XT does not split the results based on the identity of 
the subjects forming a Nest.

How to specify Nest
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Nest.
2. Specify the Nest size.
3. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure.
4. If you wish to have the results for all nest sizes in one table, repeat the steps 

above to add more Nest variables, one for each size.

Example
Subject A (red dot), B (light green) and D (dark green) are forming a nest. Subject C 
(orange dot) walks around and is therefore not part of the nest.
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In the Trial Statistics, Frequency is the number of instances of Nest (color bars on the 
time line as in the figure above) and Cumulative Duration is the sum of the duration 
of all the instances in the selected trial (or interval).

Applications
You can use Nest to quantify the tendency of subjects to huddle together and form 
groups. Nest occurs especially in the sleep (light) phase. 

See also

▪ Group
▪ Dependent variables for Live Mouse Tracker
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Nose contact
Definition
A discrete (state event) variable that is scored when the focal subject’s nose is near 
the nose point (see below, left) or the tail-base point (right) of another subject.

Calculation
▪ Nose-nose contact is scored when the distance between the nose-point of 

the focal subject is at less than 15 pixels (26 mm for Live Mouse Tracker 
arenas) from the nose-point of another subject.

▪ Nose-anogenital contact is scored when the distance between the nose-
point of the focal subject is at less than 15 pixels (26 mm for Live Mouse 
Tracker arenas) from the tail-base point of another subject.

How to specify Nose contact
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Nose contact.
2. Under Calculate Statistics for, select Nose-nose contact, Nose-

anogenital contact, or both.
3. Click the Receivers tab.

Under Select, choose the subjects that the focal subject was in nose contact 
with. If you select two or more subjects, select one of the available options 
from the list:

▪ All selected subjects: Nose contact is scored when the focal subject 
was in contact with all the subjects selected above.

▪ Any selected subject: Nose contact is scored when the focal subject 
was in contact with any of the subjects selected above.

▪ Each subject: Nose contact is scored when the focal subject was in 
contact with one of the subjects selected above. The results are 
displayed for each Receiver. 
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4. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Example
A Nose contact variable has been defined with both options Nose-nose contact 
and Nose-anogenital contact selected. Below you find the Integrated visualization 
of this variable. Note that the results are split based on the subject that the focal 
subject is in contact with. In the current video image, Subject A (red dot) is in nose 
contact with Subject D (dark green dot). 

In the Trial Statistics results table, with the default layout, the results of Nose contact 
are shown per subject (on the rows). The columns vary depending on what you 
chose in the Receivers tab (see above).
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▪ If you chose Each subject, the columns contain the statistics of Nose 
contact with specific subjects (for example, Nose-nose contact / A to D). 

▪ If you chose All selected subjects or Any selected subject, a column 
Nose-nose (or Nose-anogenital) / All of A, B, C, D or Nose-nose (or 
Nose-anogenital) / Any of A, B, C, D contains cumulative statistics of Nose 
contact when the subject was in contact with all cage mates simultaneously 
or with any of them, respectively, depending on which option you chose. 

Notes
▪ For this variable, Live Mouse tracker takes the distance between the body 

points on the X,Y plane, and ignores their Z coordinates.
▪ In the Analysis profile under Social, you find Body contact. This is a variable 

that quantifies the level of generic body contact between subjects.

See also

▪ Nose contact sequence
▪ Social Behavior > Body contact
▪ Dependent variables for Live Mouse Tracker
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Nose contact sequence
Definition
A discrete (state event) variable that is scored from an instance of nose contact of 
one type to the following nose contact of opposite type, both performed by the 
focal subject.

In other words:

▪ From an instance of Nose-nose contact to the next instance of Nose-
anogenital contact. Or

▪ From an instance of Nose-anogenital contact to the next instance of Nose-
nose contact.

See also Nose contact

Calculation
1. EthoVision XT selects all instances of type Nose-nose contact or Nose-

anogenital contact (depending on what is chosen in the settings), and 
longer than 10 video frames (0.33 s for a video of 30 fps).

2. EthoVision XT selects all the instances of type of Nose-contact other than 
that selected in the previous step, and longer than 10 video frames (0.33 s).

3. If the second Nose-contact occurs within 60 video frames (2 seconds, for a 
video of 30 fps) from the end of the first one, a Nose contact sequence is 
found.

How to specify Nose contact sequence
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Nose contact sequence.
2. Under Calculate Statistics for, select Nose-nose to Nose-anogenital, 

Nose-anogenital to Nose-nose, or both.
3. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure
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Example
The following example shows a sequence of type Nose-nose contact to Nose-
anogenital contact of Subject A directed to subject B. The position and orientation 
of the subjects at the beginning and at the end of the sequence are shown on the 
right. Triangles represents the nose points and squares represent the tail-base 
points.

See also

▪ Nose contact
▪ Dependent variables for Live Mouse Tracker
▪ Social > Body contact
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Out of nest
Definition
A discrete (state event) variable that is scored when the focal subject is away from 
the remaining subjects, which form a nest.

Calculation
EthoVision XT finds all the instances of Nest 3, that is, when three subjects are in 
contact and do not move (see Nest). The state event Out of nest is scored for the 
remaining subject and lasts as long as the Nest 3 lasts.

How to specify Out of nest
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Out of nest.
2. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure

Example
In the following figure, subject B is far from the remaining subjects B, C and D, 
which huddle together forming a nest.

The state event Out of nest has been scored for subject A and lasts until one of the 
subjects B, C, and D leaves the nest, or when A joins the others to form a nest of size 
4.
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See also

▪ Nest
▪ Dependent variables for Live Mouse Tracker
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Rear
Definition
A discrete (state event) variable that is scored when the focal subject stands only on 
its hindlimbs and raises its head above its body. Two categories are defined:

▪ Rear alone: the subject is not in contact with any other subject.
▪ Rear in contact: the subject rears while in contact with another subject.

Calculation
EthoVision XT considers the samples when the focal subject's nose point is at least 
40 mm higher than its tail base. 

▪ Rear in contact is scored when rearing overlaps with any event of type 
Contact scored for the focal subject.

▪ In all other cases, Rear alone is scored.

How to specify Rear
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Rear.
2. Under Calculate Statistics for, select Rear alone, Rear in contact, or both.
3. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure

Note
Note the differences between Rear in Live Mouse Tracker and Rearing in Behavior 
Recognition:

▪ Rear in Live Mouse Tracker is detected using 3D data obtained from the 
depth camera, while Rearing in Behavior Recognition is detected using 
features of the pose extracted from a series of 2D images.
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▪ Rear in Live Mouse Tracker does not distinguish between rearing at the wall 
and rearing unsupported.

▪ Rear in Live Mouse Tracker with multiple subject in the arena, while Rearing 
in Behavior Recognition only works with one subject at a time.

See also

▪ Setting up Behavior Recognition
▪ Behavior Recognition: Requirements
▪ Analysis of Behaviors detected with Behavior recognition
▪ Dependent variables for Live Mouse Tracker
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Social approach
Definition
A discrete (state event) variable that is scored when the focal subject approaches 
another subject. The distance between the center points of the two subjects is 
within two mean body lengths of the approached subject. Social approach does not 
necessarily lead to contact.

Calculation
1. EthoVision XT finds all the instances of the events Approach between two 

subjects in the Live Mouse Tracker database. 
2. EthoVision XT calculates the average body length of the approached 

subject, measured as the distance between the nose-point and the tail-base 
point, throughout the entire track.

3. If the distance between the center point of the focal subject is within two 
times the average body length of the approached subject, Social approach 
is scored for that sample.

How to specify Social approach
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Social approach.
2. Click the Receivers tab.

Under Select, choose the subjects that the focal subject approached. If you 
select two or more subjects, select one of the available options from the list:

▪ All selected subjects: Social approach is scored when the focal subject 
approached all the subjects selected above simultaneously. For 
example, when the focal subject approached a group of three cage 
mates.

▪ Any selected subject: Social approach is scored when the focal subject 
approached any of the subjects selected above.
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▪ Each subject: Social approach is scored when the focal subject 
approached one of the subjects selected above. The results are 
displayed for each Receiver.

3. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Notes
In the Trial Statistics results table, with the default layout, the results of Social 
approach are shown per subject (on the rows). The columns vary depending on 
what you chose in the Receivers tab (see above).

▪ If you chose Each subject, the columns contain the statistics of Social 
approach directed to specific subjects (for example, Social approach A to 
D).

▪ If you chose All selected subjects or Any selected subject, a column All of 
A, B, C, D or Any of A, B, C, D contains cumulative statistics of Social 
approach when the subject was approached all the cage mates 
simultaneously or approached any of them, respectively, depending on 
which option you chose. 

See also

▪ Approach rearing subject
▪ Social escape
▪ Social > Relative movement
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Social escape
Definition
A discrete (state event) variable that is scored when the focal subject walks away 
from a conspecific (named Receiver). The distance between the center points of the 
two subjects is within two times the average body length of the receiver.

Calculation
1. EthoVision XT finds all the events of type Get Away in the Live Mouse 

Tracker database. 
2. EthoVision XT calculates the average body length of the subject which the 

focal subject is moving away from. The body length is measured as the 
distance between the nose-point and the tail-base point, and averaged 
throughout the entire track.

3. If the distance between the center point of the focal subject is within two 
times the average body length of the other subject, Social escape is scored 
for that sample.

How to specify Social escape
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Social escape.
2. Click the Receivers tab.

Under Select, choose the subjects that the focal subject escaped from. If 
you select two or more subjects, select one of the available options from 
the list:

▪ All selected subjects: Social escape is scored when the focal subject 
escaped from all the subjects selected above simultaneously. For 
example, when the focal subject left a group of three cage mates.

▪ Any selected subject: Social escape is scored when the focal subject 
escaped from any of the subjects selected above.
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▪ Each subject: Social escape is scored when the focal subject escaped 
from one of the subjects selected above. The results are displayed for 
each Receiver.

3. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Notes
In the Trial Statistics results table, with the default layout, the results of Social escape 
are shown per subject (on the rows). The columns vary depending on what you 
chose in the Receivers tab (see above).

▪ If you chose Each subject, the columns contain the statistics of Social 
escape from specific subjects (for example, Social escape A to D).

▪ If you chose All selected subjects or Any selected subject, a column All of 
A, B, C, D or Any of A, B, C, D contains cumulative statistics of Social 
escape when the subject escaped from all the cage mates simultaneously or 
from any of them, respectively, depending on which option you chose. 

See also

▪ Social approach
▪ Social > Relative movement
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Stop
Definition
A discrete (state event) variable that marks the time that the focal subject’s center 
point moves little or not at all in space. 

Two categories are defined, based on whether the subject is in contact with other 
subjects or not.

Calculation
1. EthoVision XT finds all the events of type Stop in the Live Mouse Tracker 

database. These are scored when the speed of the subject is lower then the 
threshold value (5.26 cm/s or 2 5/64 in). This threshold is set in the Live 
Mouse Tracker algorithms and cannot be changed.

2. EthoVision XT finds the events of type Contact in the Live Mouse Tracker 
database. 

3. If the event Stop and Contact overlaps, then Stop in contact is scored for 
that sample. In all the other cases, Stop alone is scored.

How to specify Stop
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Stop.
2. Under Calculate Statistics for, select Stop alone, Stop in contact, or both.
3. Click the Receivers tab. This applies if you selected Stop in contact in the 

previous step.
Under Select, choose the subjects that the focal subject was in contact with 
while it was not moving. If you select two or more subjects, select one of 
the available options from the list:

▪ All selected subjects: Stop in contact is scored when the focal subject 
was in contact with all the subjects selected above simultaneously.
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▪ Any selected subject: Stop in contact is scored when the focal subject 
was in contact with any of the subjects selected above.

▪ Each subject: Stop in contact is scored when the focal subject was in 
contact with one of the subjects selected above. The results are 
displayed for each Receiver.

4. Complete the procedure to add the variable to the Analysis profile. See 
Calculate statistics: procedure

Notes
▪ The state Not moving, which you can find in the EthoVision XT dependent 

variable Movement, is similar to Stop. However, there are differences:
▪ You can set the speed thresholds for Not moving, not for Stop.
▪ Instances of Not moving cannot be split based on the events of contact 

with other subjects.
▪ In the Trial Statistics results table, with the default layout, the results of Stop 

are shown per subject (on the rows). When choosing Stop in contact, the 
columns vary depending on what you chose in the Receivers tab (see 
above).
▪ If you chose Each subject, the columns contain the statistics of Stop in 

contact with specific subjects (for example, Stop in contact with A to 
D).

▪ If you chose All selected subjects or Any selected subject, a column 
With all of A, B, C, D or With any of A, B, C, D contains cumulative 
statistics of Stop in contact when the subject was in contact with all the 
cage mates simultaneously or with any of them, respectively, 
depending on which option you chose.

See also

▪ Live Mouse Tracker > Move
▪ Movement
1227



Stretch attend posture
Definition
A discrete (state event) variable that is scored when the subject slows down and 
stretches its body forward. The subject’s apparent body length (measured from the 
top view) increases and its height (measured with the depth camera) decreases.

Calculation
1. EthoVision XT calculates the average and the standard deviation (SD) of the 

body length, measured as the distance between the nose-point and the 
tail-base point, throughout the entire track.

2. EthoVision XT calculates the median body height, where body height is 
measured using the z-coordinate of the subject’s center point. 

3. Stretch attend posture is scored when the following occur simultaneously:
▪ The current body length is equal to or greater than the average + 1 SD 

of the body length.
▪ The current body height is smaller than the median body height.
▪ The current speed of the subject is lower than 5 pixels per video frame 

(at 30 fps, this is about 26 cm/s).

How to specify Stretch attend posture
1. Open an Analysis profile and in the Dependent Variables panel, under Live 

Mouse Tracker, click the Add button next to Stretch Attend Posture.
2. Complete the procedure to add the variable to the Analysis profile. See 

Calculate statistics: procedure

Note
Stretch attend posture is not detected if the nose-point or the tail-based point are 
not found at that time. The software needs both points to estimate the body length.
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See also

▪ Dependent variables for Live Mouse Tracker
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File Management

Main topics and tasks
▪ Manage your experiments  1231
▪ Import data  1247
▪ Export data  1249

IMPORTANT Manage your files and experiments EthoVision XT. If you delete, move 
or rename files using the Windows File Explorer, EthoVision XT may not be able to 
find the files again. 

To move or copy data and experiments to another location, see Back up an 
experiment.

See also

▪ Using Digital Video
▪ File locations
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Manage your experiments
Learn about

▪ File locations

What do you want to do?
▪ Create a new experiment from scratch
▪ Save an experiment
▪ Save an experiment with a different name
▪ Open an existing experiment
▪ Delete an experiment
▪ Back up an experiment
▪ Import data from other experiments
▪ Manage Settings and profiles
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Create a new experiment from scratch
Aim
To create an experiment without predefined settings. See below.

You can also create an experiment in EthoVision XT using a template, for example 
for a Morris Water Maze test, or a Radial Maze test, and for a specific animal, like 
the rat, mouse, or zebrafish. See Create an experiment from a predefined template

Procedure
1. Choose File > New, or in the EthoVision XT Startup window, under New 

experiment, click New, or press Ctrl+N.
2. In the New Experiment window, enter a name for your experiment.

3. Browse to the location in which you want to store your experiment.
IMPORTANT Do not create an experiment on a removable disc, like a USB 
Flash drive or an external hard disk.

4. Additional options:
▪ Select GLP Experiment if you want EthoVision XT to support you in 

making a Quality Assurance-compliant experiment. For this, you need 
the Quality Assurance add-on module.

▪ Select DanioVision experiment if your PC is connected to a 
DanioVision system and you want to create a DanioVision experiment.

▪ Select Live Mouse Tracker experiment if you want to import Live 
Mouse Tracker data. For this, you need the Live Mouse Tracker add-on 
module.See Live Mouse Tracker: Workflow

5. Click OK. 
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Notes
▪ You can find the experiment file (*.evxt) in a folder with the same name as 

the experiment. See File locations for the default experiment locations. You 
can specify the default experiment location during installation. You can 
change it any time in the Preferences for default folders.

▪ If you select DanioVision experiment, the EthoVision XT interface is 
adjusted for DanioVision. Unnecessary functions like the Manual Scoring 
Settings are not available. Detection settings are optimized for detection of 
zebrafish larvae and the arenas are detected automatically. for more 
information, see the DanioVision DVOC-0041 - Reference Manual.
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Save an experiment
Procedure
Choose File > Save or press Ctrl+S.

Notes
▪ You can also choose to save the data automatically at regular intervals. 

Choose File > Preferences > Auto save, select Enable auto save and enter 
the auto-save interval.

▪ When you make changes to your experiment, e.g., changes in settings, 
these are saved with save or auto-save. 

▪ During data acquisition and track editing, data are saved to file 
immediately.
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Save an experiment with a different name
Aim
To create a copy of an experiment, with a different name and saved in a different 
location (optional).

IMPORTANT  Do not rename the experiment file *.evxt and any other files within the 
experiment. That would invalidate the data within the experiment. Instead, save the 
experiment with a different name.

IMPORTANT  Do not save experiments within the folder of another experiment!

Procedure
1. Open the experiment in EthoVision XT.
2. Choose File > Save As. 
3. Enter the new experiment name and choose the destination folder.

Notes
▪ By default, the destination folder is the same folder as that of the original 

experiment.
▪ When you save an experiment with a different name, in the destination 

folder a new experiment folder is created with the same name as the 
experiment. For example:
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Open an existing experiment
Procedure
Choose one of the following:

In EthoVision XT

▪ In the EthoVision XT startup window, under Open, click one of the 
experiments in the recent experiment list. To open a different experiment, 
click Browse and open the folder where your experiment is stored. Select 
the file with the extension evxt and click Open.

▪ Press Ctrl+O. Browse to the location where your experiment is stored, 
select the file with the extension evxt and click Open.

▪ Choose File > Open. Browse to the location where your experiment is 
stored, select the file with the extension evxt and click Open.

With the File Explorer

▪ Using the Windows File Explorer, open the folder where your experiment is 
stored. Right-click the file with extension evxt and click Open or Start 
experiment.

Notes
▪ You can open an experiment saved in older versions of EthoVision XT. 
▪ You cannot open experiments made in newer versions of EthoVision XT. Use 

the newest version to open that experiment.
▪ GLP compliant experiments that have been made with EthoVision XT 12 or 

earlier cannot be opened in EthoVision XT 18.
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Delete an experiment
Aim
To remove an experiment from your computer. If video files are included in the 
experiment folder, these files will be deleted.

Procedure
1. In the Windows File Explorer, browse to the experiments folder.
2. Click the folder of the experiment that you want to delete and press Delete, 

or right-click that folder and select Delete.
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File locations
Program folder
The default folder for EthoVision XT is

C:\Program Files\Noldus\EthoVision XT 18

Experiments folder
The default folder for EthoVision XT experiments is

 C:\Users\Public\Public Documents\Noldus\EthoVision XT\Experiments.

Each experiment has its own folder, the experiment folder. An experiment folder 
contains the following sub-folders:

▪ Bitmap Files. Contains the background images that were used in the Arena 
Settings and the reference images that were used in the Detection Settings.

▪ Configuration Files. Contains the configuration files that are created when 
you set the connection between EthoVision XT and hardware devices.

▪ Data Files. Contains the binary track files acquired during acquisition.
▪ Export Files. When you export your track data, manually scored behaviors, 

analysis results or the experiment’s GLP log files, the export files are, by 
default, stored in this subfolder. 

▪ External. When you import external data files, they are stored in this 
subfolder. In addition, the subfolder contains the sync-out files that were 
used for external data co-acquisition.

▪ Intermediate. This folder contains intermediate results.
▪ Log. Contains the log files if your experiment is set for Quality Assurance 

(GLP experiment).
▪ Media Files. This is the default location for media files that have been 

recorded during the experiment.
▪ Temp. This is a folder where temporary files are stored. It is usually empty.

Import Profiles
The default folder for profiles for import of physiological data is

 C:\ProgramData\Noldus\Common\Profiles.
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The log file for Technical Support
Locate the file in: C:\ProgramData\Noldus\EthoVision\XT 18\Log.

The dump files for Technical Support
Our Technical Support department may also request the dump files EthoVision XT 
[version number].dmp.

You can find the dump files in the following locations:

▪ For Noldus debug-mode dump files: C:\Users\[user 
name]\AppData\Local\Temp.
TIP  To access this folder, in the Windows Search field type %temp%.

▪ For user-mode dump files: C:\Users\[user 
name]\AppData\Local\CrashDumps
A user-mode dump is a dump created for a specific process, for example an 
application like EthoVision XT.

Notes
▪ The AppData folder may be hidden on your computer. If so, in the File 

Explorer, from the View menu select Options and then Change folder and 
search options. Click the View tab and make sure that under Hidden files 
and folders the option Show hidden files, folders and drivers is selected.

▪ If EthoVision XT did not create a DMP file, do the following:
1. Start EthoVision and use the system until it freezes. Let the software sit 
there frozen and proceed with the instructions below.

2. Navigate to: C:\Windows\SysWOW64, double-click on a file called 
Taskmgr.exe. The Task Manager opens. 

3. On the Processes tab, right-click on EthoVision XT and select Create 
dump file.

4. Wait until a message pops up telling you the location of the DMP file 
(likely here: C:\Users\<your name>\AppData\Local\Temp\EthoVision.DMP). 

5. Close EthoVision XT, copy the DMP file and send it to Technical Support.
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Back up an experiment
Aim
To keep a safe copy of your data, or transfer an experiment to a different computer.

Prerequisites
▪ The second computer must have EthoVision XT installed, with a version 

equal or more recent than that in the first computer.
▪ Note that the hardware key is necessary to acquire the data, not create or 

restore the backup file.

Procedure
1. Choose File > Make Backup. 

▪ In the Backup Experiment window, enter a name for your experiment 
backup file, and browse to the location in which you want to store your 
experiment backup file.

▪ Choose the backup options (see below).
2. Copy or send the *.evz file to the final destination.
3. Restore the backup on the second computer (see below).

Backup options
Select whether you want to:
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▪ Include Media Files: These are the video files stored in the Media Files 
folder of that experiment. IMPORTANT Video files used in that 
experiment but stored in other locations are not copied to the backup 
file.

▪ Include Export Files: These are the result files and image files stored 
in the Export Files folder of that experiment.

▪ Include External Data Files: These are the physiological data files 
stored in the External folder of that experiment.

▪ Make backup read-only. When you select this option you get a 
warning in case you (accidentally) delete the backup file.

Notes
▪ The backup file has the extension *.evz. The file name must not contain any 

of the following characters: / : * ? \ “ < > | . ; .
▪ IMPORTANT Your backup files can get very big if you include your media 

files!
▪ If you have recently carried out batch statistics calculations, the backup file 

may be unnecessarily large. To reduce file size, for each Track Smoothing 
profile in your experiment click two times a Track smoothing option (see 
details below). Next, make a backup.

▪ Make sure that your media files, export files and external data files are 
within the experiment folder, otherwise they will not be included in the 
backup.

▪ You should store the backup file on a secure medium (preferably a network 
drive), in a separate location.

▪ When you carry out batch statistics calculations, EthoVision XT stores the 
results in a number of files, one for each combination of Track Smoothing 
profiles, Data profiles, Analysis profiles, dependent variable, track, etc. 
These files are stored in the Intermediate sub-folder in the experiment 
folder. A large number of result files can make the backup file exceedingly 
large especially when you deal with a large number of tracks and/or 
profiles. To remove the result files, open a Track Smoothing profile that you 
used for analysis and click an option two times, whether that option was 
selected or not:
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Do this for all Track smoothing profiles that you used for analysis. Next, 
make a backup of your experiment.

To restore the batch calculation results, repeat the batch calculation 
procedure.

To restore an experiment from the backup file
1. Choose File > Restore Backup, or in the EthoVision Startup window, under 

Restore experiment, click Restore backup.
2. Browse to the location where your backup file is stored, select it and click 

Open.
3. Browse to the location where you want to save the experiment and click 

OK.
The experiment folder and all associated files of the experiment are restored.

To delete a backup file
Do one of the following:

▪ Choose File > Restore Backup. In the window that opens, click the backup 
file you want to delete and press the Delete. Click Yes to confirm.

▪ In Windows File Explorer, browse to the experiment backup file (*.evz) and 
delete it.
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Settings and profiles
You can store your favorite options in Settings and Profiles that apply to specific 
procedures. Settings and profiles are visible in the Experiment Explorer. Except for 
Experiment Settings and Manual Scoring Settings, you can store multiple settings 
for different situations, for example different Trial Control settings to acquire trials 
of different durations.
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To view the settings used in a trial
1. Choose Setup > Trial List.
2. Click the Show/Hide button on the toolbar and select Variables.

3. Choose the type of settings you want to view.
4. The settings column is added to your Trial List. For a specific trial, the 

column shows the name of the settings used to acquire the data.
5. In the Experiment Explorer, open that settings profile. 

Profiles that have been used to acquire data are marked with a lock symbol (see 
below).

To create a new settings/profile
1. Right-click the corresponding folder in the Experiment Explorer and select 

New.
2. Type the name for the new profile or accept the suggested name, then 

press Enter.

To activate settings/profiles
In the Experiment Explorer, right-click the settings/profile you want to activate and 
select Set as Current.

Active profiles are highlighted in blue in the Experiment Explorer. Activating means 
that EthoVision XT uses that profile to carry out a procedure. For example, when 
acquiring the data it uses the Arena Settings active at that moment. When 
calculating statistics, it uses the active Track Smoothing profile. 

To open settings/profiles
Right-click the settings/profile you require under the corresponding folder in the 
Experiment Explorer and select Open. 

Opening settings/profiles also means that those settings/profiles are activated.

To edit settings/profiles
To edit settings/profiles, open them (see above) and then make the necessary 
changes.
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When at least one trial has been carried out, the Arena Settings, Trial Control 
Settings and Detection Settings used for that trial are locked. Locked settings are 
marked by a lock symbol in the Experiment Explorer.

You cannot edit locked settings. If you want to make changes to those settings, 
make a copy (see below) and edit this. Then, make sure that you carry out the next 
trial using the new profile.

If you delete all trials acquired with specific settings, those settings are unlocked, so 
you can edit them.

To copy settings/profiles
Do one of the following:

▪ Open the settings/profile folder in the Experiment Explorer. Right-click the 
name of the settings/profile you want to copy and select Duplicate. 

▪ From the Setup or Analyze menu, select the type of settings/profile you 
want to copy. In the window that opens, select Duplicate from. Change the 
name of the new settings/profile if necessary. Next, select the settings/
profile you want to copy from.

Result: A new item is added to the folder. Type a new name or accept the suggested 
one, then press Enter.

The suggested name for a new settings/profile is [Settings/Profile] N, where N is 
the first integer not yet used in the name of the other settings/profiles in that 
folder.
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To rename settings/profiles
1. In the Experiment Explorer, right-click the name of the settings/profile you 

want to rename and select Rename. 
2. The profile name is highlighted. Type the name you require and press Enter. 

You cannot rename settings/profiles that were used to acquire at least one trial.

To delete settings/profiles
In the Experiment Explorer, right-click the name of the settings/profile you want to 
delete and select Delete. 

Notes
▪ You cannot delete settings/profiles that were used to acquire at least one 

trial. To delete those settings/profiles, you must first delete the trials (make 
sure you do not lose any important data!). 

▪ You cannot delete settings/profiles if your experiment is set for Quality 
Assurance (GLP experiment) and you do not have specific rights. 

▪ If the currently-active settings/profile is deleted, the first of the remaining 
settings/profiles folder is activated automatically. 

▪ If you delete the only settings/profile in the folder, a new default settings/
profile is created automatically. 

▪ If you delete a Data profile or an Analysis profile used to create an analysis 
result open on your screen (track plot or statistics result), the result is 
updated according to the first available Data profile, or, if no other profiles 
are available, a newly-created default profile. 
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Import data
Aim
To import data from other programs to analyze tracks and other data combined.

What do you want to do?

Import track data from other experiments

▪ Import data from other experiments
TIP  Choose this option to merge data from multiple experiments.

▪ Import Live Mouse Tracker data

Import other types of data

▪ Import UltraVox XT 3 call data
▪ Import Live Mouse Tracker data
▪ To import data acquired with a separate data acquisition (DAQ) system, see 

Import external data in EthoVision XT. For how to create an import profile 
see Create a new custom import profile.

NOTE  You cannot import track files from one EthoVision XT experiment into 
another. This means that data which you want to analyze together in EthoVision 
must be acquired in the same experiment.
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Import UltraVox XT 3 call data
Procedure

1. In EthoVision XT, open the Trial List.
2. Click the Import External Data button.
3. Under Files of type, select UltraVox XT 3.

If you do not see this profile, install it from the UltraVox XT 3 installation 
installation package. Open the folder ...Extras\Import profiles, and 
double-click EthoVision XT 11 and Newer.bat.

4. Select the *.etx files and click Open.
5. Drag the data lines from the Import External Data window to the trial, arena, 

or subject you require.
6. When ready, click Import.

Notes
▪ Data for each call name (or call name*pattern label) is imported and 

resampled as a separate dependent variable.
▪ For more information on importing and analyzing UltraVox XT call data, and 

how to control UltraVox XT start and stop data recording, see the UltraVox 
XT 3 Help.

See also

▪ The import profile for UltraVox XT 3
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Export data
Aim
To export EthoVision XT data to other programs to carry out further analysis.

What do you want to do?

Export data from EthoVision XT

▪ Export the raw data (track and dependent variables)
▪ Export external data
▪ Export manually-scored behaviors
▪ Export Trial Control data

Import EthoVision XT data in other applications

▪ Import data into Excel
▪ Import manually scored data into The Observer XT

See also

▪ Export the statistics result
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Export the raw data (track and dependent 
variables)
Aim
To export the x,y coordinates and the subject size for each sample together with the 
values of the dependent variables selected in the currently active analysis profile, 
including manually-scored behaviors and automatically recognized behaviors. The 
raw data file includes the independent variables that you defined in the Trial List.

Procedure
1. Choose Analysis > Export > Raw Data, or in the Experiment Explorer 

under Analysis - Export click Raw Data.
2. In the Raw Data Export window, select the Track Smoothing profile, the 

Data profile and the Analysis profile that define the data to be exported.
3. Under Data to Export, select Track & dependent variables.

4. Click Browse next to Destination folder and navigate to the location 
where you want to save the export files.

5. Under File Type, select either ANSI text (*.txt), Excel (*.xlsx), or Unicode 
text - default (*.txt). For text export, enter the Delimiter character you 
want to use to separate columns in the exported file.
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6. Next to Missing value representation, choose the character that you want 
to use to mark missing values.

7. Click Start export.

Options

File type

▪ If you export to text, data of each subject (track) is exported to a separate 
file. Each file name is unique, and is formed by, in the following order: Raw 
Data (or Manual Scoring, depending on what option you have chosen) - 
Experiment name - Trial number - Arena name - Subject name.
For example Raw Data-Open Field-Trial 1-Arena 1-Subject 1.txt

▪ Choose Unicode text to export according to the Unicode character set. 
This supports most world languages, including Chinese. Choose ANSI text 
to export the data as text files according to the ANSI character set. Choose 
this option only if the application in which you will open the exported file 
cannot handle the Unicode character set.

▪ If you export to Excel, the file contains all tracks of a trial. The file name is 
unique and formed by the following elements: Raw data (independent of 
the type of export) - Experiment name - Trial number.
For example Raw Data-Plus Maze-Trial 1.xlsx.

Data of each subject is written in a separate tab of the worksheet, named 
for example Track-Arena 1-Subject 1.

IMPORTANT  If your tracks contain more than approximately one million 
samples, Excel is unable to load the exported file. With 30 samples per 
second, this happens just after 9 hours. To solve this, export the file to text 
and use the Excel macro SplitTxtFiles.xlsm. You can find this file on 
my.noldus.com, under Downloads > EthoVision XT > Drivers and tools.

Manual scoring log

▪ If you want to export the manually-scored behaviors to The Observer XT, or 
in a format like for example, 5.12s Rearing, 5.88s Not Rearing, choose 
Manual scoring log.

▪ You can also export behaviors (both manually-scored and automatically 
recognized) in the same format as the other dependent variables, where a 
behavior is scored as 0 or 1 for each sample time, depending on whether it 
occurs or not at that time. Choose Track & dependent variables. Make 
sure that the Analysis profiles includes the behaviors to export.
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Trial Control data

▪ Choose Track & dependent variables also if you want to export Trial 
Control events and states defined in your Analysis profile. For example, to 
export the state ‘from Cue light on To Subject in Feeder zone’. The state is 
exported as a series of 0s and 1s (0= state not active, 1= state active) in the 
corresponding column of the export file.

▪ Choose Trial Control log if you want to export Trial Control events and 
states with their own time stamp, for example 6.8 s - Cue light on - 
Activated. For more information, see Export Trial Control data.

Hardware log

Choose Hardware log if you want to export the complete log of events of hardware 
devices as a separate file. See the EthoVision XT 18 - Trial and Hardware Control - 
Reference Manual.

External data

Choose External data log (not resampled) if you want to export the values of the 
physiological data streams. Note that these export file contain the original data, not 
the resampled data that appear in the EthoVision XT analysis profile. See External 
Data

Missing value representation

Enter the character for missing values. By default, missing values are exported as “-”. 
See also Export settings for specific applications

A missing value is exported in the following cases:

▪ The X,Y coordinates of a missing body point.
▪ The values of a dependent variable that could not be calculated for that 

sample. For example, the distance moved when the previous sample was 
missing.

File names, folders, and data format
▪ If you export the same data multiple times to the same location, EthoVision 

XT attaches a number at the end of the file name: (1), (2), etc.
▪ The files' suggested location is the Export Files folder located in your 

experiment folder. See File locations
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▪ The values exported have a variable number of decimals, depending on the 
number of integers. The total number of significant digits exported is 
always six (for example, 1.23456 or 1234.56), or seven if the unsigned 
number is smaller than one (0.123456).

The raw data file
Below: Part of a raw data file, opened in Excel. Top: Headers with independent 
variables. Bottom: data lines with time, x,y coordinates, subject area and dependent 
variables (one line per sample). 
1253



Reading the raw data file

▪ The track file export takes into account your data selection for entire tracks, 
but not for within tracks. So, if you make a data selection such that you only 
have track 1 and only zone 1, EthoVision will export track 1, but the entire 
track. If you want to filter out zone 1 in your track data, you should include 
the zone as a dependent variable and then filter on that column in Excel. 
The result column in the export file has values 0 and 1 dependent on the 
fact if the data selection criteria were met (1) or not met (0). 

▪ Trial time is the time elapsed from the start of the trial (basically, the 
moment when you clicked the green Start button). Recording time is the 
time elapsed from the start of the track. The difference between the two 
time values is also shown next to the header Recording after. For more 
information on trials and tracks, see Important terms in Trial Control.

▪ The values of the x,y coordinates and the subject size (Area) in the exported 
track files are expressed in calibrated units, (square) millimeters, (square) 
inches, etc., not in pixels.

▪ Areachange is the change in the pixels of the subject area from the 
previous sample, used to calculate Mobility. Note that this is not the same 
as the difference in Area between the current sample and the previous one.

▪ Samples that were missing (EthoVision XT could not analyze the video 
image) or not found (EthoVision XT could not find the subject) are indicated 
by "-" instead of the coordinate values. Note that sometimes the center 
point is found, not the nose point or the tail base (or neither of the two). 
To see the proportion of samples that were not found in a trial, in the Trial 
list click the Show/Hide button on the toolbar, choose Variables and select 
Subject not found. Check the value in the column Subject not found 
corresponding to that trial.

▪ Excel can import a limited number of rows and columns. For Excel 2007 and 
newer versions this is 16384 rows and 1048576 columns. Excel will only 
import the maximum number of rows. If necessary, you can import the 
exported files to another program like SPSS.
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Export external data
Aim
To export data like physiological data that were imported into EthoVision XT, to 
another application for further analysis. You can export the original data or the 
resampled data.

To export the original external data:
1. Choose Analysis > Export > Raw Data.
2. Select External data log (non resampled).
3. Choose the File type and click Start Export.

Notes

▪ Each line in the exported data file represents one sample according to the 
original sample rate. For example, for Heartbeat sampled at 1 sample/s:

▪ Trial time and Recording time are the original time stamps relative to the 
start of the trial and the start of the track, respectively.

▪ For text export: each file contains the original signal combined with the 
current Data profile/Result container. The default file name is:  
External-[experiment name]-[Trial number]-[signal name]-[Data profile or 
Result container name]-[Arena name]-[Subject name].txt.

▪ For Excel export: each file contains the signal from one trial. The default file 
name is:
Raw data-[experiment name]-[Trial number].xlsx.

Within an Excel file, each sheet contains the signal combined with the 
current Data profile/Result container. Sheets are named in this way: [signal 
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name]-[Data profile or Result container name]-[Arena name]-[Subject 
name]. This name may be truncated.

▪ For more information on other options, see Export the raw data (track and 
dependent variables).

To export the resampled external data:
1. Choose Analysis > Export > Raw Data.
2. Select Track and dependent variables.
3. From the list on the toolbar, select the Analysis profile that contains the 

resampled signals. See External data (resampled)
4. Choose the File type and click Start Export.
▪ In the exported data file, each line is one EthoVision XT sample. Each 

resampled signal is written in a column. The Data profile column indicates 
whether a sample is included (1) or not (o) in the Data profile.

▪ Export files are named like Raw data files. For more information on other 
options, see Export the raw data (track and dependent variables).

▪ To export a specific selection of resampled external data, first edit the Data 
profile. 

To export the signal statistics
Make sure that the signal is selected in the Analysis profile, with the Trial Statistics 
that you require. Next, choose Analysis > Export > Statistics. See Export the 
statistics result
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Export manually-scored behaviors
Aim
To export the behaviors scored manually, depending on the file structure you 
require.

▪ Export as dependent variable. The behaviors are exported as 0s or 1s, 
depending on whether the behavior is active (1) or not (0) at a specific 
sample time. Note that the export file contains a header. For example:
Time   Grooming head

10.00   0

10.04   1

...      ...

12.00   0

▪ As a Manual Scoring log. The behaviors are exported to a file where the 
start and stop events are written in sentences with the following structure:
Time - Subject - Behavior - Event type (State start or State stop)

For example:

10.04  Subject 1 Grooming head State start 

12.00  Subject 1 Grooming head State stop

Procedures

To export manually-scored behaviors as dependent variables

1. Make sure that the Analysis profiles includes the behaviors to export. 
2. Choose Analysis > Export > Raw Data, and select Track and dependent 

variables. See also Export the raw data (track and dependent variables).

To export manually-scored behaviors as a Manual Scoring log

1. Choose Analysis > Export > Raw Data, or in the Experiment Explorer 
under Analysis - Export click Raw Data.

2. Select Manual scoring log. Select the export format. If you export to The 
Observer XT, select a Text option and select semicolon (;) as Delimiter. 
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3. Click Start export.
For more options see Export the raw data (track and dependent variables).

Notes
▪ See Import manually scored data into The Observer XT.
▪ If you export to Excel, the manually scored data are stored in a separate tab 

of the Excel worksheet. The tab is named Manual scoring - [arena name]. 
▪ If you export to Text, data of different arenas are exported to different files. 
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Export Trial Control data
Choose between two ways to export the Trial Control data, depending on the file 
structure you require.

▪ As dependent variables. Data are saved to additional columns of the track 
data file, and each sample point receives a “0” or “1” depending on whether 
a state (or event) is active at that time.

▪ As a Trial Control log. Data are written to a separate file, where all events 
occurred during the trial (also those not included in the Analysis Profile) are 
stored as lines each with a time stamp.

To export Trial Control data as dependent variables
1. Define Trial Control events and states in the Analysis profile (see Trial Con-

trol in the Analysis profile).
2. Choose Analysis > Export > Raw Data. Select Track & dependent 

variables then click Start export.
Below: Part of a raw data file containing Trial Control data. The columns Frequency 
Light on and Duration Light on are dependent variables defined in an Analysis 
profile. Frequency Light on is a Trial Control event defined by the action “Light on”. 
Duration Light on is a state interval that goes as long as the light is on. At trial time 
40.48, a light device switches on. This is marked by Frequency Light On which gets 
the value 1. From that moment, the variable Duration Light On gets value 1. 

To export Trial Control data as a Trial Control log
1. Choose Analysis > Export > Raw Data. 
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2. Select Trial Control log and click Start export. 
Below: Part of a Trial Control log. Activation of conditions and actions is written as 
an event with a time stamp. The event is written in the Event column. The next 
columns describe which type of Trial Control element becomes true/false/active/
inactive. 

The Trial Control log file contains the following columns:

▪ Trial time and Recording time. See Reading the raw data file for the 
difference.

▪ Event. The type of trial control event. For an explanation of the terms, see 
How the trial control instructions are executed.

▪ Rule, Condition, Action, Operator, Reference. The Trial control element 
that is involved in the event described in the corresponding Event cell.

▪ Variable, Value. The variable that is subject to an action, and the new value 
assigned to the variable.

▪ Reference1...4, Repeat1...4. Marks the time that a sub-rule is active. Repeat 
indicates the number of times that sub-rule has been repeated up to that 
time.

To export log files of the hardware devices operated during the trial, select also the 
Hardware log option.

For more information, see Analysis of Trial Control data in the EthoVision XT 18 - 
Trial and Hardware Control - Reference Manual.
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Import data into Excel
To import analysis results
Analysis results here refers to the table in the Trial Statistics or Group Statistics tabs.

1. Export the statistics result, with Excel as format.
2. Open the file in Excel.

To import EthoVision XT raw data and dependent variables
1. Export the raw data (track and dependent variables).
2. Open the file in Excel.
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Import manually scored data into The 
Observer XT
Aim
To analyze the events scored manually in EthoVision XT in The Observer XT, for 
further analysis.

Prerequisite 
In EthoVision XT, export the data in the form of Manual scoring log (for details see 
Export manually-scored behaviors). Before clicking Start Export, select Manual 
Scoring log; select one of the Text options as export format, and select semicolon 
(;) as Delimiter.

To export a subset of tracks or subjects, filter the data before exporting.

Procedure
1. Open the export file in the Windows Notepad.
2. Remove the lines from “Experiment” to “” so that the first line of the file 

contains “Header Lines” and the second “Trial time”.

3. Change the number of header lines to 2, then save and close the file.

4. In The Observer XT, create a project or open an existing one. Make sure that 
the project’s coding scheme contains exactly the same behavior names and 
that these are organized in the same groups (mutually-exclusive or start-
stop) as the corresponding behaviors scored in EthoVision XT. See Effects 
on the coding scheme below.

5. Choose File > Import Observational Data.
6. From the Files of type list, select EthoVision XT Data File (*.txt). 

EthoVision XT Data File is an import profile made for manual scoring logs 
exported from EthoVision XT. It is installed automatically when you install 
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EthoVision XT. If you do not have this import profile, click Create New and 
see below.

7. Select the file you want to import and click Open.
8. Repeat the procedure for the remaining export files (remember that each 

trial and arena results in a separate export file).
9. Choose Setup > Independent Variables. Define the independent variables 

and enter the values of those variables for the trials you have imported.

To create an import profile in The Observer XT
In the Import Profile Definition window, drag the columns of the Data Sets box as 
shown here:

▪ Time. Drag the column B (Recording time) to the Time column. This is the 
time of manually scored behaviors relative to the time that tracking started. 
In the Select Time Format window, if the time matches one of the 
predefined formats, EthoVision XT automatically selects one. Converted 
time shows the converted time and Conversion is OK. Click OK.

▪ You can also define your own format by typing an 'H' for each number 
representing 'hour', an 'm' for 'minute', an 's' for second and a 'f' for each 
number representing millisecond (see the next picture). If Conversion is OK, 
then click OK.

▪ Under Import Time, select one of the options. 
▪ Relative to time zero. Suppose the first row in the imported external 

data set has time 00:00:05. When the option Relative to time zero is 
selected, the time stamp of the first row of the imported data set will 
remain 00:00:05.
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▪ Relative to the time of the first data line. Suppose the data set you 
want to import starts at 14:28:00 and sample every 5 seconds. With the 
option Relative to the time of the first data line, the first row of the 
imported data will get the time stamp 00:00:00. The second row will 
have time stamp 00:00:05. The options under Import Time are grayed 
out when your time stamps contain the date the file was created. In this 
case the option Relative to time zero is used.

▪ Do not drag the column A (Trial time) as this provides the same timing as 
column B when imported into The Observer.

▪ The predefined import profile EthoVision XT Data File uses the Recording 
time as time code for the manually scored behaviors.

▪ Event Type. Drag the E column and click OK in the windows that appears.
▪ If you want to import video in The Observer, you must keep the correct sync 

between events and video. See To import video in The Observer XT

Effects on the coding scheme
If you import manually scored data without creating a coding scheme in advance, at 
import of the first file The Observer creates a coding scheme with all behaviors 
contained in that file. By default, all behaviors are put in a start-stop group named 
Behavior1. To re-arrange the coding scheme, delete the observation just imported, 
move the behaviors of Behavior1 to the groups they belong to, and re-import the 
data.

Independent variables
The Observer does not import the independent variables from EthoVision XT. You 
must define those variables in the Observer’s Independent Variables List and assign 
the values of those variables to each imported file. You can find those values in the 
headers of the original export files.

Data from multiple arenas 
If your setup includes multiple arenas, for each trial you import one file per arena. If 
you want to keep data from different arenas (in the same trial) in the same 
observation, you can import the files of the second, third, etc. arena in the same 
observation as that of the first arena. To so, do the following:

▪ Follow the procedure above for the first arena. Right-click the name of the 
resulting observation and select Properties. Edit the observation name by 
giving a name that specifies the trial only, not the arena (for example Open 
Field Trial 12).
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▪ For the second, third, etc. arena file, instead of following step 6 of the 
procedure above, in the Project Explorer right-click the observation name 
and select Import Observational Data, then follow the rest of the procedure. 
The files are imported in the observation of the first arena as separate 
event logs. Rename each event log in such a way it clearly indicates the 
arena from which it was obtained.

To import video in The Observer XT
1. Open the observation, and from the Observe menu select Video, then 

Open in Current Observation and select the video file. 
2. Choose the option below that applies:

▪ If the video file was obtained with programs other than EthoVision XT, 
or if you tracked from video previously recorded with EthoVision, take 
note of the difference between the Start time and the Video start 
time (you can find these in the headers of the raw data export file). 
This difference is 0 only if you start the trial from the first video frame. 
Also, take note of the value of Recording after (also available in the 
export file). Calculate the value of Offset = Start time - Video start time 
+ Recording after.

▪ If the video file was recorded with EthoVision while doing live tracking, 
take note of the value of Recording after (you can find this in the 
headers of the raw data export file). In your case Offset = Recording 
after.

3. In The Observer XT, click the Offset button. 

4. Then choose Numerical Offset and locate the imported event log. In the 
corresponding cell, enter the Offset calculated as described above, and 
make sure that the sign stays positive (+).

5. Open the observation, click the start line of the event log. The video is 
positioned to the point that the tracking started.

See also

▪ Trial vs. track
▪ For more information on creating an import profile for The Observer XT, 

see Importing other observational data in The Observer XT Help.
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Camera Installation

Main topics and tasks
▪ Choose your camera  1267
▪ Install GigE cameras  1282
▪ Install USB 3.0 cameras  1326
▪ Install analog cameras  1332
▪ The test environment  1340
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Choose your camera
Learn about

▪ Types of cameras
▪ Cameras supported by EthoVision XT
▪ Using multiple GigE cameras
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Types of cameras
You should select the video camera most suitable for your needs:

Color vs. monochrome
Monochrome cameras are cheaper, more compact and usually have greater light 
sensitivity. If you want to film in near darkness, you must use a monochrome (or 
specialist IR) camera. If you want to track multiple animals and distinguish them on 
the basis of color markers, you (of course) need a color camera.

See also

▪ Tips for color tracking
▪ Camera position and settings
▪ Lighting setup

Digital vs. analog
The advantage of analog over digital cameras used to be that they can be placed at 
considerable distance from the computer and that they were more light sensitive. 
However, this is no longer true. 

Furthermore, current digital cameras can be as light sensitive as analog cameras.

GigE Vision digital cameras
Henceforth called GigE cameras.

Noldus can supply a GigE camera that is sensitive to 0.5 lux, and to near IR light. You 
can connect up to four GigE cameras to a desktop computer. See Install GigE 
cameras

Advantages of GigE cameras:

▪ You can use much longer cables than, for example, USB cameras. This way 
you can place the camera further away from the PC. When working with 
rodents, this solves the problem of ultrasound emissions from computers, 
which stress animals.
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▪ You do not need an encoder board to convert the analog signal into digital 
video.

▪ Relative to analog cameras, you can use a higher frame rate and a greater 
video resolution. However, recording video with a GigE camera requires a 
lot of computer resources, which may potentially decreases the quality of 
tracking. Therefore, lower the frame rate at high resolution, and vice versa.

USB 3.0 digital cameras

USB 3.0 cameras can create video of higher resolution and frame rate than analog 
cameras. However, the cable that connects the camera to the PC may up to 5 m 
long, unless you use an powered repeater cable. A 20-m powered repeater cable 
works good with EthoVision XT.

▪ EthoVision XT supports the use of one USB 3.0 camera. See USB 3.0 
cameras

▪ Most USB 2.0 cameras are not accurate enough for video tracking with 
EthoVision XT. See USB 3.0 cameras

FireWire (IEEE 1394 standard)
EthoVision XT does not support FireWire cameras. The Imaging Source FireWire 
camera of older DanioVision systems is no longer officially supported.

Internet Protocol (IP) cameras
IP cameras are definitely cheaper than industrial GigE or USB 3.0 cameras, however 
they are less accurate in the timing of video frames sent out to the EthoVision XT 
computer. This can cause EthoVision XT to skip a number of video frames during 
tracking.

If you use IP cameras, for information open the Help of EthoVision XT 17 or earlier, 
which you can download from my.noldus.com. 

Webcams
EthoVision XT could in principle work with most webcams. However, we do not 
support and do not recommend to use webcams when timing of video frames is 
important. For example, you can use a webcam to film a mouse in an open field, 
with the aim of measuring the distance moved. However, do not use webcams to 
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track multiple animals in an apparatus, or in multiple apparatuses, or when you 
use the Behavior Recognition, or whenever precise timing of events and behavior 
is needed. 

Furthermore, test if the webcam still works when other software needed to run 
during the trials is open, for example PowerPoint for stimulus presentation.

Other cameras
If you want to use a camera model other than one of the models listed under 
Cameras supported by EthoVision XT, before starting an experiment make sure that 
the timing of the camera is accurate enough for a frame-level video analysis. To do 
so, create a live tracking experiment, and carry out a test trial with the video footage 
of a digital clock for some ten minutes. Just before stopping the trial, check that the 
trial duration shown on your screen does not deviate from that obtained with the 
clock time.

Also check the Noldus support center for more information. See Noldus Support

See also

▪ Cameras supported by EthoVision XT
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Cameras supported by EthoVision XT
Overview
The maximum number of cameras that you can use depends on whether EthoVision 
XT is installed on a desktop or laptop computer. The figures reported in the 
following tables refers to the configurations tested.

For more details see Resolution, frame rate, and maximum trial duration

IMPORTANT You can use one, two, three, four, eight, 12 or 16 cameras 
simultaneously. Using for example 5 cameras is not supported. Furthermore, we do 
not support the use of a combination of different camera types.

Type Brand/Model Max number Interface board 
(for Desktop)

Driver 
version (a)

Frame
rate (f

GigE Basler acA1300-
60gm 
(monochrome)

Desktop: 16

Laptop: not 
tested, not 
supported

CT1000 Pro (1 
camera)

Adlink PCIe-
GIE74 (1-4 
cameras) (c)

Basler GigE 
Interface Card, 4 
port PoE (1-4 
cameras) (c)

FS X550AT2-2TP, 
2-port (1-16 
cameras) (c)

7.5.0.15658 60

GigE Basler acA1920-
40gc (color) (b)

Desktop: 4

Laptop: not 
tested, not 
supported

CT1000 Pro (1 
camera)

Adlink PCIe-
GIE74 (1-4 
cameras)

7.5.0.15658 40

USB 3.0 Basler acA1920-
155um 
(monochrome)

Desktop: 1

Laptop: 1

U3-PCIE1XG205 -
1S, U3X4-
PCIE4XE111

7.5.0.15658 60

Analog PhenoTyper 1 (f) Desktop: 16

Laptop: not 
tested, not 
supported

Picolo Alert (1-4 
cameras) (g)

Multicam 
6.15.1.3573

25 (PA

29.97 
(NTSC
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Drivers

▪ (a) You can find the drivers for the supported cameras on the full 
installation package, or on my.noldus.com, under Downloads > 
EthoVision XT > Drivers and Tools.

GigE cameras

▪ (b) Recommended for color tracking in low light (< 10 lux).
▪ (c) To connect multiple GigE cameras, see Using multiple GigE cameras and 

16-camera configuration
▪ For resolution, frame rates etc. see GigE cameras

USB 3.0 cameras

▪ For resolution, frame rates etc. see USB 3.0 cameras

Analog cameras

▪ (f) In theory you could use any analog camera, in combination with the 
Picolo Alert encoder board. Test your camera thoroughly before running 
the actual trials. 

▪ (g) One Picolo Alert board works with a maximum of 4 analog cameras, or 
16 cameras in combination with Quad Unit Processors. See Connect analog 
cameras to the computer

▪ For resolution, frame rates etc. see Analog cameras.

IP cameras and webcams

▪ IP cameras and webcams are no longer tested and supported. If you wish to 
keep using those cameras, make sure you test them thoroughly before 
running the actual experiments. Make sure that the number of missing 
samples is not too high.

See also

▪ Resolution, frame rate, and maximum trial duration
▪ Restrictions in EthoVision XT
▪ Install GigE cameras
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▪ Install USB 3.0 cameras
▪ Install analog cameras
▪ System requirements > Hardware
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Resolution, frame rate, and maximum trial 
duration
Click the link below for the camera type you are using. There you will find the main 
settings we used in our tests: the maximal resolution, frame rate and duration. 

▪ In all tested configurations, EthoVision XT tracked the nose-, center- and 
tail-base point of one subject with the Contour-based method (that is, no 
Deep learning) and recorded video simultaneously. Video was recorded 
without audio. When using multiple cameras, one arena was defined for 
each camera. Each section reports which detection method worked with 
zero (or a low percentage of) missed samples.

▪ If you want to track the subjects using Deep learning, there are further 
restrictions. See Deep learning: Requirements.

▪ If a test was successful with Deep Learning (DL in the tables in the following 
sections), then it is assumed that Contour-based tracking (C) also works.

▪ The figures report the maximum time tested. Acquiring longer trials is 
possible in principle, but you must test your configuration thoroughly. Run 
a test trial with the desired resolution and frame rate, and check that the 
resulting video does not contain too many missing video frames, and check 
that the tracks obtained do not contain too many missing samples, for 
example less than 5%. See View the detection statistics

▪ IMPORTANT  When tracking for more than 24 hours, always reboot the PC 
after every trial to refresh the PC resources, the RAM specifically. Failure to 
do so could result in crashing, which can corrupt the experiment, or the 
recorded video.

▪ IMPORTANT  When you track many animals in multiple arenas, simultaneous 
tracking and video recording may go beyond the processor’s capability. In 
those cases, choose Save video, track later in the Acquisition Settings 
window to be able to record at higher resolution without skipping video 
frames. See Record video, then acquire a trial

▪ IMPORTANT  The test results reported here may differ from those you 
experience, even when using the same camera, PC and graphics card. For 
example depending on the lighting and the camera settings.

Click the camera type that applies: 

▪ GigE cameras
▪ USB 3.0 cameras
▪ Analog cameras
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GigE cameras
Basler acA1300-60gm

▪ Monochrome.
▪ Standard camera of PhenoTyper 2.
▪ Interface: Gigabit Ethernet (RJ45 connector, CAT5e or CAT6 (the latter 

recommended when using 16 cameras).
▪ Sensor: 1/1.8” Progressive Scan CMOS.
▪ Cable length: 10 m (standard) up to 100 m (not tested).
▪ Maximum number of cameras: 16.
▪ Recommended color space in EthoVision XT: Y800. 
▪ This camera is also the standard camera in DanioVision and 

PhenoTyperversion 2.
▪ Tested on Operating system Windows 11 Pro, 23H2.
▪ Resolution: For configurations with two or more cameras, the resolution of 

the resulting video file is reported. The resolution of the single camera 
image is given in brackets.
EXAMPLE 1 2560 x 2048 (1280 x 1024) means that four images 1280 x 1024 
arranged 2x2 result in a video file with resolution 2560 x 2048. The 
resolution of each camera image in the video file is the same as the original 
value.

EXAMPLE 2 1280 x 1024 (1280 x 1024) means that four images 1280 x 1024 
arranged 2x2 result in a video file with the same resolution. That is, the 
resolution of the camera image in the video file is reduced to one half of 
the original value.

Tested configurations with 1 camera, desktop

NOTE

Computer Operating 
system

Resolution 
(W x H)

Frame rate  
(fps)

Duration (h) DL or C

Dell 
Precision 
3680

W11 1280 x 1024 60 3 DL
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▪ Graphics card: NVIDIA T1000, 8 GB. Detection method: Dynamic 
Subtraction or Differencing. Missing samples: 0.1%.

Tested configurations with 2 cameras, desktop

NOTES

▪ Graphics card: NVIDIA T1000, 8 GB. Detection method: Dynamic 
Subtraction or Differencing. Missing samples: 0.0%.

▪ The cameras were connected to the network interface board FS X550AT2-
2TP through a network switch FS 3100-16TMS. For this switch you need an 
adapter (SFP+ 10GBASE-T Copper 30m RJ-45 Transceiver module) attached 
to the Ethernet RJ45 connector. We recommend to use CAT6 network 
cables. Connect the cameras to the powered ports of the switch. 

▪ See also Using multiple GigE cameras

Tested configurations with 4 cameras

NOTES

▪ Graphics card: NVIDIA T1000, 8 GB. Detection method: Dynamic 
subtraction. Binning: 1 (see Binning). Missing samples: 0.0%.

▪ The cameras were connected to the network interface board FS X550AT2-
2TP through a network switch FS 3100-16TMS. For this switch you need an 
adapter (SFP+ 10GBASE-T Copper 30m RJ-45 Transceiver module) attached 

Computer Operating 
system

Resolution 
(W x H)

Frame rate  
(fps)

Duration (h) DL or C

Dell 
Precision 
3680

W11 1920 x 540 
(960 x 540)

30 3 DL

Computer Operating 
system

Resolution 
(W x H)

Frame rate  
(fps)

Duration (h) DL or C

Dell 
Precision 
3680

W11 2560 x 2048 
(1280 x 1024)

25 3 DL

Dell 
Precision 
3680

W11 2560 x 2048 
(1280 x 1024)

60 3 C
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to the Ethernet RJ45 connector. Connect the cameras to the powered ports 
of the switch. 

▪ See also Using multiple GigE cameras

Tested configurations with 16 cameras

NOTES

▪ Graphics card: NVIDIA T1000, 8 GB. Detection method: Dynamic 
Subtraction or Differencing. Missing samples: 0.0 %. Binning: 2 (see 
Binning).

▪ Body point detection technique: DL = Deep learning, C = Contour-based.
▪ For Deep learning, see also Deep learning: Requirements and GPUs tested 

and supported
▪ The cameras were connected to a network interface board FS X550AT2-2TP 

through a network switch FS 3100-16TMS. For this switch you need an 
adapter (SFP+ 10GBASE-T Copper 30m RJ-45 Transceiver module) attached 
to the Ethernet RJ45 connector. We recommend to use CAT6 network 
cables. With this switch, you need to connect eight cameras to eight PoE 
injectors because the switch has only eight powered ports. Instead, use a 
16-powered ports switch (not tested).

▪ See also Using multiple GigE cameras and 16-camera configuration.

Basler acA1920-40gc
▪ Color camera; recommended for tracking colors in dim light.
▪ Interface: Gigabit Ethernet (RJ45 connector, CAT5e or higher).
▪ Sensor: 1/1.2” CMOS.
▪ Maximum number of cameras: 4.
▪ Recommended color space in EthoVision XT: BYRG.

Computer Operating 
system

Resolution 
(W x H)

Frame rate  
(fps)

Duration (h) DL or C

Dell 
Precision 
3680

W11 2560 x 1920 
(640 x 480)

30 72 C
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▪ In the Basler pylon Viewer software the pixel format that corresponds to 
BYRG is Bayer RG8. See Settings for the color camera and Pixel format and 
color space

▪ Resolution: For configurations with two or more cameras, the resolution of 
the resulting video file is reported. The resolution of the single camera 
image is given in brackets.

▪ In brackets, the resolution of the single camera image is reported.

Tested configurations, desktop

NOTES

▪ Detection method tested: Dynamic subtraction (DS) or Differencing (DF). 
Missing samples 0.0%. For tracking monochrome video: color space Y800. 
For color-marker tracking: color space BYRG.

▪ Body point detection technique: DL = Deep learning, C = Contour-based. 
For Deep learning, see also Deep learning: Requirements

▪ Desktop: Dell Precision 3680, Graphics card NVIDIA T1000 8 GB, AdLink 4-
port PCIe-GIE74 network interface board. For deep learning see also GPUs 
tested and supported.

See also

▪ Cameras supported by EthoVision XT

Computer Operating 
system

Nr. 
cameras

Resolution 
(WxH)

Frame rate 
(fps)

Duration  
(h)

DL 
or C

Dell 
Precision 
3680

W11 1 1920 x 1200 30 (DS, DF) 3 DL

Dell 
Precision 
3680

W11 4 3840 x 2400 
(1920 x 1200)

15 (DS) 12 DL
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USB 3.0 cameras
Basler acA1920-155um

▪ Monochrome.
▪ Interface: USB 3.0. A separate PCIe USB 3.0 interface board is required. 
▪ Sensor: 1/1.2” CMOS.
▪ Cable length: 3 m (standard) or 20 m (with powered extension cable, not 

tested).
▪ Maximum number of cameras: 1.
▪ Recommended color space in EthoVision XT: Y800.
▪ See Install USB 3.0 cameras

Tested configurations with 1 camera

NOTES

▪ Detection method used: Dynamic subtraction (DS) or Differencing (DF). 
Missing samples 0.0%.

▪ Body point detection technique: DL = Deep learning, C = Contour-based.
▪ Desktop: Dell Precision 3680, Graphics card NVIDIA T1000 8 GB. The camera 

was connected through a Basler USB 3.0 PCIe Interface card. 
▪ Laptop: Dell Precision 3591, Graphics card NVIDIA RTX 1000. The camera 

was connected through a USB 3.0 port on the motherboard.
▪ For deep learning see also GPUs tested and supported.

See also

▪ Resolution, frame rate, and maximum trial duration

Computer Operating 
system

Resolution 
(WxH)

Frame rate 
(fps)

Duration  
(h)

DL or C

Desktop Dell 
Precision 
3680

W11 1920 x 1200 60 (DS) 12 DL

Laptop Dell 
Precision 
3591

W11 1920 x 1200 25 (DS, DF) 12 DL
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Analog cameras
PhenoTyper 1

▪ TV Standard: PAL and NTSC.
▪ Cable length: up to 100 m (not tested).
▪ Maximum number of cameras: 16 when using one Picolo Alert encoder 

board and four video processors (Quad Units). See Install analog cameras
▪ Resolution: For configurations with two or more cameras, the resolution of 

the resulting video file is reported. In brackets, the resolution of the single 
camera image is reported.

▪ IMPORTANT  When mixing 16 PhenoTyper 1 cameras, the resolution of a 
single camera image is 384 x 288 (PAL) or 320 x 240 (NTSC). This resolution 
is often too low for nose-tail tracking. If you want to use the Deep learning-
based method to track subjects, work with up to four analog cameras (and 
four arenas).

Tested configurations with 4 cameras, desktop

Tested configurations with 16 cameras, desktop

NOTES

▪ Detection method used: Dynamic subtraction or Differencing. Missing 
samples: 0.0 %.

Computer Video Resolution 
(WxH)

Frame rate 
(fps)

Duration  
(h)

DL or C

Dell Precision 
3680

PAL 1536 x 1152 
(768 x 576)

25 3 DL

Dell Precision 
3680

NTSC 1280 x 960 
(640 x 480)

29.97 3 DL

Computer Video Resolution 
(WxH)

Frame rate 
(fps)

Duration  
(h)

DL or C

Dell Precision 
3680

PAL 1536 x 1152 
(384 x 288)

25 72 C

Dell Precision 
3680

NTSC 1280 x 960 
(320 x 240)

29.97 72 C
1280



▪ Body point detection technique: DL = Deep learning, C = Contour-based.
▪ Desktop: Dell Precision 3680, Graphics card NVIDIA T1000 8 GB, Picolo Alert 

encoder board. For deep learning see also GPUs tested and supported
▪ Quad unit used for testing 16 camera: UHPPOTE 4CH Color Quad System.

See also

▪ Resolution, frame rate, and maximum trial duration
▪ Connect analog cameras to the computer
▪ The PhenoTyper - EthoVision XT 18 - Reference Manual. See Manuals
1281



Install GigE cameras
Together with the Basler GigE camera, you need a 1Gb Ethernet board installed in 
your computer. To connect the camera, you need at least cat-5e cables.

IMPORTANT  To install the camera, follow each step below. Most information applies 
to the Basler GigE cameras. 

What do you want to do?
▪ Install an Ethernet board for GigE cameras
▪ Install the driver software for the digital cameras
▪ Assign IP addresses
▪ Disable the Windows firewall for the Ethernet board
▪ Connect the GigE camera to the PC
▪ Configure the digital camera
▪ Using multiple GigE cameras

See also

▪ Cameras supported by EthoVision XT
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Install an Ethernet board for GigE 
cameras
Aim
To install a network board that receives video from one or more GigE cameras.

NOTE  If you ordered a computer from Noldus Information Technology when you 
purchased EthoVision XT and Basler GigE cameras, the Ethernet interface board(s) 
has already been installed and tested. If you bought your computer somewhere 
else, you will have to install the board yourself. Follow the instructions below. 

IMPORTANT  The network interface board must support data transfer of 1 Gb/s. 

This topic applies to Ethernet interface boards that have been tested with 
EthoVision XT.

▪ One-port board: the Intel PRO/1000 CT (or its successor), to connect one 
camera.

▪ Four-port board: the Adlink PCIe-GIE74 (A), or the Basler GigE Interface 
Card (B) to connect up to four cameras.

▪ Two-port board: FS X550AT2-2TP. This was combined with an optical switch 
FS 3100-16TMS to connect 16 GigE cameras. See 16-camera configuration
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Procedure
1. Turn off your computer and all connected peripherals, such as the monitor 

and printer. Make sure that the computer is unplugged.
2. Remove the PC's case according to the instructions provided in the PC's 

user manual.
3. Select a free PCIe expansion slot, and remove the corresponding extension 

cover.
Different PCIe slots have different properties, resulting in different 
performances. When possible, choose the slot that gives maximum 
performance. To estimate performance, take note of the slot version (2, 3, 
etc.) and compare it with the following:

▪ PCIe v1.x: 250 MB/s
▪ PCIe v2.x: 500 MB/s
▪ PCIe v3.0: ~1 GB/s
▪ PCIe v4.0: ~2 GB/s
▪ PCIe v5.0: ~4 GB/s
▪ PCIe v6.0: ~8 GB/s
Note that values are given per lane; they should not be multiplied by the 
number of lanes in a slot (e.g. x4) since the board has a 1x connector). For 
example, SLOT1-PCIe3x4 written near the slot means version 3.0 with four 
lanes.

IMPORTANT  Do not insert the PCIe board in the blue or white slots.
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4. Unpack the Ethernet board, place it into the slot, and press it carefully into 
position. If the board does not fit into place easily, remove it and repeat the 
operation.

IMPORTANT When touching the board, its electronic components can be 
damaged by static electricity. To avoid any such risk, make sure that you are 
grounded. You can ground yourself by putting on an earthing wristlet, and 
attaching its clip to the metal frame of the computer. If you do not have an 
earthing wristlet, hold the metal frame with one hand while holding the 
Ethernet board in your other hand. Ensure also that your clothing does not 
touch any components while handling the board.

5. This step is only for when installing a 4-port board.
Connect the power connector on the board (Molex/IDE male 4-pin DC) to 
one of the power supplies inside the PC. See Power the Ethernet board for 
the GigE cameras

6. Fix the board to the chassis and re-fit the computer's cover.
7. IMPORTANT  If you have not done yet so, turn off Fast startup in the 

Windows Power options. See Power options when using cameras
8. Next: Install the driver software for the digital cameras.
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Main settings of the Ethernet board
You may need to check these settings if the PC / camera are set correctly based on 
this Help and yet you get camera issues in EthoVision XT:

1. In Windows, open the Device Manager.
2. Under Network adapters, locate your Ethernet board, right-click on it and 

select Properties. 
3. Click the Power Management tab.
4. Make sure that Allow the computer to turn off this device to save power 

is not selected. 

Notes
▪ Here is some information from Basler about network interface boards and 

which ones are supported with the GigE cameras:
https://docs.baslerweb.com/hardware-installation-(gige-cameras)#basler-
1gige-cameras

See also the knowledge base of Basler:

https://docs.baslerweb.com/knowledge-articles#gige

▪ IMPORTANT  Turn off Fast startup in the Windows Power options. See Power 
options when using cameras
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Power the Ethernet board for the GigE 
cameras
Aim
To power the GigE cameras without the PoE injectors.

This topic applies when you have a 4-port Ethernet interface board to connect the 
GigE cameras to your EthoVision XT computer.

Prerequisites
▪ You have installed a 4-port Ethernet board. See Install an Ethernet board for 

GigE cameras

Procedure
Power cable and connector types vary between computers. Many computers have a 
SATA 15-pin power connector. Use an adapter cable with a 4-pin female Molex 
connector at one end and a SATA 15-pin connector at the other end. 

If a separate cable is not available, you can disconnect the cable that from the 
power supply (PSU) goes to the hard disk (HD) and connect that end to a Y adapter 
cable, whose other two ends go to the hard disk and to the Ethernet board:
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Notes
▪ When your Ethernet board is not powered, you must power the camera 

using a Gigabit Power-over-Ethernet injector (PoE injector; one per camera). 
The data transfer rate of the PoE injector must be 1 Gbit/s. See Connect the 
GigE camera to the PC
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Install the driver software for the digital 
cameras
Aim
To install the software that enables you to configure the camera. For example, to set 
the video frame rate or the exposure time.

IMPORTANT  Whenever possible, install the Basler driver software from the setup file 
of EthoVision XT, following the procedure below, not from the original Basler driver 
installation file Basler_pylon_[version number].exe. If, for any reason, you must 
install the driver from that file, follow the note at the end of this topic.

This topic applies to Basler GigE cameras (model name ending with gm or gc), and 
Basler USB cameras (model name ending with um).

Procedure (recommended)
1. If you have not done so, download the EthoVision XT installation files from 

my.noldus.com.
2. Double-click EthoVision XT - Setup - [version number].exe. If you have 

already installed EthoVision XT, select Modify; otherwise select Install.
3. Under Drivers and tools, select:

▪ Basler GigE camera driver if you have Basler GigE cameras.
▪ Basler USB camera driver if you have Basler USB 3.0 cameras.

4. Click Install/Update and continue with installation.
5. Next: Assign IP addresses.

Procedure (manual installation)
If you need to install the camera driver software from the original installation file, do 
the following:
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1. If you have the installation file already, make sure that its version is the 
version that EthoVision XT uses. For Basler cameras, this is 
Basler_pylon_7.5.0. Skip the next step and go to step 3.

2. To download the driver, log in to my.noldus.com. Choose Downloads > 
EthoVision XT > Drivers and Tools. 
For Basler cameras, choose Basler Camera Driver.

Extract its content and copy everything to the local disk.

3. Double-click the exe file. Accept the Terms and Conditions, then click Next.
4. For the Basler driver: Under Profiles, select Custom and click Next. 
5. For the Basler driver: Under Features, choose:

▪ For GigE Vision cameras, GigE Camera Support.

      

▪ For USB 3.0 cameras, USB Camera Support. 

     

6. Also select:
▪ pylon Viewer and
▪ DirectShow Support.
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7. Complete the installation.

Notes
▪ Always install the drivers that you download from the Noldus web site. Do 

not install drivers from other sources, unless requested by Noldus Support.
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Settings of the Ethernet board
Aim
If camera is setup correctly based on this Help and you have checked all the System 
requirements and yet there are camera issues in EthoVision XT, e.g. dropped frames, 
it may be good to check the settings of the Ethernet interface board.

Procedure
1. In the Windows search field, type in device. In the results list click Device 

Manager.
2. Open the Network adapters item. 
3. Locate the item that has the same name as the network port connected to 

the camera.

4. Right-click that item in the Device Manager and select Properties, then 
click the Advanced tab.

5. Adjust the settings as here:
▪ Interrupt Moderation: Disabled.
▪ Interrupt Moderation Rate: Off.
▪ Receive Buffers: 2048.
▪ Jumbo Packet: 9014 Bytes.
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6. Click the Power Management tab and de-select Allow the computer to 
turn off this device to save power.
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Connect the GigE camera to the PC
Aim
To make sure that EthoVision XT receives the video signal from the GigE camera.

Prerequisites
▪ You have followed the entire procedure in Install an Ethernet board for GigE 

cameras.
▪ No matter how many cameras you use, you need a 1-Gb Ethernet interface 

board (desktop computers only).
▪ When you use a 4-port Ethernet board, you can power the cameras with 

Power-over-Ethernet (PoE) injectors but you can also choose to connect the 
board to the power outlet inside the PC. See Power the Ethernet board for 
the GigE cameras

▪ You must use a 1-Gb (1 Gigabit/s) Power-over-Ethernet (PoE) injector: 
▪ When the Ethernet interface board is not powered. This is usually the 

case for 1- or 2- port boards. Also 4-port boards may not be powered - 
See Power the Ethernet board for the GigE cameras

▪ When you use a network switch ant this has RJ45 ports that are not 
powered. In all cases, use one PoE injector per camera.

▪ Cables: Use Cat5e or Cat6e crossover cables.
▪ Do not use an Ethernet to USB adapter (in the picture below) to connect the 

camera to the PC. Always connect the camera and the PC directly using an 
Ethernet crossover cable. 
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Procedure

If you have a single or dual port Ethernet board

To connect one camera, you need a single or dual port Ethernet interface board. To 
connect two cameras, you need a dual port Ethernet interface board. If the board is 
not powered, you need as many PoE injectors as cameras. Only use 1Gbit/s PoE 
injectors.

1. Using cross-network cables (cat-5e or newer), connect the Ethernet port/
board on the PC to the IN port of the PoE injector. Connect the camera to 
the OUT port. Use the short cable between PoE injector and PC. Use the 
long cable between PoE injector and camera.

2. Power up the PoE injector; make sure that the two CONNECT and ON 
green LEDs are on.
If the green LEDs keep blinking, wait a few more seconds. If you see no 
change, disconnect the cables, then re-connect them.

3. Next: Configure the digital camera.

You can also connect two cameras to two single-port Ethernet boards:
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If you have a four-port Ethernet board

When you use this board, the PoE injector is not required. However, the Ethernet 
board must receive power from the PC. See the connection scheme in Power the 
Ethernet board for the GigE cameras

1. Connect each camera (up to four) to one of the ports on the Ethernet 
board, as shown in the figure below.

2. Next: Assign IP addresses.

Notes
▪ TIP  Label the cameras and the Ethernet ports (for example Cam 1, Cam 2 

etc.). Take note of the camera’s serial numbers; these actions may be useful 
when you need to know which camera is connected to which port and 
assign or adjust the IP addresses.
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▪ The Power over Ethernet (PoE) injector is a device that passes power along 
with data (in this case, video data from the camera) on twisted-pair Ethernet 
cabling.

▪ If you bought your camera elsewhere, make sure you bought the correct 
Ethernet cables. Cheap or incorrect cables will affect frame rate and result in 
missing samples. Always use Cat5e, Cat6 or Cat7. 
▪ Cat6 and Cat7 cables support higher network speeds (5 Gb/s or higher) 

than Cat5e (2.5 Gbps), but these are way above the network speeds 
required for a GigE camera and Ethernet board. 

▪ Cat5e cables are cheaper, lighter and thinner and may be the preferred 
choice for some applications due to ease of installation in tight spots. 
They are typically easier to terminate as well.

See also

▪ Using multiple GigE cameras
▪ Assign IP addresses
▪ Configure the digital camera
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Assign IP addresses
Aim
To make sure that the IP address of the GigE camera and that Ethernet interface 
board physically connected to that camera match. This ensures reliable data transfer 
to and from the camera.

What do you want to do?
▪ Assign the IP address to the Ethernet interface board
▪ Assign the IP address to the camera

TIP  For how to assign IP addresses and connect digital GigE Vision cameras, watch 
the video tutorial Set Up the Cameras. To open the tutorial, choose Help > Video 
Tutorial.

Assign the IP address to the Ethernet interface board
This applies to Basler GigE cameras.

1. In Windows, search for Network connections or Network computers. 

Alternatively, in Windows 11, from the Start menu choose Settings > 
Network and Internet > Advanced network settings (at the bottom of 
the screen) > More network adapter options.

2. The Network Connections window opens. Right-click the item that 
correspond to your camera and click Properties.
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TIP  If your computer has more than one adapter item, unplug the camera 
and take note of which item shows Unplugged. That indicates the port that 
camera was connected to.

NOTE  You may see one or more additional items named Ethernet or similar. 
This is the standard interface board that is connected to your local network 
and the internet. Do not use that port unless it is the only one available. If 
you use that port to connect the camera, you won’t be able to connect the 
EthoVision XT computer to your local network and the internet.

3. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

4. Select Use the following IP address and fill in the details as shown in the 
figure below. Also select the option Validate settings upon exit. When 
done, click OK and then Close.
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For US-Canada users: please enter 192.168.200.101. In case of multiple 
Ethernet boards or one board with multiple ports, use 192.168.201.101 for 
the second board/port, 192.168.202.101 for the third, etc.

5. Close all windows. Repeat the steps for each port on the board connected 
to a camera. See also Using multiple GigE cameras

Assign the IP address to the camera
The procedure below is for Basler GigE cameras, not Basler USB 3.0 cameras.

1. If you have not done so yet, Connect the GigE camera to the PC.
2. In Windows, search for and start pylon IP Configurator.
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3. Select the camera name that appears under the Ethernet port set in the 
previous procedure. This is the camera physically connected to that port.

Note that the camera status is Not reachable. This is normal since the 
camera cannot communicate yet with the Ethernet port.

4. Under Static IP, fill in the details in the IP Address and Subnet Mask fields 
as shown here. 

If you have multiple cameras, the IP address must differ between cameras 
and match the IP address of the Ethernet port. See also Using multiple GigE 
cameras

For US-Canada users: Please enter 192.168.200.1 for camera IP address. For 
the second camera on same card, 192.168.200.2, etc. The first three 
numbers must match the address set for the Ethernet port the camera is 
connected to. For example, a camera connected to 192.168.201.101 can be 
designated as 192.168.201.1.

5. Click Save and then close pylon IP Configurator, or repeat the procedure 
for the next camera. See also Using multiple GigE cameras

6. Next: Configure the digital camera.
1301



See also

▪ Connect the GigE camera to the PC
▪ Configure the digital camera
▪ Using multiple GigE cameras
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Disable the Windows firewall for the 
Ethernet board
Aim
To allow the camera network traffic through the firewall.

Procedure
By following this procedure, you exempt the network adapter connected to the 
camera(s) from the firewall. You may need to do this if EthoVision XT does not show 
the live camera image, or EthoVision XT shows a message like Device unplugged.

1. Do one of the following:
▪ From the Windows Start menu, select Settings. Next, select Privacy & 

Security > Windows Security > Firewall & Network Protection, 
then click Advanced Settings.

▪ In the Windows Control panel, select Network and Internet > 
Network and Sharing Center > Windows Defender Firewall, then 
click Advanced Settings.

2. At the bottom of the Overview middle panel click Windows Defender 
Firewall Properties.

3. In the new window that opens, click the Domain Profile tab.
4. Next to Protected network connections, click the Customize button.
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5. De-select the network adapters that are used only for the camera(s), and 
click OK.

6. Repeat the steps 4-6 above on the Private Profile and Public Profile tabs.
7. Click Close.
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See also

▪ Connect the GigE camera to the PC
▪ Configure the digital camera
▪ Using multiple GigE cameras
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Configure the digital camera
Aim
To adjust settings in a Basler GigE camera or USB 3.0 camera, like the video frame 
rate, video frame resolution, and exposure time, within the camera software.

▪ You can also change most of these settings within EthoVision XT. See Adjust 
camera settings in EthoVision XT

▪ IMPORTANT  Do not use pylon Viewer to record video! Always use 
EthoVision XT or MediaRecorder.

Main actions
▪ Procedure (general)
▪ Set the video resolution
▪ Set the camera frame rate
▪ Center the camera view
▪ Set the pixel format
▪ Adjust the camera exposure time
▪ Adjust the camera gain
▪ Adjust the white balance
▪ Save the camera settings
▪ Do a factory reset on the Basler GigE camera

Procedure (general)
1. Make sure EthoVision XT (and MediaRecorder, when present on the 

computer) are not running.
2. In the Apps screen, choose Basler > pylon Viewer.

pylon Viewer is installed only if you selected to install the Basler camera 
drivers during installation of EthoVision XT. See Install EthoVision XT

3. From the Windows menu of pylon Viewer select Features - All. 
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4. In the Devices panel, double-click the item Basler under GigE or USB 
depending on the camera you have.

If an error message Failed to download... appears, it is probably caused by 
the mismatch between IP addresses of camera and Ethernet interface. 
Adjust the IP addresses and when ready click the Refresh button in pylon 
Viewer. See Assign IP addresses

5. To preview the camera image, click the Continuous Shot button on the 
toolbar. 

IMPORTANT  Do not use the Record button if you want to record video! This 
creates very large files. Always use EthoVision XT record video.

6. Under Features - All, expand the camera name and choose the settings 
category that you would like to adjust. See the instructions that apply in the 
following sections.
NOTE  To be able to adjust the settings, click the Stop button first.

7. After you have adjusted the camera settings, save them under 
Configuration Sets. See Save the camera settings

8. When working with multiple cameras, repeat the procedure for each 
camera.
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Set the video resolution
1. In the Features panel, open the Basler camera item and then the AOI 

Controls item (Image Format Control for USB 3.0 cameras). 
2. You can set the resolution by adjusting the Width and the Height.

▪ Recommended: 1280 x 960 or 1280 x 1024.
▪ When using multiple cameras you may need to limit the resolution, 

also depending on the frame rate and the tracking methods you intend 
to use. See suggestions for GigE cameras and USB 3.0 cameras 

3. Save the settings. See Save the camera settings

Set the camera frame rate
1. In the Features panel, under Category, open the camera item and then 

click Acquisition Controls.
2. Select Enable Acquisition Frame Rate.
3. Next to Acquisition Frame Rate (Abs) [Hz], enter the frame rate you 

require (frames per second).

4. To check that the frame rate is stable, click the Continuous Shot button on 
the toolbar. 

Under the live video window, locate the resulting frame rate. This is the 
frame rate that the camera can sustain with the current settings. Check that 
this matches the value you have just set.

5. Save the camera settings.
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Center the camera view
Follow this procedure to make sure the camera view is centered. Alternatively, you 
can use part of the original camera image by operating the Offset controls.

1. In the Features panel, open the Basler camera item and then the AOI 
Controls item (Image Format Control for USB 3.0 cameras). 

2. Select both options Center X and Center Y.

3. Save the camera settings.
NOTE  If you want to have the camera image off center, for example to focus on one 
region of interest, do the following in pylon Viewer:

1. Under Features > AOI Controls de-select Center X and Center Y. 
2. Click the Stop button.

3. De-select Center X and/or Center Y.
4. If the Width and Height of the image are set to the maximum values, 

reduce those values so you have room for the offset adjustment (see 
below). 

5. Move the X Offset and Y Offset sliders. 
6. Click the Continuous shot button and check the live camera view. 
7. When you are satisfied with the new off-center camera view, Save the 

camera settings. For more details, see the camera documentation.
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Set the pixel format
Pixel format is the format in which video data sent out by the camera sensor is 
represented and analyzed by EthoVision XT.

1. Click the Stop button.

2. In the Features panel, under Category, open the camera item and then 
click Image Format Controls.

3. Select the Pixel Format:
▪ For monochrome cameras, choose Mono 8.
▪ For color cameras, choose Bayer RG 8. See also Settings for the color 

camera
IMPORTANT  Mono 8 corresponds to the option Y800 in EthoVision XT. See Adjust 
camera settings in EthoVision XT > Format tab.

Adjust the camera exposure time
The exposure time (or shutter time) is the time the camera shutter is kept open to 
let light in. The exposure time limits the maximum achievable frame rate. If the sum 
of the exposure time and the time needed for reading the chip (readout time) is 
greater than the time between consecutive video frames, the next frame may be 
dropped, resulting in a lower frame rate, and missed samples during tracking.

To adjust camera exposure that matches a frame rate:

1. In the Features panel, under Category, open the camera item and then 
click Acquisition Controls.

2. Make sure that Exposure Mode is Timed, and Exposure Auto is Off.
3. Next to Exposure Time (Abs) [us], enter the exposure time you require, in 

microseconds.
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▪ For Zebrafish larvae, enter 4000 or 2000, depending on the video 
resolution chosen. If resolution in EthoVision is 1280 x 960 or similar, 
select 4000. If the resolution is 640 x 480 or similar, select 2000.

▪ In all other cases, you may choose a higher value. The ideal range of 
exposure will likely be anywhere from 2000 to 10,000. 

▪ If lighting in the room is low, you will likely need a longer exposure 
time. Try 8000 up as high as 15000. When tracking under infrared light, 
you generally need to set high Exposure times, up to 20000. 

▪ Values higher than 20000 are not recommended - increase illumination 
or set the Gain a bit higher. See Adjust the camera gain

▪ Note that a longer exposure time may cause motion blur. Faster 
animals like flying insects require shorter exposure times than other, 
slow-moving animals. In case of motion blur, reduce exposure time and 
compensate this by opening the lens aperture and/or increasing the 
amount of ambient light (the latter is preferred).

4. A longer exposure time may conflict with the time that the software needs 
to process an image, because both must fit within the time between two 
successive video images. In that case some video images may be dropped 
during acquisition. To check that the exposure time is compatible with the 
frame rate you have chosen, click the Continuous Shot button on the 
toolbar. 

At the bottom of the live video window, locate the frame rate resulting with 
the new exposure time. If the camera can cope with the new exposure time, 
the current frame rate should be the same as that set next to Acquisition 
Frame Rate (Abs) [Hz]. This is usually 25, 30 or 60.
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If the exposure time is very high, the resulting frame rate could be lower 
than the set frame rate Acquisition Frame Rate (Abs) [Hz].

For example, setting an Exposure time of 40000 (40 ms) reduces the frame 
rate from 25 to 20:

To solve this, do one of the following:
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▪ Under Acquisition Controls, lower the Exposure Time (Raw). This 
makes the video image darker. To compensate for that, open the lens 
diaphragm so that the camera sensor receives more light. Note, 
however, that an open diaphragm reduces the depth of field, that is, 
the range of distances where the object appear sharp in the camera 
image.

▪ Under AOI Controls, lower the Width and Height (video resolution). 
Do this until you see the expected frame rate under the live view.

5. Save the camera settings.

Adjust the camera gain
Camera gain amplifies the video signal. A higher value of gain results in a brighter 
image. That could be an option whenever the image is too dark for EthoVision XT to 
detect a subject, and you do not have other ways to correct for that. For example, 
when the lens of the camera is wide open and you cannot increase light intensity in 
the test room.

TIP  Whenever possible, add lights instead of increasing camera gain. See Lighting 
setup and the video tutorial Set up Your Test Environment (Help > Video Tutorial).

1. Start the live view by clicking the Continuous Shot button.

2. In the Features panel, click Analog Control.
3. From the Gain Auto list, select Off.
4. Next to Gain (Raw), select the value you require.

In normal situations values like 0 or 1 should suffice. Only increase the gain 
further if there is no other way to get a bright image (e.g. by increasing the 
exposure time, or improving the ambient light, or opening the aperture ring 
of the lens). However, increasing gain results in more image noise.
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5. Check the live view and adjust the gain when necessary.
6. When ready, Save the camera settings.

Adjust the white balance
If you have a color camera, you also need to adjust its white balance.

1. Click Color Improvements Control.

2. Point the camera at a piece of white paper, so that the camera image looks 
entirely white. Click in the field next to Balance White Auto and select 
Once from the list.

3. Save the settings (see below). See also Settings for the color camera

Save the camera settings
IMPORTANT  If you have multiple GigE/USB 3.0 cameras, make sure that you save the 
settings for each camera. To select a camera, double-click its name in the Device 
panel in pylon Viewer, adjust the settings that you require and repeat the procedure 
to save the settings.

1. Click the Stop button.

2. In the Features panel, click Configuration Sets (User Set Control for USB 
3.0 cameras).
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3. From the Configuration Set Selector list (User Set Selector for USB 3.0 
cameras), select User Set 1.

4. Next to User Set Save, click Execute. The camera settings are saved under 
User Set 1.

5. From the Default Startup Set list (User Set Default for USB 3.0 cameras), 
select User Set 1. This means that the camera always starts with the 
settings contained in User Set 1.

6. Close pylon Viewer.
These settings will be used each time you start up EthoVision XT.

TIP  You can also save different settings for the same camera in User Set 2 and User 
Set 3. Under Default Startup Set/User Set Default, select which you want 
EthoVision to use.

Do a factory reset on the Basler GigE camera
1. Open pylon Viewer and double-click the camera name. At the bottom left 

of the interface, click All Features.
2. In the Features window, expand Configuration Sets. 
3. For Configuration Set Selector, select Default Configuration Set. 
4. For Default Startup Set, select Default User Set.
5. For User Set Save, click the Execute button.
6. For User Set Load, click the Execute button.
7. The camera should now be reset to factory defaults.

At this point you need to set the resolution, frame rate, exposure and other settings 
while still in pylon Viewer. See the top of this topic. Finally, save the settings with a 
specific name (e.g. User Set 1) so you can always return to those settings (User Set 
Load) when needed.
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Using multiple GigE cameras
Aim
To track from two up to four GigE cameras. This topic applies to Basler GigE cameras 
only.

IMPORTANT You cannot use a combination of analog and digital cameras. Also, 
mixing video images of different camera types is not supported. 

Connect the cameras
How you connect multiple GigE cameras depends on which Ethernet interface 
board you have installed.

▪ If you have multiple, 1-port Ethernet boards, connect each camera to a 
Ethernet board. If the boards are not powered, you must connect the 
cameras through PoE injectors to a power supply. Only use 1Gbit/s PoE 
injectors.

▪ If you have a 4-port Ethernet board, you can connect up to four cameras.
IMPORTANT  Make sure the Ethernet board also receives power from the PC. 
See the connection in Power the Ethernet board for the GigE cameras
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▪ For a 16-camera configuration, see 16-camera configuration
▪ IMPORTANT  Each camera must always be connected to the same port on 

the Ethernet board, because the IP address of the camera and that of the 
Ethernet port must match. In the case of a multi-port Ethernet board, each 
port is viewed as a network adapter, with its own IP address. The 
information of which port is linked is stored in the driver software of each 
camera. If you swap cameras, they will not be recognized. Therefore, always 
label the Ethernet ports and the cameras.
TIP  When using one Ethernet interface board per camera, rename the 
network adapters listed in the Windows Control Panel, for example Front 
camera and Top camera.

Assign the IP addresses to multiple cameras
You can assign IP addresses with pylon IP Configurator.

1. Assign an IP address to each Ethernet port on your PC. See Assign IP 
addresses. 

2. Assign an IP address to each camera. See Assign IP addresses
Here are the main rules:

▪ Each camera must have a unique IP address. 
▪ Always set the first two numbers to 192.168.
▪ The third number must be the same for the camera and the Ethernet port 

the camera is connected with. 
EXAMPLE

▪ Camera 1: IP address 192.168.1.101 connected to Ethernet port with IP 
address 192.168.1.51

▪ Camera 2: IP address 192.168.2.102 connected to Ethernet port with IP 
192.168.2.52.
In pylon IP configurator, the first camera looks like this.
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Video resolution
You can set the video resolution in EthoVision XT. See Select multiple GigE cameras 
in EthoVision XT. 

See also

▪ 16-camera configuration
▪ GigE cameras
▪ Install an Ethernet board for GigE cameras
▪ Power the Ethernet board for the GigE cameras
▪ Assign IP addresses
▪ Configure the digital camera
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16-camera configuration
IMPORTANT  When using a 16-camera configuration, we recommend to use 
Contour-based tracking, not Deep learning. This because Deep learning is so 
resource-demanding that it is unlikely to work with 16 arenas on a typical PC.

Setup

Hardware and settings

▪ PC: Dell Precision 3680, CPU i7-14700K 3.4 GHz, RAM memory 32GB, GPU 
NVIDIA T1000 8 GB; Windows 11 Pro 23H2.

▪ 16 Basler GigE cameras acA1300-60gm.
▪ PCIe Ethernet interface board: FS X550-AT2, 10GBase-T Dual-Port, PCIe 3.0 

x4.
▪ Network switch: FS S3100-16TMS-P, 16-Port Gigabit Ethernet L2+ PoE+, 8x 

PoE+ Ports@125W, 2x 5Gb RJ45, with 2x 10Gb SFP+ Uplinks.
▪ For this switch you need an adapter (SFP+ 10GBASE-T Copper 30m RJ-45 

Transceiver module) for the network cable that goes to the PC. 
▪ We recommend to use CAT6+ network cables. 
▪ Video resolution: single camera view 640 x 480, merged view in EthoVision 

XT 2560 x 1920.
▪ Image binning: 2. See Binning
▪ Video frame rate: 30 fps. Trial duration: 72 hours.
▪ Video source: Live tracking; Number of subjects per arena: 1; Tracked 

features: Center-point, nose-point and tail-base detection; Body Point 
Detection Technique: Contour-based. Detection method: Dynamic 
Subtraction or Differencing. Acquisition mode: Track + Save video.

Connection scheme

Follow this scheme also for PhenoTyper 2. Note that in the S3100-16TMS-P network 
switch, the RJ45 ports marked in yellow are powered, so eight cameras do not need 
PoE injectors. Connect the remaining eight cameras through PoE injectors.
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Connect the cameras as follows:

Assign the IP addresses

The figure above shows an example of IP addresses that worked. See also Assign IP 
addresses

Connect the cameras to the switch using the ports as in the figure above. For a 
good overview of the IP addresses we recommend to use pylon IP Configurator.

Start pylon IP Configurator.
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For the port of the Ethernet board of the PC connected to the switch, specify the 
address 192.168.1.51. To do so, locate the Ethernet row in IP Configurator, that is, 
the row with the board symbol connected to the cameras. Note that the name of 
the Ethernet row may vary between PCs.

Right-click and select Properties, then double-click Internet Protocol Version 4, 
select Use the following IP address, and enter the IP address in the IP Address 
field.

For the cameras (1 to 16), specify the following addresses: 192.168.1.101 to 
192.168.1.116.

Note that the third number must be the same as that for the Ethernet port 
connected to the network switch. To assign the IP addresses to a camera, select the 
camera row, then in the panel at the bottom of the screen choose Static IP and 
enter the IP address.

For all Ethernet ports and cameras, leave 255.255.255.0 as Subnet Mask.

For more schemes of multiple camera configurations, see also the PhenoTyper - 
EthoVision XT 18 - Reference Manual.
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Using network switches
▪ The network switches must be of type PoE (Power over Ethernet), that is, 

they must provide power to the cameras. Mind that the maximum power 
provided by a switch, measured in Watt (W), must be greater than that the 
total requirements of the cameras (one Basler camera requires about 2.5 
W).

▪ The network switches must be able to handle large packets (known as 
jumbo packets or jumbo frames). With jumbo frame-capable devices, the 
maximum packet size can be up to 16 KB. For maximum network efficiency, 
your camera should be configured to use the largest packet size that your 
network adapters and switches can handle.

▪ Refer to the user guide of the network switch for how to set it up.

See also

▪ GigE cameras
▪ Install an Ethernet board for GigE cameras
▪ Power the Ethernet board for the GigE cameras
▪ Connect the GigE camera to the PC
▪ Assign IP addresses
▪ Configure the digital camera
▪ Select multiple GigE cameras in EthoVision XT
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Select multiple GigE cameras in 
EthoVision XT
Aim
To have EthoVision XT mix the images from multiple cameras in a picture-by-picture 
fashion.

Procedure
1. Connect your cameras. 

Connect each camera to the port of its Ethernet board. Each camera has its 
unique link with one of the Ethernet boards. This link is the IP address. If 
you swap cameras, EthoVision XT won’t get the camera image. See Connect 
the GigE camera to the PC and Assign IP addresses

2. In EthoVision XT, choose Setup > Experiment Settings and select the 
number of cameras from the list next to Number of sources.

3. Select the cameras under Source. The camera names will show their own IP 
address in brackets at the end, which makes it possible to distinguish 
between the cameras.

4. Select the resolution and frame rate of the first camera. The resolution and 
frame rate of the other cameras is set automatically to the same values as 
for the first camera.

5. Next to Merged camera view, select whether the picture by picture mixed 
image should have the same resolution as the images from the individual 
cameras, of whether the resolution should be the sum of that of each 
camera image.
NOTE  The maximum total resolution depends on which cameras you have. 
For Basler monochrome cameras, the maximum resolution is 2560 x 2048 
when mixing four camera images. However, each camera model has its own 
set of available resolutions, which also determine the maximum resolution 
when merging the camera images. See tested configurations for GigE 
cameras (including PhenoTyper 2).

6. Click the preview icon to get a preview of the merged camera images.
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Recommended video resolutions
▪ 4-camera configuration: Single camera view 1280 x 1024, merged camera 

view 2560 x 2048. See Using multiple GigE cameras
▪ 8-camera configuration: Single camera view 640 x 480, merged camera 

view 2560 x 960. See Using multiple GigE cameras
▪ 16-camera configuration: Single camera view 640 x 480, merged camera 

view 2560 x 1920. See 16-camera configuration
▪ See also Resolution, frame rate, and maximum trial duration

Notes
▪ Noldus does not support video tracking from multiple GigE cameras 

connected to a laptop computer. Always connect multiple cameras to a 
desktop computer.

▪ When using multiple cameras, pay attention to the lens settings. These 
should be in such a way that the apparent size of the arenas is the same 
since you calibrate the distance for all the cameras (Shared calibration). If 
that is not possible, make one calibration for each arena (Unshared 
calibration). See Calibrate multiple arenas 

▪ The cameras should have the same Firmware version. Check this in the 
pylon Viewer software. In the Features panel, under Device Information, 
check Firmware Version. If the two (or more) cameras do not have the 
same firmware, an upgrade/downgrade must be done. 
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See also

▪ Cameras supported by EthoVision XT 
▪ For examples of frame rate and resolution when using multiple cameras: 

GigE cameras
▪ Connect the GigE camera to the PC
▪ Assign IP addresses
▪ To view the camera image Select multiple cameras
▪ PhenoTyper - EthoVision XT 18 - Reference Manual. See Manuals
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Install USB 3.0 cameras
To work with a USB 3.0 camera, if your PC does not have a USB 3.0 port, then you 
need to install a USB 3.0 interface board (for desktop computers).

What do you want to do?
▪ Install the USB 3.0 interface board
▪ Install the USB 3.0 camera driver
▪ Connect the USB 3.0 camera to the PC
▪ Configure the digital camera

See also

▪ Cameras supported by EthoVision XT
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Install the USB 3.0 interface board
Aim
To install an interface board that receives video from one or more USB 3.0 cameras.

We tested the following USB 3.0 interface boards:

▪ U3-PCIE1XG205-1S Ren 1HC, x1, 2 ports

▪ U3X4-PCIE4XE111 Fresco FL1100, 4HC, x4, 4 ports

IMPORTANT  Although these boards have multiple USB ports, always connect one 
camera only.

Procedure
1. Turn off your computer and all connected peripherals, such as the monitor 

and printer. Make sure that the computer is unplugged.
2. Remove the PC's case according to the instructions provided in the PC's 

user manual.
3. Select a free PCIe expansion slot, and remove the corresponding extension 

cover. For details about PCIe slots, see Install an Ethernet board for GigE 
cameras.

4. Unpack the USB 3.0 interface board, place it into the slot, and press it 
carefully into position. If the board does not fit into place easily, remove it 
and repeat the operation.
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5. Fix the board to the chassis and re-fit the computer's cover.
If you have a 4-port Fresco Logic U3X4-PCIE4XE111 board, make sure that 
the board receives power from the PC. Connect the power connector on the 
board (Molex/IDE male 4-pin DC) to one of the power supplies inside the 
PC (C). Connector types vary between computers. Many computers have a 
SATA 15-pin power connector. Use an adapter cable with a 4-pin female 
Molex connector at one end and a SATA 15-pin connector at the other end.

6. Proceed with Install the USB 3.0 camera driver.

Notes
▪ For the best performance, the USB 3.0 interface board should be installed in 

a PCIe Gen 2 compliant slot in the host computer. Most computers have 
PCIe Gen 2 (5.0 Gbps) throughput on x8, x16 or x 32 slots. A PCIe Gen 1 
compliant slot reaches up to 2.5 Gbps throughput.

▪ IMPORTANT  Turn off Fast startup in the Windows Power options. See Power 
options when using cameras
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Install the USB 3.0 camera driver
Aim
To install the software that enables you to configure the camera. For example, to set 
the video frame rate or the exposure time.

Prerequisite
▪ You have installed the USB 3.0 interface board. See Install the USB 3.0 

interface board

Procedure
1. Please follow the procedure in the topic 

Install the driver software for the digital cameras

▪ If you have already installed EthoVision XT, on the installation screen 
choose Modify and under Drivers and tools choose Basler USB 
camera driver.

▪ If you still have to install EthoVision XT, choose Install, then under 
Drivers and tools choose Basler USB camera driver.

2. Next: Connect the USB 3.0 camera to the PC
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Connect the USB 3.0 camera to the PC
One USB 3.0 camera
Connect the camera to the USB 3.0 interface board of the EthoVision XT desktop 
computer, or to a USB 3.0 port on the EthoVision XT laptop computer.

▪ USB cables are usually 3 to 5 meter long. These are generally passive cables, 
meaning that quality of the signal degrades with cable length. Longer 
passive cables are not recommended. If you need cables to cover more 
than 5 m distance, use a active (powered) extension cable. 

▪ Some USB 3.0 connectors and ports can be recognized by their blue color 
coding. Others show 'SS' (SuperSpeed) and the USB sign.

Multiple USB 3.0 cameras
IMPORTANT  EthoVision XT has been tested with one USB 3.0 camera. If you want to 
use multiple USB 3.0 cameras simultaneously, test them thoroughly before running 
your experiments. Install as many USB 3.0 PCIe interface boards as cameras, unless 
you have an USB 3.0 4-port interface board. See Install the USB 3.0 interface board

How you connect multiple USB 3.0 cameras depends on which USB 3.0 interface 
board you have installed.

▪ If you have multiple interface boards with 2 ports each, connect each 
camera to one of the ports on the USB 3.0 boards.
IMPORTANT  Do not connect two cameras to the same USB 3.0 interface 
board.
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▪ If you have a 4-port interface board, you can connect up to four cameras. 
Connect each camera to one of the USB ports.

Notes
▪ If you have one USB 3.0 interface board with two ports, always connect one 

camera. You can use the second port as a power source when using an 
extension cable.

See also

▪ Cameras supported by EthoVision XT
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Install analog cameras
What do you want to do?

▪ Install the Picolo Alert encoder board

NOTE the Picolo H.264 boards are no longer supported with EthoVision XT.

▪ Connect analog cameras to the computer
▪ Test an analog camera

See also

▪ Cameras supported by EthoVision XT > Analog cameras
1332



Install the Picolo Alert encoder board
Aim
To install the encoder board Picolo Alert on your computer. You need this board to 
track and record video using analog cameras. 

NOTE  If you ordered a computer from Noldus Information Technology when you 
purchased EthoVision XT, the encoder board is already installed. Follow the 
procedure below if you bought your computer somewhere else.

Prerequisite
▪ IMPORTANT  Turn off Fast startup in the Windows Power options. See Power 

options when using cameras

Procedure

Insert the Picolo Alert board in the PC

1. Turn off the PC and disconnect the power cable.
2. Open the computer and gently but firmly insert the board into a free PCI 

express slot. Avoid touching the contacts or other metal parts of the board.

For details about PCIe slots, see Install an Ethernet board for GigE cameras.

3. Close the PC.
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4. Connect the power cable and turn the PC on.

Install the driver for the Picolo Alert board

1. Browse to my.noldus.com, log in or register, and select Downloads > 
EthoVision XT > Drivers and Tools. 

2. Download and save the file Euresys Multicam - Driver win10.
3. Run the exe file and continue with installation.
4. When the following message appears:

5. Click Install.
6. At the end of installation, restart the PC.
7. Next, see Connect analog cameras to the computer.

Notes
▪ Always install the drivers from my.noldus.com. Do not install drivers from 

other sources, unless requested by Noldus Support.

See also

▪ Analog cameras
▪ Install analog cameras
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Connect analog cameras to the computer
Connect one to four cameras
Connect each camera to one of the inputs of the Picolo Alert encoder board.

Furthermore:

▪ Take note of which camera is connected to which input of the board.
▪ Make sure that all four switches on the board are in the position opposite to 

their labels.

▪ Create or open an experiment, choose Setup > Experiment Settings, then 
select Live tracking and under Video Source select the camera inputs. 
Next, view the mixed camera image. See Video source

Connect up to 16 cameras
You can track from up to 16 analog cameras simultaneously if you connect Quad 
Unit Processors between each group of four cameras and the four inputs the Picolo 
Alert encoder board. 

A Quad Unit Processor mixes the video inputs of up to four cameras. Connect the 
output of the Quad Unit Processor to one of the inputs of the Picolo Alert board, as 
shown in the figure below.
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To connect 16 cameras, you need:

▪ Four Quad Unit Processors.
▪ One Picolo Alert board.

Connect the output of each Quad Unit Processor to one input of the Picolo Alert 
board.

Notes
▪ The Picolo U4/U8 H.264 boards are no longer supported with EthoVision 

XT.

See also

▪ Install the Picolo Alert encoder board
▪ Experiment settings > Video source
▪ The PhenoTyper - EthoVision XT 18 - Reference Manual for more 

information about using multiple PhenoTypers. See Manuals
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Test an analog camera
Aim
To check whether your analog camera and the Euresys Picolo Alert encoder board 
are functioning properly.

Prerequisites
▪ When you install EthoVision XT you have also installed the Euresys 

Multicam driver for the Picolo Alert encoder board. See Install EthoVision 
XT. This software also include Multicam Studio.

▪ If Multicam Studio is not installed on your EthoVision XT computer, browse 
to my.noldus.com, log in or register, and select Downloads > EthoVision 
XT > Drivers and Tools and download and save the file Euresys Multicam 
-Driver win10. Run this file and install Multicam Studio.

Procedure
1. Connect the camera to the EthoVision XT computer.
2. Power up the camera.
3. Double-click Multicam Studio.
4. Select the video input and check the camera image. When necessary, adjust 

the settings like the video standard.

See also

▪ Install analog cameras
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Power options when using cameras
Aim
To disable Fast startup on your computer. This prevents problems when recording 
videos from within EthoVision XT.

NOTE  By default the computer has the Fast startup option enabled. This can 
sometimes cause EthoVision XT and MediaRecorder to stop responding when 
selecting an input of the frame grabber board or camera. That problem has been 
found when using encoder boards for analog cameras, but we recommend to 
follow the procedure below for any type of camera you have.

Procedure
1. Open the Windows Control Panel, and select System & Security. 
2. Under Power Options select Choose what the power button does. Click 

Change settings that are currently unavailable.
3. Under Shutdown settings, de-select Turn on fast startup 

(recommended).
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See also

▪ Install GigE cameras
▪ Install USB 3.0 cameras
▪ Install analog cameras
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The test environment
Learn about

▪ Camera position and settings
▪ Physical setup of an arena
▪ Lighting setup

TIP  Watch the video Set Up Your Test Environment, which you can find in the 
main EthoVision XT video tutorial (Help > Video Tutorial).
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Camera position and settings
TIP  Watch the video Set Up the Cameras, in the EthoVision XT video tutorial (Help 
> Video Tutorial).

Attach the cameras

With the ceiling mount
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With the Autopole

For this configuration you need an Autopole, a SuperClamp and a camera adapter 
(all shown in the following figure).

The Autopole range is 2.1-3.7m, or up to 5.7m with the extension (sold separately).

NOTE  The elements shown here may slightly differ from those you have purchased.

How to attach the camera to the SuperClamp:

1. Connect the camera to the SuperClamp through the brass stud connector 
or the camera adapter.

2. The Autopole gets clamped between the jaws of the SuperClamp. Turn the 
handle to tighten the SuperClamp to the Autopole. 

Horizontal installation is mainly for top view tracking. For this you need the 
Autopole and the SuperClamp. 
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Vertical installation is for top view tracking and side view tracking. For this you need 
the Autopole, the SuperClamp and a camera adapter (see above). For more 
flexibility you can use a variable friction arm attached between the SuperClamp and 
the camera adapter. 
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Suspended ceilings

If you need to attach the camera to suspended ceilings, you can get a special 
mount that has two parts which move like scissors. Move them to open up the 
mount and it will fit over the framework of the suspended ceiling, then close them 
to hold. Attach the camera adapter and then the camera. 
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This is a temporary mount, it is sturdy enough but you can always open the mount 
to remove it from the ceiling and place it elsewhere. If you have a suspended ceiling 
it’s probably the best solution.

Cable length
The maximal length of the cable between camera and computer depends on the 
type of camera you use.

▪ For GigE cameras and Analog cameras: 100 m.
▪ For USB 3.0 cameras: 5 m. You can increase this length by means of an 

active extension cable (not tested though). See Connect the USB 3.0 camera 
to the PC.

Things to check
▪ Position the camera perpendicular to the plane in which the animal moves. 

If this is not the case, the shape of the arena and subject inside will appear 
distorted on the screen and calculated distances, velocities and spatial 
statistics will be incorrect.

▪ Anchor the entire setup. Secure the position of the arena, camera and 
illumination relative to each other, and fasten the camera zoom, focus 
control and aperture settings.

▪ Adjust the zoom setting (or select the appropriate lens) and focus the lens 
until the entire experimental arena is visible on the screen and is displayed 
in focus.

▪ When using multiple cameras, pay attention to the zoom settings. These 
should be in such a way that the apparent size of the arenas is the same 
since you calibrate the distance for all the cameras (Shared calibration). If 
that is not possible, make one calibration for each arena (Unshared 
calibration). See Calibrate multiple arenas 

▪ Turn off all automatic camera settings: focus, gain, exposure (auto-iris), anti-
shake.

▪ Adjust the camera aperture until the image shows maximal contrast. 
Depending on how bright your IR setup is, you might need to open the 
aperture on the lens all the way (do this first) and/or adjust the cameras 
Gain (Raw) and/or adjust the Exposure time in Pylon Viewer. See Configure 
the digital camera

See also Lighting setup
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View the camera image in EthoVision XT
1. IMPORTANT  When using digital cameras, close the camera software Basler 

pylon Viewer before operating the camera in EthoVision XT.
2. Create a new experiment.
3. Choose Setup > Experiment Settings.
4. Set the Video source to Live tracking. For details, see Video source.
5. Click the camera button (for single cameras) or the eye button (for multiple 

cameras in merged view).

Image magnification
If you need to get higher magnification images than is available with a standard 
lens (get 'closer'), then you can use one of the following techniques.

Macro lens

A true macro lens, that is, a lens of a magnification of at least 1:1 (expressed as 'real 
world': CCD chip size) usually gives good quality images. However, it is often 
expensive and probably gives a lower magnification than either a close-up filter or 
an extension ring.

Extension rings 

An extension ring inserted between the camera body and the lens enables you to 
focus on subjects closer to the camera, and so provides a greater magnification. An 
extension ring is usually cheaper than a true macro lens, but more expensive than a 
close-up filter. It may give a reduction in optical quality, and it will reduce the light 
intensity of the signal, but you can use it to get very high magnifications.

Close-up filter 

This is a lens attached in front of the normal lens, to give greater magnification. It is 
also known as a close-up lens. It works by shortening the focal length of the lens 
while keeping the lens-to-camera distance constant, which increases the 
magnification of the lens. The strength of a close-up filter is measured in diopters, 
which is the fraction by which the lens' focal length is shortened. Thus, a +3 lens 
reduces the focal length of the lens to which it is attached by 1/3. A close-up filter is 
usually cheaper than a macro lens or extension ring, but it gives lower 
magnification, and poorer optical quality.
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Microscope

EthoVision XT tracks well from cameras attached to microscopes. Use back-lighting 
to maximize contrast.

Change color to monochrome
If you If you have a color camera, you can temporarily change it to monochrome by 
changing the Pixel format setting. For Basler cameras:

▪ In pylon Viewer, change the Pixel format to Mono8. See Set the pixel 
format

▪ In EthoVision XT, set the Color space to Y800. See Adjust camera settings 
in EthoVision XT > Color space

See also Settings for the color camera
1347



Physical setup of an arena
Think carefully about the kind of enclosure to use in your experiments. Consider 
both the background of the arena, as well as its size and position. 

Location
Place the computer and all electrical equipment other then the cameras in a room 
separate from the test room. Computers and electrical devices produce ultrasound, 
which may affect the behavior of the subjects.

For specific tests, see also the EthoVision XT 18 - Application Manual. See Manuals

TIP  Watch the video Set Up Your Test Environment, which you can find in the 
EthoVision XT video tutorial (Help > Video Tutorial).

Background
▪ The animals you are tracking should be able to move freely and naturally.
▪ The background must be fixed in relation to the camera. Make sure you 

firmly anchor the entire setup when it is completed. If the arena moves, you 
must update the background image.

▪ The background should be made of non-reflective surfaces. If this is 
unavoidable (e.g. the water in a Morris water maze) use indirect illumination 
(e.g. bounce light of the ceiling) and non-reflective surfaces (e.g. black pool 
sides). For details, see Lighting setup.

▪ There should be maximum contrast between the background and the 
animal. For a Morris water maze:
▪ If you use dark animals, color the water with white tempera paint.
▪ If you use white animals, add 300 g of tempera black nontoxic 

powdered paint to a 45 liter pool.

Dimensions of the arena
▪ The arena should have no 'depth', because the camera can only see in two 

dimensions. If the animal can move towards or away from the camera, like 
when climbing on a shelter, its apparent size will vary. This may interfere 
with subject detection and tracking. 

▪ If you want to track animals in a three-dimensional environment like an 
aquarium, then make sure this is as shallow as possible, or only calculate 
variables like In zone, not Distance moved or Distance to a zone. For true 
3D movement analysis, contact your nearest Noldus office.
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▪ The maximum arena size (in pixels) is limited by the image resolution (W x 
H) of the digital video file you are using, or the resolution of the live camera 
image set in the Experiment Settings. Your subject must be at least three 
pixels wide in order for EthoVision XT to distinguish it from system noise. 
Therefore, the ratio of your maximum subject size to the maximum arena 
size is given by the limiting resolution (usually H) divided by three. With 
digital; cameras and a vertical resolution of 1024 pixels, this is 
approximately about 300 times the animals' size. In practice the limit is 
lower, depending on various factors including the animal’s contrast with the 
background. Especially when tracking small insects, for more robust 
tracking, make sure that the subject is always at least 10-20 pixels large.

Maximum size of the arena
When you have video of resolution L × H (in pixels), and you want to track a subject 
of l × w (length x width, in mm), check the following:

▪ Calculate the ratio maximum subject size to maximum arena size = H/3.
▪ Calculate the maximum arena size = w × (H/3)

If the arena was bigger than that limit, the subject would often be less than three 
pixels wide and EthoVision XT would not be able to distinguish it from random 
noise.

Maximum size of multiple arenas in one image
If you use multiple arenas, the calculation applies to the total distance across all 
arenas, thus if you have four arenas in a square, the maximum width of each one is 
half what it would be if you had only one arena.
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Lighting setup
Ideal light conditions
A good lighting setup is vital to get a good image that EthoVision can use to 
accurately track your animal. This is particularly important when you want to do 
nose-tail tracking or track multiple animals with color markers. To produce a good 
image, the lighting must satisfy three criteria:

▪ It must be bright enough. Stand-alone video cameras (which we 
recommend) can sometimes work at 0.1 lux or darker. At higher light levels 
you can work with a smaller aperture. See also Using EthoVision XT in near 
darkness. Please note that poor lighting gives more noise in the image 
which enlarges the video file size.

▪ It must be even. That is, a diffuse light source, such as a shaded fluorescent 
tube or globe-type incandescent bulb. Spotlights can produce changing 
shadows and reflections.

▪ There must be no reflection of the light source visible in the image (see 
below).

TIP  Watch the video Set Up Your Test Environment, which you can find in the 
EthoVision XT video tutorial (Help > Video Tutorial).

Eliminating reflections
If you have reflections in your image, EthoVision may confuse those reflections with 
your subject, and track the reflections rather than your animal. Preventing 
reflections is particularly important when you want to do nose-tail tracking. There 
are a number of measures that you can take to reduce this problem:

▪ Surfaces within the arena should be (whenever possible) a dark color and 
matte texture.

▪ Lighting should be from a diffuse source, such as a shaded fluorescent tube 
or globe-type incandescent bulb.

▪ The light source should not be in direct line-of-sight of the camera (that is, 
it should be indirect lighting). You can achieve this by bouncing the light off 
the ceiling or walls (which should be a pale color and matte texture) and, if 
necessary, placing a shield in between the light source and lens.

▪ If your arena is transparent (for example, a glass olfactometer), you can use 
backlighting. This will eliminate reflections, but you must take special care 
that the lighting is even and diffuse. Place the light source underneath the 
setup and attach a sheet of white paper to the bottom to create diffuse 
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back light. It is important to avoid light coming from above as much as 
possible, otherwise there is no effect of back light.

▪ You could also try a polarizing filter in front of the camera lens. The filter 
will remove reflections that are incident to the reflective surface at 32 - 37.

▪ If possible, draw your arena in such a way that bright reflecting rims of 
mazes are excluded.

▪ To remove reflections brighter or darker than your animal, set appropriate 
thresholds in the Detection Settings.

▪ To remove reflections larger than your animal, enter an appropriate value 
for the Maximum Subject size in the Detection Settings. Note that if your 
animal enters the area of the reflection, EthoVision might no longer be able 
to track it if you use this setting.

Lighting a Morris water maze
Lighting a Morris water maze needs to be carried out particularly carefully because 
the water can give large and variable reflections. Some of these can be excluded by 
the software settings listed above, and the following lighting setup should give 
good results:

Place four (or more) bulbs round the pool, below the level of the water surface or at 
the ceiling. 'Globe' type bulbs are ideal (twice the diameter as standard 
incandescent light bulbs). They should be close enough to the pool wall so that 
there is no direct line of sight between the bulbs and the camera lens. The light is 
reflected off the walls and ceiling, so that it only reaches both the lens and water 
surface indirectly.
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▪ Take special care when dealing with water and electricity in the same room. 
The lights should be placed so that water cannot splash on them, ideally 
they should be suitable for outdoor use (double-insulated) and if 
connected to an electrical outlet in the same room as the water maze they 
should be connected through a circuit-breaker.

▪ Ask a photographer for advice on the lighting of your water maze.

Lighting water tanks
When using water tanks like in the Porsolt forced swim test, a problem is often that 
there is a lot of reflection, especially just above the water surface. Furthermore, 
detection of the animal can be hindered by the water's meniscus.

Try to make a set-up with as much contrast between animals and background as 
possible. For instance, when you have white rats, preferably use a completely black 
background. Back light (that is, light from behind the subjects so you only see the 
animals' contour) generally gives very good results. A solution to remove the 
water's meniscus in the video image is also to place the test cylinders in a separate 
tank with water (for example an aquarium) and then make recordings. The water 
level in the tank should be higher than in the cylinders.

For more information on the Porsolt forced swim test, see the EthoVision XT 18 - 
Application Manual.

Using EthoVision XT in near darkness
Nocturnal animals like rats and mice are active in the dark. It is, therefore, a logical 
choice to measure their behavior in the dark. You can use infrared (IR) lights to 
illuminate the arena and a camera that is sensitive in the infrared. Most animals, 
including rats and mice, do not see infrared (IR) or near-infrared (NIR) light. Infrared 
illumination is perceived by them (and also by humans) as being total darkness.

Camera

Infrared light (IR) is light of a longer wavelength than visible light. Generally, to track 
with EthoVision XT, near-infrared light is used, with a wavelength of 700-900 nm 
(near the visible range of 400-700 nm). Color video cameras are insensitive to 
infrared but standard monochrome cameras have reasonable sensitivity to near IR.

In particular, the Basler monochrome GigE cameras are IR sensitive. Normally they 
do not require an IR-pass filter unless you want to track the animals in both dark 
and light conditions during the same trials, for example in multi-day trials. See Light 
in 24-hour experiments

Below: Sensitivity to infrared light of a standard monochrome camera and a 
specialist IR camera.
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Optimizing image brightness

Depending on how bright your IR setup is, you might need to:

▪ Open the aperture on the lens all the way (do this first).
▪ Adjust the cameras Gain and/or the Exposure setting in EthoVision XT. 

▪ A high Gain increases brightness but also noise in the image.
▪ A longer Exposure time may not be compatible with the frame rate set 

in the camera. Check carefully in Adjust the camera exposure time
TIP  Watch the video Set Up the Cameras, which you can find in the EthoVision XT 
video tutorial (Help > Video Tutorial).

Light source

As your light source, you can use IR illuminators, which basically are LED lamps that 
produce infrared rather than visible light. Using an IR illuminator is just like using a 
lamp, except that neither you nor your animals can see its light. Check the image 
from your camera to see what the illumination actually looks like. Just as with visible 
light, you want uniform lighting throughout your arenas. You may find that objects 
that look light in visible light, appear dark in the IR image, and vice versa. Likewise, 
objects that appear transparent may be opaque, or opaque objects (especially some 
kinds of acrylic) may be transparent in the IR image. You can record through acrylic, 
unless it has been colored or coated with pigments that absorb IR light. You can 
use, for example, a sheet of acrylic to cover the top of a cage or arena. If you use an 
IR illuminator from overhead, you may gets spots of reflective glare, just as with 
normal lighting. Moving the illuminators to the sides, rather than overhead, can 
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eliminate the glare. To eliminate shadows, you may get the best results by using two 
or more illuminators.

▪ You can obtain IR LED illuminators from Noldus Information Technology.
▪ You can also use an IR lightbox as your light source. An IR lightbox provides 

a uniform source of IR illumination from beneath your animal. Unlike the 
case with an IR illuminator, the camera will see a dark silhouette of the 
animal against a light background, which is easy to track in EthoVision. An 
IR lightbox is also an excellent solution if your animals are highly variable or 
mottled in color, for example Long Evans rats, and eliminates any concern 
about glare.

Light in 24-hour experiments
If you want to go from light to dark conditions (or vice versa) during a single trial 
(e.g., recording across a 24-hour circadian cycle), EthoVision needs consistent 
lighting. This can be accomplished by using an IR-pass filter on your camera and by 
preventing any variation in the amount of IR illumination. 

Should you require an IR-pass filter, take note of the lens characteristics. The filter 
should match the diameter of the lens, and simply screws on to the front of the lens.

The filter prevents the camera from seeing visible light, only IR light gets through. 
The filter is not necessary under constant lighting conditions, but you need it if the 
visible light level changes during the trial. The IR illumination must remain on for 
the entire duration of the trial. 

Some IR illuminators have the feature of automatically turning off when there is 
visible light (for example, IR illuminators designed for security applications usually 
turn off during the day). If your illuminator has this function, it needs to be disabled. 
Consult the documentation for your illuminator to see how this is done. If it is not 
possible to prevent the automatic turning off, you can cover the illuminator's light 
sensor with tape so that it will not detect light.
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The normal light in the room should not affect the detection setting unless it also 
emits IR light. Many light fixtures will give off some IR illumination in addition to 
visible light. Incandescent and halogen lights especially will produce a great deal of 
infrared light. Preferably use fluorescent lights which produce much less infrared 
light. If there is an intensity adjustment on your IR illuminator, turn it up as high as 
possible. Increasing the amount of IR illumination will minimize the impact of any 
infrared light from your visible lights. Sunlight also has an IR component, so if you 
have windows, they should be covered. When watching the camera image, ideally 
you should see no change in the image when the visible lights turn on or off. It 
might be that your image is slightly out of focus, but that is no problem for tracking 
in EthoVision.

Notes

▪ If you have light colored animals, use the darkest non-reflective bedding 
possible for improved contrast. Be aware that some dark materials may 
appear white under infrared light. See also the section Recommended 
materials in the PhenoTyper - EthoVision XT 18 - Reference Manual. See 
Manuals

▪ If you have not eliminated all infrared light from the visible light in the test 
room, and you are using Static subtraction as your detection method, the 
entire arena may be detected as the animal after the visible lighting 
changes. Choose Dynamic subtraction and the animal will be detected after 
a few frames.
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Using Digital Video

Main topics and tasks
▪ Video file formats  1357
▪ Record digital video  1360
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Video file formats
Background information
One of the difficulties with digital video files is that the file extension does not 
indicate what the file type is. For example, the extension *.mpg can mean any one of 
different type of formats, and an MPEG-4 movie can have the extension mpg, mpeg, 
mp4, m4v or avi. 

IMPORTANT  If you are not sure whether the format of your video files is compatible 
with video tracking in EthoVision XT, test a few video files thoroughly and check 
that there are no or few missing video frames. 

▪ Video file formats supported by EthoVision XT
▪ Video files created by EthoVision XT
▪ Video files created by Media Recorder
▪ Video formats not supported by EthoVision XT

Video file formats supported by EthoVision XT
IMPORTANT When in doubt, test a video format thoroughly before carrying out 
experiments. Acquire test trials and check that there are no missing samples, and 
the video plays smooth in the various parts of the software.

If the video format is not compatible, convert video to H.264 MPEG-4. That should 
solve the issue.

MPEG-4

This is a collection of formats, not all are supported. MPEG-4 can achieve a very 
high rate of compression with good quality, because it separately codes the 
background (which does not change much from frame to frame) from the moving 
parts of the video. 

MPEG-4 (mp4v) in a MP42 container, with extension *.mp4, is the format of video 
files recorded with Media Recorder 4 and EthoVision XT 15.

H.264 AVC 

H.264 AVC is a type of MPEG-4 and is also known under the names H.264/AVC, 
AVC/H.264, H.264/MPEG-4 AVC, MPEG-4/H.264 AVC, MPEG-4 Part 10 or x.264. It 
creates good video quality and uses previously-encoded pictures as references in a 
much more flexible way than in other standards, allowing the use of up to 16 
reference frames.
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H264 AVC in MP42 container, with extension *.mp4, is the format of video created 
by EthoVision XT 16-18 and MediaRecorder 5 and 6. See Video files created by 
EthoVision XT

Video files created by EthoVision XT
When you record video with EthoVision XT, video is encoded with the H.264/
MPEG-4 AVC codec and is stored in a container of MP4-version 2 (MP42). The 
video file extension is mp4.

Note that a container is something different as the codec. 

▪ The container is the structure that handles various streams such as video 
and audio streams. You can imagine the container as a box that contains 
your video frames.

▪ The codec is software that compresses the video stream data.
For information about the H.264 specification, you can find many internet pages 
that explain the process of video/audio compression. Here is one of them:

https://www.videoproc.com/resource/h264-codec.htm

Video files created by Media Recorder

MediaRecorder 4.0

▪ With analog cameras: H.264 AVC in an MPG container.
▪ With GigE cameras: MPEG-4 Video in an MP4-version 2 container.
▪ With IP cameras: H.264 stream in an MP4-version 2 container.

MediaRecorder 5.0

▪ With all cameras: H.264 stream in an MP4-version 2 container.

MediaRecorder 6.5

▪ With all cameras: H.264 stream in an MP4-version 2 container.
All video files have file extension mp4.

Video formats not supported by EthoVision XT
IMPORTANT  The term “not supported” means that the video formats listed below 
were not thoroughly tested by Noldus. It may be that some formats work fine. If 
you have old MPEG-2 videos and you want to re-track them with EthoVision XT, test 
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them and check whether (1) Video plays smooth and without artifacts (“blocks” in 
the image) and (2) Samples are not missed during tracking, even when selecting the 
Detection Determines Speed (DDS) option.

IMPORTANT  When using camcorders or other encoding software to make video 
files, test those files in EthoVision XT before deciding to work with them or convert 
them to a supported format. See Video file formats supported by EthoVision XT

▪ MPEG-1. 
▪ MPEG-2. This is a collection of formats, not all may work in EthoVision XT. 
▪ DivX.
▪ Variants of MPEG-4. However, an AVI 1.0 file with codec MP43, and an 

OpenDML AVI file with codec MP4S-ISO MPEG-4 Video V1 may work. 
▪ DV-AVI. This is uncompressed video from FireWire cameras. We do not 

recommend this format because of the large file size. DV-AVI is a special 
case of AVI. In general, EthoVision XT does not support video files of AVI 
format. The AVI format should not be confused with the file extension avi.

▪ WMV. However, an OpenDML AVI file with codec WMP v9 may work.
▪ Quick Time.
▪ FLV (Flash video, YouTube).
▪ XviD variants of the MPEG-4 format. However, an OpenDML AVI file with 

codec XviD 1.0 RC4 may work.

See also

▪ Record digital video
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Record digital video
Background
Digital video requires a lot of storage capacity and always needs to be compressed 
before it can be stored on a disk medium. In order to compress a video recording 
you need an encoder, usually a plug-in board, which converts the video signal into a 
media file on disk at a fraction of the original size. The input signal can either be 
analog or digital.

Prerequisites
▪ If you have analog cameras: EthoVision XT works with the Picolo Alert 

encoder board. You can use this board not only for live tracking, but also for 
recording video. See Install analog cameras

▪ If you have digital cameras:
▪ Install GigE cameras
▪ Install USB 3.0 cameras

Another possibility is to use the Noldus MediaRecorder software to make digital 
video files and track from these videos in EthoVision XT (offline tracking).

Procedure
1. Create a new experiment or open an existing one.
2. In the Experiment Settings, select the camera(s). See Video source
3. In the Arena Settings, calibrate and draw the arena.
4. In the Acquisition screen, on the right-hand pane select Save video only, 

track later. With this option you record the live image to a video file 
without tracking. Select this option especially if your computer is not fast 
enough to do tracking and recording at the same time. For other options, 
see Acquire Data in this Help.

5. To start recording, click the Start trial button.
TIP  Save this experiment as a template (File > Save As). You can then re-use the 
same settings in a new experiment when you Create a new experiment based on an 
existing experiment.
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Video file location
Your video files are saved in the Media Files subfolder of your experiment folder. By 
default in: C:\Users\Public\Public Documents\Noldus\EthoVision XT\Experiments\ 
[experiment name]\Media Files.

Video file size
Roughly speaking, the file size is given by:

File size = Bitrate x Duration x Compression ratio

Where:

▪ The Bitrate is the product of Frame size x Frame rate (frames per second)
▪ The Duration is the length of the video (in seconds).
▪ The Compression ratio tells how much space is needed to store similar 

frames that have fewer moving parts, like an empty open field.
You can use the following table as a reference for video created with EthoVision XT. 
Please note that the figures reported are only indicative. There are other factors 
which influence video file size, such as whether a variable bit rate is used or which 
color space is used. Also the amount of movement in the video influences file size. 
The more movement, the larger the resulting video file. 

Therefore, the size of your video files may well differ from what reported here 
below, even when using a comparable setup.

See also

▪ Video file formats

Resolution, frame 
rate

Camera 10 minutes video Duration per GB

1280x1024, 30 fps Basler GigE, 
monochrome

75 -150 MB 1-2 h

1280x1024, 25 fps Basler GigE, color 175 MB < 1 h

2560x1024, 10 fps Basler GigE, color 100-160 MB 1-2 h

720 x 480, 30 fps Analog cameras, 
monochrome

60 MB 16 h

DanioVision 
800x600, 60 fps

Basler GigE, 
monochrome

90-125 MB 1-1.5 h

DanioVision 
1280x960, 25 fps

Basler GigE, 
monochrome

355 MB < 30 min
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Tips for color tracking

Main topics and tasks
▪ Lighting conditions  1363
▪ Color markers  1366
▪ Settings for the color camera  1373
▪ Pixel format and color space  1377
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Lighting conditions
You need the information below when you track color-marked animals.

General
Generally, for optimal tracking it is important that the contrast between the subject 
and the background is as good as possible. For marker tracking, EthoVision XT 
needs to be able to distinguish the different marker colors. For both issues, the 
lighting conditions play an important role.

▪ It must be bright enough. A low light intensity can result in a suboptimal 
contrast between the animal and the background and therefore tracking 
might not be optimal. Furthermore, a low light intensity makes it difficult to 
separate different colors. When it is not possible to use strong illumination 
in your setup, try using fluorescent marker colors with UV lighting.

▪ It must be even. The light source should be diffuse, for example, a shaded 
fluorescent tube or globe-type incandescent bulbs. This way, the contrast 
between the animal and the subject and the intensity of the marker color 
are the same throughout the arena.

▪ Shadows must be avoided. To avoid shadows, do not point the light directly 
to your animals, but, for example to the walls or ceiling. Use several lamps, 
to obtain an even illumination. 

Full-spectrum lights
For optimal color separation, illuminate your setup with lamps that approximate to 
day-light in frequency distribution of wavelengths, that is, have a full-spectrum 
range. There is no technical definition of “Full spectrum”, therefore it cannot be 
measured. However, to compare full-spectrum lights you can directly compare 
spectral distributions. 

In practice, full-spectrum lights can be recognized from two parameters:

▪ High Color Temperature (measured in degrees Kelvin). Usually higher than 
5000 ºK. Values of color temperature around 2500-3000 ºK are typical of 
“warm” color lights (yellowish), for example incandescent bulbs.

▪ High Color Rendering Index (expressed as percentage). Higher than 95. A 
value of 100 represents the ideal or natural light.

See also

▪ For color temperature: http://en.wikipedia.org/wiki/Color_temperature
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▪ For color rendering index: http://en.wikipedia.org/wiki/
Color_Rendering_Index

When buying LED lamps, make sure that the technical specifications report the 
required color temperature and CRI. A disadvantage of most LED lamps is that they 
cast light in one direction at a narrow angle compared to energy-saving fluorescent 
lights, creating more shadows and reflections.

We have tested the following lamps:

▪ True-Light Energy Saving Light 15 W. Color Temperature 5500 ºK, Power 15 
W, Brightness 720 lumen.

▪ ProLite Helix Compact Fluorescent ES 15. Color Temperature 6400 ºK, Power 
15 W, Brightness 795 lumen.

Both lamps have E27 fitting. 

Recommendations
▪ Choose a light source with color temperature  5500 °K and color rendering 

index > 95.
▪ Do not use halogen lamps; instead use LEDs, as halogen light is too “cold”.
▪ Use at least four lights and place them at equal distance around the arena, 

at least 1 m from the subjects.
▪ If the image of white animals looks overexposed, close the aperture of the 

camera lens. Too much light heavily reduces color discrimination.
▪ If light creates shadows in the arena, place white sheets in front of the 

lamps to obtain more diffuse light.
▪ Set the white balance of your camera, to obtain a wider color spectrum. 

Consult the manual of your camera for the exact procedure. Generally, you 
can set the camera to white balance the image automatically. To check 
whether this is done correctly, point the camera to a white wall and check 
whether the wall appears white in the video image. If this is not the case, 
search for the settings to set the white balance manually. Point the camera 
to a white wall and set the white balance. Make sure you do this every time 
the light changes. 

Useful web sites
Below you find the web address of full spectrum lights producers

▪ True-Light: http://www.true-light.eu/en/
▪ BlueMax Lighting: https://www.fullspectrumsolutions.com
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▪ OSRAM: http://www.osram.com/
▪ Philips: https://www.lighting.philips.com/main/home
▪ Pro-Lite: http://www.prolite-lamps.co.uk
▪ Viva-Lite: http://www.viva-lite.nl/home.html
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Color markers
Aim
You need the information below when you track color-marked animals.

General information
▪ Use a color scale (for example from a paint company) to find out which 

colors are most easily recognized by EthoVision XT in your setup and 
lighting conditions. Do this before applying color markers to your animals.

▪ Use colors that have different hue values. For example, use red and green 
and not red and orange.

▪ For birds and animals in general that perceive color in the red-green 
wavelength range, using red markers is not advisable as it looks like blood, 
and may influence the subjects’ behavior. Rodents have dichromatic vision, 
that is, they perceive wavelengths around the blue and the green, so 
probably red is seen as gray or a mix of blue and green. Albino animals 
have heavily impaired vision, both in acuity and color perception.

▪ If you want to use red together with orange or pink, provide more light 
around (by means of additional lamps) and then close the aperture of the 
camera lens. 

▪ If the color of your marker is also present elsewhere in the arena, you can 
get rid of it by using a minimal marker size. 

▪ Marking your animals may stress them, and therefore affect their behavior. 
If necessary, ensure that you select a marking method that lasts for a longer 
period of time.

▪ To improve color discrimination in EthoVision XT, you can alter the 
Saturation settings of the video image (this only applies for live tracking). In 
the Detection Settings window, under Video click Image Quality. Alter the 
Saturation value and check in the video window if the markers are more 
distinguishable. However, before altering the Image Quality always try to 
optimize the lighting and camera aperture settings. 
Note that if you alter the Image Quality values you need to redefine the 
color detection (click Identification for each subject). 

Marker characteristics
▪ Make sure that the marker is visible as much as possible; preferably place it 

on the center of the animals backbone.
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▪ Make sure that the marker is as round as possible, this will ensure that the 
relative movement of the center of gravity of the marker is the same in all 
directions when the edges of the marker change due to posture changes or 
otherwise. For color marker tracking it will help to prevent the jitter of the 
marker.

▪ When you use marker assisted tracking, make sure the marker is not too 
big; the marker can interfere with proper detection of the body contour. For 
example, make sure that a dark marker on a white animal does not cover 
the complete width of the animal because it can cause the body to be split 
in two.

Markers for rodents and other small mammals
There are several ways to color mark small mammals like rats and mice. Color mark 
as much of the head and back as possible. This way the mark is always visible, also 
when the animals rear or turn. 

▪ Livestock markers are intended for large animals but can also be used on 
smaller animals. These markers come as paint sticks and spray cans, and are 
available in many colors including fluorescent ones. The markers are 
weather-resistant, non-toxic and they stay on for one or two days.

▪ Fluorescent tubes can be used for color-tracking in the dark. It is possible to 
mark rats with fluorescent markers and illuminate the arena with UV-light 
(350-400 nm, 2 lamps of 1.2 W each). The fluorescent spots on the rats 
1367



appear as patches of different color against a dark background. EthoVision 
XT can then effectively separate the two animals (source: J.P. Johansson and 
M.L. Carlsson, Institute of Clinical Neuroscience, Göteborg University, 
Göteborg, Sweden). See Tracking colors in the dark

▪ The fur of rats and mice can be marked with commercial products for 
dyeing human hair. Dark fur can be bleached (like dark human hair, to make 
it blonde) before coloring. Hair dyes are available in many bright colors, and 
provide long-lasting coloration. Schwarzkopf PolyColor Hair color Cream, 
for example, can be applied to rat’s fur with a cotton swab.

▪ Permanent marker pens (for example, Edding or Marks-A-Lot) present a 
cheap and easy way to mark small mammals. Take care to make a large and 
uniform blob. This method may only work for a short period of time as 
many species may remove the mark by grooming.

▪ Chalk ink markers can be used to mark rodents. They are available in a 
variety of bright colors. Their main advantages is that they are not toxic, are 
readily available and inexpensive, and, in contrast with other marker types, 
can be applied directly to dark fur without bleaching it first. Coloration may 
last several hours.
It is advised not to mark the animals just before you start a test, because 
the handling of the animals might affect their subsequent behavior. If you 
use a marker that stays on the animal for only a short period of time, you 
should habituate the animal to the marking procedure.

▪ Colored ‘jackets’ can be used to color-track mammals with colored fur like 
cats. Jackets cover most of the cat’s back, and can be provided with Velcro 
strips, so one can place pieces of cloth of different colors to test optimal 
color combinations. Orange vests may give problems when animals are 
red-haired, so it should be replaced by either (bright) green, yellow or pink.

Markers for large mammals
You can use livestock markers to mark large animals such as cows, sheep and pigs.

Markers for birds
▪ The feathers of birds can be marked with commercial products for dyeing 

human hair or permanent marker pens (see ‘Small mammals’ above).
▪ Seabird ecologists often use picric acid (2,4,6-trinitrophenol, TNP) to mark 

their birds. You paint a dab of this yellow liquid on the feathers. It is 
permanent and very bright yellow, although it turns orange in the sun. To 
use it to mark animals you dissolve it in an excess of ethanol. If the acid (a 
powder) dries, it becomes explosive, so it is important to keep it dissolved 
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(Source: J. Blount, Division of Environmental and Evolutionary Biology, 
University of Glasgow, UK).

Markers for fish
▪ Fish can be color marked by attaching plastic pearls. This technique has 

been used successfully in Mediterranean damsel fish (Chromis chromis, size: 
about 9 cm long) and trout (about 25 cm). Colored pearls can be bought 
from a toy store or a warehouse. Use bright colors that are as distinct as 
possible. For damsel fish pearls of 1 cm are used and for trout pears of 8 
mm are used.
Damsel fish. The pearls can be attached under the dorsal fin with blue non-
resorbable surgery polyamide mono filament (for example, from B/Braun), 
using a surgical needle under anaesthesia. The fish can be anesthetized by 
placing them in a small tank with 2-phenoxy-ethanol (0.3 ml/l for the 
damsel fish) for five minutes, before attaching the pearl. The bottom and 
sides of the arena have to be very dark. The pearls do not significantly 
impair swimming in damsel fish (Source: M. Ylieff, Institut de Zoologie, 
Université de Liège, Belgium).

Trout. The pearls can be attached at the base of the first ray of the dorsal 
fin. Use a curved needle and normal fishing-line to attach the pearls to the 
fin. X-ray images showed no injury after several weeks using this method. 
The fish can be anesthetized by placing them in a tank with 2-phenoxy-
ethanol (0.3 ml/l), before attaching the pearl.

▪ Visible implant fluorescent elastomer (VIE) tags are produced by North 
west Marine Technologies (NMT). VIE material is implanted beneath 
transparent or translucent tissue (it may become difficult to detect it 
beneath pigmented tissue). The material is injected as a liquid and soon 
turns into a pliable, bio-compatible solid. VIE colors are well visible under 
normal lighting conditions and have greatly enhanced visibility under ultra-
violet light or with other fluorescence enhancing techniques. You can test 
which colors work best in your own setup with a color test patch from NMT. 
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(Source: J. Merilä, Evolutionary Biology Centre, Uppsala University, Sweden 
and Delcourt et al. (2012). Behavior Research Methods 43: 590–600).

Markers for reptiles
Nail polish (available in many colors) can be used to mark lizards. The mark usually 
lasts 10 days in small (up to 10 cm) lizards in the field. (Source: M. Massot, 
Laboratoire d’Ecologie, Université Pierre et Marie Curie, Paris, France).

Markers for amphibians
For amphibians you can use visible implant fluorescent elastomer (VIE) tags (see 
‘Fish’ above). They work fine with small tadpoles.

Markers for insects
▪ Acrylic paint (for example, Royal Talens Amsterdam deco) can be used to 

mark insects. The paint can be applied with a fine brush or thread. You have 
to hold the insect with forceps until the paint is dry (Source: G. Driessen, 
Institute of Evolutionary and Ecological Sciences, Leiden University, The 
Netherlands; S. Belmain, Natural Resources Institute, Chatham Maritime, 
UK).

▪ Some species of parasitic wasp develop a colored abdomen when you feed 
them honey with a non-toxic dye, as used for coloring food. The dyes can 
be obtained from a normal bakery. The advantage of this method over 
marking with paint is that you do not have to anesthetize the insects (which 
may influence their behavior and survival). The method will work best in 
insects with unpigmented abdomens (Source: G. Driessen, Institute of 
Evolutionary and Ecological Sciences, Leiden University, The Netherlands).

▪ Mosquitoes can be fed with a sugar solution in water containing fluorescent 
dyes. Blue-black light is used to illuminate the subjects. See the paper by 
Sarkar et al. 2017, International Journal of Mosquito Research 4(6): 5-9 
(animals were not video-tracked though). Other techniques using 
fluorescent powders or dyes are described by Verhulst et al. (2013), 
Parasites & Vectors 6: 200-206. 

▪ For insects you can also use visible implant fluorescent elastomer (VIE) tags 
(see ‘Fish’ above).

▪ Aphids have successfully been color marked with fluorescent powders. The 
powders that are fluorescent under ultraviolet light can be obtained from 
Day Glo, Cleveland, Ohio. For optimal detection, a high intensity UV long 
wave UV·366 nm lamp can be used. To apply the powder to the aphids, 
gently dust the powder with a powder insufflator. Make sure, each aphid 
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gets at least 10 grains of powder. For more information see Thomas et al. 
(1997). Journal of Agricultural Entomology 14(2): 187-198.

▪ Ants can be color marked with a small drop of paint on the thorax or the 
abdomen. Anesthetize the ant with CO2. To restrain the ant during painting, 
use a sponge with a single strand of hair attached to it. Place the ant under 
the hair and apply the color mark. Transfer the ant to a plastic tube and 
allow the paint to dry for approximately 20 minutes. After 24 hours, the ant 
can be used in experiments.

▪ For a review of the marking techniques see Hagler & Jackson (2001). Annual 
Reviews of Entomology 46: 511–543.

Markers for zooplankton
▪ Nanoparticles known as Quantum dots can have been applied to the 

carapace of crustaceans Daphnia sp. Like any other fluorescent molecule, 
they must be excited with light of one wavelength in order to emit 
fluorescence at a longer wavelength. Among the advantages of these 
markers, the great photostability (animals can be tracked for up to 24 hours 
after labeling, without loss of signal due to photo-bleaching. Note that 
some quantum dots may be toxic to animals.
For more information see Lard et al. (2010). PLoS ONE 5(10): e13516. 
doi:10.1371/journal.pone.0013516.

Tracking colors in the dark
If you want to apply color markers and track the animals in the dark, you need 
lighting conditions that allow EthoVision XT to detect the marker and detect the 
contour of the animals.

To track colors in the dark, combine fluorescent markers with ultraviolet (UV) light. 
UV light makes the marker emit visible light, which is then detected by the camera. 
EthoVision will track the marker like it would normally do in daylight. See Markers 
for rodents and other small mammals

To track the contour of the animal, you must also use light sources other than UV. If 
you only use UV light, the contour of the animal won’t be seen. A couple of solution 
that may work:

▪ Use visible light. Make sure that the contrast between animal and 
background is maximized. 
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▪ Use infrared (IR) light. Some good color cameras are also sensitive to IR 
light. You can then use IR light to enhance the contour of the animal, 
provided that the camera lens does not have a IR-block filter. 

Note that fine-tuning this setup may take considerable effort and time.

Useful web sites
▪ Carmel livestock markers: http://www.livestockmarkers.com.
▪ La-Co livestock markers: http://www.allweathermarker.com.
▪ Net-Tex livestock markers: http://www.net-tex.co.uk and search for 

“marker”.
▪ Edding markers: http://www.edding.com.
▪ Marks-A-Lot markers: http://www.avery.com.
▪ MS Schippers (livestock or rodent markers): https://www.schippers.nl. See 

the product line “MS Merkstift” (in Dutch).
▪ Chalk Ink markers: http://www.chalkink.com. Choose a 15-mm broad tip 

marker.
▪ Schwarzkopf hair dyes: https://www.schwarzkopf.com
▪ Royal Talens acrylic paint: https://www.royaltalens.com/en/products/acrylic-

colours/.
▪ B/Braun surgical sutures and needles for attaching pearls to fish: http://

www.bbraun.com.
▪ Northwest Marine Technology fish markers: http://www.nmt.us/.
▪ Invitrogen quantum dots http://www.thermofisher.com/nl/en/home/

brands/invitrogen.html.
▪ Fluorescent powders: https://www.dayglo.com/
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Settings for the color camera
Aim
To make sure that the tracking of color markers in EthoVision XT is optimized.

This topic applies to the Basler color cameras acA1300-60gc and acA1920-40gc. 
Note that the Basler acA1300-60gc is no longer officially supported and therefore 
not tested by Noldus.

Prerequisites
You have installed the camera, its driver software and EthoVision XT. See Install GigE 
cameras

Settings in pylon Viewer
The procedure below refers to the options available in the camera software. Most of 
the options are also available in EthoVision XT. See Adjust camera settings in 
EthoVision XT

1. Close EthoVision XT and open pylon Viewer.
NOTE  The Basler pylon Viewer software is installed automatically when you 
install the camera drivers.

2. From the Window menu select Features - All.
3. In the Devices panel, double-click the item Basler under GigE.
4. Open the item Image Format Control. Next to Pixel Format select:

▪ YUV 422 Packed for the camera acA1300-60gc. Note that this camera 
has not been tested with EthoVision XT 18.

▪ Bayer RG 8 for the camera acA1920-40gc.
5. Click Color Improvements Control.

6. Click the Continuous Shot button on the tool bar to view the live image.
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7. Point the camera at a piece of white paper, so that the camera image is 
entirely white. Click in the field next to Balance White Auto and select 
Once from the list.

8. To save the settings, see Save the camera settings.
9. Close pylon Viewer and open EthoVision XT.
10. Open your experiment and in the Experiment Settings select Live tracking 

and the color camera.
11. Click the camera button and then in the window that appears click the 

Format tab. Choose the video resolution and frame rate. 
12. Next to Color space select:

▪ For the camera acA1300-60gc, UYVY or YUV.
▪ For the camera acA1920-40gc, BYRG. If the image stays black and 

white, select UYVY or YUV, then select BYRG again.
13. Select the resolution and frame rate. See what has been tested for the 

Basler acA1920-40gc.
14. Check the Current frame rate. If this is significantly lower than the rate you 

set, choose a lower resolution.

Settings for low light conditions
When tracking animals in low light, you can adjust the camera settings in such a 
way that the colors are more apparent. The settings below apply to the camera 
acA1920-40gc. 

In pylon Viewer, do the following:

1. Under Analog Controls, set Gain to for example 240 or higher if necessary.
2. Next to Gamma Selector, choose User.
3. Next to Gamma, choose 1.0.
4. Increase the Digital Shift for example to 1 or higher if necessary.
5. Under Acquisition Controls, set Exposure Time to for example 20000 μs. 

A higher value is not recommended.
1374



For adjusting a specific color (usually not necessary if the white balance has been 
done correctly): 

▪ Next to Color adjust enable, select the option.
▪ Next to Color Adjust Saturation, adjust color saturation (per color).

Color to monochrome
If you have a color digital camera, you can temporarily change it to monochrome.

▪ For Basler cameras: see Change color to monochrome
NOTE  This does not make your color camera infrared-sensitive. For that, you must 
either remove the infrared block filter (see below) from your color camera or use a 
monochrome GigE camera.

TIP  Basler cameras have model numbers like this: acA1300-60xx, where 

▪ xx = gm means monochrome.
▪ xx = gmNIR means Near Infrared, that is, monochrome with extra sensitivity 

to infrared light.
▪ xx = gc means color.

Color to infrared-sensitive
Most color cameras are not infrared-sensitive. To make them more infrared (IR)-
sensitive:

1. Set them to monochrome (see above).
2. Remove the infrared-block filter, if this is present. For how to do so, see 

below

Infrared-block filter
Some color cameras may have a built-in infrared block filter which prevent them to 
see some infrared light. If you bought a Color GigE camera from Noldus prior to 
July 2018, you can remove this filter to make your color camera IR sensitive. 

NOTE  Color GigE cameras of model acA1300-30gc purchased after July 2018 from 
Noldus had the IR block filter removed making the color camera IR sensitive like the 
monochrome version (model: acA1300-30gm). If you have such a camera you can 
skip this procedure.

1. Remove the lens from the camera.
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2. Check that the filter is present: you should see two circular holes at the 
sides of the filter.

3. Use a small Allen key or a similar object to lift the filter.
4. Put the lens back on the camera.

See also

▪ Lighting setup
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Pixel format and color space
Aim
To inform you about the relation between pixel format and color space used to 
create video.

This topic applies to
▪ Basler digital cameras.

Background
▪ A Pixel format is the format of the image data transmitted by the camera. 

For example, for monochrome cameras the default pixel format is Mono8. 
This means that the camera outputs 8 bits of data for each pixel in the 
image captured by the chip.
TIP  You find the Pixel format setting in the pylon Viewer software. See 
Configure the digital camera

▪ A Color space is a specific organization of colors. Selecting a color space in 
the camera driver software or in EthoVision XT determines the way color 
information is encoded in the video file.
TIP  You find the Color space setting in EthoVision XT. See Adjust camera 
settings in EthoVision XT

There is a relation between the pixel format and the color space. When you specify 
the color space in EthoVision XT, the camera software may automatically change 
the pixel format. Follow the tables below to find which pixel format is used in your 
video. This is usually the format that is optimal to convert color into the selected 
color space.
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If the starting pixel format is Mono8 or YUV422 (YUYV) Packed

If the starting pixel format is YUV422 Packed

If the starting pixel format is Bayer RG8, Bayer RG12 or Bayer GRG12 Packed

When you set the color space to... Then the pixel format changes to...

UYVY YUV422 Packed

RGB24 YUV422 (YUYV) Packed

RGB32 YUV422 (YUYV) Packed

YV12 YUV422 (YUYV) Packed

YUY2 YUV422 (YUYV) Packed

Y800 Mono8

BYRG Bayer RG8

When you set the color space to... Then the pixel format changes to...

UYVY YUV422 Packed

RGB24 YUV422 Packed

RGB32 YUV422 Packed

YV12 YUV422 Packed

YUY2 YUV422 (YUYV) Packed

Y800 Mono8

BYRG Bayer RG8

When you set the color space to... Then the pixel format changes to...

UYVY YUV422 Packed

RGB24 Bayer RG8

RGB32 Bayer RG8

YV12 Bayer RG8

YUY2 YUV422 (YUYV) Packed
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See also

▪ Adjust camera settings in EthoVision XT
▪ Configure the digital camera (in pylon Viewer)

Y800 Mono8

BYRG Bayer RG8
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EthoVision XT and Quality 
Assurance

Main topics and tasks
▪ EthoVision XT and Quality Assurance  1381
▪ EthoVision XT user management  1383
▪ EthoVision XT logging  1392
▪ Create a GLP experiment from a template  1396

If you need a Certificate of Validation for EthoVision XT, please contact Noldus. 
Other contact information

IMPORTANT  It is not possible to open a GLP experiment that was made with 
EthoVision XT 12 or earlier. If you upgrade, you can leave both versions of 
EthoVision XT on one computer, to be able to open the old experiments.

See also

▪ Troubleshooting: Quality Assurance (GLP)
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EthoVision XT and Quality Assurance
EthoVision XT offers functionality to support the user in fulfilling quality 
requirements in in-vivo studies. The Quality Assurance (QA) functions can also be 
used to help comply with Good Laboratory Practice (GLP) regulations.

Quality Assurance functions
▪ EthoVision XT user management

You can set up the program so that only authorized users are able to take 
particular actions, and that certain actions such as editing or deleting data 
are prevented. 

▪ EthoVision XT logging
All user actions which can result in changes to the acquired data (for 
instance altering settings) are logged and every time you leave a part of the 
program you are prompted to add a comment to the log file. This creates 
an audit trail suitable for a QA auditor to review. 

IMPORTANT  You need the EthoVision XT Quality Assurance module to use the 
Quality Assurance functions in EthoVision XT. See Modules of EthoVision XT

Note about GLP
GLP (Good Laboratory Practice) is a set of rules for conducting non-clinical 
laboratory studies that support or are intended to support applications for research 
or marketing permits for products regulated by the U.S. Food and Drug 
Administration. These products include animal food additives, medical devices for 
human use, biological products and human and animal drugs. The principles of and 
regulations for GLP are described under the Code of Federal Regulations Title 21, 
Part 58 (CFR21/58).

For Europe, the GLP rules have been compiled and adapted by the Organization of 
Economic Cooperation and Development (OECD).

Subparts of the CFR21/58 GLP rules define and describe the following major points:

▪ Organization and personnel.
▪ Facilities.
▪ Equipment.
▪ Testing Facilities Operations.
▪ Test and Control Articles.
▪ Protocol for and Conduct of a Non-clinical Laboratory Study.
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▪ Records and Reports.
▪ Disqualification of Testing Facilities.

All these items require to be managed in such a way that GLP-compliance is 
facilitated and ensured. 

CFR21/11 more specifically describes guidelines for the use of electronic records.

IMPORTANT  The Quality Assurance functions in EthoVision XT do not actively check 
that experiments made in EthoVision XT are GLP-compliant.
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EthoVision XT user management
With EthoVision XT User Management you can:

▪ Prevent non-GLP users to access EthoVision XT with the Quality Assurance 
module installed.

▪ Define which users may access which function in EthoVision XT (for 
example experiment design, data recording, editing etc.).

Learn about
▪ How EthoVision XT user management works

What do you want to do?
▪ Add a user
▪ Assign rights to users
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How EthoVision XT user management 
works
You can define a list of users that can access EthoVision XT. Furthermore, users can 
have different rights; these rights can only be assigned by a user with User 
Management rights in EthoVision XT.

Initially, after installation, only one user has access to EthoVision XT. Which user this 
is depends on how EthoVision XT was installed:

▪ EthoVision XT came installed on a computer provided by Noldus 
Information Technology.

▪ EthoVision XT was installed by the user.

EthoVision XT came installed on a computer
When you purchased both EthoVision XT and the EthoVision XT computer from 
Noldus Information Technology, EthoVision XT is already installed on that 
computer. In that case, a user account EVXT has been created to log on to 
Windows. This user EVXT, with administrator rights, initially is the only user who can 
access EthoVision XT on that computer.

Choose File > Users. User EVXT has, by default, the following rights: User 
Management and EthoVision Preferences. 

Use EVXT to add new users and assign them rights. 

▪ Add a user
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EthoVision XT was installed by user
When a user with administrator rights installed EthoVision XT, this user is 
automatically added to the list of users in the User Management window in 
EthoVision XT.

Also, a user EVXT is automatically added to the list of users. With this standard user 
EVXT, any administrator can at all times create a user account EVXT through which 
EthoVision XT can be accessed.

Next, either the user that installed EthoVision XT or user EVXT can add new users 
and assign them rights (see below).
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Add a user
The procedure to add a user differs depending on whether EthoVision XT came 
installed on a computer, or was installed by the user, and on whether the computer 
is on a domain or not. 

Follow the procedure according to your situation.

EthoVision XT came installed on a computer that is on a 
domain
Make sure that user EVXT has also been added to the domain by your network 
administrator.

To add a new user in EthoVision XT:

1. Log on to Windows as user EVXT and open EthoVision XT.
2. Choose File > Users.
3. In the User Management window, click Add.
4. In the Add New User window, click Network.
5. A list of users on the domain appears. Select a user from the list.

At this point, you have the option to select an initial role (Administrator, 
Researcher or Technician) for the new user. See Assign rights to users

6. Click Add to add a user to the list of users that can access EthoVision XT.
Next, assign rights to the new user.

EthoVision XT came installed on a computer that is not on a 
domain
When EthoVision XT was installed by Noldus Information Technology on an 
EthoVision XT computer, initially there is only one user, EVXT, on that computer. Log 
on to Windows as this user. You can find the password in the welcome letter you 
received with the software.

You first need to define new users in Windows before you can add them to the list 
of authorized users in EthoVision XT. You must have a local computer administrator 
account to add a new user to the computer.

To add a new user in Windows, click the Start button, then select Settings > 
Accounts > Other people/Other users.
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Next, add this user in EthoVision XT:

1. Open EthoVision XT and choose File > Users.
2. In the User Management window, click Add.
3. Local users on the computer are shown. Select one of the users in the list.

At this point, you have the option to select an initial role (Administrator, 
Researcher or Technician) for the new user. See Assign rights to users

4. Click Add to add this user to the list of users that can access EthoVision XT.
Next, assign rights to the new user.

EthoVision XT was installed by user on a computer that is on a 
domain
The user that installed EthoVision XT can add new users to the list of authorized 
users in EthoVision XT.

1. Open EthoVision XT and choose File > Users.
2. In the User Management window, click Add.
3. In the Add New User window, click Network.
4. A list of users on the domain appears. Select a user from the list.

At this point, you have the option to select an initial role (Administrator, 
Researcher or Technician) for the new user. See Assign rights to users

5. Click Add to add a user to the list of users that can access EthoVision XT.
Next, assign rights to the new user. 

EthoVision XT was installed by user on a computer that is not 
on a domain
First, you might need to add local users to the computer (see Add a user for a 
description of how to do this. You must have a local computer administrator 
account to add a new user to the computer.

To add a new user in EthoVision XT:

1. Open EthoVision XT and choose File > Users > Add.
2. Local users on the computer are shown. Select one of the users in the list.

At this point, you have the option to select an initial role (Administrator, 
Researcher or Technician) for the new user. See Assign rights to users
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3. Click Add to add this user to the list of users that can access EthoVision XT.

See also

▪ Assign rights to users
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Assign rights to users
Prerequisites

▪ You have been assigned User Management rights in EthoVision XT.
▪ There is no experiment open.

User roles
When you add a new user, you have the option to select one of three predefined 
roles, each representing a set of rights. However, these rights can be changed at any 
time. 

The three initial roles are:

▪ Administrator
With default rights User Management and EthoVision Preferences.

▪ Researcher 
With default rights Experiment Management, Experiment Settings, Trial 
Control Settings, Arena / Trial Control / Detection Settings, Acquisition, 
Import External Data, Edit Tracks, Edit Data Profile / Analysis Profile.

▪ Technician
With default rights Arena / Trial Control / Detection Settings, Acquisition, 
Import External Data.

User rights
▪ User Management

Gives you the right to add and remove users, and change user rights.

▪ EthoVision Preferences
Gives you the right to change the default experiment folder, the warnings 
displayed and the autosave options.

▪ Experiment Management
Gives the right to create new experiments, make and restore backups.

▪ Experiment Settings
Gives the right to set and change Experiment Settings.

▪ Trial Planning
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Gives the right to add trials and variables to the Trial list, and to skip trials or 
arenas within trials, and re-do trials.

▪ Arena / Trial Control / Detection Settings
Gives you the right to create and or edit Arena Settings, Trial Control 
Settings and Detection Settings.

▪ Acquisition
Gives the right to change Acquisition settings and carry out Acquisition.

▪ Import External Data
Gives the right to import external data files.

▪ Edit Tracks
Gives the right to edit tracks.

NOTE  It is likely that your Standard Operating Procedure forbids modifying 
acquired data. If this is the case, no user should have this right.

The original data is always stored in your experiment.

▪ Edit Track Smoothing, Data, Analysis Profiles
Gives the right to smooth tracks, create and edit Data profiles and Analysis 
profiles.

▪ Delete Trials and Clear Log
Gives you the right to delete trials and delete the Experiment log file.
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Notes
▪ It is likely that your Standard Operating Procedure forbids modifying 

acquired data. If this is the case, no user should have this right. By default, 
this right is disabled for all users.

▪ The User Management right to delete trials and the Experiment log file is 
useful when you want to create a template experiment. This template 
experiment, for example, contains default settings as defined in a Standard 
Operating Procedure, but should not contain test trials and an already filled 
log file. Also see Creating an Experiment template. It is advisable to create a 
special user for this right. In normal operation under GLP no user should be 
able to perform these actions.
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EthoVision XT logging
Aim
With the logging functionality in EthoVision XT, you enable auditing of (changes to) 
settings that were made during an experiment. EthoVision XT creates two types of 
log files:

▪ General log file
In this Application log the usage of EthoVision XT by authorized users is 
registered. See The General log file

▪ Experiment log file
One for each experiment, to register the settings made and actions carried 
out during that experiment. The user, date and time are logged for each 
setting and action. See The Experiment log file

Notes
▪ The user can at any time add additional user comments to the Experiment 

log file.
▪ The log file is tamper-proof. As soon as someone edits it outside EthoVision 

XT, that is detected and it is logged that the file has been tampered with.
1392



The General log file
The General log file is created the moment EthoVision XT is installed. The following 
actions are logged:

▪ Start and stop of an experiment.
▪ Creation of a new experiment.
▪ Users that are added / user rights that are assigned / user rights that are 

modified.
▪ Errors that occurred when opening or closing an experiment.

For every action, the user name, date and time are logged. 

To view the General log file
1. Choose File > GLP Log Files.
2. In the GLP log window, select General log file.

To export the General log file
1. Choose File > GLP Log Files, and click the Export button, or in the Experi-

ment Explorer, under Export, click GLP Log. 
2. Select General log file.
3. Browse to the folder where you want to export the log file to and click OK.

Notes
▪ The export format is HTML (*.html). The name of the export file is GLP-

EthoVision(n), where n is a progressive number.
▪ You cannot delete the General log file.
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The Experiment log file
The Experiment log file is started at the moment a GLP experiment is created. 
Changes made by the user that affect the data and results of an experiment can be 
traced back in the log file.

These changes are logged from the moment you actually start acquiring data. At 
that moment a snapshot is taken of the various settings in your experiment and this 
snapshot is logged. Thereafter, all changes that can affect your data are logged.

When a users makes changes to settings (for example, in the Trial List or Trail 
Control Settings) and/or leaving a Setting, the user is prompted to add a comment 
to the Experiment log file. A new snapshot is then taken when new data are 
acquired. When the user cancels this automatic pop-up or does not enter a 
comment, a line appears in the Experiment log file with user name, date and time 
but without a comment.

To add a comment to the Experiment log file
1. Choose File > Add log comment (Ctrl+L).
2. Type in comments and click OK.

To view the experiment log file
Before you can view an experiment log file, you need to open the corresponding 
experiment. To view the experiment log file in EthoVision XT:

1. Choose File > GLP Log Files.
2. In the GLP log window, select the experiment log file radio button. If 

necessary, click on one of the html links to go to a specific part of the 
Experiment log file.

To delete the Experiment log file
You can only clear the contents of the Experiment log file, not delete it. You can only 
clear the Experiment log file when you have the user management right to Delete 
Trials and Clear Log.

1. Choose File > GLP Log Files.
2. Select Experiment log file and click the Clear Log button.
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To export the experiment log file
1. Choose File > GLP Log Files, and click the Export button, or in the Experi-

ment Explorer, under Export, click GLP Log.
2. Select Experiment log file.
3. Browse to the folder where you want to export the log file to and click OK.

Notes
▪ In the case of large experiments, when the log file exceeds a size of 1 Mb, it 

is split in multiple log files.
▪ The export format is HTML (*.html). The name of the export file is GLP-

[Experiment name](n), where n is a progressive number.
▪ Experiment Settings, Arena Settings, Trial list, Trial Control Settings and 

Detection Settings are not stored in the log file until the first data are 
acquired. After that, only changes are logged.

▪ Logged Arena Settings include a screenshot of Arenas and their 
Calibrations. It also contains a screenshot of each Zone Group and its 
Zones.

▪ If your current experiment is not set for Quality Assurance, there is no 
Experiment log file present.

▪ The suggested export location is the experiment’s Export Files folder.
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Create a GLP experiment from a 
template
Aim
Create a new experiment with all the right default settings, but without tracks and 
an Experiment log file, based on an existing GLP experiment.

Prerequisites
▪ You must have the User Management right to delete trials and clear log. 

See Assign rights to users
▪ You have a GLP experiment that you want to use as a template. For example 

an experiment with specific arenas and zones, etc.

Procedure
1. Choose File > New template experiment or press Ctrl+T.
2. In the Template option window, select Use a custom template.
3. Click Browse and select the existing GLP experiment you want to use as a 

template. Select the file with extension *.evxt and click OK.
4. Type in the name of the new experiment.
5. Select GLP experiment and click OK.

Notes
▪ Create a backup of the template and store it in a safe place.
▪ To open a GLP experiment, you need an EthoVision XT license that includes 

the Quality Assurance module. Upgrade EthoVision XT
▪ In a GLP experiment you cannot change/edit the zones already used in 

Acquisition.
▪ If your license includes the Quality Assurance module, you can still create or 

open non-GLP experiments. In that case User Management does not apply 
and no log file is kept.

▪ Multiple copies of the same version of EthoVision XT installed on the same 
computer share the General log file. Different versions of EthoVision XT 
installed on the same computer each have their own General log file.
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Troubleshooting

Main topics and tasks
▪ Troubleshooting: Installation and license  1398
▪ Troubleshooting: General  1405
▪ Troubleshooting: pylon camera software
▪ Troubleshooting: Camera  1412
▪ Troubleshooting: Video image  1418
▪ Troubleshooting: Arenas and zones  1428
▪ Troubleshooting: Detection  1432
▪ Troubleshooting: Data acquisition  1434
▪ Troubleshooting: External data  1444
▪ Troubleshooting: Track editor  1446
▪ Troubleshooting: Statistics  1449
▪ Troubleshooting: Behavior recognition  1460
▪ Troubleshooting: Deep learning  1463
▪ Troubleshooting: Data visualization  1468
▪ Troubleshooting: Control of hardware devices  1479
▪ Troubleshooting: DanioVision  1482
▪ Troubleshooting: Live Mouse Tracker  1484
▪ Troubleshooting: Import trials  1486
▪ Troubleshooting: Quality Assurance (GLP)  1487
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Troubleshooting: Installation and license
Issues: Installation

▪ Error message (ID 10020
▪ Installation stops halfway
▪ Blue-screen crash during installation of Euresys Multicam
▪ The hardware key does not light up
▪ When I start EthoVision XT, I get the message: No license key found
▪ Installation of EthoVision XT fails, likely due to an error during installation of 

the Basler camera drivers
▪ I have realized that I installed the wrong camera driver software. What can I 

do?

Issues: License
▪ My EthoVision XT license has expired. What should I do?
▪ I am trying to upgrade my license, but the upgrade key is not being 

accepted
▪ I cannot start EthoVision XT with a floating license
▪ I purchased an add-on module but I cannot use it
▪ I purchased an add-on module. How do I update my license?
▪ I entered a license key but an error message shows a different one
▪ I need to create a Firewall rule to access the Noldus license server. Which 

port do I need to access?
▪ I cannot deactivate a license. The menu item Deactivate license is greyed 

out
▪ EthoVision XT is in Analysis mode, but there is no way to work with a full 

license
▪ Message “Activation not complete”
▪ Message “License already activated...”
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Error message (ID 10020
This usually happens when you install EthoVision XT after logging in with a guest 
account, or an account with insufficient rights. In those cases EthoVision XT may not 
use various folders on the hard drive.

Ask your system administrator to create a user account with more (local) rights than 
guest accounts, or ask the administrator to log in and install EthoVision XT.

Installation stops halfway
There may be a few reasons why installation fails. The log file may provide clues 
about the actual cause. To get this file, see The log file for Technical Support.

Do the following:

▪ Open the Windows Control Panel, and under Programs and Features 
check that an item named Sentinel Runtime is listed. If that is the case, 
remove it. Next, restart the PC, and install EthoVision XT (choose Modify on 
the installation screen).

▪ The issue could also be cased by the Basler Installer which tries to install its 
certificates on a Windows 10 version LTSC. If the procedure above does not 
solve the problem, you may first need to remove the root certificates from 
your PC, then install the Basler driver, then install EthoVision XT. You can 
remove root certificates with the app mmc.exe in Windows. Contact the 
Noldus Support for more information.

▪ Open the Windows Control Panel, and under Programs and Features 
check whether software like Microsoft Visual C++ Redistributable 
(version 14) is present. If that is the case, uninstall it. We know that version 
14, not earlier, of this software has caused a couple of issues during 
installation of EthoVision XT. Next, install EthoVision XT. After that, you may 
want to re-install Visual C++ redistributable software.

Blue-screen crash during installation of Euresys Multicam

For the Dell Precision 3650

Solution: Disable the Secure Boot option in the PC’s BIOS.

1. Start up the PC. Press the F12 key and once in the BIOS Setup menu, select 
Boot Configuration.

2. Set the Enable Secure Boot option to (disabled).
3. Save and exit the BIOS Setup menu.
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NOTE  There may be different ways to open the BIOS Setup menu in different 
computers. In Windows 11, you can press F2 while your PC is booting. Or, if the PC 
is running, hold the Shift key while selecting Restart. Go to Troubleshoot > 
Advanced Options > UEFI Firmware Settings. Then select Restart. The BIOS 
Setup opens. 

For the Dell Precision 3640

A blue-screen crash in Dell 3640 has been reported after the update of the firmware 
of the BIOS (the firmware update is nowadays integrated in the Windows Update 
routine). The crash is triggered with firmware version 1.4.3 or later. 

It is possible to roll back to an earlier version of the firmware. 

1. Start up the PC. Press the F12 key and once in the BIOS menu, select 
Maintenance > BIOS downgrade.

2. Select the option Allow BIOS downgrade.
3. Save and exit the BIOS.

Note that firmware version 1.3.2 is tested OK. If you need this version, consult the 
Dell support web site or contact the Noldus Noldus Support.

During installation, a message says that a newer version of the 
Sentinel Runtime is already installed.

1. Cancel installation of EthoVision XT.
2. Open the Windows Control Panel and choose Programs and Features. Look 

for Sentinel Runtime and uninstall it. 
3. If necessary, download the latest version of the Sentinel Hasp Driver from 

my.noldus.com. Copy the setup file to your PC and run it.
4. Re-install EthoVision XT.

The hardware key does not light up
1. Close EthoVision XT and remove the hardware key.
2. Run the installation file of EthoVision XT. Select Custom, then Repair. See 

Install EthoVision XT
3. Insert the hardware key into the computer and start EthoVision XT. The 

hardware key should now light up.
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When I start EthoVision XT, I get the message: No license key 
found

▪ If you work with a hardware license key, check that the hardware key is 
plugged in and its red LED is burning (see above).
NOTE  When the hardware key is not plugged in, you can open an existing 
experiment and analyze data already collected. However, you cannot 
acquire more data. See EthoVision XT in analysis mode

▪ See also Activate your EthoVision XT license

Installation of EthoVision XT fails, likely due to an error during 
installation of the Basler camera drivers
Based on the Basler error log file, installation stops because the system fails to 
register a Basler ax file.

Solution:

1. Install EthoVision XT while keeping all Basler camera driver options de-
selected. See Install EthoVision XT

2. Browse to my.noldus.com, log in or register, then select Downloads > 
EthoVision XT > Drivers and tools and download Basler Pylon Camera 
Driver to your PC. Run this file. During installation, choose the Custom 
option, and de-select DirectShow Support.

TIP  Remember to also select pylon Viewer and the option that applies to 
your camera (USB vs. GigE).

3. Continue with installation.
4. At the end of installation, double-click the exe file again, and choose 

Modify the current installation. Choose Custom, and this time keep 
DirectShow Support selected.
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I have realized that I installed the wrong camera driver 
software. What can I do?

1. Run the file EthoVision XT - Setup -[version number].exe (see Install 
EthoVision XT) and select Modify. Select the correct driver and continue 
installation.

2. If the action above does not help, open the Windows Control Panel and 
under Programs and Features select the driver software (for example for 
Basler camera there is an item named Basler Pylon), and select Uninstall. 
Next, run the setup file (step above) and select the correct driver. See also 
Install the driver software for the digital cameras

I am trying to upgrade my license, but the upgrade key is not 
being accepted
This may occur when your hardware key (dongle) specifies an EthoVision XT version 
that is later than that specified in the Upgrade Key that you have received. For 
example, you have a license number EV180-... (this number you can view in Help > 
About EthoVision XT > License Info), and you are trying to enter an Upgrade Key 
for a (probably old) license number that starts with EV150 or the like.

Another possible cause of the error is that the version of the Upgrade Key is not the 
same as the EthoVision XT version.

Please contact Noldus to receive a matching Upgrade Key.

My EthoVision XT license has expired. What should I do?
1. Contact Noldus to purchase a new license. See Noldus Support
2. Start EthoVision XT.
3. A message says No License key found. Choose Activate software license 

key.
4. Choose either Floating or Computer-locked depending on how you want 

to use the software. See Types of EthoVision XT license
5. Click OK and enter the new software activation key that you received from 

Noldus. See Activate your EthoVision XT license

I purchased an add-on module but I cannot use it
Choose Help > About EthoVision XT > License info to view which modules are 
enabled on your EthoVision XT system.

See Upgrade EthoVision XT. If necessary, contact Noldus for help.
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I purchased an add-on module. How do I update my license?
This depends on whether you have a software license or a license stored on the USB 
hardware key. See Add new modules to your license

TIP  To know which modules are included currently in your license, choose Help > 
About EthoVision XT > License Info. See also Modules of EthoVision XT

I cannot start EthoVision XT with a floating license
This occurs when a floating license was not deactivated on one of the other 
computers before starting EthoVision XT on that computer. This could happen for 
example when EthoVision XT is closed on a computer that has a floating license but 
currently no internet connection. Restart EthoVision XT on that computer and make 
sure that the computer is connected to the internet, then close EthoVision XT. Then 
start EthoVision XT on the computer you want to work with.

NOTE  With a floating license, all EthoVision XT computers must have an internet 
connection. See Types of EthoVision XT license. However, you can work offline with 
EthoVision XT under a floating license for a maximum of 90 days. After that, you 
must re-connect the EthoVision XT PC to the internet in order to continue to work 
with the software.

See also Software license - offline

I entered a license key but an error message shows a different 
one
Contact Noldus for support. Contact the Noldus Support

I need to create a Firewall rule to access the Noldus license 
server. Which port do I need to access?
You need port 443. 

I cannot deactivate a license. The menu item Deactivate license 
is greyed out
Close the experiment, then select Help > Deactivate license. 
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EthoVision XT is in Analysis mode, but there is no way to work 
with a full license
After starting EthoVision XT, you can work in Analysis mode, but the dialog that 
offers to work with the full license does not show up.

1. Close the experiment (if open).
2. Choose Help > Deactivate License.
3. Click Continue. EthoVision XT will now close.
4. Insert the hardware key in the PC or have the license key ready.
5. Start EthoVision XT and choose how to activate the license.

Message “Activation not complete”
This may be caused by the following reasons:

▪ A wrong or expired license key was entered in the previous step of the 
activation procedure. Click Back, and enter the license activation key that 
you received from Noldus.

▪ The computer may temporarily be disconnected from the internet. Check 
the internet connection and repeat the license activation procedure.‘

▪ The license may have been revoked, or is expired. Please contact your 
Noldus representative to purchase a new license.

Message “License already activated...”
After trying to activate a license, EthoVision XT (or the Noldus page displayed on 
your smartphone) shows a message:

The license [license number] has already been activated on a system called [computer 
name].

The license that you are trying to activate is still active on another computer.

1. Deactivate the license on the first computer. See Deactivate an EthoVision 
XT license 

2. Activate the license on the second computer. See Activate your EthoVision 
XT license

It is possible that EthoVision XT was removed from the first computer, but the 
license is still active there. Please re-install EthoVision XT back in order to deactivate 
the license on the first computer. See Install EthoVision XT
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Troubleshooting: General
Issues

▪ Some items in the EthoVision XT screen are missing
▪ EthoVision XT does not start when I double-click the icon on the desktop
▪ I cannot open an experiment
▪ EthoVision XT crashes after opening an experiment
▪ EthoVision XT hangs after creating a new experiment
▪ I cannot create new experiments, or acquire data with EthoVision XT
▪ Video and data seem out of sync
▪ When I create a new DanioVision experiment with a template made with a 

previous EthoVision XT version, my trial control rule does not work
▪ I get a message that a dll file is missing
▪ I cannot work remotely with EthoVision XT
▪ I get a message that the backup file cannot be created
▪ After selecting Deep Learning in the Experiment Settings, the software 

becomes unresponsive
▪ EthoVision XT crashes after opening a GLP log
▪ The text and boxes look very small (Windows 11)

Some items in the EthoVision XT screen are missing
Check that the item is selected in the Show/Hide menu at the top-right corner of 
the EthoVision XT screen.
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Menu items, items in the Experiment explorer, icons, etc. may become unavailable 
due to memory limitations. Use the data selection functions to reduce the amount 
of data to analyze.

EthoVision XT does not start when I double-click the icon on 
the desktop
This means that an instance of EthoVision XT is running in the background. This 
could be also due to removal of the dongle while EthoVision XT was running. Do 
one of the following:

▪ Press Ctrl+Alt+Del and then click Task Manager. Click the Processes tab, 
select each instance of EthoVision XT and click End task.

▪ Restart the computer and start EthoVision XT.

I cannot open an experiment

Experiment (in general)

▪ This occurs when you try to open an experiment (File > Open) that is saved 
in a newer EthoVision XT version. Start that version and open the 
experiment.

▪ Another reason could be that the experiment contains files whose names 
include non-ASCII or special characters. Please use standard ASCII 
characters when creating backups and saving copies of experiments (Save 
As).
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▪ It may be that the experiment repository file (*.evxt) is corrupt. First, delete 
that file (though not permanently - just leave it in the recycle bin). Locate 
the file Restore.btn and rename this file as the file you have just deleted, 
including the extension *.evxt. Next, in EthoVision XT, open that repository 
file (*.evxt). 

If none of the actions above solve the issue, contact Noldus Support.

Experiment from a backup

▪ You get a message like Backup [name of backup file] could not be restored. 
Probably the backup file is stored on a location for which you do not have 
write rights like a DVD or a network drive. Copy the backup to a location 
where you have full rights, and restore the experiment from that file. 

▪ You get a message like [name of backup file] is not a valid backup archive. 
(ID 10060).
Probably the backup is still in a zip folder after downloading (for example, 
My PC > Downloads > [folder name].zip). Extract the files to another folder. 
The backup should be outside zip folders.

Experiment from MyDocuments or Windows Explorer

Make sure that the MyDocuments is a mapped network drive.

If My Documents is on a non-mapped network drive (the file path shows no drive 
letter but \\computer\), you can open the experiment there by double-clicking its 
name (*.evxt), but it is not possible to open it by selecting File > Open. 

EthoVision XT crashes after opening an experiment
This may occur if you open an EthoVision XT experiment and UltraVox XT 3 is open 
on the same PC.

Always follow this sequence of actions when working with UltraVox XT 3 and 
EthoVision XT:

Close UltraVox XT > Start EthoVision XT > Open the EthoVision XT experiment > 
Start UltraVox XT.

This issue does not occur if you use UltraVox XT 4.
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EthoVision XT hangs after creating a new experiment
This may occur when the USB-IO box is connected to a USB port on a docking 
station or a USB hub. Some docks and hubs interfere with the signal between 
EthoVision and the hardware connected over USB.

Therefore, always connect the USB-IO box and other USB peripherals directly to the 
computer instead of through USB hubs or docking stations.

▪ If you use a laptop and encounter issues, connect the USB-IO box on the 
other side of the machine.

▪ If you use a desktop and encounter issues, connect the USB-IO box to the 
back side of the machine.

Video and data seem out of sync
You can test a video source on timing. This can determine how accurate a camera is 
in combination with EthoVision XT and can in some cases explain synchronization 
problems.

To do so you can use the TestVideo utility software. Browse to my.noldus.com, log in 
or register, then select Downloads > EthoVision XT > Drivers and tools and 
download TestVideo. Copy the file TestVideo [version number].exe to a location 
on your EthoVision XT computer and run it.

IMPORTANT Only install and operate TestVideo when requested by Noldus Support.

When I create a new DanioVision experiment with a template 
made with a previous EthoVision XT version, my trial control 
rule does not work
This happens if you change the Trial Control Hardware Settings in the Experiment 
Settings. We recommend to create a new experiment in EthoVision XT 18 and use 
this as a template for new ones.

I get a message that a dll file is missing
When starting EthoVision the message appears: The program can’t start because 
api-ms-win-crt-heap-I1-1-0.dll is missing from your computer.

To solve the issue, do a Windows Update.
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I cannot work remotely with EthoVision XT
You cannot control EthoVision XT from another computer through the Remote 
Desktop app. See Work with EthoVision XT remotely

See also Use a remote control to start and stop acquisition

I get a message that the backup file cannot be created
The backup is created anyway. You can restore the backup as usual. 

The issue occurs when some files in the experiment folder are still opened. For 
example, one or more Excel export files. Close all files before creating a backup of 
an experiment. 

After selecting Deep Learning in the Experiment Settings, the 
software becomes unresponsive
The first time the Deep learning function is selected, a model is created for the 
specific GPU installed on that computer. For some GPUs this process takes some 
time. During this time Ethovision will be unresponsive and appear to be crashed. If 
this is so in your case, wait until EthoVision will become responsive again. If the 
software no longer responds, contact Noldus.

The text and boxes in EthoVision XT look very small (Windows 
11)
This occurs sometimes in Windows 11 at very high screen resolutions.

Do the following:

1. Right-click the shortcut of EthoVision XT on the desktop and select 
Properties.

2. Click the Compatibility tab.
3. Click Change high DPI settings.
4. Under High DPI scaling override, check the option Override high DPI 

scaling behavior and select System or System (Enhanced) from the list 
below. 
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Troubleshooting: pylon camera software
This section applies to the applications pylon Viewer and pylon IP Configurator 
for Basler cameras.

NOTE  These two applications are installed automatically when you select to install 
the drivers for the Basler GigE camera or the Basler USB 3.0 camera. See Install 
EthoVision XT

Issues
▪ Pylon IP Configurator is not seeing a camera
▪ Pylon IP Configurator can see my camera but the Status column says Not 

Reachable
▪ I cannot save my camera settings in pylon Viewer
▪ No camera image in pylon Viewer

Pylon IP Configurator is not seeing a camera
1. Make sure that the camera is connected. See Connect the GigE camera to 

the PC.
2. If you use a Power injector or PoE switch, make sure that it is powered.
3. Restart the PC (if you didn’t after installing the camera’s driver).
4. If the issue persists, check the Ethernet board that is connected to the 

camera. See the following:
▪ Install the driver software for the digital cameras’
▪ Settings of the Ethernet board

NOTE  An issue has been reported for Dell 3540 running Windows 10 Pro, when 
using a 4-port AdLink Ethernet interface board. All ports in the Device Manager 
show an exclamation mark (!) and the cameras are not detected by pylon IP 
configurator. The problem appears to be caused by the Fast startup feature in 
Windows. This feature is disabled by default by Noldus. To enable Fast startup on 
Window 10 systems, navigate to Settings > System > Power & sleep > 
Additional power settings > Choose what the power buttons do and click 
Change the settings that are currently unavailable. Select Turn on fast startup 
and save the changes. 
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Pylon IP Configurator can see my camera but the Status 
column says Not Reachable
This may be caused by the IP address of the network card not matching that of the 
camera. 

For example, the network card should be 192.168.1.51 and camera should be 
192.168.1.101, that is, the first 3 numbers must be the same and the fourth number 
must be different.

Also verify that the subnet mask is 255.255.255.0.

See Install GigE cameras

I cannot save my camera settings in pylon Viewer
1. In pylon Viewer, click the Stop button on the tool bar.

2. From the Window menu select All Features.
3. In the Features panel, locate Configuration Sets. Now you can save the 

current settings. See Save the camera settings

No camera image in pylon Viewer
1. Check the issues above about IP Configurator.
2. Check that each Ethernet board has different networks in their IP addresses. 

For example 192.168.200.x for board 1, and 192.168.201.y for board 2. 
3. If the video screen is completely back it may be that the camera has an IR-

block filter and the light in the test room contains little infrared, or that the 
aperture of the lens is minimized.

4. Swap cables, cameras etc. to exclude the possibility that hardware is faulty.
5. Disable firewall and anti-virus software.
6. Check the Ethernet board settings and driver:

▪ Settings of the Ethernet board
▪ Make sure that the Ethernet board allows data transfer of 1 Gigabit/s.
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Troubleshooting: Camera
Issues

▪ The camera name is partly hidden in the Experiment Settings
▪ I cannot see the camera image when I click on the Camera icon in the 

Experiment Settings
▪ When I click on the camera icon in the Experiment Settings, the Video 

Settings box says “No frames available”
▪ There is no video camera listed in the Experiment Settings
▪ One or more cameras are not listed in the Experiment Settings
▪ The settings for color space are not available
▪ I cannot select a specific combination of frame rate and color space
▪ EthoVision XT stops working when two or more digital cameras are 

connected
▪ I cannot select a high frame rate
▪ I notice that video frames are dropped. Reducing Exposure time did not 

help.
▪ After selecting the first GigE camera in Experiment Settings, when I select 

the second camera, EthoVision crashes
▪ When using multiple GigE cameras, if one of the camera signals is lost, the 

order of the cameras in EthoVision XT scrambles
▪ EthoVision XT freezes in live video mode
▪ Error message “Device unplugged”

The camera name is partly hidden in the Experiment Settings
For example:
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In the Windows Control Panel, choose Display and reduce the text size, for example 
select 100%.

 

I cannot see the camera image when I click on the Camera icon 
in the Experiment Settings

1. Make sure that pylon Viewer is closed.
2. Make sure that the camera(s) is connected to the PC and powered prior to 

opening EthoVision XT.
3. Make sure that the aperture of the lens is fully open (lens ring all the way to 

Open or O).
4. Make sure the correct camera is selected in the Video Source list of the 

Experiment Settings. For example: Basler GenICam [Basler acA1300-60].
5. Make sure that the correct camera driver version 7.5.0 is installed. To find 

the version number, In the Windows Control Panel choose Programs and 
Features and locate the pylon Camera Software Suite.

6. Check the IP addresses of the Ethernet board ports and the cameras. See 
Assign IP addresses
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When I click on the camera icon in the Experiment Settings, 
the Video Settings box says “No frames available”

1. When using Windows 10: make sure you installed the camera driver from 
the installation files. If you installed it from an older installation disk, you 
could have installed an older driver (for example 4.2.1) which doesn’t 
support Windows 10. For the driver version that applies to your cameras, 
check the table in Cameras supported by EthoVision XT

2. If you changed the settings in pylon Viewer, check in that software under 
Acquisition Controls that the Trigger mode is set to Off.

3. Other causes are possible like installing Windows 10 on an older PC which 
isn’t compatible with Windows 10.

4. If none of these examples fit your situation, contact the Noldus Support for 
further assistance. Please also Make a PC report for Supports. 

There is no video camera listed in the Experiment Settings
▪ Make sure that the IP addresses are assigned to all cameras and ports in the 

Ethernet board, based on this topic: Assign IP addresses
▪ Check in the Windows Control Panel that the drivers for the camera are 

installed.
▪ Check the driver version. If the driver version differs from that reported in 

the table (see Cameras supported by EthoVision XT), uninstall the driver 
from the Control Panel. Install the correct driver, which you can find on the 
Noldus web site.
IMPORTANT  Always re-install the camera drivers from the EthoVision XT 
setup file, using the Modify option. If you need to install the Basler camera 
driver software from the original installation file Basler_pylon_[version 
number].exe, do the following:

▪ Log in to my.noldus.com. Choose Downloads > EthoVision XT > 
Drivers and Tools. Download Basler Camera Driver - Noldus - 
[version number]. Extract its content and copy everything to the local 
disk.

▪ Double-click the file Basler_pylon_[version number].exe. Accept the 
Terms and Conditions, then click Next.

▪ Under Profiles, select Custom and click Next. 
▪ Under Features, choose GigE Camera Support for GigE Vision 

cameras, or USB Camera Support for USB 3.0 cameras. Make sure to 
select pylon Viewer and DirectShow Support. 
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▪ Complete the installation.

One or more cameras are not listed in the Experiment Settings
▪ Check that you selected the correct number of cameras.
▪ Check that all cameras are connected and powered up. For digital cameras: 

close EthoVision XT and start pylon IP Configurator. There you should see 
which cameras are connected. 

▪ Make sure that the IP addresses are assigned to all cameras and ports in the 
Ethernet board, based on this topic: Assign IP addresses

▪ Check whether that camera is already selected in a different input. For 
example you do not see a camera for input 4 because that camera was 
already selected for input 1.

▪ It may be that after adjusting the settings for the first camera, those 
settings are no longer compatible with those still applied to the other 
cameras. 
For example, suppose you select Binning for the first camera, then you 
decide to de-select it. When you return to the camera list, Binning is still 
selected for the remaining cameras. This makes the camera views of the 
other camera incompatible with that of the first one. The result is that the 
remaining cameras are removed from the list. To solve this, select a new 
camera from the list at the top, and clear the Binning option also for that 
camera. Click OK, and do the same for the remaining cameras.

The settings for color space are not available
I have a color camera Basler AcA1920-40gc. When choosing the color space, the 
settings for the BYRG are not available.

Solution:

1. Select BYRG as color space.
2. Disconnect the camera, so it does not receive power. 
3. Reconnect the camera.
4. Fine-tune the camera setup leaving the color space to BYRG.
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I cannot select a specific combination of frame rate and color 
space
This happens because some values of video frame rate and color space are not 
compatible in some cameras. Those frame rate * color space combinations have 
been removed in the software.

EthoVision XT stops working when two or more digital 
cameras are connected
The problem occurs when the video resolution does match the values accepted by 
the software. Select for example 800 x 600, not 640x 426. See the tables in Cameras 
supported by EthoVision XT 

See also

▪ Adjust camera settings in EthoVision XT
▪ Camera Installation

I cannot select a high frame rate
For example, in the EthoVision XT Experiment Settings, when I set the resolution to 
something in the range of 1280x960, the maximum attainable frame rate is for 
example 7.5 frames per second.

1. Check that the Exposure time setting isn’t too high. See Adjust camera 
settings in EthoVision XT > Camera/General tab

2. Make sure that the Power Injector is in fact a 1GB Power Injector.
3. Make sure that the network card is in fact a 1GB network card. If that is the 

case, check that it is set to Auto-negotiate. If it is, then the network card 
either needs a driver update or is defective.

4. Check the cables. Cheap, incorrect or defective Ethernet cables can also 
reduce the frame rate.

5. The PC may have insufficient resources, for example only has an on-board 
video card. Please contact the Noldus Support and Make a PC report for 
Support.
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I notice that video frames are dropped. Reducing Exposure 
time did not help.
See this page and check that the camera settings match those of the Ethernet 
board:

https://docs.baslerweb.com/knowledge/how-to-troubleshoot-lost-packets-or-
frames-while-using-gige-cameras

After selecting the first GigE camera in Experiment Settings, 
when I select the second camera, EthoVision crashes
In the Experiment Settings, next to each video source, select a standard resolution 
like 640x480. Avoid resolutions like 640x426.

When using multiple GigE cameras, if one of the camera 
signals is lost, the order of the cameras in EthoVision XT 
scrambles

1. Always plug the cameras into the same ports. Label the ports and camera 
cables if needed to keep things in order.

2. Restore the camera signal.
3. In EthoVision XT, choose Setup > Acquisition, then choose Setup > 

Experiment Settings, and then go back to Acquisition. The camera order 
should now be restored to what you originally setup when first setting up 
this experiment. Despite the visual swapping of the cameras listed in Source 
table (via Experiment Settings), the order of the cameras should still load in 
the correct order matching the arenas.

Error message “Device unplugged”
Check first the cable connections between cameras and PC.

Check the video resolution in the Experiment Settings screen. Probably the 
resolution of resulting merged view is too large. Reduce the resolution in such a 
way it is compatible with the software. 

▪ For eight cameras, 2560 x 960.
▪ For sixteen cameras, 2560 x 1920.
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Troubleshooting: Video image
Issues

▪ The camera image is not detected by EthoVision XT
▪ EthoVision XT shows a message “No video frames”
▪ I do not see the image of the video file
▪ The video image looks grainy
▪ The live image from the camera looks distorted
▪ The camera image is static/pixelated with red, blue and green pixels
▪ The camera image is -center
▪ The camera image is too narrow to display the entire arena
▪ The camera image is ok in the Experiment Settings, but in the Arena 

Settings I see a white background image
▪ The camera image is not shown in the Arena Settings or Integrated 

Visualization
▪ The camera image flickers
▪ The camera image doesn’t flicker but the overall image lightens and 

darkens
▪ There is motion blur in the camera image
▪ The camera image is not in focus, no matter what I do
▪ The camera image is dark, even when using a lot of infrared light
▪ My video file is not playing correctly
▪ Video is being processed poorly
▪ A black bar is displayed when zooming in to a video file
▪ Ethovision XT freezes when playing a video file
▪ EthoVision XT freezes in live video mode

The camera image is not detected by EthoVision XT
Try the following:

▪ Make sure that the camera is powered and switched on, that the video 
cables are not broken and that there is no loose connection between 
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camera and computer. Try, for example, another video cable to see whether 
the image is then detected.

▪ If you have an analog camera, check that the camera is connected to the 
input of the encoder board that is selected under Video source in the 
Experiment Settings. If you have a digital camera, check that it is connected 
to the correct port on your PC.

▪ If you have a Basler digital camera, make sure to close the pylon Viewer 
software.

▪ Make sure that the lens cap is removed, and turn the camera’s aperture ring 
to Open.

▪ Click the Show/Hide button on the toolbar and make sure that Video 
Source is selected.

▪ If the camera was accidentally disconnected, reconnect the camera, then in 
EthoVision XT choose Setup > Experiment Settings and click the Refresh 
button next to the camera name.

▪ If you have MediaRecorder 2.5 installed on the same PC, it could be that the 
problem occurs because you have installed MediaRecorder 2.5 after 
installing EthoVision XT. Note that this problem does not occur with 
MediaRecorder 4 to 6. 
To solve the issue, download the installation files (see Install EthoVision XT) 
and double-click EthoVision XT - Setup - [version number].exe. In the 
window that opens, select Repair. This re-installs the correct software for 
displaying the camera image. 

▪ If the problem persists, re-install the drivers for the encoder board or digital 
camera. To do so, download the installation files (see Install EthoVision XT) 
and double-click EthoVision XT - Setup - [version number].exe. On the 
window that opens, select Modify and choose the appropriate driver from 
the list. See Install EthoVision XT
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EthoVision XT shows a message “No video frames”

The message is shown in the Experiment Settings > Video Settings window.

▪ See the issue above. 
▪ Confirm that the PC monitor is plugged into the stand-alone graphics card 

(GPU) and not the motherboard.
▪ If you are using Windows 10, and you are using GigE Basler cameras, make 

sure you installed the driver from the installation files. But if you installed 
from an older installation drive, you might have installed an older driver 
(e.g. 4.2.1) which doesn’t support Windows 10.

▪ The message “No video frames” is also shown when there is something 
wrong with the camera or the power supply or the video cable. Please 
replace cables or connect the camera to another input channel of the 
board, or another computer.

▪ Disable the Firewall for the network ports connected to the cameras. 
Disable the Windows firewall for the Ethernet board

I do not see the image of the video file
▪ Click the button next to Video in the Acquisition Settings window and 

select the file you require.

▪ Click the Show/Hide button on the toolbar and make sure that Video 
Source is selected.
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▪ TIP  Choose File > Preferences > Default Folder. Under Alternative media 
location enter the folder where your video files are stored. This way 
EthoVision XT looks in this folder if video files are not found in the Media 
Files folder of the experiment.

The video image looks grainy
The problem occurs only when connecting the video cables from a T splitter to 
input 1 and 2 of the Picolo H.264 board. Splitting the video signal into two cabling 
was necessary to acquire the tracks and simultaneously save video. However, In 
EthoVision XT 12 and later versions this is no longer necessary. Just connect the 
camera to video input 1 of the board.

The live image from the camera looks distorted
This may occur when you change the resolution of the camera image in the 
Experiment Settings (see Adjust camera settings in EthoVision XT), without 
updating the background image in the Arena Settings. To so, open the Arena 
Settings, and click the Grab Background Image button in the lower part of the 
Arena Settings window.

The camera image is static/pixelated with red, blue and green 
pixels
For example:

Solution: Make sure that the camera is set to black and white mode (via the camera 
menu; see the camera user manual for how to access this menu). 

▪ If you have a digital monochrome camera, in EthoVision XT, make sure that 
the Color space is set to Y800. If you set the color space in pylon Viewer, 
the correct option is Mono 8.

▪ If you have a digital color camera, see the camera type in Cameras 
supported by EthoVision XT for the recommended color space.

See also Adjust camera settings in EthoVision XT > Format tab
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The camera image is -center
This may occur if you select a lower resolution in the Experiment Settings, and the 
Center X and Center Y options are not checked in the camera settings. 

To solve this, increase the resolution to the maximum value and the arena will be 
centered. See Adjust camera settings in EthoVision XT > Format tab

If you prefer a lower resolution, check the option Center Image in the Camera/
General tab. See Adjust camera settings in EthoVision XT > Camera/General tab

The camera image is too narrow to display the entire arena
▪ This may occur when you select a low video resolution in the Experiment 

Settings. Rather than scaling the entire image down to the lower resolution, 
this camera displays a limited area of interest in order to maintain the full 
image quality. For the widest possible view, increase the resolution to the 
maximum value (typically 1280x1024).

▪ If you have a varifocal lens, you can also adjust the zoom setting on the 
lens. Note that adjusting the zoom will also change the focus, so you will 
need to adjust the focus as well in order to see the actual effect. Also note 
that you may need to loosen the lock screw on the side of the lens before 
the zoom setting may be adjusted.
TIP  Watch the video tutorial Set Up Your Test Environment. To open the 
tutorial, choose Help > Video Tutorial.

The camera image is ok in the Experiment Settings, but in the 
Arena Settings I see a white background image

▪ The video resolution set in the Experiment Settings is either too high or an 
odd resolution is selected, like 640x426. Reduce the resolution and/or pick 
a standard resolution (like 640x480).

▪ A similar issue occurs when no drivers have been installed for the 
computer’s graphics card. See below.

The camera image is not shown in the Arena Settings or 
Integrated Visualization
NOTE  This information is probably obsolete for EthoVision XT 18, since EthoVision 
XT no longer needs hardware acceleration. We keep it in the Help in the case you 
encounter this issue in EthoVision XT 17 or earlier.

This issue can occur in computers and laptops with two graphics cards, a primary 
(integrated) card and a secondary card (Graphics Processing Unit, or GPU), usually 
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more advanced and powerful than the integrated one. The issue occurs when 
EthoVision XT uses a graphics card that is not given hardware acceleration.

Choose one of the two solutions. In either case the chosen card is given hardware 
acceleration.

SOLUTION 1  Select the integrated (primary) card for EthoVision XT.

With this solution EthoVision XT uses the integrated card, which saves energy. You 
can choose that other programs use the secondary card, which requires more 
power.

▪ Method 1.
▪ Open the settings for the secondary card. For example, NVIDIA 

Control Panel. 
▪ Under Manage 3D Settings, click Program Settings and click the Add 

button to add EthoVision XT.
▪ From the list below 2. Select the preferred graphics processor for 

this program, select Integrated graphics. If the option is not 
available, follow Method 2 below. 

▪ Method 2. 
▪ In Windows choose Settings. Next to Search, type ‘graphics’ and press 

Enter. Choose Graphics Settings.
▪ Click Graphics. 
▪ If EthoVision XT is not listed yet, under Add an app choose Desktop 

app, browse to the installation folder (default C:\Program 
Files\Noldus\EthoVision XT 18), select EthoVision.exe and click Add.

▪ Click Options under EthoVision XT. In the Graphics Preference 
window, choose Power saving. Below this option you should see the 
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name of the integrated graphics card. EthoVision XT will use this card 
to play back video.

SOLUTION 2  Disable the integrated card in the computer’s BIOS. 

This solution has the disadvantage that the computer won’t use the integrated 
graphics card, which saves energy compared with the secondary card. EthoVision 
XT will always use the secondary graphics card.

1. Shut down the computer and start it again. Enter the BIOS. This is usually 
done by pressing the F2, F12 or other keys when the first screen appears. 
See your PC’s documentation for details.

2. Under Video, select Switchable graphics on the left, and de-select Enable 
Switchable Graphics, click Apply and exit the BIOS.

3. Now Windows only sees the secondary graphics card, which is given 
hardware acceleration. You can check that in the Windows Device Manager, 
under Display adapters.
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The camera image flickers
The underlying issue is that fluorescent and LED lighting cycles at a specific 
frequency, for example at 60 Hz in the US, and that frequency does not align with a 
frame rate of 25. Instead, use a frame rate of 30. Sometimes this is enough to 
resolve this issue.

If the problem persist, try the following:

1. The Exposure Time setting set in pylon Viewer or EthoVision XT is likely 
too low. To increase Exposure time, see Adjust camera settings in 
EthoVision XT. Try something in the 4000-8000 range. If lighting is low in 
the room, go for a higher exposure or open the aperture of the lens.

2. If none of the above resolve the problem, then was your PC purchased from 
Noldus? If not, it may be insufficient to run EthoVision as EthoVision is a 
very CPU intensive program. If you would like the Noldus Support to review 
your PC specs, please Make a PC report for Support.

The camera image doesn’t flicker but the overall image 
lightens and darkens

1. Check that in pylon Viewer under Acquisition Controls, Exposure Auto is 
set to Off.

2. Check that in pylon Viewer under Analog Controls, Gain Auto is set to Off.
3. Check that in pylon Viewer under Color Improvement Control, White 

Balance Auto is set to Off.
4. If none of the above resolve this, then check that your Exposure setting (in 

pylon Viewer under Acquisition Controls, or in EthoVision XT (Experiment 
Settings > click the camera button), Exposure Time is high enough (try 
8000).

There is motion blur in the camera image
The Exposure Time setting is likely too high, for example 20000 (microseconds) or 
higher. 

1. See Adjust camera settings in EthoVision XT for how to reduce the camera’s 
Exposure Time. The faster the subject, the lower the Exposure Time must 
be.
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2. With a lower exposure time, the image becomes darker. You can 
compensate for this by increasing the lens’ aperture or the camera Gain. For 
the latter, see Gain in Adjust camera settings in EthoVision XT.

The camera image is not in focus, no matter what I do
It does not matter how high the camera is mounted or whether I zoom in then 
focus. Image from camera is always blurry.

The camera will not focus if the wrong type of lens is mounted:

▪ A C-mount lens on a CS-mount camera. The camera can be used but 
requires an adapter ring installed between the lens and camera. 

▪ A CS-mount lens on a C-mount camera. In that case the camera and the 
lens are not compatible.

If the camera and lens have the same mount type, make sure this adapter ring has 
not been installed, as it will prevent correct focus.

If the solution above does not help, try resetting the camera. See Do a factory reset 
on the Basler GigE camera. When in doubt, contact Noldus Support.

The camera image is dark, even when using a lot of infrared 
light
This may be due to a few reasons:

▪ The Aperture ring on the camera lens is closed all the way. 
▪ The Exposure time of the camera is too low. See Adjust the camera 

exposure time
▪ The Gain of the camera is too low. Note that if you increase the camera 

gain, noise also increases. See Adjust the camera gain
▪ Some color cameras may have infrared block filters attached by default. In 

that case the IR light is blocked and the image looks dark. For Basler 
cameras, you can remove that filter. See Infrared-block filter
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My video file is not playing correctly
Download and use the Gspot software to check that the video file contains header 
information. If a video lacks header information, playback may not be smooth in 
EthoVision XT.

http://www.headbands.com/gspot/

We advise to convert the video file to another format. 

▪ Some MPEG-2 videos play back irregularly in the Track Editor and in the 
Integrated Visualization. In this case too, convert the video to another 
format.

▪ The following formats are NOT supported in EthoVision XT: WMV, Quick 
Time, FLV (YouTube), Xvid variants of the MPEG-4 format. See Video file 
formats

Video is being processed poorly
Set the hardware acceleration to maximum. You can do this in the graphics card 
control panel.

A black bar is displayed when zooming in to a video file
This may happen in the Track Editor or in Integrated Visualization. When zooming in 
and the size or position of the video exceeds the total size of graphic display then 
on some computers the hardware acceleration needed for rendering the video will 
stop functioning, causing a (partially) black video. Contact Noldus Information 
Technology for a new video graphics card.

Ethovision XT freezes when playing a video file
This may happen with MPEG-2 videos. Convert the video file to another format. 

EthoVision XT freezes in live video mode
This occurs with one or more digital cameras connected simultaneously. Experience 
tells that the software does not freeze only when you lower the resolution to e.g. 
800x600. 
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Troubleshooting: Arenas and zones
Issues

▪ How do I know the coordinates of the arenas, points and zones?
▪ Tracking does not start when the animal is inside the shelter
▪ The animal is in the hidden zone but the data show “missing sample”
▪ How do I view the analysis results for hidden zones?
▪ What if a hidden zone is part of a larger (overlapping) zone?
▪ I get a warning that two zones point to the same region, when in fact they 

don’t
▪ I want to repeat calibration but I do not see the ‘+’ cursor anymore

How do I know the coordinates of the arenas, points and 
zones?

1. Open the Arena Settings.
2. Position the mouse pointer on one vertex of the arena/zone outline or on a 

point of interest.

3. Do not move the mouse. In the Status bar, locate the World point (for the 
coordinates in calibrated units, for example cm) or Pixel point (for the 
coordinates in pixels).
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TIPS

▪ If you do not see the Status bar, choose View > Status bar.
▪ Zoom in the arena for a more precise positioning of the mouse pointer.
▪ You can use the point coordinates to calculate the coordinates of the 

subject relative to a point of interest. See an example in Troubleshooting: 
How can I merge heatmaps generated in different arenas? 

▪ See also The x-y coordinate system in the arena

Tracking does not start when the animal is inside the shelter
In an experiment with a hidden zone, for example a shelter, it is possible that the 
animal is already inside that zone when you start the trial. In that case, the trial will 
only start when the animal first exits the hidden zone. If you want the trial to start 
straight away, recording the animal inside the hidden zone, you can make a second 
entry zone, somewhere where you can put, for instance, your finger. 

If you cannot get close to the shelter, you can draw a zone that runs along the arena 
side:

After starting the trial, put your finger in that zone in such a way that EthoVision 
detects it (so the trial can start), then remove it (but make sure that the finger only 
appears and disappears in this entry zone, not the rest of the arena. This way 
EthoVision assumes that the animal has entered the hidden zone).
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The animal is in the hidden zone but the data show “missing 
sample”
You may encounter this issue in the Track Editor or in the Track Visualization/
Integrated Visualization. Normally this happens when the last recorded position of 
the animal immediately before disappearing from view is outside the entry zone. 
There are at least two possible reasons for that to occur:

▪ The entry zone is too narrow and too near the hidden zone. So chance 
increases that the last data point occurs outside the entry zone, before the 
subject disappears from view. 

▪ Another reason is that Track noise reduction is applied during tracking. In 
such a situation, the position of the subject at any time is smoothed using 
the last 12 samples. Especially when the subject moves fast, the data points 
may “lag behind” the image of the moving subject (you can check this in 
the Integrated Visualization). It can happen that the last smoothed position 
is calculated outside the entry zone. 

In both cases there is some chance that the last data point before the subject goes 
missing is still outside the entry zone. For this reason, EthoVision XT considers the 
subject missing, not in the hidden zone. 

To solve the issue, do at least one of the following:

▪ Make the entry zone larger. Duplicate the Arena Settings, enlarge the entry 
zone in such a way that the last position is likely to be inside that zone, and 
then use the new Arena Settings for the next trials.

▪ Increase the sample rate. Especially if the animals move fast, increase the 
sample rate. This increases the chance that at least one point position is 
determined inside the entry zone.

▪ Disable Track noise reduction. If you use Track noise reduction, duplicate the 
Detection Settings, under Smoothing set Track noise reduction to Off, 
and use the new Detection Settings to acquire the next trials.

How do I view the analysis results for hidden zones?
To calculate the time that the subject spent in a hidden zone, choose In zone in the 
Analysis profile and select the hidden zone.

What if a hidden zone is part of a larger (overlapping) zone?
▪ If the hidden zone is part of a larger zone, the results for that zone do not 

include the time spent in the hidden zone. This is because the time in the 
hidden zone is always calculated separately. 
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▪ If an entry zone is part of a larger zone, the time in the entry zone is also 
included in the time spent in the larger zone. 

In practice: if a zone includes a hidden zone, in order to know the total time spent in 
that zone, including the time spent in the hidden zone, you must sum up the times 
shown in the results table. See a note under the topic In zone

I get a warning that two zones point to the same region, when 
in fact they don’t
This is caused by very sharp corners of one or more zones. Using the Point edit tool 
(press P), move single points so that sharp corners are removed. For instance by 
adding a point just next to the sharp corner. See Move, rotate and resize a shape

I want to repeat calibration but I do not see the ‘+’ cursor 
anymore
Click the 1. Draw Scale to Calibrate button at the top-right corner of the screen. 
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Troubleshooting: Detection
Issues

▪ I cannot modify the Detection Settings
▪ The yellow blob changes its size periodically
▪ The percentage of Missed samples is very high
▪ The detected nose point is far from the animal’s contour

I cannot modify the Detection Settings
Once data has been acquired in EthoVision using a specific profile (Arena Settings, 
Trial Control Settings, or Detection Settings), they become locked from changes. 
This ensures that EthoVision always preserves the settings you used to acquire your 
data, so it can be checked or replicated.

If you need to make changes, right-click your existing settings profile, and select 
Duplicate. The new profile will allow modifications.

The yellow blob changes its size periodically
The area considered as detected subject changes at regular intervals, as if the 
brightness of the image was not constant.

▪ Check that the auto iris function of the camera is not enabled.
▪ For digital cameras, increase the Exposure time. It may be that periodical 

changes in the intensity of the ambient light are picked by the camera 
sensor.
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The percentage of Missed samples is very high

There may be a few reasons for this:

▪ The video resolution of the camera and/or the frame rate are set too high 
for the current detection method. EthoVision XT cannot acquire so much 
video information and at the same time track the subject. Reduce the frame 
rate and if necessary the video resolution in the Video source.

▪ The camera may not be sending the video frames at the expected rate. This 
occurs often with webcams or IP cameras. Select Dropped frames 
correction.

▪ The detection method currently selected is using too much processor time 
and that may not be necessary. For example, try a less demanding method 
like Static Subtraction instead of Dynamic Subtraction or Differencing.

See also Sample rate

The detected nose point is far from the animal’s contour
This may happen in some cases with detection based on Deep learning. For 
example, the nose is placed somewhere on an object or on the image of the subject 
reflected on a wall, as shown in this figure:

In the Detection Settings, under Method, click Define and reduce the size of the 
box around the animal. 
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Troubleshooting: Data acquisition
Video tracking

▪ The Start trial button is grayed out
▪ I track from the live camera image, and I get missing samples
▪ I track from video, yet I get missing samples
▪ Tracking from video is slow
▪ During tracking there is a significant lag
▪ The subject’s trail (or the area where it was first detected) is detected as the 

subject
▪ The text on top of the video window during acquisition is too small
▪ Tracking does not start when the animal is inside the shelter
▪ I cannot make tracks of long duration
▪ I selected the DDS option but my video plays at normal speed. Why?
▪ I see spikes in the track
▪ Error: The trial duration does not correspond with the system time (Id: 

12015)
▪ The subjects is detected in one arena, while in another arena I only see an 

orange blob

Manual scoring
▪ I do not see a behavior category in the Manual Scoring screen
▪ I want to remove the center point of the subject while observing
▪ The body points of one or more subjects are not displayed in the Manual 

Scoring screen

Other issues/questions
▪ I cannot start acquisition with a remote control
▪ I cannot import external data, or I get an error message “a gap was 

detected in the raw data”
▪ How can I randomize the start time of my trials?
▪ The Acquisition screen is not available in a Quality Assurance (GLP) 

experiment
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▪ How do I start data acquisition on multiple PCs simultaneously?

The Start trial button is grayed out
This may happens also when trials are planned. Adding trials in the Trial List does 
not help.

1. Make sure that, in the trial list, all the necessary settings are selected (Arena, 
Trial Control, Detection).

2. Make sure that the video selected in the Trial List is the same as that 
selected in the Acquisition screen (you find its name next to the Video 
button).

3. If you defined behaviors in the Manual Scoring Settings, make sure that 
there is one selected as initially active.

I track from the live camera image, and I get missing samples
This could be due to a number of reasons.

▪ Tracking is too processor-demanding.
▪ Try reduce the sample rate, or use another detection method (e.g. 

Dynamic subtraction instead of Differencing).
▪ Camera settings are not optimal.

▪ Make sure that the Exposure of the camera does not reduce the frame 
rate of the camera. See Adjust the camera exposure time

▪ Make sure in EthoVision XT that Video Pixel Smoothing is set to 
None. See Detection Settings > Video pixel smoothing.

▪ In the Experiment Settings, click the camera button. Make sure that the 
color space is Y800 for monochrome cameras. See Adjust camera 
settings in EthoVision XT

▪ Communication between camera and computer not optimal.
▪ In some circumstances the Ethernet board is not set properly, or the 

data transfer rate is too low for the frame size. You may see this 
message in pylon Viewer:

Either reduce the video resolution and frame rate, or increase the 
packet size in pylon Viewer (in the Feature panel, locate Transport 
Layer). A packet size of 1500 should be fine. If this is not sufficient, 
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increase the packet size to the maximum. If it does not help, there may 
be something wrong with the Ethernet board. See also Settings of the 
Ethernet board

▪ Disable the firewall. See Disable the Windows firewall for the Ethernet 
board

▪ Disable your anti-virus software: check the settings in your anti-virus 
software or ask your local IT person to disable it.

▪ As a last resort, do a factory reset on the camera. See Do a factory reset on 
the Basler GigE camera

▪ If none of the above solves the issue please Make a PC report for Support.

See also

▪ Missed samples

I track from video, yet I get missing samples
This is probably caused by the option DDS (Detection Determines Speed) not being 
selected. When DDS is selected, EthoVision XT takes the time necessary to process 
the images, and samples are not missed. See DDS (Detection determines speed)

If you work with multiple subjects per arena, and you do not want to select DDS, for 
example because you score behaviors live and you do not want video to be played 
back too fast, then in the Detection Settings (Subject size section), move the 
Modeling effort slider towards Performance. This reduces the likelihood that 
samples are missed. See Advanced detection settings: Subject size (multiple animals 
per arena) 

Also make sure that the camera Exposure time does not conflict with the camera 
frame rate. See I cannot select a high frame rate

Tracking from video is slow
Close other programs, including virus scanners. Check if the drivers of the video 
board (not the encoder board) are up to date.

During tracking there is a significant lag
At times the system freezes a bit, then catches up and resumes.

1. Restart the PC daily to refresh PC’s resources.
2. Assuming you are using a PC purchased from Noldus and the setup isn’t 

too demanding (e.g. multiple arenas, deep learning), then this is likely to be 
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related to an incorrect exposure settings in pylon Viewer (see Adjust the 
camera exposure time). 

3. Check that the video resolution is compatible with the frame rate; this may 
also need adjusting. See Adjust camera settings in EthoVision XT

4. Do also a check for missing samples. See Check that the camera is set up 
properly

5. If none of the above resolve your lag problem, then was your PC purchased 
from Noldus? If not, it may be insufficient to run EthoVision XT. If you 
would like Noldus Support to review your PC specifications, please Make a 
PC report for Support and submit a support case at my.noldus.com.

The subject’s trail (or the area where it was first detected) is 
detected as the subject
Make a reference image of the empty arena. Or if you use video, open the 
Advanced section in the Detection Settings pane and click Background next to 
Detection reference Image. Choose one of the options in the window that opens. 

The text on top of the video window during acquisition is too 
small
The size of the text is proportional to the screen resolution. The higher the 
resolution, the smaller the text. To solve this, choose a lower screen resolution. 

I cannot make tracks of long duration
Try the following:

▪ Switch off the Windows power-save options. 
▪ Remove virus-scanners
▪ Switch off the automatic Windows Update. If that cannot be done, 

disconnect the computer from the internet and restart it before acquiring 
data.

▪ Make sure that you have enough disk space.
For information on the maximum trial duration tested with specific cameras, see 
Resolution, frame rate, and maximum trial duration.

To track or record video for time longer than that reported above, we recommend 
that you make a series of trials. See Split a multi-day test in multiple trials
1437



I selected the DDS option but my video plays at normal speed. 
Why?
The cause could be related to the amount of data processing that EthoVision XT 
carries out. For example, the following options in the Detection Settings may be 
enabled: Track noise reduction and Dropped frames correction. To speed up data 
acquisition, make a copy of the Detection Settings, set the options above to Off and 
re-do the trial with those new settings. Or, accept the slow data acquisition if you 
need those settings to produce good data.

I see spikes in the track
This may occur in the Detection Settings, during data acquisition or in Track 
Visualization, or in the Integrated Visualization. In most cases you need to correct 
the arena settings and the detection settings.

Here a few examples:

1. EthoVision XT tracks light reflections as the subject. Remove sources of 
reflections by using diffuse, indirect light. Watch the video chapter Set Up 
the Test Environment in Help > Video Tutorial.

2. EthoVision XT detects some noise at the margin of the well. You can do two 
things:
▪ In the Arena Settings, reduce the size of the arenas, so they do not 

include the margin of the wall where the animal will never be. This 
should solve most of the issues.

▪ In the Detection Settings, increase the Minimum Subject Size so small 
groups of pixels will not be detected as the subject. If you work with 
DanioVision, move the Sensitivity slider to the right. See Advanced 
detection settings: Subject size (one subject per arena)

3. EthoVision XT finds the subject but it considers it as noise (here in orange), 
while other objects are detected as the subject. In this case it may suffice to 
increase the Maximum Subject Size in the Detection Settings. The 
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Maximum value should always be higher than that under Current when 
the animal is detected correctly. See Advanced detection settings: Subject 
size (one subject per arena)

You can also remove spikes by editing the tracks (not in DanioVision though). See 
Edit the Tracks

Error: The trial duration does not correspond with the system 
time (Id: 12015)
This could occur if the video camera provides an unreliable (i.e., fluctuating) frame 
rate. This may cause a mismatch between the system time and the tracking time. 
This halts data acquisition.

Industrial cameras such as the Basler cameras have reliable frame rates, while IP 
cameras and web cams often do not. If the camera is faulty or the driver is not 
installed properly, unreliable frame rates could occur.

The subjects is detected in one arena, while in another arena I 
only see an orange blob
This may be caused by one of the following:

▪ The second animal is of a color that does not match the current detection 
settings. 

▪ The reference image is not updated.
▪ The subject in the second arena is larger than the one in the first arena, and 

its exceeds the Maximum subject size currently set in the Detection 
Settings. See Advanced detection settings: Subject size (one subject per 
arena)

▪ The second arena is set to To Skip. Open the Trial List and set the 
Acquisition Status for that arena back to Planned.

I do not see a behavior category in the Manual Scoring screen
This happens when you open the Manual Scoring screen, then open the Manual 
Scoring Settings to define a new behavior there, and then return to the Manual 
Scoring screen.

Solution: Close and reopen the experiment.
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I want to remove the center point of the subject while 
observing
In some cases the center point of a small animal makes it hardly visible.

Solution: To hide the center point, choose Track Visualization or Integrated 
Visualization or Track Editor, and de-select the body points on the right-hand 
pane. Next, close and re-open the experiment.

The body points of one or more subjects are not displayed in 
the Manual Scoring screen
This happens when one or more subjects have been de-selected in the Track Editor 
or in one of the Visualization screens.

Solution: 

1. Open the Track Editor or the Integrated Visualization.
2. In the Track Plot Settings, under Subjects select the items you are 

interested in. 
3. Return to the Manual Scoring screen. 

I cannot start acquisition with a remote control
The remote control only works after opening the Acquisition screen and adding a 
new trial.

To activate the remote control, follow the instructions, see Use a remote control to 
start and stop acquisition.

Contact Noldus Information Technology to obtain a remote control.

IMPORTANT Before using the remote control, make sure that the Video window or 
the Playback Control window are on focus. To do so, click anywhere on the Video 
window or the Playback Control window. Then, operate the remote control.

How can I randomize the start time of my trials?
For example, start a one-minute trial every N minutes chosen randomly between 60 
and 120.

1. Create a batch file that performs a key press Ctrl+F5, which triggers the 
start of the trial. In this example, a batch (*.bat) file calls a VBS script (*.vbs) 
in Windows:
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wscript "C:\vbsprogram.vbs"

2. The VBS script contains the following code:
Set WshShell = WScript.CreateObject("WScript.Shell")

WshShell.AppActivate "EthoVision"

WScript.Sleep 1000

WshShell.SendKeys "^{F5}"

3. In Windows, open the Task Scheduler and create a new task.
▪ In the Triggers tab, specify when a trial should start (e.g. with a random 

delay).
▪ In the Actions tab, select the batch file (*.bat) that triggers the key press 

Ctrl+F5. 
▪ See also Start and stop the trial at specific clock times

NOTES

▪ When the task is enabled, make sure that EthoVision XT Acquisition screen 
is open, and there are no other windows or applications open.

▪ The end of each trial should be set in the Trial Control Settings. 
▪ In the Trial List, create a list of trials with the appropriate settings already 

assigned to each trial.
▪ The WScript.Sleep 1000 (1 s delay) ensures that the key press is given when 

EthoVision XT is in focus.

The Acquisition screen is not available in a Quality Assurance 
(GLP) experiment
First, make sure that you have a valid EthoVision XT license that includes the Quality 
Assurance module. See Modules of EthoVision XT

This issue could occur if you use EthoVision XT 17 or earlier, and you try to open 
Acquisition with an EthoVision XT software license. In that case you need a license 
on a hardware key instead. See Types of EthoVision XT license Contact Noldus when 
needed.
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How do I start data acquisition on multiple PCs 
simultaneously?
In the following example, we want to start data acquisition (that is, tracking) in three 
computers. For this you need three USB-IO boxes and EthoVision XT with the Trial 
and Hardware Control module in all PCs.

1. Connect the first PC (master) to the other two through the USB-IO boxes: 
TTL port 1 of the master PC to the TTL port 1 of the second PC, and TTL 
port 2 of the master PC to the TTL port 1 of the third PC.

2. For each PC, configure the hardware in the Experiment Settings. 
3. On the master PC, open the Trial Control Settings and modify the Start-Stop 

Trial rule in such a way that a TTL “high” signal is sent after the start of 
tracking to both ports TTL 1 and TTL 2 simultaneously. Make sure that the 
Action boxes and the Operator are at the right of the Start track box.

4. For each of the other PCs, open the Trial Control Settings and modify the 
Start-Stop Trial rule in such a way that tracking starts as soon as TTL “high” 
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signal is detected in TTL port 1. Make sure that you place the Condition box 
at the left of the Start track box.

5. To start acquisition in all the PCs, click the Start Trial button on the master 
PC.

As an alternative solution, you could devise a push button that sends TTL signals to 
each of the USB-IO boxes through UTP cables. Contact Noldus if you need this 
device.
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Troubleshooting: External data
Issues

▪ I cannot import external data, or I get an error message “a gap was 
detected in the raw data”

▪ I imported the external data in EthoVision XT, but the values are missing
▪ The external signals look “stretched”, or “compressed” over the time line.

I cannot import external data, or I get an error message “a gap 
was detected in the raw data”
Check carefully the prerequisites for importing external data. See Import external 
data: General information

TIP  Open one of your data files with the Notepad, and check whether there are 
irregularities in the file. Move the cursor between the numbers.

If there are blank spaces, not tabs between them, then in the import profile you 
must specify Space under Select data delimiters.

See also

▪ Create a new custom import profile
▪ Edit a custom import profile

I imported the external data in EthoVision XT, but the values 
are missing

▪ CASE 1  In the Integrated Visualization, you see the original signal, but not 
the downsampled signal as defined in the Analysis Profile:
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In most cases this could be due to the fact that the original signal is not in 
sync with the track data. Check the synchronization and re-import the files, 
or change the set of the external data by editing the start/end time.

See Synchronize data manually after import and Synchronize data 
automatically

CASE 2  The external data, both original and downsampled, are absent. 
When I try to re-synchronize the data, the Start date and time and the End 
date and time are identical.

This occurs when the original imported data (files with extension *.pbi) are 
not available, for example when they are stored on an external device. Make 
sure all files (experiment, and external data) are stored on the local drive.

The external signals look “stretched”, or “compressed” over the 
time line.
This may occur if one of the TCAP pulse trains, which encode the time used for 
alignment, is truncated. EthoVision XT calculates the average set using 10 values of 
time, and if one or more of the train pulses are incorrect, the data may be out of 
sync, or their form may look compressed or stretched.

In this example the last pulse train is shorter than the others:

1. Remove the imported data from the trial.
2. Open the original data (text) file and remove the last pulse train.
3. Re-import the edited data file.
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Troubleshooting: Track editor
Issues

▪ When I select a sample in the Sample List, the corresponding point in the 
track is not highlighted

▪ I try to move a point, but nothing happens. The software moves a point at 
an earlier time stamp

▪ When I select a group of samples of one subject, samples of another 
subject are also selected

▪ I no longer see the Track editor toolbar
▪ When I click to jump to another time, video update takes very long time

When I select a sample in the Sample List, the corresponding 
point in the track is not highlighted
In other words, when double-clicking a row in the Sample List, the corresponding 
point stays as a filled symbol (left), while it should be highlighted (right).

This occurs when the trials were recorded with EthoVision XT 17 or an earlier 
version. If that is the case, and provided that you still have the associated video files, 
clear the trials and re-do them using the same video and settings. See Redo a trial

I try to move a point, but nothing happens. The software 
moves a point at an earlier time stamp
You may have noted that when you click the point you want to move, the cursor on 
the Sample List (indicated with a green row) jumps to another time stamp. In the 
video image, the point is no longer highlighted (see an example with the nose-
point in the following picture):
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This happens because multiple samples overlap in the small portion of the image 
where you click. It is more likely to happen when you visualize the last few seconds 
of a track.

Solution: In the Track Plot Settings pane on the right, under Filter select Last and 
enter 0 next to seconds. This way, only the current sample, that is, the one 
highlighted in blue in the Samples List, is selected.

TIP  To select the nose point, hover with the mouse until the tip of the mouse cursor 
is near the tip of the triangle. To select the tail-base point, hover the mouse next to 
the lower-right corner of the square. When the mouse cursor is near the point, a 
four-headed cross symbol appears. Drag now the point to the new position.

If the actions outlined above do not solve the issue, it may be that the trials were 
recorded with EthoVision XT 17 or an earlier version. If that is the case, and 
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provided that you still have the associated video files, clear the trials and re-do 
them using the same video and settings. See Redo a trial

When I select a group of samples of one subject, samples of 
another subject are also selected
This occurs when you draw a box to select a group of samples, and the Filter option 
Last ... seconds is set to a value greater than zero. In that case EthoVision XT also 
select the samples of other subjects that lie within the box, and have a time stamp 
within the interval set in the Last ... seconds option. This makes it likely that you 
move or delete points of other subjects unintentionally.

Solution: Set the filter to Last 0 seconds.

If the problem still occurs it is because the body points of two subjects are very 
close to each other, and those subjects appear in the Samples List. To avoid this 
issue, de-select the subject you are not editing from the Samples List. 

I no longer see the Track editor toolbar
1. Close EthoVision XT.
2. In the experiment folder, locate two files with extension POS and POB, 

respectively. Delete both files.
3. Start EthoVision XT and open the experiment.

When I click to jump to another time, video update takes very 
long time
Do one or more of the following until the problem is solved:

▪ From the Apps screen, under Windows System, click Run, type in dxdiag 
and click OK. After the diagnostic procedure has been completed, click Exit.

▪ Restart the PC and have the computer enter hibernation mode. Then 
resume the PC and start EthoVision XT.

▪ Upgrade the video graphics card drivers. 
▪ Change the video graphics card. Contact Noldus Information Technology 

for information.
▪ See also System requirements: Hardware
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Troubleshooting: Statistics
Issues

▪ A variable does not appear in my results
▪ I get unrealistic values of path shape and direction
▪ A subject shows rotational behavior. However, when I look at the stats of 

Angular velocity or Turn Angle, the values are lower than for a subject which 
does not show rotation. Why?

▪ I get different results in two EthoVision XT versions
▪ I get different results when I analyze the same video twice
▪ I want to validate angle variables like Heading, Head direction, and Heading 

to Point, but the average value I calculate in Excel does not match the 
results in EthoVision XT

▪ The total distance moved does not always match the mean velocity
▪ I want to analyze Activity to detect freezing in rodents. However, when I plot 

the data I get lots of Inactive states
▪ I get wrong statistics of manually-scored behaviors
▪ The statistics result table contains many empty rows or columns
▪ The statistics result table contains two or more values of a dependent 

variable for the same trial, arena or subject
▪ The statistics result table does not appear
▪ The Data Preparation Report says “Failed” for some trials
▪ The percentage of “Subject not found” does not match the time in the arena
▪ The results table contains “?” in many cells
▪ How do I know the time between the starting point of a video and the time 

that I started tracking?
▪ I get more zone entries than expected
▪ The Analysis profile does not list Mobility and Head direction

A variable does not appear in my results
One or more of the following may the case:
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▪ The experiment is not set to Nose-point, center-point and tail-base point 
tracking.

▪ You do not have the add-on module that allows to calculate those variables.
▪ For social behavior variables: double-click a variable in the Analysis Profile 

and define Receivers there.
▪ Your experiment is set to Live Mouse Tracker. This type of experiment does 

not contain the raw data needed to calculate variables like Mobility, Head 
direction and Body elongation.

See also

▪ Dependent variables in detail: Social

I get unrealistic values of path shape and direction
Variables like Meander may have very high values (e.g. 5000 º/min) despite the fact 
that the animal moves approximately on a straight line. High values of the variable 
occur when body points for consecutive samples (that is, at times t-1, t, t+1...) lie 
near each other. For example, when the sample rate is high, and the subject does 
not move much, the distance moved between consecutive samples is very small, 
consequently Meander (which is by definition Turn angle divided by Distance 
moved) will be very high.

In this case it is useful to filter data using the Minimal Distance Moved method. 

To choose the threshold, plot the data of Distance moved together with your 
variable. For example, if you see that values of Distance moved around 0.05 produce 
unrealistic values of the variable, set Minimal Distance Moved = 0.1.

If this does not fix the problem, try re-tracking from the same video, but with a 
lower sample rate.

See also

▪ Dependent Variables in Detail > Path
▪ The Minimal Distance Moved smoothing method

A subject shows rotational behavior. However, when I look at 
the stats of Angular velocity or Turn Angle, the values are lower 
than for a subject which does not show rotation. Why?
Angular velocity does not necessarily correlate with rotations. If the animal turns 
slowly, its Angular velocity is low. Furthermore, when the subject sits still, but its 
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body point oscillates in all directions due to random noise, high values of Turn angle 
(and therefore Angular velocity) will appear. To minimize this effect, either use the 
Minimal Distance Moved filter (see the previous issue), or nest over Movement to 
only select the data points when the animal is Moving. Then, calculate your 
variables. The figure below compares Angular velocity calculated for when the 
animal moves significantly, with when it does not move.

To quantify rotational behavior, also use Rotation.

I get different results in two EthoVision XT versions
The possible causes of this issue are:

▪ You specified a sample rate that is lower than the maximum sample rate; in 
that case EthoVision XT analyzes every nth video frame (where n is the 
video frame rate/your sample rate; for example if you choose a sample rate 
of 12.5 for a video file of 25 frames per second, then n =2, that is, the 
software analyzes every two frames). In some previous versions, EthoVision 
XT always took the second frame in the video and every nth frame 
thereafter. The results like distance moved may be slightly different, but that 
is very unlikely to affect the outcome of an experiment.

▪ EthoVision XT 17.5 and later play video using the GPU by default. In 
contrast, EthoVision XT 17.0 and earlier used the CPU. This may result in 
slight differences in the appearance of the video image, for example, video 
looking brighter, which in turn could affect detection and the tracking 
results. You have two options:
▪ Revert to playback with the CPU in the Preferences for video settings.
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▪ Keep using the GPU and adjust the detection settings in the new 
version so they match the detection in the old version as much as 
possible.

I get different results when I analyze the same video twice
There may be a few reasons for this to happen.

Reason 1 - The effect of the reference image. When you use the detection methods 
Dynamic Subtraction or Differencing, the image used as reference may differ 
between trials even when you use exactly the same detection settings. The effect is 
more pronounced when you use Differencing.

▪ If you position the video file at different times (thus at different frames) 
then you go back to the beginning and start the trial, the reference image 
may be different in the two trials. This will cause the track to differ slightly 
between the trials.

▪ If you choose to use the dynamic reference image instead of the saved 
reference image at the start of each trial in a series (see The reference 
image) then the reference image with which trial 2 starts may not be exactly 
the same as the one at the start of trial 1. The difference may be of one or 
few more pixels brighter or darker, but still that difference has an effect. 

To ensure that you use a consistent reference image, duplicate the Detection 
Settings and under Advanced select Background > under Acquisition Settings 
select Use saved reference image or Use first frame of each trial. This way at the 
start of each trial the same reference image is used. See The reference image

Reason 2 - Missing samples can affect the track duration. This happens especially if 
the missing samples happen to occur just when trial control start or stop conditions 
are evaluated.

Reason 3 - In multi-subject tracking doe with Deep learning, the results are not 
entirely repeatable due to the non-deterministic nature of the algorithm. Note that 
this occurs when you select to track two subjects in the arena, not just one. See 
Troubleshooting: Deep learning > The results of two-subject tracking are not 
consistent when using the same video

Concluding, to improve the consistency between trials:

▪ Start both trials at the beginning of the video file, without positioning the 
video on any frame in the middle.

▪ Improve the subjects’ detection to reduce the number of missing samples. 
▪ Use Gray Scaling or Static Subtraction (if possible). If you use Differencing 

or Dynamic Subtraction, choose to use a fixed reference image. See The 
reference image
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▪ To smooth out the tracks and remove outliers, apply the Lowess smoothing 
to the tracks. See The Lowess smoothing method

I want to validate angle variables like Heading, Head direction, 
and Heading to Point, but the average value I calculate in Excel 
does not match the results in EthoVision XT
If you use the ATAN formula, the value is wrong because ATAN uses another 
convention for the sign of the average sine and cosine of angles. Use instead 
ATAN2. 

The formula for the average in a track is 

=DEGREES (ATAN2(AverageCos, AverageSin))

Where AverageCos is the average of Cos values (calculated as 
=COS(RADIANS(angle)), and AverageSin is the average of Sin values (calculated as 
=SIN(RADIANS(angle)), and angle is the per-sample value of Heading, Head 
direction, or Heading to point. 

The total distance moved does not always match the mean 
velocity
When plotting the average velocity and the total distance moved, there should be a 
linear relationship between the two. In particular:

Average Velocity = Total distance moved / T

Where T is the time interval (e.g. trial, or time bin) within which the samples are 
used to do the calculations. For example (here the time bin is 1 second):
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In some cases the data points deviate from the linear relationship. The reason is that 
the total distance moved is calculated over the available samples. If some samples 
within an interval are missing, or in some samples the subject was not found or if 
the interval is incomplete (for example, the last time bin in a track), then the total 
distance is underestimated while the average velocity is unaffected. As a result, the 
mean velocity no longer lies on the straight line, rather, it lies above the line. The 
mean velocity is higher then expected from the current distance moved. This 
pattern is therefore an artifact of the variation in the number of samples available 
for each time interval. In principle, there is nothing wrong with the data, provided 
that the proportion of missing samples or samples with “subject not found” is low.

I want to analyze Activity to detect freezing in rodents. 
However, when I plot the data I get lots of Inactive states
This usually happens when the Activity settings in the Detection Settings are too 
high. For example, the Activity threshold is 20, or Background noise filter is set 
to more than 3. In such cases the thresholds are so high that almost no video frame 
the subject is considered Active, even if in the Analysis profile the Active state was 
defined with low threshold values.

Solution: make a duplicate of your Detection Settings, reduce the Activity 
threshold and/or the Background noise filter. Check in the video image that 
purple pixels appear only when the subject moves. Then repeat the tracking with 
those Detection Settings.

I get wrong statistics of manually-scored behaviors
Problem: I scored a behavior of type “Start-stop”. In the Statistics and Charts page, 
the frequency of Not [behavior name] is X+1 when it should be X.
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Explanation: This occurs when you score a Start-stop behavior until the end of the 
trial. At the last sample time, the behavior is automatically ended (see Grooming 
below), and its complementary Not [behavior name] is scored. This results in the 
additional occurrence of Not [behavior name] in the statistics. However, the statistics 
of the actual behavior are correct.

The statistics result table contains many empty rows or 
columns
This occurs often when you make multiple data selections. For example, you make a 
Nest condition to select the time from 12 hours to 24 hours. Then you create time 
bins of one hour each. The results table also shows the “empty” bins from 0 to 12 
hours:

To hide the empty rows/columns:

1. Click the Layout button on the toolbar (or click the Show/Hide button at 
the top-right corner of the screen and select Layout). 
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2. In the window that opens, select Hide empty rows or columns.

The statistics result table contains two or more values of a 
dependent variable for the same trial, arena or subject

This may be due to the fact the results are calculated with a data profile containing 
two or more Results boxes, but the table does not show the corresponding headers. 
Click the Layout button and add Selection Result, or Arena name, or Subject. See 
Modify the layout of the results table

The statistics result table does not show the measurement 
units
This occurs when in the Layout window you place the Variable with detail on the 
rows and the Statistic with unit on the columns, and vice versa. To solve the issues, 
place both items on the rows or on the columns. See Modify the layout of the 
results table

The statistics result table does not appear
Problem: The results table in Trial Statistics or Group statistics and charts shows no 
headers and no results.

Explanation/Solution: This could happen for example when

▪ The experiment has no data yet.
▪ The data have been completely filtered out in the Data profile. Please check 

your data selection.
▪ For Group statistics: An independent variable was inserted in the table 

Layout, and at least one of those groups contains multiple values of that 
variable.
EXAMPLE  In the Data profile, you group tracks in two groups, Treated and 
Control. In the Group statistics and charts, you insert the independent 
variable Rat ID in the Layout, but each group contains many values of this 
variable (one per subject tested). Therefore, the grouped results cannot be 
listed properly. 
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To solve this, either remove the variable from the Layout (Modify the layout 
of the results table), or in the Data profile group your trials in a different 
way. See also Trial Statistics result

The Data Preparation Report says “Failed” for some trials
This message occurs in experiments with Deep learning based body point 
detection. In some cases EthoVision XT fails to review the tracks and fix subject 
identity swaps. For example, when the two subjects spent most of the trial time in 
close contact, or the video file was too short to obtain a reliable trained neural 
network. See a note in Prepare the data in multi-subject trials

The percentage of “Subject not found” does not match the 
time in the arena
Problem: “Subject not found” gives one value (e.g. 5%) and the total time the animal 
is in the arena (Cumulative duration% in the Arena) is 96%, while I expect them to 
be complementary.

Explanation/Solution. In the following example there is a gap of 25 frames of 
“subject not found”. With 25 frames per second (so 0.04 s per frame), that comes 
down to a missed sample time of 1 second, which may be for example 0.5% of the 
total time. That percentage you see in the Trial list. However, when the subject goes 
missing, EthoVision XT assumes that it is still in the arena in the next 3 frames, 
before considering it “not in the arena”. In this example, the gap is not 25 frames 
but 25-3 = 22 frames. Therefore, the total time “not in the arena” is 22*0.04 s = 0.88 
s instead of 1 s. Thus, Subject not found and Cumulative duration% in Arena not 
always match.

The results table contains “?” in many cells
This could indicate that one or more trials are corrupt. However, it is also possible 
that you edited the tracks and something went wrong with editing. 

1. Click Calculate and take note of a trial that gives the “?” results. 
2. Go to the Track Editor, select the trial and then click Undo All. Note that this 

action erases all your edits in that trial.
3. Re-do editing when necessary.
4. Run analysis.
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How do I know the time between the starting point of a video 
and the time that I started tracking?
This applies to cases when you positioned the video later than its starting point and 
then clicked Start Trial. 

1. Export the raw data (Choose Analysis > Export > Raw data). 
2. Open the exported file and look at the difference between the value next to 

Start time and the value next to Video Start time. 

I get more zone entries than expected
This applies to In Zone variables where the number of entries is higher than that 
expected. For example:

This could occur for different reasons: 

▪ A common issue is that the center point of the subject moves back and 
forth around the boundary between zones when the animal moves just on 
that spot. This overestimates the number of true zone entries. To avoid that, 
use the Zone exit threshold, in the In Zone dependent variable settings, or 
use all the three body points to score a zone entry. See In zone

▪ Another reason for an overestimate of zone entries is that the center point 
is no longer detected in a zone, although the subject is still found. Consider 
for example this zero maze. The open and closed zones do not cover the 
arena completely. 

The orange part in the figure above is the region of the arena outside the 
zones. When the center point is detected there, a zone exit is scored. A new 
zone entry is scored when the center point is found in the zone again. As a 
result, you could see a train of zone entries like this:
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To solve this issue, re-draw the zones in such a way they overlap the entire 
region of interest within the arena. For example:

 

The Analysis profile does not list Mobility and Head direction
This occurs when your experiment is set to Number of Subject = 2 and Body Point 
Detection Technique = Deep learning. In that case the software does not calculate 
the body contour and the Head direction line.
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Troubleshooting: Behavior recognition
Issues

▪ How do I check that the video file contains artifacts?
▪ EthoVision XT finds more instances of a behavior than expected
▪ EthoVision XT finds no instances of Grooming
▪ I get different results when I use Behavior Recognition in two EthoVision XT 

versions

How do I check that the video file contains artifacts?
Artifacts due to video compression can reduce performance of Behavior 
Recognition.

1. Create an experiment and set it to tracking From video file and Activity 
analysis. 

2. In the Detection Settings, open the Activity analysis. Reduce the Activity 
threshold to the minimum.

3. If the video contains artifacts, you should see purple pixels appearing and 
disappearing with a regular rhythm.

4. Just to be sure, do a test trial and plot the Activity values in the Integrated 
Visualization. A pattern resulting from video compression artifacts looks 
like this:

EthoVision XT finds more instances of a behavior than 
expected
This may occur due to the low contrast of the subject with the background, and too 
little contrast within the subject area, that is, too little detail in the fur.

For example, too many Grooming instances are scored when the subject is asleep. 
This occurs when the image of the subject is overexposed. For example, white rats 
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look pure white. In this case the inner part of the subject area is fairly constant in 
time, compared with the outline, and that increases the probability of detecting 
grooming. To solve the issue, close the lens’ aperture or reduce the exposure time. 
See Adjust camera settings in EthoVision XT

EthoVision XT finds no instances of Grooming
The subjects clearly displays bouts of grooming, however EthoVision XT does not 
detect it at all. This may happen when the regular shape of the subject viewed from 
above is more “round” than usual, as it occurs in certain strains or circumstances. 

In that case, after clicking Grab in the Define Subject Properties dialog often results 
in a value of Posture being lower than the minimum required (70 for mice). This 
means that the contracted shape of the subject during grooming is more likely to 
be considered as “normal”, therefore grooming is not detected.

Find a video frame where the subject walks and looks a bit stretched, preferably 
when one can see the contour of the hindlimbs. Then, click Grab. Repeat these 
steps until the value of Posture obtained is higher than the minimum required.

I get different results when I use Behavior Recognition in two 
EthoVision XT versions
There may be differences in the scores of behaviors between EthoVision XT 18 and 
a previous version, even when using the same video file and the same Behavior 
Recognition settings. This may have to do with the different video decoding 
software that is used in the two versions. Small changes in the way video is 
displayed (e.g. the same pixel displayed with slightly different intensity value) may 
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result in changes in the probability of some behaviors, and therefore influence the 
automatic scores.

We tested a number of video files and found that the codec used to create the 
video file may affect the difference in the results between software versions. When 
the video was created with H.264 MPEG-4 AVC codec or the mp4v MPEG-4 codec, 
the average difference in the behavior scores (either frequency of occurrence or 
cumulative duration) expressed as a percentage of the scores obtained with the 
same video in EthoVision XT 15, is between 0 and 2% (averaged across all behavior 
categories).

The H.264 MPEG-4 AVC codec is used by EthoVision XT 16-18 and MediaRecorder 
5-6. The mp4v MPEG-4 codec is used by EthoVision XT 15 and MediaRecorder 4.

For codecs like DivX, Xvid, MPEG 1 and MPEG 2, the average difference between 
EthoVision XT 15 and 16 is larger - up to 22%.

As general recommendations:

▪ Always use EthoVision XT or MediaRecorder to record video that you will 
analyze with Behavior Recognition.

▪ When you upgrade an experiment made with an older version of 
EthoVision XT to EthoVision XT 18, and you want to re-do Behavior 
Recognition, make sure you use exactly the same Arena Settings and 
Detection Settings that you used with that particular video file.

▪ In the Analysis profile, adjust the criteria based on the behavior probability 
to only consider the instances of behaviors that have a high probability, for 
example higher than 95%. That usually gives more robust results.

See also

▪ Behavior Recognition: Data, performance and accuracy
▪ How behaviors are scored in Behavior recognition
▪ Dependent variables: Behavior Recognition
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Troubleshooting: Deep learning
Issues

▪ I see identity swaps during data acquisition
▪ The nose and tail base points are not stable even when the contour of the 

subject is detected well
▪ The results of two-subject tracking are not consistent when using the same 

video
▪ The Data Preparation Report says “Failed” for some trials
▪ A subject is labeled as Subject 1 in the first trial and Subject 2 in the second 

trial
▪ The results of two-subject tracking differ depending on the graphics card 

(GPU) used
▪ One of the subjects was not tracked at the start of the video

I see identity swaps during data acquisition
This is normal when using the Deep learning technique in two-subject tracking. The 
identity swaps are corrected during the Data Set Preparation process. During that 
process, the track segments are sorted and put together based on the visual 
appearance of the subjects. This procedure greatly reduces identity swaps. See 
Prepare the data in multi-subject trials

The nose and tail base points are not stable even when the 
contour of the subject is detected well

▪ With one subject per arena: In the Detection Settings, click the Define 
button, then Automated.

▪ With one or two subjects per arena: check that there is enough contrast 
between subjects and background.

▪ Furthermore, objects in the arena may reduce the accuracy of the position 
of the nose point. 

▪ See also Deep learning: Requirements
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The results of two-subject tracking are not consistent when 
using the same video
This occurs because the individual recognition algorithm is not entirely 
deterministic. Probability plays a role in determining whether an animal in a certain 
video frame is labeled as Subject 1 or Subject 2. 

As a result, the statistics may differ between two trials, even when using the same 
video and tracking settings (Trial Control Settings, Arena Settings and Detection 
Settings).

▪ Mirror labeling. The first thing you may notice is that, when you acquire two 
trials from the same video, one individual (say that with the tail marks) is 
labeled as Subject 1 in trial 1 (red dot; left), whilst as Subject 2 in trial 2 
(green dot; right). Conversely, its partner is labeled as Subject 2 in trial 1, 
and as Subject 1 in trial 2. Thus, the second trial is a sort of mirror image of 
the first one.

If you want to keep consistency of labeling, for example to have the 
resident individual of a resident-intruder pair of mice always labeled as 
Subject 1, swap the subjects in the entire trial (see below).

▪ Consistency of ID assignment. Even when the same individual is labeled as 
Subject 1 in both trials, there is a small chance that the results are not 100% 
consistent. Within short segments of the tracks, the identity labels may 
differ: for example, the marked mice is labeled as Subject 1 in trial 1, and as 
Subject 2 in trial 2. 
1464



Such segments last a few seconds and usually occur during situations of 
body contact. According to our tests carried out on videos provided by 
users, the probability that an individual at any time point in the video is 
labeled the same way in both trials, after correcting for the mirror labeling 
(see above), is 99.6% (range 83.5 to 99.9, n= 9). Low values occurred in 
videos where the animals were in contact most of the time, or videos of low 
resolution and with more noise. 

In the Track Editor, review the video to evaluate the extent to which identity 
swaps occur. If that is not acceptable, swap the subjects where necessary, so 
that you get fully consistent results.

▪ Consistency of general statistics. The non-deterministic mechanisms of the 
multi-subject tracker based on deep learning also cause the statistics to be 
not 100% repeatable when tracking multiple times from the same video. 
When analyzing the Total Distance moved in trials acquired from the same 
video, the coefficient of variation is 0.4 % (range 0.1 - 2.5). In practice, a 
video where an animal walks 100 meters could result in some 40 cm 
difference in distance moved between trials. Higher-quality videos produce 
variability of the results lower than 1% of the mean. 
If this variability is not acceptable, open the Track Editor and swap the 
subjects where necessary.

See also

▪ Prepare the data in multi-subject trials
▪ Deep learning: Requirements
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A subject is labeled as Subject 1 in the first trial and Subject 2 
in the second trial
You may want to keep the identity labels consistent. For example, to assign the label 
Subject 1 always to the resident individual, or the individual marked on the tail.

To make identity labeling consistent, swap the subjects for the entire trial.

1. Open the Track Editor (Acquisition > Edit Tracks). 
2. Select the trial where you want to swap the subjects.
3. Click the header for the first subject (default: Subject 1) in the Sample List.

You may have replaced Subject 1 and Subject 2 by other role names in the 
Experiment Settings; see Subjects per arena). 

4. Press Shift, and click the header of the second subject (default: Subject 2).
5. As a result, the entire sample list is highlighted in green. See also Select 

samples manually
6. Click the Swap subjects button.

See also

▪ Swap subjects
▪ Select samples manually

The results of two-subject tracking differ depending on the 
graphics card (GPU) used
The results of two-subject tracking could be slightly different based on which GPU 
was installed, everything else being equal (e.g., computer, arena settings, etc.

When the neural network model is not highly certain about the pose of the subject, 
small differences in handling of number with decimals could lead to noticeable 
differences, for example in the position of the nose at a certain sample time. 
Another reason could be that precision handling could differ between NVIDIA 
driver versions.

Tests carried out with supported GPUs show that the maximal difference in distance 
moved between GPUs is in the order of 0.1%.
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One of the subjects was not tracked at the start of the video
When you open the Integrated Visualization, there is one track in each arena, while 
you expect two tracks. One of the two subjects apparently was not detected. This 
usually occurs in the first few seconds of the video.

In reality both subjects were detected, but their tracks now overlap. You can check 
this by de-selecting one of the subjects in the Show/Hide pane. 

To prevent this from happening.

▪ Create new Detection Settings and select the maximal sample rate, i.e. at 
least 25 samples per second, then re-do the trial. See Sample rate

▪ Make sure that the two animals are released at the same time, or one 
shortly after the other (e.g. less than 30 seconds). The video should not 
contain a long segment with just one animal in the arena.
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Troubleshooting: Data visualization
Tracks and Integrated Visualization

▪ I defined “In zone” for two adjacent zones. In the Integrated visualization, I 
see that the animal is in the two zones simultaneously

▪ I defined a free interval, and in the visualization I get an interval every other 
sample

▪ I plotted a variable in the Integrated visualization. I only get a few values on 
the timeline. Why?

▪ I interpolated my data, but some variables including Elongation and 
Mobility still show missing values

▪ Screen recording could not be started
▪ There seems to be a delay between video and track
▪ The video image is not shown
▪ Video is choppy or does not play smooth
▪ The points are too small (or too large) or the traces are too narrow (or too 

thick)
▪ When I import UltraVox XT data, some calls are visualized as 1, others as 0.5. 

Why?
▪ The Integrated Visualization shows “Not calculated”
▪ The Data Preparation Report says “Failed” for some trials
▪ I cannot visualize a trial
▪ The name of the trial is not fully visible

Heatmaps
▪ A heatmap is plotted outside the arena, or merged with the heatmap of 

other arenas
▪ In the Heatmaps screen the Group Mean button is not available
▪ How can I merge heatmaps generated in different arenas?
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I defined “In zone” for two adjacent zones. In the Integrated 
visualization, I see that the animal is in the two zones 
simultaneously
This happens when a Zone exit threshold has been defined that is greater than 0, 
and the two zones Center and Border are adjacent. In such a case, when the animal 
moves from Border to Center, it is at some point considered to be in Center, but if it 
is not yet outside the zone exit threshold of Border, it is also considered to be in 
Border.

To prevent this, re-define the two zones in such a way there is a gap between the 
two, its width being at least the same as the zone exit threshold.

I defined a free interval, and in the visualization I get an 
interval every other sample
Most probably you defined a free interval based on two values of external data or a 
hardware variable, for instance:

▪ From Heart rate >= 300 to Heart rate >= 400
▪ From Number of pellet drops >= 1, to Number of pellet drops >= 10

When the value of the (resampled) variable reaches the second (higher) threshold, 
the interval ends and EthoVision XT finds the next sample that matches the 
criterion defined in From (first threshold). If the current value is higher than the first 
threshold, a new free interval is defined. However, if the value at the next sample is 
also higher than the second threshold, the interval is ended, resulting in a free 
interval of one sample. The search is repeated in the next samples, generating the 
pattern shown in the first plot below.
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In such cases, do not use a free interval. Instead, use a state variable that is based on 
the original external or hardware signal. You can find the state variable in the 
Analysis profile. For example, for the external data Heart rate, in the Analysis profile 
under External data choose Heart rate state. For a hardware signal, under 
Hardware choose Hardware state. There you can define the range of values you 
are interested in. In the example above about heart rate:

I plotted a variable in the Integrated visualization. I only get a 
few values on the timeline. Why?
This may happen for variables which require two or more consecutive data points to 
be calculated. Consider the following examples:

▪ Your data contain missing samples. If one sample is missing, the variable is 
not calculated for one, two or more time points. For example, Distance 
moved is not calculated for two time points, and Turn Angle is not 
calculated for three time points.

▪ You may have applied Minimal Distance Moved smoothing method. When 
using this method, if the distance between body points for time t and t+1 is 
lower then the Minimal Distance Moved, the body point at time t+1 is 
“moved” to the same coordinates as the point as time t. In this case 
Distance moved gets the value 0 (zero), but any variable that quantifies 
change in direction has no meaning here. Therefore, is not calculated for 
that sample.
If many samples in your track are filtered out that way, variables like Turn 
Angle, Meander and Heading only appear in short segments. Because the 
filter removes data points that do not represent movement, these few 
remaining segments are a more realistic measure of the subject’s behavior.
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See also

▪ How variables are calculated: Dependent Variables in Detail

I interpolated my data, but some variables including 
Elongation and Mobility still show missing values
Interpolation is only applied to missing body points to obtain valid x,y coordinates. 
When the subject is not detected, the subject’s contour and surface area remain 
unknown. This is why variables such as Activity, Elongation and Mobility still show 
missing values after interpolation. 

Screen recording could not be started
When trying to make a screen recording, you get the following message:

This may be caused by the fact that older versions of the Noldus MediaLooks A/V 
filters are still installed, but the newest version was not installed. 

1. Close EthoVision XT.
2. In the Windows Control Panel, choose Programs and Features, and 

remove old versions of Noldus MediaLooks A/V Filter. 
3. Download the full installation ZIP file (see Install EthoVision XT), extract and 

browse to Drivers and tools > PreRequisites > MediaLooks. Copy 
Noldus Medialooks ScreenCapture 2.0 x64.msi to your EthoVision XT 
computer and run that file.

4. Follow the installation, then start EthoVision XT.

There seems to be a delay between video and track
The track is lagging behind the video or the other way round.
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This issue can only occur when you track live and save video.

Solution:

1. Choose Acquisition > Edit Tracks.
2. Choose the trial from the list at the top.
3. Play the video until the subject and the track are well in view. 

TIP  Choose a frame when the animal walks fast so you can see exactly in 
which sample the nose point overlaps with the subject’s nose in the video. 

4. In the Playback Control window, click the Offset button. 

This button is only available when you tracked live and saved video.

5. In the Synchronize video window that opens, enter a number of frames 
(negative or positive) to correct the discrepancy between track and video. 
Click OK when ready.
For example, enter -1 to move the video one frame backward relative to the 
track.

The video image is not shown
This issue can occur in computers with two graphics cards: a primary (integrated) 
card and a secondary card, usually more advanced and powerful than the 
integrated one. The issue is solved when you choose which card EthoVision XT uses.
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See The camera image is not shown in the Arena Settings or Integrated 
Visualization

Video is choppy or does not play smooth
This may occur if you play video at high playback speed like 16x in the Integrated 
Visualization. The effect is worse if the secondary graphics card (GPU) which takes 
care of the playback is less powerful.

The points are too small (or too large) or the traces are too 
narrow (or too thick)
Solution: in various parts of EthoVision XT you can change the thickness of the lines 
and the size of the dots. 

1. Click Show/Hide (at the top-right corner of the screen) and select 
Detection Features. 

2. Adjust the Line thickness and Dot size.

Note:

▪ What you select in the Detection Settings screen are also selected in the 
Acquisition screen, and the other way round.

▪ What you select in one of the following screens is also selected in the other 
screens: Track Editor, Track Visualization, Integrated Visualization, Manual 
Scoring screen 

▪ The line thickness is also applied to the body contour in Detection Settings 
and Acquisition screen. It is not available in the Manual Scoring screen.
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When I import UltraVox XT data, some calls are visualized as 1, 
others as 0.5. Why?
This is due to the type of resampling selected in the external variable of your 
Analysis profile. Consider the following example. The first plot shows the original 
signal imported from UltraVox XT and the second plot shows the same signal after 
resampling:

For the second call at 25.5, the time between the “1” an “0” in the original signal is 
so short that it fits in one sample interval. 

Two points in the same sample interval result in downsampling. Now open the 
Analysis profile, and open the External data variable. See External Data

▪ If you choose Mean for downsampling, the value A in the resampled signal 
will be the average of 1 and 0, that is 0.5.

▪ If you choose Total for downsampling, the value in the resampled signal 
will be 1 + 0 = 1. After selecting Total, the signal is as follows:
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So, choosing Total should solve the issue.

The Integrated Visualization shows “Not calculated”
One or more trials are corrupt, or something went wrong with editing the tracks. 
See The results table contains “?” in many cells. 

The Data Preparation Report says “Failed” for some trials
This message occurs in experiments with Deep learning based body point 
detection. In some cases EthoVision XT fails to review the tracks and fix subject 
identity swaps. For example, when the two subjects spent most of the trial time in 
close contact. See a note in Prepare the data in multi-subject trials

I cannot visualize a trial
In most cases, this occurs when a Data profile is active that does not include that 
trial. Make a Data profile that includes that trial and visualize the data. See Filter 
tracks

The name of the trial is not fully visible
The name of the trial on the toolbar of the Integrated Visualization screen is 
partially hidden. This may occur when the display is set to a high resolution. Reduce 
the screen resolution in Windows.
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A heatmap is plotted outside the arena, or merged with the 
heatmap of other arenas
For example:

Solution: In the Heatmap Settings pane, click Colors and under Smoothing select a 
lower value.

Result:

See also

▪ Color smoothing

In the Heatmaps screen the Group Mean button is not 
available
Probably you are working with a DanioVision experiment. The Group Mean button 
is disabled in the experiments set as DanioVision.

How can I merge heatmaps generated in different arenas?
For example, you acquired tracks in Arena 1 and Arena 3 with subjects that belong 
to the same treatment group, and you would like to create one heatmap based on 
the data of both arenas.
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Unfortunately merging heatmaps from different arenas is not possible within 
EthoVision ZXT. However, with simple JavaScript code you can re-calculate the 
coordinates in the tracks and export them to an external applications that creates 
heatmaps. Here below we describe a possible solution:

1. In the Arena Settings, define a Point of interest (see Draw a point) in each 
arena. For example, the south-west corner of the open field. This point will 
be the new reference point of the coordinates, so it must represent the 
same physical location in all arenas. 
If the arenas includes already a zone or point, like the shelter of PhenoTyper, 
and the zone has the same position and orientation in all arenas, then you 
do not need to define a Point of interest.

2. In the Analysis profile, add two JavaScript continuous variables. See 
JavaScript continuous
The first variable is for recalculating the x-coordinate. Add the following 
text (replace “Point” with the name of you point or zone).

const g_zone = "Point";

function Start()

{

}

function Stop()

{

}

function Process()

{

   var pt1 = GetCenter(); 

   var pt2 = GetPointPoi(g_zone);

   if (pt1)

   {

      var xc = pt1.x - pt2.x;

      SetOutput(xc);
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   }

   else

   {

      SetOutputMissing();

   }

}

3. For the second variable, repeat the step above, this time replace x with y.
4. Export the two variables (Analysis > Export > Raw Data). These contain 

the x,y coordinates expressed relative to the point in the arena.
5. Import the data in an application that creates heatmaps, like Excel Power 

Maps, R or MatLab. 
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Troubleshooting: Control of hardware 
devices
Issues

▪ EthoVision XT does not record the pellet drops
▪ The USB-IO box was accidentally disconnected, or is not found
▪ EthoVision XT does not trigger the LED in an optogenetics setup
▪ I cannot select devices from the second USB-IO box
▪ Some inputs of the Fear Conditioning System do not work
▪ How can I send data through a COM port?

EthoVision XT does not record the pellet drops
The problem occurs also when the Pellet dispenser works just fine.

1. Check that all USB-IO boxes are powered up. If the USB-IO box is not 
powered up, it may work half way and that is rarely noticed.

2. If many devices are connected or there is much USB activity, EthoVision XT 
cannot read the pellet drops in the necessary time. The Pellet dispenser 
sends out an approximately 100 ms pulse to the USB-IO box and then 
EthoVision XT; if it takes longer to read the pulse, EthoVision XT misses the 
read out. Try reduce USB devices that work simultaneously. 

See also the EthoVision XT 18 - Trial and Hardware Control - Reference Manual for 
limitations in the number of devices that can be controlled. 

The USB-IO box was accidentally disconnected, or is not found
The message appears At least one USB-IO box was not found.

1. Reconnect the USB-IO box to the EthoVision XT PC. Check that the USB-IO 
box is powered.

2. Click the Retry button (when this button is available).
3. Establishing connection requires some time. Wait until a message is given 

that the USB-IO box is detected again.
If the message of re-established connection does not appears, close and then 
restart EthoVision XT.
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EthoVision XT does not trigger the LED in an optogenetics 
setup
In an optogenetics experimental setup, EthoVision XT controls one or more Pulsers 
through the USB-IO box. The Pulser and the LED can be triggered manually or with 
the Pulser software, but not through EthoVision XT. When the trigger command is 
sent out from EthoVision XT, the LED in the USB-IO box does not switch on.

Solution: Review all the cable connections as in the chapter Optogenetics 
experiments in the EthoVision XT 18 - Application Manual. Check that on the LED 
controller box, the switch at the back is set to Ext. Also in the Device Configuration 
window of EthoVision XT, make sure that for the ports TTL1, 2, etc. Custom 
hardware is selected. For details on this step, see the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.

I cannot select devices from the second USB-IO box
A number of devices are connected to the EthoVision XT system through two USB-
IO boxes. When one tries to select devices in the Device Configuration window, the 
drop-down menu under Devices is grayed-out.

Solution: 

1. Close EthoVision XT, and uninstall the Noldus HardwareInterface software. 
You can find this in the Windows Control Panel > Programs and Features.

2. Download the full installation file (see Install EthoVision XT), and browse to 
Drivers and tools > PreRequisites > HardwareInterfaceIobox. Run the 
installation file HardwareInterface_Iobox_x64 [version number].msi. 

Some inputs of the Fear Conditioning System do not work
Check that the USB-IO box is powered. Review the cable connections as described 
in the section of the EthoVision XT 18 - Application Manual which describes the 
Ugo Basile Fear Conditioning System.

How can I send data through a COM port?
Use case: Send a string or an integer to an Arduino board via COM. 

To do so, you must first install a DLL interface component. Please contact Noldus 
for further details. Once this component is installed:

1. In the Experiment Settings, declare the COM port as you would when using 
the Noldus USB-IO box and other devices.
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2. In the Arena-Hardware mapping window, map the COM port onto the 
arena.

3. In the Trial Control Settings, add an action based on a COM port. 
Note that:

▪ Data (string or long integers) is sent out as a string. For example, if you 
specify 1234, the string “1234” is sent out. 

▪ A string can also be hexadecimal, for example, 0x6261. Two bytes are sent 
out, first 0x61, then 0x62.
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Troubleshooting: DanioVision
Issues

▪ The quality of detection deteriorates with time
▪ I cannot specify the white light fade duration in minutes and hours
▪ There are spikes in the tracks
▪ The DanioVision White light does not work when I skip some arenas

The quality of detection deteriorates with time
After a few trials, the subjects are no longer correctly detected. For example:

The issue likely occurs because of condensation on the Fresnel lens. 

1. Set the anti-condensation mechanism to permanent On (see the 
DanioVision DVOC-0041 - Reference Manual for details). This bypasses the 
automatic control.

2. If condensation disappears after a while, the temperature sensor and/or the 
sensor circuit may be defective. If condensation remain, the glass heater 
may be defective. Contact Noldus Support for more information.

I cannot specify the white light fade duration in minutes and 
hours
Probably you have an experiment created with a previous version of EthoVision XT. 
There you can only select fade duration of the white light in seconds.
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There are spikes in the tracks

See the topic Troubleshooting: Data acquisition > I see spikes in the track

The DanioVision White light does not work when I skip some 
arenas
Normally the White light device is associated with Arena 1 (A1 in most well plates). 
If you set that arena to To Skip, once you start the trial EthoVision XT does not send 
any command to the White light device because the corresponding arena is not 
active.

To solve this issue, do one of the following.

▪ In the Trial List, set Arena 1 back to Planned. EthoVision XT collects data for 
all the planned arenas, including Arena 1. If you are not interested in the 
data of Arena 1, you can filter it out in the Data profile (Filter option). 

▪ In the Trial List, keep Arena 1 set to To Skip. Open the Arena Settings and in 
the Arena-Hardware Mapping window select No device allocated under 
Arena 1 and select White Light Stimulus under one of the arenas that you 
do not skip. 
The second option is only available when your experiment does not 
contains tracks yet. 
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Troubleshooting: Live Mouse Tracker
Issues

▪ My results differ from what I obtain using the original Python scripts
▪ Number and names of subject do not match those in the LMT database file
▪ The LMT database file is of compatible format

My results differ from what I obtain using the original Python 
scripts
This may occur when you use Python scripts that were modified after the release of 
EthoVision XT. In that case we cannot guarantee that EthoVision XT gives exactly 
the same results. EthoVision XT is based on the Live Mouse Tracker scripts of version 
1.0.3 (October 4, 2022).

Number and names of subject do not match those in the LMT 
database file
After you have selected a LMT database (*.sqlite) for import, the following error 
message opens:

1. Click Close and open the Experiment Settings.
2. Next to Number of Subjects per Arena, enter the number of individuals 

that interacted in the LMT experiment.
3. If necessary, rename the subject to A, B, C, etc. Do not enter other names. 

See Subjects per arena
4. Repeat the import data procedure. See Import Live Mouse Tracker data
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The LMT database file is of compatible format
After you have selected a LMT database (*.sqlite) for import, the following error 
message opens:

This could be caused by the experiment file being empty or without of a definition 
of the subjects. It is probably corrupt. Try to export the LMT data again.
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Troubleshooting: Import trials
Error message ID10107: The source experiment has different 
hardware
This occurs when the Device ID of the hardware devices declared in the experiment 
settings (Device Configuration window) differ between the experiments. Or, if the 
names are the same but the devices ID have been mapped to different arenas. For 
example, when Lickometer 1 was assigned to Arena 1 in the current experiment, and 
in Arena 2 in the experiment you want to import the trials from. 

Unfortunately there is no way to re-assign Devices ID post-acquisition. Always make 
sure to use the same names and mapping criteria when creating new experiments 
that you want to merge.
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Troubleshooting: Quality Assurance (GLP)
Issues

▪ I cannot start EthoVision XT (GLP restriction)
▪ I cannot create new experiments, or acquire data with EthoVision XT
▪ EthoVision XT crashes after opening a GLP log

I cannot start EthoVision XT (GLP restriction)
A message appears:

You are not registered as a GLP user, so you cannot use EthoVision XT. Please ask a 
EthoVision XT user manager for help.

This issue could be caused by the fact that the user that has started EthoVision XT is 
not known as GLP user.

1. Restart the computer and ask the system administrator or someone with an 
administrator account to log in.

2. Start EthoVision XT. Add users as GLP users. Make sure to add all the 
persons that are going to use EthoVision XT. See EthoVision XT user 
management

3. The administrator logs out.
4. Log in with your account.
5. Start EthoVision XT.

Alternatively, ask your system administrator to add your user account to the 
administrator group.

I cannot create new experiments, or acquire data with 
EthoVision XT
The File > New menu items and the Acquisition menu are disabled. When using 
the Quality Assurance module, it seems that users have been removed as 
authorized GLP users.

This may occur for two reasons:

▪ The hardware key is not plugged in.
▪ You reinstalled or repaired the application.
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In the latter case the Quality Assurance user list is deleted. Ask your Quality 
Assurance user manager to add your user ID and give you the appropriate rights.

EthoVision XT crashes after opening a GLP log
This occurs when using Quality Assurance experiments, after you click within the 
GLP log or when you click the Close button. 

Do the following:

1. Open the Windows Notepad and enter the following text:
Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Internet 
Explorer\Main\FeatureControl\FEATURE_USE_LEGACY_JSCRIPT]

"EthoVision.exe"=dword:00000001

2. Save the file as [file name].reg on the EthoVision XT computer.
3. Run the file. 
4. Click OK in the message that appears.

TIP  Files with extension *.reg are blocked by Windows and mail servers. Do not run 
REG files stored on network drives. If you need to send a REG file by email, enclose 
it in a ZIP file.
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Buttons and Keyboard 
Shortcuts

Keyboard shortcuts are only available when the corresponding menu or window is 
active.

▪ Windows – General
▪ Experiment Explorer
▪ EthoVision XT – General
▪ Select and Edit
▪ Trial List and other grids
▪ Row-select grids
▪ Playback Control, Acquisition and Visualization
▪ Arena Settings
▪ Manual Scoring Settings
▪ Trial Control
▪ Detection Settings
▪ Track Editor
▪ Analysis Profiles
▪ Statistics and Charts

Windows – General
Some of these shortcut keys can also be used in the Experiment Explorer, the Show/
Hide menu, the Arena Settings window, the Trial Control window, and the Detection 
Settings window.
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Esc Cancel action

F1 Help

F2 Rename/ edit

F3 Find next

Shift+F3 Find previous

F4 Expand pull down list

Ctrl+F4 Close active window (does not apply to EthoVision XT)

Alt+F4 Close application

Alt+Enter Open properties of selected item (e.g. Settings dialog of 
dependent variable)

Shift+F10 or context 
menu key

Open context menu of selected item

Alt+Spacebar Open shortcut menu of selected window

Ctrl+Esc Display Start menu

Alt+underlined letter Application: open corresponding main menu

Dialog: carry out corresponding command

F10 Activate main menu bar

Main-menu: down 
arrow key

Open menu-item/ cycle thru sub-items

Main-menu: up arrow 
key

Open menu-item/ cycle thru sub-items

Main-menu: right 
arrow key

Open sub-items/ Cycle thru items

Main-menu: left arrow 
key

Close sub-items/ Cycle thru items

Spacebar Select/ clear checkbox if active option is a checkbox

Arrow keys Move/ nudge cursor (highlighted item in grid) or selected 
item

Alt+Tab Switch between open applications

Alt+Esc Cycle through applications in order they were opened
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Experiment Explorer

End Display the bottom of the active window

Home Display the top of the active window

* on numeric keypad Display all subfolders under the selected folder

+ on numeric keypad Display the contents of the selected folder

- on numeric keypad Collapse the selected folder

Left arrow key Collapse current selection if it's expanded, or select parent 
folder

Right arrow key Display current selection if it's collapsed, or select first 
subfolder

Up arrow key Previous item

Down arrow key Next item

EthoVision XT – General

Shortcuts from the menu

Use the keyboard to activate all the functions in EthoVision XT that are on the 
menus. Press Alt plus the letter underlined in the menu and then select the desired 
function by scrolling down to the function or by pressing the underlined letter. For 
example, to go to Preferences on the File menu, press Alt+F, f.

Ctrl+N New default experiment

Ctrl+O Open (experiment or other file type)

Ctrl+S Save experiment

Ctrl+Shift+S Save experiment as…

Ctrl+T New template experiment

Main shortcuts
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Select and Edit

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste

Ctrl+Delete or Delete Delete

Ctrl+drag item Copy selected item

Shift+drag item Move selected item

Shift+arrow keys Expand/ contract block selection in direction of arrow key

Trial List and other grids

Ctrl+left arrow key Go to first cell of row

Ctrl+right arrow key Go to last cell of row

Ctrl+up arrow key Go to first cell of column

Ctrl+down arrow key Go to last cell of column

Arrow keys Move highlight in direction of key

F2 Rename/ edit cell content (see Windows - general)

Tab Go to next cell in row. If last cell, do nothing

Shift+Tab Go to previous cell in row. If first cell, do nothing

Enter (Accept entry and) Go to same column, next row. If last 
row, go to first cell last row

Home Go to the first character within the cell (edit mode, only for 
user-defined variables)

End Go to the last character within the cell (edit mode, only for 
user-defined variables)

Page Up Go to row - no. of rows visible in window and highlight 
same location (and de-select)

Page Down Go to row + no. of rows visible in window and highlight 
same location (and de-select)

Ctrl+Home Go to first cell of first column

Ctrl+End Go to last cell of last column

Ctrl+Alt+T Add trials to the Trial List

Ctrl+Alt+V Add an independent variable to the Trial List
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Row-select grids
An example of a row-select grid is the Components pane in the Data Profile screen 
and Analysis Profile screen. There you can select rows, not individual cells.

Up arrow key Step one row up

Down arrow key Step one row down

Enter Open the settings window of the selected row in the 
Analysis profile

Playback Control, Acquisition and Visualization

Ctrl+Alt+L Add videos to the Trial List

Ctrl+Alt+I Import external data into the Trial List

Ctrl+Alt+E Import trials into the Trial List

Ctrl+up arrow key Jump to begin

Ctrl+down arrow key Jump to end

Ctrl+left arrow key Step 1 sample (or frame) backward

Ctrl+right arrow key Step 1 sample (or frame) forward

(no shortcut) Loops the video (only for Integrated 
Visualization)

Ctrl+9 Play forward at the speed selected. When 
playing back the tracks, one step forward 
corresponds to the time interval for the 
sample rate used for tracking. For example, 
0.04 seconds if the sample rate is 25/s.

Ctrl+Shift+4 Play backward. When playing back the tracks, 
one step backward corresponds to the time 
interval for the sample rate used for tracking.

Ctrl+0 Pause / stop
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Ctrl+. Zoom x2 (Track Visualization, Heatmaps and 
variable plots in Integrated Visualization)

Ctrl+, Zoom x1/2 (Track Visualization, Heatmaps and 
variable plots in Integrated Visualization)

Ctrl+/ Fit all (Track Visualization only)

Ctrl+‘ Play forward at speed 0.01x (Visualization 
only)

Note: This is the key left to the key 1 on the 
international keyboard

Ctrl+1 Play forward at speed 0.04x (Visualization 
only)

Ctrl+2 Play forward at speed 0.2x (Visualization only)

Ctrl+3 Play forward at speed 0.5x (Visualization only)

Ctrl+4 Play forward at speed 1x (Visualization only)

Ctrl+5 Play forward at speed 2x (Visualization only)

Ctrl+6 Play forward at speed 4x (Visualization only)

Ctrl+7 Play forward at speed 8x (Visualization only)

Ctrl+8 Play forward at speed 16x (Visualization only)

Ctrl+Shift+’ Play backward at speed 0.01x (Visualization 
only)

Note: This is the key left to the key 1 on the 
international keyboard

Ctrl+Shift+1 Play backward at speed 0.04x (Visualization 
only)

Ctrl+Shift+2 Play backward at speed 0.2x (Visualization 
only)

Ctrl+Shift+3 Play backward at speed 0.5x (Visualization 
only)

Ctrl+Shift+4 Play backward at speed 1x (Visualization only)

Ctrl+Shift+5 Play backward at speed 2x (Visualization only)

Ctrl+Shift+6 Play backward at speed 4x (Visualization only)

Ctrl+Shift+7 Play backward at speed 8x (Visualization only)

Ctrl+Shift+8 Play backward at speed 16x (Visualization 
only)

Ctrl+F3 New trial (Acquisition only)
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Arena Settings
See also Windows – General and Normal Grids shortcut keys.

Ctrl+F5 Start trial (Acquisition only)

Ctrl+F6 Stop trial (Acquisition only)

Ctrl + + Playback speed one step up. The current 
speed is shown next to this button.

Note: It does not work with the key + on the 
numerical keyboard.

Ctrl + - Playback speed one step down

Note: It does not work with the key - on the 
numerical keyboard.

(no shortcut) Reset the background (grabs the current video 
frame and uses it as background)

(no shortcut) Skip trial

(no shortcut) Optimize tracking speed

See DDS (Detection determines speed)

(no shortcut) Starts screen recording (Integrated 
Visualization only)

Del Delete selected element

Ctrl+J Validate the Arena Settings

V Normal (arrow) mode

R Rotation mode

P Point edit mode

L Draw lines

S Draw rectangle
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Manual Scoring Settings

Ctrl+B Add a behavior category

Ctrl+V Validate the current coding scheme

O Draw open polyline

Y Draw closed polyline

E Ellipse

T 3-Point circle

I Subdivided circle

U Subdivided rectangle

Z Add zone label

A Auto label zone

C Add point

Up arrow key Nudge selected element smallest resolution 
unit up

Down arrow key Nudge selected element smallest resolution 
unit down

Left arrow key Nudge selected element smallest resolution 
unit left

Right arrow key Nudge selected element smallest resolution 
unit right

Shift+arrow key Nudge 10x

Ctrl+. Zoom in the background image and arena 
elements

Ctrl+, Zoom out the background image and arena 
elements
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Trial Control
See Windows – General and Row-select Grids shortcut keys.

Detection Settings
See Windows – General and Row-select Grids shortcut keys. The following shortcut 
keys for playing back the video file work in the Detection Settings window.

Ctrl+up arrow key Jump to begin

Ctrl+down arrow key Jump to end

Ctrl+left arrow key Step -1 sample

Ctrl+right arrow key Step +1 sample

Ctrl+9 Play forward

Ctrl+0 Pause / stop

Track Editor

Ctrl+E Open the Auto Select window

W Swap nose and tail in selection

Ctrl+F Open the Fix Nose-Tail swaps window

D Swap subjects in selection

Ctrl+Del Set selection to missing

Ctrl+I Interpolate selection

Ctrl+Shift+I Interpolate only center-points

Ctrl+M Set tail-base points to missing

Ctrl+Shift+M Set nose points to missing

The shortcut keys for playing back the video files, listed in Playback Control, 
Acquisition and Visualization also work in the Track Editor screen.
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Analysis Profiles
▪ For the Components pane: see Row-select grids
▪ For the Dependent Variables list: see Trial List and other grids

Statistics and Charts

C Refresh the statistics results table

B Start batch analysis

E Export the statistics results table
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